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Get Help

Get Help
There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications
Use help icons    to access help in the application. If you don't see any help icons on your page, click your user image
or name in the global header and select Show Help Icons.

Get Support
You can get support at My Oracle Support. For accessible support, visit Oracle Accessibility Learning and Support.

Get Training
Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community
Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Learn About Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program. Videos included in
this guide are provided as a media alternative for text-based topics also available in this guide.

Share Your Feedback
We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!

i

https://support.oracle.com/portal/
https://www.oracle.com/corporate/accessibility/learning-support.html#support-tab
https://www.oracle.com/education/
https://cloudcustomerconnect.oracle.com/pages/home
https://community.oracle.com/customerconnect/categories/idealab-guidelines
https://www.oracle.com/corporate/accessibility/
mailto:oracle_fusion_applications_help_ww_grp@oracle.com
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Introduction to Replenishment Planning

1  Introduction to Replenishment Planning

Overview of Oracle Replenishment Planning  
This topic provides an overview of Oracle Replenishment Planning.

Here's what you can do in the Replenishment Planning work area:

• Maintain optimum inventory levels at each node of your supply chain while meeting customer service targets.

• Use automated processes to maintain inventory policy parameters, dynamically update on-hand inventory,
reduce costs by calculating the economic order quantity (EOQ) for replenishments, and improve customer
service levels.

• Perform dynamic demand segmentation by grouping item-location combinations into segments that are
meaningful to your business.

• Calculate service level-based inventory policies and thresholds.

• Integrate demand forecasting and time-phased inventory replenishment.

• Set up a multiechelon replenishment plan to balance demand and supply at each echelon of your supply chain
and perform replenishment planning in a holistic manner.

• Rebalance inventories to move items from locations with excess inventory to locations with inventory
shortages.

• Perform end item substitution and supersession during demand fulfillment.

• Simulate inventory planning.

• Set up and monitor exceptions.

• Use rich, embedded analytics.

• Open the Buyer Planning work area to manage buy recommendations from Replenishment Planning. Buyer
Planning helps you evaluate ways to consolidate and group planned orders. Additionally, you can release buy
recommendations from within Buyer Planning.

Also, with REST services, you can generate replenishment orders, manage segments, and integrate Replenishment
Planning with other modules in Oracle Fusion Cloud Applications.

This table shows how Replenishment Planning integrates with Oracle Fusion Applications:

Family in Oracle Fusion Applications Entities Collected by Replenishment
Planning

Entities Released by Replenishment Planning

Oracle Fusion Cloud Inventory Management
 

• On-hand inventory

• Inventory transfers

• Consumption history

• Inventory transfer recommendations

Oracle Fusion Cloud Procurement
 

• Purchase orders

• Requisitions

• Buy recommendations

Oracle Fusion Cloud Order Management
 

• Sales orders Not applicable
 

1
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Family in Oracle Fusion Applications Entities Collected by Replenishment
Planning

Entities Released by Replenishment Planning

• Shipment history

Oracle Fusion Cloud Product Lifecycle
Management
 

• Items

• Organizations

Not applicable
 

Related Topics
• Policy Assignment Sets

• Segmentation in Oracle Replenishment Planning

• Overview of Inventory Rebalancing

• Overview of End Item Substitution and Supersession

• Overview of Simulations for Replenishment Plans

Overview of Supply Chain Planning Work Areas  
The Oracle Fusion Cloud Supply Chain Planning solution is composed of products designed for specific supply chain
planning business processes and tasks.

You perform these processes and tasks by using work areas. Each of the Oracle Supply Chain Planning products
provides access to one or more work areas.

The Supply Chain Planning work areas that you can use are determined by these factors:

• The products that your enterprise has licensed and configured

• The security privileges assigned to your user account

To use the Supply Chain Planning work areas, you must be aware of these points:

• Navigation to work areas

• List of Supply Chain Planning work areas and the products to which they're applicable

Navigation to Work Areas
You can use different paths to navigate to a specific work area including:

• From the Navigator: Click the Navigator icon to see the work areas that you have access to. The Supply Chain
Planning work areas are listed within the Supply Chain Planning heading. The work area names are links. Click a
specific work area link to access that work area.

• From the Springboard: On your home page you might have one or more springboard icons that represent
a group of work areas, such as the group of Supply Chain Planning work areas. Click on the Supply Chain
Planning springboard to access a set of icons, each of which represents a specific Supply Chain Planning work
area. Click a specific icon to access that work area.

2
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List of Supply Chain Planning Work Areas
The following table lists the Supply Chain Planning work areas and the Oracle Fusion Cloud Supply Chain Planning
modules that are applicable to each of the work areas.

Work Area Modules

Demand Management
 

Oracle Demand Management
 

Supply Planning
 

Oracle Supply Planning
 

Demand and Supply Planning
 

Both of these products must be configured:
 

• Oracle Demand Management

• Oracle Supply Planning

Planning Central
 

Oracle Planning Central
 

Sales and Operations Planning
 

Oracle Sales and Operations Planning
 

Backlog Management
 

Oracle Backlog Management
 

Production Scheduling
 

Oracle Production Scheduling
 

Replenishment Planning
 

Oracle Replenishment Planning
 

Plan Inputs
 

Use the Plan Inputs work area to perform tasks that don't require creating or accessing a plan.
 
This work area can also be opened from other Supply Chain Planning work areas.
 

Note:  If a plan that has been created in the Planning Central work area is opened from either the Supply Planning
or the Demand and Supply Planning work area, then that plan will no longer be accessible from the Planning Central
work area.

The Global Order Promising work area is bundled within the Oracle Fusion Cloud Order Management solution.

Related Topics
• Overview of the Replenishment Planning Work Area

• Overview of the Supply Planning Work Area

• Overview of the Demand Management Work Area

• Overview of the Sales and Operations Planning Work Area

• Overview of the Order Promising Work Area

3
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Overview of the Replenishment Planning Work Area  
You use the Replenishment Planning work area to create, configure, and view your replenishment plans and analyze
your real-world business processes.

Using the Replenishment Planning work area, you can:

• Create and configure replenishment plans.

• View replenishment plans and plan inputs.

• Use predefined or user-defined page layouts to view plan data that's tailored to your business.

To go to the Replenishment Planning work area and open a plan:

1. Open the work area by doing one of the following:

◦ In the Navigator, go to the Supply Chain Planning group, and click Replenishment Planning.

◦ On the home page, click the Supply Chain Planning springboard, and click the icon for Replenishment
Planning.

2. To open a replenishment plan, use one of these methods:

Method Step

Through the Plans drawer
 

a. Click the Plans panel tab.
b. Expand Plans.
c. Right-click a replenishment plan, and select Open.

Note:
Only those replenishment plans that have been successfully run are shown in the Plans panel
tab.
 

Through the Manage Plans page
 

a. Click the Tasks panel tab.
b. Under Plans, select Manage Plans.

The Manage Plans page appears.
c. Select a replenishment plan, and click Actions > Open.

Your replenishment plan opens by default in the Edit Plan page, which consists of a header and configurable pane.

Header
The header contains the Page Layout list and drop-down buttons such as Open, Actions, and Save.

Configurable Pane
You can display the contents of your replenishment plan in the configurable pane. The number of panes displayed
depends on the page layout that you're using. Using the Change drop-down button in the header, you can configure the
number of displayed panes.

4
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How to Enable the Replenishment Planning Work Area  
To enable the Replenishment Planning work area, you must perform two setup tasks.

You can perform these tasks in any order, but you must do both before a user can access the work area.

• Opt in to the Replenishment Planning feature

• Assign a job role to the applicable users

Opt In to the Replenishment Planning Feature
You perform this opt in one time for your overall site.

• Offering: Supply Chain Planning

• Feature: Replenishment Planning

For more information regarding how to opt in to features, refer to the Using Functional Setup Manager guide, Offering
Configuration chapter in the Oracle Help Center.

Assign the Applicable Job Role to the Applicable Users
Assign a job role to the user associated with each of your replenishment planners that includes these privileges:

• Monitor Replenishment Planning Work Area
(MSC_MONITOR_REPLENISHMENT_PLANNING_WORK_AREA_PRIV)

• Manage Segments (MSC_MANAGE_SEGMENTS_PRIV)

For more information regarding how to assign job roles to users, refer to the Securing SCM guide, Role Provisioning
chapter in the Oracle Help Center.

Related Topics
• Role Provisioning and Deprovisioning

• Overview of Configuring Offerings

Access Tasks as Quick Actions on a Home Page  
Some tasks that are accessible by using the tasks panel drawer in a supply chain planning work area are also available
from the home page as quick actions.

Click the Show More link on the home page to display all of the available quick actions for which you have access. You
don't have to first navigate to a supply chain planning work area to take an action. For example, use quick actions to
create a sourcing rule to purchase components from a new supplier without having to first select a planning work area.

In addition, there are work area-specific preferences that enable you to change your default page layout without having
to first launch the work area. These preferences are useful if you configured a content-heavy default page layout that's

5
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taking too long to load. In such cases, you can change your default page to a different page layout that opens quicker
and then edit the content-heavy page layout to make it perform better.

Here's some additional information about quick actions on a home page:

• You must have the applicable privileges associated with the task to see the task as a quick action on the
home page. Each quick action is secured by its related privilege or privileges. For example, if you have the
Manage Planning Sourcing privilege, then you should see the Manage Sourcing Rules task in the tasks panel
drawer in the work area. You should also see the task as a quick action on the Supply Chain Planning or Order
Management (in the case of Global Order Promising) home pages.

• You must have access to the work area to see the associated manage preferences quick actions. For example,
you must have access to the Supply Planning work area to see the Edit Supply Planning Preferences quick
action.

• You can't navigate to any other UI or open other tabs. When you click a quick access link, the UI opens in the
page, but you aren't in a work area.

• You can only return to the Supply Chain Planning home page when you close out of a task that you initiated
from the Supply Chain Planning home page.

Work with Page Layouts in Replenishment Planning  
In the Replenishment Planning work area, you can create and edit page layouts.

Create a Page Layout
To create a page layout:

1. In the Replenishment Planning work area, open the replenishment plan for which you want to create a page
layout.

2. In the header, select Page Layout > Create.

The Create Page Layout dialog box opens.
3. Specify the following details:

◦ Enter the page layout name and description.

◦ Select Public to make the page layout accessible to all users, or select Private to restrict the page layout
to yourself.

◦ In the Enable in Work Area field, ensure that Replenishment Planning is selected.

4. Click Save and Close.

The page layout is created with an empty pane.
5. Click the Change drop-down button to select a pane layout (for example, Two Pane, Horizontal Split) for your

page layout.
6. To add content to a pane, click the Open drop-down button, and select the pane.

The Open Table, Graph, or Tile Set dialog box opens.
7. Select a table, graph, or tile set from the displayed list, and click OK.
8. Add content to the other panes of the page layout.
9. Click the Save Layout drop-down button.

6
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Edit a Page Layout
You can edit a user-defined page layout using the Save Layout drop-down button in the header or the Manage Page
Layouts dialog box that's opened from the Page Layout field. You can't save your changes to a predefined page layout
or a page layout that belongs to another user. If you modify a predefined page layout or a page layout that belongs to
another user, you can save it as a new, user-defined page layout that belongs to you.

After making changes to the page layout, click the Save Layout drop-down button to save your changes. To save your
changes to a new page layout, click Save Layout > Save As. The Save Layout As dialog box opens, and you can specify
the name, description, access, and work area for the new page layout.

In the Manage Page Layouts dialog box, you can:

• Change the name, description, work area, and access for the page layout.

• Duplicate or delete the page layout.

Note:  You can't delete the page layout if it's presently being used by the displayed replenishment plan.

• Make the page layout your default page layout.

• Add tables, graphs, or tile sets to the page layout.

• Remove tables, graphs, or tile sets from the page layout.

Predefined Page Layouts for Replenishment Planning
The Replenishment Planning work area has the following predefined page layouts:

• Demand and Replenishment Plan Summary: This page layout provides infotiles for policy execution, policy
effectiveness, segment analysis, total inventory value, and shipment forecast mean absolute percentage error
(MAPE). By clicking the bar at the bottom of each infotile, you can view the associated graphs and tables. Use
this page layout for integrated replenishment plans for which you select the Generate forecast, Calculate
policy parameters, and Calculate replenishments check boxes on the Plan Options page.

• Product Lifecycle Management: This page layout displays the predefined Manage Product Life Cycle by Item
and Date table that you can use to modify the launch and discontinuation dates for products. The page layout
also displays the predefined Manage Forecast During Product Life Cycle table that you can use to modify the
shipments or bookings forecasts for products. Use this page layout to manage product introductions and
retirements.

• Replenishment and Rebalancing Plan Summary: This page layout provides infotiles for policy execution, policy
effectiveness, segment analysis, total inventory value, and rebalancing performance. Use this page layout for
analyzing the effectiveness of the inventory rebalancing process for replenishment plans for which you select
the Rebalance inventory check box on the Plan Options page.

• Replenishment Plan Summary: This page layout provides infotiles for policy execution, policy effectiveness,
segment analysis, and total inventory value. By clicking the bar at the bottom of each infotile, you can view the
associated graphs and tables. Use this page layout for replenishment plans for which you select the Calculate
policy parameters and Calculate replenishments check boxes on the Plan Options page.

• Replenishment Workbench: This two-pane page layout has the Replenishment Workbench table and an
inventory sawtooth graph. Use this page layout when you want to simultaneously use a table and graph for
analyzing replenishment planning results.
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Overview of Supply Chain Planning Plan Types  
When you create a plan, plan type is the first choice that you make. After you run a plan, you can't edit the plan type.

Oracle Fusion Cloud Supply Chain Planning provides these types of plans, which you can create, edit, run, and so on,
depending on the work area that you have access to:

Plan Type Use This Plan Type Work Areas the Plan Type is Available

Demand Plan
 

• When you want to perform collaborative
and statistical demand forecasting.

• When you want to use a demand plan as
a demand schedule for a supply plan or
replenishment plan.

Demand and Supply Planning
 
Demand Management
 
Planning Central
 
Replenishment Planning
 

Supply Plan
 

When you want to generate a supply schedule.
 

Demand and Supply Planning
 
Planning Central
 
Supply Planning
 

Demand and Supply Plan
 

For an integrated demand and supply planning.
 

Demand and Supply Planning
 
Planning Central
 

Sales and Operations Plan
 
 

For aggregate planning.
 

Sales and Operations Planning
 

Backlog Plan
 

For backlog management.
 

Backlog Management
 

Replenishment Plan
 

For replenishment planning.
 

Replenishment Planning
 

Related Topics
• Actions to Manage Your Plans
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Planners for Supply Chain Planning  

How You Define Planners for Supply Chain Planning  
Planners are the people in your organization who are responsible for a set of items, their inventory levels, supply and
demand, and so forth. For example, some typical titles of planners are Material Planner, Supply Chain Planner, and
Demand Planner.

All supply chain planning products use planners. You can define a specific person as a supply chain planner for
the Oracle Fusion source system or for any other source system. You can also associate a planner to an item at the
organization level.

Use the ScpPlannersImportTemplate.xlsm import template to create the CSV file for the Load Planning Data from Files
task for planners. You can also use the Manage Planners page to define supply chain planners for each source system.
Access the Manage Planners page from a Supply Chain Planning work area. Click the Tasks panel drawer and then click
the Manage Planners link.

For Oracle Fusion source systems, associate the employee identification number with the planner name because Oracle
Purchasing requires a valid employee identification number. When a planner releases a planned order, purchasing
checks the employee identification number before creating the purchase requisition.

For external source systems, determine if the employee identification number is required when releasing planned
orders. If required, use the Manage Planners page to associate the planner with their employee identification number.
Or, you can use the ScpPlannersImportTemplate.xlsm template to associate the employee identification number with
the planner name.

Use Oracle Product Hub to assign planners at the item-organization level. During data collections, the planning
processes collect the planner-item-organization assignment. Planners can then use the planner name to search the
data on most of the demand and supply planning pages.

Update Planner Data with New Employee Information  
If a planner's employee information (such as employee number, employee name, or email) changes, then that
information can be updated in the planners table in several ways.

For external source systems, the collection process looks for the employee number in the data managed by Oracle
Fusion Cloud Human Capital Management.

• If the employee number is available in the employee data managed by Oracle Fusion Cloud Human Capital
Management, then its respective details (employee name and email) are extracted and populated in the
planners table.

• If the employee number isn’t available in the employee data managed by Oracle Fusion Cloud Human Capital
Management, then the collection process populates the employee number as provided in the comma-
separated values (CSV) file in the planners table.

Employee details are updatable only once during the initial collection process. For example, in the first collection run,
123456 is provided for an employee number. If you change the employee number to 100100 on the second collection
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run, then the latest employee details aren’t reflected in the planners table. To change a planner’s employee information,
you can select a different employee by using the Manage Planners UI or you can mass update planners.

There are two methods to mass update planners. They both involve removing planner data and then collecting the
planner data again with any changes.

Method A

1. In one of the Supply Chain Planning work areas, select the Manage Planners task.
2. Delete all the planners who need their employee information updated.
3. Collect the planner data again by using the Load Planning Data from Files scheduled process.

Method B

Note:  Method B will purge planner data for all planners.

1. In the Scheduled Processes work area, click Schedule New Process.
2. In the Schedule New Process dialog box, search for and select the Purge Data Repository process.
3. In the Process Details dialog box:

a. Select the Source System.
b. Set Purge Global Entities = Yes.
c. In the Reference Data tab, move Planners to Selected Entities.
d. Click Submit.

The scheduled process purges the planner data.
4. Collect the planner data again by using the Load Planning Data from Files scheduled process.

How You Reassign Item Definitions to a Different Planner  
When a planner leaves an organization and that planner's items need to be reassigned, there are two ways you can
reassign the planner’s item definitions.

• Don't change the planner code but instead reassign the existing code to a different employee on the Manage
Planners page. In this case, there’s no need to change the planner codes for the item.

• Create one or more new planner codes (or use an existing one) and then either:
◦ Manually reassign the items to those one or more new planners individually.

◦ Use the item mass changes feature in the Product Information Management work area.

Assign Time Zones to Locations in Supply Chain
Planning  
You can view supplies and demands in your Supply Chain Planning work area based on the time zone of the
organization, customer site, or supplier site.

In addition, you can calculate precise in-transit time because supply chain planning considers the time zone difference
between the source and destination locations.
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The following points discuss in detail how you can collect time zone details and view orders depending on the locations'
time zone:

• Update Time Zones Using Data Collections

• Assign Time Zones in Supply Network Model

• Calculate In-Transit Time

• View Time Zones in Supplies and Demands

• Release to Execution

Update Time Zones Using Data Collections
Use data collections to update organizations, customer site, or supplier site time zones. You can update the time zone in
one of following three ways:

• Collect the organization's time zone from an Oracle Fusion source system.

• Collect time zones from an external source system using the organization, customer, and supplier import
templates.

• Update the time zone on Customers and Suppliers tabs of the Maintain Supply Network Model page.

If you are collecting from an Oracle Fusion source system, then you can update the organization's time zone using the
data collections method only. You cannot manually update the organization's time zone using the Maintain Supply
Network Model page in your Supply Chain Planning work area.

Assign Time Zones in Supply Network Model
Before collecting time zones or converting time zones to a local time, you must first assign time zones to organizations,
customer sites, and supplier sites. A new time zone field is available on the Organizations, Customers, and Suppliers tab
of the Maintain Supply Network Model page in your Supply Chain Planning work area.

You cannot collect customer site and supplier site time zones from an Oracle Fusion source system. To update the
customer site or supplier site time zone, use one of the following options:

• Use the customer or supplier import template to update the customer site or supplier site time zone. You can
also use this template if you are collecting from an external source system.

• Update the customer site and supplier site time zones directly in the Maintain Supply Network Model page.

When you recollect new customer and supplier data from an Oracle Fusion source system, the existing customer site
and supplier site time zone information is preserved. If you do not collect or update the customer site or supplier site
time zone, then planning calculations assume that the customer site or supplier site is located in the same time zone as
the organization that is associated with the demand or supply.

When you collect the supplies and demands, collections automatically convert the associated dates from the database
server time zone (Coordinated Universal Time or UTC) to the local time zone based on where the event takes place. In
addition, when you collect shipments and booking history from the Oracle Fusion source system for use in the Demand
Management or the Demand and Supply Planning work area, collections converts the historical data from the database
server time zone (UTC) to the associated organization's time zone.

Calculate In-Transit Time
When calculating in-transit times, supply chain planning considers the time zone difference between the shipping
and receiving locations. The following example shows how supply chain planning calculates the in-transit time. In this
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example, the customer site is located in Sydney (UTC+10) and the shipping organization is in Sacramento, California
(UTC-8).

1. When planning collects a sales order with a requested arrival date of 25-March-2018, 21:00 (UTC) on the
database server, the requested arrival date is offset to the customer site's time zone. The customer site's time
zone is Sydney time zone (UTC+10 hours). The requested arrival date becomes 26-March-2018, 7:00 in plan
inputs (Sydney time zone).

2. When you run the plan with the Refresh with current data option, the sales order is included in the plan and
supply chain planning uses this date to calculate the scheduled ship date.

3. Consider the in-transit time for the selected shipping method (Air Freight) is 36 hours. Supply chain planning
first calculates the scheduled ship date as 25-March-2018, 19:00 hours (Sydney time) and then converts the
date to the Sacramento time. The product is shipped from Sacramento. The time zone difference is applied
to the scheduled ship date by subtracting 18 hours. The scheduled ship date becomes 25-March-2018, 1:00
Sacramento time, which is used to generate the pegged supplies.

4. After completing the calculations, supply chain planning moves all the dates to the end of the day. All dates
have the time stamp of 23:59:00. The time stamp is not available on the UI, but you can query the time stamp
from the planning database.

Supply chain planning makes similar in-transit calculations when shipping supplies from a supplier site to an
organization, or when transferring product from one organization to another.

View Time Zones in Supplies and Demands
On the Supplies and Demands page, use the following three columns to view supplies and demands in relation to the
time zone:

• Organization Time Zone

• Source Time Zone

• Destination Time Zone

The columns aren't included in any predefined table layout. Create a user-defined table layout and include these
columns in your table.

To display supply and demand measure values within a table such as Material Plan or Build Plan, supply chain planning
assigns the measure value to the day based on the organization's local time zone. The supply and demand measure
value is not assigned to a date based on a common time zone.

Release to Execution
When you release orders that are marked for release to Oracle Fusion Cloud execution system, the release action offsets
the date from the location's time zone to the database server time zone (UTC).

For example, when you release a planned make order, supply chain planning converts the need-by date from the
organization's time zone to UTC.
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2  Tables, Graphs, Analysis Sets, Tiles, and Tile
Sets

Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile
Sets  
You can configure the entities for tables, graphs, analysis sets, tiles (also referred to as infotiles), or tile sets by using the
Selector Tool.

You can also create and manage groups on the Selector Tool page and associate your tables and graphs with the group.
Navigate to the Selector Tool from an open plan or from the Actions menu on a table or graph toolbar.

To create a table, graph, analysis set, tile set, or tile, open the Selector Tool:

1. From an open plan, click Actions and then select Manage Tables, Graphs, and Analysis Sets.
2. In the Manage Tables, Graphs, and Analysis Sets dialog box, click Actions and then select Create.
3. Select one of the following to open the Selector Tool:

◦ Table

◦ Graph

◦ Analysis Set

◦ Tile Set

◦ Tile

4. Depending on your selection, the Selector Tool dialog box opens with the following tabs:

Tab Table Graph Analysis Set Tile

Measures
 

Yes
 

Yes
 

Yes
 

Yes
 

Hierarchies
 

Yes
 

Yes
 

No
 

Yes
 

Members
 

Yes
 

Yes
 

Yes
 

Yes
 

Measure Filters
 

Yes
 

Yes
 

No
 

Yes
 

Layout
 

Yes
 

Yes
 

No
 

Yes
 

Comparison Options
 

Yes
 

Yes
 

No
 

No
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Tab Table Graph Analysis Set Tile

Details
 

No
 

No
 

Yes
 

No
 

Note:  In the Selector Tool, the member values displayed are based on what's configured in the Member Identifier to
Display column on the Configure Planning Analytics page, Levels and Attributes tab. For example, for item, you can
configure your tables and graphs to show the item description instead of the item name, which is what also appears
when you're in the Selector Tool.

Measures
Use the Measures tab to select measures for a table or graph by moving measures from the Available Measures pane to
the Selected Measures pane. The measures that you select determine the content of the other tabs. The dimensions of
the measures determine the dimensions available on the Hierarchies tab and the dimension members on the Members
tab. For example, if a measure has the Product, Organization, and Time dimensions, those dimensions and their
hierarchies are visible on the other tabs. You can display the available measures by measure group or alphabetically by
using the Tree View or List View icon.

A measure is usually a named time series of values that represent the following at a particular intersection of the
Customer, Organization, Product, Supplier, and Resource dimensions:

• Historical performance (Bookings History). This measure isn't applicable for supply planning.

• Future projections (Shipments Forecast)

• A key performance indicator (KPI), such as Gross Margin Percentage, or a derived calculation, such as Projected
Available Balance

The planning process aggregates measure data from lower levels to higher levels or computes KPIs and derives
calculations from other values at the same level as needed. The planning process can also allocate or spread updates
made at an aggregate level to the affected cells at lower levels. Measures can be expressed in different units of measure,
such as inches, dollars, kilos, or liters. Depending on the context, you can display, update, or compare measures that are
in different units. The planning process can convert values among different units and among different currencies (for
monetary values).

When plans are archived, you can retrieve measures from the archived time periods and show them on a plan table. See
the View Planning Measures from Archived Time Periods topic to learn more. However, for Demand and Supply Plans,
the Demand History Buckets option determines whether the archived period is shown or not.

Note:  Text-based measures aren't supported in graphs and aren't displayed in the Available Measures pane on the
Measures tab of the Selector Tool during the configuration of graphs.

Hierarchies
Use the Hierarchies tab to select the dimensions, hierarchies, and levels to include or exclude in the table or graph.

For each dimension, select the hierarchies and levels that you want to include in the graph or table. Checking the
box in the Display column includes that dimension in the table or graph. Expand the dimension to view the available
hierarchies. Expand the hierarchy to view the levels of the hierarchy. Checking a level includes it in the table or graph. If
multiple levels are checked, the top level is displayed in the table or graph by default. Each level in the table or graph can
be expanded until all checked levels are visible. The Show Unassociated check box determines whether the measure
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values that aren't associated with a specific dimension in the table or graph are hidden or displayed. For example, a
table could include Shipments Forecast and Net Resource Availability. Shipments Forecast has product, organization,
and time as dimensions. Net Resource Availability has resource, organization, and time as dimensions. With the check
box selected, the Resource column displays the word Unassociated when you view Shipments Forecast rows.

For a demand plan that uses a hybrid time hierarchy, only the hierarchy that was selected as the planning calendar on
the Scope tab on the Plan Options page is displayed for the Time dimension along with the other, corresponding hybrid
time hierarchies that were created when the Create Hybrid Time Hierarchies scheduled process was run.

You can select the levels of only one hybrid time hierarchy.

Members
You use the Members tab to manually select dimension members by moving members from the Available Members
pane to the Selected Members pane. If no selections are made on this tab for a dimension, the graph or table displays
the dimension starting at the top level checked on the Hierarchies tab. For example, if you selected the Gregorian
Calendar hierarchy with Quarter and Month on the Hierarchies tab, the graph or table displays all quarters; each quarter
has an icon to drill to its months.

Measure Filters
Use the Measure Filters tab to filter results based on measure values across dimension member combinations that meet
the criteria that you specify. You can filter your measure data to return only multidimensional combinations that meet
the measure criteria for selected dimensions of the measure.

Note:  The measures listed are those that are of data type number, currency, or percent that aren't dimensioned by
time. Measures that are time dimensioned and of data types date and text are excluded from the list. If the table
contains any configure-to-order (CTO) measures, then the Measure Filters tab is disabled.

When you create or edit a table or graph, make your selections on the Measures, Hierarchies, and Members tabs. Next,
on the Measure Filters tab, specify the measure criteria to apply across combinations of your dimension selections, such
as Item and Customer. The table or graph displays only the combinations that meet your specified measure criteria.

You can compare measures to fixed values or to other measures, and you can apply multiple measure conditions:

• Multiple AND conditions are allowed

• Multiple OR conditions are allowed

• Combinations of AND and OR conditions aren't allowed.

You can apply the measure filters in a table or graph to a linked table or graph in the Manage Links dialog box. On the To
Table, Graph, or Layout tab, select the Include measure filters check box. This check box is enabled after you select the
Pass user-specified parameters check box.

Layout
Use the Layout tab to format tables, graphs, or tiles. The following are the key layout options for tables, graphs, and
tiles:

• Tables: Use table layout options to drag and drop dimensions to change the table layout and configure drill
settings.

• Graphs: Use the graph layout options to select the graph type and the formatting options for the graph type
that you select. In the Filters section, you can specify the filter criteria that you want displayed in the graph.
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• Tiles: Use the tile layout options to select the graph type and add tables and graphs to the content area of the
tile you're creating.

Comparison Options
The Comparison Options tab is applicable only for tables and graphs. On the Comparison Options tab, you can compare
your current plan with an archived version or an alternate plan. Use this tab to compare how specific measures have
varied over time. The Comparison Options tab contains three sections: Waterfall Analysis, Trend Analysis, and Plan
Comparison.

Note:   The Comparison Options tab isn't available in the Oracle Planning Central work area.

• In the Waterfall Analysis section, you can compare selected measures in a table or a graph with an archived
plan.

Select the Use MAPE calculations check box if you have scheduled your plan archival process. Mean absolute
percentage error (MAPE) calculations use the system administrator archive and not an on-demand archive.

In the Measure Archives to Use list, select one or more archives to reference. The number of weeks refers to
how long ago the archive was created. The planning process uses the following logic for when to use an archive:

◦ Match the exact dates. If multiple versions of an archive are within the waterfall time frame, use the
closest, most current version.

◦ If no match is found on the exact date, use the match closest inside the range, which is +3/-3 days of a
selected weekly waterfall time frame, or +15/-15 days for a monthly archive.

◦ If no match is found within +3/-3 days of a selected weekly waterfall time frame, or +15/-15 days for a
monthly archive, then nothing is returned.

For example, if you select 4 weeks ago, the planning process searches for the archive 4 weeks prior to today's
date, for instance, March 6. If your archives are stored at the month level and nothing is found on February 5,
the planning process searches for the most recent archive within +15/-15 days.

• In the Trend Analysis section, you can provide the number of archives that you want to reference. The planning
process selects the latest archives. For example, you have five archives, where number five is the latest archive
and you have selected 3 in the Number of Previous Versions to Include field. The planning process selects
archive number five, four, and three for the comparison. The difference between Waterfall Analysis and Trend
Analysis is that in Waterfall Analysis you can choose an archive created within each selected time frame that
you want to compare. In Trend Analysis, you can select the number of archives that you want to compare, and
only the latest archives are used for comparison.

• The Plan Comparison section pertains to both archived plans and alternate plans that you consider for
comparison. You can select the type of difference to display in tables or graphs for comparison. For example,
you can choose to view the difference in percentage or absolute percentage.

Related Topics
• Use Advanced Options in the Selector Tool

• Use Table Drilling

• Create a Tile in Supply Chain Planning

• Create a Tile Set in Supply Chain Planning

• How You Use Levels and Attributes in Supply Chain Planning
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Use Advanced Options in the Selector Tool  
You can use the Advanced Filter dialog box to filter data and select specific members that fulfill some criteria.

Click the Advanced Filter icon on the Members tab to open the Advanced Filter dialog box. You can use the following
filter criteria tools:

• Levels: Select by level. Select the members in a level such as Customer Site for the Customer dimension, or
Period for the Time dimension.

• Family: Select parent or child of a dimension member. Select members based on a parent or child relationship,
such as selecting the Days in a Week.

• Attributes: Select based on name. For example, select members based on items whose name contains
Economy.

• Measure Criteria: Select based on meeting measure criteria. Select members that meet the criteria, such as
Products for which the gross margin is greater than a particular value.

• Time Range: Select a range of dates. Select time periods based on a range, a start date, or today's date.

The advanced filter criteria tools are used in conjunction with action keywords to refine selections. The following four
actions determine how to apply the criteria:

• Replace with: Replace the current selection, if any, with members meeting the criteria.

• Add: Add members meeting the criteria to the current selection.

• Keep: Keep only the members in the current selection that meet the criteria.

• Remove: Remove the members from the current selection that meet the criteria.

You can apply filter criteria tools sequentially to refine your selection. For example, select all the items for a category,
and then keep the top 10 items based on sales.

Click the Show Results button to see the filtered list of members based on the criteria. Removed members are shown
below the filtered list. You have the option of accepting the results or resetting to the previous members.

When you accept the results, the criteria used to retrieve the accepted members appear in the Criteria Steps section on
the tab. These criteria are evaluated when the table or graph is displayed. You can remove criteria steps.

Note:  Ensure that the criteria steps defined for each dimension are needed and relevant. Remove all unwanted or
unnecessary criteria steps so that your table or graph displays the correct information.

• To remove a step, click the Remove icon in a row.

• To view the result of removing a criteria, click Show Criteria Change.

• To accept the Show Criteria Change results, click Accept and then OK.

• To make the change permanent, click Save or Save and Close.

• To view the results without making the change permanent, click Apply and Close.

Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets
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Create an Analysis Set  
An analysis set is a named set of criteria that can contain selected measures, dimension members, or both measures
and dimension members.

Use the Apply Analysis Set and Save as Analysis Set buttons to apply previously made selections or to save the
selections made in the Selector Tool.

Applying an existing analysis set to a table or graph is a quick way to select the measures and dimension members that
you frequently use.

You have the option to save measures and dimension members. You can save the dimension members as a list or as
a script. For example, you can select the top 10 items based on sales for January. If saved as a list, the same 10 items
would always be displayed in the table or graph, regardless of the current month. However, as sales data changes over
time, you would want to see the top items in the current month in your table or graph. To accomplish this, save the
dimension members in a script that would evaluate the criteria whenever the table or graph is displayed.

Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Create a Tile in Supply Chain Planning  
A tile is a component used to present a graphical summary of the data. A tile is also referred to as an infotile in Oracle
Fusion Cloud Supply Chain Planning.

Each tile has one or more related tables or graphs with predefined drill-to actions to display additional information
about that key performance indicator (KPI).

To create a tile:

1. In a Supply Chain Planning work area, open a plan.
2. Click Actions > Manage Tables, Graphs, and Analysis Sets.
3. In the Manage Tables, Graphs, and Analysis Sets dialog box, in the Search Results region, click Actions and then

select Create > Tile.
4. In the Selector Tool - Create Tile dialog box, on the Measures tab, select the required measures and move them

from the Available Measures pane to the Selected Measures pane.
5. On the Hierarchies tab, select the dimensions, hierarchies, and levels to include or exclude in the tile.
6. On the Members tab, select the required dimension members and move them from the Available Members

pane to the Selected Members pane. If you don't select a dimension member, the tile displays the dimension
starting at the top level selected in the Hierarchies tab.

7. On the Layout tab, do the following:

◦ Select the graph type for the infotile.

◦ Expand the Content Area panel, and then click the Add Row button. You can add up to four tables or
graphs to display them in the content area for that tile.

8. Click Save and Close.
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Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

• Create a Tile Set in Supply Chain Planning

Set Measure Targets for Use in Tiles  
You can enter or update goals for a measure to track performance against the goals. Set targets by editing a measure
and updating the measure goal. When the plan summary displays the measure, the goal or target for that measure is
visible.

You can define goals only for measures that are of data type currency, number, or percent.

For global goals, you can provide a low range or a high range. The ranges are displayed on the user interface when you
view a measure in comparison with its goal. Global goals are measure level parameters and aren't defined specifically for
a data population.

To enter or update measure target goals, follow these steps:

1. Open the Manage Planning Measures page:

a. In a Supply Chain Planning work area, open a plan.
b. On the Edit Plan page, click the Tasks panel tab.
c. In the Tasks panel drawer, click the Manage Planning Measures link.

2. On the Manage Planning Measures page, select the measure and click the Edit icon.
3. On the Edit Measure page, navigate to the Advanced tab, Goals subtab.
4. In the Goals subtab, select whether low values or high values are better.

For example, high values are better for Gross Margin, but low values are better for Demand at Risk.
5. In the Global Goals section, provide a low range or a high range.
6. Click Save and Close.

Create a Tile Set in Supply Chain Planning  
You can create a tile set to group individual tiles.

Tiles are also referred to as infotiles in Oracle Supply Chain Planning. Creating tile sets can be useful in cases where you
want to track various metrics on a single page. You can add tile sets to a pane in a page layout.

Tip:  Before you create a tile set, check whether you need to create the tiles that you will be adding to the tile set.

To create a tile set:

1. In a Supply Chain Planning work area, open a plan.
2. Click Actions > Manage Table, Graphs, and Analysis Sets.
3. On the Search table toolbar, from the Actions menu, select Create > Tile Set.
4. In the Selector Tool - Create Tile Set dialog box, specify these details:
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◦ Enter a name and description for the tile set.

◦ Select a group for the tile set.

5. From the Available Tiles pane, select the tiles to include in the tile set and move them to the Selected Tiles pane.
6. Click Save and Close.

Related Topics
• Create a Tile in Supply Chain Planning

Use Table Drilling  
After you create a table, use drilling in the table to expand and collapse the levels within the hierarchy by which you can
view different levels of aggregation.

When viewing a table or graph, the dimensions and hierarchies selected on the Hierarchies tab are visible. The top
selected level is visible; use drilling to view lower levels.

To drill across hierarchies or dimensions, the levels must be adjacent. Drilling is automatically available for the levels
within the predefined hierarchies, but you can also configure drill pairs to drill across hierarchies or dimensions.

To display a table showing Final Shipments History with the ability to drill from customer to item, the columns Customer
and Item must be adjacent:

1. On the Layout tab, use the View menu to select Configure Drill Settings.
2. Click the Add Row  icon to add a new drill pair.
3. In the Drill From column, select Customer. In the Drill To column, select Item.

With this configuration, you can view the shipments history values by item for each customer in the table.

Note:  Drilling is only active between the adjacent levels in the table.

Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

• Use Advanced Options in the Selector Tool

• Use Table Linking

Use Table Linking  
You can link a table or graph to another table or graph or a page layout by selecting Manage Links from the Actions
menu on the toolbar.

The links enable you to pass the context of a table or graph to another table or graph or a page layout.

In the Manage Links dialog box, you can use these tabs:

• To Table, Graph, or Page Layout: Create a link to another table or graph or to a page layout.
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• From Table or Graph: Link to the open table or graph from another table or graph.

Use the Add Row icon to add a link.

• Enable dynamic linking: Select this check box to enable dynamic linking. If selected, then the target table or
graph is refreshed when the selections in the source table or graph change.

• Pass highlighted selections and selected members: If you select this option, then whatever you highlight in
the current table or graph is passed as the context along with the filters in the Selector Tool to the target table,
graph, or page layout.

• Pass user-specified parameters: If you select this option, then you can select the level and context of the source
table or graph to pass as link parameters to the target table, graph, or page layout.

• Include measure filters: Select this check box to apply measure filters that you defined on the Measure Filters
tab in the Selector Tool to a linked table or graph. This check box is enabled:

◦ After you select the Pass user-specified parameters option.

◦ If the From Table contains measure filters.

Note:  If you're linking a summary table that lists configure-to-order (CTO) items to a detail table that lists the CTO
items along with their option classes and options, select the Pass highlighted selections and selected members
option.

After you define the link, use the Drill icon on the toolbar to drill to the linked table, graph, or page layout.

Dynamic linking is supported only from a pivot table displaying measures to another pivot table or graph displaying
measures. It's not supported from the entity tables such as items, item structures, and so on.

Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

• Use Advanced Options in the Selector Tool

• Use Table Drilling

Link to External Systems  

Overview of Linking to External Systems with Context  
You can link a table or graph in your Oracle Fusion Cloud Supply Chain Planning module to supporting information in an
external system to gain a deep understanding of your data and aid your decision making.

Note:  You can create links to external systems from only pivot tables and not regular tables.

When you're analyzing data in a table or graph in the Demand Management, Demand and Supply Planning, Planning
Central, Replenishment Planning, Sales and Operations Planning, or Supply Planning work area, you might need to view
additional information that resides in an external system. Using this functionality, you can link your table or graph to an
object in the external system. For example, you can link your table or graph to a predefined or user-defined analysis or
report in Oracle Transactional Business Intelligence (OTBI), Oracle Analytics Cloud, or Oracle Analytics Publisher.
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While specifying the link, you can pass dimensions, levels, and level members in your table or graph along with the link
so that it opens the external system object with the context of the data in your table or graph. You can also pass the plan
name or ID along with the link to restrict the displayed data in OTBI, Analytics Cloud, or Analytics Publisher.

How You Set Up Links to External Systems
To set up links to an external system, you must do the following:

1. Set up the application integration for the external system.
2. Configure a table or graph with a link to the external system.

Additional Points About Links to External Systems
Note these additional points about links to external systems:

• Any link that you create from a table or graph to an external system is tied to that table or graph and your user
credentials.

When you log on to an Oracle Supply Chain Planning module, you can use the link in the table or graph from
all plans that include the table or graph. Others with the required role and privileges can also use the link in the
table or graph from all plans that include the table or graph.

However, you can edit or delete the link only if you created it.

• During data migration, when you export a table that contains a link to an external system and subsequently
import the table, the link is available in the table.

• When you duplicate the table or graph, you can choose to include the links to the external system in the copy.

Related Topics
• Structure of a Link to an External System

• Set Up the Application Integration for an External System

• Create a Link to an External System

• Use a Link to an External System

Structure of a Link to an External System  
This topic explains the structure of a link to an external system from a table or graph in an Oracle Fusion Cloud Supply
Chain Planning module. The topic also provides examples of such links.

A link to an external system consists of these parts:

• Base URL: You supply this part of the link in the Full URL field on the Create Application Integration page. The
link must include the host information and can also include the port details. This part is displayed in the Base
URL field in the Create Link to External System dialog box and can't be modified.

For example, the base URL could be as follows: https://...oracle.com
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• Page or report path: You supply this part of the link in the Page Path field in the Create Link to External System
dialog box. This path is appended to the base URL and contains details about the page or report in the external
system to which you're creating the link.

Along with the page path, you can also pass the name or ID of the Oracle Supply Chain Planning plan you're
in to restrict the displayed information in the linked, predefined or user-defined analysis or report in Oracle
Transactional Business Intelligence (OTBI), Oracle Analytics Cloud, or Oracle Analytics Publisher.

An example of the report path without the plan context is as follows: /analytics/saw.dll?
Dashboard&PortalPath=%2Fshared%2FCustom%2FSCP%2FSalesOrders_Booking_Rpt
%2FSO_Bookings_Rpt4&Page=page%201&Action=Navigate, where SO_Bookings_Rpt4 is the name of the
report.

An example of the report path with the plan context is as follows: /analytics/saw.dll?Dashboard&PortalPath=
%2Fshared%2FCustom%2FSCP%2FPL_OTBI_report2%2FDM_Plan_Details&Page=page
%201&Action=Navigate&col3=%22Plan%22.%22Plan%20Name%22&val3=#PlanName#

You must provide the plan context only when the page or report in the external system has a filter for the plan
context, and you want to review the information by plans. For example, a link to an external web page doesn't
require plan context.

• Linking parameters: You supply this part of the link in the Linking Parameters section on the To External
System tab in the Manage Links dialog box. The linking parameters contain details about the dimensions,
levels, and level members in the table or graph. This information is appended to a combination of a base URL
and page or report path and opens the external system object with the context of the data in your table or
graph.

For example, the linking parameters could be as follows: "Distributed Order Orchestration - Fulfillment Lines
Real Time"."Order Header Detail"."Ordered Date"&op1=bet&val1=timestamp '#StartDate# 00:00:00' timestamp
'#EndDate# 23:59:00'

After the link is encoded, when it's accessed from a table or graph, and the runtime values for the contextual
parameters are passed, the linking parameters would look as follows: &col1=%22Distributed%20Order
%20Orchestration%20-%20Fulfillment%20Lines%20Real%20Time%22.%22Order%20Header%20Detail%22.
%22Ordered%20Date%22&op1=bet&val1=%22timestamp%20%272022-06-01%2000%3A00%3A00%27%22+
%22timestamp%20%272022-06-30%2000%3A00%3A00%27%22

The resulting, concatenated link opens the external system object with the context of the selected data in your table or
graph.

Example of a Link to an OTBI or Analytics Cloud Report or Analysis
You must meet these requirements while creating a link from a table or graph to a report or analysis in OTBI or Analytics
Cloud:

• In the Parameter field on the To External System tab in the Manage Links dialog box, enter the names in the
col<number> format. For example, the parameter names could be col1, col2, col3, and so on.

• In the Value field on the To External System tab, enter the names for the subject areas and columns to which
you're passing tokens, and enclose this information in quotation marks.

Then, enter the tokens in the val<number> =<token name> format. The token names mustn't be within double
quotation marks.

If required, include operators, which you must preface in the op<number> format (for example, op2=bet).
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This example depicts how the linking parameters would look before the link is encoded:

col1="Submitted Date (Booked Date) - UTC"."Submitted Date"&val1=timestamp '#MemberName# 00:00:00'

col2="Fulfillment Line Details"."Demand Class Meaning"&val2=#MemberName#

col3="Product"."Product Number"&val3=#MemberName#

col4="Planning Date 1"."Period Start Date"&op4=bet&val4=#StartDate# #EndDate#

After the link is encoded, the linking parameters would look as follows: &col1=%22Submitted+Date+%28Booked
+Date%29+-+UTC%22.%22Submitted+Date%22&val1=%22timestamp+%27<date from selection context>
+00%3A00%3A00%27%22&col2=%22Fulfillment+Line+Details%22.%22Demand+Class+Meaning%22&val2=
%22<member name from selection context>%22&col3=%22Product%22.%22Product+Number%22&val3=
%22<member name from selection context>%22&col4=%22Planning%20Date%201%22.%22Period%20Start%20Date
%22&op4=bet&val4=%22<start date from selection context>%22+%22<end date from selection context>%22

Note:  Ensure that the numbers for the parameter, value, and operator names are the same for a combination of a
parameter and value.

Example of a Link to an Analytics Publisher Report
You must meet these requirements while creating a link from a table or graph to a report in Analytics Publisher:

• In the Parameter field on the To External System tab in the Manage Links dialog box, enter the access
parameters for Analytics Publisher.

Some examples of access parameters are as follows:

◦ _paramsp_itemname

◦ _paramsp_fromdate

◦ _paramsp_todate

◦ _paramsp_customer

• In the Value field on the To External System tab, enter the token names.

Match the access parameters for Analytics Publisher to the available token names for links to external systems.

This example depicts how the linking parameters would look before the link is encoded:

_paramsp_itemname=#MemberName#

_paramsp_fromdate=#StartDate#

_paramsp_todate=#EndDate#

_paramsp_customer=#MemberName#

After the link is encoded, the linking parameters would look as follows: &_paramsp_itemname=<member name from
selection context>&_paramsp_fromdate=<start date from selection context>&_paramsp_todate=<end date from
selection context>&_paramsp_customer=<member name from selection context>
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Related Topics
• Overview of Linking to External Systems with Context

• Set Up the Application Integration for an External System

• Create a Link to an External System

• Use a Link to an External System

Set Up the Application Integration for an External System  
You must specify the application integration for an external system before you can link to it from a table or graph in your
Oracle Fusion Cloud Supply Chain Planning module. You must have administrator privileges to perform this procedure.

1. In the Setup and Maintenance work area, on the Tasks panel tab, select Manage Setup Content.
The Manage Setup Content page opens.

2. Under Topology Definition, select Manage Integration of Additional Applications.
The Manage Integration of Additional Applications page opens.

3. Click Actions > Create.
The Create Application Integration page opens.

4. In Application Name, enter the name of the external system.

Note:  The name must start with "SCP_EXT_LINK_". Otherwise, you can't select the application integration in the
Application Name field in the Create Link to External System dialog box.

5. In Full URL, enter the base portion of the URL to the external system. The URL must include the host information
and can also include the port details. The page path and linking parameters are appended as context to this URL.
For example, you can enter "https://...oracle.com" in the field.
When you create the link for the table or graph, this URL is displayed in the Base URL field in the Create Link to
External System dialog box and can't be modified. The information you specify in the Page Path field in the dialog
box and on the To External System tab in the Manage Links dialog box is appended to this base URL.

6. In Partner Name, enter any value you require.
7. In Security Policy, ensure that None is selected.
8. Click Save and Close.

Related Topics
• Overview of Linking to External Systems with Context

• Structure of a Link to an External System

• Edit the Application Integration for an External System

• Create a Link to an External System

25



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 2
Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Edit the Application Integration for an External System  
You can edit or delete the application integration for an external system to which you're linking tables or graphs from
your Oracle Fusion Cloud Supply Chain Planning module. You must have administrator privileges to perform this
procedure.

1. In the Setup and Maintenance work area, on the Tasks panel tab, select Manage Setup Content.
The Manage Setup Content page opens.

2. Under Topology Definition, select Manage Integration of Additional Applications.
The Manage Integration of Additional Applications page opens.

3. Search for your application integration, and select it.
4. Do one of the following:

◦ To edit the application integration, follow these steps:
i. Click Actions > Edit.

The Edit Application Integration page opens.

You can't edit the application and partner names.
ii. Edit the value in the Full URL field.

The URL must include the host information and can also include the port details.
iii. In Security Policy, ensure that None is selected.
iv. Click Save and Close.

◦ To delete the application integration, follow these steps:
i. Click Actions > Delete.

A dialog box is displayed.
ii. Click Yes.

What to do next
After editing or deleting the application integration, you must modify the external links that use the application
integration. Otherwise, the external links won't work.

Related Topics
• Overview of Linking to External Systems with Context

• Structure of a Link to an External System

• Set Up the Application Integration for an External System

• Create a Link to an External System

• Edit a Link to an External System

Create a Link to an External System  
After specifying an external system's application integration, you can create a link to the system from a table or graph in
your Oracle Fusion Cloud Supply Chain Planning module by supplying the page path and linking parameters.
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Tip:  To create a link to a page or report in an external system, examine the target URL. Then, enter the required
information for the base URL, page or report path, and linking parameters so that the rendered link meets the external
system's requirements. Use supported tokens instead of actual values in the linking parameters to pass contextual
values during runtime.

1. In your table or graph in the Demand Management, Demand and Supply Planning, Planning Central, Replenishment
Planning, Sales and Operations Planning, or Supply Planning work area, click Actions > Manage Links.
The Manage Links dialog box opens.

Note:  You can create links to external systems from only pivot tables and not regular tables.

2. On the To External System tab, click the Create icon.
The Create Link to External System dialog box opens.

3. In Name, enter a unique name for the combination of the application integration and page path for which you're
creating the link.
This name is displayed when you click Actions > Drill To > External Links in the table or graph.

4. In Description, enter the link description.
5. In Application Name, select the application integration that was previously specified on the Create Application

Integration page.
The base URL that you entered on the page is displayed in the Base URL field and can't be changed.

Tip:  You can reuse the same application integration in links to external systems so long as you don't need to
change the base URL.

6. In Page Path, enter the path to the page or report in the external system.

To restrict the displayed data to the current plan in the linked, predefined or user-defined analysis or report in Oracle
Transactional Business Intelligence (OTBI), Oracle Analytics Cloud, or Oracle Analytics Publisher, specify these
tokens:

◦ #PlanName#: Append this token to the page path to pass the name of the current plan in the Oracle Supply
Chain Planning work area.

◦ #PlanId#: Append this token to the page path to pass the ID of the current plan in the Oracle Supply Chain
Planning work area.

Ensure that the path doesn't contain the host or port details because they're derived from the application
integration.

7. Click OK.
The link is displayed on the To External System tab in the Manage Links dialog box.

8. With the link name selected, in the Linking Parameters section, click the Add Row icon.
A blank row appears in the Linking Parameters section.
You can save the link only when it has at least one valid combination of a parameter and value.

9. In Dimension, select a dimension that you want to pass along with the link to the external system.
The available dimensions are those selected for the table or graph on the Hierarchies tab in the Selector Tool.
The Level field becomes available.

If you selected the Time dimension, the Date Format field is enabled.

10.Select a level that you want to pass along with the link to the external system.
The available levels are those selected for the table or graph on the Hierarchies tab in the Selector Tool.
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11. In Parameter, enter a unique name for the parameter through which you want to pass the dimension, level, and
value to the external system page or report.
Ensure that the name meets the external system's nomenclature rules for parameters.

12. In Value, enter a token for passing the selected level member in the table or graph. The information in this field
should be in the decoded format for URLs.
You can specify these tokens:

◦ #MemberName#: Use this token to pass the member name. For example, the token can contain the name
of the item, organization, customer, week, or month.

◦ #MemberId#: Use this token to pass the internal ID of the member.

◦ #StartDate#: Use this token to pass the start date of the time bucket for your selection in the table or
graph.

◦ #EndDate#: Use this token to pass the end date of the time bucket for your selection in the table or graph.

When you use the link, the tokens are replaced by the actual values for your selection in the table or graph.

13. In Date Format, select the format in which the value for the Time dimension must be passed to the external system
page or report.

14.Configure additional parameters by repeating Steps 8 through 13.
15. Click Save and Close.

The link is added to the External Links group that's available when you click Actions > Drill To > External Links for
the table or graph.

Related Topics
• Overview of Linking to External Systems with Context

• Structure of a Link to an External System

• Edit a Link to an External System

• Set Up the Application Integration for an External System

Edit a Link to an External System  
You can edit or delete a link to an external system from a report or graph in your Oracle Fusion Cloud Supply Chain
Planning module.

Before you start
You can edit or delete the link only if you created it.

Here's what to do

1. In your table or graph in the Demand Management, Demand or Supply Planning, Planning Central, Replenishment
Planning, Sales and Operations Planning, or Supply Planning work area, click Actions > Manage Links.
The Manage Links dialog box opens.

2. On the To External System tab, select the link that you want to edit.
The linking parameters for the link are displayed.
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3. To edit the link, follow these steps:
a. Click the Edit icon on the toolbar above the link name.

The Edit Link to External System dialog box opens.
b. Change the name, description, application integration, and page path.

Ensure that the link name is unique.
The value in the Base URL field is populated according to the selected application integration and can't be
changed.

Ensure that the page path doesn't contain the host or port details because they're derived from the
application integration.

c. Click OK.
4. To edit the linking parameters, follow these steps:

◦ To add a parameter, click the Add Row icon for the linking parameters.

In the new row that appears, specify the dimension, level, parameter name, value, and date format.

Ensure that the parameter name is unique.

◦ To modify a parameter, click it, and change the values for the dimension, level, parameter name, value, and
date format.

Ensure that the parameter name is unique.

◦ To delete a parameter, select it, and click the Delete icon for the linking parameters.

You can delete the parameter only if at least one valid combination of a parameter and value remains for
the link.

5. To delete the link, follow these steps:
a. Click the Delete icon on the toolbar above the link name.
b. Click Yes in the displayed dialog box.

6. Click Save and Close.

Related Topics
• Overview of Linking to External Systems with Context

• Structure of a Link to an External System

• Create a Link to an External System

• Set Up the Application Integration for an External System

Use a Link to an External System  
This topic explains how you can use a link to an external system from a table or graph in your Oracle Fusion Cloud
Supply Chain Planning module.

29



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 2
Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Prerequisites for Using Links to an External System
You can use the link to an external system if these conditions are met:

• You must have the privileges to view the data in the external system.

Otherwise, you can't view the data in the external system when you click the link.

• The application integration for the external link must exist.

• You can open the link only if it has at least one valid combination of a parameter and value.

After the link is configured, if the underlying table or graph is edited, and dimensions are removed, the affected
combinations of parameters and values are automatically deleted. Consequently, the link might become invalid.

• You must select a cell, column, or row of the table or an area of the graph before clicking the link.

• You must select values for the levels that have been configured in the link.

Otherwise, an error message is displayed.

Tip:  To identify the required levels, examine the configuration of the link on the To External System tab in the
Manage Links dialog box.

• You must select a value that's associated with or assigned to a level and then click the link.

• You can select multiple values only if they're contiguous.

1. In the Demand Management, Demand and Supply Planning, Planning Central, Replenishment Planning, Sales and
Operations Planning, or Supply Planning work area, open your table or graph.

2. Make a selection.
3. Click Actions > Drill To > External Links, and select a link.

The external link opens on a new tab of your web browser.

What to do next
Note these additional points while using links to external systems:

• Every time you click the link to the external system, it opens on a new tab of your web browser.

• After clicking the link, if you change the selection in your table or graph, the data on the page or report in the
external system isn't refreshed.

You must click the link anew to view the external system data on a new tab of your web browser according to
the changed context in your table or graph.

Related Topics
• Overview of Linking to External Systems with Context

• Structure of a Link to an External System

• Set Up the Application Integration for an External System

• Create a Link to an External System
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Graph Layout Options  
The graph layout option is available in the Selector Tool dialog box, on the Layout tab when you create or edit a graph
using the Manage Tables, Graphs, and Analysis Sets option.

In the Graph Layout Options section, you can define the type of graph and configure layouts and the dimension of axes.
In the Filters section you can specify the filter criteria that you want displayed in the graph.

The layout options vary according to the type of graph. For example, a bar graph has X and Y-axis layout options
whereas a Pie chart doesn't have any X or Y axis. General Options is common for all layout options and includes generic
information for a graph such as title, font, and position of the graph. You can also preview a graph from the Layout
tab before you save the graph. In the preview mode, you can format measures, change the layout, and modify the drill
settings.

The following types of graphs are available:

• X and Y axes graphs

◦ Vertical bar

◦ Horizontal bar

◦ Line graph

• X and Y axes graphs with additional parameters

◦ Area graph

◦ Combination graph

◦ Bubble graph

• Pie graph

• Sunburst graph and Treemap graph

• Funnel graph and Radar graph

• Gauge graph

For graphs with an X, Y, or dual Y axes, you can select up to three entities in total: measures are mandatory, and you can
select one or two dimension hierarchies. A dual Y-axis graph requires the measures on the Y axis. You must select one
measure for the Y2 axis in the Y2 -Axis panel. Axis title and tick label rotation options are available for all axes. Tick label
options are also available for the X-axis. For example, skip a certain number of labels for legibility. The Formatting panel
contains visual effect options for the graph, such as 2 dimension or 3 dimension, and bar or line style.

Here's additional information about some of the graphs:

Graph Type Comments

Combination
 

A Combination graph includes an area, bar, and line. The measures represented by each of these
options are specified in the Formatting panel.
 

Bubble
 

A Bubble graph requires selections for the bubble component of the graph in addition to the X and Y
axes options. Select the hierarchy and the bubble sizing measure in the Bubble panel.
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Graph Type Comments

Sunburst
 

A Sunburst graph is comprised of rings. Select the number of rings to display. Each ring represents
a level of the hierarchy. The rings are divided into sectors for each member of the level. The size and
color of the sector is determined by the measures selected for those options.
 

Treemap
 

A Treemap graph is comprised of rectangles. Select the depth of the rectangles for a hierarchy. The
rectangles for a level of the hierarchy are nested within the parent level rectangle. The size and color of
the rectangles are determined by the measures selected for those options.
 

Funnel and Radar
 

Funnel and Radar graphs require only a hierarchy and measure selection.
 

Gauge
 

Gauge graphs, which are used in infotiles, require measures with goals defined.
 

Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Configure Filters for Graphs  
You can configure graphs that specify filter criteria that enables you to page through data in the graph by one or more
hierarchy levels. For example, you might want to filter for product category when analyzing your plan.

After you analyze one product category, you can select another product category to review from the filter bar above the
graph. Specify the filter criteria in the Selector Tool dialog box, Layout tab, Filters section.

The hierarchy levels that you selected on the Hierarchies tab are available to select as filters. You can select one or more
levels of a hierarchy for a filter. However, if you also selected the hierarchy for the X-axis or Y-axis, then you can't select
all of the hierarchy levels for filters. At least one hierarchy level must be used for the X-axis or Y-axis.

The members of the levels that you select are used to filter the data shown in your graph. You can select the level
member value of interest from a set of values in the filter bar above the graph.

Let's work through an example of setting up filters for a graph:

1. In the Selector Tool dialog box, on the Hierarchies tab, select the Time, Product, Organization, and Customer
dimensions.

All levels are selected by default. The levels that you select for the dimensions become visible in the Filters
section.

2. On the Layout tab, in the X-Axis section, select Gregorian Calendar.
3. In the Y-Axis section select the Product hierarchy and Measures.
4. In the Filters section, select to filter on Quarter and Zone.
5. Click Apply and Close.

When you display the graph, you can see the Quarter and Zone filters above the graph. Months are on the X-Axis and
items are on the Y-Axis. The months shown are determined by the selected quarter, based on the Gregorian calendar.
So, for Quarter 1, the graph displays January, February, and March on the X-Axis. Levels not selected on the axes or in
the Filters section, such as Organization, aren't included in the graph.
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For the X-axis and Y-axis, if one or more levels are selected on the Hierarchies tab, such as Year, Quarter, and Month,
the graph displays with the highest level. You can drill to lower levels that aren't selected in the Filters section.

Note:  Filters for graphs are similar to filters for tables. However, you can't drag and drop filters onto the X-axis or Y-
axis of the graph.

Set Your Axis Scale  
Use Axis Scale Options to refine your scale.

• Axis Scale Options applies to the Y axis and Y2 axis and you can use it only for bar, line, area, or combination
graphs.

• Minimum is the starting point of the axis.

• Maximum is the ending point of the axis.

• Increment is the increase in values between maximum and minimum.

Specify the behavior.

• Automatic. Promising automatically adjusts the scale for the Y axis and the Y2 axis.

• Manual. You have to manually specify the scale for the Y axis and the Y2 axis.

Assume you set Minimum to 3, Maximum to 10, and Increment to 2. The graph will display 3 as the lowest value, 10 as
the highest value, and 5, 7, and 9 as incremental values for the Y axis or the Y2 axis.

Format How Measures Are Displayed in Tables and
Graphs  
You can make measure formatting changes to tables and graphs to reflect your individual preferences or requirements
for how you want the tables or graphs to display.

For example, you can override the name of a measure and its measure of unit. When you format measures in a planning
table or graph, your measure formatting can't be overridden by another user. Any formatting changes done by other
users, including the owner of the table or graph, don't take precedence over your changes. To make user-specific
measure formatting changes, open a table or graph and select View > Format Measures to open the Format Measures
dialog box.

If you're the owner of the table or graph, then your formatting changes are visible to you and to other users who haven't
defined their own formatting. These changes can include overriding the measure label, applying conditional formatting,
or changing the unit of measure that you want displayed in your table or graph. Formatting changes made by others
won't impact your specific measure formatting.

If you're not the owner of the table or graph, then any measure formatting you define takes precedence over the
owner's measure formatting and is visible only to you. For example, if you change decimal positions to 0 (zero) for all
measures in a table, you're the only user that sees those changes. When you save your measure formatting, you'll no
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longer see future formatting changes made by the table or graph owner. For example, if you save measure formatting
and then the table owner adds conditional formatting on a measure, you won't see that conditional formatting.

Use the Reset to Default button in the Format Measures dialog box to remove your user-specific measure formatting.

• If you're the owner of the table or graph, then your measure formatting is removed. Any measure formatting by
non-owners won't be impacted.

• If you're not the owner of the table or graph, then all of your measure formatting is removed. The table or graph
displays all existing measure formatting saved by the owner of the table or graph.

If you duplicate a measure, the duplicated measure is added as the last measure in the table. For example, you can
duplicate a measure with a different currency or unit of measure. If you're the owner of the table, the duplicated
measure is visible to you and to other users who haven't defined their own formatting. If you're not the owner of the
table, the duplicated measure is visible only to you. You can reorder the duplicated measures, but you must save your
layout to preserve the measure order.

You can make user-specific measure formatting changes in the following work areas:

• Demand Management

• Demand and Supply Planning

• Planning Central

• Replenishment Planning

• Sales and Operations Planning

• Supply Planning

Configure Color by Measure to Display in Graphs  
You can configure the color by measure and then use that color for every graph that the measure appears in. For
example, always show Final Shipments Forecast in blue and Final Sales Forecast in green.

This functionality is helpful when viewing a specific measure in several graphs in one layout. You can also specify the
color to display for a measure in a specific graph.

The configure color by measure to display in graphs functionality is available in the following Supply Chain Planning
work areas:

• Demand Management

• Demand and Supply Planning

• Planning Central

• Replenishment Planning

• Sales and Operations Planning

• Supply Planning

Configure Color by Measure for All Graphs
When you configure graphs, you can have a consistent color for a specific measure in your graphs. For example, you
have multiple graphs that display the forecast. You can quickly identify the forecast measure by using the same color for
the measure in all of your graphs.
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To configure a graph color for a specific measure to use in all graphs, select the graph color for the measure in the Edit
Measure dialog box.

1. In a Supply Chain Planning work area, click the Tasks panel tab.
2. In the Tasks panel drawer, click the Manage Planning Measures link in the Configuration section.
3. On the Manage Planning Measures page, select a measure, click Actions, and then select Edit.
4. In the Edit Measure dialog box, click the Advanced tab.
5. In the Properties subtab, click the Graph Color drop down arrow and select a color to use for the measure in all

graphs.

Configure Color by Measure for a Specific Graph
You can configure a color for a measure in a specific graph, which overrides the color configured for the measure in the
Edit Measure dialog box.

To configure a graph color for a specific measure for a specific graph, select the graph color for the measure in the
Format Measures dialog box.

1. In an open table or graph, click View and then select Format Measures.
2. In the Format Measures dialog box, in the Graph Color column, click the drop down arrow and select a color to

use.

Automatically Assign Graph Color
If a graph color is already configured for a measure for all graphs, but you want the graph color assigned automatically
for that measure for a specific graph, then select the Assign Graph Color Automatically check box on the Format
Measures page.

1. In an open table or graph, click View and then select Format Measures.
2. In the Format Measures dialog box, in the Assign Graph Color Automatically column, click the check box in

the row for the measure.

Tips and Considerations for Assigning Graph Colors to Measures
The following is additional information about the configure color by measure to display in graphs functionality:

• Duplicate Colors: You might have a situation where you have two measures with the same color in a graph.
If the color you configure for a measure is the same color as one of the colors automatically assigned to a
measure in a specific graph, then you must select a different color for the measure you're configuring.

• Predefined measures: By default, predefined measures initially don't have a graph color selected on the
Manage Planning Measures page. In this case, when used in a graph the planning process automatically
assigns a color for the measure.

• Bar, line, and radar graphs: Only measures located in the Y-axis display the graph color settings. This is only in
case the measures aren't combined with one or more hierarchies in the Y-axis. Automatically-assigned colors
are used in this case.

• Plan Comparison: When comparing plans, the configured measure color in the graph is honored only for the
measure itself. The measures that represent the compared plans get an automatically-assigned color, selected
randomly by the planning process.

• Archive Plan: When archiving a plan and using Waterfall Analysis or Trend Analysis graphs, the configured
measure color is honored only for the measure itself. The measures that represent the archive get an
automatically-assigned color, selected randomly by the planning process.
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• Export and Import: When exporting and importing measure settings from one environment to another, the
export and import keeps the graph color settings in Manage Planning Measures and Format Measures.

• Graph Types: The graph color functionality isn't available for the following graph types:

◦ Pie

◦ Sunburst

◦ Treemap

◦ Gauge

◦ Funnel

◦ Bubble

Related Topics
• How You Manage Planning Measures

• Predefined Measures in Supply Chain Planning

How You Can Edit Measures at an Aggregate Time Level 

This topic explains how you can edit measures at an aggregate time level in tables in demand, demand and supply,
replenishment, sales and operations, and supply plans.

You can edit a measure with an edit range that's set to only the future at an aggregate time level in only those table cells
that don't contain time periods for the past. For example, if the current date is Wednesday, August 11, 2021, and you're
viewing the data at a weekly level, you can't edit the forecast for the week starting August 09 or any aggregate level
such as the year 2021. Instead, you can edit the forecasts for the days of August 11 and later as well as the weeks starting
August 16 and later.

You can edit a measure with an edit range that's set to only the history at an aggregate time level in only those table
cells that don't contain time periods for the future. For example, if the current date is Wednesday, August 11, 2021, and
you're viewing the data at a weekly level, you can't edit the history for the year 2021. Instead, you can edit the history for
the days before August 11 and the weeks starting August 02 and earlier.

The same behavior applies when you summarize data across time in tables. For example, the Adjusted Shipments
Forecast measure has an edit range that's set to only the future. If you summarize the measure by time in a table, the
summarized value is editable only if all the included values are editable. If the current month is August 2021, you can't
edit the summary for 2021, but you can edit the summary for 2022.

The same behavior also applies to plans with aggregate planning time levels. For example, if the planning time level
is week, and the current month is August 2021, you can't edit measures at aggregate time levels such as quarter and
year if the underlying weeks aren't editable. Instead, you can view the data at the weekly level to update the values for
editable weeks.

The edit ranges of measures are enforced at the Hybrid time level in demand plans. For example, for the week starting
Monday, December 31, 2029, there are two Hybrid time level members, one starting on Monday, December 31, 2029,
and the other starting on Tuesday, January 01, 2030. If the forecasting time level is set to week, and the plan is run on
Wednesday, January 02, the forecast would begin on Monday, December 31. But, the first Hybrid time level member is
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before the plan run date and considered as history. Therefore, any measure with an edit range that's set to the future,
such as Adjusted Shipments Forecast, isn't editable for the first Hybrid time level member.

Thus, data integrity is ensured because you can't make changes to the values of measures outside of their configured
edit ranges.

How Time Periods Are Calculated and Displayed in
Tables, Graphs, and the Selector Tool  
This topic explains how time periods are calculated and displayed in tables, graphs, and the Selector Tool in the Demand
Management, Demand and Supply Planning, Planning Central, Replenishment Planning, and Sales and Operations
Planning work areas.

Settings That Affect the Calculation and Display of Time Periods
The following settings affect the calculation and display of time periods in tables and graphs for a demand, demand and
supply, replenishment planning, or sales and operations plan:

• The value in the Demand History Days field in the Demand: Advanced Options dialog box that you open from
the Demand tab on the Plan Options page

• The selection on the Time Range tab of the Advanced Filter dialog box that's available on the Members tab in
the Selector Tool

• The selected members for the Time dimension on the Members tab in the Selector Tool

• Shared measures

The following settings affect the calculation and display of available members for the Time dimension on the Members
tab in the Selector Tool for the plan:

• The value in the Demand History Days field

• The planning horizon

The default value for the Demand History Days field is 182 days.

Note:  If data isn't available, blank rows are displayed for the time periods included in tables and graphs. Also, the
amount of historical data that's considered for the forecast depends on the value in the Historical Buckets field on
the Demand tab on the Plan Options page.

How Time Periods Are Calculated and Displayed
Time periods are calculated and displayed in a table or graph as follows:

• If you select members of the Time dimension on the Members tab in the Selector Tool, they're displayed in the
table or graph.

• If you don't select members of the Time dimension on the Members tab in the Selector Tool, time periods are
displayed as follows:
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◦ If the table or graph has shared measures, time periods are displayed for the combination of the demand
history days and planning horizon.

◦ If the table or graph doesn't have shared measures, time periods are displayed for the planning horizon.

The display of available members for the Time dimension on the Members tab in the Selector Tool is for the
combination of the demand history days and planning horizon.

Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Manage Measure Data in Tables  

How You Can Edit Measure Data  
While working in one of the Supply Chain Planning work areas, you might be editing measure data in a table.

The following table provides a list of some features you can use when doing so, and where each feature is located:

Feature Location

Configure Summaries
 

View menu
 

Data Calculation Options
 

Table toolbar
 

Lock and Unlock Cells
 

If at least one summary is configured:
 
Action menu, table toolbar, right-click in cell
 

Related Topics
• Manage Data Calculations When Editing Measure Data in a Supply Chain Planning Table

• How You Lock Cells While Editing Measure Data or Allocating Values in a Table

Copy and Paste Values in Tables  
Use the Copy and Paste options in the Actions menu for a table to copy cell values and paste them in editable cells. You
can also copy values from one table to another within the same plan.

Pasting overwrites any existing values, and any measures that are dependent on the overwritten measures are
recalculated.
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If your data is in an external application such as Microsoft Excel, you can use the following procedure to copy and paste
your data:

1. Copy your data from the external application.
2. In your work area table, click the first editable cell from which you want the data to be pasted, and select

Actions > Paste from Clipboard. The Paste from Clipboard dialog box opens.
3. Press Ctrl+V to paste your content in the dialog box. You can further edit your data in the dialog box.
4. Click Paste and Close. The copied content is pasted into the editable cells of the table.

Alternatively, you can export your table data to Microsoft Excel using the Export icon, work with your data in that
application, copy your data, and bring it back into your table by using the Paste from Clipboard option. To copy data
between plans, export the table data to Microsoft Excel from one plan, and use the Paste from Clipboard option to
copy data into the other plan.

Note:  You can paste values in only those cells that fall within your plan horizon. The number and orientation of the
cells from which data is copied and the cells into which data is pasted must match. Only numeric data can be copied
and pasted. Non-editable cells that are within a range of editable cells are skipped when data is pasted, and a warning
is displayed to this effect.

Related Topics
• How can I highlight editable cells in a table?

Manage Data Calculations When Editing Measure Data in a Supply
Chain Planning Table  
When you are working in a Supply Chain Planning work area, you might be editing measure data in tables that include
dependent measures.

You can use the Data Calculation Options menu to determine when calculations are performed. You access the Data
Calculation Options menu from the table toolbar for the table you are editing.

The Data Calculation Options choices are:

• Enable Automatic Calculations

• Calculate Now

Enable Automatic Calculations
When you edit data with this option selected, each time you edit a value, calculations are performed for any applicable
summaries or other measures that include an expression. The Enable Automatic Calculations choice is the default
selection.

Calculate Now
To choose when calculations are performed, you must first deselect Enable Automatic Calculations. When you make
edits with the Enable Automatic Calculations choice deselected, you must click the Calculate Now choice when you want
calculations to be performed. Calculations will be performed for all edits made since the last time calculations were
performed.

If you save a table after making edits, any needed calculations will be performed, but you must refresh the table to see
the results.
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How You Lock Cells While Editing Measure Data or Allocating
Values in a Table  
When you are working in a Supply Chain Planning work area, you might be editing measure data in a table.

When you have locked cells, edits, including those that spread allocations to other cells, do not change locked cells.

Note:  You must configure at least one summary to enable the Lock and Unlock actions.

Lock cells by performing one of the following:

• Click the Lock action in the Actions menu.

• Click the Lock icon on the table toolbar.

• Right-click in an editable cell.

Related Topics
• How do I enable the Lock and Unlock actions for a table while editing measure data in a Supply Chain Planning

table?

• Can I unlock all cells at once while editing measure data in a Supply Chain Planning table?

How can I highlight editable cells in a table?  
In the View menu for a table, select Highlight Editable Cells to provide a background color for cells that contain editable
measures.

Do note that any conditional formatting that has been applied to an editable measure or a table takes precedence over
the highlight color. You can choose to save your page layout with this setting.

Predefined Tables, Graphs, and Infotiles for
Replenishment Planning  

Predefined Tables for Replenishment Planning  
You can use predefined tables to get insights into various aspects of your replenishment plans.

Pivot Tables for Inventory Policies
These pivot tables pertain to inventory policies for replenishment plans:
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Name Based on Use Available Drills

Fill Rate by Item Location • Fill Rate Shortfall Percentage
measure

• Projected Fill Rate measure

• Target Fill Rate measure

View the fill rates for items at a
particular location.

Note:  Before running your
replenishment plan, set up the
Target Fill Rate measure in a
table with a row or column for
each segment.

• Manage Policy Parameters by
Item table

• Replenishment Workbench
table

Manage Policy Parameters by Item • Adjusted EOQ measure

• Adjusted Maximum Days
measure

• Adjusted Maximum Quantity
measure

• Adjusted Minimum Days
measure

• Adjusted Minimum Quantity
measure

• Adjusted ROP Days measure

• Adjusted ROP Quantity
measure

• EOQ measure

• Final EOQ measure

• Final Maximum Days measure

• Final Maximum Quantity
measure

• Final Minimum Days measure

• Final Minimum Quantity
measure

• Final ROP Days measure

• Final ROP Quantity measure

• Maximum Days measure

• Maximum Quantity measure

• Minimum Days measure

• Minimum Quantity measure

• On Hand measure

• Policy Type measure

• Policy UOM measure

• ROP Days measure

• ROP Quantity measure

• Safety Stock measure

• Review the calculated policy
parameters for an item-
location combination.

• Manually change the policy
parameters to simulate
solutions to issues.

• Items table

• Replenishment Workbench
table

• Supplies and Demands table

Planned Orders by Location • Orders Released
Automatically measure

Review the counts of automatically
released orders and planned orders
for item-location combinations.

Supplies and Demands table
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• Total Planned Orders measure

Policy Analysis by Segment - Table • Fill Rate Shortfall Percentage
measure

• Item Locations Planned
measure

• Item Locations with Fill Rate
Violations measure

• Item Locations with Safety
Stock Violations measure

• Item Locations with Stockouts
measure

• Stockout Cost measure

View the number of planned item-
location combinations, number of
item-location combinations with
fill-rate violations, and so on by
segment.

• Fill Rate by Item Location
table

• Manage Policy Assignments
table

Policy Comparison Summary by
Location

• Policies Automatically
Accepted measure

• Policies to Review measure

View the counts of items
with policies for review and
automatically accepted policies at a
location.

Manage Policy Comparison table

Policy Review Status by Segment • Policies Automatically
Accepted measure

• Policies Manually Accepted
measure

• Policies Reviewed measure

• Policies Retained measure

• Policies to Review measure

View the counts of item-location
combinations within a segment
with various policy review statuses.

• Manage Policy Comparison
table

• Policy Comparison Summary
by Location table

Replenishment Policy Parameters • Adjusted EOQ measure

• Adjusted Maximum Days
measure

• Adjusted Maximum Quantity
measure

• Adjusted Minimum Days
measure

• Adjusted Minimum Quantity
measure

• Adjusted ROP Days measure

• Adjusted ROP Quantity
measure

• Average Daily Demand
measure

• EOQ measure

• Final EOQ measure

• Final Maximum Days measure

• Final Maximum Quantity
measure

• Final Minimum Days measure

Review the calculated policy
parameters by item-location
combination.

• Items table

• Manage Policy Assignments
table

• Replenishment Workbench
table

• Supplies and Demands table
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• Final Minimum Quantity
measure

• Final ROP Days measure

• Final ROP Quantity measure

• Item Order Quantity measure

• Maximum Days measure

• Maximum Quantity measure

• Minimum Days measure

• Minimum Quantity measure

• Policy Type measure

• Policy UOM measure

• ROP Days measure

• ROP Quantity measure

• Safety Stock measure

Replenishment Workbench • Adjusted Maximum Quantity
measure

• Adjusted Minimum Quantity
measure

• Adjusted Shipments Forecast
measure

• Beginning Inventory Position
measure

• Final Inventory Position
measure

• Final Maximum Quantity
measure

• Final Minimum Quantity
measure

• Final Shipments Forecast
measure

• Gross Forecast measure

• Maximum Quantity measure

• Minimum Quantity measure

• Net Forecast measure

• On Hand measure

• On Order measure

• Planned Replenishments by
Due Date measure

• Planned Replenishments by
Order Date measure

• Projected Available Balance
measure

• Purchase Orders measure

View the time-phased supplies,
demands, and projected inventory
levels for an item-location
combination.

• Inventory Sawtooth graph

• Items table

• Manage Policy Assignments
table

• Replenishment Policy
Parameters table

• Supplies and Demands table
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Name Based on Use Available Drills

• Safety Stock measure

• Sales Orders measure

• Scheduled Receipts measure

• Total Demand measure

• Total Supply measure

• Transfer Orders measure

Suggested Replenishment Policy
Parameters

• Suggested Average Daily
Demand measure

• Suggested EOQ measure

• Suggested Maximum Days
measure

• Suggested Maximum
Quantity measure

• Suggested Minimum Days
measure

• Suggested Minimum Quantity
measure

• Suggested Order Quantity
measure

• Suggested Policy Type
measure

• Suggested Policy UOM
measure

• Suggested ROP Days
measure

• Suggested ROP Quantity
measure

• Suggested Safety Stock
measure

View the suggested policy
parameters by item-location
combination for a policy
comparison plan.

• Items table

• Manage Policy Assignments
table

• Replenishment Workbench
table

• Supplies and Demands table

Pivot Tables for Inventory Rebalancing
These pivot tables pertain to the inventory rebalancing functionality for replenishment plans:

Name Based on Use Available Drills

Cluster Analysis by Quantity Planned Shipments Quantity
measure

• View the rebalancing
recommendations for a
cluster.

• View the rebalancing
recommendations for a
specific shipping lane that
consists of a source location
and a destination location.

• View the highlighted
top 10% of rebalancing

Manage Rebalancing
Recommendations table
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recommendations by
quantity.

Cluster Analysis by Value Planned Shipments Value measure • View the rebalancing
recommendations for a
cluster.

• View the rebalancing
recommendations for a
specific shipping lane that
consists of a source location
and a destination location.

• View the highlighted
top 10% of rebalancing
recommendations by value.

Manage Rebalancing
Recommendations table

Rebalancing Analysis • Gross Forecast measure

• Initial Excess for Rebalancing
measure

• Initial Shortage for
Rebalancing measure

• Net Forecast measure

• On Hand measure

• Planned Inbound Shipments
measure

• Planned Outbound
Shipments measure

• Projected Available Balance
measure

• Projected Inventory measure

• Purchase Orders measure

• Reserved Safety Stock
measure

• Safety Stock measure

• Sales Orders measure

• Transfer Orders measure

• Perform time-phased analysis
of the inventory rebalancing
recommendations for an
item-location combination.

• Review the planned inbound
and planned outbound
shipments.

• Analyze how various
measures are calculated.

• Items table

• Rebalancing Details by Item
Location table

Rebalancing Details by Item
Location

• Excess After Rebalancing
measure

• Excess Before Rebalancing
measure

• Excess Computation Window
measure

• Planned Inbound Shipments
measure

• Planned Outbound
Shipments measure

• Shortage After Rebalancing
measure

• Review the excess inventory
and inventory shortage for
an item across the locations
within a cluster.

• Review the windows for
computing the excess
inventory and inventory
shortage for all locations in a
cluster.

Items table
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• Shortage Before Rebalancing
measure

• Shortage Computation
Window measure

Shortages by Item Location • Item Locations with Safety
Stock Violations measure

• Item Locations with Stockouts
measure

• Revenue measure

Identify the items that are out of
stock at locations.

• Manage Policy Parameters by
Item table

• Replenishment Workbench
table

Other Pivot Tables for Replenishment Planning
These are other pivot tables that are available for replenishment plans:

Name Based on Use Available Drills

Analyze Consumption Demand:
Item and Organization, Daily

• Adjusted Consumption
Forecast measure

• Adjusted Consumption
History measure

• Consumption Forecast
measure

• Consumption Forecast MAPE
measure

• Consumption Forecast Status
measure

• Consumption History
measure

• Consumption History Average
measure

• Final Consumption Forecast
measure

• Final Consumption History
measure

Review the consumption and
forecast by item-location
combination in daily buckets.

NA

Analyze Consumption Demand:
Item and Organization, Monthly

• Adjusted Consumption
Forecast measure

• Adjusted Consumption
History measure

• Consumption Forecast
measure

• Consumption Forecast MAPE
measure

• Consumption Forecast Status
measure

• Consumption History
measure

Review the consumption and
forecast by item-location
combination in monthly buckets.

NA
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Name Based on Use Available Drills

• Consumption History Average
measure

• Final Consumption Forecast
measure

• Final Consumption History
measure

Analyze Demand: Item and
Organization, Monthly

• Adjusted Shipments Forecast
measure

• Adjusted Shipments History
measure

• Final Shipments Forecast
measure

• Final Shipments History
measure

• Sales Orders measure

• Shipments Forecast measure

• Shipments Forecast Bias
measure

• Shipments Forecast MAD
measure

• Shipments Forecast MAPE
measure

• Shipments History measure

Review the shipments history
and forecast by item-location
combination in monthly buckets.

NA

Forecast Consumption Definitions • Consumption Forecast
measure

• Final Consumption History
measure

View the final consumption history
and consumption forecast by item
and organization.

NA

Forecast Shipments Definitions • Final Shipments Forecast
measure

• Final Shipments History
measure

• Shipments Forecast measure

View the final shipments history,
 shipments forecast, and final
shipments forecast by item and
organization.

NA

Manage Forecast During Product
Life Cycle

• Change to Shipments
Forecast Percentage measure

• Adjusted Discontinuation
Date measure

• Adjusted Launch Date
measure

• Adjusted Shipments Forecast
measure

• Discontinuation Date
measure

• Final Discontinuation Date
measure

Manage the shipments or bookings
forecast for products.

NA
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• Final Launch Date measure

• Final Shipments Forecast
measure

• Launch Date measure

• Shipments Forecast measure

Manage Product Life Cycle by Item
and Date

• Adjusted Discontinuation
Date measure

• Adjusted Launch Date
measure

• Discontinuation Date
measure

• Final Discontinuation Date
measure

• Final Launch Date measure

• Launch Date measure

• Shipments Forecast Status
measure

Modify the launch and
discontinuation dates for products.

Manage Forecast During Product
Life Cycle table

Other Tables for Replenishment Plans
These are other tables that are available for replenishment plans.

Name Use Available Drills

Exceptions Review the custom exceptions for
replenishment plans. Seeded exceptions for
replenishment plans aren't supported.

NA

Item Relationships Review the relationships, such as end item
substitution or supersession, defined between
items.

• Items table

• Supplies and Demands table

Items Review the attributes for item-location
combinations.

• Item Relationships table

• Manage Policy Comparison table

• Manage Policy Parameters by Item table

• Manage Rebalancing Recommendations
table

• Replenishment Policy Parameters table

• Replenishment Workbench table

• Suppliers table

• Supplies and Demands table

Manage Policy Assignments • Review and simulate changes to the policy
parameters, default policy parameters,
 and policy parameter overrides at the
segment level.

NA
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Name Use Available Drills

• View the policy overrides for item-location
combinations.

Manage Policy Comparison • Review and manage the policy
comparison process.

• Accept, review, or update policy
suggestions.

• Manage Policy Parameters by Item table

• Replenishment Policy Parameters table

• Suggested Replenishment Policy
Parameters table

Manage Rebalancing Recommendations • View the planned orders that are
recommended after inventory
rebalancing.

• Manually release the planned orders.

• Items table

• Rebalancing Analysis table

• Rebalancing Details by Item Location table

Suppliers Review the details of approved suppliers for an
item.

• Items table

• Supplies and Demands table

Supplies and Demands • View the details of supplies and demands,
 create supplies and demands, and
perform simulations.

• Review the details of replenishment
orders, and manually release them.

• Item Relationships table

• Items table

• Replenishment Policy Parameters table

• Replenishment Workbench table

• Suppliers table

Related Topics
• Predefined Graphs for Replenishment Planning

• Predefined Infotiles for Replenishment Planning

Predefined Graphs for Replenishment Planning  
You can use predefined graphs to get insights into various aspects of your replenishment plans.

Name Format Based on Use Available Drills Associated with

Excess by Cluster Vertical bar graph • Item Locations
with Excess After
Rebalancing
measure

• Item Locations
with Excess
Before
Rebalancing
measure

Use this graph to
view the total counts
of item-location
combinations with
excess inventory
before and after
rebalancing.

• Cluster Analysis
by Quantity table

• Cluster Analysis
by Value table

• Manage
Rebalancing
Recommendations
page

Rebalancing
Performance infotile

Fill Rate Performance
by Segment

Vertical bar graph • Projected Fill
Rate measure

• Compare the
targeted and
projected fill
rates by segment.

• Fill Rate by Item
Location table

Policy Effectiveness
infotile
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Name Format Based on Use Available Drills Associated with

• Target Fill Rate
measure

• Review how
effectively
your policies
are driving
replenishments.

Note:  Before
running your
replenishment plan,
 set up the Target
Fill Rate measure in
a table with a row
or column for each
segment.

• Manage Policy
Assignments
page

Inventory Sawtooth
Graph

Combination graph • Beginning
Inventory
Position measure

• Final Maximum
Quantity
measure

• Final Minimum
Quantity
measure

• On Order
measure

• Planned
Replenishments
by Due Date
measure

• Projected
Available Balance
measure

• Safety Stock
measure

View the time-phased
inventory levels for
an item-location
combination.
 

Note:  When the
line representing
the projected
available balance
strays into negative
territory often, it's
a sign of frequent
stockouts and poor
setup of inventory
policies. When the
projected available
balance is above
the safety stock, the
inventory position
is healthy. When the
line representing
the beginning
inventory position
goes into the
band representing
the safety stock,
 replenishments are
triggered.

NA NA

Inventory and Safety
Stock by Segment

Bubble graph • Projected
Available Balance
measure

• Projected
Available Balance
Value measure

• Safety Stock
measure

• Review aggregate
inventory levels
by segment at
the end of the
planning horizon.

• View the
projected
available
balance, value
of projected
available balance,
 and safety stock
by segment.

Manage Policy
Assignments page

• Inventory
Turnover Ratio
infotile

• Policy
Effectiveness
infotile

• Total Inventory
Value infotile
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Name Format Based on Use Available Drills Associated with

PAB and Safety Stock
by Segment

Vertical bar graph • Projected
Available Balance
measure

• Safety Stock
measure

View and compare the
projected available
balance and safety
stock by segment.

NA Inventory Turnover
infotile

Policy Analysis by
Segment - Spider
Graph

Absolute radar graph • Fill Rate Shortfall
Percentage
measure

• Item Locations
Planned measure

• Item Locations
with Fill Rate
Violations
measure

• Item Locations
with Safety
Stock Violations
measure

• Item Locations
with Stockouts
measure

• Stockout Cost
measure

View the number
of planned
item-locations
combinations, number
of item-location
combinations with fill-
rate violations, and so
on by segment.

• Fill Rate by Item
Location table

• Manage Policy
Assignments
page

Segment Analysis
infotile

Policy Comparison
Summary by Segment

Vertical bar graph • Policies
Automatically
Accepted
measure

• Policies to Review
measure

View the counts
of item-location
combinations with
policies for review
and automatically
accepted policies for
each segment.

• Manage Policy
Comparison page

• Policy
Comparison
Summary by
Location table

Policy Comparison
infotile

Shipments Forecast
MAPE by Segment

Tree map graph • Final Shipments
Forecast
measure

• Shipments
Forecast MAPE
measure

View the mean
average percentage
error (MAPE) for the
shipments forecast by
segment.

NA Shipment Forecast
MAPE infotile

Shortages by Cluster Vertical bar graph • Item Locations
with Shortage
After
Rebalancing
measure

• Item Locations
with Shortage
Before
Rebalancing
measure

View the total counts
of item-location
combinations in a
cluster with inventory
shortages before and
after rebalancing.

• Cluster Analysis
by Quantity table

• Cluster Analysis
by Value table

• Manage
Rebalancing
Recommendations
page

Rebalancing
Performance infotile

Shortages by Segment Vertical bar graph • Item Locations
with Safety
Stock Violations
measure

View the counts
of item-location
combinations with
stockouts and safety-

Shortages by Item
Location table

Policy Execution
infotile
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Name Format Based on Use Available Drills Associated with

• Item Locations
with Stockouts
measure

stock violations by
segment.

Supply Details by
Segment

Vertical bar graph • Orders Released
Automatically
measure

• Total Planned
Orders measure

Compare the number
of automatically
released orders
with the number of
planned orders by
segment.

Planned Orders by
Location table

Policy Execution
infotile

Related Topics
• Predefined Tables for Replenishment Planning

• Predefined Infotiles for Replenishment Planning

Predefined Infotiles for Replenishment Planning  
You can use predefined infotiles to get insights into various aspects of your replenishment plans.

Name Format Based on Use Associated with Available in

Inventory Turnover
Ratio

Status meter gauge Inventory Turns
measure
Set the goals for the
measure to configure
the infotile. The
available colors are
red, yellow, and green.
 

Review the inventory
turnover ratio for your
plan, and compare the
ratio with the set goal.

• PAB and
Safety Stock by
Segment graph

• Inventory and
Safety Stock by
Segment graph

NA

Policy Comparison Horizontal bar • Policies to Review
measure

• Policies
Automatically
Accepted
measure

View the counts
of item-location
combinations
with automatically
accepted policies and
policies for review.

• Policy
Comparison
Summary by
Segment graph

• Policy Review
Status by
Segment table

NA

Policy Effectiveness LED gauge Projected Fill Rate
measure
Set the goals for the
measure to configure
the infotile. The
available colors are
red, yellow, and green.
 

• View the
projected fill rate
at the plan level.

• Review how
effectively your
policies are
driving your
replenishments.

• Fill Rate
Performance by
Segment graph

• Inventory and
Safety Stock by
Segment graph

• Demand and
Replenishment
Plan Summary
page layout

• Replenishment
and Rebalancing
Plan Summary
page layout

• Replenishment
Plan Summary
page layout
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Name Format Based on Use Associated with Available in

Policy Execution Horizontal bar • Item Locations
with Stockouts
measure

• Orders Released
Automatically
measure

• Analyze how
many item-
location
combinations
had stockouts at
least once in the
planning horizon

• See how many
replenishment
orders were
automatically
released

• Decide whether
your policies are
ordering enough
material to keep
the inventory at
the right level

• Shortages by
Segment graph

• Supply Details by
Segment graph

• Demand and
Replenishment
Plan Summary
page layout

• Replenishment
and Rebalancing
Plan Summary
page layout

• Replenishment
Plan Summary
page layout

Rebalancing
Performance

Horizontal bar • Percentage
of Item
Locations with
Shortage Before
Rebalancing
measure

• Percentage
of Item
Locations with
Shortage After
Rebalancing
measure

Review the
percentages of item-
location combinations
with shortages before
and after rebalancing.

• Shortages by
Cluster graph

• Excess by Cluster
graph

Replenishment and
Rebalancing Plan
Summary page layout

Segment Analysis Pie graph Item Locations
Planned measure

Analyze the
performance of each
segment according
to key performance
indicators (KPIs) such
as the number of item-
location combinations
with stockouts, costs
of stockouts, and
number of item-
location combinations
with safety-stock
violations.

• Policy Analysis by
Segment graph

• Policy Analysis by
Segment table

• Demand and
Replenishment
Plan Summary
page layout

• Replenishment
and Rebalancing
Plan Summary
page layout

• Replenishment
Plan Summary
page layout

Shipment Forecast
MAPE

Status meter gauge Shipments Forecast
MAPE measure
Set the goals for the
measure to configure
the infotile. The
available colors are
green, yellow, and red.
 

View the summary
of the mean absolute
percentage error
(MAPE) for the
shipments forecast at
the plan level.

Shipments Forecast
MAPE by Segment
graph

Demand and
Replenishment Plan
Summary page layout

Total Inventory Value Status meter gauge Projected Available
Balance Value
measure
Set the goals for the
measure to configure

• View the total
projected
available balance

Inventory and Safety
Stock by Segment
graph

• Demand and
Replenishment
Plan Summary
page layout

53



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 2
Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

Name Format Based on Use Associated with Available in

the infotile. The
available colors are
red, yellow, and green.
 

value at the plan
level.

• See the projected
available balance
and safety stock
by segment

• Replenishment
and Rebalancing
Plan Summary
page layout

• Replenishment
Plan Summary
page layout

Related Topics
• Predefined Tables for Replenishment Planning

• Predefined Graphs for Replenishment Planning
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3  Planning Analytics

Overview of Planning Analytics  
Configuring planning dimensions and hierarchies on the Configure Planning Analytics page is a key setup to use the
analytics in Supply Chain Planning work areas.

It has a unified dimensional hierarchy for various uses. Depending on your security privilege, you can also open the
Configure Planning Analytics page from the Setup and Maintenance work area by selecting the following:

• Offering: Supply Chain Planning

• Functional Area: Supply Chain Planning Configuration

• Task: Configure Planning Analytics

To run plans successfully, you must complete the following Configure Planning Analytics tasks:

• Set Up Dimension Catalogs

• Set Up Measure Catalogs

• Set Up Levels and Attributes

You can use the default hierarchies for most of the dimensions.

If the default product catalog named Product is not collected, then you must select at least one product hierarchy. If a
default product catalog is collected, then the predefined Product hierarchy is selected as a product hierarchy by default.
You can optionally add or change the product hierarchy. You must include at least one product hierarchy when creating
a dimension catalog.

On the Configure Planning Analytics page, Levels and Attributes tab, you can configure your planning table and graphs
to display descriptions instead of codes for the following entities: Items, Organizations, Resource, Work Center, and
Work Area.

Related Topics
• Considerations for Setting Up Dimension Catalogs

• Configure Planning Analytics

• How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

• How You Use Levels and Attributes in Supply Chain Planning

• Can I modify the default dimension catalog?

Configure Planning Analytics  
To run plans successfully, you must set up dimensions and dimension catalogs, measure catalogs, and levels and
attributes.
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You can open the Configure Planning Analytics task from one of the Supply Chain Planning work areas. Depending on
your security privilege, you can also open the Configure Planning Analytics page from the Setup and Maintenance work
area.

Note:  Default Catalog is the name of the predefined dimension catalog. It contains predefined hierarchies. Oracle
recommends that you make a copy of the Default Catalog if changes are required, instead of editing the default
catalog.

To configure planning analytics:

1. In the Navigator, click one of the Supply Chain Planning work areas or click the Setup and Maintenance work
area.

◦ If you clicked one of the Supply Chain Planning work areas, do the following:

i. Click the Tasks panel tab.
ii. In the Tasks panel drawer, click the Configure Planning Analytics link.

◦ If you clicked the Setup and Maintenance work area, select the following:

- Offering: Supply Chain Planning
- Functional Area: Supply Chain Planning Configuration
- Task: Configure Planning Analytics

2. On the Configure Planning Analytics page, Dimension Catalogs tab, do the following:

a. Create a dimension catalog using the Add Row button, or duplicate the default dimension catalog using
the Duplicate button.

b. Specify what hierarchies to use in the dimension catalog by moving hierarchies from the Available pane
to the Selected pane.

c. Assign the dimension catalog to a plan that will use the set of hierarchies for analysis during the plan
creation from Manage Plans.

3. Each Supply Chain Planning work area has a default measure catalog. Create a new measure catalog to add or
remove measures.

a. Use the Add Row button to create a new catalog or use the Duplicate button to duplicate an existing
catalog.

b. Specify the measures for the catalog by moving the measures from the Available pane to the Selected
pane.

c. Assign the measure catalog to a plan that will use the set of measures during the plan creation from
Manage Plans.

After you create and define a measure catalog, you can select the measure catalog for a plan from the Edit Plan
Options page.

4. Click the Levels and Attributes tab and select the desired dimension and hierarchy.

a. In the Dimension list, select a dimension.
b. Optionally, in the Hierarchy list, select a hierarchy.
c. Click the Search icon button.
d. To change how the level name appears in pivot tables and graphs, select the row and enter the level

name in the Level Name to Display field.

Note:  You can't edit the Level Name to Display field for the lowest level of the hierarchy.
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e. To display a particular member identifier in your tables and graphs, select a dimension (Product,
Organization, or Resource) and level, and then select a value in the Member Identifier to Display
column:

Dimension Level Member Identifier to Display Options

Product
 

Item
 

Item Name, Item Description, Item Name
and Description, or Item Description and
Name
 

Organization
 

Organization
 

Organization Name or Organization Code
 

Resource
 

Resource
 

Resource Code, Resource Name, or
Resource Description
 

Resource
 

Work Center
 

Work Center Code, Work Center Name, or
Work Center Description
 

Resource
 

Work Area
 

Work Area Code, Work Area Name, or
Work Area Description
 

Resource
 

Organization
 

Organization Name or Organization Code
 

Time Quarter Quarter Name or Start Date
The display name you configured on
this page appears for quarter name on
the Fiscal, Manufacturing, and Hybrid
calendars.
 

Time Month Month Name or Start Date
The display name you configured on
this page appears for month name on
the Fiscal, Manufacturing, and Hybrid
calendars.
 

Tip:  The organization level in the Organization dimension and the organization level in the Resource
dimension are separate settings. Oracle recommends that you set them to use the same identifier.

f. To add an attribute for the lowest level of the hierarchy, click the Edit Page button in the Attributes
column.

i. In the Manage Attribute List dialog box, click the Add Row button.
ii. In the Attribute list, select an attribute.

iii. In the Attribute Label text box, enter a label name and click OK.
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5. On the Configure Analytics page, click the Save and Close button.

Related Topics
• How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

• Considerations for Setting Up Dimension Catalogs

• How You Use Levels and Attributes in Supply Chain Planning

• Overview of Planning Analytics

• How You Use Measure Catalogs in Supply Chain Planning

Dimensions and Dimension Catalogs  

How You Use Dimensions and Dimension Catalogs in Supply
Chain Planning  
Oracle Fusion Cloud Supply Chain Planning has hierarchy levels by which you can view, compare, and analyze demands
and supplies of your products over various dimensions, such as geography and organizations.

Oracle Supply Chain Planning uses a single set of dimensions and hierarchies to drive aggregation context for demand
planning, supply planning, embedded analytics, and management analytics.

Oracle Supply Chain Planning provides predefined planning dimensions. Each of those dimensions has a predefined
hierarchy. When you implement the Oracle Supply Chain Planning offering, you must decide which dimensions and
hierarchies to use for demand and supply analysis.

Each dimension catalog has a collection of hierarchies in different dimensions that is enabled for use in the plan
options. By default, all predefined hierarchies are available in Planning Analytics. You can disable certain dimensions
that are not relevant for your plans. For example:

• If you are only using demand plans, then supplier, resource, and order type dimensions may not be relevant

• If you are using sales and operations plans, then the order type dimension is not relevant

The following hierarchies are predefined in Oracle Supply Chain Planning:

• Customer

• Demand Class

• Exception Type

• Order Type

• Organization

• Plan

• Product

• Resource

• Supplier

• Source

• Time
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Access the Configure Planning Analytics page from a Supply Chain Planning work area. Depending on your security
privilege, you can also open the Configure Planning Analytics page from the Setup and Maintenance work area.

• To access the Configure Planning Analytics page from a Supply Chain Planning work area:

a. Click the Tasks panel tab.
b. In the Tasks panel drawer, click the Configure Planning Analytics link

• To access the Configure Planning Analytics page from the Setup and Maintenance work area, select the
following:

◦ Offering: Oracle Supply Chain Planning

◦ Functional Area: Supply Chain Planning Configuration

◦ Task: Configure Planning Analytics

In the Dimension Catalogs tab, several hierarchies are available in various dimensions. You can specify which hierarchy
to use in a particular dimension catalog. For example, you can select an organization type hierarchy, a product type
hierarchy, or a customer hierarchy to use in plans for analysis. After you define a dimension catalog, you can assign it to
a plan that will use the set of hierarchies for analysis.

You can select one of your dimension catalogs to be used as the default dimension catalog in plans. If you do not select
a default catalog, the predefined catalog named Default Catalog is used.

Related Topics
• Considerations for Setting Up Dimension Catalogs

• How can I use dimensions in Supply Chain Planning?

• Overview of Planning Analytics

• What's a dimension in Supply Chain Planning?

• Why You Disable or Enable Dimensions for Supply Plan Measures

Considerations for Setting Up Dimension Catalogs  
Oracle Fusion Cloud Supply Chain Planning provides predefined dimensions, and those dimensions have predefined
hierarchies. The predefined hierarchies are included in the Default Catalog.

Hierarchy Selections for the Customer Dimension
The default Customer hierarchy has the Customer Site, Customer, and Customer Class levels. This default hierarchy is
defined in the Oracle Fusion Trading Community Model, and you can modify it there.

Hierarchy Selections for the Exception Type Dimension
The default Exception Type hierarchy has the Exception Type level.

Hierarchy Selections for the Order Type Dimension
The default Order Type hierarchy has the Order Type and Order Group levels.
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Hierarchy Selections for the Organization Dimension
The default Enterprise hierarchy has the Organization, Business Unit, and Legal Entity levels. This default hierarchy is
defined in Oracle Fusion Cloud HCM, and you can modify it only there. Optionally, you can enable other Organization
hierarchies (based on regions, one per country).

Hierarchy Selections for the Product Dimension
The default Product hierarchy has the Item, Category Level 1, and Category Level 2 levels. You can collect other catalogs
for the Product dimension into Oracle Supply Chain Planning and select the resulting hierarchies.

For Oracle Sales and Operations Planning, the Lifecycle Phase attribute is also included in the default hierarchy.

The Planning catalog is populated into the Product hierarchy.

You must create the Planning catalog in the Product Information Management work area as follows:

• In the Create Catalog dialog box, in the Functional Area field, select Planning.

• In the Controlled At field, select Master Level.

• Select the Assign items to leaf level categories only check box.

• Don't select the Allow multiple item category assignments check box.

• On the Edit Catalog page, on the Details tab, in the Default Category field, select a default category.

On the Edit Catalog page, on the Category Hierarchy tab, you won't be able to create a hierarchy of categories. Under the
root level, you will be able to create only one level of categories.

If you're using the file-based data import (FBDI) template named Supply Chain Planning Catalogs
(ScpCatalogImportTemplate.xlsm), do the following:

• On the Catalogs_ tab, in the Control Level column, enter 1.

• In the Default Indicator column, enter Yes.

• On the CatalogCategoryAssociation_ tab, create a hierarchy of categories if this setup meets your requirements.

• On the ItemCategories_ tab, ensure that items belong to only the lowest-level categories, and that items don't
belong to multiple categories.

If you haven't set up the Planning catalog, the predefined Product hierarchy of the Product dimension is used. The
predefined Product hierarchy has only one predefined item. In this situation, your items won't be available in the default
Product hierarchy, and your items will be available through the other hierarchies that are created for collected catalogs.

Hierarchy Selections for the Resource Dimension
The default Resource hierarchy has the Resource, Work Center, Work Area, and Organization levels. This default
hierarchy is defined in Oracle Manufacturing and you can't modify it.

Hierarchy Selections for the Source Dimension
The default Source hierarchy has the Source level.

Hierarchy Selections for the Supplier Dimension
The default Supplier hierarchy has the Supplier Site and Supplier levels.
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Hierarchy Selections for the Time Dimension
The Gregorian Calendar hierarchy has the Day, Month, Quarter, and Year levels. You can collect other hierarchies for
the Time dimension into Oracle Supply Chain Planning and select them. These hierarchies include workday calendars
of inventory organizations collected from Oracle Fusion Cloud SCM and fiscal calendars collected from Oracle Fusion
Cloud Financial Management.

Related Topics
• How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

• How can I use dimensions in Supply Chain Planning?

• Can I modify the default dimension catalog?

• Overview of Planning Analytics

• Why You Disable or Enable Dimensions for Supply Plan Measures

What's a dimension in Supply Chain Planning?  
A dimension is a structure that organizes data. It categorizes data to enable you to answer business questions.
Commonly used dimensions are customers, products, and time.

Related Topics
• Configure Planning Analytics

• How can I use dimensions in Supply Chain Planning?

• How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

• Considerations for Setting Up Dimension Catalogs

How can I use dimensions in Supply Chain Planning?  
Oracle Fusion Cloud Supply Chain Planning applications come with predefined hierarchies in the Product dimension.

These predefined hierarchies are part of the Dimension catalog structure in Oracle Product Model. Integrations with
Oracle E-Business Suite and third-party systems where the product dimensions can still be maintained and uploaded
for use by the Oracle Supply Chain Planning applications is supported.

Related Topics
• How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

• Considerations for Setting Up Dimension Catalogs

• What's a dimension in Supply Chain Planning?
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What's a dimension catalog in Supply Chain Planning?  
In Oracle Fusion Cloud Supply Chain Planning, a dimension catalog is a selected list of dimensions enabled for use in
plans.

In Oracle Supply Chain Planning, a dimension catalog is a selected list of hierarchies in different dimensions that is
enabled for use in plans. The Default dimension catalog appears by default, but can be changed to another dimension
catalog that has been defined.

Related Topics
• Can I modify the default dimension catalog?

• What's a dimension in Supply Chain Planning?

• Considerations for Setting Up Dimension Catalogs

• How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

Can I modify the default dimension catalog?  
Yes, you can modify the Oracle Fusion Cloud Supply Chain Planning default dimension catalog. However, if you want to
make any changes, Oracle recommends that you create a duplicate of the default dimension catalog.

Related Topics
• How You Use Dimensions and Dimension Catalogs in Supply Chain Planning

• Considerations for Setting Up Dimension Catalogs

• What's a dimension catalog in Supply Chain Planning?

Measure Catalogs  

How You Use Measure Catalogs in Supply Chain Planning  
The measure catalog is similar to the dimension catalog.

Each measure catalog has a collection of measures that you can use in plans in one of the Oracle Fusion Cloud Supply
Chain Planning work areas. The measure catalog can contain predefined and user-defined measures.

On the Measure Catalogs tab on the Configure Planning Analytics page, you can create a measure catalog and add or
remove measures from a measure catalog.

Note:  In the Status column, the count indicates only those plans that include the measure catalog on the Scope tab
on the Plan Options page. The count doesn't indicate the plans in which the measure catalog is used for archiving the
plans or extracting them.
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This table lists some predefined measure catalogs for Oracle Supply Chain Planning:

Work Area Predefined Measure Catalogs

Demand and Supply Planning • Default Demand and Supply Catalog

• Default Demand Management Catalog

• Default Supply Planning Catalog

• Supersession Forecasting Catalog

Demand Management • Default Demand Management Catalog

• Supersession Forecasting Catalog

Planning Central • Default Demand and Supply Catalog

• Default Demand Management Catalog

• Default Planning Central Catalog

• Default Supply Planning Catalog

Replenishment Planning • Default Replenishment Planning Archive Catalog

• Default Replenishment Planning Catalog

• Incremental Replenishment Planning Default Catalog

• Supersession Forecasting Catalog

Sales and Operations Planning • Default S&OP Archive Catalog

• Default S&OP Catalog

Supply Planning Default Supply Planning Catalog

Related Topics
• Can I modify the default measure catalog?

Can I modify the default measure catalog?  
No. Although you cannot modify the default measure catalog, you can create a measure catalog, modify the list of
measures, and assign it to plans on the Plan Options page.

Related Topics
• How You Use Measure Catalogs in Supply Chain Planning
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Levels and Attributes  

How You Use Levels and Attributes in Supply Chain Planning  
On the Levels and Attributes tab, you can enable certain item attributes (standard fields or flexfields) and organization
attributes (standard fields) to be available in Planning Analytics as filters.

For example, you can enable PLANNER_CODE to use in an analysis to group metrics and measures by that particular
attribute.

You can create a display name to use in the various pivot tables and graph configurations. For example, if the
predefined level name is Product Category 2, you can enter a display name of Laptops. You can also configure which
identifier to display in tables and graphs for selected hierarchies. For example, you can choose to display item name or
item description in your tables and graphs.

Displaying Descriptions in Tables and Graphs
You can analyze planning data in planning tables and graphs by using the description fields of selected entities in
hierarchies, such as items and organizations. You can use the description fields when their primary identifier is a difficult
to understand alphanumeric code.

For each dimension level (Item, Organization, Resource, Work Center, or Work Area) you can select only one member
identifier option to display in a planning table or graph. To see a list of the Member Identifier to Display options, refer to
the Configure Planning Analytics topic in this guide.

Tip:  The organization level in the Organization dimension and the organization level in the Resource dimension are
separate settings. Oracle recommends that you set them to use the same identifier.

Changing a member identifier can impact the advanced criteria in tables and graphs. If you use an advanced filter
criteria in a table or graph, then the criteria will be compared to the new member identifier, which can affect the search
results. The change to the member identifier can result in different or no members meeting the filter criteria. For
example, many names might start with AB, but no descriptions start with AB. After you make this change, you should
verify that any advanced filter criteria used are still valid.

Note:  In the Selector Tool, the member values displayed are based on what's configured in the Member Identifier to
Display column on the Configure Planning Analytics page, Levels and Attributes tab. For example, for item, you can
configure your tables and graphs to show item description instead of item name, which is what also appears when
you're in the Selector Tool.

Related Topics
• Overview of Planning Analytics

• Configure Planning Analytics
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4  Planning Measures

Predefined Measures in Supply Chain Planning  
When you use one of the Supply Chain Planning work areas, you have access to many predefined measures.

To review the details of each predefined measure, use the following:

• The Manage Planning Measures task

• A spreadsheet available at My Oracle Support

The Manage Planning Measures Task
On the Manage Planning Measures page, select a measure, and then select edit. You can review the details of the
measure on the Edit Measure page even if you can't make changes to the measure.

A Spreadsheet Available at My Oracle Support
Use Doc ID 2374816.1, Oracle Supply Chain Planning Cloud: List of Predefined Measures.

The List of Predefined Measures spreadsheet contains only the core measure attributes. You can use the Edit Measures
page to view all the attributes associated with a particular measure.

How You Manage Planning Measures  
Use the Manage Planning Measures task to review Supply Chain Planning measures.

You can edit several measures, but some measures you can only view. You use the pivot table to view the data you
edited at different aggregations. The results of the edits are stored based on definitions of a measure.

This topic discusses how you can perform these tasks:

• Update the definition of a measure

• Update aggregation parameters

• Update disaggregation parameters

• Edit data of a measure

Update the Definition of a Measure
To update the definition of a measure:

1. In a Supply Chain Planning work area, click the Tasks panel tab.
2. In the Tasks panel, click the Manage Planning Measures link.
3. Expand a measure group and scroll manually or use the search option to find all measures that match the

search criteria.
4. Select the measure that you want to modify and then click the Edit icon.
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Note:  Look for a check mark next to Allow editing at the top of the measure definition controls to confirm
that the measure is editable.

5. Click the Aggregation and Disaggregation tab to view measure definitions.

The dimensions, hierarchies, and levels at which data persists vary from measure to measure. For the
dimensions with a check mark, the measure is defined on the current dimension. For these dimensions, each
measure is defined on a single hierarchy as listed on the dialog box.

6. Click Save and Close.

Update Aggregation Parameters
Aggregation parameters control the way in which data of a measure is aggregated from the storage level to a table,
graph, or infotile. Calculation Order enables you to chose between the following options:

• Calculate and Aggregate: Calculates the measure's expression at the lowest data level and then aggregate up.

• Aggregate and Calculate: Aggregates all measures referenced in the measure's expression and then calculate
the expression.

Update Disaggregation Parameters
The disaggregation methodology is driven by the definitions of the disaggregation parameters. Disaggregation for
definitions that include time can be different from disaggregation for definitions that don't include time. For noneditable
measures there are no configuration in the disaggregation parameters.

Here are the four different allocation methods:

• Same: Indicates that all lower-level entries into which the data is being saved will receive the same value.
Service level would be a good measure to use Same Value settings as the percentage being entered should not
be allocated between different items and organizations.

• Equal: Spreads the edited value among the lower level entries into which data is being saved. Each entry
receives an equal share of the update. This could commonly be seen on the time dimension, where data may
be updated for a week or month, but there is no guidance on how it should be allocated to the common storage
level of days. It is typically set to the time dimension to equal value to support equal allocation between the
days.

• Self: Uses a measure's own pre-calculated values to allocate the data to the dimension member combinations.

For example, item-organization. The weights for each combination are calculated and stored for the measure
during plan run. These weights are used to allocate the data. For example, the forecasts for P1-Org1 and P2-
Org1 are 40 and 60 respectively. Therefore, the weights used for allocation would be 40% for P1-Org1 and 60%
for P2-Org1.

• Measure: Uses values of a different measure to allocate.

Edit Data of a Measure
To edit the data of a measure, open a table containing the measure, double-click the cell where the data is to be entered
and then enter the data. In a table, editable and noneditable cells look similar. However, when you double-click a cell of
an editable measure, the cell enables you to enter values.
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Copy Data from One Measure to Another
In a Supply Chain Planning table, you can update the value of one measure by using values from another measure. In
several cases, a measure can have other related measures that enable you to override the value of a base measure. For
example, Sales Forecast is one of those measures:

• Sales Forecast: Base measure.

• Adjusted Sales Forecast: You can override what's in Sales Forecast.

• Final Sales Forecast: The planning process takes the Adjusted Sales Forecast, if there is one, or uses the Sales
Forecast. The planning process uses the Final Sales Forecast, which takes into account any manual adjustments
that you made.

You can specify the data source whose values you want to copy to the selected range of cells in the target measure.
Using a table containing the three measures listed in our previous example, select a range of cells associated with the
Adjusted Sales Forecast measure, click Actions and then select Edit. In the Edit Measures dialog box, use the Sales
Forecast measure as the source measure for Adjusted Sales Forecast and increase it by 10 percent. If your Sales Forecast
is 200, then Adjusted Sales Forecast now reflects 220.

For a measure to appear in the list of values for Source Measure in the Edit Measures dialog box, the measure must be
included in the table. The measure must also conform to the same dimensions as the measure you're editing.

When editing a measure's value at an aggregate level, the value is allocated down to the lowest level. For example, when
editing weekly data, the value will be allocated down to the day.

You can also edit multiple measures at a time; however, you can't have circular references. In the following example,
Measure3 is used as a source measure for Measure1. But, Measure3 is also being edited at the same time to increase the
measure by 10 percent.

Measure Source Measure Action Value

Measure1
 

Measure3
 

Increase by percentage
 

10
 

Measure2
 

Measure2
 

Increase by percentage
 

10
 

Measure3
 

Measure3
 

Increase by percentage
 

10
 

In this scenario, the planning engine won't know which value of the source measure to use: the original Measure3 value,
or the value of Measure3 after increasing it by 10 percent. To avoid circular references, you must handle these edits
separately.

Related Topics
• Configure Units for a Measure

• Configure Currencies for a Measure

• Configure Conditional Formatting for a Measure

• Configure Color by Measure to Display in Graphs
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Import Measure Data Into a Planning Table  
When working with large volumes of data, you can export data from a planning pivot table to Microsoft Excel.

After you export the data, you can edit and make adjustments to any planning measure in the spreadsheet. When
you're done making changes offline in the spreadsheet, you can then import the updated planning data back into the
same table. To initiate the Upload Planning Table Data scheduled process, click the Import icon on the toolbar in the
opened table and then select the spreadsheet.

The spreadsheet that you import must have the same structure and format as the planning table. The imported
spreadsheet can be at any level of aggregation, as long as the levels match all of the levels displayed in the table. After
you select the file to import, the Upload Planning Table Data scheduled process updates the table in the background in
batch mode. While the import process uploads data in the background, you can work on other supply chain planning
tasks. When the upload process completes, the Import icon in the table displays a green check mark for the planner
who uploaded the data.

Note:  To see the uploaded data in your planning table, refresh the table after the Upload Planning Table Data
scheduled process completes.

Importing data into planning tables is available for all pivot tables in Supply Planning, Sales and Operations Planning,
Demand Management, Replenishment Planning, and Planning Central. Importing data isn't available for non-pivot
views like standard grids or other views such as the Build Plan table.

Tips for Importing Measure Data
Here are some tips to successfully import data from a spreadsheet into a planning table:

• The imported file must be a Microsoft Excel file with the .xlsx file extension.

• The import process only updates editable measures.

• The imported file must have the exact same format at the planning table. This includes the following:

◦ The uploaded file and the target table must contain the same number of rows and columns.

◦ The levels specified in the spreadsheet must match. The level names, such as Item or Organization, don't
have to appear as the header columns, but the columns and rows that represent the level must match.

◦ The members in each of the level rows and columns must be identical and in the same order. No member
can be omitted and new members can't be added.

◦ The measures column must have the same measures as the planning table for all combinations.

• The imported file must have the exact member combinations and their order listed in the column and row
headers of the table. All member names, such as item names and time periods, must be present in the same
order in the file being imported even if there are no updates for those combinations. Typically, you can achieve
the required order by exporting the table, making the edits offline, and then using the same file for import.

• All date values must be in the correct date format.

• If you update data directly in a table when the update process is still in progress, your updates can be
overwritten if they're for the same combination and measure.
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• If multiple users import files into the same table, the import process that finishes last overrides the others. For
planning tables that need frequent updates by multiple users, Oracle recommends that you create different
tables with appropriate filters.

Additional Information about the Import Process
Here's some additional information about importing data into planning tables:

• Tables with page filters aren't enabled for import. To use the table for import, remove the page filter or use
member filters in the table configuration. Filters specified as member filters in the table configuration are
respected.

• The import process evaluates and imports only the first worksheet in the workbook. If the workbook contains
other worksheets, the import process ignores them.

• The worksheet can contain native Excel comments and conditional formatting. The import process ignores
these comments and conditional formatting.

• If a cell has a formula based on another cell, the import process evaluates the formula and uses the result. The
other cell can be in the same worksheet or a different worksheet in the same workbook.

• The import process uses the data security rules assigned to the planner doing the import.

Configure Units for a Measure  
You can view a measure in several units of measure (UOM) and currencies side by side without needing separate
measures. By converting a single measure into various values and currencies, you get superior data consistency and
don't require recalculation and data synchronization.

In addition, sometimes different products and organizations have data that's loaded externally using different units of
measure. For example, vitamins sold in Europe may be shipped in bottles, while in Asia the quantities are by pill count.
By defining units, you enable these values to be converted into a cohesive value, which can be aggregated in a seamless
manner.

To configure units for a measure:

1. In a Supply Chain Planning work area, click the Tasks panel tab.
2. In the Tasks panel, click Manage Planning Measures.
3. Locate the measure for which you want to configure units and click Edit.
4. On the Advanced tab, select the Properties tab.
5. Select UOM from the list as the default value for the Base Units of Measure.

The base units of measure define the default unit of measure to which displayed data is converted. It is editable
only for numeric measures, which don't have product and organization-based levels. For measures that have
product and organization, the definition comes from the data source. When using the measure, you must
attempt to select only the relevant UOM entries for the measure to streamline the user process.

6. Select the relevant units of measure from the Display Unit of Measure.
You completed defining the unit of measure. You can view the measure using a specific table or graph.

Note:   To show the same measure with different unit of measures, you can create a copy from the original measure.
Rename the duplicated measure to use another unit of measure of your choice. You can show the same measure as
both numbers and currencies.
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To override the default unit of measure:

1. Open a table and select View, Format Measures to find the measure.
2. Click the measure you want to modify and select the value from the Unit of Measure list.
3. Click Save and Close.

Related Topics
• How You Manage Planning Measures

Configure Currencies for a Measure  
You can view a measure in several units of measure and currencies side by side without having separate measures. By
converting a single measure into various values and currencies, you get superior data consistency and don't require
recalculation and data synchronization.

To configure currencies for a measure:

1. In a Supply Chain Planning work area, click the Tasks panel tab.
2. In the Tasks panel, click the Manage Planning Measures link.
3. Locate the measure for which you want to configure currencies and click Edit.
4. On the Advanced tab, select the Properties tab.
5. Select Currency from the list as the default value for the Base Currency.

The base currency defines the default currency to which displayed data is converted and is editable only for
currency type measures.

6. Select the relevant currencies from the Display Currency.

You completed defining the currencies for a measure. You can view the measure using a specific table or graph.
The currency value is editable only if the measure type is Currency. For numeric measures, you can change the type
from Number to Currency. Select the currency that you want to use in this instance of the measure.

Note:  To show the same measure with different currencies, you can create a copy from the original measure. Rename
the duplicated measure to use another unit of measure of your choice. You can show the same measure as both
numbers and currencies.

To override the default currency:

1. Open a table and select View, Format Measures to find the measure.
2. Click the measure you want to modify and select the value from the Currency list.
3. Click Save and Close.

Related Topics
• How You Manage Planning Measures
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Configure Conditional Formatting for a Measure  
Use conditional formatting to change the background color of a cell when a specific condition occurs.

Conditional formatting is useful to draw the attention of the user for information that requires action. You define
conditions for an individual measure. A measure can have one or more formats applied. The condition is evaluated
at the table level using the configured units and currencies. Two tables with different units of measure or currencies
defined can have different cells trigger the conditional formats.

To configure global conditions:

1. In a Supply Chain Planning work area, click the Tasks panel tab.
2. In the Tasks panel, click the Manage Planning Measures link.
3. Locate the measure for which you want to apply conditions and click Edit.
4. On the Advanced tab, select the Conditional Formatting tab.
5. Click the + icon to add a row and complete the information.

Field Name Description

Measure
 

Locate the measure you want to use to evaluate. Conditional format for a measure can be based
on another measure.
 

Condition
 

Compares the selected measure to a value or another measure
 

Compare to Measure
 

Measure to which the selected measure is compared
 

Value
 

When the Compare to Measure is empty, this value is used to compare the selected measure
 

Color
 

Defines the color for the cell background when the condition is met
 

6. Click Save and Close.
To configure local overrides to conditions:

1. Open a table and select View, Format Measures.
2. Locate the measure that you want to modify and then select the Use Override Conditional Formatting check

box.
3. The Conditional Formatting section appears. Select a new conditional format to use in your table.
4. For only the Build Plan table accessed through a Supply Planning work area, the Conditional Formatting section

also includes the Apply and Name columns.

In the Apply column, select whether you want the conditional formatting to be highlighted in your Build Plan
table all the time or only when you select it from the Highlight Exceptions drop-down list.

For example, if you set up a conditional format named Resource Overload and select When selected, Resource
Overload appears in the Highlight Exceptions drop-down list in your Build Plan.
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5. Click Save and Close.

Related Topics
• How You Manage Planning Measures

Guidelines for Setting the Calculation Order  
How you set the calculation order for a measure affects its computation of data.

On the Aggregation and Disaggregation tab on the Create Measure page, in Aggregation Parameters, you can select
Calculate then aggregate or Aggregate then calculate in the Calculation Order field. If you make an incorrect
selection in this field, the measure value won't be correct.

Note these guidelines for setting the calculation order of the measure:

• When the measure's calculation order is Calculate then aggregate, all dependent measures must also use the
same order.
Dependent measures are all the measures (and their dependent measures, in turn) that are used in the main
measure's expression.

• On the Expression tab, your selection of the calculation order along with your use of the Lag and Lead
functions can affect the calculation of data.
The Lag and Lead functions have two parameters. The first parameter contains the measure the function is
applied to. The second parameter contains the number of time buckets.
When you use the Calculate then aggregate order, the second parameter is interpreted as being in days. For
example, Lag(Bookings History Average, 10) returns the value of the Bookings History Average measure from
10 days prior to the time period of the table cell.
When you use the Aggregate then calculate order, the second parameter is interpreted as being in the time
level that the measure data is displayed at in the table. For example, in a table that displays monthly time
buckets, Lead(Consensus Forecast MAD, 6) returns the value of the Consensus Forecast MAD measure 6
months after the month of the table cell.
If you've configured the table so that time buckets can be expanded or collapsed, then the time buckets can be
interpreted at different levels. For example, if you've configured the table to display both quarterly and monthly
time buckets and can expand a quarter to see the underlying months, Lag(Shipments History, 2) returns the
value of the Shipments History measure from 2 quarters prior to the cell being reviewed if the quarters are
collapsed or 2 months prior to the cell being reviewed if the quarters are expanded.

Manage User-Defined Measures  

Create Measures and Assign to a Measure Catalog  
In addition to reviewing measures, you use the Manage Planning Measure task to create, edit, duplicate, and delete
measures. You can also create measure groups and add predefined and user-defined measures in them.
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This topic discusses the following:

• Creating measures

• Assigning measures to a measure catalog

Create Measures
If you have the required privileges, you can create measures if the predefined ones don't meet your requirements. The
measures that you create have the same features and functionality as predefined measures.

To create a measure:

1. In a Supply Chain Planning work area link, click the Tasks panel tab.
You can create measures from one of the following work areas: Demand Management, Replenishment
Planning, Supply Planning, Sales and Operations Planning, Demand and Supply Planning, or Plan Inputs.

2. In the Tasks panel, click the Manage Planning Measures link.
3. Click Create from the Actions menu.

a. On the Create Measure page, enter a measure name and description.
b. Select a measure group.
c. Select a data type.
d. Select the Allow editing check box if you want the measure to be editable in a pivot table.
e. Select Edit Range to enable the Edit Lock tab, which controls the editable status of the measure

The Edit Range value determines the time range over which the measure is editable. The available values
are: History, Future, History and Future.

f. On the Aggregation and Disaggregation tab, define the dimension parameters. Select the dimensions,
hierarchy, and hierarchy level within the dimension to store the measure data. When a dimension and
hierarchy are selected, the default setting for the Stored Level is the lowest level of the dimension's
hierarchy. You can modify the level to store by selecting the hierarchy from the list and setting the stored
level parameter within that hierarchy.

- Aggregation Parameters: The Aggregation parameters control the way a measure's data is
aggregated. You have two options:

◦ Calculate and aggregate: Calculate and Aggregate calculates the measure's expression at the
lowest data level and then aggregate up.

◦ Aggregate then calculate: Aggregate and Calculate aggregates all measures referenced in
this measure's expression and then calculate the expression.

In the Time Dimension field, select the aggregation function that controls how data is aggregated
for the time dimension. The Other Dimensions fields are the same as the Time dimension fields.
These options control how the data is aggregated across all the dimensions except for time. The
Weighted By field is enabled only if you select Weighted Average as the aggregation parameter
for either Time or Other Dimensions. It enables you to select the measure to drive the weighted
average calculation.
The aggregation types include: Sum, Average, Weighted Average, Minimum, Maximum, Count,
Latest, Median, Variance, and Standard Deviation.

- Disaggregation Parameters: The Disaggregation Parameters control how changes to the data at
an aggregated level are allocated down for storage. This is used when data changes are made in a
pivot table, but also when made by the demand forecast. The weights for each combination, such

73



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 4
Planning Measures

as item-organization, are calculated and stored for the measure during plan run. These weights
are used to allocate the data. For example, the forecasts for P1-Org1 and P2-Org1 are 40 and 60
respectively. Therefore, the weights used for allocation would be 40% for P1-Org1 and 60% for P2-
Org1.

The parameters for the Disaggregation Type field are: By Measure, By Self, Equal, and Same Value.
The default parameter is Equal.

The Disaggregation Basis field is enabled only if you select the Disaggregation Type as By Measure.
Select the measure to use as the disaggregation basis from the list of measures.

The Secondary Basis field is enabled only if you have selected the Disaggregation Type field as
By Measure or By Self. The values for Secondary Basis are Booking History Average or Shipment
History Average.

The Secondary Basis measure is selected in case the basis measure has no value. You can select
only measures that contain pre-calculated proportions as a secondary basis. That is, they're
calculated during plan run.

g. On the Expression tab, define any new expressions for a measure. You create an expression when you
have to show any value other than its stored information. The expression provides a flexible framework
for an extensive variety of calculations and information. An expression for a measure references other
measures, operators, and numbers.

For example, to create a user defined measure that shows archived time periods, you need to use an
archive expression. See the View Planning Measures from Archived Time Periods topic to learn more.

In the Expressions subtabs:

- The Functions tab lists the available functions, a description, an example of the function's use.
- The Measures tab lists the available measures, their descriptions, and data type. The Insert button

inserts the highlighted measure into the expression building area where functions or arithmetic
operations can be specified.

- The Attribute tab lists the attributes available for the Product dimension at Item level. The
description and data type of the attribute is shown in the description pane.

After you complete the expression, use the Validate button to ensure the syntax is correct. An error or
succeeded messaged is displayed.

h. On the Edit Lock tab, you can define a new expression similar to the measure expression. The difference
is rather than evaluating and displaying the expression result, the expression result is used to control or
refine the editable status of the measure. If the expression evaluates as true, the measure is locked from
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editing. The expression is evaluated every time the table is run, and may change as relevant measures or
attributes are modified.

i. On the Advanced tab, click the Properties tab and review the following parameters:

- If you select the Shared measure check box, then the measure is shared across plans. By default,
the parameter isn't selected, and the measure is plan-specific.

Note:  You can share measures across only demand plans with the day planning time level or
across demand and supply plans. In such plans, shared measures are common, and the entries
you make in one plan apply to other plans. For plans of other types, even if you select the check
box, the measures are plan-specific.

- If you select the Refresh with current data check box, then the current measure value needs a
placeholder to store the result in the application. For example, a noneditable measure where the
data is imported from a legacy or other application. Selecting this check box allocates a space to
store the measure by the defined dimensions.

- Conversion Type enables you to define the valid Unit of Measure (UOM) and Currency conversions
that are available for a measure in a table.

Base Units of Measure defines the default unit of measure used to convert displayed data. The field
is editable only for Numeric measures, which don't have Product and Organization-based levels
(for measures that have product and organization, the definition comes from the data source).
Select any relevant units of measure, which may be useful in a table, graph, or tile. Only the UOMs
that you select are available for selection in a table or graph.

Base currency defines the default currency to which displayed data are converted. The field is
editable for only Currency type measures.

You use Price lists to convert quantities into values, which are then converted to a currency.
- Data Lookup value enables you to identify a data lookup source that displays the measure as a list

of value. The source attributes have 3 options: None (Default), Level, and List.

◦ If Source=Level, you must identify the level and the attribute to display in the measure list.

◦ If Source=List, then you can create and maintain the list of values. You can either add or
remove members in this list.

j. On the Advanced tab, click the Goals tab to define if low or high values are better for measure goals.
k. On the Advanced tab, click the Conditional Formatting tab to define conditional formatting settings for

the measure.
4. Click Save and Close.

Assign Measures to a Measure Catalog
To use the user-defined measure in your plan, add the new measure to the plan's measure catalog. Navigate to
Configure Planning Analytics, find the plan's measure catalog on the Measures Catalog tab. In the Available Measures
pane, search for the new user-defined measure, and add it to the Selected Measures. After you perform a plan run you
can create a table or use an existing table, and add your new measure to the table.

Related Topics
• Configure Global Goals for Measures

• Duplicate, Edit, and Delete Measures

• Create Measure Groups
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Duplicate, Edit, and Delete Measures  
You can duplicate, edit, or delete user-defined measures using the Manage Planning Measures task, which is available in
the Tasks drawer.

To duplicate the measure: Select a measure from the list of measures, select the Action menu on the toolbar, and then
click Duplicate. Duplicating the existing measure gives you a starting point for creating a new measure definition. When
you duplicate a measure the default name is Copy of <original measure name>. Other definitions of the duplicated
measure remain the same as the original measure.

To edit the measure: Select a measure from the list of measures, select Actions menu, and then click Edit. Editing a
measure enables you to select an existing measure and edit its attributes.

To delete the measure: Select a measure from the list of measures, select Actions menu, and then Delete. A complete
list of all objects including tables and measure groups are be displayed to ensure you are aware of impacts of deleting a
measure.

Related Topics
• Create Measure Groups

• Configure Global Goals for Measures

Create Measure Groups  
Use Manage Planning Measures task to create a measure group. Measure groups are created to group measures
together that you need frequently. Depending on your business need you can create measure groups and associate
measures with appropriate groups.

To create a measure group:

1. In the Navigator, click a Supply Chain Planning work area link.
2. Click the Tasks panel tab.
3. In the Tasks panel drawer, select the Manage Planning Measures link.
4. Select Create Group from the Actions menu.

◦ Enter a name and description.

◦ From the Available Measures pane you can select measures and move them to the Selected Measures
pane.

5. Click Save and Close.

Related Topics
• Create Measures and Assign to a Measure Catalog

• Duplicate, Edit, and Delete Measures
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Configure Global Goals for Measures  
You can define global goals for a measure using the Goals tab when you create or edit a measure. On the Create
Measure page, click the Advanced tab and then select the Goals tab to configure global goals.

Define if low or high values are better. For example, a high value is good for revenue; a low value is good for expenses.

For global goals, you can provide a low range or a high range.

Goals option is available only for measures of type Currency, Number, and Percent. Using Global Goals, you can first
define if low or high values are better for a measure. The ranges are displayed on the page when you are viewing a
measure in comparison with its goal, for example, in an infotile. Global goals are measure level parameters and are
not defined specifically for a subset of the data. For example, you cannot have a goal of 1000 for one organization and
50000 for another.

Related Topics
• Create Measures and Assign to a Measure Catalog

• Duplicate, Edit, and Delete Measures
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5  Supply Network Model

How You Maintain Your Supply Network Model  
Use the Maintain Supply Network Model page to view your collected data that includes details of organizations,
customers, suppliers, carriers, and interlocation shipping networks.

To open the Maintain Network Model page, navigate to a Supply Chain Planning work area. Click the Tasks panel tab
and then select the Maintain Supply Network Model link.

You use organizations to represent your business facilities or functions. Typically, if your business has a single physical
facility that performs two different functions, then you model it as two organizations. For example, you have one facility
that's a manufacturing plant and a distribution center. You can model them as two separate organizations. Additionally,
if your business has one function located in two separate physical facilities, you can model those as one organization. If
you modeled your facilities as one organization, you can create separate subinventories to represent inventory for each
facility.

Review the Collected Data
Based on your search results, use the Organization tab to do the following:

• Review organizations, including the time zones associated with the organizations, for all source systems.

• Create customer and supplier associations to organizations. This is used when creating the buy-sell transfers.

• Select the drop ship validation organization. For each source system, you can select only one organization as
the drop ship validation organization. You can also assign a calendar to a drop ship validation organization.

• Set past due parameters for each organization, which include:

◦ Past due forecast days

◦ Past due sales order days

◦ Past due supply days

• Set up organizations for subinventory-level replenishment planning by selecting Yes under Plan
Subinventories.

Use the Customers and Supplier tabs to review collected data and assign time zones to customer sites and supplier
sites. If the customer site or supplier site doesn't have an associated time zone, then the customer site or supplier site is
assumed to be in the same time zone as the organization that's associated with the demand or supply.

Use the Carriers and Interlocation Shipping Networks tabs to review collected data on carriers, shipping methods, and
transit times.

Manage Organization Groups
Click the Manage Organization Groups button on the Organizations tab to create and manage organization groups.
Organization groups are managed within the source systems and are used to:

• Limit the net change data collection from a source system to specific organizations.
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• Load planning data from files for a specific organization group when collection type is Targeted.

Enable Inventory Organization Tracking by Project
This parameter appears on the Maintain Supply Network Model page only when your organization is enabled for
project-specific supply planning.

The Project Enabled parameter governs whether your inventory organization is enabled for inventory tracking by
project. The value for this parameter can be Yes or No for an organization.

When the parameter value is Yes for an organization, the data collection process collects project-and-task-specific
supplies and demands, and the project-specific planning releases planned orders to the organization. The value for this
parameter is No for a supplier-modeled organization or a contract manufacturing organization.

Buy and Sell Transfers
You can conduct material transfers between two organizations in a single Oracle Fusion source system by using the
purchase order and sales order documents. The sales order at the source organization is used to ship the transfer. The
purchase order at the destination organization is used to receive the transfer.

In the supply network model for the purchase order supply at the receiver organization:

• Define the supplier to source organization relationship and for the sales order demand at the shipping
organization.

• Define the customer to destination organization relationship.

To model an organization as a supplier, update the Supplier and Supplier Site columns of the associated organization.

To model an organization as a customer, update Customer and Customer Site columns of the associated organization.

Forecast and Consume Internal Orders
To forecast and consume internal orders, assign a customer and customer site to the organization that's the destination
of the transfers. Use a customer name that makes sense for the destination organization, such as M1 Transfers. After
you assign a customer and customer site on the Organizations tab, select the Use Customer and Customer Site for
Interorganization Transfers check box for the organization.

Note:  To complete the setup to forecast and consume internal orders, you must also do the following:
• On the Collect Planning Data page, Parameters tab, Demand Planning Data subtab, select the Organization -

Consumption Inventory Transactions to Include check box.

• In the plan options for your plan, select the Include transfer orders check box in the Demand: Advanced
Options dialog box. This check box is only available from a Demand Management, Planning Central, or Demand
and Supply Planning work area.
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Related Topics
• Overview of Data Collections for Supply Chain Planning

• How You Collect Different Data Types for Supply Chain Planning

• How You Load Planning Data from Files

• How You Define the Approved Supplier List for Supply Chain Planning

• Set Up Forecast Consumption for Transfer Orders

Publish Order Forecasts to Suppliers  
You publish order forecasts to your suppliers to enable them to commit supply and indicate their ability to meet the
demand. Collaborating with suppliers by publishing an order forecast enables:

• Suppliers to send supply commits to the Original Equipment Manufacturer (OEM)

• OEMs to receive supply commits as supplier capacity

Collaboration enables suppliers to get an insight into the demand that the OEMs forecast and plan supply chain
activities to meet the demand. Additionally, collaboration with suppliers enables OEMs to plan their downstream
activities in the supply chain more efficiently.

Use the Collaboration Basis column in the Suppliers tab on the Maintain Supply Network Model page to indicate the
basis on which you want to publish the order forecast to your suppliers. You can choose to publish the order forecast at
the supplier and supplier site levels based on one of the following dates:

• Start date: Suppliers use the start date to know when they need to start manufacturing an order to fulfill the
order on time

• Dock date: Suppliers use the dock date to know the date by which they need to fulfill the order

How You Define the Approved Supplier List for Supply
Chain Planning  
An approved supplier list (ASL) is a repository of information that links items to the suppliers and supplier sites that
provide them to either a specific ship-to organization or the entire enterprise.

An ASL can be global or specific to an organization; however, supply planning only recognizes global ASLs.

To determine the supplier and supplier sites for items, the planning process collects ASLs from the CSV file upload,
Oracle Fusion Cloud Procurement, or both.

• Use the Load Planning Data from Flat Files process to load data directly into the planning ASL by using the
Approved Supplier List CSV template (ScpApprovedSupplierListImportTemplate.xlsm).

• You can also define some ASL attributes in Oracle Procurement and then upload a CSV file that defines
the attributes that you want supply planning to use. For example, define the following item-to-supplier
relationships and order modifiers in Oracle Procurement:

◦ Supplier
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◦ Supplier site

◦ Minimum order quantity

◦ Fixed lot multiple

To upload additional attributes for supply planning to use, you can create and collect the ASL from purchasing. You can
then use the CSV file upload to define additional attributes such as the following:

• Item-supplier lead time

• Supplier capacity calendar

• Daily supplier capacity

Oracle Fusion Cloud Supply Planning supports the approved supplier list for a base model. However, approved supplier
lists aren't supported for configured items and won't be copied into a supply plan.

Related Topics
• How You Maintain Your Supply Network Model

• Supplier Capacity Options

Associate Calendars with Supplier Sites  
Use a supplier site calendar to measure processing lead times for purchases from a supplier site. You can associate a
Supply Chain Planning calendar with a supplier site to use for all items sourced from that supplier site.

The calendar is in the collected planning data.

You can associate a calendar with supplier sites to use if there is no calendar defined through the Approved Supplier List
upload for a supplier site-item combination. From a Supply Chain Planning work area, navigate to the Maintain Supply
Network Model page, Suppliers tab. In the Supplier Site Calendar column for a supplier, select a calendar name from
the list of collected calendars. You can only edit this field if the supplier row contains a supplier site.

When you run the plan, the planning process uses the selected calendar on the Maintain Supply Network Mode page
if the approved supplier list calendar for the supplier site-item is blank. If the approved supplier list calendar for the
supplier site-item is blank, and you do not associate a calendar with a supplier site on the Maintain Supply Network
Model page, then the planning process uses the 24/7 calendar.

Related Topics
• How You Define the Approved Supplier List for Supply Chain Planning

Assignment Sets, Sourcing Rules, and Bills of
Distribution  
You use assignment sets in a Supply Chain Planning work area to link sourcing rules and bills of distribution to items.

82

https://www.oracle.com/pls/topic/lookup?ctx=fa24a&id=s20055911


Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 5
Supply Network Model

Using sourcing rules, bills of distribution, and assignment sets together, you can specify how material is supplied,
manufactured, and transferred across a supply chain.

Note:  This topic is applicable to only the Planning Central, Sales and Operations Planning, Supply Planning, Demand
and Supply Planning, and Replenishment Planning work areas.

When you create sourcing rules and bills of distribution, you create descriptions of the means by which you can
replenish items. However, items aren't specified anywhere on the definition forms, and so a defined sourcing rule or
bill of distribution can later be assigned to any item or group of items. Use assignment sets to associate specific items,
categories, or organizations with the sourcing rules and bills of distribution.

You must use sourcing to describe the supply chain to the planning process. Use the following three structures to do so:

• Sourcing rules

• Bills of distribution

• Assignment sets

Sourcing Rules
Sourcing rules and bills of distribution determine the movement of material between organizations. These
organizations include supplier, manufacturing, and distribution facilities. You can navigate to a Supply Chain Planning
work area and click Manage Sourcing Rules from the Tasks drawer to create or search for an existing sourcing rule.

The three types of sources are:

• Transfer From: Interorganization shipping functionality accomplishes the transfer between internal
organizations. Enter the source organization in the Organization column.

• Make At: The item is manufactured at this internal organization. Enter the manufacturing organization in the
Organization column.

Oracle Fusion Replenishment Planning doesn't support make at sourcing rules.

• Buy From: Purchase the item from an external enterprise. Data entry in the Supplier and Supplier Site columns
is enabled, and the Organization column is disabled.

Allocation Percent and Rank: The total allocation percentage for all sources within a rank must add up to 100 percent.
The sources with the highest rank (lowest numeric value) get the highest priority in allocations. Unconstrained supply
planning and Replenishment Planning only consider sources of rank one. Replenishment Planning also doesn't support
sourcing splits.

Bills of Distribution
When material flows through three or more organizations, bills of distribution describe supply chain links more
efficiently than sourcing rules. However, any relationship that can be described by bills of distribution can also be
described by a set of sourcing rules. Typically, most users use sourcing rules rather than bills of distribution. You can
navigate to a Supply Chain Planning work area and click Manage Bills of Distribution from the Tasks drawer to create
or search for existing bills of distribution.

Replenishment Planning supports bills of distribution of only rank one and doesn't support split bills of distribution.

Sales and Operations Planning doesn't support bills of distribution.
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Note:  Despite the name, bills of distribution don't describe an outward bound or push type of sourcing relationship.
Both sourcing rules and bills of distribution are used only to pull material from sources to destinations.

Assignment Sets
You use assignment sets to link sourcing rules and bills of distribution to items. In other words, you use assignment
sets to link sourcing rules, items and supply nodes. The assignment set creates the sourcing and transfer links between
organizations for each item involved in a supply chain plan. Alternative supply chains can be modeled by creating
alternative assignment sets. You can navigate to a Supply Chain Planning work area and click Manage Assignment
Sets from the Tasks drawer to create or search for existing assignment sets.

For more information, see Create an Assignment Set.

Sourcing Assignment Hierarchy
The planning process uses a sourcing assignment hierarchy to determine the actual source of a specific item. You can
assign replenishment sources at the following levels. Specific sourcing assignments override general assignment levels.
If the planning process doesn't find any sourcing assignment, then the make or buy item attribute is used to determine
sourcing.

The following table lists the supply sourcing hierarchy.

Rank Item or Category Applies to

1
 

Item - Organization
 

1. Sourcing rule

2
 

Category - Organization
 

1. Sourcing rule

3
 

Item
 

1. Bill of distribution
2. Global sourcing rule

4
 

Category
 

1. Bill of distribution
2. Global sourcing rule

5
 

Organization
 

1. Global sourcing rule

6
 

Global
 

1. Bill of distribution
2. Global sourcing rule

When entering sourcing assignments at the category level, the catalog associated with the assignment set is used to
determine the list of available categories.

When you source supplies for sales orders and forecasts (independent demands), then order promising and planning
use a more detailed hierarchy. This hierarchy includes the demand class, customer, and customer site which are
dimensions of independent demand.

The following table lists the demand sourcing hierarchy.
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Rank Item or Category

1
 

Item - Customer / customer site
 

2
 

Item - Customer
 

3
 

Item - Demand Class
 

4
 

Item - Region
 

5
 

Category - Customer / customer site
 

6
 

Category - Customer
 

7
 

Category - Demand Class
 

8
 

Item
 

9
 

Category - Region
 

10
 

Category
 

11
 

Customer / customer site
 

12
 

Customer
 

13
 

Demand Class
 

14
 

Region
 

15
 

Global
 

Using the demand sourcing hierarchy, if a demand line includes a value for demand class, then if no sourcing rule exists
for Item - Customer / customer site or Item - Customer, but a rule exists for Item-Demand Class, then that rule is used
to determine supply sources for the demand line.

When using the sourcing hierarchy, if two rules conflict, the more granular rule is used. To verify which source is
used for an assignment set, from within the set, click the View Sourcing button after entering the following required
parameters:

• Assignment set

• Organization

• Item

• Date

85



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 5
Supply Network Model

The dialog box displays which assignments apply to the item-organization-date that you selected. If multiple rules
apply, then the Active Rule is marked in the form.

Related Topics
• Support for Sourcing Rules and Bills of Distribution in Oracle Replenishment Planning

• Item Attributes and Order Modifiers for Supply Planning

Create an Assignment Set  
Learn how to create an assignment set.

Assume you sell the AS54888 Computer. You're releasing a new version of it, AS54888.1 to all your customers, but you
want to make sure your highest valued customer, Computer Service and Rentals, gets first dibs on it.

Here's your supply chain.
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Note

• You are in the Vision Operations organization.

• You fulfill all computers that you have in the Computers category from:

• ◦ Vision Distribution Center 1 (DC1)

◦ Vision Distribution Center 2 (DC2)

◦ Superfly Supply (S1)

You will create one sourcing rule to meet this need:

• You fulfill the AS54888.1 only from Distribution Center 1 and Distribution Center 2.
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You will create a second sourcing rule to meet this need:

• You fulfill sales orders from Computer Service and Rentals that have the AS54888.1 only from Distribution
Center 1.

You will create a third sourcing rule to meet this need:

• You fulfill all items that are in the Computers category from Distribution Center 1, Distribution Center 2, or
Superfly.

So you need to implement this set up.

Sourcing Rule Item Category Item Fulfillment Source

1 Computers - Vision Distribution Center 1 (DC1)
 
Vision Distribution Center 2 (DC2)
 
Superfly Supply (S1)
 

2 - AS54888.1 Vision Distribution Center 1 (DC1)
 
Vision Distribution Center 2 (DC2)
 

3 - AS54888.1 Vision Distribution Center 1 (DC1)

Summary of the Setup

1. Create your sourcing rules.
2. Assign your sourcing rules.

Create Your Sourcing Rules
1. Go to the Global Order Promising work area, then click Tasks > Manage Sourcing Rules.
2. Create your first sourcing rule.

◦ On the Manage Sourcing Rules page, click Actions > Create.

◦ On the Create Sourcing Rules page, set the values.

Attribute Value

Name Transfer Computers From D1, D2, and S1

Description Sourcing rule to transfer supply for all items that are in the Computers category from our
distribution centers and from Superfly Supply.

Organization Assignment Type Global

◦ In the Sourcing Rule Effective Dates, click Actions > Add Row, then set the Start Date to today's date. You
want this rule to last forever, so leave the End Date attribute empty.

If you ever need to stop using this rule, you can always come back and set the end date.

◦ In the Sources area, use Actions > Add Row 3 times to add these rows.
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Type Organization Allocation Percent Rank

Transfer From D1 100 1

Transfer From D2 100 1

Buy From S1 100 1

3. Create your second sourcing rule.

◦ Repeat step 2, but with these values.

Attribute Value

Name Transfer Computers from D1 and D2

Description Sourcing rule to transfer supply for the AS54888.1 item from our distribution centers.

Organization Assignment Type Global

◦ Add these sources.

Type Organization Allocation Percent Rank

Transfer From D1 60 1

Transfer From D2 40 1

4. Create your third sourcing rule.

◦ Repeat step 2, but with these values.

Attribute Value

Name Transfer Computers from D1

Description Sourcing rule to transfer supply for the AS54888.1 item from our D1 distribution center.

Organization Assignment Type Global

◦ Add this source.

Type Organization Allocation Percent Rank

Transfer From D1 100 1

5. Click Save and Close.

89



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 5
Supply Network Model

Assign Your Sourcing Rules
Now you create a set of assignments to assign your sourcing rules. Your set will have three assignments.

1. Click Tasks > Manage Assignment Sets.
2. On the Manage Assignment Sets page, click Actions > Create.
3. On the Create Assignment Set page, set the values.

Attribute Value

Name Assign My Computers

Description Assign the sourcing rules that we're using to source all of our computers.

Catalog GOP_Catalog
 
For details about catalogs and categories, see How Catalogs Work Together.
 

4. Click Actions > Add Row, then assign your first sourcing rule.

Attribute Value

Assignment Level Category

Category Computers

Sourcing Rule or Bill of Distribution Transfer Computers From D1, D2, and S1

5. Click Actions > Add Row, then assign your second sourcing rule.

Attribute Value

Assignment Level Item

Item AS54888.1

Sourcing Rule or Bill of Distribution Transfer Computers from D1 and D2

6. Click Actions > Add Row, then assign your third sourcing rule.

Attribute Value

Assignment Level Item and Customer

Item and Customer Computer Service and Rentals

Item AS54888.1

Sourcing Rule or Bill of Distribution Transfer Computers from D1
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7. Click Save and Close.

Another Example of Creating an Assignment Set
Create an assignment set that Promising can use when your first choice for supply can't fulfill the demand.

Consider this supply chain.

Assume:

• You're in the Vision Operations organization.

• You sell the AS54888 Computer item, and its in the Vision Pro category of computers.

• The Western Warehouse and the Eastern Warehouse are each an organization in Vision Corporation.
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• You want to ship from Western first.

• If Western can't fulfill demand in time to meet the requested delivery date, then ship from Eastern.

• If Eastern can't fulfill demand in time to meet the requested delivery date, then use Superfly Supply to fulfill
demand. Superfly is your 3rd party supplier. You use the acronym SFS to identify the Superfly organization.

• You need 10 days lead time to fulfill the item.

Summary of the Setup

1. Create your sourcing rules.
2. Assign your sourcing rules.
3. Create your ATP rules.

Create Your Sourcing Rules

1. Create your first sourcing rule.

◦ Go to the Global Order Promising work area, then click Tasks > Manage Sourcing Rules.

◦ Create a new sourcing rule.

Attribute Value

Name Sourcing Rule for Vision Pro Computers

Description We use this sourcing rule to source all items in a category from our Western Warehouse. If
Western can't fulfill the item in time, then it sources from Eastern Warehouse.

Organization Assignment Type Global

◦ Set the start date to today's date. Don't enter an end date.

◦ Add your sources.

Type Organization Allocation Percent Rank

Transfer From Western Warehouse 100 1

Transfer From Eastern Warehouse 100 2

2. Create your second sourcing rule.

Attribute Value

Name Sourcing Rule for a Vision Pro Item

Description We use this sourcing rule to source an item from our Western Warehouse. If Western can't fulfill
the item in time, then it sources from Eastern Warehouse.

Organization Assignment Type Global

◦ Set the start date to today's date. Don't enter an end date.

◦ Add your sources.

92



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 5
Supply Network Model

Type Organization Allocation Percent Rank

Transfer From Western Warehouse 100 1

Transfer From Eastern Warehouse 100 2

3. Create your third sourcing rule.

Attribute Value

Name Sourcing Rule for Superfly Supply

Description We use this sourcing rule to source an item from our Superfly Supply supplier.

Organization Assignment Type Local

Organization SFS

◦ Set the start date to today's date. Don't enter an end date.

◦ Add your source.

Type Organization Allocation Percent Rank

Buy From Superfly Supply 100 1

Assign Your Sourcing Rules

1. Click Tasks > Manage Assignment Sets.
2. On the Manage Assignment Sets page, click Actions > Create.
3. On the Create Assignment Set page, set the values.

Attribute Value

Name Assign My Vision Pro Computers

Description Assign the sourcing rules that we're using to source all of our computers in the Vision Pro
category.

Catalog GOP_Catalog
 

4. Click Actions > Add Row, then assign your first sourcing rule.

Attribute Value

Assignment Level Category

Category Vision Pro

93



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 5
Supply Network Model

Attribute Value

Sourcing Rule or Bill of Distribution Sourcing Rule for Vision Pro Computers

5. Click Actions > Add Row, then assign your second sourcing rule.

Attribute Value

Assignment Level Item

Item AS54888

Sourcing Rule or Bill of Distribution Sourcing Rule for a Vision Pro Item

6. Click Actions > Add Row, then assign your third sourcing rule.

Attribute Value

Assignment Level Organization

Organization SFS

Sourcing Type Sourcing Rule

Sourcing Rule or Bill of Distribution Sourcing Rule for Superfly Supply

7. Click Save and Close.

Create Your ATP Rules

1. Click Tasks > Manage ATP Rules.
2. Create your first ATP rule.

Click Actions > Create, then set the values.

Attribute Value

Name ATP Rule for the AS54888

Description ATP rule that we're using to promise the AS54888 item.

Promising Mode Lead-Time Based

Lead Time Considered User-Defined Lead Time

User-Defined Lead Time in Days 10

Assignment Basis Item

Assigned-to Item AS54888

3. Create your second ATP rule.
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Click Actions > Create, then set the values.

Attribute Value

Name ATP Rule for the Vision Pro Category

Description ATP rule that we're using to promise items that are in the Vision Pro category.

Promising Mode Lead-Time Based

Lead Time Considered User-Defined Lead Time

User-Defined Lead Time in Days 10

Assignment Basis Category

Assigned-to Item Category Vision Pro

Specify Catalogs for Assignment Sets  
A catalog is a group of categories that you can use to classify an item. Use it to organize your item into a hierarchy.

A catalog can have a flat or a one level structure of categories. You can also have a hierarchical structure of categories.

You must specify a catalog for each assignment set when you create the set. You associate the set with a catalog to:

• Use categories associated to that catalog in your assignment set.

• Link the sourcing assignments to the categories.

Use the Manage Assignment Sets task in the Global Order Promising work areas to create an assignment set and specify
the catalog. Don't use assignment sets in the Demand Management work area.

If you don't specify a catalog, then the assignment set uses the Catalog for Sourcing Assignments
(MSC_SRC_ASSIGNMENT_CATALOG) profile option as the catalog. To modify it, see Manage Promising Profiles.

A catalog is a collection of categories that you can use to classify your item. For example, you can assign the Floral Dress
item to the Summer category in the Ladies Wear catalog. For details about catalogs and categories, including how to
create a catalog and add categories and items to it, see Assign Catalogs and Categories Using Item Rules.

Create a Sourcing Rule  
Learn how to create a sourcing rule.

1. Collect the reference data that you need to create your sourcing rule, such as organizations, items, and so on.
Make sure the collected data is up to date on the server.

For details, see Collect Data for Global Order Promising.
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2. Go to the Global Order Promising work area, then click Tasks > Manage Sourcing Rules.
3. On the Manage Sourcing Rules page, click Actions > Create.
4. On the Create Sourcing Rule page, enter a name and description.
5. Set the Organization Assignment Type attribute to Global or Local.

If you set it to Local, then set a value in the Organization attribute. Select the one organization that you will
apply this sourcing rule to.

6. In the Sourcing Rule Effective Dates section, click Actions > Add Row, then set the dates when you want the
sourcing rule to be in effect.

7. In the Sources section, click Actions > Add Row, then set the values.

Attribute Value

Type Choose one:
 

◦ Transfer From

◦ Make At

◦ Buy From

8. Set other attribute values depending on the type that you selected. The page will help you. It will make some
attributes available depending on the type.

9. Click Save and Close.

Related Topics
• How You Collect Different Data Types for Supply Chain Planning

• Support for Sourcing Rules and Bills of Distribution in Oracle Replenishment Planning

Export Planning Data to CSV Files  
You can replicate sourcing rules and assignment set data from your Oracle Fusion Cloud Supply Planning instance to
another instance. When exporting data to CSV files, you can export a subset of the measures that are listed in a plan's
measure catalog.

Replicate Sourcing Rules and Assignment Set Data
You can replicate sourcing rules and assignment set data from your Oracle Fusion Cloud Supply Planning instance to
another instance or application without manually reentering data. For example, you can replicate the sourcing rules in
your Oracle Supply Chain Planning production instance into a reporting system or a test instance.

Use the Export Supply Chain Planning Data scheduled process job to extract sourcing rules and assignment set data
into a comma-delimited values (CSV) file format. The generated file is in the standard file-based import (FBDI) file
format that you can then use to do the following:

• Check for missing or incorrect sourcing rules or sourcing assignments. For example, does a particular item-
organization have a valid sourcing assignment?

• Replicate and then modify existing sourcing rules and assignment sets in a spreadsheet. You can then upload
the new setups into another instance or application to create new sourcing rule and assignment set setups.
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• Copy the sourcing rule and assignment set setups from one instance to another instance or application, such as
from a test instance to a production instance.

The format of the CSV files, including the header content, is the same as the format of the corresponding files in the
source instance. This enables you to import the same data directly into another production or test instance. Use the
Load Planning Data from Files process to upload your imported files to staging tables.

The following steps show you how to export sourcing rules and assignment set data to a CSV file:

1. In the Scheduled Processes work area, click the Schedule New Process button on the Overview page.
2. In the Schedule New Process dialog box, search for and select Export Supply Chain Planning Data and then

click OK.
3. In the Process Details dialog box, Basic Options section, select Sourcing Rules and Assignment Sets from the

Entities to Export drop down list.
4. Optionally, click the Filter button to filter your export with specific assignment sets. If you don't select any

filters, then the process exports all sourcing rules and assignment sets.
5. In the Process Details dialog box, click the Submit button to submit the scheduled process job.

After you submit your job, you will receive a confirmation with a confirmation number. The planning process
appends the confirmation number to the extracted CSV file names, such as AssignmentSets_65960.csv and
SourcingRules_65960.csv, where 65960 is the confirmation number.

Export Measures Along With Planning Data
While exporting planning data, you can include a subset of measures that are part of a plan's measure catalog.

You can assign a measure catalog other than a plan’s extract measure catalog defined in Plan options, in the Manage
Plans UI. This improves the versatility and quality of data extracts required for planning.

Depending on your planning cycle and data needs, extract only those measures that are most relevant for the planning
activity. For example, for a given plan you can export demand related measures early in a planning cycle and supply
related measures later in the cycle.

You can also assign a measure catalog when running the Prepare Planning Data for Export scheduled process.

Item Attributes for Oracle Replenishment Planning  
This topic lists the item attributes that are supported by Oracle Replenishment Planning.

Replenishment Planning supports these item attributes:

• ABC Class

• Annual Carrying Cost Percentage

• Average Interarrival Time

• Average Interarrival Time Override

• Buyer

• Category

• Category Description
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• Create Supply

• Create Supply After

• Currency

• Description

• Fixed Lot Multiplier

• Fixed Order Quantity

• Intermittent Demand

• Intermittent Demand Override

• Item

• Make or Buy (Replenishment Planning doesn't support Make items. If the item attribute is set to Make,
Replenishment Planning considers the item attribute as Buy. This item attribute is used if no sourcing rule is
present.)

• MAPE

• MAPE Override

• Maximum Order Quantity

• Minimum Order Quantity

• Net Selling Price

• Note

• Order Cost

• Planner

• Planner Description

• Planning Method (This attribute must be set to Replenishment Planning.)

• Postprocessing Lead Time

• Preprocessing Lead Time

• Processing Lead Time

• Release Time Fence Date

• Release Time Fence Days

• Release Time Fence Type

• Rounding

• Selling Price

• Service Level Percentage

• Standard Cost

• UOM

Related Topics
• Support for Create Supply and Create Supply After Attributes in Oracle Replenishment Planning
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6  Planning Data Collections

Overview of Data Collections for Supply Chain Planning  
Before running plans from one of the Oracle Fusion Cloud Supply Chain Planning work areas, you must collect data into
the planning data repository. Order promising and order management processes also use the planning data repository
to promise and manage orders.

To collect data into the planning data repository from one of the Supply Chain Planning work areas, you can do one of
the following:

• Collect Planning Data: Use this page when you collect data from the source system for Fusion Applications.

• Load Planning Data from Flat Files: Use this scheduled process when you collect data from a completely
external source system.

Depending on your security privileges, you might need to manually add these tasks. In the Setup and Maintenance work
area, use the following:

• Offering: Supply Chain Planning

• Functional Area: Supply Chain Planning Configuration

• Task: Collect Planning Data

In the collections process flow, when you begin data collections from the Fusion Applications source system, the
staging table pulls data from the source system. Similarly, when you begin data collections from comma-separated
values (CSV) files, the data is pushed from files to the staging table. Then, the data from the staging table is loaded into
the planning repository with the use of scheduled processes.

The following figure illustrates the collections processes that you can use to populate the planning data repository.

99



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 6
Planning Data Collections

Collect Planning Data
There are two steps involved in the data collection process. The Collect Planning Data process first pulls data from the
Fusion Applications source system into staging tables. The process then loads data from the staging tables into the
planning data repository.

On the Collect Planning Data page, use the following tabs to select what data you want to collect:

• Reference Data

• Demand Planning Data

• Supply Planning Data

Most of the reference data are global entities. Global entities are common for all source systems. For example, Units of
Measure (UOM) is common for all source systems. The supply planning and demand planning data are transactional
data. Most of the transactional data are local entities. Local entities are specific to each source system. For example, on-
hand quantity is specific for each source system.

Note:  You must have the Run Plan with Snapshot privilege to collect the item relationships preference data.

You can also select collection filters to further refine what data you want to collect. You can save your selections to
collection templates.

Note:  If you're collecting information at the Customer Site level for a demand plan that uses a planning level profile,
you must run the Aggregate Collected Planning Data scheduled process after data collection is over. Then, you
must run the Create Trees for Dimensions scheduled process in the net change mode for the Customer dimension.

Load Planning Data from Flat Files
When you submit the Load Planning Data from Flat Files scheduled process, data from the CSV files is first pushed
into the staging tables. The process then loads the data from the staging tables into the planning data repository.

To load the planning data using CSV files, follow this high-level process:

1. Create the CSV files. To create the CSV files, you can use a predefined set of file-based data import (FBDI)
templates.

2. Import the CSV files. From the Navigator, click File Import and Export, and create a new import. Specify scm/
planningDataLoader/Import for the account.

3. Submit the Load Planning Data from Flat Files scheduled process.

Note:  If you're collecting information at the Customer Site level or deleting customer-related information using the
Load Planning Data from Flat Files scheduled process for a demand plan that uses a planning level profile, you must
run the Aggregate Collected Planning Data scheduled process after data collection is over. Then, you must run the
Create Trees for Dimensions scheduled process in the net change mode for the Customer dimension.

Related Topics
• How do I update existing setup data?

• Load Planning Data from Flat Files

• Overview of Planning Level Profiles
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Global Entities  
Within data collections, certain business entities in Oracle Fusion Cloud Supply Chain Planning are referred to as global
entities.

Global entities are specific for each instance and are common for all source systems. They're common without regard to
whether they're collected from the Oracle Fusion source system or from an external source system with the use of the
file-based data import (FBDI) templates.

When data is collected for a global entity, the planning data repository stores only one record for each instance of the
global entity. The data collections process removes the source system reference from the global entity and stores the
data in the data repository. If the data collections process collects the same instance of a global entity from more than
one source system, the data repository stores the value from the last collection.

The following example describes the collection of the global entity called unit of measure (UOM) from three source
systems, namely A, B, and C:

• A has an instance of a UOM. During the collection of UOMs from A, the kilogram UOM is collected. This is the
first time the kilogram UOM is collected. The data collections process creates a kilogram record in the data
repository.

• B doesn't have any instances of a UOM. During the collection of UOMs from B, the data collections process
doesn't collect the kilogram value. Because there was no record for the kilogram UOM in B, the data collections
process doesn't change the kilogram record in the data repository. The record of the kilogram value from A is
still valid.

• C has an instance of a UOM. During the collection of UOMs from C, the kilogram UOM is again collected. The
data collections process registers the kilogram record in the data repository to match the value from C.

Note:  When you use the FBDI templates, the global entity files require a source system. The collections framework
validates that the source system matches each record's source system. A source system identifier marks each data
record.

In Oracle Supply Chain Planning, the following entities are classified as global entities:

• Approved Supplier List

• Currencies and Currency Conversion Class

• Customer and Customer Site

• Demand Class

• Order Orchestration Reference Objects

• Planners

• Regions and Zones

Note:  When you set up your geographies in the Oracle Trading Community Architecture or regions using the
Supply Chain Planning Regions import template (ScpRegionsImportTemplate.xlsm), ensure that the names
used for the first- and second-level regions are different. If the names are the same, collections won't happen
for the second-level region and child regions.

• Shipping Methods (Carrier, Mode of Transport, Service Level)
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• Supplier Capacity

• Suppliers and Supplier Sites

• Units of Measure and UOM Conversions

Data Collection Types for Supply Chain Planning  
When you collect planning data, one of the parameters you specify for the Collect Planning Data task is the Collection
Type parameter.

You can select this task from any of your Supply Chain Planning work areas. For the Collection Type parameter, you can
select one of the following values:

• Targeted: Choose the Targeted collection type when you want to collect a significant volume of source system
data. Typically, you use the Targeted collection type in scenarios such as bulk upload of transaction data,
instance upgrade, and change in collection filters.

• Net change: Choose the Net change collection type when you want to collect changed data and new records
since the last successful collection cycle.

• Automatic selection: Choose the Automatic collection type when you want the planning process to decide and
automatically select an appropriate collection type for each of the entities.

Targeted
You use the Targeted collection type when you want to perform a complete refresh of the data in the data repository.
In this mode, the planning process deletes the existing data for the selected entities from the data repository. Next, if
subsequently collected from the source, the data for the selected entities replaces the deleted data.

Note:  For the following data collection entities, you can use only the Targeted collection type: Item Costs, Resource
Availability, Fiscal Calendars, and all Shipment and Booking History data.

Net change
When you use the Net Change collection type, you collect data incrementally. The Net Change collection type collects
only changed or new data. Collecting data using the Net Change collection type is usually faster than using the Targeted
collection type. You typically use the Net Change collection type when you have previously performed a Targeted
collection, and now you want to keep your planning data current with your execution system data. You cannot select the
demand planning data when the collection type is Net Change.

Automatic selection
You use the Automatic collection type when you are not sure which collection type to select and you want the planning
process to decide the collection type for each entity. The planning process evaluates each entity on multiple factors,
such as the last collected date for an entity, and decides whether to perform a Targeted or a Net Change collection for
the entity. You can manually select the entities that you want to collect or you can use one of the predefined templates
to select your entities. If you select one of the predefined templates, you can't make any changes in the Reference Data,
Demand Planning Data, and Supply Planning Data tabs.
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Manage Planning Source Systems for Data Collections  
To populate the planning data repository, also known as the order orchestration and planning data repository, you
collect data from the Oracle Fusion source system.

On the Manage Planning Source Systems page in one of the Supply Chain Planning work areas, enable organizations for
collections. Depending on your security privilege, you can also enable organizations from the Setup and Maintenance
work area.

Go to the Setup and Maintenance work area, then go to the task:

• Offering: Supply Chain Planning

• Functional Area: Supply Chain Planning Configuration

• Task: Manage Planning Source Systems

The Oracle Fusion Source System
The Oracle Fusion source system is included as a source system for data collection. Supply chain planning, order
orchestration, and order promising processes use data that are stored in the planning data repository. You ensure the
Collections Allowed check box is enabled and manage which organizations you enable for collections.

To open the Manage Trading Community Source Systems page, navigate to the Setup and Maintenance work area and
use the following:

• Offering: Supply Chain Planning

• Functional Area: Supply Chain Planning Configuration

• Task: Manage Trading Community Source System

External Source Systems
You can also allow collections for external source systems if you will be loading planning data from files for Oracle
Fusion Global Order Promising. You must first define the external source system on the Manage Trading Community
Source Systems.

There are two types of external source systems: Others and External.

Version External
The version External source system indicates that the source system is not connected to any other Oracle Fusion
Cloud Applications Suite. This source system is not integrated with the Product Information Management work area,
Oracle Trading Community Model, and Oracle Order Management. The external source system is also referred as a
completely external source system. You cannot enable any other source system settings that are related to other Oracle
Fusion applications. You can select the Collections allowed check box now or later depending on when you want to start
collecting data. This enables the source system for data collections using the file-based import process.

Version Others
The version Others source system indicates that the source system is connected to other Oracle Fusion Applications
Suite. This source system is integrated for the Product Information Management work area, Oracle Trading Community
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Model, and Oracle Fusion Cloud Order Management. The following conditions are applicable when the external source
is Others.

• External system data for Items, Item Structures, and Catalogs is uploaded to the Product Information
Management work area

• External system data for Customers, Customer Sites, Regions and Zones is uploaded to Oracle Oracle Trading
Community Model

• External system data for Sales Orders is uploaded to Oracle Fusion Cloud Order Management

For more information on types of data that can be collected for each source system, see the Import Templates Used to
Create CSV Files for Supply Chain Planning topic.

Organizations Enabled for Data Collections
The process for enabling organizations varies depending on the version of the source system.

To enable organizations for data collections when the source system version is Oracle Fusion, perform the following
steps:

1. Click the Manage Organization List button for your Oracle Fusion source system.
2. Click the Refresh Organization List button to update the organizations list.

When adding organizations to the Oracle Fusion source system to be collected into planning, you must click the
Refresh Organization List button and then enable the organizations for collections.

3. Select the Enable for Collections check box for the organizations from which you want to collect data.

Tip:  When performing collections during your initial setup, collect order orchestration reference objects from the
predefined Oracle Fusion source system, and consider collecting organizations. After enabling organizations for
collection, collect organizations first. You can confirm the collection results on the Supply Network Model page.

To enable organizations for data collections when the source system version is External (completely external source
system), upload organizations using the file-based import process. The organizations are automatically enabled for
collections. In the Supply Chain Planning Organizations FBDI import template (ScpOrganizationImportTemplate.xlsm),
Organization tab, enter Active in the Status column for all organizations you want to import. If you leave the field blank
for an organization, that organization won't show up in the Maintain Supply Network Model page in the Plan Inputs
work area.

To enable organizations for data collections when the source system version is Others, perform the following steps:

1. Define an organization as an item-organization in the product data model.
2. Upload the organization using the file-based import process and associate the organization with Others source

system.

Related Topics
• Import Templates Used to Create CSV Files for Supply Chain Planning

• Considerations for Enabling Organizations for Data Collections

• Define Flexfield Mappings
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How the Order Orchestration and Order Promising
Processes Use the Collected Planning Data  
You perform data collections to populate the planning data repository. In addition to being used by Supply Chain
Planning processes, the collected data is used by Oracle Order Management order orchestration processes and by
Oracle Global Order Promising processes.

Data Collections
You must perform data collections to populate the planning data repository, also called the order orchestration and
planning data repository, with data from the Oracle source system or from a completely external source system. When
you load data from an external source system, use the XLSM files to organize your data in the required format and then
convert the data into CSV files. You can then upload the CSV files to the planning data repository.

Order Orchestration
Order orchestration processes use some reference data directly from the planning data repository. You must perform
data collections for the order orchestration reference entities even if you are not using the Supply Chain Planning work
areas.

Note:  Before collecting data from your Oracle source system, you must define at least one organization for the
source system. After you have set up at least one organization, you must update the organization list on the Manage
Planning Source Systems page and then enable at least one of the organizations for collections. If you have not
enabled any organization, then the collections process ends with an error.

Order Promising
The Global Order Promising processes use an in-memory copy of the data from the planning data repository. When
order orchestration processes send a scheduling request or a check availability request to Oracle Global Order
Promising, the order promising processes use the data stored in main memory to determine the response to send back
to order orchestration. You must refresh the Global Order Promising data store after every collections so that the main
memory always reflect the current.

Related Topics
• Collect Data for Global Order Promising
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How You Enable Cross-References of Entities by Data
Collections  
Cross-references enable you to locate the correct source value for each cross-referenced entity. When you enable
entities for cross-referencing, data collection pays attention to the cross-references that you have set up for certain
values.

To enable cross-referencing of entities, click the Manage Planning Data Collection Processes task from your supply
chain planning work area. Select the source system from the list, and then enable the available entities that you want to
cross-reference during data collections.

You can view the cross-referenced data for each entity on the Cross-Reference Relationships for Collected Data page in
the Plan Inputs work area.

How Planning Processes Collect Different Work
Definitions and Item Structures  
You may be concerned that the work definition and item structure data in your supply chain planning work area does
not match with what was defined in Oracle Manufacturing.

You may be concerned that the work definition and item structure data in your supply chain planning work area does
not match with what was defined in Oracle Fusion Cloud Manufacturing.

You don't need to worry. The planning application collects and uses data based on how the work definitions and item
structures are defined and associated in the manufacturing source system.

Work Definitions and Item Structures in the Source System
The work definition is a primary source of data for the planning application. The planning process uses the work
definition of make order items to determine component and resource requirements. In case the work definition is not
defined, the planning process uses the defined item structure, but to plan for components only. If a work definition
is defined and no item structure is associated to it, then you can manually add ad hoc components to it. If an item
structure is associated to it, you can still add ad hoc components to the work definition, alongside the components in
the item structure. Remember that while a work definition can be associated with only one item structure, one item
structure can be associated with several work definitions within the parent item.

Work Definitions and Item Structures in the Planning Data Repository
In the manufacturing source system, the work definitions and item structures for an item can be defined and associated
in different ways. The following table lists the most common source system combinations and how the collections and
run plan processes proceed accordingly:
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Oracle Manufacturing Definition Item Structure Name and Work Definition
Name in the Planning Data Repository

Planning Collections Processes

Only item structure is defined for an item. No
work definition is defined.
 

Item structure name exists, no work definition
name
 

The planning process collects the item structure
information but does not collect information for
routing, operations, or item resources.
 
The planning process uses item structure to
plan components and does not plan resources.
 

Only work definition is defined for an item. No
item structure is defined.
 

Work definition name exists, no item structure
name
 

The planning process collects the work
definition information to populate the item
structure and routing information.
 
The planning process populates the component
information and operation sequence number
in the item structure based on the ad hoc
components and operation assignment
available in the work definition.
 
The planning process uses the work definition
information to plan both components and
resources.
 

Both item structure and work definition are
defined for the item.
 

Both work definition name and item structure
name exist
 

The planning process uses the components
that are associated with the work definition to
plan. The planning process does not consider
any components of item structure that are not
associated with the work definition. You can
override the item structure component usage
within the work definition.
 
The planning process collects component
attributes (such as component effectivity)
from the item structure if the components are
associated with the work definition.
 
The planning process uses the work definition
to plan resources.
 

Both item structure and work definition are
defined for the item, but the work definition
does not refer to the item structure. Ad hoc
components are assigned to the work definition
operations.
 

Work definition name exists, no item structure
name
 

The planning process collects the components
from the work definition and not from the
item structure in the Oracle Fusion Product
Information Management solution.
 
The process plans components based on work
definition operation assignments and plans
resources based on the work definition.
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Enable External Data Collection for the Oracle Fusion
Source System  
Enable external data collection if you want to load transactional data from external systems. Typically, you do this if
some of your supply chain processes are managed in external applications. You load the transactional data from these
applications using file-based data imports (FBDI).

You can use external data sources for these functional areas: Inventory and Materials Management, Procurement, Order
Management, and Manufacturing. When you enable external data collection for a functional area, be aware of these
restrictions:

• You can't use configure-to-order, drop shipment, and back-to-back fulfillment.

• The entities associated with the functional area are no longer available for Oracle Fusion source collection. For
example, if you enable Order Management, the Sales Orders entity won't be available on the Collect Planning
Data page for you to select for Oracle Fusion source collection.

This table lists the entities for each functional area.

Functional Area Entities

Inventory and Materials Management
 

On-hand Quantity and Transfer Orders
 

Procurement
 

Purchase Orders and Requisitions
 

Order Management
 

Sales Orders and Reservations
 

Manufacturing
 

Work Order Supplies, Resource Availability, Resources, Work Definitions, and Item Structures
 

Enable External Data Collection
Use these steps to enable external data collection:

1. Select the Manage Planning Source Systems task in the Tasks panel from any Supply Planning work area
page. Or use this task in the Setup and Maintenance work area:

◦ Offering: Supply Chain Planning

◦ Functional Area: Supply Chain Planning Configuration

◦ Task: Manage Planning Source Systems

2. In the list of source systems, select the row that has Oracle Fusion in the Version column.
3. In the Actions menu, click Select Data Sources.
4. Select the Enable External Data check box, and then select the functional areas that you want to source

transactional entities for.
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Note:  Every time you enable or disable external data collection, you must run a targeted data collection to ensure
complete refresh of data in the data repository. Only the data for the organizations included in the FBDI template is
refreshed.

Related Topics
• How You Load Planning Data from Files

Collection of Safety Stock Levels  
This topic explains how you collect safety stock levels for modules of Oracle Fusion Cloud Supply Chain Planning.

Note these points about collecting safety stock levels:

• You must use the file-based data import (FBDI) template named Supply Chain Planning Safety Stock Levels
(ScpSafetyStockLevelImportTemplate.xlsm) to import externally calculated safety stock levels.

You can't use the Collect Planning Data page to collect safety stock levels from an Oracle Fusion source system.

• You can import safety stock levels at only the organization level.

You can't import safety stock levels at the subinventory level.

• You can import only time-phased safety stock quantities using the import template. You can't use the null value
for the Effective Date column.

For Oracle Replenishment Planning, only one value is accepted for a combination of an item and an
organization. If you upload time-phased safety stock quantities, the quantity for which the effective date is on
or before the plan start date and that's closest to the plan start date is used. For information about externally
calculated safety stock quantities for replenishment plans, see the topic titled How You Upload Externally
Calculated Safety Stock.

Collect Planning Data from the Oracle Fusion Source
System  

How You Collect Different Data Types for Supply Chain Planning  
When you collect data, you collect data from three categories: reference data, demand data, and supply data. On the
Collect Planning Data page there is a tab for each of these categories.

The collected data are stored in the planning data repository.

The following figure illustrates the three categories of data that you collect from the Oracle Fusion source system to the
planning data repository.
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Explanation of Callouts

1. Reference data is primarily sourced from Oracle Fusion Cloud SCM
2. Demand data comes from Oracle Fusion Cloud Order Management and Oracle Fusion Cloud Inventory

Management
3. Supply data is sourced from Oracle Inventory Management, Oracle Fusion Cloud Manufacturing, and Oracle

Fusion Cloud Purchasing

Reference Data
The collection process begins with reference data, which is primarily sourced from Oracle Fusion Cloud SCM. You collect
the data collection entities, such as basic item, resource, organization, customers and suppliers, and calendar data.

Note:  Oracle Sales and Operations Planning uses the Bill of Resources entity to link the make items with their
associated components and resource requirements. For more information on collecting Bill of Resources from an
external source system, see the Loading Planning Data from Files section.

You also use Oracle Fusion Cloud Supply Chain Planning to collect the following items:

• Item structures: To explode item-level demand into component demands and supplies.

• Work Definitions: To assign the component and resource requirements for make items.

• Units of measure: To align plan data and to convert plans from one set of units to another.

• Costs: To review plans in financial terms and evaluate the financial impact of planning decisions.

Demand Data
You collect demand data from two potential sources:

• Sales orders that flow from Oracle Fusion Cloud Order Management: You can use this as the basis of the
demand forecast, while current orders can consume the demand in near-term forecast time buckets.

• Shipment history from Oracle Fusion Cloud Inventory Management: You can use this to generate a shipments
forecast.
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Supply Data
You collect supply data from three sources:

• Oracle Inventory Management: This provides data related to on hand inventory, reservations, material transfers,
in-transit supplies, and receipts.

• Oracle Manufacturing: This provides work in process status and any manufacturing work orders.

• Oracle Purchasing: This provides purchase requisitions and purchase orders.

Related Topics
• How You Load Planning Data from Files

• Run the Load Planning Data from Files Process

• Import Templates Used to Create CSV Files for Supply Chain Planning

Collection Filters and Collection Templates  
You use collection filters and collection templates when you need to collect some common set of entities repeatedly.

The collection filters and collection templates are located on the Collect Planning Data page. To open the Collect
Planning Data page, click the Collect Planning Data task from one of the Supply Chain Planning work areas.

Depending on your security privileges, you can also open the Collect Planning Data page from the Setup and
Maintenance work area. In the Setup and Maintenance work area, use the following:

• Offering: Supply Chain Planning

• Functional Area: Supply Chain Planning Configuration

• Task: Collect Planning Data

Collection Filters
Use collection filters to improve the performance and efficiency of the collections process, and to avoid accumulation of
irrelevant data in the planning data repository. You can use several filter criteria while performing collections, such as by
employing catalogs, order types, and price lists. You can also use date-based filters for collecting shipment and booking
history information.

Enabling Collection Filters
To enable collection filters, you must first run the schedule process called Load Filter Names for Planning Data
Collection from the Scheduled Processes work area. When you run the scheduled process, the filters get enabled in the
Collect Planning Data page. Then, you can apply the filters from the next collection.

Collection Templates
Use collection templates when you want to collect a set of data repeatedly over a period. You can select either one of the
predefined templates that serves your specific need, or you can create your own template and save it for future use.

When you select a predefined template from the list, the Collection Type field is defaulted to Automatic selection and
you cannot edit the field. Also, when you select a predefined template, the Select Collection Filters field is disabled.
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You can create a collection template on the Collect Planning Data page by selecting the data collection entities and
saving the template for future use. For example, if you frequently collect certain supply planning transactional entities,
such as On Hand, Purchase Orders, and Purchase Requisitions, then save these entities as a collection template. It
reduces the overhead of selecting the same entities for subsequent collection cycles.

If the template file contains any error during the upload process, rectify the issue found in the log file and upload the
template file again.

Collect Data Using the Targeted Collection Type  
To perform a complete refresh of the data repository used by the Supply Chain Planning products, run a targeted
collection.

You can run the targeted collection immediately or you can schedule the process to run later. Demand planning data
can only be collected by using the Targeted collection type.

Note:  Before collecting demand planning data, you must successfully run the Load Filter Names for Planning Data
Collection scheduled process.

Perform the following steps to collect reference data, demand planning data, and supply planning data using the
Targeted collection type.

1. Access the Collect Planning Data page from a Supply Planning work area or the Setup and Maintenance work
area.

◦ If you are in one of the Supply chain Planning work areas:

i. Click the Tasks panel tab.
ii. In the Tasks panel drawer, click the Collect Planning Data link.

◦ If you are in the Setup and Maintenance work area, then select the following:

- Offering: Supply Chain Planning
- Functional Area: Supply Chain Planning Configuration
- Task: Collect Planning Data
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2. On the Collect Planning Data page, complete the following steps.

◦ On the Parameters tab:

i. Select your source system.
ii. For the collection type, select Targeted.

Demand planning data can only be collected by using the Targeted collection type.
iii. Click Select Collection Filters to select the collection filters.

◦ On the Reference Data subtab, move the required reference entities to the Selected Entities area.

◦ On the Demand Planning Data subtab, set options to collect the historical demand data in the planning
data repository. The planning process uses the historical demand data for statistical forecasting.

- Collection Time Frame Options: You can specify a fixed or rolling date range for which to collect
data.

The Fixed Date Range option enables you to collect history data within a fixed date range that you
specify.

The Rolling Date Range option enables you to collect the history data for the number of days that
you specify. For example, if you forecast weekly, specify 7 in the Number of Days to Collect field
to collect the demand history data once per week. The data collections collect the demand history
data for the latest week.

Select Roll off time periods automatically to truncate the history data by the number of days that
you specify in the Number of days to keep field each time you run collections for the demand
history data. For example, if you prefer to forecast each week based on the history data of 52
weeks, select the Roll off time periods automatically check box and specify Number of days
to keep as 364 days. This setting ensures that as you collect data every week, you keep the most
recent history of 52 weeks and automatically purge history data older than 52 weeks.

- History Measures and Attributes: Select your shipments history and bookings history measures.
- Collection for ETO Items: Select Collect history from associated base models to collect

bookings and shipments history for Engineer to Order (ETO) items from the associated base
models. When you don't select this option, the history is collected from the standard ETO items.

- History Data Options: To collect only specific order types, select from the Order Types to Include
list of values. By default, all order types are included.

Select Organization - Consumption Inventory Transactions to Include to collect consumption
inventory transactions at the organization level. You can collect only the transfer orders inventory
transactions or all consumption inventory transactions.

Select Subinventory - Consumption Inventory Transactions to Include to collect consumption
inventory transactions at the subinventory level. You can collect only the transfer orders inventory
transactions or all consumption inventory transactions for the organizations that you enabled for
subinventory planning.

Select the Collect amount data for history check box to collect amount data.
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- Additional Options: Select additional options for collections.

Collect Price Lists: Collect the price lists specified in the collections filter for price lists, or collect all
price lists if no filter is specified.

Collect Configure to Order Data: If you selected history measures and attributes, then select the
relevant check boxes to collect shipment history options and booking history options.

Sales Organization Hierarchy: Select Enable sales organization hierarchy collection to collect
one or more sales hierarchies.

◦ On the Supply Planning Data subtab:

i. Move the required supply entities to the Selected Entities area.
ii. If you collect resource availability, then select a date range type: Fixed or Relative to collection

run date.

If you selected Fixed, then provide a start date and an end date for collecting resource availability.

If you selected Relative to collection run date, then enter a number of days in the Collection
Window in Days field. The number that you enter determines a collection window in days to
collect resource availability based on a rolling time window. That rolling time window adjusts itself,
based on the date that you run collections. For example, if you specify 90, then resource availability
is collected for the next 90 days each time from the date of the collection run.

Note:  You can save your date range type selection for resource availability collection as a
collection template to use later.

iii. You can collect the existing data for the resource availability.
iv. You can also regenerate the resource availability data and then collect the data. If you select the

Regenerate data, and then collect option, the collections process runs the Update Resource
Availability Job scheduled process first and then collects the resource availability data.

3. (Optional) Click the Schedule tab and set collections to run as soon as possible or schedule to run at a different
time.

4. Click Submit to start the collections process.
5. Monitor the collection status using the Scheduled Processes page.
6. Review the collected data in the Plan Inputs work area.

Related Topics
• Verify the Load Planning Data from Files Process

• Review Data in the Planning Data Repository

• Set Up Forecast Consumption for Transfer Orders

Collect Data Using the Net Change Collection Type  
You can collect data from the Oracle Fusion source system by running the net change collection or by scheduling to run
the process later.

Before running a Net Change collection, you must run a Targeted collection for the selected entities. After the first
Targeted collection, you can run Net Change collections.
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Perform the following procedure to collect reference data and supply planning data using the net change collection
type:

1. If you are in one of the Supply Chain Planning work areas, then click the Tasks panel tab. In the Tasks panel
drawer, click the Collect Planning Data task. If you are in the Setup and Maintenance work area, then use the
following:

◦ Offering: Supply Chain Planning

◦ Functional Area: Supply Chain Planning Configuration

◦ Task: Collect Planning Data

2. Complete the following parameters for the Collect Planning Data process:

a. Select your source system.
b. Select the collection type as Net change.

Note:  You cannot make any changes to the filter criteria and demand planning data in the net change
collection type.

c. In the Reference Data tab, move the required reference entities to the Selected Entities area.
d. In the Supplies Planning Data tab, move the required supply entities to the Selected Entities area.

3. (Optional) Click the Schedule tab and set collections to run as soon as possible or schedule to run at a different
time.

4. Click Submit to initiate the collections process.
5. Monitor the collection status using the Scheduled Processes page.
6. Review the collected data in the Plan Inputs work area.

Related Topics
• Verify the Load Planning Data from Files Process

• Review Data in the Planning Data Repository

• How do I update existing setup data?

Enable Organization Group Collection for the Net Change
Collection Type  
You can use organization groups to limit the net change data collection from a source system to specific organizations.

Using organization groups for collection also eliminates the chances of data overlap when multiple instances of net
change collections are run at a time. Planners can run collections for their organizations without waiting for each other.

Let's take a simple example where your organization considers only the D1 and D2 distribution centers in your source
system for shipments to your customers. In such a case, you can create an organization group, assign D1 and D2 to the
organization group, and collect net change data specifically for this group.

Note:  Before you begin, ensure that you have your organization groups created. A supply planner creates and
manages organization groups using the Manage Organization Groups button on the Maintain Supply Network Model
page.
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Do these to collect net change data for an organization group.

1. Access the Collect Planning Data page or Load Planning Data from Files page from a Supply Planning work
area.

2. Select the source system. Organization groups are managed within the source systems.
3. Select the Net Change collection type. You can select an organization group for data collection only when the

collection type is Net Change.
4. Enable the organization group collection, and then select an organization group.
5. Perform the net change data collection. Refer to the Collect Data Using Net Change Collection Type topic in this

chapter for instructions.

Note:  After selecting your organization group and other data collection entities, you can also save your selections as
a template. Refer to the Collection Filters and Collection Templates topic in this chapter for additional information.

Related Topics
• Collect Data Using the Net Change Collection Type

• Collection Filters and Collection Templates

• How You Maintain Your Supply Network Model

Manage Incremental Planning Collections Artifacts Scheduled
Process  
Use the Manage Incremental Planning Collections Artifacts scheduled process to create, maintain, drop, or truncate net-
change planning collection log tables.

Log tables store information about modifications to supported entities within net-change or incremental collections.
These modifications include actions such as deletion, updating, or creation of entities or their attributes. For example,
the details could reflect alterations to the date or quantity of a purchase order schedule.

The Manage Incremental Planning Collections Artifacts scheduled process is run to manage log tables in these
modules:

• Oracle Supply Planning

• Oracle Demand and Supply Planning

• Oracle Sales and Operations Planning

• Oracle Demand Management

• Oracle Replenishment Planning

• Oracle Global Order Promising

• Oracle Backlog Management

For more information on this scheduled process, see the topic titled Manage Incremental Planning Collections Artifacts.
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Load Planning Data from Others and External Source
Systems  

How You Load Planning Data from Files  
You upload data using CSV files for specific business objects using the targeted or net change method.

Note:  To create the CSV files, you can use a set of Microsoft Excel template files that are provided for this purpose.
You can download the templates from the File-Based Data Import (FBDI) for SCM guide in the Oracle Help Center.

You use the targeted mode when you want to refresh data for selected entities in the planning data repository. You use
the net change mode to collect data incrementally. The net change collections mode collects only the changed or new
data. Data collection using the net change mode is fast compared to the targeted mode. The net change mode is used
to retain planning data to current with that of the executing system.

The following figure illustrates the process of collecting data from files.
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To load planning data from files, you perform the following steps:

1. Create CSV files using Microsoft Excel template and compress them into zip files.

a. Save the CSV file using the suggested entity name. You can add an underscore and other additional
characters to the CSV file name. However, you can provide any name to the zipped file.

For example, you can name the CSV file ShipmentHistory_abc.csv and the zip file LoadingCSV.zip.
2. Run the process to load planning data from files
3. Verify the load planning data process
4. Review the loaded data

Related Topics
• Create CSV Files to Load Planning Data

• Import Templates Used to Create CSV Files for Supply Chain Planning

• Run the Load Planning Data from Files Process

• Verify the Load Planning Data from Files Process

• Review Data in the Planning Data Repository

Create CSV Files to Load Planning Data  
To perform the Load Planning Data from Files task in one of the Supply Chain Planning work areas or Setup and
Maintenance work area, you must prepare the data you want to load.

You must create the necessary CSV files used to create files for import. This procedure explains how to create CSV files
to prepare planning data for loading.

1. Locate the applicable file import templates (XLSM files) in the following guide: File-Based Data Import (FBDI) for
SCM. Extract the templates to a local space.

For additional information about creating and importing CSV files, see the following section in the
Implementing Common Features for SCM guide: External Integration chapter, External Data Integration
Services for Oracle Cloud section.

2. Open the template file for the entity you are preparing and complete the file import template worksheet.

You must enable the macros in the template file before generating the CSV file.

CAUTION:  For the cells that contain dates, ensure that the data is set to the correct format in the data type.
For example, date must be set to YYYY/MM/DD.

3. After you finish preparing the data in the worksheet, generate the CSV file. The Generate CSV File button is
located in the Instructions and CSV Generation worksheet of the workbook.

4. When you save the generated CSV file, you must use the suggested name of the entity. You can add
underscore and add additional characters to the file name. For example, you can name the CSV file as
ShipmentHistory_abc.csv and you can name the file as LoadingCSV.zip.
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5. Compress the CSV file into a zipped file format using a compression utility. You can provide any name to the
zipped file.

Note:  You can include multiple CSV files in a single compressed file for a source system. The load process
uploads them in a sequential order. Select the CSV files and compress them directly. Do not compress the
parent folder that contains the files.

This completes the preparation of a file that you will upload to collect planning data.

Related Topics
• How You Load Planning Data from Files

• Run the Load Planning Data from Files Process

Data Collection Sequence  
This topic explores the sequence that you should follow for data collection.

Data collection involves collecting entities in a predefined sequence. The collected entities form the basis for supply
planning calculations. To have accurate data, you must ensure to collect the entities in a proper sequence. You cannot
collect some entities without collecting their precursor entities. The data collection sequence is very crucial when you
collect data from an external source system using CSV files.

If you run targeted collections for all entities, you can ignore the sequence for collections because targeted collections
automate the collection sequence for all entities within a single collections request. If you collect many entities in a
single request, collections will process them according to the sequences shown in this topic. If you collect only a few
entities, then you must be aware of the collections sequence information. For example, you should not collect work
orders before you collect items or resources.

To make the workflow simple, the collection sequence is divided into two parts - Part A and Part B. The collection
entities in Part B are dependent on the collection entities in Part A. You must collect the entities in Part A before you
collect the entities in Part B. Also, the collection entities are grouped together for easier presentation. The data groups
in Part A are:

• Collections Sequence Part A for Item Data

• Collections Sequence Part A for Region, Location, and Customer Data

• Collections Sequence Part A for Currency, Calendar, Demand Class, and UOM Data

The data groups in Part B are:

• Collections Sequence Part B for Sales Order and Assignment Sets

• Collection Sequence Part B for Work Orders, Work Definition, and Item Structure

Every collection sequence in Part A starts with defining a source system where the collected data will reside. If you are
collecting data to the same source system, you define the source system only once. Then, use the same source system
to collect all the entities.

The following figure provides an overview of the data collection sequence. The overview shows how Part A and Part B
fit together to form a complete data collection flow.
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Collections Sequence Part A for Item Data
The following image shows the collections sequence to follow while collecting Item data from external source systems.
This image represents only half of the entities for collecting Item data.

Note:  The Organization entity is marked with an asterisk because you can collect other entities such as Planner, Item
Cost, Subinventory, Carrier, Calendar Assignment, Supplier, and Supplier Site after collecting Organization. For more
information on the collection sequence for these entities, see the Collections Sequence Part A for Currency, Calendar,
Demand Class, and UOM Data figure. Refer to the entities that are collected after Organization. Also, ensure that you
collect Location before collecting Supplier Site.
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When you collect the data described here, continue to the collection sequence Part B described in the following
subsections.

• Collection Sequence Part B for Sales and Order and Assignment Sets

• Collection Sequence Part B for Work Orders, Work Definition, and Item Structure

Collections Sequence Part A for Region, Location, and Customer Data
The following image shows the collections sequence to follow while collecting Regions and Customers data from
external source systems. This image represents only half of the entities for Item data.
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When you collect the data described here, continue to the collection sequence Part B described in the following
subsections.

• Collection Sequence Part B for Sales and Order and Assignment Sets

• Collection Sequence Part B for Work Orders, Work Definition, and Item Structure

Collections Sequence Part A for Currency, Calendar, Demand Class, and UOM Data
The following image shows the collections sequence to follow while collecting Currency, Calendar, Demand Class, and
UOM data from external source systems. Also, ensure that you collect Location before collecting Supplier Site.

Note:  The Calendar entity is marked with an asterisk because there are other entities that are associated with
Calendar that you must collect in a sequence. To collect other entities associated with Calendar, see the Calendar
Upload Sequence figure.
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When you collect the data described here, continue to the collection sequence Part B described in the following
subsections.

• Collection Sequence Part B for Sales and Order and Assignment Sets

• Collection Sequence Part B for Work Orders, Work Definition, and Item Structure

Collection Sequence for Calendar Data
The following image shows the collections sequence to follow for collecting the Calendar data. Calendar data is a part
of the data collection in Part A. You collect the Calendar data in the following subsection: Collection Sequence Part A for
Currency, Calendar, Demand Class, and UOM Data.
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Collections Sequence Part B for Sales Order and Assignment Sets
The following image shows the collections sequence to follow while collecting Sales Order and Assignment Sets data
from external source systems. The data entities in Part B are dependent on Part A. So, you must collect entities listed in
Part A before you collect the entities in Part B.
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Collection Sequence Part B for Work Orders, Work Definition, and Item Structures
The following image shows the collections sequence to follow while collecting Work Orders, Work Definition, and Item
Structure data from external source systems. The data entities in Part B are dependent on Part A. So, you must collect
entities listed in Part A before you collect the entities in Part B.
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Import Templates Used to Create CSV Files for Supply Chain
Planning  
You can use the Microsoft Excel templates (XLSM files) to prepare the data for the supported collection entities.

The templates are listed in the following guide: File-Based Data Import (FBDI) for SCM. Extract the templates to a local
drive, enter appropriate data as described in the template, and generate CSV files. Compress the CSV files to a zipped
file format and upload the .zip file to the Universal Content Manager using the File Import and Export utility. The data is
then loaded from the Universal Content Manager to the planning data repository.

Collect Data from the Oracle Fusion Source

The following table lists the collections entities that can be loaded into the planning data repository for the Oracle
Fusion source. The Collection Entity column provides the name of the entities for which you can collect the data.
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The XLSM File Name column provides the template name that you will download for the respective collection entity.
Download the XLSM template from the File-Based Data Import (FBDI) for SCM guide. The Link in Data Import Guide
column provides the name of the topic in the FBDI guide from where you will download the template. For example, to
collect data for the Item Costs collection entity, refer to the Item Cost Import topic in the FBDI guide.

Collections Entity Link in Data Import Guide XLSM File Name

Item Costs
 

Supply Chain Planning Item Cost
 

ScpItemCostImportTemplate.xlsm
 

Customer Specific Item Relationships
 

Supply Chain Planning Item Substitute
 

ScpItemSubstituteImportTemplate.xlsm
 

Planners
 

Supply Chain Planning Planners
 

ScpPlannersImportTemplate.xlsm
 

Item Suppliers
 

Supply Chain Planning Approved Supplier List
 

ScpApprovedSupplierListImportTemplate.xlsm
 

Demand Classes
 

Supply Chain Planning Demand Classes
 

ScpDemandClassImportTemplate.xlsm
 

Allocation Assignments and Allocation Rules
 

Supply Chain Planning Planning Allocation
Rules
 

ScpPlanningAllocationRulesImportTemplate.xlsm
 

ATP Assignments and ATP Rules
 

Supply Chain Planning Available-to-Promise
Rules
 

ScpATPRulesImportTemplate.xlsm
 

Supply Update Rules
 

Supply Chain Planning Real Time Supply
Updates
 

ScpRealTimeSupplyUpdatesImportTemplate.xlsm
 

Measures
 

Supply Chain Planning Measures
 

ScpMeasuresImportTemplate.xlsm
 

Note:
You must use separate CSV files to collect
measure data for measures with different
dimensional granularity.
 

Booking History
 

Supply Chain Planning Bookings History
 

ScpBookingHistoryImportTemplate.xlsm
 

Option Booking History
 

Supply Chain Planning Option Bookings History
 

ScpOptionBookingHistoryImportTemplate.xlsm
 

Shipment History
 

Supply Chain Planning Shipments History
 

ScpShipmentHistoryImportTemplate.xlsm
 

Option Shipment History
 

Supply Chain Planning Option Shipments
History
 

ScpOptionShipmentHistoryImportTemplate.xlsm
 

Price Lists
 

Supply Chain Planning Price List
 

ScpPriceListImportTemplate.xlsm
 

Causal Factors
 

Supply Chain Planning Causal Factors
 

ScpCausalFactorsImportTemplate.xlsm
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Collections Entity Link in Data Import Guide XLSM File Name

Forecast Measures
 

Supply Chain Planning Forecast Measures
 

ScpForecastMeasureImportTemplate.xlsm
 

Note:
This template has been superseded
by the generic template
ScpMeasuresImportTemplate.xlsm, but
will continue to be supported. Future
enhancements will be made only to the
generic measures template.
 

Fiscal Calendars
 

Supply Chain Planning Fiscal Calendars
 

ScpFiscalCalendarImportTemplate.xlsm
 

Forecasts
 

Supply Chain Planning External Forecasts
 

ScpExternalForecastImportTemplate.xlsm
 

Safety Stock Levels
 

Supply Chain Planning Safety Stock Levels
 

ScpSafetyStockLevelImportTemplate.xlsm
 

Supplier Capacity
 

Supply Chain Planning Approved Supplier
Capacity
 

ScpApprovedSupplierCapacityImportTemplate.xlsm
 

Planned Order Supplies
 

Supply Chain Planning Planned Order Supply
 

ScpPlannedOrderSupplyImportTemplate.xlsm
 

Note:
This template is only used to load planned
order supply to Global Order Promising.
 

Sourcing Rule and Assignments
 

Supply Chain Planning Sourcing Rules
 

ScpSourcingImportTemplate.xlsm
 

Cross-Reference Mapping Information
 

Supply Chain Planning Cross-Reference Data
 

ScpCrossReferenceDataImportTemplate.xlsm
 

Collect Data from External Source - Version Others

The following table lists the collections entities that can be loaded into the planning data repository from an external
source, where the version is Others. The Collection Entity column provides the name of the entities for which you can
collect the data. The XLSM File Name column provides the template name that you will download for the respective
collection entity. Download the XLSM template from the File-Based Data Import (FBDI) for SCM guide. The Link in Data
Import Guide column provides the name of the topic in the FBDI guide from where you will download the template. For
example, to collect data for the Items and Item Costs collection entities, refer to the Item Cost Import topic in the FBDI
guide.

Collections Entity Link in Data Import Guide XLSM File Name

Item Costs
 

Supply Chain Planning Item Cost
 

ScpItemCostImportTemplate.xlsm
 

Customer Specific Item Relationships Supply Chain Planning Item Substitute ScpItemSubstituteImportTemplate.xlsm
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Collections Entity Link in Data Import Guide XLSM File Name

   

Planners
 

Supply Chain Planning Planners
 

ScpPlannersImportTemplate.xlsm
 

Organizations (Warehouses) and Organization
Site (Including Organization Site - Internal
Location Mapping)
 

Supply Chain Planning Organizations
 

ScpOrganizationImportTemplate.xlsm
 

Subinventories
 

Supply Chain Planning Subinventories
 

ScpSubInventoryImportTemplate.xlsm
 

Suppliers and Supplier Sites
 

Supply Chain Planning Suppliers
 

ScpPlanningSupplierImportTemplate.xlsm
 

Item Suppliers
 

Supply Chain Planning Approved Supplier List
 

ScpApprovedSupplierListImportTemplate.xlsm
 

Interlocation Shipping Networks
 

Supply Chain Planning Interlocation Shipping
Methods
 

ScpInterLocationShipMethodsImportTemplate.xlsm
 

Currencies, Currency Conversion Types, and
Currency Conversion Rates
 

Supply Chain Planning Currencies
 

ScpCurrencyImportTemplate.xlsm
 

Units of Measure, Units of Measure
Conversions, and Units of Measure Class
Conversions
 

Supply Chain Planning Units of Measure
 

ScpUOMImportTemplate.xlsm
 

Calendars, Calendar Exceptions, Calendar
Shifts, Week Start Dates, Period Start Dates,
 and Calendar Shift Workday Pattern
 

Supply Chain Planning Calendars
 

ScpCalendarImportTemplate.xlsm
 

Calendar Associations
 

Supply Chain Planning Calendar Assignments
 

ScpCalendarAssignmentsImportTemplate.xlsm
 

Demand Classes
 

Supply Chain Planning Demand Classes
 

ScpDemandClassImportTemplate.xlsm
 

Ship Mode of Transport, Ship Class of Service,
 and Carrier
 

Supply Chain Planning Carriers
 

ScpCarrierImportTemplate.xlsm
 

Allocation Assignments and Allocation Rules
 

Supply Chain Planning Planning Allocation
Rules
 

ScpPlanningAllocationRulesImportTemplate.xlsm
 

ATP Assignments and ATP Rules
 

Supply Chain Planning Available-to-Promise
Rules
 

ScpATPRulesImportTemplate.xlsm
 

Supply Update Rule
 

Supply Chain Planning Real Time Supply
Updates
 

ScpRealTimeSupplyUpdatesImportTemplate.xlsm
 

Freight Terms, FOB Points, Invoicing and
Accounting Rules, Shipment Priorities, Payment
Terms, Return Reason, Tax Classification Code,
 Tax Exemption Reason, Sales Credit Type,

Supply Chain Planning Order Orchestration
 

ScpOrderOrchestrationImportTemplate.xlsm
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Collections Entity Link in Data Import Guide XLSM File Name

 Activity Type, Document Categories, Payment
Methods, and Receipt Methods
 

Measures
 

Supply Chain Planning Measures
 

ScpMeasuresImportTemplate.xlsm
 

Note:
You must use separate CSV files to collect
measure data for measures with different
dimensional granularity.
 

Booking History
 

Supply Chain Planning Bookings History
 

ScpBookingHistoryImportTemplate.xlsm
 

Option Booking History
 

Supply Chain Planning Option Bookings History
 

ScpOptionBookingHistoryImportTemplate.xlsm
 

Shipment History
 

Supply Chain Planning Shipments History
 

ScpShipmentHistoryImportTemplate.xlsm
 

Option Shipment History
 

Supply Chain Planning Option Shipments
History
 

ScpOptionShipmentHistoryImportTemplate.xlsm
 

Price Lists
 

Supply Chain Planning Price Lists
 

ScpPriceListImportTemplate.xlsm
 

Causal Factors
 

Supply Chain Planning Causal Factors
 

ScpCausalFactorsImportTemplate.xlsm
 

Forecasts Measures
 

Supply Chain Planning Forecast Measures
 

ScpForecastMeasureImportTemplate.xlsm
 

Note:
This template has been superseded
by the generic template
ScpMeasuresImportTemplate.xlsm, but
will continue to be supported. Future
enhancements will be made only to the
generic measures template.
 

Fiscal Calendars
 

Supply Chain Planning Fiscal Calendars
 

ScpFiscalCalendarImportTemplate.xlsm
 

Forecasts
 

Supply Chain Planning External Forecast
 

ScpExternalForecastImportTemplate.xlsm
 

User-Defined Hierarchies
 

Supply Chain Planning User-Defined
Hierarchies
 

ScpUser-DefinedHierarchyImportTemplate.xlsm
 

Safety Stock Levels
 

Supply Chain Planning Safety Stock Levels
 

ScpSafetyStockLevelImportTemplate.xlsm
 

Supply Reservations to Sales Orders
 

Supply Chain Planning Reservations
 

ScpReservationImportTemplate.xlsm
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Collections Entity Link in Data Import Guide XLSM File Name

On Hand
 

Supply Chain Planning Supply On Hand
 

ScpOnhandImportTemplate.xlsm
 

Purchase Orders, Purchase Requisitions, PO in
Receiving, and In Transits
 

Supply Chain Planning Purchase Order
Requisitions
 

ScpPurchaseOrderRequisitionImportTemplate.xlsm
 

Transfer Orders
 

Supply Chain Planning Transfer Orders
 

ScpTransferOrderImportTemplate.xlsm
 

Supplier Capacity
 

Supply Chain Planning Approved Supplier
Capacity
 

ScpApprovedSupplierCapacityImportTemplate.xlsm
 

Resources and Resource Shifts
 

Supply Chain Planning Resources
 

ScpResourcesImportTemplate.xlsm
 

Resource Availability
 

Supply Chain Planning Resource Availability
 

ScpResourceAvailabilityImportTemplate.xlsm
 

Work Definition (Including mapping between
Item Structures and Work Definitions), Work
Definition Operations, and Work Definition
Operation Resources
 

Supply Chain Planning Routings
 

ScpRoutingsImportTemplate.xlsm
 

Work Order Supply
 

Supply Chain Planning Work Order Supplies
 

ScpWorkOrderSuppliesImportTemplate.xlsm
 

Work Order Material Requirements
 

Supply Chain Planning Work Order Component
Demands
 

ScpWIPComponentDemandsImportTemplate.xlsm
 

Work Order Resource Requirements
 

Supply Chain Planning Work Order Operation
Resources
 

ScpWIPOperationResourceImportTemplate.xlsm
 

Planned Order Supplies
 

Supply Chain Planning Planned Order Supply
 

ScpPlannedOrderSupplyImportTemplate.xlsm
 

Note:
This template is only used to load planned
order supply to Global Order Promising.
 

Sourcing Rule and Assignments
 

Supply Chain Planning Sourcing Rules
 

ScpSourcingImportTemplate.xlsm
 

Cross Reference Mapping Information
 

Supply Chain Planning Cross-Reference Data
 

ScpCrossReferenceDataImportTemplate.xlsm
 

Key Customer Options
 

Supply Chain Planning Key Customer Options
 

ScpKeyCustomerOptionsImportTemplate.xlsm
 

Collect Data from External Source - Version External

The following table lists the collections entities that can be loaded into the planning data repository from an external
source, where the version is External. The Collection Entity column provides the name of the entities for which you can
collect the data. The XLSM File Name column provides the template name that you will download for the respective
collection entity. Download the XLSM template from the File-Based Data Import (FBDI) for SCM guide. The Link in Data
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Import Guide column provides the name of the topic in the File-Based Data Import (FBDI) for SCM guide from where
you will download the template. For example, to collect data for the Items and Item Costs collection entities, refer to the
Item Cost Import topic in the File-Based Data Import (FBDI) for SCM guide. All the planning-related entity names are
prefixed with Supply Chain Planning in the FBDI guide.

Collection Entities Link in FBDI Guide XLSM File Name

Items
 

Supply Chain Planning Items
 

ScpItemImportTemplate.xlsm
 

Item Costs
 

Supply Chain Planning Item Cost
 

ScpItemCostImportTemplate.xlsm
 

Item Relationships
 

Supply Chain Planning Item Substitute
 

ScpItemSubstituteImportTemplate.xlsm
 

Catalogs, Categories, and Item Categories
 

Supply Chain Planning Catalogs
 

ScpCatalogImportTemplate.xlsm.xlsm
 

Item Structures
 

Supply Chain Planning Item Structures
 

ScpBillofMaterialImportTemplate.xlsm
 

Bill of Resources
 

Supply Chain Planning Bill of Resources
 

ScpBillOfResourcesImportTemplate.xlsm
 

Planners
 

Supply Chain Planning Planners
 

ScpPlannersImportTemplate.xlsm
 

Customers and Customer Sites
 

Supply Chain Planning Customers
 

ScpCustomerImportTemplate.xlsm
 

Regions
 

Supply Chain Planning Regions
 

ScpRegionsImportTemplate.xlsm
 

Zones
 

Supply Chain Planning Zones
 

ScpZonesImportTemplate.xlsm
 

Region-Zone Mapping
 

Supply Chain Planning Region Zone Mappings
 

ScpRegionZoneMappingImportTemplate.xlsm
 

Locations and Region-Location Mapping
 

Supply Chain Planning Locations
 

ScpLocationsImportTemplate.xlsm
 

Organizations and Organization Sites
 

Supply Chain Planning Organizations
 

ScpOrganizationImportTemplate.xlsm
 

Subinventories
 

Supply Chain Planning Subinventories
 

ScpSubInventoryImportTemplate.xlsm
 

Suppliers and Supplier Sites
 

Supply Chain Planning Suppliers
 

ScpSupplierImportTemplate.xlsm
 

Item Suppliers (Approved Supplier List)
 

Supply Chain Planning Approved Supplier List
 

ScpApprovedSupplierListImportTemplate.xlsm
 

Interlocation Shipping Networks and Transit
Times
 

Supply Chain Planning Interlocation Shipping
Methods
 

ScpInterLocationShipMethodsImportTemplate.xlsm
 

Currencies and Currency Conversions
 

Supply Chain Planning Currencies
 

ScpCurrencyImportTemplate.xlsm
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Collection Entities Link in FBDI Guide XLSM File Name

Units of Measure, Units of Measure
Conversions, and Units of Measure Class
Conversions
 

Supply Chain Planning Units of Measure
 

ScpUOMImportTemplate.xlsm
 

Calendars, Calendar Exceptions, Shifts, Shift
Workday Pattern, Week Start Dates, and Period
Start Dates
 

Supply Chain Planning Calendars
 

ScpCalendarImportTemplate.xlsm
 

Calendar Associations
 

Supply Chain Planning Calendar Assignments
 

ScpCalendarAssignmentsImportTemplate.xlsm
 

Demand Classes
 

Supply Chain Planning Demand Classes
 

ScpDemandClassImportTemplate.xlsm
 

Carrier, Ship Mode of Transport, and Ship Class
of Service
 

Supply Chain Planning Carriers
 

ScpCarrierImportTemplate.xlsm
 

GOP Allocation Rules and Rule Assignments
 

Supply Chain Planning Planning Allocation
Rules
 

ScpPlanningAllocationRulesImportTemplate.xlsm
 

GOP ATP Rules and Rule Assignments
 

Supply Chain Planning Available-to-Promise
Rules
 

ScpATPRulesImportTemplate.xlsm
 

GOP Supply Update Rules
 

Supply Chain Planning Real Time Supply
Updates
 

ScpRealTimeSupplyUpdatesImportTemplate.xlsm
 

Order Orchestration Reference Objects: Freight
Terms, FOB Points, Invoicing and Accounting
Rules, Shipment Priorities, Payment Terms,
 Return Reason, Tax Classification Code, Tax
Exemption Reason, Sales Credit Type, Activity
Type, Document Categories, Payment Methods,
 and Receipt Methods
 

Supply Chain Planning Order Orchestration
 

ScpOrderOrchestrationImportTemplate.xlsm
 

Cross Reference Mapping Information
 

Supply Chain Planning Cross-Reference Data
 

ScpCrossReferenceDataImportTemplate.xlsm
 

Measures
 

Supply Chain Planning Measures
 

ScpMeasuresImportTemplate.xlsm
 

Note:
You must use separate CSV files to collect
measure data for measures with different
dimensional granularity.
 

Booking History
 

Supply Chain Planning Bookings History
 

ScpBookingHistoryImportTemplate.xlsm
 

Option Booking History
 

Supply Chain Planning Option Bookings History
 

ScpOptionBookingHistoryImportTemplate.xlsm
 

Shipment History
 

Supply Chain Planning Shipments History
 

ScpShipmentHistoryImportTemplate.xlsm
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Collection Entities Link in FBDI Guide XLSM File Name

Option Shipment History
 

Supply Chain Planning Option Shipments
History
 

ScpOptionShipmentHistoryImportTemplate.xlsm
 

Price Lists
 

Supply Chain Planning Price Lists
 

ScpPriceListImportTemplate.xlsm
 

Causal Factors
 

Supply Chain Planning Causal Factors
 

ScpCausalFactorsImportTemplate.xlsm
 

Forecast Measures
 

Supply Chain Planning Forecast Measures
 

ScpForecastMeasureImportTemplate.xlsm
 

Note:
This template has been superseded
by the generic template
ScpMeasuresImportTemplate.xlsm, but
will continue to be supported. Future
enhancements will be made only to the
generic measures template.
 

Fiscal Calendars
 

Supply Chain Planning Fiscal Calendars
 

ScpFiscalCalendarImportTemplate.xlsm
 

Measures, Sales and Operations Planning
Backlog, Inventory, and Production History
 

Supply Chain Planning Measures
 

ScpMeasuresImportTemplate.xlsm
 

Note:
You must use separate CSV files to collect
measure data for measures with different
dimensional granularity.
 

User-Defined Hierarchies
 

Supply Chain Planning User-Defined
Hierarchies
 

ScpUser-DefinedHierarchyImportTemplate.xlsm
 

Forecasts
 

Supply Chain Planning External Forecasts
 

ScpExternalForecastImportTemplate.xlsm
 

Sales Orders
 

Supply Chain Planning Sales Orders
 

ScpSalesOrderImportTemplate.xlsm
 

Safety Stock Levels
 

Supply Chain Planning Safety Stock Levels
 

ScpSafetyStockLevelImportTemplate.xlsm
 

Supply Reservations to Sales Orders
 

Supply Chain Planning Reservations
 

ScpReservationImportTemplate.xlsm
 

On Hand
 

Supply Chain Planning Supply On Hand
 

ScpOnhandImportTemplate.xlsm
 

Purchase Orders, Purchase Requisitions, PO in
Receiving, In Transits
 

Supply Chain Planning Purchase Order
Requisitions
 

ScpPurchaseOrderRequisitionImportTemplate.xlsm
 

Transfer Orders (including expense type
transfers)

Supply Chain Planning Transfer Orders
 

ScpTransferOrderImportTemplate.xlsm
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Collection Entities Link in FBDI Guide XLSM File Name

 

Supplier Capacity
 

Supply Chain Planning Approved Supplier
Capacity
 

ScpApprovedSupplierCapacityImportTemplate.xlsm
 

Resources, Resource Shifts
 

Supply Chain Planning Resources
 

ScpResourceImportTemplate.xlsm
 

Resource Availability
 

Supply Chain Planning Resource Availability
 

ScpResourceAvailabilityImportTemplate.xlsm
 

Work Definition (including mapping between
Item Structures and Work Definitions), Work
Definition Operations, Work Definition
Operation Resources
 

Supply Chain Planning Routings
 

ScpRoutingsImportTemplate.xlsm
 

Work Order Supply
 

Supply Chain Planning Work Order Supplies
 

ScpWorkOrderSuppliesImportTemplate.xlsm
 

Work Order Material Requirements
 

Supply Chain Planning Work Order Component
Demands
 

ScpWIPComponentDemandsImportTemplate.xlsm
 

Work Order Resource Requirements
 

Supply Chain Planning Work Order Operation
Resources
 

ScpWIPOperationResourceImportTemplate.xlsm
 

Planned Order Supplies
 

Supply Chain Planning Planned Order Supply
 

ScpPlannedOrderSupplyImportTemplate.xlsm
 

Note:
This template is only used to load planned
order supply to Global Order Promising.
 

Sourcing Rule and Assignments
 

Supply Chain Planning Sourcing Rules
 

ScpSourcingImportTemplate.xlsm
 

Key Customer Options
 

Supply Chain Planning Key Customer Options
 

ScpKeyCustomerOptionsImportTemplate.xlsm
 

Related Topics
• Run the Load Planning Data from Files Process

Run the Load Planning Data from Files Process  
To load planning data from files, first you must prepare the data you want to load.
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To prepare the data, download the relevant XLSM template, update the XLSM template with required data, and create
the necessary CSV files for upload. This procedure explains how to load planning data from files after you have
prepared the data and created CSV files.

1. From the Navigator, use the File Import and Export page to upload the previously prepared and zipped CSV
files to the Universal Content Manager. Use the account scm/planningDataLoader/Import to upload the zipped
file.

Note:  For more information about uploading files to the Universal Content Manager server, see the following
section in the Implementing Common Features for SCM guide: External Integration chapter, External Data
Integration Services for Oracle Cloud section.

2. From one of the Supply Chain Planning work areas or Setup and Maintenance work area, Supply Chain
Planning offering, select the Load Planning Data from Files task.

3. Complete the following parameters on the Load Planning Data from Files page:

a. Select the source system.
b. Select Collection Type: Net change or Target.
c. Select the .zip file you previously imported into the Universal Content Manager.

4. Click Submit. Make a note of the process ID. You will need this process ID to review the status of the process.

Related Topics
• Create CSV Files to Load Planning Data

Load Planning Data from Files for a Selected Group of
Organizations  
When you load planning data from files for the net change or targeted collection type, you can enable organization
group collection and then select an organization group.

Data is collected for only the organizations in the organization group, and the purge of data before the load of the
new data is also done for only the organizations in the organization group. That is, previously collected data for
organizations that aren't included in the organization group is retained when you're doing collections using the file-
based data import (FBDI) process.

Note:  Enabling organization group collection isn't applicable to reference entities and entities for Oracle Demand
Management, such as history, measures, and price lists.

Parameters for the Load Planning Data from Flat Files Scheduled Process
These are the parameters for the Load Planning Data from Flat Files scheduled process:

• Source System: The source system for the data determines which organization groups are applicable.

• Collection Type: You must select Net change or Targeted.

• Data File: The file previously uploaded to the Oracle WebCenter Content server.

• Enable Organization Group Collection: Select Yes for this parameter.

• Organization Group: Select an organization group.
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Organization Groups
The organization group you can select for the Organization Group parameter is determined by:

• Which source system you select for the Source System parameter

• What organization groups are set up for that source system

You set up organization groups in the Manage Organization Groups dialog box that you open from the Organizations
tab on the Maintain Supply Network Model page.

Example
Here's an example that shows how data is retained for organizations in other organization groups when you load
planning data for a selected organization group.

For this example, let's say you've three organizations and two organization groups, and the source for your data is the
EX1 source system.

• Organization group OG1 includes organization M1.

• Organization group OG2 includes organizations B1 and B2.

First, you load planning data for the OG1 organization group for the Work Order Supplies entity. Two rows of data are
collected for the OG1 organization group.

Item Organization Order Type Order Quantity Suggested Due Date

Item 1
 

EX1:M1
 

Work order
 

10
 

2/14/22
 

Item 2
 

EX1:M1
 

Work order
 

15
 

2/11/22
 

Then, you load planning data for the OG2 organization group for the Work Order Supplies entity.

• Three rows of data are collected for the OG2 organization group.

• The two rows that were previously collected for the OG1 organization group are retained.

Item Organization Order Type Order Quantity Suggested Due Date

Item 1
 

EX1:M1
 

Work order
 

10
 

2/14/22
 

Item 2
 

EX1:M1
 

Work order
 

15
 

2/11/22
 

Item 1
 

EX1:B1
 

Work order
 

11
 

2/09/22
 

Item 1
 

EX1:B2
 

Work order
 

16
 

1/31/22
 

Item 2
 

EX1:B2
 

Work order
 

10
 

2/09/22
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Applicable Entities
You can use FBDI templates to load data for organization groups for these entities:

Source Entities

From an Oracle Fusion Cloud SCM source
 

• External Forecasts

• Planned Order Supply

• Safety Stock Levels

From an Oracle Fusion Cloud SCM source
for which you've selected the Enable
external data check box and other check
boxes in the Select Data Sources dialog
box that you open from the Setup and
Maintenance work area, Supply Chain
Planning Configuration functional area,
 Manage Planning Source Systems page
 

• On Hand

• Transfer Orders

• Purchase Orders and Purchase Requisitions

• Sales Order and Associated Reservations

• Work Order Component Demands

• Work Order Supplies, Work Order By-Product and Co-Product Supplies, Work Order Operation
Resources

• Resource Availability

Note:  These entities are in addition to those mentioned in the previous row for the Oracle Fusion
Cloud SCM source.

From an external source
 

• External Forecasts

• Movement Requests

• Planned Order Supply

• Purchase Orders and Purchase Requisitions

• Reservations

• Safety Stock Levels

• Sales Orders

• Transfer Orders

• On Hand

• Work Order Component Demands

• Work Order Supplies, Work Order By-Product and Co-Product Supplies, Work Order Operation
Resources

• Resource Availability

More Details About Using Organization Groups for Loading Data
Here are a few more details to know about loading planning data from files for a selected group of organizations:

• If you've included the history, measures, or price list entities in a data file used during collections with
organization group collection enabled, collections will be done for these entities for all organizations and not
just the organizations in the groups.

• If you've included reference data entities in a data file used during collections with organization group
collection enabled, these entities will be ignored.
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• Data security created and enabled at the organization level for any role isn't applied to organization groups.

• You can submit the Load Planning Data from Flat Files scheduled process multiple times to specify a different
organization group for each submission. The submissions are processed in the order of submission.

• You can specify an organization group when you submit the Load Planning Data from Flat Files scheduled
process or when using a scheduled process job set.

• You can specify an organization group when you submit the Load Planning Data from Flat Files scheduled
process using the ERP Integrations REST resource.

• If you use the Collect Planning Data page to collect some of your data, note that you can use organization
groups for only the net change collection type. For the targeted collection type, you must use the collection
filter named Organizations Filter for Transaction Data.

Related Topics
• Enable External Data Collection for the Oracle Fusion Source System

• Enable Organization Group Collection for the Net Change Collection Type

Improve Performance of Measure Disaggregation  

Overview of Improving Performance While Disaggregating Measure Data  
While importing data at an aggregate level to stored measures for Oracle Fusion Cloud Supply Chain Planning, you can
improve the performance by enabling multithreading for the disaggregation process.

While using the file-based data import (FBDI) template named Supply Chain Planning Measures, you can import data at
the stored levels or aggregate levels of the stored levels. For example, if your measure is configured with the dimension
levels of Item, Organization, Sales Rep, Customer Site, Demand Class, and Day, you can import data at these stored
levels or aggregate levels, such as product category, business unit, sales organization level, customer, demand class,
and month.

Measure data that's collected at an aggregate level is disaggregated to the stored levels during the data refresh step in a
plan run or when you incrementally refresh a plan after loading new measure data.

By default, the process for disaggregating the measure data is single-threaded. Consequently, long processing times
can result when there's a large volume of measure data to disaggregate.

To improve performance, you can configure disaggregation to run as a multithreaded process. The disaggregation
process runs in parallel for different time ranges within the time range for the collected measure data.

The multithreaded process runs in 90-day increments by default. For example, if you've collected measure data at an
aggregate level for the past year (365 days), then the process runs five disaggregation jobs in parallel, four jobs of 90
days each and one job for the remaining five days of data.

You can do the following:

• Enable multithreading for measure data disaggregation for all plans in the Demand Management, Demand and
Supply Planning, Planning Central, Replenishment Planning, Sales and Operations Planning, or Supply Planning
work area.

• Enable multithreading for measure data disaggregation for a single plan that's enabled for demand forecasting.

• Override the default of 90 days for the multithreaded process.
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Related Topics
• Enable Multithreading for Measure Data Disaggregation for All Plans

• Enable Multithreading for Measure Data Disaggregation for a Single Plan

• Override the Default Value for the Multithreaded Process

Enable Multithreading for Measure Data Disaggregation for All Plans  
You can enable multithreading for measure data disaggregation for all demand, demand and supply, replenishment,
sales and operations, or supply plans.

Before you start
You may need to work with someone who has administration privileges to make these profile-related changes.

Here's what to do

1. In the Demand Management, Demand and Supply Planning, Plan Inputs, Planning Central, Replenishment Planning,
Sales and Operations Planning, or Supply Planning work area, on the Tasks panel tab, under Configuration, select
Manage Planning Profile Options.
The Manage Planning Profile Options page opens.

2. Search for the SCP_PARAMETER_OVERRIDES profile option code.
3. If the SCP_PARAMETER_OVERRIDES profile option code exists, then click the New icon.

A new row appears for the profile value.
4. Add the profile value as follows:

◦ Profile Level: Select Site to set the value globally for all users. Select User to set the value for a specific user,
in which case you must then select a user. User-level values take precedence over the site-level value.

◦ Profile Value: Enter enableParallelDisaggMeasure=true.

Note:  You can enter multiple profile values for a profile level provided you separate them with the space
or semicolon. Whether you can select the site or user depends on the enabled levels in the profile option.

5. Click Save and Close.
6. If the SCP_PARAMETER_OVERRIDES profile option code doesn't exist, then follow these steps:

a. In the Setup and Maintenance work area, go to the Manage Profile Options task.
The Manage Profile Options page opens.

b. Click New.
The Create Profile Option page opens.

c. Create the profile option as follows:
- Profile Option Code: SCP_PARAMETER_OVERRIDES
- Profile Display Name: SCP_PARAMETER_OVERRIDES
- Application: Planning Common
- Module: Planning Common
- Start Date: Current date

Leave the remaining fields blank.

7. Click Save and Close.
8. For the profile option levels for the profile option, select the check boxes under the Enabled and Updatable columns

for both the Site and User levels.
9. Click Save and Close.
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10. In your work area, open the Manage Planning Profile Options page.
11. Search for the SCP_PARAMETER_OVERRIDES profile option code.
12. Set the profile level and value as previously explained.
13. Click Save and Close.

Related Topics
• Overview of Improving Performance While Disaggregating Measure Data

• Enable Multithreading for Measure Data Disaggregation for a Single Plan

• Override the Default Value for the Multithreaded Process

Enable Multithreading for Measure Data Disaggregation for a Single Plan  
You can enable multithreading for measure data disaggregation for a single, forecast-enabled plan in the Demand
Management, Demand and Supply Planning, Planning Central, Replenishment Planning, or Sales and Operations
Planning work area.

1. In your work area, open the Plan Options page for your forecast-enabled plan.
2. On the Demand tab, click Select Advanced Options.

The Demand: Advanced Options dialog box opens.
3. In Forecasting Control Parameters, in Parameter Overrides, enter enableParallelDisaggMeasure=true.

Note:  You can enter multiple values in the Parameter Overrides field provided you separate them with the
number sign (#).

4. Click Done.
5. Save your plan.

Related Topics
• Overview of Improving Performance While Disaggregating Measure Data

• Enable Multithreading for Measure Data Disaggregation for All Plans

• Override the Default Value for the Multithreaded Process

Override the Default Value for the Multithreaded Process  
After you've enabled multithreading for the measure disaggregation process for all plans in your work area or a single,
forecast-enabled plan, you can override the default value of 90 days for the process.

Before you start
You may need to work with someone who has administration privileges to make these profile-related changes.

Here's what to do

1. In the Setup and Maintenance work area, go to the Manage Profile Options task.
The Manage Profile Options page opens.

2. Click New.
The Create Profile Option page opens.
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3. Create a profile option as follows:

◦ Profile Option Code: MSC_DISAGG_PERF_BATCH_SIZE

◦ Profile Display Name: MSC_DISAGG_PERF_BATCH_SIZE

◦ Application: Planning Common

◦ Module: Planning Common

◦ Start Date: Current date

Leave the remaining fields blank.

4. Click Save and Close.
5. For the profile option levels for the profile option, select the check boxes under the Enabled and Updatable columns

for both the Site and User levels.
6. Click Save and Close.
7. In the Demand Management, Demand and Supply Planning, Plan Inputs, Planning Central, Replenishment Planning,

Sales and Operations Planning or Supply Planning work area, on the Tasks panel tab, in Configuration, select
Manage Planning Profile Options.
The Manage Planning Profile Options page appears.

8. Search for the MSC_DISAGG_PERF_BATCH_SIZE profile option code.
9. Click the New icon.

A new row appears for the profile value.
10.Add the profile value as follows:

◦ Profile Level: Select Site to set the value globally for all users. Select User to set the value for a specific user,
in which case you must then select a user. User-level values take precedence over the site-level value.

◦ Profile Value: Enter the number of days for processing in each parallel job.

11. Click Save and Close.

Related Topics
• Overview of Improving Performance While Disaggregating Measure Data

• Enable Multithreading for Measure Data Disaggregation for All Plans

• Enable Multithreading for Measure Data Disaggregation for a Single Plan

Collections for Oracle Replenishment Planning  
This topic explains how collections are done for Oracle Replenishment Planning.

Collections are done at the organization level.

Collections are also done for all subinventories of organizations that are marked for subinventory-level planning on the
Organizations tab on the Maintain Supply Network Model page.

Collected Business Objects That Are Relevant for Replenishment Planning
This table lists the collected business objects that are relevant for replenishment planning:
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Oracle Fusion Cloud Applications Business Object

Oracle Fusion Cloud Procurement
and Oracle Fusion Cloud Inventory
Management
 

• Purchase orders and requisitions

• Suppliers

• Approved supplier lists

• Units of measure (UOMs)

• Transfer orders

• Shipping methods

• Subinventories

• On-hand inventory

Oracle Fusion Cloud Product Lifecycle
Management
 

• Items

• Organizations

• Catalogs

Oracle Cost Management, Oracle Order
Management, and others
 

 
• Item costs

• Currencies

• Calendars and fiscal calendars

• Sales orders

• Bookings history

• Shipments history

• Transfer order history

• Price lists

Related Topics
• How You Maintain Your Supply Network Model

• How You Set Up Replenishment Planning for Subinventories

Collection of Consumption Data for Oracle
Replenishment Planning  
This topic discusses the collection of consumption inventory transactions or point-of-sale (POS) data from Oracle
Fusion Inventory Management for the generation of consumption-based forecasts in Oracle Replenishment Planning.

To generate consumption-based forecasts for your replenishment plan, make these selections on the Collect Planning
Data page:

• On the Parameters tab, for the Targeted collection type, under History Data Options on the Demand Planning
Data tab, in Organization - Consumption Inventory Transactions to Include, select the types of consumption
inventory transactions you want to collect at the organization level. If you select Transfer orders, historical
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transfer orders at the organization level are collected. If you select All, all historical consumption inventory
transactions at the organization level are collected.

• In Subinventory - Consumption Inventory Transactions to Include, select the types of consumption
inventory transactions you want to collect at the subinventory level. If you select Transfer orders, both
historical transfer orders and historical movement requests at the subinventory level are collected. If you select
All, all historical consumption inventory transactions at the subinventory level are collected.

Consumption-based forecasting provides you with these benefits:

• You can improve the effectiveness of your forecast by basing it on demand signals that are closest to your
customers.

Thereby, you can effectively compute your policy parameters and calculate and release your replenishment
orders.

• In the retail and healthcare sectors, you can model stores and departments as subinventories. By collecting
consumption inventory transactions at the subinventory level, you can generate forecasts at this level.

Historical Transaction Collections for Consumption-Based Forecasting at
the Organization Level
When you select All in the Organization - Consumption Inventory Transactions to Include field, all historical
transactions are collected at the organization level from Inventory Management for consumption-based forecasting
except for those listed in this table:

Transaction Action Transaction Source Transaction Type

Issue from stores
 

Purchase Order
 

Return to Supplier
 

Issue from stores
 

Sales Order
 

Sales Order Issue
 

Issue from stores
 

Transfer Order Return
 

Transfer Order Return with Scrap
 

Item Transaction Collections for Consumption-Based Forecasting at the
Subinventory Level
When you select All in the Subinventory - Consumption Inventory Transactions to Include field, all item transactions
are collected at the subinventory level from Inventory Management for consumption-based forecasting except for those
listed in this table:

Transaction Action Transaction Source Transaction Type

Direct organization transfer
 

Transfer Order Return
 

Transfer Order Return Transfer
 

Intransit shipment
 

Transfer Order Return
 

Transfer Order Return Shipment
 

Issue from stores
 

Purchase Order
 

Return to Supplier
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Transaction Action Transaction Source Transaction Type

Issue from stores
 

Transfer Order Return
 

Transfer Order Return with Scrap
 

Staging transfer
 

Transfer Order Return
 

Transfer Order Return Pick
 

Difference Between Consumption History and Shipments History
While shipments history includes the history for shipped sales orders, consumption history includes the shipments
history as well as the consumption-related history that falls under transaction actions such as Issue from stores.

Measures for Storing Collected or Uploaded Consumption Data
If you're collecting consumption data from Inventory Management, the collected data is stored in the measure that you
select in the Shipments History Measures field under History Measures and Attributes on the Demand Planning Data
tab.

If you're uploading consumption data from an external source, use the file-based data import (FBDI) template named
Supply Chain Planning Measures (ScpMeasuresImportTemplate.xlsm) to import consumption data into the predefined
Consumption History measure.

In the import template, enter #ignore under the Customer Level Name and Demand Class Level Name columns if you
don't want to specify these levels. Don't enter values in the columns for level member names.

ERP Integrations REST Service  

Use of ERP Integrations REST Service in Collections  
You can upload all reference and transactional data to Oracle Fusion Cloud Supply Chain Planning from an external
source using the ERP Integrations REST service. This external source can be data from Oracle E-Business Suite, Oracle
Fusion Cloud Applications, or third-party source. In Collections, this REST service is used to upload data and submit the
collection job set.

Overview
This service updates all key changes in supply chain operations like unexpected changes in inventory levels or
manufacturing capacities in your application in real-time. Hence when compared to the system that relies on batch
integration and synchronizes data only on periodic basis, this system provides accurate results.

Note:  To upload data for Oracle Supply Chain Planning products, use of ERP Integrations REST service is preferred
over use of ERP Integrations SOAP Service.
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ERP Integrations REST Service  
The ERP Integrations REST service that is available as part of Oracle Fusion Cloud Financials is used with Oracle Fusion
Cloud Supply Chain Planning products to import bulk data, upload files to UCM server, and to load planning data from
flat files. The REST resource name is ERP Integrations and it supports multiple POST operations.

This topic provides specific guidelines on how to use these REST operations with Oracle Supply Chain Planning
products. For the Oracle Financials documentation regarding the ERP Integrations REST service, refer to the REST API
for Oracle Fusion Cloud Financials book, ERP Integrations task, in Oracle Help Center.

Import Bulk Data
The ERP Integration Service importBulkData is the main REST operation that’s used to import data for Oracle Supply
Chain Planning. This is a multistep operation that invokes the following subprocesses to complete the data load:

1. Upload file content to UCM Server
2. Loads data into Planning staging tables
3. Launches Load Planning Data from Files scheduled process
4. Launches the Collect Planning Data Job Set

This operation is completed in a single API call and also handles encrypted data files and decrypts them as part of
upload.

Here are the specific parameters that are used in the importBulkData REST operation.

• JobName: For Oracle Supply Chain Planning data loads, this parameter must be specified as
JobName: /oracle/apps/ess/scm/advancedPlanning/collection/configuration/CSVController

• Parameter List: This parameter contains a comma separated list of the parameter values. This is used by the
Load Planning Data from Files scheduled process that is launched as part of this REST service operation. Here
are the parameters that are used in the parameter list.

Parameters

Scheduled Process Internal
Parameter

Maps to the displayed
parameter of this process

Expected Value Parameter Details

Parameter 1 Source System Source System Source system code of the
source system for which the
data is being uploaded. This
code is specified during the set
up of the source system

Parameter 2 Collection Type 1 or 2 Type of collections to be
launched. Valid values are:

◦ 1 denotes Targeted
Collection type

◦ 2 denotes Net change
Collection type

Parameter 3 Data File Zip File name Name of the zip file to be
uploaded.
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Scheduled Process Internal
Parameter

Maps to the displayed
parameter of this process

Expected Value Parameter Details

Parameter 4 Not displayed Not used Specify as #NULL.

Parameter 5 Not displayed Document ID (DId) Value Document ID of the zip file to be
uploaded to UCM.
 
Optional when using
importBulkData operation but
mandatory when using the
submitEssJobRequest operation.
 

Parameter 6 Not displayed Instance ID Internal ID of the source
system specified in Parameter
1 (instance code). This is stored
internally as MSC_APPS_
INSTANCES.INSTANCE_ID
and can be derived using the
following SQL query:
 

SELECT instance_id FROM
 msc_apps_instances
 WHERE instance_code =
 '<instance code>'

 

Parameter 7 Not displayed Apps Version Internal value of the version of
the source system specified in
Parameter 1 (instance code).
This is stored internally as MSC_
APPS_INSTANCES.APPS_VER
and can be derived using the
following SQL query:

SELECT apps_ver FROM
 msc_apps_instances
 WHERE instance_code =
 '<instance code>'

 

Parameter 8 Not displayed Not used Specify as #NULL.

Parameter 9 Organization Group Organization Group This is optional. It is required
only if the user wants to
run collections for a specific
organization group. The value
is the name of the organization
group. If not specifying, use
#NULL.
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Parameters File
You must include the special parameters file Supply Chain Planning ERP Integration Service Parameters that’s generated
using the ScpErpIntegrationServiceParamsImportTemplate.xlsm template file when using ERP Integrations REST service
with Oracle Supply Chain Planning products. This parameters file is the file that provides metadata that you need to
include in the zip file along with other CSV files to load data in the ERP Integrations Flow. This file contains the following
parameters:

• Source System Code (Parameter 1 in the Parameters table)

• Collection Type (Parameter 9 in the Parameters table)

• Organization Group (Parameter 9 in the Parameters table)

If the input zip file does not contain ScpErpIntegrationServiceParams.csv, then the mode of collections is defaulted to
Net change and the Load Planning Data from Flat Files schedule process reads the value of instance code from the
respective data files.

The ScpErpIntegrationServiceParams.csv meta data file is required only when your loading data using the ERP
Integration importBulkData operation and isn’t required when you submit the Load Planning Data from Flat Files
process either from the Scheduled Processes page or using the submitEssJobRequest operation.

Note:  Oracle Supply Chain Planning data loads using importBulkData operation don’t need any other properties files
like jobDetails.properties that are required for other product areas.

Upload File to UCM
The uploadfiletoUCM operation uploads a file to the UCM server in a single step based on the document specified in the
REST operation.

Here is the parameter that is used to complete the operation.

DocumentAccount: For Oracle Supply Chain Planning data loads, this parameter must be specified as

DocumentAccount":"scm$/planningDataLoader$/import$

The REST response includes the DocumentId as one of the data elements.

Load Planning Data from Flat Files
The submitEssJobRequest operation is used to load planning data from flat files. It submits the collections job set with a
set of parameters in a single step.

When loading data for Oracle Supply Chain Planning products, use the following parameters and respective guidelines
to complete the operation.

• JobPackageName: This parameter must be specified as
JobPackageName:oracle/apps/ess/scm/advancedPlanning/collection/configuration 

• JobDefName: This parameter must be specified as
JobDefName: CSVController

• DocumentId: Use the document ID from the response of uploadFileToUCM operation.

• ESSParameters: This parameter must include a list of values as indicated for the Parameter List parameter of
importBulkData operation. For example,
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ESSParameters:EX8,2,UOM.zip,#NULL,289568,300100110961358,3,#NULL,#NULL

The REST response includes the RqstId as one of the data elements. This data element is the process ID of the
submitted scheduled process which in this case is the Load Planning Data from Files process. This process is completed
only after total flow including Collect Planning Data job set is launched and completed.

For other Oracle Supply Chain Planning processes, like the Publish Data and Release Plan processes, the recommended
approach is to use the respective REST services under Oracle Supply Chain Planning group and not use the
submitEssJobRequest operation. For example:

• For Publish Data – use Supply Chain Planning/Supply Chain Plans/Publish Data

• For Release Plan – use Supply Chain Planning/Supply Chain Plans/Releases

• For Archive Plan – use Supply Chain Planning/Supply Chain Plans/Archives

Note:  loadAndImportData operation isn't recommended for use with Oracle Supply Chain Planning products because
with this operation you can’t upload encrypted data files.

Verify Collection Processes  

Verify the Load Planning Data from Files Process  
Perform the following steps to verify the process status of the uploaded file and review log file for any errors or
warnings.

1. In the Navigator, click Scheduled Processes.
2. In the search area, enter the process ID you noted when you submitted during the Load Planning Data from

Files process. Click Search.
3. Monitor the process to verify completion.

If the process completes with warnings, select the request that shows the warning status and click the View
Log button to review the details.

4. For the rows with errors, resolve the issues found in the log file, and then upload the CSV file again. To load only
the revised rows, use the Net Change option.

Review Data in the Planning Data Repository  
You can review the data collected or loaded into the planning data repository using two different options. The option
you use depends on which data collection entities you want to review.

To review the data collected or loaded into the planning data repository, use one of the following options:

• Review data using the Plan Inputs page layout

• Review data using the Maintain Supply Network Model page
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To review the following entities, use the Maintain Supply Network Model page:

• Organizations

• Customers

• Suppliers

• Carriers

• Interlocation Shipping Networks

To review data that's not part of the supply network model, use the Plan Inputs page layout. You can view the following
data in the Plan Inputs page layout

• Supply data

• Demand data

You can view Carriers and Suppliers using either option.

Review Data Using the Plan Inputs Page Layout
Perform the following steps to review the planning data that you loaded.

1. In the Navigator, click Plan Inputs.
2. From the Plans menu, right-click Plan Inputs, and click Open.

Tip:  You can set the preview pane to Full Pane for viewing your data in full pane. Click Change and select
Full Pane.

3. On the Plan Inputs page, click Open, and click Full Pane.
4. On the Open Table, Graph, or Tile Set page, search for the table name.
5. Enter the criteria for the data you want to verify and click Search.
6. Review the data in the Search Results table.

Review Data Using the Maintain Supply Network Model Page
Perform the following steps to review the planning data using the Maintain Supply Network Model page.

1. In the Navigator, click Plan Inputs.
2. From the Tasks menu, click Maintain Supply Network Model.
3. Enter the criteria for the data you want to verify and click Search.
4. Review the data in the Search Results table.
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Purge Data  

How You Purge Collected Data from the Data Repository for
Supply Chain Planning  
Use the Purge Data Repository scheduled process to purge data collected by supply chain planning collections
processes into the database tables that comprise the planning data repository.

Delete data from these tables to free up space and improve performance. Use the Scheduled Processes work area to run
the scheduled process. This topic explains the parameters of the Purge Data Repository scheduled process.

The parameters for the Purge Data Repository scheduled process are in one of these categories:

• The Source System and Purge Global Entities parameters

• Parameters on the Reference Data tab

• Parameters on the Demand Planning Data tab

• Parameters on the Supply Planning Data tab

Note:  If you're purging Customer dimension data or measure data at the Customer Site level for a demand plan that
uses a planning level profile, you must manually run the Aggregated Collected Planning Data and Create Trees for
Dimensions scheduled processes after you've purged the data.

The Source System and Purge Global Entities Parameters
Provide values for these parameters to determine which data records for reference data will be purged from the staging
tables when you run the Purge Data Repository scheduled process.

Parameter Notes

Source System
 

You must select a source system.
 

• For data collected from the Oracle Fusion source system, select OPS.

• For data collected from an external system, select the applicable source system code.

Purge Global Entities
 

You can select Yes if you want to delete data for the entities for which the planning data repository
stores only one record for each instance of the global entity so there's no reference to a source system.
The default is No.
 

Parameters on the Reference Data Tab
Provide values for these parameters on the Reference Data tab to determine which data records for reference data will
be purged from the staging tables when you run the Purge Data Repository scheduled process.
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Parameter Notes

The set of entities categorized as reference
entities. The entities you haven't selected
yet are included in the Reference Entities
list on the Reference Data tab.
 

You select which reference entities you want data deleted for. The entities you select are included in
the Selected Entities list on the Reference Data tab.
 

Parameters on the Demand Planning Data Tab
Provide values for these parameters on the Demand Planning Data tab to determine which data records for demand
planning data will be purged from the staging tables when you run the Purge Data Repository scheduled process.

Parameter Notes

The set of entities categorized as reference
entities. The entries you haven't selected
yet are included in the Demand Entities list
on the Demand Planning Data tab.
 

You select which demand entities you want data deleted for. The entities you select are included in the
Selected Entities list on the Demand Planning Data tab.
 

Limit the Days to Purge
 

You can choose to limit the number of days to purge by selecting one of three choices. For each choice
you must also specify the additional details needed for that choice:
 

• By date range, followed by a from date and a to date

• By number of days in the future, followed by a number of most recent days to keep

• By number of days in the past, followed by either a number of most recent days to keep or a
number of oldest days to purge

Parameters on the Supply Planning Data Tab
Provide values for these parameters on the Supply Planning Data tab to determine which data records for supply data
will be purged from the staging tables when you run the Purge Data Repository scheduled process.

Parameter Notes

The set of entities categorized as supply
entities. The entities you haven't selected
yet are included in the Supply Entities list
on the Supply Planning Data tab.
 

You select which supply entities you want data deleted for. The entities you select are included in the
Selected Entities list on the Supply Planning Data tab.
 

Related Topics
• Purge Data Repository

• Overview of Planning Level Profiles
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How You Purge Staging Tables for Supply Chain Planning  
Use the Purge Staging Tables scheduled process to delete data from the staging tables used during collections
processes for supply chain planning.

Delete data from the staging tables to free up space and improve performance. Use the Scheduled Processes work
area to run the scheduled process. This topic explains the parameters of the Purge Staging Tables scheduled process.
For information on how to run scheduled processes, refer to the Scheduled Processes chapter in the Implementing
Common Features for SCM guide.

Provide values for these parameters to determine which data records will be purged from the staging tables when you
run the Purge Staging Tables scheduled process.

Parameter Notes

Source System
 

You must select a source system.
 

• For data collected from the Oracle Fusion source system, select OPS.

• For data collected from an external system, select the applicable source system code.

Record Type
 

You must select a record type, but you can select All if you want to purge all records that meet the
values of the other parameters, regardless of their record type. The record types other than the All type
are the status of records in the staging tables in regard to the next stage of the collections process. The
next stage of the collections process is the import of the records that are in the staging tables into the
tables that comprise the planning data repository.
 

• All: All records regardless of status.

• Complete: Records that were successfully imported into the tables that comprise the planning
data repository.

• Error: Records that are in the Error status in the staging tables after import into the planning data
repository was tried, but not successful.

• New: Records that were collected into the staging tables, but import into the planning data
repository hasn't been tried yet.

• Retry: Records in the staging tables for which import into the planning data repository is being
tried again.

• Warning: Records in the staging tables for which a warning occurred when the record was
imported into the planning data repository.

Collection Cycle ID
 

You can enter a request number if you want to do so.
 

Collected From Date
 
and
 
Collected To Date
 

You can provide these dates if you want to purge data within a specific time frame.
 

The set of specific entities for which data is
collected and deletion of the data from the
staging tables is supported.
 

Each entity is a parameter for the scheduled process. You can select No for any of the parameters if
you don't want to purge the data for that entity. The default value for each parameter is Yes.
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Aggregate Customer Data  

How You Aggregate Customer Data  
Use the key customer data options collections template to identify key customers.

The data for these customers will be visible. For each Zone, all non-key customers' data will be aggregated to a member
named All Other. By aggregating the planning data for non-key customers, you can focus your analysis on the key
customers. You use the Supply Chain Planning Key Customer Options (ScpKeyCustomerOptionsImportTemplate.xlsm)
import template to identify the key customers; the rest of the customers' data will be aggregated under an All Other
member.

The data that aren't identified in the upload template are aggregated to an All Other member for each zone. You can
view the key customers and the All Other member containing the aggregated non-key customer data when you analyze
the forecasts and other data.

Identifying key customers and aggregating non-key customer data helps you to do the following:

• Organize key customer data that are required for planning

• Save time by collecting only the required data from Oracle Fusion Cloud Supply Chain Management

• Build a plan specifically for your key customers

Note:  You can't use the functionality for aggregating data for non-key customers in a demand plan to which you've
attached a planning level profile. The Aggregate non-key customer data to an All Other level member check box
on the Demand tab on the Plan Options page is disabled if you've attached a planning level profile to the demand
plan.

Related Topics
• Collection Filters and Collection Templates

• Overview of Planning Level Profiles

How can I reset the key customer aggregated data for a plan?  
After you make changes to the aggregation level values in the ScpKeyCustomerOptionsImportTemplate.xlsm file, you
must upload the file and run the plan again.

To reset the key customer aggregated data for a plan, do the following:

1. Review the ScpKeyCustomerOptionsImportTemplate.xlsm file.
2. Update the Aggregation Level values for all of the Level Name values (for example, Customer) and upload the

CSV file.
3. From your Supply Chain Planning work area, open the plan and enable the Aggregate non-key customer data

to All Other level member check box. Run the plan again.
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Related Topics
• Considerations for Collecting Key Customer Information

Considerations for Collecting Key Customer Information  
Use the ScpKeyCustomerOptionsImportTemplate.xlsm file to identify the key customers for which nonaggregated data
must be made available.

For non-key customers, the aggregation level that you define in the import template determines whether the data is
retained or aggregated. You can differentiate between key customers and non-key customers and use the aggregated
key customer data to build a plan specifically for your key customers.

Note:  For details regarding the ScpKeyCustomerOptionsImportTemplate.xlsm file, refer to the File-Based Data Import
(FBDI) for SCM guide. This guide is one of the guides in the Oracle Help Center for Oracle Fusion Cloud Supply Chain
Management. Use the All Books link for a list of the guides by category, and look for the Development category.

In the ScpKeyCustomerOptionsImportTemplate.xlsm file template:

1. Define your key customers on the KeyCusOptnHeader tab. Enter the name of a valid customer hierarchy in the
Hierarchy Name column.

2. Next, enter the level of that hierarchy in the Level Name column. All customers in this level are identified as key
customers.

3. To have only certain customers identified as key customers, enter the specific customer names on the
KeyCusOptnMembers detail tab.

4. Set the aggregation level values for both key and non-key customers. Use the settings in the template to set the
data to different aggregation levels, such as 1, 2, or 3.

5. Upload the template.

Ignore Aggregate by Zone
There are two Customer hierarchies--Customer and Customer Zone--where the lowest level of each hierarchy is
Customer Site. If you don't have any key customers, leave the Hierarchy Name and Hierarchy Level columns blank on
the KeyCusOptnHeader tab. All customers not named in the template (non-key customers) are aggregated into an All
Other member for the hierarchy.

The upload also creates All Other Zone members for the non-key customers in the Customer Zone hierarchy. If you
don't want to aggregate by zone, enter #ignore_zone in the Hierarchy Name column in the KeyCusOptnHeader.csv and
leave the Level Name column blank.

Aggregation Levels
The aggregation levels are listed in the following table.

Aggregation Level Description

1
 

Retain all customer sites, and aggregate non-key customer sites. In addition to key customer data
being available, non-key customer data is retained for plans that require data that's not aggregated.
Aggregated customer data is available for plans that require aggregated non-key customer data.
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Aggregation Level Description

2
 

Aggregate non-key customer sites. Customers that aren't identified as key customers are aggregated
to an All Other site by zone. However, if the Hierarchy Name and Level Name columns are blank, all
customers are identified as non-key customers and aggregated to an All Other site by zone. This
means that there are no key customers.
 

3
 

No aggregation of customer sites. All data is available at customer site level.
 

To remove the key customer designation for previously-loaded customers, use Aggregation Level 3. This enables data
for all customers to be made available at the lowest level. No customers are marked as key customers.

If you select the aggregation level 3, the following happens:

• No aggregation is done. All data is at the customer site level only.

• If option 2 or 3 was used in previous collection runs, all non-key customer by zone members and data are
deleted.

• Plans using the Key Customer feature become invalid and you have to run them again.

The KeyCusOptnMembers detail tab is optional. Use this tab to identify specific customers as key customers.
The Hierarchy Name and Level Name column entries must be the same as the information entered on the
KeyCusOptnHeader tab. Enter valid level member names in the Level Member Name column. These members are the
only customers that will be identified as key customers.

• If the KeyCusOptnMembers detail tab is empty, all child members of the hierarchy level chosen in the Header
tab are flagged as key customers.

• If the KeyCusOptnMembers detail tab isn't empty, only the listed members are identified as key customers.

The members must be children of the hierarchy level named on the Header tab.

When you create a plan, there is an option in the Plan Options dialog box that determines what level of customer
aggregation is used for the plan:

• Key customer data is available and non-key customer data is aggregated to a level member named All Other.

• No customer data is aggregated for the plan if the option is deselected.

Related Topics
• How can I reset the key customer aggregated data for a plan?

Load Aggregated Customer Data from Oracle E-Business Suite  
This topic explains the procedure you follow to load aggregated customer data from an Oracle E-Business Suite source
system into your Oracle Fusion Cloud Supply Chain Planning destination system.

The procedure is composed of the following steps:

1. Extract data from your Oracle E-Business Suite source system.
2. Prepare the Supply Chain Planning Key Customer Options file if you have defined key customers in your Oracle

E-Business Suite source system.
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3. Add the files to your desktop or local hard drive.
4. Import data into your Oracle Supply Chain Planning destination system.

Additional details for each step are provided in this topic.

Prerequisites
To perform the process that extracts data from your Oracle E-Business Suite source system, you must be assigned a
configured, administrator-level role that’s similar to either the Advanced Planning Administrator role or the Advanced
Supply Chain Planner role.

Your source system must be set up as one of the Trading Community Source Systems for Oracle Supply Chain Planning.

You can perform the steps to import data into your Oracle Supply Chain Planning destination system from one of the
Supply Chain Planning work areas. You don't need an administrator role to perform these steps.

Extract Data
To extract the data from your Oracle E-Business Suite source system, run the Extract Data for Oracle Supply Chain
Planning process.

Consider the following conditions for the MSD_DEM_CUSTOMER attribute when you run the process:

• If the MSD_DEM_CUSTOMER_ATTRIBUTE is set to null, then all sites are extracted.

• If the MSD_DEM_CUSTOMER_ATTRIBUTE is set to none, then all records are aggregated to Default Customer
Site.

• If the MSD_DEM_CUSTOMER_ATTRIBUTE is set to a valid customer attribute, then all sites are extracted.

The extracted data is stored in a file in the zipped file format in the middle tier of your source system.

Prepare the Key Customer Options File
If you have defined key customers in your Oracle E-Business Suite source system, then perform these steps to prepare
the Supply Chain Planning Key Customer Option file:

1. Download the template for file-based data loads for the Supply Chain Planning Key Customer Options object.
2. Add your data to the file.
3. Generate the CSV file.

For details on preparing files for loading planning data, refer to these help topics: Loading Planning Data from Files:
Overview and Creating CSV Files Used to Load Planning Data: Procedure.

Add the Files to Your Desktop or Local Hard Drive
Locate the extracted Zip file on your Oracle E-Business Suite middle tier, and download or transfer the file to your
desktop or local hard drive.

If you have defined key customers in the Oracle E-Business Suites source system, then include the Key Customer
Options file in the Zip file.

Import Data into Your Oracle Supply Chain Planning Destination System
To import the data into your Oracle Supply Chain Planning destination system, perform these steps:

1. From the Navigator, click File Import and Export.
2. On the File Import and Export page, perform the upload action using these values:
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◦ File: The file you created

◦ Account: scm/planning DataLoader/Import

3. From one of the Supply Chain Planning work areas, perform the Manage Planning Source Systems task to
check if your source system is already created. If your source system is not already created, then create it with
the following values:

◦ Version: External.

◦ Code: Must be the same as the one used for your Oracle E-Business Suite source system.

4. From a Supply Chain Planning work area, perform the Load Planning Data from Files task.

View and Refresh Collected Measure Data  

View Collected Data for Measures Before Running a Plan  
The Collected Measure Data table enables you to view imported or collected records and their statuses without having
to examine log files or run a plan. The table lists measures that were successfully populated as well as also those that
weren’t for your plan. By using this table, you can quickly resolve problems in the data load process.

Just as you can use the Supplies and Demands table to view the collected or imported supplies and demands, you can
use the Collected Measure Data table to view bookings, shipments, and other entities.

For example, Small Inc. imported its shipments history data using the Supply Chain Planning Shipments History file-
based data import (FBDI) template. To save time and work efficiently, the company wants to ensure that data was
correctly imported before running its plan. The company uses the Collected Measure Data table and selects the option
to view only records with errors. The company notices that several records have an error pertaining to invalid names for
the Customer Site level member. Now that the reason behind the error has been identified, Small Inc. can fix the data
in the FBDI file, import the data again, and run the plan. By using the Collected Measure Data table, Small Inc. quickly
identified data import-related problems and didn’t have to spend time analyzing the log files for the import or analyzing
the plan after running it.

1. In the Plan Inputs work area, click the Open drop-down button.
The Open Table, Graph, or Tile Set dialog box opens.

2. Select the Collected Measure Data table and click OK.
The Collected Measure Data table opens in a new tab.

3. Specify your search criteria, and click Search.
Use the Errors field to limit the records to those with errors or those without errors.

Note:  By default, the table displays only the first 10,000 records that meet your search criteria. To change this
limit, you need to create and use a profile option with the MSC_COLLECTED_MEASURE_DATA_MAX_ROWS code.
No indication is provided if the table has records that aren’t displayed because the predefined or user-defined limit
has been exceeded.

4. Analyze the records that are returned according to your search criteria.
The Last Updated Date column displays the date on which the records were created or last updated.
The Refresh Number column displays the refresh numbers of the collection job sets through which the measures
were populated when the FBDI templates or collections feature was used.
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5. Optionally, to export the records to a Microsoft Excel file for further analysis, click Actions > Export to Excel.
The records available in the Collected Measure Data table are exported to the file. The predefined or user-defined
limit is applied when the records are exported.

Tip:  When you export the records to an Excel file, you can view more than 15 records at a time. You may find it
helpful during your error analysis to view more than 15 records at a time.

Additional Points About the Collected Measure Data Table  
These are some additional points about the Collected Measure Data table:

• The table displays records that are successfully uploaded to the MSC_MEASURE_DATA table.

• For records with errors, the table displays records from the MSC_ST_MEASURE_DATA staging table that have
information in the ERROR_TEXT column.
The table doesn't display records from the staging table that weren't moved to the MSC_MEASURE_DATA table
and don't have error information.

• The table filters records by the applicable security privileges of the user. For example, if you have access to only
certain organizations, you can view measure values for only those organizations.

• The table lists both predefined and user-defined measures.

• The table displays measure data that’s imported through these file-based data import (FBDI) templates:
◦ Supply Chain Planning Bookings History

◦ Supply Chain Planning Causal Factors

◦ Supply Chain Planning Forecast Measures

◦ Supply Chain Planning Measures

◦ Supply Chain Planning Option Bookings History

◦ Supply Chain Planning Option Shipments History

◦ Supply Chain Planning Shipments History

• The table doesn’t display measure data that’s imported through the Supply Chain Planning External Forecasts
and Supply Chain Planning Price Lists FBDI templates.
To troubleshoot imported data for external forecasts or price lists, examine the log files or run your plan.

• The table also displays any measure for which information is collected from Oracle Fusion Cloud Applications
Suite or imported from Oracle E-Business Suite.

• To view aggregated non-key customer data in the table for demand, demand and supply, and sales and
operations plans, before collecting or importing measure data, select the Aggregate non-key customer data
to an All Other level member check box on the Demand tab on the Plan Options page for the plan. Then, enter
the required aggregation levels in the Supply Chain Planning Key Customer Options FBDI template, and import
customer data with the template. After you collect or import measure data, when you filter your records by the
plan name in the table, you can view the aggregated data for non-key customers. For aggregated records, the
value displayed in the Customer column is “<zone name>:All Other.”

• The table doesn't return aggregated data for a planning level profile.

• To avoid reduced performance, don’t sort the records if you increase the maximum
number of records displayed in the table by creating and using a profile option with the
MSC_COLLECTED_MEASURE_DATA_MAX_ROWS code.
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Related Topics
• How You Aggregate Customer Data

Refresh Collected Measure Data  
The Orchestrate Refresh Measures Processes scheduled process lets you update the plan data for collected planning
measures without running the plan.

You can refresh a subset of predefined or user-defined measures such as shipments and bookings history, sales and
marketing forecasts, and financial measures such as Budget Value and Financial Forecast Value. This scheduled process
retains the measure data for statistical and simulation demand forecasts usually purged when running your plan. By
defining a job set, you can automate this scheduled process to refresh measures immediately after loading external
measure data from flat files.

For example, an enterprise has a weekly demand planning cycle. They need to generate a baseline statistical forecast
once a week but continue to get daily updates for recent shipments, bookings, and sales forecasts. Instead of running
the plan daily, they modify their planning process to run it at the start of the week and then refresh the key collected
measures daily.

Orchestrate Refresh Measures Processes  
Use these steps to configure the Orchestrate Refresh Measures Processes scheduled process using a measure catalog
containing only a subset of plan measures:

1. In the Scheduled Processes work area, click Schedule New Process on the Overview page.
2. In the Schedule New Process dialog box, search for and select Orchestrate Refresh Measures Processes, and

then click OK.
3. In the Process Details dialog box, Basic Options section, do the following:

◦ Plan: Select a plan name.

◦ Measure Catalog: Select a measure catalog.

4. Click Advanced and navigate to the Schedule tab. You can set up the process to run as soon as possible or
establish a schedule.

5. When done, click Submit.

The Confirmation dialog box opens and displays the process number. You can use this process number to search for the
process result in the Scheduled Processes work area.

Related Topics
• Orchestrate Refresh Measures Processes
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Additional Information About Orchestrate Refresh Measures
Processes  
Here’s some additional information about the Orchestrate Refresh Measures Processes scheduled process:

• You can schedule the Orchestrate Refresh Measures Processes scheduled process to refresh collected
measure data for one time or on a repetitive schedule from the Scheduled Processes work area. You can
configure a job set that contains the Orchestrate Refresh Measures Processes scheduled process after the
Load Planning Data from Flat Files scheduled process to sequence and automate these planning processes.

• When copying a plan, you get the following options:

◦ Copy plan options only

◦ Copy plan with reference to the base plan

◦ Copy plan with no reference to the base plan

If the copied plan was created using the second option (Copy plan with reference to the base plan), then it
doesn't support the Refresh Collected Measure Data capability. Such plans don't appear in the Plan field of the
Orchestrate Refresh Measures Processes scheduled process.

• The Orchestrate Refresh Measures Processes scheduled process considers the measure data uploaded using
file-based data import (FBDI) templates, including planning measures and demand history. The scheduled
process doesn't consider transactional data such as sales orders, price changes, or new items and organizations
that aren't already included in a plan. For supply plans, measure data loaded using the Supply Chain Planning
External Forecasts import template can't be refreshed.

• If you've defined a measure with the Refresh with current data option on the Properties subtab on the
Advanced tab in the Create Measure dialog box, after you add the measure to a plan, you must first run the plan
to refresh it with the current data before you can refresh that measure's data using this scheduled process.

Note:  Run your plan after a release upgrade before using this scheduled process.

• You need to include both the Shipments History (or Bookings History) measure and the default measure used
to refresh shipments history in your measure catalog. For example, if the default measure used for the Default
Shipments History Measure profile option is Shipments History: Requested Item by Shipped Date, then include
both this measure and the Shipments History measure in the measure catalog used to refresh your plan.

• You can't use the Orchestrate Refresh Measures Processes scheduled process to refresh the measures in a
demand plan that has a planning level profile. Such plans aren't available for selection in the Plan field for the
scheduled process.

Related Topics
• Orchestrate Refresh Measures Processes

• Overview of Planning Level Profiles
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7  Exceptions

Exceptions in Plans  

Overview of Plan Exceptions  
Exceptions are a key element to evaluate and improve your plan in Oracle Fusion Cloud Supply Chain Planning.

After you run a plan, view the exceptions to understand the quality of the plan and to get visibility of key problem areas.
You can focus on key exceptions to understand their root causes. From the exceptions tables, you can drill down to
other plan views for more details into the problem areas. After taking actions to resolve exceptions, run the plan again
to evaluate whether the plan is now acceptable.

Oracle provides several predefined exceptions that the Oracle Supply Chain Planning processes compute after you run
a plan. View these exceptions to identify problem areas in the plan that might need your attention. To view a list of the
exceptions, open your plan and then open the Exceptions table.

The exception types and their calculation logic are predefined. However, to ensure that only significant deviations
are highlighted, you can edit the conditions under which the exceptions are generated. You control which exceptions
to calculate for a plan by specifying an exception set on the Plan Options page. View the metrics associated with
exceptions, such as by count or by quantity, in tables or graphs at different hierarchical levels.

You can also create user-defined exceptions based on specific conditions in the supply chain that you want to identify.
Base these user-defined exceptions on your business requirements and focus on specific areas to improve your supply
chain planning capabilities. Use the Configure Exception task to create a user-defined exception.

Note:  You can't create user-defined exceptions in the Planning Central work area. Also, there are no predefined
exceptions for Replenishment Planning.

Plan Exception Types
From within your plan, you can open the Exceptions table to view the exceptions grouped within the following folders:

Exception Folder Accessible from these work areas:

Demand Planning Exceptions
 

Demand Management
 
Planning Central
 
Sales and Operations Planning
 

Replenishment Planning Exceptions
 

Replenishment Planning (user-defined exceptions only)
 

Sales and Operations Planning Exceptions
 

Sales and Operations Planning
 

Supply Planning Exceptions
 

Supply Planning
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Exception Folder Accessible from these work areas:

Planning Central
 

Views for Multiple Exceptions
 

Supply Planning
 
Planning Central
 

Exception Categories
There are two categories of exceptions:

• Measure-based exceptions

• Order-based exceptions

Oracle provides several predefined exceptions for most Supply Chain Planning modules. You can also create user-
defined exceptions from most Supply Chain Planning work areas. The following table lists the Supply Chain Planning
modules, the type of exception, whether the product has predefined exceptions, and whether you can create user-
defined exceptions.

Module Type of Exception Predefined Exceptions User-Defined Exceptions

Oracle Demand Management
 

Measure-based exceptions
 

Yes
 

Yes
 

Oracle Planning Central
 

Measure-based exceptions
 

Yes
 

No
 

Oracle Replenishment Planning
 

Measure-based exceptions
 

No
 

Yes
 

Oracle Sales and Operations
Planning
 

Measure-based exceptions
 

Yes
 

Yes
 

Oracle Supply Planning
(constrained and unconstrained)
 

Order-based exceptions
 
Measure-based exceptions
 

Yes
 

Yes
 

View Exceptions for Your Plan
When you open the exceptions table, the number of exception records generated are shown after the exception name,
in parentheses. Clicking the exception name displays a table with details of the exception. From the Exceptions tab, you
can:

• Search for exceptions for a specific item and organization within a specified date range

• Search for measure-based exceptions based on various attributes such as Planner, Planner Description,
Catalog, and Category. If a measure-based exception is created at the category level, categories specific to the
catalog selected in the hierarchy parameter appear in search results. If a measure-based exception is created
at the Item level, then you can filter the records based on Item, Catalog, and Category Level attributes. If a
measure-based exception is created with no product dimension, then you can filter the records based on other
attributes except Item and Category level
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• Save the search criteria for future searches

• Export the table to a spreadsheet, rearrange columns, and perform other standard table actions on the table

Predefined views within the Views for Multiple Exceptions folder enable you to view all exceptions for an item, resource,
or supplier within the same table. The folder is available only in the Supply Planning and Planning Central work areas.

From tables that show exception data, you can navigate in context to other plan data. This navigation capability is useful
when, for example, you view exceptions for an item and you also want to see its supply or resource availability.

Related Topics
• How You Edit Exceptions

• Configure Exception Thresholds

• Overview of Exceptions and Exception Sets

• Overview of Predefined Planning Exceptions

• Overview of User-Defined Exceptions

Configure Exception Thresholds  
You can control the number of exceptions that your plan generates by changing the levels at which an exception is
computed and its threshold value. A higher threshold value typically results in fewer exceptions.

To configure exception thresholds, do the following:

1. From a Supply Chain Planning work area, select the Configure Exceptions task.
2. On the Configure Exceptions page, select an exception.
3. Click Actions and then select Edit.

Demand planning, replenishment planning, and sales and operations planning exceptions are measure-based
exceptions. A base measure forms the foundation for these exceptions.

In the Planning Central work area, you can't change the base measure, but you can edit the level at which the exception
is computed and its threshold value.

Most supply planning exception calculations are for a specific order and aren't associated with a base measure. For
these types of exceptions, select the fact associated with the exception and modify the condition that specifies when to
generate the exception. Think of a fact as an attribute of the exception. Typical facts are quantity and value.

Related Topics
• How You Edit Exceptions

• Overview of Plan Exceptions

• Overview of User-Defined Exceptions

Create Tables and Graphs for Exceptions  
Create a table or graph for plan exceptions based on their measures, such as number of exceptions generated and the
quantity associated with the exception.

165



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 7
Exceptions

Create a Table for Exceptions

1. In a Supply Chain Planning work area, open a plan.
2. Click the Actions button and select Manage Tables, Graphs, and Analysis Sets from the list.
3. In the Manage Tables, Graphs, Analysis Sets dialog box, click Actions. Next, select Create and then select Table.
4. On the Create Table page, do the following:

◦ Enter a name for your table.

◦ Select a group.

◦ Enter a description.

◦ Select the type of access (public or private).

5. On the Measures tab, do the following:
a. In the Available Measures section, expand the Overall Plan Health folder.

The Overall Plan Health folder contains the measures associated with exceptions.
b. Select the exception facts that you want to view in the table.

6. On the Hierarchies tab, include the Exception Type hierarchy.
7. On the Members tab, select the exception types to display in the table.
8. Click Save and Close.

Create a Graph for Exceptions

1. In a Supply Chain Planning work area, open a plan.
2. Click the Actions button and select Manage Tables, Graphs, and Analysis Sets from the list.
3. In the Manage Tables, Graphs, Analysis Sets dialog box, click Actions. Next, select Create and then select

Graph.
4. On the Create Graph page, do the following:

◦ Enter a name for your graph.

◦ Select a group.

◦ Enter a description.

◦ Select the type of access (public or private).

5. On the Measures tab, do the following:
a. In the Available Measures section, expand the Overall Plan Health folder.

The Overall Plan Health folder contains the measures associated with exceptions.
b. Select the exception facts that you want to view in the graph.

6. On the Hierarchies tab, include the Exception Type hierarchy.
7. On the Members tab, select the exception types to display in the graph.
8. On the Layout tab, do the following:

a. In the Graph Layout Options section, select a type of graph.
b. Configure your graph in the horizontal panels below the Graph Layout Options.

The horizontal panels below the Graph Layout Options section vary, depending on the type of graph that
you select. For example, if you select Pie Graph for your graph type, the horizontal panels include General
Options, Pie Slice, and Formatting.
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9. Click Save and Close.

Related Topics
• How You Edit Exceptions

• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

• Overview of Plan Exceptions

Exceptions and Exception Sets  

Overview of Exceptions and Exception Sets  
On the Configure Exceptions page, you can select an exception and edit the thresholds for reporting. You can configure
only those exceptions that are relevant to your Supply Chain Planning work area.

On the Configure Exception Sets page, you can restrict the exceptions that are computed as part of the plan run. You
can also control the organizations, item categories, time period, and so on for which to compute exceptions.

A defined exception set is associated with a plan. The plan evaluates the exceptions using the filters associated with the
exception set. Select the exception set to use during the plan run on the Plan Options page, Scope tab.

Related Topics
• How You Edit Exceptions

• Configure Exception Sets

• Set Filters on Planning Dimensions for Exceptions

• Overview of User-Defined Exceptions

• Define Scope Plan Options

How You Edit Exceptions  
To edit exception parameters, select an exception on the Configure Exceptions page. You can configure only those
exceptions that are relevant to your Supply Chain Planning work area.

In the Edit Exception dialog box, there is an area for General Properties and Exception Detail. Depending on the Supply
Chain Planning work area that you're in, you can see the following tabs in the Exception Detail section:

• Demand Management work area: Level, Threshold, and Notification

• Planning Central work area: Level and Threshold

• Replenishment Planning work area: Level, Threshold, and Notification

• Sales and Operations work area: Level, Threshold, and Notification

• Supply Planning work area: Level, Threshold, and Notification
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You can edit Level and Threshold only for those exceptions whose basis is Measure. For exceptions whose basis is
Order, you can edit only the Threshold.

Level Tab
On the Level tab, the dimensions for the exception are derived from the base measure. You can edit the default values
for hierarchy and level. You can also enable and disable each of the available dimensions to control the level that the
exception is evaluated at.

Note:  Ensure that the selected hierarchy is in the dimension catalog for the plan. The Configure Exceptions task is
outside of the plan context. It's possible to select a product hierarchy that's not used in the plan's dimension catalog,
in which case the plan exceptions output won't display data for items.

Threshold Tab
On the Threshold tab, the base measure used in the exception is compared to either a value or another measure. If
the threshold is specified in terms of a value, the value is interpreted in terms of the data type of the base measure. To
ensure that exceptions return meaningful values, set the threshold to an appropriately high or low value.

Notifications Tab
On the Notification tab, set up notification rules for exceptions. Configure exceptions to trigger notifications to specific
users or roles. In the Details section specify the entity and condition for notifications. Notifications are automatically
sent at the end of the plan run.

Related Topics
• Configure Exception Sets

• Set Filters on Planning Dimensions for Exceptions

• Overview of Predefined Planning Exceptions

• Overview of User-Defined Exceptions

• Overview of Plan Exceptions

Configure Exception Sets  
Use the Configure Exception Sets page to create, modify, or copy an exception set.

The set of exceptions and their scope that's calculated by the plan is configured on the Create or Edit Exception Set
page. When creating an exception set, you must first specify the exceptions to include in the set, which can include
user-defined exceptions. User-defined exceptions aren't available in Planning Central.

The exception set also enables you to restrict the generation of exceptions for specific organizations, categories,
suppliers, and customers. You can then point to the exception set on the Plan Options page for a plan.

When you create a constrained supply plan in Supply Planning, the Exception Set plan option defaults to the
Constrained Supply Planning Default exception set.

Use the following steps to configure exception sets:

1. In a Supply Chain Planning work area, click the Tasks panel drawer and click Configure Exception Sets.
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2. On the Configure Exception Sets page, select an existing exception set. Next, click Actions and select
Duplicate.

3. In the Create Exception Sets dialog box:

a. Expand the group of exceptions in the Available Exceptions section. For example, expand Supply
Planning Exceptions.

b. Select the exception from the Available Exceptions section and move it to the Selected Exceptions
section.

4. Click Save and Close to return to your plan.

Note:  To generate exceptions, you must include the exception set in the plan options for your plan.

Related Topics
• How You Edit Exceptions

• Set Filters on Planning Dimensions for Exceptions

• Overview of Plan Exceptions

• Overview of Predefined Planning Exceptions

• Overview of User-Defined Exceptions

Set Filters on Planning Dimensions for Exceptions  
After selecting available exceptions for an exception set to use in a plan, you can add filters on some of the key planning
dimensions. The levels on which you can define filters are organizations, categories, suppliers, and customers.

On the Configure Exception Sets page, Filters tab, select one or more organizations, suppliers, categories, and
customers in each of the tables for which to generate exceptions. If you don't specify a filter for a level, you will generate
exceptions for all records in that level. For example, if you don't specify an organization, exceptions will be generated for
all planning organizations when you run the plan. If any of the organizations, categories, suppliers, or customers in the
exception set aren't available in the plan, they will be ignored.

In the Exception Cutoff Days field, specify the number of calendar days, starting from the plan start date, from which
to generate the exceptions. If this field is blank, exceptions will be generated for the full planning horizon.

Related Topics
• Configure Exception Sets

• How You Edit Exceptions

• Overview of Plan Exceptions

169



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 7
Exceptions

Predefined Planning Exceptions  

Overview of Predefined Planning Exceptions  
The planning process computes several predefined exceptions after you run a plan.

View these exceptions to obtain quick visibility of problem areas in the plan that might need your attention. To view a
list of the exceptions, from a Supply Chain Planning work area, open a plan and then open the Exceptions table.

The Exceptions table is grouped into different folders, depending on the plan type:

• Demand Planning Exceptions

• Sales and Operations Planning Exceptions

• Supply Planning Exceptions

• Views for Multiple Exceptions: View exceptions for an item, resource, or supplier within the same table. (This
folder is available only in the Supply Planning and Planning Central work areas.)

Note:  There are no predefined exceptions for Replenishment Planning, only user-defined exceptions that reside in
the Replenishment Planning Exceptions folder.

Related Topics
• Overview of Plan Exceptions

• How You Edit Exceptions

• Predefined Demand Planning Exceptions

• Predefined Sales and Operations Planning Exceptions

• Predefined Supply Planning Exceptions

Predefined Demand Planning Exceptions  
The basis for all predefined demand planning exceptions is Measure.

The following table lists the predefined demand planning exceptions, their descriptions, the base measure used for the
exception, the intersection of levels that the condition is evaluated for, the threshold to base measure, and the relevant
exception set.

Demand Planning
Exception Name

Description Base Measure Levels Threshold to Base
Measure

Exception Set

Bookings MAPE
Exceeds Threshold
 

The Bookings Forecast
MAPE is greater than
the specified threshold
value.
 

Bookings Forecast
MAPE
 

Item
 
Organization
 

Greater than 0.4
 

Default
 
Demand Management
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Demand Planning
Exception Name

Description Base Measure Levels Threshold to Base
Measure

Exception Set

Shipment MAPE
Exceeds Threshold
 

The Shipments
Forecast MAPE is
greater than the
specified threshold
value.
 

Shipments Forecast
MAPE
 

Item
 
Organization
 

Greater than 0.4
 

Default
 
Demand Management
 

Significant Deviation
between Actual
Sales and Consensus
Forecast
 

The deviation between
the Actual Sales
and the Consensus
Forecast is significant.
 

Deviation between
Shipment History
Shipped Items by
Requested Date and
Consensus Forecast
 

Item
 
Organization
 
Customer
 
Week
 

Greater than 20
percent
 

Demand Management
 

Significant Deviation
between Bookings
History and Final
Bookings Forecast
 

The deviation between
the Bookings History
and the Final Bookings
Forecast is significant.
 

Deviation between
Bookings History
Booked Items by
Requested Date and
Final Bookings
 

Item
 
Organization
 
week
 

Greater than 20
percent
 

Demand Management
 

Significant Deviation
between Budget
and Final Shipments
Forecast
 

The deviation between
the Budget and the
Final Shipments
Forecast is significant.
 

Deviation between
Budget Value and
Final Shipments
Forecast Value
 

Category
 
Organization
 
Period
 

Greater than 0.2
 

Demand Management
 

Significant Deviation
between Marketing
Forecast and
Consensus Forecast
 

The deviation between
the Marketing
Forecast and the
Consensus Forecast is
significant.
 

Deviation between
Final Marketing
Forecast and
Consensus Forecast
 

Item
 
Customer
 
Period
 

Greater than 20
percent
 

Demand Management
 

Significant Deviation
between Sales
Forecast and
Consensus Forecast
 

The deviation between
the Sales Forecast
and the Consensus
Forecast is significant.
 

Deviation between
Final Sales Forecast
and Consensus
Forecast
 

Item
 
Customer
 
Period
 

Greater than 20
percent
 

Default
 
Demand Management
 

Significant Deviation
between Sales
Forecast and Final
Shipments Forecast
 

The deviation between
the Sales Forecast and
the Final Shipments
Forecast is significant.
 

Deviation between
Final Sales Forecast
and Final Shipments
Forecast
 

Item
 
Organization
 
Week
 

Greater than 20
percent
 

Default
 
Demand Management
 

Significant Deviation
between Sales Orders
and Final Shipments
Forecast
 

The deviation between
the Sales Orders and
the Final Shipments
Forecast is significant.
 

Deviation between
Sales Orders by
Request Date and
Final Shipments
Forecast
 

Item
 
Organization
 
Week
 

Greater than 20
percent
 

Default
 
Demand Management
 

Significant Deviation
between Shipments
History and Final
Shipments Forecast

The deviation between
the Shipments
History and the Final

Deviation between
Shipment History
Shipped Items by
Requested Date and

Item
 
Organization
 

Greater than 20
percent
 

Demand Management
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Demand Planning
Exception Name

Description Base Measure Levels Threshold to Base
Measure

Exception Set

 Shipments Forecast is
significant.
 

Final Shipments
Forecast
 

Week
 

Significant Deviation
in Year on Year Sales
 

The difference
between the current
year's sales and the
past year's sales
exceeds a specified
percentage.
 

Deviation in Sales Year
over Year
 

Item
 
Organization
 
Customer
 
Period
 

Greater than 20
percent
 

Default
 
Demand Management
 

User-Defined Exceptions  

Overview of User-Defined Exceptions  
You can create your own exceptions to improve supply planning capabilities using specific conditions in the supply
chain.

Use the Configure Exception task to create a user-defined exception.

You can create and use exceptions for these modules:

Module Exception Type

Oracle Demand Management
 

Measure-based exceptions
 

Oracle Replenishment Planning
 

Measure-based exceptions
 

Oracle Sales and Operations Planning
 

Measure-based exceptions
 

Supply Planning (constrained and
unconstrained)
 

Order-based exceptions
 
Measure-based exceptions
 

Note:  User-defined exceptions aren't available for Oracle Planning Central.

For user-defined exceptions that are measure based, the measure forms the foundation for that exception. After you
select a measure, you can specify the dimension hierarchy and level for that measure, and the threshold value or
measure to generate the exception. You can create an exception based on the following thresholds:

• Value: Set the value and the specific operation, such as less than, equal, and larger than, against the base
measure.
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• Measure: Select the measure based on your business requirement and select the specific operation that meets
the condition against the base measure.

For example, you can create a date-type, measure-based exception such as launch date or discontinuation date. You
then can set the threshold value with date and select a date-type measure from the Measure parameter.

Consider the Forecast Start Date before Launch Date date-type exception. You can define the parameters as:

• Base Measure = Forecast Start Date

• Operation = Before (Available values for date type exceptions are: After, Before, Equals, On or after, and On or
before)

• Threshold Measure = Product Launch Date

Related Topics
• Configure Measure-Based Exceptions

Configure Measure-Based Exceptions  
This topic covers how to configure measure-based exceptions in Supply Planning, Sales and Operations Planning,
Demand Management, and Replenishment Planning.

You can create measure-based exceptions where the measure forms the foundation for that exception. After you select
a measure, you can specify the dimension hierarchy and level for that measure, and the threshold value or measure
to generate the exception. For example, you can create an exception to identify resource overloads when the resource
utilization percentage is greater than 110%.

Configure Exceptions That Are Measure Based
Use the following general steps to configure a user-defined exception that's measure based.

1. In a Supply Chain Planning work area, click the Tasks panel drawer and click Configure Exceptions.
2. On the Configure Exceptions page, click Actions and then select Create.
3. In the Create Exception dialog box, General Properties section, specify or enter information for the following

fields:

a. Exception
b. Display Name
c. Exception Group
d. Base Measure

4. In the Exception Detail section, on the Level tab, select the dimension and its corresponding hierarchy and level
to use for your exception

What you select for levels determines the combination at which the exception condition is evaluated. For
example, if you select levels Item and Organization, then the exception criteria is evaluated for each unique
combination of Item and Organization.

Note:  Configure Exceptions is a task defined outside of plan context. When configuring exceptions for
measure-based plans, ensure the selected hierarchy is in the plan's dimension catalog in plan options.
Otherwise item level exceptions might be blank after running a plan.
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5. On the Threshold tab:

a. Select an operation.
b. Define a threshold for the base measure, which can be defined based on a value or another measure.

6. On the Notification tab, define the notification attributes.
7. When done, click Save and Close.

Exception Detail Section
In the Create Exception dialog box, the Level tab in the Exception Detail section is populated based on the base
measure. The Level tab consists of dimension, hierarchy, and level.

For example, for the user-defined exception Fill Rate Shortfall Percentage, the details are populated based on the base
measure Fill Rate Shortfall Percentage. As defined on the Threshold tab, the planning process generates this exception
when the Fill Rate Shortfall percentage is greater than 10%.

For this exception, the populated dimensions are Organization and Product. You can select dimensions and their
corresponding hierarchy and levels. In this example for the Product dimension, you can select either Item or Category as
the level.

If you select the Item level, the planning process generates this exception for any item with the Fill Rate Shortfall
Percentage of greater than 10% as defined in the Threshold tab. This case enables you to analyze the plan output in
more detail. At the same time, the number of exceptions could be large enough that analyzing each exception might not
be possible.

On the other hand, if you select the Category level, the planning process generates this exception for any category with
the Fill Rate Shortfall Percentage of greater than 10%. In this case, the number of exceptions is lower than the item level
scenario. But, potentially some issues that exists at the item level aren't visible since the planning process generates an
exception only when the specified criterion holds at the category level.

Related Topics
• Overview of User-Defined Exceptions

• Overview of Plan Exceptions

Configure Exceptions for Replenishment Planning  
Create user-defined exceptions in Replenishment Planning by using the same process to configure measure-based
exceptions covered in the Configure Measure-Based Exceptions topic. This topic details how to configure a specific
exception for Replenishment Planning.

Projected Fill Rate Less than 90 Percent
The fill rate is the fraction of customer demand that's met through immediate stock availability, without backorders or
lost sales. The planning process generates the Projected Fill Rate Less than 90 Percent exception when the projected fill
rate for an item and organization is below 90 percent.

Use these steps to configure a Projected Fill Rate Less than 90 Percent exception for a replenishment plan:

1. Navigate to the Tasks panel. In the Configuration section, click the Configure Exceptions link.
2. On the Configure Exceptions page, click Actions and then select Create.
3. In the Create Exceptions dialog box in the General Properties section, enter or select the following:
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Parameter Value

Exception
 

Projected fill rate less than 90 percent
 

Display Name
 

Projected fill rate less than 90 percent
 

Exception Group
 

Replenishment Planning Exceptions
 

Base Measure
 

Projected Fill Rate
 

4. On the Level tab, specify the dimension and its corresponding hierarchy and level.
5. On the Threshold tab, define the threshold for the base measure as Projected Fill Rate Less than 90%:

◦ In the Operation field, select Less than.

◦ In the Threshold field, select Value and then enter 90.

Related Topics
• Configure Measure-Based Exceptions

• Overview of User-Defined Exceptions

• Overview of Plan Exceptions

• Configure Exception Thresholds

Configure Exceptions Based on User-Defined Measures  
You might have a scenario where you need to define a user-defined measure and then configure an exception based on
that measure.

For example, you want to identify the items that have demands with a risk of not being satisfied, and the value of these
demands are 10 percent more than their quarterly revenue.

Step 1: Configure a User-Defined Measure
In our example, the first step is to define a user-defined measure that represents the percentage value of demands at
risk. This percentage can be calculated as follows:

Demand at Risk Value Percentage = (Demand at Risk Value / Revenue) x 100

Use the following steps to configure a user-defined measure.

1. Navigate to the Tasks panel. In the Configuration section, click the Manage Planning Measures link.
2. On the Manage Planning Measures page, click Actions and then select Create.
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3. In the Create Measure dialog box, enter or select the following:

Parameter Value

Measure
 

Demand at Risk Value Percentage
 

Description
 

Enter a description
 

Data Type
 

Percent
 

Enable in Work Area
 

Supply Planning
 

Measure Groups
 

Overall Plan Health
 

4. On the Aggregation and Disaggregation tab in the Dimension Parameters section, select the Customer and
Demand Class dimensions.

5. On the Expression tab, Functions subtab, define the Demand at Risk Value Percentage equation:

Safe_Division (Demand at Risk Value, Revenue, null) * 100.
6. Click Save and Close.

Step 2: Configure a User-Defined Exception
The next step is to configure a user-defined exception using Demand at Risk Value Percentage as the base measure.

1. Navigate to the Tasks panel. In the Configuration section, click the Configure Exceptions link.
2. On the Manage Planning Measures page, click Actions and then select Create.
3. In the Create Exceptions dialog box, in the General Properties section, enter or select the following:

Parameter Value

Exception
 

Demand at Risk Value over 10 Percent of Revenue
 

Display Name
 

Demand at Risk Value over 10 Percent of Revenue
 

Exception Group
 

Supply Planning Exceptions
 

Base Measure
 

Demand at Risk Value Percentage
 

4. In the Exception Detail section, on the Level tab, specify the dimension and its corresponding hierarchy and
level.

5. On the Threshold tab, define the threshold for the base measure as Demand at Risk Value Percentage Greater
than 10%:
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Parameter Value

Base Measure
 

Demand at Risk Value Percentage
 

Description
 

Demand at Risk Value Percentage
 

Operation
 

Greater than
 

Threshold Value
 

10%
 

6. Click Save and Close.

Calculate User-Defined, Measure-Based Exceptions  
After you modify, add, or delete one or more user-defined, measure-based exceptions in your plan’s exception set,
you can recalculate these exceptions independent of running the plan. These calculations are based on the current
definitions of the exceptions and include any changes since the plan was last run.

This calculation is based on the current definition of exceptions that includes any changes since the plan was last run.
By default, the process calculates all exceptions in the plan exception set. You can change the exception set parameters
of the process to calculate a subset of those exceptions.

Note:  The Calculate Measure-Based Exception process doesn't recalculate predefined order-based exceptions.

The Calculate Measure-Based Exception process is available from the Supply Planning, Demand Planning,
Replenishment Planning, and Sales & Operations Planning work areas.
You can recalculate user-defined, measure-based exceptions from these pages:

• Scheduled processes: By default, scheduled process recalculates all exceptions in the exception set. However,
you can also recalculate exceptions of a subset by changing the exception set parameters.

• Actions menu on the header of the open plan

• Actions menu on Manage Plans page

Note:  The Calculate Measure Based Exception process and Plan Run process cannot run simultaneously for the same
plan.
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8  Segmentation

Segmentation in Oracle Replenishment Planning  
Segmentation is the process of grouping item-location combinations into segments on the basis of user-defined, static,
or dynamic attributes. Through segmentation, you can better manage the replenishment requirements for many item-
location combinations by grouping them into a few segments.

You do replenishment planning and forecasting and apply policy assignment sets by segment groups. You also view
data in tables and graphs by segments.

You can also filter data in analysis sets by using segments as filters. Then, you can apply forecasting profiles to specific
segments by selecting the associated analysis sets.

For example, you can perform segmentation by defining segment groups that are based on:

• Intermittency and volatility

• Demand volume and cost

• Item attributes for the Product and Organization dimensions

• User-defined attributes and organizations, regions, and zones

You collect the item-location combinations and associated attributes from Oracle Fusion Cloud Product Lifecycle
Management. To restrict segmentation to items for which replenishment planning must be done, you first set the MPS
and MRP Planning Method attribute of items to Replenishment planning in Oracle Product Lifecycle Management.
Then, while setting up the criteria for segments of a segment group, you set the Planning Method attribute for the
Product dimension to Replenishment planning. After segmentation, only replenishment planning items are grouped
into the segments of the segment group. If you don't restrict the scope of segmentation, it happens for all item-location
combinations collected from Oracle Product Lifecycle Management; however, the replenishment plans process only
those item-location combinations for which the MPS and MRP Planning Method attribute is set in Oracle Product
Lifecycle Management.

How You Perform Segmentation
Here's what you do during the segmentation process:

1. Set up a segment group and its segments. The segment group has a specific granularity that's applicable to
the segments. You specify dimension-based or measure-based criteria for each segment on the basis of which
item-location combinations are assigned to the segment.

2. Run the segmentation job for the segment group from the Manage Segment Groups and Criteria page
(Actions > Execute Segmentation).The item-location combinations are grouped into the segments.

3. View the results of segmentation, and optionally override the assignment of item-location combinations to
segments to better meet your business requirements.

This flow chart summarizes the segmentation process:
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When the segments are used as members for tables and graphs, for item-location combinations that aren't associated
with a segment in the segment group, the segment information is shown as "Not available."

What You Do After Segmentation
Here's what you do after the segmentation process:

1. Create a policy assignment set, and attach the segment group to the policy assignment set.
2. Attach the segment group to a replenishment plan.
3. Run the replenishment plan to calculate the unique replenishment requirements for the item-location

combinations in each segment.
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Work with Segment Groups  

Create a Segment Group  
A segment group consists of segments into which combinations are grouped. The segment group has a granularity
that's also applicable to the segments. You define the segments on the basis of dimension-based or measure-based
criteria.

• In the Replenishment Planning work area, the combinations consist of items and locations that are collected
from Oracle Fusion Cloud Product Lifecycle Management.

• In the Supply Planning and Planning Central work areas, the combinations consist of items and locations that
are collected from Oracle Product Lifecycle Management.

• In the Sales and Operations Planning work area, the combinations consist of items and locations that are
collected from Oracle Product Lifecycle Management.

• In the Demand Management work area, the combinations could include both:

◦ Items and locations that are collected from Oracle Product Lifecycle Management.

◦ Customers and demand classes that are collected from Oracle Fusion Cloud Applications and external
sources.

To create a segment group, you must:

1. Create the segment group.
2. Define the segments.
3. Define criteria for the segments.

To restrict segmentation to items for which replenishment planning must be done, you first set the MPS and MRP
Planning Method attribute of items to Replenishment planning in Oracle Product Lifecycle Management. Then, while
setting up criteria for segments of the segment group, you set the Planning Method attribute for the Product dimension
to Replenishment planning. After collection and segmentation, only replenishment planning items are grouped into the
segments of the segment group.

If you're planning replenishments at the item-subinventory level, select the Organization dimension for the segment
group. Then, add the dimension to segments of the group, and use the Location attribute of the dimension to include
subinventories in the segments. The subinventories are listed in the <organization>:<subinventory> format.

Create the Segment Group
Follow these steps to create the segment group:

1. On the Tasks panel tab, under Plan Inputs, select Manage Segment Groups and Criteria.

The Manage Segment Groups and Criteria page opens.
2. Under Search Results, click Actions > Create.

The Create Segment Group page opens.
3. In Segment Group, enter the segment group name.
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4. In Source System, select the source system for the segment group.
The source system must be the same as that used in the plan to which you attach the segment group. Only the
combinations in the selected source system are available after segmentation in the segment group.

5. In Simulation Set, select a simulation set for the segment group.
If you plan to simulate changes to the same item attributes at the segment group and plan levels, preferably,
use the same simulation set in both cases.

6. In Description, enter the segment group description.
7. Under Segment Granularity, in the Dimension column, select the dimension that you want to specify for the

segment group granularity.
The lowest levels for the selected dimensions are displayed in the Level column, and the displayed levels make
up the segment group's granularity.
Note the following:

◦ For demand, demand and supply, sales and operations, and supply plans, only the predefined Customer,
Demand Class, Organization, and Product dimensions are supported. You must select the Product
dimension. If you select the Customer or Demand Class dimension, you must specify measure-based
criteria for each segment.

◦ For replenishment plans, you must select only the Organization and Product dimensions.

8. Add more dimensions as required by clicking the Add Row icon.
9. In Catalog, select the Oracle Product Lifecycle Management catalog from which you want to use categories

while specifying the attributes for Product dimension-based criteria of segments in the group.
10. Click Save.

Define the Segments
Follow these steps to create a segment in the segment group:

1. Under Segments, click the Add Row icon.
2. Enter the segment name and description.
3. Under Rank, accept the default number that's a multiple of 10 or enter a whole number that's unique for the

segment group.
During segmentation, if a combination meets the criteria for more than one segment, the combination is
assigned to the segment with the lower rank.

4. Add more segments as required.
5. Click Save.

Define Criteria for the Segments
Follow these steps to define criteria for segments:

1. Under Segments, select the segment for which you want to define criteria.
2. Under Segment Criteria, click the Add Row icon.

A row appears for the segment criterion of the segment.
3. Set the criterion as follows:

a. In the list under Dimension, if you want the criterion to be based on the selected dimensions for the
segment group:

i. Select a dimension.
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The list under Attribute is enabled and displays the attributes for the selected dimension.
ii. In the list for attributes, select an attribute for the dimension.

If you selected the Product dimension, and you previously specified an Oracle Product Lifecycle
Management catalog, the list includes Category as an attribute.

If you selected the Product dimension, you can select the attribute named Safety Stock Planning
Method.

iii. In the list for operators, select the operator with which you want to evaluate the attribute.

Depending on your selection, fields or lists under From Value and To Value may be enabled, and
dialog boxes may open.

iv. Specify the values for the attribute.

If you selected Category as an attribute, the categories for the selected Oracle Product Lifecycle
Management catalog are displayed in the list under From Value.

If you selected Safety Stock Planning Method as an attribute, you can select Safety stock
quantity, Days of cover, or Not planned in the list under From Value.

b. In the list under Dimension, if you want the criterion to be based on measures:

i. Select Measure-based criteria.

The Search and Select: Plans dialog box appears.
ii. In the Available Plans pane, in Type, specify the plan type.

iii. Click the Find icon.

The available plans are displayed. For Replenishment Planning, only those plans for which the
Generate forecast check box is selected on the Plan Options page are displayed.

The plans should have been run and contain tables with the required measures. The tables should
have only those dimensions and levels that are in the segment group.

iv. Select and move plans to the Selected Plans pane.
v. Click OK to return to the Create Segment Group page.

vi. In Measure Evaluation Table, select the table from which a measure should be selected for the
segment criterion.

The tables associated with the selected demand or replenishment plans are available in the list.
vii. In Measure Name, select a measure.

viii. In Operator, select the operator with which you want to evaluate the measure value.

Depending on your selection, the From Value field, To Value field, or both are enabled.
ix. Specify the values for the measure.

4. Add more rows for segment criteria as required.

If you're adding rows, enter a whole number in the field under Group for each row. During segmentation,
those rows with the same whole number are processed with the AND operator. Then, the resulting criteria are
processed with the OR operator.

5. Click Save.
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Related Topics
• How You Set Up Replenishment Planning for Subinventories

Edit a Segment Group  
You can edit and delete segment groups, segments, and segment criteria.

Edit the Segment Group
You can duplicate, edit, and delete a segment group.

You can delete the segment group only if it's not associated with a policy assignment set or a plan for the work area.

The changes you can make to the segment group are limited. You can't change the name or source system for the
segment group, and you can't change its granularity by adding or deleting dimensions.

Follow these steps to edit the segment group:

1. On the Tasks panel tab, under Plan Inputs, select Manage Segment Groups and Criteria.
The Manage Segment Groups and Criteria page opens.

2. Search for the segment group that you want to edit.
3. Select the segment group, and click Actions > Edit.

The Edit Segment Group page opens.
4. Change the description and simulation set as required.

If you plan to simulate changes to the same item attributes at the segment group and plan levels, preferably,
use the same simulation set in both cases.

5. In Catalog, select the catalog from Oracle Fusion Cloud Product Lifecycle Management from which you want to
use categories while specifying the attributes for Product dimension-based criteria of segments in the group.
If you previously selected a catalog and used one of its categories while setting up a Product dimension-based
criterion, the list is grayed out.

6. Click Save.

Edit the Segments
You can add, duplicate, and delete segments and change their names, descriptions, and ranks.

In the Replenishment Planning work area, you can delete segments only if the segment group isn't associated with a
policy assignment set or replenishment plan. In the Supply Planning work area, you can delete the segment group only
if it's not associated with a policy assignment set or supply plan. In the Sales and Operations Planning work area, you
can delete the segment group only if it's not associated with a plan.

If you change the rank of a segment, you may change how combinations are assigned to segments after you run
segmentation again. During segmentation, if a combination meets the criteria for more than one segment, the
combination is assigned to the segment with the lower rank.

Edit the Segment Criteria
You can add, edit, and delete criteria for a segment.
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For dimension-based criteria, you can change the attributes, operators, and values. For measure-based criteria, you can
change the plans, measure evaluation tables, measures, operators, and values.

Depending on the operator used for a criterion, you can change the values under From Value, To Value, or both.

If you change the value under Group for the criterion, you may affect the segmentation result. During segmentation,
those criteria with the same whole number are processed with the AND operator. Then, the resulting criteria are
processed with the OR operator.

Run Segmentation  
You can run segmentation for a segment group from the Manage Segment Groups and Criteria page.

Follow these steps to run segmentation for the segment group:

1. On the Tasks panel tab, under Plan Inputs, select Manage Segment Groups and Criteria.

The Manage Segment Groups and Criteria page opens.
2. Search for the segment group for which you want to run segmentation.
3. Select the segment group, and click Actions > Execute Segmentation.

The Execute Segmentation dialog box opens.
4. To retain your segment overrides, select Retain segment overrides.

To save your last segmentation result for display on the Segmentation Summary page, select Save the last
segmentation result. When you select this check box, the results of the last segmentation run are displayed
under the Previous heading on the Segmentation Summary page, and the results of the segmentation run you
are presently submitting are displayed under the Latest heading.

Tip:  If you're performing simulations, you may want to repeatedly make changes to your segmentation
criteria and run segmentation so that you can compare the results of your changes with the results of the
last segmentation run, which are displayed under the Latest heading on the Segmentation Summary page.
In such cases, you don't want to select this check box. When you have finished your simulations and are
satisfied with the results of your changes, then select this check box.

5. Click Submit.

The Information dialog box opens and provides you with the request number (process ID) of the segmentation
run. You can use this request number to search for the process status and log on the Scheduled Processes
page. If the segmentation run fails, see the log for more information and troubleshooting.

6. Click OK.

The Information dialog box closes.
7. On the Manage Segment Groups and Criteria page, click View > Refresh to update the status and last run date

of segmentation for the segment group.

185



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 8
Segmentation

View the Segmentation Summary  
You can view segmentation results on the Segmentation Summary page. The results of the latest and previous
segmentation runs are displayed.

A segment group consists of segments into which combinations are grouped.

• In the Replenishment Planning work area, the combinations consist of items and locations that are collected
from Oracle Fusion Cloud Product Lifecycle Management.

• In the Supply Planning and Planning Central work areas, the combinations also consist of items and locations
that are collected from Oracle Fusion Cloud Product Lifecycle Management.

• In the Sales and Operations work area, the combinations consist of items and locations that are collected from
Oracle Fusion Cloud Product Lifecycle Management.

• In the Demand Management work area, the combinations could include both:

◦ Items and locations that are collected from Oracle Fusion Cloud Product Lifecycle Management.

◦ Customers and demand classes that are collected from Oracle Fusion Cloud Applications and external
sources.

View the Summary
Follow this procedure to view the segmentation summary for a segment group:

1. Perform one of these steps:

◦ On the Tasks panel tab, under Plan Inputs, select View Segmentation Summary.

The Segmentation Summary page opens.

◦ On the Manage Segment Groups and Criteria page, select a segment group, and click Actions > View
Segmentation Summary.

The Segmentation Summary page opens.
2. In Segment Group, select the segment group for which you want to view the segmentation summary.

The page is refreshed with the segmentation summary for the segment group. The results of the latest and
previous segmentation runs are displayed, along with other details of the combinations for each segment.

You can click a number for a segment under a column to open the Manage Segment Members page and view
the combinations that meet the criteria for the number that you clicked. If you perform any overrides on the
Manage Segment Members page, the changes are immediately reflected on the Segmentation Summary page.

If you opened the segmentation summary from the Manage Segment Groups and Criteria page, the field is
grayed out, and you can view segmentation results for only the segment group you selected on the page.

3. Click Done to close the Segmentation Summary page.
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Points to Note About Displayed Information
Note these points about the information displayed on the Segmentation Summary page:

• You can use the latest and previous results to understand how and why combinations have moved from one
segment to another. These movements happen because of changes in demands, sales, and consumption. By
identifying the factors underlying these movements, you can fine-tune the segmentation process and apply
manual overrides as required.

• Every time you run segmentation with the Save the last segmentation result check box selected in the
Execute Segmentation dialog box, the latest results presently displayed on the Segmentation Summary page
are displayed as the previous results, and the results of the job you just submitted are displayed as the latest
results. Your manual overrides remain unaffected so long as you selected the Retain segment overrides check
box in the Execute Segmentation dialog box.

• If you have run segmentation for the first time for the segment group, the previous results aren't displayed.

• No previous results are displayed for a segment that's added during the latest segmentation run.

• The values under the Latest Count, Previous Count, Added in Latest Run, and Removed in Latest Run
columns don't include your manual overrides.

Override Segmentation Results  
You can override segmentation results by manually assigning combinations to segments.

• In the Replenishment Planning work area, the combinations consist of items and locations that are collected
from Oracle Fusion Cloud Product Lifecycle Management.

• In the Supply Planning and Planning Central work areas, the combinations also consist of items and locations
that are collected from Oracle Fusion Cloud Product Lifecycle Management.

• In the Supply Planning and Planning Central work areas, the combinations also consist of items and locations
that are collected from Oracle Fusion Cloud Product Lifecycle Management.

• In the Demand Management work area, the combinations could include both:

◦ Items and locations that are collected from Oracle Fusion Cloud Product Lifecycle Management.

◦ Customers and demand classes that are collected from Oracle Fusion Cloud Applications and external
sources.

In the case of Replenishment Planning, the combinations consist of items and locations that are collected from Oracle
Fusion Product Lifecycle Management. In the case of Demand Management, the combinations could also include
customers and demand classes that are collected from Oracle Fusion Cloud Applications and external sources.

You can override segmentation results using the:

• Manage Segment Members page

• Edit-in-spreadsheet feature

Changes you make to the segments for combinations are overwritten the next time you run segmentation for the
segment group unless you have selected the Retain segment overrides check box in the Execute Segmentation dialog
box.
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Override Segmentation Results Using the GUI
To override segmentation results through the Manage Segment Members page, follow this procedure:

1. Perform one of these steps:

◦ On the Tasks panel tab, under Plan Inputs, select Manage Segment Members.

The Manage Segment Members page opens.

◦ On the Manage Segment Groups and Criteria page, select a segment group, and click Actions > Manage
Segment Members.

The Manage Segment Members page opens and displays the combinations for the segment group.

◦ On the Segmentation Summary page, for the segment of a segment group, click the number under
Latest Count, Previous Count, Added in Latest Run, Removed in Latest Run, Manually Added to
Segment, Manually Removed from Segment, or Final Count.

The Manage Segment Members page opens and displays the combinations corresponding to the
number you clicked.

2. On the Manage Segment Members page, under Search, select the segment group for which you want to
override the segmentation results, and click Search. You can further refine your search by the segment,
previous segment, and levels for the dimensions in the segment group.

The page is refreshed with the segmentation results. For each combination, the assigned segment in the latest
segmentation run, assigned segment in the previous segmentation run, and segment override are displayed.

3. For each combination for which you want to override the segmentation results, under Segment Override,
select the new segment.

4. Click Save and Close.

Override Segmentation Results Using a Spreadsheet
To override segmentation results through the edit-in-spreadsheet feature, follow this procedure:

Note:  You must first download and install the desktop integration installer that's available under Navigator > Tools.
Otherwise, you can't override segmentation results using a spreadsheet.

1. Perform one of these steps:

◦ On the Tasks panel tab, under Plan Inputs, select Manage Segment Members.

The Manage Segment Members page opens.

◦ On the Manage Segment Groups and Criteria page, select a segment group, and click Actions > Manage
Segment Members.

The Manage Segment Members page opens and displays the combinations for the segment group.

◦ On the Segmentation Summary page, for the segment of a segment group, click the number under
Latest Count, Previous Count, Added in Latest Run, Removed in Latest Run, Manually Added to
Segment, Manually Removed from Segment, or Final Count.

The Manage Segment Members page opens and displays the combinations corresponding to the
number you clicked.
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2. On the Manage Segment Members page, under Search, select the segment group for which you want to
override the segmentation results, and click Search.

The page refreshes with the segmentation results.
3. Under Search Results, click Edit in Spreadsheet.

A dialog box opens and prompts you to open or save a Microsoft Excel file.
4. Open the spreadsheet.

The Connect dialog box opens and prompts you to connect to the application URL.
5. Click Yes.

A dialog box opens and prompts you to enter your credentials.
6. Sign in with your Oracle Applications Cloud credentials.

The spreadsheet is refreshed with the combinations in the segment group displayed on the Manage Segment
Members page. For each combination, the assigned segment in the latest segmentation run, assigned segment
in the previous segmentation run, and segment override are displayed. Only the first 2,000 rows are displayed.

7. To narrow your search to a combination in the segment group, enter the details in the first table, and click
Manage Segment Members > Search.

You can use the percent sign as a wildcard character for your search.
8. For each combination for which you want to override the segmentation results, under the Segment Override

column, select the new segment.

A symbol appears in the cell under the Changed column for each changed row.
9. To upload your changes, click Manage Segment Members > Upload.

The results of the upload for each row are displayed under the Status column.

The symbol in the cell under the Changed column disappears for each successfully uploaded row.
10. Save and close the spreadsheet.
11. To view your changes on the Manage Segment Members page, click View > Refresh.
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9  Policy Assignment Sets and Policy
Parameter Calculation

Policy Assignment Sets  
A policy assignment set is a group of policy parameters that are defined for each segment of a segment group.

Policies are calculated for item-location combinations on the basis of these policy parameters. The policy assignment
set can also contain policy overrides for segments and item-location combinations.

The policy assignment set is attached to a segment group. You can define multiple policy assignment sets for the
segment group. However, you can specify only one policy assignment set for the segment group on the Scope tab on
the Plan Options page in a replenishment plan.

The policy assignment set consists of the following:

• Policy parameters

• Default policy parameters

• Policy parameter overrides

• Item-location level policy overrides

Note:  For end item substitution and supersession chains, the start and end dates of item revisions aren't considered
during policy computation. Consequently, policies are calculated even for time buckets for which the item revisions
aren't active.

Policy Parameters
You define policy parameters at the segment level.

This table lists the policy types that you can specify:

Policy Type Method for Calculation of Quantities How the Policy Type Is Used

Min-max planning
 

The following is the formula for calculation of
the minimum quantity: Demand During Lead
Time + Safety Stock,
 
where Demand During Lead Time = Total Lead
Time * Average Daily Demand
 
and Total Lead Time = Preprocessing Lead
Time + Processing Lead Time + Postprocessing
Lead Time + Transit Time for a buy order or
Preprocessing Lead Time + Postprocessing
Lead Time + Transit Time for a transfer order
 
The safety stock and average daily demand are
calculated as discussed later in this guide.
 

When the Beginning Inventory Position
measure (Projected Available Balance + On
Order measures) equals or falls below the
minimum quantity, a replenishment order is
triggered.
 
The quantity of the replenishment order is
what's required to bring the inventory up to
the maximum quantity (provided by Maximum
Quantity - (Projected Available Balance + On
Order)).
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Policy Type Method for Calculation of Quantities How the Policy Type Is Used

The maximum quantity is calculated as
specified later in this topic.
 

Fixed order cycle
 

The maximum quantity is calculated as
specified later in this topic.
 

The replenishment orders are placed on only
those days on which suppliers can take orders,
 according to the associated fixed order cycle
calendar.
 
When the Beginning Inventory Position
measure (Projected Available Balance + On
Order measures) falls below the maximum
quantity, a replenishment order is triggered.
 
The quantity of the replenishment order is
what's required to bring the inventory up to
the maximum quantity (provided by Maximum
Quantity - (Projected Available Balance + On
Order)).
 

Reorder point (ROP) and order quantity
 

The following is the formula for calculation of
the ROP: Demand During Lead Time + Safety
Stock,
 
where Demand During Lead Time = Total Lead
Time * Average Daily Demand
 
and Total Lead Time = Preprocessing Lead
Time + Processing Lead Time + Postprocessing
Lead Time + Transit Time for a buy order or
Preprocessing Lead Time + Postprocessing
Lead Time + Transit Time for a transfer order
 
The average daily demand and safety stock are
calculated as discussed later in this guide.
 
The order quantity is taken for the item-
location combination from the Fixed Order
Quantity column of the Items table. If this
value is unavailable, the default order quantity
specified at the segment level in the policy
assignment set is used.
 
Therefore, for this policy type, the fixed order
quantity should be correctly defined at the item
level.
 

When the Beginning Inventory Position
measure (Projected Available Balance + On
Order measures) equals or falls below the ROP,
 a replenishment order is triggered.
 
The quantity of the replenishment order is the
order quantity.
 
If the fixed order quantity isn't defined in the
Items table or the default order quantity isn't
defined at the segment level in the policy
assignment set, replenishment orders are
created to bring the inventory to the ROP level.
If the inventory is zero, no replenishments are
created.
 

ROP and economic order quantity (EOQ)
 

The following is the formula for calculation of
the ROP: Demand During Lead Time + Safety
Stock,
 
where Demand During Lead Time = Total Lead
Time * Average Daily Demand
 
and Total Lead Time = Preprocessing Lead
Time + Processing Lead Time + Postprocessing
Lead Time + Transit Time for a buy order or
Preprocessing Lead Time + Postprocessing
Lead Time + Transit Time for a transfer order
 

When the Beginning Inventory Position
measure (Projected Available Balance + On
Order measures) equals or falls below the ROP,
 a replenishment order is triggered.
 
The quantity of the replenishment order is the
EOQ.
 
If the EOQ can't be calculated at the item-
location level or the default EOQ isn't defined
at the segment level in the policy assignment
set, replenishment orders are created to bring
the inventory to the ROP level. If the inventory
is zero, no replenishments are created.
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Policy Type Method for Calculation of Quantities How the Policy Type Is Used

The average daily demand, safety stock, and
EOQ are calculated as discussed later in this
guide.
 
Therefore, for this policy type, the EOQ should
be correctly calculated.
 

 

You specify whether you want to calculate safety stock on the basis of the days of cover or service level.

By specifying Units as the unit of measure (UOM), you ensure that the policies are static. By specifying Days as the
UOM, you ensure that the policies are time-phased.

You determine whether the average daily demand should be calculated on the basis of the forecast or history.

You calculate the maximum quantity on the basis of these methods:

• Days of cover: The average daily demand is multiplied by the maximum quantity days of cover specified in the
policy assignment set.

• Minimum plus order quantity: The minimum quantity is added to the order quantity, which is taken for an item-
location combination from the Fixed Order Quantity column of the Items table. If this value is unavailable, the
default order quantity specified at the segment level in the policy assignment set is used.

• Minimum plus EOQ: The minimum quantity is added to the EOQ.

Default Policy Parameters
You define these default policy parameters at the segment level:

• Default daily demand: This value is used when forecast or history data is unavailable at the item-location level
for the calculation of the average daily demand.

• Default order quantity

• Default EOQ: If you specify this default, the default standard cost, default carrying cost percentage, and default
ordering cost can't be specified.

• Default standard cost

• Default carrying cost percentage

• Default ordering cost

The default order quantity, default standard cost, default carrying cost percentage, and default ordering cost are used
when the corresponding values are unavailable for the item-location combination in the Items table.

Policy Parameter Overrides
You define these policy parameter overrides at the segment level:

• Safety stock override

• Order quantity override

• Minimum override: If this value is specified, the safety stock isn't calculated, and no value is shown for the
safety stock in tables.

• EOQ override
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• Maximum override

• ROP override: If this value is specified, the safety stock isn't calculated, and no value is shown for the safety
stock in tables.

Use policy parameter overrides when all item-location combinations in a segment must have the same policy values.
When these overrides are specified, policies aren't calculated for the item-location combinations of the segment.

Item-Location Level Policy Overrides
You define overrides at the level of individual item-location combinations, and these settings take precedence over
those for the segments to which the item-location combinations belong:

• Policy type

• Policy UOM

• Safety stock override

• Minimum override: If this value is specified, the safety stock isn't calculated, and no value is shown for the
safety stock in tables.

• Maximum override

• ROP override: If this value is specified, the safety stock isn't calculated, and no value is shown for the safety
stock in tables.

• Order quantity override

• EOQ override

• Fixed order cycle calendar

Use these policy overrides when you know what values you need for item-location combinations in your business, and
you want to generate replenishment orders on the basis of these values. When these overrides are specified, inventory
policies aren't calculated for the corresponding item-location combinations.

Hierarchy for Reading Policy Overrides and Item Attributes
The following hierarchy explains how policy overrides and item attributes are read during the policy calculation process:

1. If policy overrides are specified for item-location combinations, these values are used as the policies, and
policies aren't calculated for these item-location combinations.

2. If policy overrides are specified for segments, these values are used as the policies for all the item-location
combinations in the segments, and policies aren't calculated for these item-location combinations.

3. If a simulation set is assigned to the replenishment plan to which the policy assignment set is attached, the item
attributes for item-location combinations are taken from the simulation set.

4. If values are unavailable in the simulation set, the collected item attributes are taken.
5. If item attributes are unavailable in the Items table, the default values specified at the segment level in the

policy assignment set are used.

Related Topics
• How Lead Time Is Calculated for Buy Orders and Transfer Orders
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How You Use Policy Assignment Sets  
The following is the process for using policy assignment sets in the Replenishment Planning work area:

1. Perform the segmentation process.
2. Create a policy assignment set, and define the policy parameters for segments and policy overrides for item-

location combinations.
3. Attach the policy assignment set to a replenishment plan.
4. Run the replenishment plan.

Generate the forecast, calculate the policy parameters, and calculate the replenishments. Refresh the plan with
the current, collected data.

5. Review the calculated policies.
6. If the calculated policies aren't satisfactory, follow these steps:

a. Perform simulations, and make changes to the policy parameters for segments or policy overrides for
item-location combinations

b. Run the replenishment plan again.

Calculate the policy parameters and replenishments, and don't refresh the measures with current data.
The following is the flow chart for using policy assignment sets:
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How Average Daily Demand Is Calculated in Oracle
Replenishment Planning  
This topic explains how average daily demand is calculated in Oracle Replenishment Planning.

Settings That Affect Average Daily Demand
The following settings affect the calculation of the average daily demand:

• Whether the history or forecast is to be considered
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• Whether policy parameters or segment-level defaults have been defined in the policy assignment set for a
replenishment plan

How Average Daily Demand Is Calculated
How average daily demand for an item-location combination is calculated depends on whether you selected History or
Forecast in the Days of Cover Basis field on the Policy Parameters subtab for the policy assignment set.

Selection in Days of Cover Basis Field Calculation of Average Daily Demand Example

History
 

These steps are taken:
 

1. The value in the Horizon for Average
Daily Demand field on the Policy
Parameters subtab is read.

The working days in the calendar are
considered. If there's no attached
calendar, all days are considered.

2. The MSC_DFLT_SHIPMENT_HIST_
MEASURE profile is used for determining
which shipment history measure must be
used for the history data.

The shipment history is collected or
uploaded through a CSV file.

If the history is unavailable, the default
daily demand defined at the segment level
is used.

3. The shipment history is divided by the
number of days.

4. The result of Step 3 is multiplied by
the value entered in the Extrapolation
Percentage field on the Policy Parameters
subtab.

5. The results of Steps 3 and 4 are added
for the calculation of the average daily
demand.

The horizon for the average daily demand is 30,
 and the calendar is open on all days.
 
The shipment history is 600.
 
The extrapolation percentage is 15.
 
This calculation provides the average daily
demand: 600/30 + 15% of (600/30) = 20 + 3 =
23
 

Forecast
 

These steps are taken:
 

1. The gross forecast is read.

The source of the gross forecast can be
one of the following:

◦ A demand plan

◦ A replenishment plan for which the
Generate forecast check box is selected
on the Plan Options page

◦ An external forecast

◦ The value in the Default Daily Demand
field on the Default Policy Parameters
subtab, if the other forecast sources are
unavailable

The gross forecast for the next 20 days is 500.
 
The number of days is 20, and the calendar is
open on all days.
 
This calculation provides the average daily
demand: 500/20 = 25
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Selection in Days of Cover Basis Field Calculation of Average Daily Demand Example

2. The number of days is identified. The
gross forecast is considered during these
days.

The value in the Horizon for Average
Daily Demand field on the Policy
Parameters subtab is read.

The working days in the calendar are
considered. If there's no attached
calendar, all days are considered. Only
those days within the planning horizon of
the replenishment plan are considered.

3. The gross forecast is divided by the
number of days for the calculation of the
average daily demand.

How EOQ Is Calculated in Oracle Replenishment
Planning  
The economic order quantity (EOQ) is the optimal quantity that should be ordered so that inventory holding and
ordering costs are minimized.

In a replenishment plan, you can use the reorder point (ROP) and EOQ policy type to calculate replenishments on the
basis of the EOQ.

Settings That Affect EOQ
The following settings affect the EOQ calculation:

• Whether information is present for an item-location combination in the Items table

• Whether segment-level defaults have been defined in the policy assignment set for the replenishment plan

How EOQ Is Calculated
The following formula provides the EOQ:

Equation Variable Description

C
 

Fixed cost per order defined at the item-location level
 
The value of C is read as follows:
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Equation Variable Description

1. If the value is present for the item-location combination in the Order Cost column of the Items
table, it's used for calculating the EOQ.

2. If the value isn't present for the item-location combination in the Order Cost column, the default
ordering cost defined for the segment in the policy assignment set is used for calculating the
EOQ.

3. If the value isn't present for the item-location combination in the Order Cost column, and the
default EOQ is specified in the policy assignment set, the default EOQ is used.

H
 

Annual carrying cost per item-location combination, which is provided by this calculation: Carrying
Cost Percentage * Standard Cost
 
The value of H is read as follows:
 

1. If the carrying cost percentage isn't present for the item-location combination in the Annual
Carrying Cost Percentage column of the Items table, the default carrying cost percentage defined
for the segment in the policy assignment set is used for calculating the EOQ.

2. If the standard cost isn't present for the item-location combination in the Standard Cost column
of the Items table, the default standard cost defined for the segment in the policy assignment set
is used for calculating the EOQ.

3. If the values aren't present for the item-location combination, and the default EOQ is specified in
the policy assignment set, the default EOQ is used.

D
 

Annual demand for the item-location combination, which is provided by this calculation: Average Daily
Demand * Total Number of Working Days in a Year
 

How Safety Stock Is Calculated in Oracle Replenishment
Planning  
You affect how safety stock is calculated during replenishment planning through selections in the policy assignment set
for your replenishment plan.

How Safety Stock Is Calculated
How safety stock for an item-location combination is calculated depends on whether you selected Days of cover or
Service level-based in the Safety Stock Calculation field on the Policy Parameters subtab for the policy assignment
set.

• If you selected Days of cover, the following calculation is done: Safety Stock = Average Daily Demand * Days of
Cover

The days of cover are taken from the Safety Stock Days of Cover field on the Policy Parameters subtab.

For example, the average daily demand is 30, and the days of cover is 3. The safety stock is 90, which is 30 * 3.
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• If you selected Service-level based, and the demand isn't intermittent, a normal distribution formula is used.
These inputs affect the formula's result:

◦ Target service level percentage. If this value isn't present in the Service Level Percentage column of the
Items table, it's taken from the Target Service Level Percentage field on the Policy Parameters subtab.

◦ Mean average percentage error (MAPE), which is taken from the demand plan, replenishment plan, or
external demand schedule that's used as the demand schedule for the replenishment plan

◦ Average daily demand

◦ Replenishment lead time, which is calculated as follows:
- For a buy order, the lead time is the total of the preprocessing, processing, and postprocessing lead

times and the transit time.
- For a transfer order, the lead time is the total of the preprocessing and postprocessing lead times

and the transit time.

• If you selected Service level-based, and the demand is intermittent, a Poisson distribution formula is used.
These inputs affect the formula's result:

◦ Number of demands during the replenishment lead time

◦ Target service level percentage. If this value isn't present in the Service Level Percentage column of the
Items table, it's taken from the Target Service Level Percentage field on the Policy Parameters subtab.

Related Topics
• How Lead Time Is Calculated for Buy Orders and Transfer Orders

How You Upload Externally Calculated Safety Stock  
If you're computing safety stock in a third-party application, you can upload the computed quantities for use in policy
parameter calculations by your replenishment plan.

By uploading these computed quantities, you can better align Oracle Replenishment Planning with your other planning
and execution systems.

You can upload externally calculated safety stock quantities using the file-based data import (FBDI) template for supply
chain planning safety stock levels.

You can view the uploaded safety stock for item-location combinations in the Safety Stock Quantity column of the Items
table. However, you can't edit this quantity in the table or simulation sets.

Note these points about uploading safety stock quantities and how they're used:

• You can upload safety stock quantities for only item-organization combinations.
You can't upload safety stock quantities for item-subinventory combinations.

• You can upload safety stock quantities in only units.
If the unit of measure (UOM) is days for the segment that's associated with the item-location combinations,
the uploaded safety stock is ignored for those item-location combinations, and the safety stock is calculated by
Replenishment Planning.
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• If you upload time-phased safety stock quantities, the quantity for which the effective date is on or before the
plan run date and that's closest to the plan run date is used.

• The uploaded safety stock quantity is used if it's available for an item-location combination.

Otherwise, the safety stock is calculated by Replenishment Planning.

• The safety stock override you specify at the item-location level in the policy assignment set is used even when
the externally calculated safety stock is available.

However, any safety stock override you specify at the segment level in the policy assignment set is ignored
when the externally calculated safety stock is available, and the uploaded value is used in policy parameter
calculations.

• When you simulate changes to policy parameters, the externally calculated safety stock is considered for item-
location combinations.

Related Topics
• How Safety Stock Is Calculated in Oracle Replenishment Planning

Static Policies or Time-Phased Policies in Oracle
Replenishment Planning  
The unit of measure (UOM) you select for a policy assignment set at the segment or item-location level determines
whether the policies are static or time-phased.

If you selected Units as the UOM, the policies are static. If you selected Days, the policies are time-phased.

In static policies, the values of measures don't vary from day to day. In time-phased policies, these measure values can
vary from day to day.

Use static policies when the total demand doesn't drastically change from day to day, and use time-phased policies
when the total demand can vary from day to day.

If required, you can override the values of these measures for a replenishment plan by using these tables:

• Manage Policy Parameters by Item: Use this table when you want to change the measure values for all days.

• Replenishment Workbench: Use this table when you want to change the measure values for specific days.

Static Policies
This table illustrates how static policies are calculated:

Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12 Day 13 Day 14

Minimum
Quantity
 

15
 

15
 

15
 

15
 

15
 

15
 

15
 

15
 

15
 

15
 

15
 

15
 

15
 

15
 

Adjusted
Minimum
Quantity

0
 

0
 

0
 

0
 

0
 

0
 

0
 

25
 

25
 

25
 

25
 

25
 

25
 

25
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12 Day 13 Day 14

 

Final
Minimum
Quantity
 

15
 

15
 

15
 

15
 

15
 

15
 

15
 

25
 

25
 

25
 

25
 

25
 

25
 

25
 

Maximum
Quantity
 

55
 

55
 

55
 

55
 

55
 

55
 

55
 

55
 

55
 

55
 

55
 

55
 

55
 

55
 

Adjusted
Maximum
Quantity
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

80
 

80
 

80
 

80
 

80
 

80
 

80
 

Final
Maximum
Quantity
 

55
 

55
 

55
 

55
 

55
 

55
 

55
 

80
 

80
 

80
 

80
 

80
 

80
 

80
 

This table depicts the calculation of static policies for a replenishment plan with a planning horizon of 14 days.

The minimum quantity is calculated by the following formula: Demand During Lead Time + Safety Stock, where
Demand During Lead Time = Total Lead Time * Average Daily Demand. For a buy order, the total lead time is the sum of
the preprocessing, processing, and postprocessing lead times and transit time. For a transfer order, the total lead time is
the sum of the preprocessing and postprocessing lead times and transit time.

The maximum quantity is calculated through the days of cover, minimum plus order quantity, or minimum plus
economic order quantity (EOQ) method.

Time-Phased Policies
This table illustrates how time-phased policies are calculated:

Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12 Day 13 Day 14

Total
Demand
 

10
 

10
 

10
 

15
 

15
 

15
 

20
 

20
 

20
 

10
 

10
 

10
 

15
 

15
 

Minimum
Days
 

3
 

3
 

3
 

3
 

3
 

3
 

3
 

3
 

3
 

3
 

3
 

3
 

3
 

3
 

Maximum
Days
 

6
 

6
 

6
 

6
 

6
 

6
 

6
 

6
 

6
 

6
 

6
 

6
 

6
 

6
 

Minimum
Quantity
(Time-
Phased
Value)
 

30
 

35
 

40
 

45
 

50
 

55
 

60
 

50
 

40
 

30
 

35
 

40
 

40
 

40
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12 Day 13 Day 14

Adjusted
Minimum
Quantity
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Final
Minimum
Quantity
(Time-
Phased
Value)
 

30
 

35
 

40
 

45
 

50
 

55
 

60
 

50
 

40
 

30
 

35
 

40
 

40
 

40
 

Maximum
Quantity
 
(Time-
Phased
Value)
 

75
 

85
 

95
 

105
 

100
 

95
 

90
 

85
 

80
 

80
 

80
 

80
 

80
 

80
 

Adjusted
Maximum
Quantity
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Final
Maximum
Quantity
 
(Time-
Phased
Value)
 

75
 

85
 

95
 

105
 

100
 

95
 

90
 

85
 

80
 

80
 

80
 

80
 

80
 

80
 

This table depicts the calculation of time-phased policies for a replenishment plan with a planning horizon of 14 days.

The total demand is calculated according to the forecast processing logic.

The formula for the calculation of the minimum days is Minimum Quantity (static value)/Average Daily Demand. The
formula for calculation of the maximum days is Maximum Quantity (static value)/Average Daily Demand.

The formulas for the calculation of the static values of the minimum and maximum quantities are the same as those
used for static policies.

For the calculation of the time-phased minimum quantity for Day X, the minimum days are considered, and the total
demand is summed up starting from Day X for the minimum days. If the number of days left in the planning horizon is
less than the minimum days on Day X, the previous day's time-phased minimum quantity is used. For the calculation of
the time-phased maximum quantity for Day X, the maximum days are considered, and the total demand is summed up
starting from Day X for the maximum days. If the number of days left in the planning horizon is less than the maximum
days on Day X, the previous day's time-phased maximum quantity is used.

Related Topics
• How Lead Time Is Calculated for Buy Orders and Transfer Orders
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Work With Policy Assignment Sets  

Create a Policy Assignment Set  
This topic explains how you can create a policy assignment set in the Replenishment Planning work area.

To create the policy assignment set, you perform these steps:

1. Name the policy assignment set, and associate it with a segment group.
2. Add segments, and define the following for their item-location combinations:

a. Policy parameters
b. Default policy parameters
c. Policy parameter overrides

3. Define policy overrides for specific item-location combinations.

Name the Policy Assignment Set and Associate It with a Segment Group
Follow these steps to name the policy assignment set and associate it with a segment group:

1. On the Tasks panel tab, under Plan Inputs, select Manage Policy Assignment Sets.

The Manage Policy Assignment Sets page opens.
2. Under Search Results, on the toolbar, click Create.

The Create Policy Assignment Set dialog box opens.
3. Enter the name and description of the policy assignment set.
4. In Segment Group, select the segment group to which the policy assignment set should be attached.

Only those segment groups for which the segmentation process has been successfully run are available for
selection. The segment groups that use the Customer or Demand Class dimension aren't displayed.

5. Click Save.

Define Policy Parameters
Follow these steps to define policy parameters for a segment:

1. On the Segment-Level Policy Parameters Assignment tab, on the toolbar, click Add Row.

A row appears underneath the toolbar.
2. In the list under Segment, select a segment of the segment group.
3. On the Policy Parameters subtab, under Replenishment Policy, in Policy Type, select the policy type for the

segment.
4. In Policy UOM, select the unit of measure (UOM) for the policy type.

The policy parameters are calculated based on the UOM.
5. In Fixed Order Cycle Calendar, select a calendar for the policy type.

This list is enabled when you select Fixed order cycle in the Policy Type list.
6. Under Safety Stock, in Safety Stock Calculation, select the method for safety stock calculation.
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7. In Safety Stock Days of Cover, enter the number of days to be covered by the safety stock.

This field is enabled when you select Days of cover in the Safety Stock Calculation list.
8. In Days of Cover Basis, select whether the average daily demand should be calculated based on the history or

forecast.

Note:  Preferably, for bidirectional supersession chains, select Forecast.

9. In Horizon for Average Daily Demand, enter the number of days of the history or forecast for which the daily
demand is averaged.

10. In Extrapolation Percentage, enter the value by which the average demand should be increased.

This field is enabled when you select History in the Days of Cover Basis list.
11. In Target Service Level Percentage, enter the value for calculation of the safety stock.

This field is enabled when you select Service level-based in the Safety Stock Calculation list.
12. Under Maximum Quantity, in Maximum Quantity Calculation Method, select the method for calculation of

the maximum quantity.

This list is enabled when you select Min-max planning or Fixed order cycle in the Policy Type list.
13. In Maximum Quantity Days of Cover, enter the number of days for which the maximum quantity must be

held.

This list is enabled when you select Days of cover in the Maximum Quantity Calculation Method list.
14. Repeat Steps 1 through 13 for other segments.
15. Click Save.

Define Default Policy Parameters
Follow these steps to define default policy parameters for item-location combinations in a segment:

1. On the Segment-Level Policy Parameters Assignment tab, under the toolbar, select a segment.
2. On the Default Policy Parameters subtab, in Default Daily Demand, enter the default value for the daily

demand.

This value is used if history or forecast data is unavailable for the calculation of the average daily demand.
3. Enter these values:

If You Selected One of These
Combinations on the Policy
Parameters Subtab

Then on the Default Policy Parameters Subtab

◦ Min-max planning or Fixed
order cycle in the Policy Type
list and Minimum plus order
quantity in the Maximum
Quantity Calculation Method list

◦ ROP and order quantity in the
Policy Type list

◦ In Default Order Quantity, enter the default value for the order quantity.

◦ Min-max planning or Fixed
order cycle in the Policy Type list
and Minimum plus EOQ in the
Maximum Quantity Calculation
Method list

◦ In Default EOQ, enter the default economic order quantity (EOQ).

If you specify this default, you can't specify the default standard cost, default carrying cost
percentage, and default ordering cost.

◦ In Default Standard Cost, enter the default standard cost.
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If You Selected One of These
Combinations on the Policy
Parameters Subtab

Then on the Default Policy Parameters Subtab

◦ ROP and order quantity or ROP
and EOQ in the Policy Type list

◦ In Default Carrying Cost Percentage, enter the default carrying cost percentage.

◦ In Default Ordering Cost, enter the default ordering cost.

4. Repeat Steps 1 through 3 for other segments.
5. Click Save.

Define Policy Parameter Overrides
Follow these steps to define policy parameter overrides for item-location combinations in a segment:

1. On the Segment-Level Policy Parameters Assignment tab, under the toolbar, select a segment.
2. On the Policy Parameters Overrides subtab, in Safety Stock Override, enter the override value for the safety

stock.

For slow-moving items or items with intermittent demand, you can optionally enter zero as the safety stock
override.

3. In Order Quantity Override, enter the override value for the order quantity.
4. In Minimum Override, enter the override value for the minimum order quantity.

The minimum override must be greater than or equal to the safety stock override.

For slow-moving items or items with intermittent demand, you can optionally enter zero as the minimum
override.

This field is enabled when you select Min-max planning in the Policy Type list on the Policy Parameters
subtab.

5. In EOQ Override, enter the override value for the EOQ.
6. In Maximum Override, enter the override value for the maximum order quantity.

The maximum override must be greater than or equal to the minimum override and safety stock override.

This field is enabled when you select Min-max planning or Fixed order cycle in the Policy Type list on the
Policy Parameters subtab.

7. In ROP Override, enter the override value for the reorder point (ROP).

The ROP override must be greater than or equal to the safety stock override.

This field is enabled when you select ROP and order quantity or ROP and EOQ in the Policy Type list on the
Policy Parameters subtab.

8. Repeat Steps 1 through 7 for other segments.
9. Click Save.

Define Item-Location Level Policy Overrides
Follow these steps to define overrides at the item-location level for the segment group:

1. On the Item-Location Level Policy Overrides tab, on the toolbar, click Add Row.

A row appears under the column headings.
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2. In the list under Item, select an item of the segment group.
3. In the list under Location, select a location for the item.
4. In the list under Policy Type, select a policy type for the item-location combination.
5. In the list under Policy UOM, select the UOM for the policy type.
6. In the field under Safety Stock Override, enter the override value for the safety stock.

For a slow-moving item or an item with intermittent demand, you can optionally enter zero as the safety stock
override.

7. In the field under Minimum Override, enter the override value for the minimum order quantity.

The minimum override must be greater than or equal to the safety stock override.

For a slow-moving item or an item with intermittent demand, you can optionally enter zero as the minimum
override.

This field is enabled when you select Min-max planning in the Policy Type list.
8. In the field under Maximum Override, enter the override value for the maximum order quantity.

The maximum override must be greater than or equal to the minimum override and safety stock override.

This field is enabled when you select Min-max planning or Fixed order cycle in the Policy Type list.
9. In the field under ROP Override, enter the override value for the ROP.

The ROP override must be greater than or equal to the safety stock override.

This field is enabled when you select ROP and order quantity or ROP and EOQ in the Policy Type list.
10. In the field under Order Quantity Override, enter the override value for the order quantity.

This field is enabled when you select ROP and order quantity in the Policy Type list.
11. In the field under EOQ Override, enter the override value for the EOQ.

This field is enabled when you select ROP and EOQ in the Policy Type list.
12. In the list under Fixed Order Cycle Calendar, select a calendar for the policy type.

This list is enabled when you select Fixed order cycle in the Policy Type list.
13. Repeat Steps 1 through 12 for other item-locations combinations.
14. Click Save.

Edit a Policy Assignment Set  
You can duplicate, edit, and delete a policy assignment set.

The changes you can make to the policy assignment set are limited. You can't change the policy assignment set's name,
and you can't delete it if it's being used in a replenishment plan. To change the segment group, you first have to delete
all the segments from the policy assignment set.

You can duplicate the policy parameters that you have specified for a segment and reuse them in another segment.

Edit the Parameters for a Segment
You can edit the policy parameters, default policy parameters, and policy parameter overrides defined for a segment of
the segment group that's attached to the policy assignment set.
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Any change that you make to the policy parameters takes effect the next time you run the associated replenishment
plan with the Calculate policy parameters check box selected on the Plan Options page.

Edit the Item-Location Level Policy Overrides
You can edit the item-location level policy overrides defined for the segment group that's attached to the policy
assignment set.

Any change that you make to the item-location level policy overrides takes effect the next time you run the associated
replenishment plan with the Calculate policy parameters check box selected on the Plan Options page.
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10  Policy Comparisons

Overview of the Policy Comparison Feature  
The policy comparison feature automates the comparison of suggested policy parameters with existing policy
parameters. You can set a threshold percentage for automatically accepting suggested policy parameters and manually
accept or reject the remaining, suggested policy parameters.

The following policy parameters are compared:

• Minimum quantity

• Maximum quantity

• Reorder point (ROP) quantity

• ROP days

• Minimum days

• Maximum days

This table lists the policy parameters that are compared for different policy types and units of measure (UOMs):

Policy Type UOM Compared Policy Parameters

Min-max planning
 

Days
 

Minimum days and maximum days
 

Min-max planning
 

Units
 

Minimum quantity and maximum quantity
 

Fixed order cycle
 

Days
 

Maximum days
 

Fixed order cycle
 

Units
 

Maximum quantity
 

ROP and order quantity
 

Days
 

ROP days
 

ROP and order quantity
 

Units
 

ROP quantity
 

ROP and economic order quantity (EOQ)
 

Days
 

ROP days
 

ROP and EOQ
 

Units
 

ROP quantity
 

209



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 10
Policy Comparisons

Benefits of the Policy Comparison Feature
By using the policy comparison feature, you can avail of these benefits:

• Automatically accept suggested policy parameters if the percentage of deviation between them and the
existing policy parameters is within the threshold.
Therefore, you can avoid having to manually review the suggested policy parameters for millions of item-
location combinations and improve the efficiency and accuracy of your policy comparison process.

• Manually accept or reject suggested policy parameters if the percentage of deviation between them and the
existing policy parameters is above the threshold.

• Use embedded analytics to review the policy comparison process.

Note:  You can't use the policy comparison feature with the inventory rebalancing feature.

Set Up the Policy Comparison Feature
To set up the policy comparison feature, you must do the following:

1. Create a policy comparison plan for which the Calculate policy parameters check box is selected, and the
Calculate replenishments and the Rebalance inventory check boxes aren't selected on the Plan Options page.
Moreover, in the Scope: Advanced Options dialog box, you must select the Enable for policy comparison
check box and enter a value in the Threshold Percentage for Policy Comparison field.
Optionally, select the Retain policy overrides check box to retain manual policy overrides after the
replenishment plan is run with the Refresh with current data option selected on the Parameters tab in the Run
Plan dialog box. The manual overrides are retained even if the deviation percentages between the suggested
and existing policy parameters are within the threshold.

2. Run the policy comparison plan with the Refresh with current data option selected on the Parameters tab in
the Run Plan dialog box.

3. Use the policy comparison plan to provide the updated policy parameters to an integrated replenishment plan
or automated execution plan.

Related Topics
• Create a Replenishment Plan

• Set Up Policy Comparisons and Retain Policy Overrides

• Best Practices for Setting Up Replenishment Plans

How You Use the Policy Comparison Feature  
The following is the process for using the policy comparison feature:

1. Set up a policy comparison plan.
In the Scope: Advanced Options dialog box of the Scope tab of the Plan Options page, select the Enable for
policy comparison check box, and enter a value in the Threshold Percentage for Policy Comparison field.

2. Run the policy comparison plan.
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When the deviation percentages between the suggested policy parameters and existing policy parameters are
within the threshold, the suggested policy parameters are automatically accepted.

3. Review the remaining, suggested policy parameters.

◦ Manually accept those suggested policy parameters that don't require changes.

◦ Manually adjust those suggested policy parameters that require changes.

◦ Mark the remaining, suggested policy parameters as reviewed, or leave them as is.

These suggested policy parameters don't take effect.
4. Update the policy measures so that the manually accepted or adjusted policy parameters overwrite the

corresponding, existing policy parameters for item-location combinations.

The updated policy parameters are then used by the integrated replenishment plan or automated execution
plan that's linked to the policy comparison plan.

The following is the flow chart for using the policy comparison feature:

Related Topics
• Best Practices for Setting Up Replenishment Plans

• Run a Replenishment Plan
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Measures Used for Comparing Policy Parameters  
This topic lists the measures that are used for comparing policy parameters.

These measures provide the following kinds of information:

• Summary of the policy comparison process

• Existing policy parameters and whether they were calculated or adjusted

• Suggested policy parameters

• Percentages of deviation between the existing and suggested policy parameters

Measures that Provide a Summary of the Policy Comparison Process
These measures provide a summary of the policy comparison process:

Measure Description

Policies Automatically Accepted
 

Number of item-location combinations with policy parameters that are automatically accepted.
 
The policy parameters have the Automatically accepted status.
 

Policies Manually Accepted
 

Number of item-location combinations with policy parameters that are manually accepted.
 
The policy parameters have the Manually accepted status.
 

Policies to Review
 

Number of item-location combinations with policy parameters that must be reviewed.
 
The policy parameters have the To be reviewed status.
 

Policies Reviewed
 

Number of item-location combinations with policy parameters that are reviewed.
 
The policy parameters have the Reviewed status.
 

Policies Adjusted
 

Number of item-location combinations with policy parameters that are manually adjusted (overridden).
 
The policy parameters have the Adjusted status.
 

Policies Retained
 

Number of item-location combinations with policy parameter overrides that are retained.
 
The policy parameters have the Retained status.
 
Policy parameter overrides are retained when the Retain policy overrides check box is selected in the
Scope: Advanced Options dialog box on the Scope tab of the Plan Options page for a replenishment
plan.
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Measures for Existing Policy Parameters
These measures provide information about the existing policy parameters and whether they were calculated or
adjusted:

Measure Description

Previous Minimum Days
 

Days previously calculated for the Minimum Days measure.
 

Previous Minimum Days Type
 

Indicator specifying whether the previous value of the Minimum Days measure was calculated or
adjusted.
 

Previous Maximum Days
 

Days previously calculated for the Maximum Days measure.
 

Previous Maximum Days Type
 

Indicator specifying whether the previous value of the Maximum Days measure was calculated or
adjusted.
 

Previous Minimum Quantity
 

Quantity previously calculated for the Minimum Quantity measure.
 

Previous Minimum Quantity Type
 

Indicator specifying whether the previous value of the Minimum Quantity measure was calculated or
adjusted.
 

Previous Maximum Quantity
 

Quantity previously calculated for the Maximum Quantity measure.
 

Previous Maximum Quantity Type
 

Indicator specifying whether the previous value of the Maximum Quantity measure was calculated or
adjusted.
 

Previous ROP Days
 

Reorder point (ROP) days previously calculated for the ROP Days measure.
 

Previous ROP Days Type
 

Indicator specifying whether the previous value of the ROP Days measure was calculated or adjusted.
 

Previous ROP Quantity
 

ROP quantity previously calculated for the ROP Quantity measure.
 

Previous ROP Quantity Type
 

Indicator specifying whether the previous value of the ROP Quantity measure was calculated or
adjusted.
 

Before the policy comparison process begins, the existing policy parameters are copied into these measures.

Measures for Suggested Policy Parameters
These measures provide information about the suggested policy parameters:

Measure Description

Suggested Average Daily Demand
 

Suggested average daily demand.
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Measure Description

Suggested EOQ
 

Suggested economic order quantity (EOQ).
 

Suggested Minimum Days
 

Suggested minimum days.
 

Suggested Maximum Days
 

Suggested maximum days.
 

Suggested Minimum Quantity
 

Suggested minimum quantity.
 

Suggested Maximum Quantity
 

Suggested maximum quantity.
 

Suggested Order Quantity
 

Suggested order quantity.
 

Suggested Policy Type
 

Suggested policy type.
 
The value is the existing policy type.
 

Suggested Policy UOM
 

Suggested unit of measure (UOM).
 
The value is the existing UOM.
 

Suggested ROP Days
 

Suggested ROP days.
 

Suggested ROP Quantity
 

Suggested ROP quantity.
 

Suggested Safety Stock
 

Suggested safety stock.
 

Suggested Safety Stock Days
 

Suggested safety stock days.
 

You can use the Suggested Replenishment Policy Parameters table for the replenishment plan to view these measures.

Measures for Deviation Percentages Between Existing and Suggested
Policy Parameters
These measures provide the percentages of deviation between the existing and suggested policy parameters:

Measure Description

Minimum Days Deviation Percentage
 

Percentage of deviation between the Suggested Minimum Days and Previous Minimum Days
measures.
 

Maximum Days Deviation Percentage
 

Percentage of deviation between the Suggested Maximum Days and Previous Maximum Days
measures.
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Measure Description

Minimum Quantity Deviation Percentage
 

Percentage of deviation between the Suggested Minimum Quantity and Previous Minimum Quantity
measures.
 

Maximum Quantity Deviation Percentage
 

Percentage of deviation between the Suggested Maximum Quantity and Previous Maximum Quantity
measures.
 

ROP Days Deviation Percentage
 

Percentage of deviation between the Suggested ROP Days and Previous ROP Days measures.
 

ROP Quantity Deviation Percentage
 

Percentage of deviation between the Suggested ROP Quantity and Previous ROP Quantity measures.
 

Work with the Manage Policy Comparison Table  
This topic explains how you work with the Manage Policy Comparison table for a policy comparison plan.

Manage Policy Comparison Table
After the policy comparison plan is run, the Manage Policy Comparison table lists the existing and suggested policy
parameters for each item-location combination. The percentage of deviation between an existing and a suggested
policy parameter is also provided.

The Policy Review Status column indicates the statuses of the policies for the item-location combination:

Status Meaning

Automatically accepted
 

The suggested policy parameters for the item-location combination have been automatically accepted
because the percentages of deviation were within the threshold.
 
This threshold was specified in the Threshold Percentage for Policy Comparison field in the Scope:
Advanced Options dialog box of the Scope tab of the Plan Options page.
 
The accepted policy parameters can be seen in the Replenishment Policy Parameters table and are
ready for use by the integrated replenishment plan or automated execution plan that's linked to the
policy comparison plan.
 

Manually accepted
 

You have accepted the suggested policy parameters for the item-location combination.
 

To be reviewed
 

The suggested policy parameters for the item-location combination must be reviewed because the
percentages of deviation are above the threshold.
 

Reviewed
 

You have reviewed the suggested policy parameters that had the To be reviewed status for the item-
location combination and neither accepted or modified them.
 

Adjusted You have manually adjusted the suggested policy parameters for the item-location combination.
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Status Meaning

  

Retained
 

The adjustments you made to the policy parameters for the item-location combination before the
latest run of the policy comparison plan have been retained.
 
The adjustments are retained because you selected the Retain policy overrides check box in the
Scope: Advanced Options dialog box of the Scope tab of the Plan Options page. When this check box
is selected, the adjustments are retained even if the deviation percentages between the suggested and
existing policy parameters are within the threshold.
 
The retained policy parameters can be seen in the Replenishment Policy Parameters table and are
ready for use by the integrated replenishment plan or automated execution plan that's linked to the
policy comparison plan.
 
The Retained status is also used when the item-location combination is subject to an override that's
specified in the policy assignment set that's attached to the policy comparison plan. In such cases, no
policy comparison takes place.
 

Work with the Manage Policy Comparison Table
To work with the Manage Policy Comparison table, follow these steps:

1. Do one of the following to open the policy comparison plan:

◦ To open the policy comparison plan using the Manage Plans page:

i. On the Tasks panel tab, under Plans, select Manage Plans.

The Manage Plans page opens and displays the available replenishment plans.
ii. Select the policy comparison plan, and click Actions > Open.

The policy comparison plan opens in a separate tab.

◦ On the Plans panel tab, under Plans, right-click the policy comparison plan, and select Open.

The policy comparison plan opens in a separate tab.
2. Click the Open drop-down button.

The Open Table, Graph, or Tile Set dialog box opens.
3. Search for the Manage Policy Comparison table, select it, and click OK.

The Manage Policy Comparison table opens in a separate subtab of the policy comparison plan.
4. Search for the segment that you want to work with.

To narrow your search, filter the rows by the To be reviewed status of the Policy Review Status column.
5. Follow these steps to adjust, review, or accept the suggested policy parameters:

Objective Steps

To adjust the policy parameters for an
item-location combination
 

a. Select the row for the item-location combination.

The cells for the adjusted values are enabled for entry. You can perform this step for only
those item-location combinations that have the To be reviewed or Retained status.
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Objective Steps

b. For the policy parameter that you want to edit, enter an adjusted value. If the policy type is
min-max planning, the adjustments for both the minimum and maximum values must be
specified.

The final policy parameters for the item-location combination are adjusted accordingly,
and the status is changed to Adjusted.

To mark the suggested policy
parameters for the item-location
combination as reviewed
 

a. Select the row for the item-location combination.

You can perform this step for only those item-location combinations that have the To be
reviewed status.

b. Click Actions > Mark as Reviewed.

The status for the item-location combination is changed from To be reviewed to
Reviewed.

The existing policy parameters for the item-location combination remain unchanged.

To accept the suggested policy
parameters for the item-location
combinations that are displayed after
your search
 

Click Actions > Accept All, and click Yes in the warning message that appears.
 
For the item-location combinations with the To be reviewed status, the final policy parameters
are updated accordingly, and the status changes to Manually accepted.
 

To accept the suggested policy
parameters for selected item-location
combinations
 

a. Select the rows for the item-location combinations.

The status for these item-location combinations should be To be reviewed.
b. Click Actions > Accept Suggested Policies.

The final policy parameters for the item-location combinations are updated accordingly,
and the status changes to Manually accepted.

6. Click Actions > Update Policy Measures to update the policy parameters for those item-location combinations
for which you have manually adjusted or accepted the suggested policy parameters.

The updated policy parameters for the item-location combinations take effect when the linked integrated
replenishment plan or automated execution plan is run.

7. Save the Manage Policy Comparison table.

Points to Remember While Working with the Policy Comparison Feature
Be aware of these points while working with the policy comparison feature:

• If policy parameters don't exist for item-location combinations, or if the policy type or unit of measure (UOM) is
changed, the suggested policy parameters are automatically accepted.

• Policies aren't compared for those item-location combinations that are covered by overrides in the policy
assignment set that's attached to the policy comparison plan.

• For a min-max planning policy, the deviation percentages between the suggested and existing values for both
the minimum and maximum days or quantities must be within the threshold for the policy to be automatically
accepted.

• The threshold for automatically accepting suggested policy parameters must be set with care. Permanently
setting the threshold at a low level can decrease the efficiency of your policy comparison process. Start with a
low threshold value, and increase it when you get comfortable with using the policy comparison feature.
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Related Topics
• Best Practices for Setting Up Replenishment Plans

• Policy Assignment Sets

• Set Up Policy Comparisons and Retain Policy Overrides

How You Use the Policy Comparison Analytics  
This topic explains how you use the predefined analytics for the policy comparison feature in a policy comparison plan.

Use the Policy Comparison Summary Tile Set
For using the analytics for the policy comparison feature, you must create a page layout that uses the predefined Policy
Comparison Summary tile set. The predefined page layouts don't include this tile set.

The Policy Comparison Summary tile set includes the following:

• Policy Comparison Tile: The tile provides a plan-level summary of the policy parameters that are in the To be
reviewed or Automatically accepted status.

• Policy Comparison Summary by Segment Graph: The graph provides a segment-wise breakup of the policy
parameters in the Automatically accepted or To be reviewed status. By default, the graph is linked to the
Manage Policy Comparison and Policy Comparison Summary by Location tables.

• Policy Review Status by Segment Table: The table provides a segment-wise breakup of the policy parameters
in various statuses. By default, the table is linked to the Manage Policy Comparison and Policy Comparison
Summary by Location tables.

The following example shows how you use the Policy Comparison Summary tile set to effectively use the policy
comparison feature:

1. Run the policy comparison plan.
2. Open the page layout that has the Policy Comparison Summary tile set.
3. Identify the segment that has the most policy parameters with the To be reviewed status.
4. Select the graph bar or table cell for the policy parameters with the To be reviewed status:

◦ To view a list of the locations to which the policy parameters pertain, click Actions > Drill To > Default
Group > Manage Policy Comparison Summary by Location.
The Policy Comparison Summary by Location table opens in a subtab and displays the policy parameters
that have the To be reviewed or Automatically accepted status for various locations of the segment.
You can select a cell and click Actions > Drill To > Manage Policy Comparison to view policy parameters
for the items in a location and act on them.

◦ To view a list of the item-location combinations to which the policy parameters pertain, and take action
on them, do the following:

i. Click Actions > Drill To > Manage Policy Comparison.
The Manage Policy Comparison table opens in a subtab and displays the segment's item-location
combinations that have the policy parameters with the searched status.
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ii. Select the rows for the item-location combinations, and work with the suggested policy
parameters.

iii. Click Actions > Update Policy Measures.
5. Return to the page layout that has the Policy Comparison Summary tile set, and click View > Refresh.

The updated information about the policy parameters is displayed.
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11  Statistical Forecasts

Create a Forecasting Profile  
A forecasting profile is a collection of definitions used during the generation of demand forecasts. Each profile includes
the definitions of the forecasting methods used and at what level demand data is aggregated.

Predefined Forecasting Profiles
This table lists the predefined forecasting profiles:

Forecasting Profile Work Area Input Measure Output Measure Forecasting Table Use

Forecast Bookings
 

Demand Management
 
Demand and Supply
Planning
 

Final Bookings History
 

Bookings Forecast
 

Forecast Bookings
Definitions
 

For forecasting on
the basis of bookings
history
 

Forecast Bookings for
Supersession Chain
 

Demand Management
 
Demand and Supply
Planning
 

Final Bookings History
 

Bookings Forecast
 

Forecast Bookings
Definitions
 

For forecasting on
the basis of bookings
history for the
current item revision
and latest (future)
item revision in a
supersession chain
 

Forecast Bookings
Including Event
Activity
 

Demand Management
 
Demand and Supply
Planning
 

Final Bookings History
 

Bookings Forecast
 

Forecast Bookings
Definitions
 

For forecasting
on the basis of
bookings history while
incorporating the
impact of events
 

Forecast Bookings
Including Product
Lifecycle
 

Demand Management
 
Demand and Supply
Planning
 

Final Bookings History
 

Bookings Forecast
 

Forecast Bookings
Definitions
 

For forecasting on
the basis of bookings
history and the
launch date and
discontinuation date
 

Feature-Based
Bookings Forecast for
New Products
 

Demand Management
 
Demand and Supply
Planning
 

Final Bookings History
 

Feature Based
Bookings Forecast
 

Feature-Based
Bookings Forecast
Definitions
 

For forecasting for
new products on the
basis of historical
bookings and features
that are used to
analyze effects on
product demand
 

Forecast Consumption
 

Replenishment
Planning
 

Final Consumption
History
 

Consumption Forecast
 

Forecast Consumption
Definitions
 

For forecasting on the
basis of consumption
history
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Forecasting Profile Work Area Input Measure Output Measure Forecasting Table Use

Forecast Shipments
 

Demand Management
 
Demand and Supply
Planning
 
Replenishment
Planning
 

Final Shipments
History
 

Shipments Forecast
 

Forecast Shipments
Definitions
 

For forecasting on the
basis of shipments
history
 

Forecast Shipments
for Supersession
Chain
 

Demand Management
 
Demand and Supply
Planning
 
Replenishment
Planning
 

Final Shipments
History
 

Shipments Forecast
 

Forecast Shipments
Definitions
 

For forecasting on the
basis of shipments
history for the
current item revision
and latest (future)
item revision in a
supersession chain
 

Forecast Shipments
Including Event
Activity
 

Demand Management
 
Demand and Supply
Planning
 

Final Shipments
History
 

Shipments Forecast
 

Forecast Shipments
Definitions
 

For forecasting
on the basis of
shipments history
while incorporating
the impact of events
 

Forecast Shipments
Including Product
Lifecycle
 

Demand Management
 
Demand and Supply
Planning
 
Replenishment
Planning
 

Final Shipments
History
 

Shipments Forecast
 

Forecast Shipments
Definitions
 

For forecasting on the
basis of shipments
history and the
launch date and
discontinuation date
 

Feature-Based
Shipments Forecast
for New Products
 

Demand Management
 
Demand and Supply
Planning
 

Final Shipments
History
 

Feature Based
Shipments Forecast
 

Feature-Based
Shipments Forecast
Definitions
 

For forecasting for
new products on the
basis of historical
shipments and
features that are used
to analyze effects on
product demand
 

You can't edit predefined forecasting profiles. However, you can modify copies of predefined forecasting profiles for
your use.

Create a Forecasting Profile
Follow these steps to create a forecasting profile:

1. In the Demand Management, Demand and Supply Planning, or Replenishment Planning work area, on the
Tasks panel tab, under Configuration, select Manage Forecasting Profiles.

The Manage Forecasting Profiles page opens.
2. Click Actions > Create.

The Manage Forecasting Profiles page opens.
3. Enter the name and description for the forecasting profile.
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4. In Machine Learning Type, select Bayesian if you want the forecasting profile to use Bayesian machine
learning for new or existing products. Bayesian machine learning uses the algorithms in Oracle Demand
Management.

Select Feature-based if you want the forecasting profile to use feature-based machine learning for new
products. Feature-based machine learning uses the algorithm in the Oracle Fusion Internet of Things Intelligent
Applications Cloud Service.

Note:  You can't select Feature-based if you want to enable your forecasting profile for the Replenishment
Planning work area.

5. In Enable in Work Area, select the check boxes for the work areas in which the forecasting profile should be
available.

After the forecasting profile is created, it'll be visible on the Managing Forecasting Profiles page in only these
work areas. Moreover, during the creation of a demand plan, demand and supply plan, or replenishment plan,
in the Forecast Profiles section on the Demand tab on the Plan Options page, only the forecasting profiles
enabled for the work area can be selected.

6. In Forecasting Table, select the forecasting table for the forecasting profile.

The forecasting table defines the data aggregation levels that are used in the forecasts.
7. In Input Measure, select the input measure for the forecasting profile.

This measure's data is used as the basis of historical demand in forecasts.

The measures available for selection are in the selected forecasting table and are dimensioned by time.
8. In Output Measure, select the output measure for the forecasting profile.

This measure stores the forecast after the plan is run.

The measures available for selection are in the selected forecasting table and are dimensioned by time.
Moreover, the available measures can't be shared across plans and are refreshed with current data.

9. In Measure Catalogs, select the measure catalogs for the forecasting profile.

Select all the measure catalogs that you anticipate are required for plans that use the forecasting profile.
Predefined measure catalogs aren't available for selection.

10. If your forecasting profile uses Bayesian machine learning, use the Forecasting Methods tab to configure the
forecasting methods and method parameters. For more information, refer to the topic on forecasting methods
for Bayesian machine learning in this chapter.

If your forecasting profile uses feature-based machine learning, accept the default selection of the XG Boost
forecasting method on the Forecasting Methods tab. For more information, refer to the topic on the forecasting
method for feature-based forecasting in this chapter.

11. If your forecasting profile uses Bayesian machine learning, use the Decomposition Groups tab to select and
configure decomposition groups. For more information, refer to the topic on decomposition groups in this
chapter.

If your forecasting profile uses feature-based machine learning, use the Feature Groups tab to select and
configure measures, levels, and attributes. For more information, refer to the topic on feature groups in this
chapter.

12. Use the Forecasting Parameters tab to configure forecasting parameters.

For more information, refer to the topic on forecasting parameters for Bayesian machine learning or forecasting
parameters for feature-based forecasting in this chapter.
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13. Click Save and Close.

Related Topics
• Overview of Forecasting Using Supersession Relationships

• Overview of the Product Lifecycle Management Page Layout

• Overview of Feature-Based Forecasting for New Products

Edit a User-Defined Forecasting Profile  
You can duplicate, edit, or delete a user-defined forecasting profile.

You can't edit a predefined forecasting profile. However, you can duplicate the predefined forecasting profile and edit
the copy.

You also can't change the machine learning type for a forecasting profile. If you duplicate the forecasting profile, the
Machine Learning Type field is set to the selection for the original forecasting profile and can't be changed.

To delete the user-defined forecasting profile, you must first deselect it for the associated demand, demand and supply,
or replenishment plan in the Forecast Profiles section on the Demand tab of the Plan Options page.

Follow these steps to edit the user-defined forecasting profile:

1. In the Demand Management, Demand and Supply Planning, or Replenishment Planning work area, on the
Tasks panel tab, under Configuration, select Manage Forecasting Profiles.

The Manage Forecasting Profiles page opens.
2. Select the forecasting profile, and click Actions > Edit

The Manage Forecasting Profiles page opens.
3. Edit the name and description as required.
4. In Enable in Work Area, select or deselect the work areas in which the forecasting profile should be available.

You can't deselect a work area if the forecasting profile is associated with a plan in that work area. Before
deselecting the work area, you must first deselect the forecasting profile for the plan in the Forecast Profiles
section on the Demand tab of the Plan Options page.

5. In Forecasting Table, select the forecasting table that defines the data aggregation levels that are used in the
forecasts.

6. In Input Measure, select the input measure for the forecasting profile.

This measure's data is used as the basis of historical demand in forecasts.

The measures available for selection are in the selected forecasting table and are dimensioned by time.
7. In Output Measure, select the output measure for the forecasting profile.

This measure stores the forecast after the plan is run.

The measures available for selection are in the selected forecasting table and are dimensioned by time.
Moreover, the available measures can't be shared across plans and are refreshed with current data.
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8. In Measure Catalogs, select the measure catalogs for the forecasting profile.

Select all the measure catalogs that you anticipate are required for plans that use the forecasting profile.
Predefined measure catalogs aren't available for selection.

9. If your forecasting profile is based on Bayesian machine learning, use the Forecasting Methods tab to configure
the forecasting methods and method parameters. For more information, refer to the topic on forecasting
methods for Bayesian machine learning in this chapter.

If your forecasting profile is based on feature-based machine learning, accept the default selection of the XG
Boost forecasting method on the Forecasting Methods tab. For more information, refer to the topic on the
forecasting method for feature-based forecasting in this chapter.

10. If your forecasting profile uses Bayesian machine learning, use the Decomposition Groups tab to select and
configure decomposition groups. For more information, refer to the topic on decomposition groups in this
chapter.

If your forecasting profile uses feature-based machine learning, use the Feature Groups tab to select and
configure measures, levels, and attributes. For more information, refer to the topic on feature groups in this
chapter.

11. Use the Forecasting Parameters tab to configure forecasting parameters.

For more information, refer to the topic on forecasting parameters for Bayesian machine learning or forecasting
parameters for feature-based machine learning in this chapter.

12. Click Save and Close.

The edited forecasting profile takes effect the next time you run the associated plan.

Forecasting Methods  
You have 15 forecasting methods for use in forecasting profiles that are based on Bayesian machine learning.

You can use one or a combination of these forecasting methods while configuring your forecasting profile. You also
have three naive forecasting methods that are used when the other forecasting methods can't produce an acceptable
forecast in a forecasting profile that's based on Bayesian machine learning.

The following table lists the 15 forecasting methods and three naive forecasting methods:

Forecasting
Method

Enabled in
Predefined
Forecasting
Profiles

Uses Short
Causal
Factors

Uses Long
Causal
Factors

Uses
Multiplicative
Causal
Factors

Uses
Nonseasonal
Causal
Factors

Supports
Method
Decomposition

Supports
Causal
Decomposition

Calculates
MAPE, MAD,
 and Bias

Auto
Regressive
External
Inputs (X)
 

No
 

No No No Yes Yes Yes Yes

Auto
Regressive
Integrated
External (V)
 

No
 

No No No Yes Yes Yes Yes
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Forecasting
Method

Enabled in
Predefined
Forecasting
Profiles

Uses Short
Causal
Factors

Uses Long
Causal
Factors

Uses
Multiplicative
Causal
Factors

Uses
Nonseasonal
Causal
Factors

Supports
Method
Decomposition

Supports
Causal
Decomposition

Calculates
MAPE, MAD,
 and Bias

Auto
Regressive
Logistic (A)
 

No
 

No Yes No No Yes Yes Yes

Causal
Winters (B)
 

No
 

Yes No No No Yes No Yes

Combined
Transformation
(E)
 

No
 

No Yes No No Yes Yes Yes

Croston for
Intermittent
(F)
 

Yes
 

No No No No No No Yes

Dual Group
Multiplicative
(D)
 

No
 

No No Yes No Yes Yes Yes

Holt (H)
 

Yes
 

No No No No Yes Yes Yes

Logistic (G)
 

No
 

Yes No No No Yes Yes Yes

Modified
Ridge
Regression
(M)
 

Yes
 

No Yes No No Yes Yes Yes

Multiplicative
Monte Carlo
Intermittent
(K)
 

No
 

No Yes No No No No Yes

Multiplicative
Monte Carlo
Regression (C)
 

No
 

No Yes No No Yes Yes Yes

Regression (R)
 

Yes
 

Yes No No No Yes Yes Yes

Regression for
Intermittent
(J)
 

Yes
 

Yes No No No No No Yes

Transformation
Regression (L)
 

Yes
 

Yes No No No Yes Yes Yes
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Forecasting
Method

Enabled in
Predefined
Forecasting
Profiles

Uses Short
Causal
Factors

Uses Long
Causal
Factors

Uses
Multiplicative
Causal
Factors

Uses
Nonseasonal
Causal
Factors

Supports
Method
Decomposition

Supports
Causal
Decomposition

Calculates
MAPE, MAD,
 and Bias

Naive (N) Yes No No No No No No No

Holt Naive (T) Yes No No No No No No No

Moving
Average Naive
(O)

Yes No No No No No No No

The six forecasting methods that are enabled in predefined forecasting profiles provide the best results in most
business scenarios that are commonly found. You can use the remaining forecasting methods in user-defined
forecasting profiles.

To enable you to analyze the generated forecasts, the letters representing the used forecasting methods and their
weights are stored in these measures:

Note:  The measures for method weights are populated only when you select the Include details of forecast
methods check box on the Parameters tab in the Run Plan dialog box for a demand or demand and supply plan.

Measure Description Applicable Work Areas

Bookings Forecasting Methods
 

Contains the letters for the forecasting methods
that are used for generating the bookings
forecast for an item.
 

• Demand Management

• Demand and Supply Planning

• Sales and Operations Planning

Bookings Forecasting Methods Weight
 

Contains the weight (percentage) assigned
to a forecasting method during the bookings
forecast generation.
 

• Demand Management

• Demand and Supply Planning

Consumption Forecasting Methods
 

Contains the letters for the forecasting methods
that are used for generating the consumption
forecast for an item.
 

Replenishment Planning
 

Shipments Forecasting Methods
 

Contains the letters for the forecasting methods
that are used for generating the shipments
forecast for an item.
 

• Demand Management

• Demand and Supply Planning

• Replenishment Planning

• Sales and Operations Planning

Shipments Forecasting Methods Weight
 

Contains the weight (percentage) assigned to
a forecasting method during the shipments
forecast generation.
 

Note:  In a replenishment or sales and
operations plan, this measure won't return
any value because causal decomposition
isn't supported in such plans.

• Demand Management

• Demand and Supply Planning

• Replenishment Planning

• Sales and Operations Planning
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For information about forecasting methods, refer to the white paper titled "Oracle Demand Management Cloud
Analytical Methods (Forecasting Methods)" that's available in Document ID 2582285.1 on My Oracle Support.

Naive Forecasting Methods
If none of the enabled forecasting methods in the predefined or user-defined forecasting profile can generate an
acceptable forecast at any level of the forecast tree, then the following steps are taken:

1. If the Holt (H) forecasting method wasn't enabled, and the number of data points in the history is sufficient,
then a simplified version of the forecasting method called Holt Naive (T) is used at the highest level of the
forecast tree. The generated forecast is used if acceptable.

2. If the Holt Naive (T) forecasting method doesn't generate an acceptable forecast, then the following steps are
taken on the basis of the value of the EnableNaiveForecast forecasting parameter:

a. If the value of the forecasting parameter is zero, no forecast is generated.
b. If the value of the forecasting parameter is 1, the Naive (N) forecasting method is used at the highest

level of the forecast tree. A simple forecast is generated on the basis of the average of the bookings,
consumption or shipments history.

Note:  In predefined forecasting profiles, the value of the EnableNaiveForecast forecasting parameter is
1. Therefore, in predefined forecasting profiles, the Naive (N) forecasting method is used.

c. If the value of the forecasting parameter is greater than 1, then the Moving Average Naive (O) forecasting
method is used at the highest level of the forecast tree. A simple moving average of the bookings,
consumption, or shipments history is used for generation of the forecast. The value of the forecasting
parameter determines the number of buckets that are used, and the bucket is specified in the
Forecasting Time Level field on the Demand Tab on the Plan Options page for the demand, demand
and supply, or replenishment plan.

Method decomposition and causal decomposition aren't available for naive forecasting methods.

Related Topics
• Create a Forecasting Profile

• Statistical Forecasts, Causal Factors, and Decomposition Groups

Configure Decomposition Groups  
A decomposition group is a container for the measures that you use as causal factors in a forecasting profile that's
based on Bayesian machine learning.

Causal factors enable forecasting methods to understand the variation in historical demand and produce an accurate
and adoptive forecast. Decomposition groups let you organize measures that have similar effects on a forecast.

Several predefined causal factors (predefined measures) are available for meeting commonly found forecasting needs.
You can also use user-defined measures as causal factors. You can easily view and modify the information in causal
factors using tables. Causal factors are the best way for you to add information that drives demand into the forecasting
process and thereby improve it.

For your user-defined forecasting profile, you can add, edit, or delete decomposition groups. You can also activate and
deactivate all causal factors in a decomposition group using its check box.
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In a demand or demand and supply plan, you can decompose the forecast by the causal factor group. When you select
the Include details of causal factors check box on the Parameters tab in the Run Plan dialog box, the duration of the
plan run increases significantly. For this reason, decompose the forecast by causal factors preferably when you simulate
the demand from a table for a subset of the plan that's based on the table selections. By doing so, you can perform a
focused analysis of the causal factors. Include the details of the causal factors only when you want to analyze the results
and not every time you run the plan.

Note:  Causal decomposition isn't supported for the Causal Winters (B), Croston for Intermittent (F), Multiplicative
Monte Carlo Intermittent (K), Regression for Intermittent (J), Naive (N), Moving Average Naive (O), and Holt Naive (T)
forecasting methods. No decomposed values are generated for any items that are forecast with these forecasting
methods.

For information about causal factors, refer to the white paper titled "Demand Management Forecasting Causal Factors"
that's available in Document ID 2551482.1 on My Oracle Support.

Create a Decomposition Group
Perform these steps to create a decomposition group:

1. On the Decomposition Groups tab in your forecasting profile, click Actions > Create.
2. In the Create Decomposition Group dialog box, do the following:

◦ Provide a name and description for the decomposition group.

◦ From the Available Measures pane, move the required measures to the Selected Measures pane.

The available measures are those that are enabled for the work area in which you create the
decomposition group. Ensure that the selected measures are in the measure catalog of the plan that uses
the forecasting profile.

3. Click OK.

Configure Causal Factors in a Decomposition Group
Perform these steps to configure the causal factors in a decomposition group:

1. On the Decomposition Groups tab in your forecasting profile, expand the decomposition group.

The expanded list details the available causal factors.
2. Select the check boxes for each causal factor:

◦ Short: Use this setting to assign the causal factor to the Causal Winters (B), Logistic (G), Regression
(R), Regression for Intermittent (J), and Transformation Regression (L) forecasting methods that use all
assigned causal factors. These forecasting methods use a limited set of causal factors and aren't efficient
at determining which causal factors are useful. You select this check box for most causal factors.

◦ Long: Use this setting to assign the causal factor to forecasting methods that use an extended set
of causal factors and are efficient at determining which causal factors are useful. These forecasting
methods are Auto Regressive Logistic (A), Combined Transformation (E), Modified Ridge Regression (M),
Multiplicative Monte Carlo Intermittent (K), and Multiplicative Monte Carlo Regression (C).

◦ Multiplicative: Use this setting to assign the causal factor to the Dual Group Multiplicative (D) forecasting
method. If you have enabled this forecasting method, each causal factor of your forecasting profile can
use the Group One or Group Two value of the list. Each of these values should be selected for at least
one causal factor.
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◦ Not Seasonal: Use this setting to assign the causal factor to the Auto Regressive External Inputs (X)
and Auto Regressive Integrated External (V) forecasting methods. The only causal factors that should
be assigned this setting are those that aren't predictable functions of time. For example, price varies
randomly with time and can be assigned this setting.

◦ Fill Missing: Use this setting for causal factors when there are missing values for dates, and you want to
have values for these dates. The values that are entered for a causal factor are based on values of the
same causal factor for other dates. Use this setting for causal factors, such as those for price, that should
always have a value.

Related Topics
• Create a Forecasting Profile

• Forecasting Methods

• Forecasting Parameters

Forecasting Parameters  
Forecasting parameters control several aspects of a demand forecast, such as the handling of missing values, outlier
detection, fit and forecast validation, and sparse data forecasting.

You can improve the default settings for forecasting parameters based on your data analysis and forecast results.

The settings for all forecasting parameters related to time are in days and automatically adjusted for aggregate
forecasting time levels. For example, the default setting of 182 days for a forecasting parameter is automatically
adjusted to 26 days for a weekly forecast.

Note:  You can’t make any change to the displayed forecasting parameters or their values in a predefined forecasting
profile. You can make such changes in only a copy of the predefined forecasting profile.

This table lists the commonly used forecasting parameters.

Forecasting Parameter Description

FillMissingMethod
 

Specifies how to fill any undefined historical values. Parameter values may be 0, 1, 2. 0 for no missing
values field. 1 for linear interpolation based on not missing neighbors. 2 for omitting missing values.
 

GlobalAllocationPeriods
 

Specifies the number of days going backward from the history end date that's used for calculating the
average demand (for bookings, consumption, or shipments).
 

DiscontinueDateMeasure
 

Specifies the measure that contains the product discontinuation date for use in the functionality
for managing product launches. If the measure is specified, the forecast ends on the product
discontinuation date instead of the plan's forecast end date.
 
If the measure date is after the forecast end date of the plan, the forecast end date is used. When the
selected measure doesn’t contain a value or isn’t present in the plan’s measure catalog, the forecast
end date of the plan is used.
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Forecasting Parameter Description

If the date for the LaunchDateMeasure forecasting parameter is later than the date for the
DiscontinueDateMeasure forecasting parameter, both dates are ignored, and the forecast is generated
from the plan's forecast start date to the plan's forecast end date.
 
The default value for the DiscontinueDateMeasure forecasting parameter is the Final Discontinuation
Date measure. The available measures for selection are of the Date data type, are available in the
forecasting profile’s work areas, and have all dimensions of the forecasting profile's output measure
except for Time.
 

EnableNaiveForecast
 

Specifies whether naive modeling is used, and if so, what type. The parameter value may be 0 or a
positive integer. Use 0 to disable naive modeling. 1 to use Oracle proprietary naive modeling. Any
integer greater than 1 to use the simple moving average with the value controlling the number of
historical periods used.
 

IntermitCriterion
 

Specifies the lowest percentage of zero values in historical demand for which the time series are
evaluated using intermittent forecasting methods.
 

LaunchDateMeasure
 

Specifies the measure that contains the product launch date for use in the functionality for managing
product launches. If the measure is specified, the forecast starts on the product launch date instead of
the plan's forecast start date.
 
If the measure date is earlier than the forecast start date of the plan, the forecast start date is used.
When the selected measure doesn’t contain a value or isn’t present in the plan’s measure catalog, the
forecast start date of the plan is used.
 
If the date for the LaunchDateMeasure forecasting parameter is later than the date for the
DiscontinueDateMeasure forecasting parameter, both dates are ignored, and the forecast is generated
from the plan's forecast start date to the plan's forecast end date.
 
The default value for the LaunchDateMeasure forecasting parameter is the Final Launch Date measure.
The available measures for selection are of the Date data type, are available in the forecasting profile’s
work areas, and have all dimensions of the forecasting profile's output measure except for Time.
 

WriteFit
 

Specifies whether the forecast is generated for the future or also for the history. Enter 0 to write the
forecast for only the future, or 1 to write the forecast for the future and history. When you enter 1, the fit
forecast is written for the entire history used during the forecasting process.
 

DetectOutlier
 

Specifies whether an attempt should be made to detect and smooth outliers in the time series. If
extreme highs and lows are acceptable in your demand pattern, you can disable this forecasting
parameter by entering zero.
 

OutlierSensitivity
 

Specifies the sensitivity of outlier detection. The greater the value, the more liberal the detection. For
common detection, use values less than 2.
 

RemoveExtremeOutlier
 

Specifies whether aggressive outlier smoothing should be performed, and if extreme values should
be removed before being processed by forecasting methods. Enable this forecasting parameter by
entering 1 only if there's a clear cause to remove extreme values, if extreme values are rare or because
of data errors, and you want a very smooth forecast.
 

EnableFitValidation
 

Specifies whether to enable statistical fit validation. 1 to enable validation. 0 to disable validation.
 

EnableForecastValidation
 

Specifies whether to enable statistical forecast validation. 1 to enable validation. 0 to disable validation.
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Forecasting Parameter Description

FitValidationSensitivity
 

Controls the sensitivity of fit validation. Forecasting methods with a mean absolute percentage
error (MAPE) greater than the specified value are rejected. The smaller the value, the stricter is the
validation. For loose validation, use values between 1 and 2. For strict validation, use values between .3
and .5.
 
This forecasting parameter may be the most important one for your forecast. If your forecast is failing
at the required level, increasing the value of this forecasting parameter might help.
 

ForecastValidationSensitivity
 

Specifies the sensitivity of forecast validation. The smaller the value, the stricter the test. For loose
forecast validation, use values between 5 and 10.
 

Additional forecasting parameters are available, and you can include them in your user-defined forecasting profile by
clicking Actions > Add to open the Add Parameter to Viewable List dialog box. Select the forecasting parameter you
want, and click the Add button to include it in the forecasting profile.

For information about forecasting parameters, refer to the white paper titled "Demand Management Forecasting
Parameters" that's available in Document ID 2551481.1 on My Oracle Support.

Related Topics
• Create a Forecasting Profile

• Forecasting Methods

• Configure Decomposition Groups

Measures for Bayesian Forecasting  
This topic lists the measures that are used in Bayesian forecasting.

Input Measures
This table lists the predefined input measures for Bayesian forecasting and the associated measures that are predefined
or automatically created:

Input Measure Associated Measure

Final Bookings History
 

Bookings History Average
 
(predefined)
 

Final Consumption History
 

Consumption History Average
 
(predefined)
 

Final Shipments History
 

Shipments History Average
 
(predefined)
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Input Measure Associated Measure

 

user-defined input measure
 

<user-defined input measure name> History average
 
(automatically created and added to the measure catalog for the user-defined forecasting profile)
 

Output Measures
This table lists the predefined output measures for Bayesian forecasting and the associated measures that are
predefined or automatically created:

Output Measure Associated Measures

Bookings Forecast
 
Consumption Forecast
 
Shipments Forecast
 

<predefined output measure name> Average Interarrival Time
 
<predefined output measure name> Batch Size
 
<predefined output measure name> Bias
 
<predefined output measure name> Complexity
 
<predefined output measure name> Decomposed
 
<predefined output measure name> Decomposed Outlier
 
<predefined output measure name> Decomposed Regime Change
 
Bookings Forecasting Levels/Consumption Forecasting Level/Shipments Forecasting Levels
 
Bookings Forecasting Methods/Consumption Forecasting Methods/Shipments Forecasting Methods
 
Bookings Forecasting Methods Weight/Consumption Forecasting Methods Weight/Shipments
Forecasting Methods Weight
 
<predefined output measure name> Generate Forecast/Consumption Forecast Generation Status
 
<predefined output measure name> Has Outliers
 
Bookings Forecast Has Regime Change/Shipments Forecast Has Regime Change
 
<predefined output measure name> Interval Time
 
<predefined output measure name> Is Intermittent
 
<predefined output measure name> MAD
 
<predefined output measure name> MAPE
 
<predefined output measure name> Outlier Values/Consumption Forecast Outlier Value
 
<predefined output measure name> Status
 
<predefined output measure name> Total
 
(all predefined)
 

user-defined output measure <user-defined output measure name> Average interarrival time
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Output Measure Associated Measures

  
<user-defined output measure name> Batch size
 
<user-defined output measure name> Bias
 
<user-defined output measure name> Complexity
 
<user-defined output measure name> Decomposed model and causal factor forecast
 
<user-defined output measure name> Decomposed outlier values
 
<user-defined output measure name> Decomposed regime change indicator
 
<user-defined output measure name> Forecast level
 
<user-defined output measure name> Forecast method weights
 
<user-defined output measure name> Forecast methods
 
<user-defined output measure name> Forecast status
 
<user-defined output measure name> Generate forecast indicator
 
<user-defined output measure name> Intermittent indicator
 
<user-defined output measure name> Interval time
 
<user-defined output measure name> MAD
 
<user-defined output measure name> MAPE
 
<user-defined output measure name> Outlier indicator
 
<user-defined output measure name> Outlier values
 
<user-defined output measure name> Regime change indicator
 
<user-defined output measure name> Total Forecast
 
The measures are automatically created and added to the measure catalog for the user-defined
forecasting profile. If the user-defined output measure is used in more than one user-defined
forecasting profile, the associated measures are reused and not created anew.
 

Forecast Trees  

Overview of Forecast Trees  
A forecast tree is a structure of hierarchy levels at which data can be aggregated during the demand forecasting
process.

The forecast tree enables Oracle Demand Management to aggregate data while performing analytical forecasts. In other
words, the forecast tree for a forecasting profile organizes the data for the forecasting process.

The forecasting process begins at the most granular (lowest) level of the forecast tree. If the forecast can’t be made
at this level because of inadequate or sparse data, the process moves up the forecast tree and attempts to forecast
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at higher levels of data aggregation. In general, forecasts are more accurate when they’re made at lower levels of the
forecast tree.

The forecast tree supports up to two dimensions. The available dimensions for the forecast tree are Product,
Organization, Customer, and Demand Class. Your configuration of the forecast tree depends on your business. You
typically use the Product dimension along with another dimension (for example, Product and Organization, Product and
Customer, or Product and Demand Class). With respect to the Product dimension, you can use levels from any hierarchy
except for levels from the configure-to-order (CTO) hierarchy (Model BOM).

The run time is short if the forecasting process has to do less data aggregation while traversing the forecast tree. If
the data quality allows, use the lowest levels for two dimensions (for example, Item and Customer Site) as the first
forecastable level in the forecast tree. The run time is long when the lowest forecastable levels are aggregated, or only
one dimension is used.

The quality of the forecast is influenced by the forecast tree’s construction. Thus, you must carefully include and
arrange levels for the forecast tree.

Related Topics
• How a Forecast Tree Is Constructed

• Best Practices for Setting Up Forecasting Tables for Forecast Trees

• Example of an Incorrectly Constructed Forecast Tree

How a Forecast Tree Is Constructed  
You determine the forecast tree by configuring a table just as you would for a table displayed in your Oracle Fusion
Cloud Supply Chain Planning module.

The forecast tree is derived from the table's layout. In the table, you select levels to include in the forecast tree, and on
the Layout tab in the Selector Tool, you arrange the levels in the decreasing order of data aggregation. Finally, you select
the table as the forecasting table for a forecasting profile.

Note:  You must arrange the levels on the row edge for the forecasting table. On the Layout tab, the row edge is the
vertical axis to the left of the pivot table's body.

The forecasting process constructs the forecast tree downwards from a fictitious top level (All – All) to the lowest level
of aggregation. Each included level is taken one at a time and placed in a forecast tree level under the column for the
respective dimension.

Assume that you have arranged the levels in the decreasing order of aggregation as follows: Category Level 2, Legal
Entity, Category Level 1, Organization, and Item.

For this level arrangement, the forecasting process constructs the forecast tree as follows:

1. First, the fictitious top level of the tree is designated as All – All.
2. At the next forecast tree level, the Category Level 2 level replaces the All level under the column for the Product

dimension.
3. At the next forecast tree level, the Legal Entity level replaces the All level under the column for the Organization

dimension. The Category Level 2 level is retained under the column for the Product dimension.
4. At the next forecast tree level, the Category Level 1 level replaces the Category Level 2 level under the column

for the Product dimension. The Legal Entity level is retained under the column for the Organization dimension.
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5. At the next forecast tree level, the Organization level replaces the Legal Entity level under the column for the
Organization dimension. The Category Level 1 level is retained under the column for the Product dimension.

6. At the lowest forecast tree level, the Item level replaces the Category Level 1 level under the column for the
Product dimension. The Organization level is retained under the column for the Organization dimension.

The demand forecasting process moves up this forecast tree while performing the forecast. First, the forecast is
attempted at the level of Item and Organization. If a forecast can’t be performed at this level, the forecast is attempted at
the next level of Category Level 1 and Organization, and so on.

The following figure depicts this forecast tree:

The following screenshot depicts the arrangement of levels on the Layout tab in the Selector Tool for the previously
provided forecast tree:
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Related Topics
• Overview of Forecast Trees

• Best Practices for Setting Up Forecasting Tables for Forecast Trees

• Example of an Incorrectly Constructed Forecast Tree

Best Practices for Setting Up Forecasting Tables for Forecast Trees
 
Keep these points in mind while you set up the forecasting tables based on which the demand forecasting process
constructs forecast trees:

• Oracle recommends that you not start from scratch while constructing the forecasting table for a forecast tree.
Instead, make a copy of one of the predefined forecasting tables (for example, Forecast Bookings Definitions or
Forecast Shipments Definitions), and change the copy to suit your requirements.

• Don’t use any time-related dimensions in the forecasting table.

• Include at least three effective hierarchy levels in the forecasting table.

• Ensure that the data aggregation of the levels decreases along the row edge of the forecasting table. The
arrangement of levels must be meaningful to your business process.

• For each dimension, select levels from a single hierarchy while configuring the forecasting table, and don’t
select levels from multiple hierarchies.

If you select levels from multiple hierarchies, the demand forecasting process uses the hierarchy that has the
most levels. If there is a tie in this regard, the hierarchy with the lowest internal ID is selected. Consequently, you
have less control over the final structure of the forecast tree.

Related Topics
• Overview of Forecast Trees

• How a Forecast Tree Is Constructed

• Example of an Incorrectly Constructed Forecast Tree
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Example of an Incorrectly Constructed Forecast Tree  
This topic provides an example of a forecast tree that's incorrectly constructed because the underlying forecasting table
was incorrectly set up.

On the Layout tab in the Selector Tool, the hierarchy levels on the row edge of the forecasting table for the forecast
tree must be in the order of decreasing data aggregation. While generating the forecast tree, the demand forecasting
process can move in only the direction of decreasing aggregation. If a level of higher aggregation follows a level of lower
aggregation, the process ignores the former. Thus, an incorrect arrangement of levels results in a forecast tree that
doesn’t meet expectations and causes an incorrect aggregation of data during the forecasting process.

Assume that you have arranged the levels as follows: Category Level 2, Legal Entity, Item, Organization, and Category
Level 1. Here, a level with a higher aggregation (Category Level 1) is placed after a level with a lower aggregation (Item).

For this level arrangement, the forecasting process constructs the forecast tree as follows:

1. First, the fictitious top level of the forecast tree is designated as All – All.
2. At the next forecast tree level, the Category Level 2 level replaces the All level under the column for the Product

dimension.
3. At the next forecast tree level, the Legal Entity level replaces the All level under the column for the Organization

dimension. The Category Level 2 level is retained under the column for the Product dimension.
4. At the next forecast tree level, the Item level replaces the Category Level 2 level under the column for the

Product dimension. The Legal Entity level is retained under the column for the Organization dimension.
5. At the next forecast tree level, the Organization level replaces the Legal Entity level under the column for the

Organization dimension. The Item level is retained under the column for the Product dimension.
6. Finally, the Category 1 level is omitted from the forecast tree on account of having a higher aggregation than

the Item level.
The following figure depicts the forecast tree:
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Related Topics
• Overview of Forecast Trees

• How a Forecast Tree Is Constructed

• Best Practices for Setting Up Forecasting Tables for Forecast Trees

Disaggregation of Statistical Forecasts  

How Statistical Forecasts Are Disaggregated by Default  
This topic explains how statistical forecasts are disaggregated by default in the Demand Management, Demand and
Supply Planning, Planning Central, Replenishment Planning, and Sales and Operations Planning work areas.
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Note:  The default disaggregation described in this topic is limited to plans that use forecasting profiles that are based
on Bayesian machine learning.

Settings That Affect Default Disaggregation of Statistical Forecasts
This table lists the forecasting parameters that affect the default disaggregation of statistical forecasts:

Note:  In the Demand Management, Demand and Supply Planning, and Replenishment Planning work areas, you can
modify these forecasting parameters in only user-defined forecasting profiles. You can use predefined forecasting
profiles with only the default values. In the Planning Central and Sales and Operations Planning work areas, you can
use only predefined forecasting profiles and can't modify forecasting parameters.

Name Description Default Value

PeriodsUntilActive
 

Specifies the number of days going backward
from the history end date that's used for
determining the forecast status for a product
combination. If the demand for the product
combination falls only within this period, the
forecast status is Inactive/New/Immature. If
the demand is wholly or partially before this
period but within the days specified in the
PeriodsUntilInactive forecasting parameter, the
forecast status is Active.
 
For example, if the value of the forecasting
parameter is 14, but the only demand for the
product combination was 10 days before the
history end date, the forecast status is Inactive/
New/Immature.
 

14 days
 

PeriodsUntilInactive
 

Specifies the number of days going backward
from the history end date that's used for
determining the forecast status for a product
combination. If the demand for the product
combination falls wholly before this period,
 the forecast status is Inactive/Retired/
Discontinued.
 
For example, if the value of the forecasting
parameter is 182, but the only demand for the
product combination was 200 days before the
history end date, the forecast status is Inactive/
Retired/Discontinued.
 

182 days
 

GlobalAllocationPeriods
 

Specifies the number of days going backward
from the history end date that's used for
calculating the average demand (for bookings,
 consumption, or shipments).
 

182 days
 

This table lists the forecast status measures and generate forecast measures for output measures of forecasting
profiles:
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Output Measure Forecast Status Measure Generate Forecast Measure

Bookings Forecast
 

Bookings Forecast Status
 
Indicates if a product combination receives a
disaggregated statistical forecast for bookings.
 
Available in the Demand Management, Demand
and Supply Planning, Planning Central, and
Sales and Operations Planning work areas.
 

Bookings Forecast Generate Forecast
 
Indicates whether historical bookings should be
analyzed and a forecast generated for a product
combination. You can edit this measure.
 
Available in the Demand Management, Demand
and Supply Planning, Planning Central, and
Sales and Operations Planning work areas.
 

Consumption Forecast
 

Consumption Forecast Status
 
Indicates if a product combination receives
a disaggregated statistical forecast for
consumption.
 
Available in the Replenishment Planning work
area.
 

Consumption Forecast Generation Status
 
Indicates whether historical consumption
should be analyzed and a forecast generated
for a product combination. You can edit this
measure.
 
Available in the Replenishment Planning work
area.
 

Shipments Forecast
 

Shipments Forecast Status
 
Indicates if a product combination receives a
disaggregated statistical forecast for shipments.
 
Available in the Demand Management, Demand
and Supply Planning, Planning Central,
 Replenishment Planning, and Sales and
Operations Planning work areas.
 

Shipments Forecast Generate Forecast
 
Indicates whether historical shipments should
be analyzed and a forecast generated for
a product combination. You can edit this
measure.
 
Available in the Demand Management, Demand
and Supply Planning, Planning Central,
 Replenishment Planning, and Sales and
Operations Planning work areas.
 

User-Defined Output Measure
 

<User-defined output measure name> Forecast
Status
 
(created automatically)
 

<User-defined output measure name>
Generate Forecast Indicator
 
(created automatically)
 

The table lists the history average measures for input measures of forecasting profiles:

Input Measure History Average Measure

Final Bookings History
 

Bookings History Average
 
Contains the average daily bookings over the days before the history end date as specified in the
GlobalAllocationPeriods forecasting parameter.
 
Available in the Demand Management, Demand and Supply Planning, Planning Central, and Sales and
Operations Planning work areas.
 

Final Consumption History
 

Consumption History Average
 
Contains the average daily consumption over the days before the history end date as specified in the
GlobalAllocationPeriods forecasting parameter.
 
Available in the Replenishment Planning work area.
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Input Measure History Average Measure

 

Final Shipments History
 

Shipments History Average
 
Contains the average daily shipments over the days before the history end date as specified in the
GlobalAllocationPeriods forecasting parameter.
 
Available in the Demand Management, Demand and Supply Planning, Planning Central, Replenishment
Planning, and Sales and Operations Planning work areas.
 

User-Defined Input Measure
 

<User-defined input measure name> History Average
 
(created automatically)
 

How Statistical Forecasts Are Disaggregated by Default
Whether a product combination receives a disaggregated statistical forecast depends on the forecast status of the
combination, which can be one of the following:

Forecast Status Description

1
 

Active
 
A product combination has this forecast status if the demand is wholly or partially before the period
specified in the PeriodsUntilActive forecasting parameter and wholly or partially within the period
specified in the PeriodsUntilInactive forecasting parameter.
 
Only product combinations with this forecast status receive a disaggregated forecast by default.
 

2
 

Inactive/New/Immature
 
A product combination has this forecast status if the demand is wholly within the period specified in
the PeriodsUntilActive forecasting parameter.
 

3
 

Inactive/Retired/Discontinued
 
A product combination has this forecast status if the demand is wholly before the period specified in
the PeriodsUntilInactive forecasting parameter.
 

These points explain the default disaggregation of statistical forecasts:

• The forecast status measure is identified on the basis of the output measure for the forecasting profile and
calculated for a product combination after these criteria are considered:

◦ The values of the PeriodsUntilActive and PeriodsUntilInactive forecasting parameters.

◦ The value of the associated generate forecast measure for the product combination.

Note:  The generate forecast measure is an override for the forecast status measure. Edit the generate
forecast measure for only those active product combinations that must not receive a forecast. Don't
use this measure if you want inactive product combinations to receive a forecast.
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• Depending on the input measure for the forecasting profile, the history average measure is selected. The
history average for the product combination is then calculated on the basis of the GlobalAllocationPeriods
forecasting parameter.

• The input history for all product combinations is collected irrespective of their forecast status (Active, Inactive/
New/Immature, or Inactive/Retired/Discontinued) and aggregated to active product combinations at a higher
level for generating the forecast.

• The generated forecast is disaggregated to only active product combinations at the lowest level on the basis of
the history average (contained in the history average measure) and disaggregation parameters for the output
measure of the forecasting profile.

As depicted in this figure, history is collected from active, inactive/new/immature, and inactive/retired/discontinued
product combinations and aggregated to active product combinations at a higher level, and the forecast is
disaggregated to only active product combinations at the lowest level.

Related Topics
• How You Configure Disaggregation of Statistical Forecasts

How You Configure Disaggregation of Statistical Forecasts  
This topic explains how you can configure the disaggregation of statistical forecasts in the Demand Management,
Demand and Supply Planning, and Replenishment Planning work areas.
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Instead of having the forecast disaggregated by default to active product combinations at the lowest level, you can use
a measure to disaggregate the forecast to product combinations of your choice. Thereby, you can override the default
logic of using the forecast status measure that corresponds to the output measure of the selected forecasting profile for
identifying active product combinations that receive the disaggregated forecast.

Configuring disaggregation of statistical forecasts is useful when your organization has a product that's frequently
updated, but only the latest version is available for ordering. You can generate the forecast using the historical demand
for old product versions that are currently available in the market and disaggregate the forecast to only the latest
product version.

Note:  You can use this feature in only a user-defined forecasting profile that's based on Bayesian machine learning.

Configure Disaggregation of Statistical Forecasts
Follow these high-level steps to configure the disaggregation of statistical forecasts:

1. Create a measure as follows:

◦ The measure should be of the Number data type.

◦ The measure should have all dimensions of the output measure of your user-defined forecasting profile
except for the Time dimension.

Any dependent measures of the created measure must also have the supported dimensions.

◦ The measure expression should return 1 for product combinations that should receive the disaggregated
forecast. For example, the expression could be as follows: Case(Lifecycle Phase When 'Active' Then 1
Else 0)

You can also configure the expression using Item-level attributes.

Preferably, the measure expression must not use these functions:

- Archive
- Bias
- Fpos
- Fsum
- Lag
- Lead
- Log
- Mad
- Mape
- MeasureOffset
- Moving_Maximum
- Moving_Minimum
- Moving_Total
- Pi
- Power
- Rand

◦ You can populate the measure through the regular collections process or the file-based data import
(FBDI) template for Supply Chain Planning measures.

2. Add the measure to the predefined Output Filters for Forecast Disaggregation measure group.
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3. Add the measure and its dependent measures to the measure catalog of your plan.
If you're using an Item-level attribute, ensure that it's present in the dimension catalog of your plan.

4. Add the ForecastOutputFilter forecasting parameter from the General Settings category to your forecasting
profile.

5. Select the measure that you created for the forecasting parameter.
Only these measures are available for the forecasting parameter:

◦ The measures have the Number data type.

◦ The measures have all the dimensions of the forecasting profile's output measure except for the Time
dimension.

◦ The measures are in the Output Filters for Forecast Disaggregation measure group.

When the plan is run, the forecast status measure corresponding to the output measure of the forecasting profile is
selected for the forecasting parameter, forecast disaggregation occurs according to the default logic, and an error
message is displayed on the Review Plan Messages page in these situations:

• The measure you selected for the forecasting parameter isn't in the plan's measure catalog.

• The dimensions of the dependent measures of the measure you selected for the forecasting parameter aren't
supported.

• The Item-level attribute used in the measure you selected for the forecasting parameter isn't in the plan's
dimension catalog.

Related Topics
• How Statistical Forecasts Are Disaggregated by Default

• Create Measures and Assign to a Measure Catalog

• Create a Forecasting Profile

• Forecasting Parameters

Forecasting Using Supersession Relationships  

Overview of Forecasting Using Supersession Relationships  
You can generate a forecast for the current revision and latest (future) revision of an item in a supersession chain or
across multiple supersession chains by using the demand history of previous item revisions.

When the functionality for forecasting using supersession relationships is used, the demand history for previous item
revisions and the available demand history for the current item revision from the history start date to the history end
date of a plan are aggregated. Then, a forecast is generated on the basis of this aggregated demand history and applied
to the current item revision and latest item revision from the plan start date to the forecast end date.

In industries such as automobile manufacturing, the hundreds or thousands of parts that make up a finished end item
go through numerous revisions on account of design or production changes. Without the functionality for forecasting
using supersession relationships, you would have to manually copy the demand history of previous item revisions to the
current revision and latest revision to generate a forecast. Thus, this functionality enables you to improve efficiency by
automating the process for forecasting for the current revision and latest revision in a supersession chain.
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Points to Note About Forecasting Using Supersession Relationships
Note these points about forecasting using supersession relationships:

• The functionality covers only supersession chains with reciprocal relationships among the item revisions.

Supersession chains with unidirectional relationships aren't considered.

For example, consider a supersession chain with item revisions A, B, C, and D, in which A and B have a
reciprocal relationship, B is superseded by C, and C and D have a reciprocal relationship. Two supersession
chains (A < > B and C < > D) are considered. If B is the current revision in the A < > B supersession chain, then
B receives a forecast on the basis of the demand history for A and the available demand history for B. Similarly,
if D is the current revision in the C < > D supersession chain, then D receives a forecast on the basis of the
demand history for C and the available demand history for D.

• Item revisions with start dates that are beyond the plan horizon or forecast end date won't be considered for
forecasting.

For example, if item revision N supersedes item revision M from 01-Sep-2024, and the forecast end date is 31-
Aug-2024, then a forecast won't be generated for N.

The start date for an item revision is stored in the Item Revision Start Date measure.

• Providing the end date for an item revision is optional. This date is stored in the Item Revision End Date
measure.

If an item revision has been defined without an end date, then the Item Revision End Date measure for
that item revision is populated with the date one day before the start date of the next item revision in the
supersession chain. For the latest item revision, the measure is populated with the end date of the plan horizon.

For example, consider a supersession chain with item revisions A, B, C, and D. In this supersession chain,
B supersedes A, C supersedes B, and D supersedes C. The start dates for B, C, and D are 01-Feb-2021, 01-
Nov-2022, and 01-Jan-2024. The end date of the plan horizon is 31-Aug-2024. For this supersession chain, the
end dates set for A, B, C, and D are 31-Jan-2021, 31-Oct-2022, 31-Dec-2023, and 31-Aug-2024.

• When you have a one-to-many supersession relationship in which an item revision is superseded by more than
one item revision, the item revision for the supersession relationship with the highest rank set in Oracle Fusion
Cloud Product Lifecycle Management receives the forecast.

For example, consider a supersession chain with item revision A that's superseded by item revisions B and C.
The supersession relationship between A and B has a rank of one, while the supersession relationship between
A and C has a rank of two. For this supersession chain, B receives the forecast that's based on the demand
history for A, and C doesn't receive a forecast.

• When you have a many-to-one supersession relationship in which many item revisions are superseded by one
item revision, the demand histories for the previous revisions across supersession chains are aggregated for
the forecast generation for the current revision and latest revision.

For example, if item revision X is superseded by item revision Z, and item revision Y is also superseded by Z,
then the demand history for X and Y is aggregated for the forecast generation for Z.

• You can define supersession relationships in Oracle Product Lifecycle Management or using the file-based data
import (FBDI) template named Supply Chain Planning Item Substitute.

Note these points about supersession relationships that are defined in Oracle Product Lifecycle Management:

◦ The item revisions in a supersession chain can belong to different organizations.
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◦ You can collect the item relationships using the Collect Planning Data page. You must select the Item
Relationships reference entity on the Reference Data subtab on the Parameters tab.

Note these points about supersession relationships that are defined through the import template

◦ The item revisions in a supersession chain must belong to the same organization.

◦ You can collect the item relationships using the Load Planning Data from Flat Files scheduled process.

• To prevent adjusting of the editable forecast measures for the current revision and latest revision outside their
effective dates, you can configure an expression using the Item Revision Start Date and Item Revision End Date
measures on the Edit Lock tab in the Edit Measure dialog box.

• A forecasting profile that includes the SupersessionForecastLevelMeasure forecasting parameter can generate
a forecast for items with and without a supersession relationship.

However, for better control over the forecasting process, you may choose to set up one forecasting
profile for supersession forecasting and add it to your plan with an analysis set that contains only the
items with supersession relationships. You can then set up another forecasting profile without the
SupersessionForecastLevelMeasure forecasting parameter for items without supersession relationships and
add the forecasting profile to your plan with an analysis set that contains only these items.

• If you use separate organizations for your items with supersession relationships, you can define a plan for
these organizations. The organizations containing items without supersession relationships can be covered by
another plan.

• During supersession forecasting in demand plans, when the SupersessionForecastLevelMeasure forecasting
parameter is in the forecasting profiles, relationships among the Item, Organization, Customer Site, and
Demand Class members are created for the current revision and latest revision on the basis of the relationships
among these members for the previous revisions. These combinations of members for the current revision and
latest revision receive the forecast. The relationships are created for current revisions and latest revisions that
have item revision start dates within 365 days before the plan start date and item revision end dates after the
plan start date. These relationships are stored in the granularity tables that correspond to the input measure of
the forecasting profile and the forecast status measure.

For example, consider a supersession chain with items A, B, C, and D, in which A and B are the previous
revisions, C is the current revision, and D is the latest revision. Item revision A is related to organization M1,
customer site S1, and demand class X, while item revision B is related to organization M2, customer site S2, and
demand class X. During supersession forecasting, relationships are created for current revision C and latest
revision D with organizations M1 and M2, customer sites S1 and S2, and demand class X. These combinations of
members for current revision C and latest revision D receive the forecast.

During supersession forecasting in replenishment plans, these relationships are created among the Item and
Organization members because the Customer and Demand Class dimensions aren't supported for such plans.
The Organization members (locations) can also be subinventories.

• For correct functioning of this feature, the previous revisions, current revision, and latest revision for an item
must be present in the plan's scope.

Example of Forecasting Using Supersession Relationships
Consider a supersession chain that consists of item revisions A, B, C, and D. There are reciprocal supersession
relationships between A and B starting from February 2021, between B and C starting from November 2022, and
between C and D starting from January 2024.

If the plan start date is between November 2022 and January 2024, A and B are the previous revisions, C is the current
revision, and D is the latest revision.
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When the functionality for forecasting using supersession relationships is used, the demand history for A and B and
the available demand history for C from the history start date to the history end date are aggregated. Then, a forecast is
generated and disaggregated for C from the plan start date to the end of December 2023 and for D from January 2024
to the forecast end date.

The following figure depicts this example:
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Related Topics
• How You Set Up Forecasting with Supersession Relationships

• How the History Average Measure Is Calculated for the Current Revision and Latest Revision

• Measures for Forecasting Using Supersession Relationships

How You Set Up Forecasting with Supersession Relationships  
This topic describes the high-level process for setting up forecasting with supersession relationships.

1. Define your supersession chains in Oracle Fusion Cloud Product Lifecycle Management or using the file-based
data import (FBDI) template named Supply Chain Planning Item Substitute.

2. Collect your item relationships using one of the following:

◦ The Item Relationships reference entity on the Reference Data subtab on the Parameters tab on the
Collect Planning Data page

◦ The Load Planning Data from Flat Files scheduled process

3. Add these predefined measures to the measure catalog for your plan:

◦ Current Revision

◦ Inventory ID of Latest Item Revision

◦ Item Revision End Date

◦ Item Revision Start Date

◦ Latest Revision

◦ Name of Latest Item Revision

Alternatively, you can use the predefined measure catalog named Supersession Forecasting Catalog in your
plan. This measure catalog contains the previously listed measures along with other measures.

4. Add these forecasting parameters to the forecasting profile used by your plan:

◦ SupersessionForecastLevelMeasure: Select the Inventory ID of Latest Item Revision measure for this
forecasting parameter.

◦ LaunchDateMeasure: Select the Item Revision Start Date measure for this forecasting parameter.

◦ DiscontinueDateMeasure: Select the Item Revision End Date measure for this forecasting parameter.

◦ SmoothIntermittent: Set the value of this forecasting parameter to zero to generate a sparse and spiky
demand forecast.

Otherwise, the forecast generated by intermittent forecasting methods is spread across the time buckets.

Alternatively, you can use the predefined Forecast Bookings for Supersession Chain or Forecast Shipments for
Supersession Chain forecasting profile in your plan. These forecasting profiles use the previously mentioned
forecasting parameters and values.

5. Run your plan with the Refresh with current data option selected on the Parameters tab in the Run Plan dialog
box.
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Related Topics
• Overview of Forecasting Using Supersession Relationships

• Create a Forecasting Profile

• Measures for Forecasting Using Supersession Relationships

How the History Average Measure Is Calculated for the Current
Revision and Latest Revision  
When you run your plan with the Refresh with current data option selected on the Parameters tab in the Run Plan dialog
box, the history average measure is calculated for the current revision and latest (future) revision of an item.

When you run your plan while refreshing it with current data, during the calculation of proportions, a history average is
calculated and forecast status set for each combination in the historical demand. The specific measures that store these
values are determined by the forecasting profile for the plan.

History Average Measure
The history average measure is used for disaggregating a forecast from the level that it's generated at to the level that
it's stored at. This disaggregation results in each combination getting its share of the forecast based on its share of the
historical demand.

Examples of the history average measure are the predefined Bookings History Average and Shipments History Average
measures.

Forecast Status Measure
The forecast status measure identifies which combinations are active and should receive forecasts. The measure values
are 1 (Active), 2 (Inactive/New/Immature), and 3 (Inactive/Retired/Discontinued). Only combinations with a forecast
status of 1 receive forecasts.

Examples of the forecast status measure are the predefined Bookings Forecast Status and Shipments Forecast Status
measures.

Calculation of the History Average Measure for the Current Revision and Latest
Revision
For the current revision, the value of the history average measure from the corresponding, active previous revision in
a supersession chain or across supersession chains is taken. The final value of the measure for the current revision is
calculated according to this formula:

History Average Measure = History Average Measure of the Current Revision Available up to the Plan Start Date +
(Forecast Status Measure of the Previous Revision x History Average Measure of the Previous Revision)

The final value of the history average measure for the current revision is taken as the measure value for the latest
revision.

When the history average measure is computed, the value of the forecast status measure is also changed for the
previous revisions, current revision, and latest revision. The value of the measure is set to 1 for the current revision
and latest revision irrespective of the demand history. The value of the measure is set to 2 for the previous revisions.
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These statuses are set because the current revision and latest revision should receive the forecast, but the superseded
(previous) versions shouldn't receive a forecast.

Note:  Don't use the generate forecast measure (for example, Bookings Forecast Generate Forecast or Shipments
Forecast Generate Forecast) to turn off forecast generation for previous revisions. The value of the forecast status
measure is automatically set to 2 for these revisions after the calculation of the history average measure for the
current revision and latest revision.

Consider an example in which a supersession chain has previous revisions A and B, current revision C, and latest
revision D:

1. For A, the value of the history average measure is 4. The value of the forecast status measure is 2.
2. For B, the value of the history average measure is 7. The value of the forecast status measure is 1.
3. For C, the value of the history average measure available up to the plan start date is 3. The value of the forecast

status measure is 1.

Thus, the final value of the history average measure for C is 10 [3 + (1 * 7)].
4. For D, the value of the history average measure is 10 (the value of the measure for C). The value of the forecast

status measure is 1.
5. After the final values of the history average measure for C and D are calculated, the value of the forecast status

measure for B is set to 2.

The following figure depicts this example:
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Related Topics
• Overview of Forecasting Using Supersession Relationships

• How Statistical Forecasts Are Disaggregated by Default
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Measures for Forecasting Using Supersession Relationships  
Predefined measures are available for use in forecasting with supersession relationships.

This table lists the predefined measures for forecasting with supersession relationships:

Name Description

Current Revision Contains 1 if an item revision is current as of today for a supersession chain. Otherwise, the value is
zero.

Inventory ID of Latest Item Revision Contains the inventory ID for the latest (future) revision of an item in a supersession chain.

Item Revision End Date Contains the effective end date for the revision of an item in a supersession chain.

Item Revision Start Date Contains the effective start date for the revision of an item in a supersession chain.

Latest Revision Contains 1 if an item revision is the latest (future) revision for a supersession chain. Otherwise, the
value is zero.

Name of Latest Item Revision Contains the name of the latest (future) revision of an item in a supersession chain.

The predefined measure catalog named Supersession Forecasting Catalog contains these measures.

Related Topics
• Overview of Forecasting Using Supersession Relationships

Use the Product Lifecycle Management Page Layout  

Overview of the Product Lifecycle Management Page Layout  
The Product Lifecycle Management page layout helps you to manage product introductions and retirements. On this
page layout, you can modify launch dates and discontinuation dates for products, while increasing or reducing baseline
forecasts.

The introduction or retirement of a product often affects the demand for a related product. When the product
introduction reduces the demand for the related product, the effect is termed as the cannibalization effect. When the
product introduction increases the demand for the related product, the effect is termed as the halo effect.

Using this page layout along with predefined forecasting profiles in demand, demand and supply, replenishment, and
sales and operations plans, you can do the following:

• Generate forecasts while allowing for the cannibalization or halo effect.

• Plan for cannibalization of existing products, and avoid revenue loss.

• Plan for the increased demand for related products on account of the halo effect.
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Note:  The page layout isn’t available in the Planning Central work area.

Description of the Page Layout
The Product Lifecycle Management page layout consists of two panes:

• The top pane displays the predefined Manage Product Life Cycle by Item and Date table, using which you can
modify the launch and discontinuation dates for products.

• The bottom pane displays the predefined Manage Forecast During Product Life Cycle table, using which you
can modify the shipments or bookings forecast for products.

By default, both tables display products under the Category level 1 level of the Product hierarchy in the Product
dimension.

The top table is dynamically linked to the bottom table; the former passes the highlighted selection in the Category level
1 level to the latter.

Note:  If your products are in a different Product dimension level, you need to make a copy of the page layout and
its tables, modify the Product dimension level for the table copies, and ensure that the top table dynamically passes
the highlighted selection in the required Product dimension level to the bottom table. You can’t make changes to
predefined page layouts or the hierarchy levels and links of predefined tables.

Measures for Managing Dates for Product Lifecycle Management
The measures you use for managing dates in this page layout are as follows:

• Launch Date: Use this measure to store the date when the product is available for sale in the market. The value
for this measure is collected or imported through the file-based data import (FBDI) template for Supply Chain
Planning measures.

• Adjusted Launch Date: Use this measure to modify the date when the product is available for sale in the market.
You can modify this measure on the page layout.

• Final Launch Date: This measure displays the final value for the date when the product is available for sale
in the market. If the Adjusted Launch Date measure contains a value, that value is displayed by the Final
Launch Date measure. Otherwise, the value of the Launch Date measure is displayed by the Final Launch Date
measure.

The Final Launch Date measure is the default value for the LaunchDateMeasure forecasting parameter of
the Forecast Bookings Including Product Life Cycle and Forecast Shipments Including Product Life Cycle
forecasting profiles.

• Discontinuation Date: Use this measure to store the date when the product is no longer available for sale in
the market. The value for this measure is collected or imported through the FBDI template for Supply Chain
Planning measures.

• Adjusted Discontinuation Date: Use this measure to modify the date when the product is no longer available for
sale in the market. You can modify this measure on the page layout.

• Final Discontinuation Date: This measure displays the final value for the date when the product is no longer
available for sale in the market. If the Adjusted Discontinuation Date measure contains a value, that value is

255



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 11
Statistical Forecasts

displayed by the Final Discontinuation Date measure. Otherwise, the value of the Discontinuation Date measure
is displayed by the Final Discontinuation Date measure.
The Final Discontinuation Date measure is the default value for the DiscontinueDateMeasure forecasting
parameter of the Forecast Bookings Including Product Life Cycle and Forecast Shipments Including Product Life
Cycle forecasting profiles.

Measures for Managing Forecasts for Product Lifecycle Management

Note:  By default, the predefined Manage Forecast During Product Life Cycle table displays shipments forecast
measures. If you want to generate a forecast that’s based on historical bookings, you need to click View > Measures >
Manage Measures, select the hidden and visible measures according to your requirement, and save the table layout.

The measures you use for managing the shipments forecast in this page layout are as follows:

• Shipments Forecast: This measure is the output measure for the predefined Forecast Shipments Including
Product Life Cycle forecasting profile. The measure stores the shipments forecast that's based on shipments
history.

• Adjusted Shipments Forecast: Use this measure to modify the shipments forecast for the product by using a
number. You can modify this measure on the page layout.

• Change to Shipments Forecast Percentage: Use this measure to modify the shipments forecast for the product
by using a percentage. You can modify this measure on the page layout.
For example, to increase the shipments forecast by 75%, enter 0.75 for the Change to Shipments Forecast
Percentage measure. To decrease the shipments forecast by 25%, enter -0.25 for the Change to Shipments
Forecast Percentage measure.

• Final Shipments Forecast: This measure displays the final value for the shipments forecast and is dynamically
updated in the Manage Forecast During Product Life Cycle table. If the Adjusted Shipments Forecast measure
contains a value, it’s displayed by the Final Shipments Forecast measure. If the Change to Shipments Forecast
Percentage measure contains a value, the calculated value is displayed by the Final Shipments Forecast
measure. Otherwise, the value of the Shipments Forecast measure is displayed by the Final Shipments Forecast
measure.
If both the Adjusted Shipments Forecast and Change to Shipments Forecast Percentage measures contain
values, the percentage of the value in the Adjusted Shipments Forecast measure is calculated and displayed by
the Final Shipments Forecast measure.

The measures you use for managing the bookings forecast in this page layout are as follows:

• Bookings Forecast: This measure is the output measure for the predefined Forecast Bookings Including Product
Life Cycle forecasting profile. The measure stores the bookings forecast that's based on bookings history.

• Adjusted Bookings Forecast: Use this measure to modify the bookings forecast for the product by using a
number. You can modify this measure on the page layout.

• Change to Bookings Forecast Percentage: Use this measure to modify the bookings forecast for the product by
using a percentage. You can modify this measure on the page layout.
For example, to increase the bookings forecast by 75%, enter 0.75 for the Change to Bookings Forecast
Percentage measure. To decrease the bookings forecast by 25%, enter -0.25 for the Change to Bookings
Forecast Percentage measure.

• Final Bookings Forecast: This measure displays the final value for the bookings forecast and is dynamically
updated in the Manage Forecast During Product Life Cycle table. If the Adjusted Bookings Forecast measure
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contains a value, it’s displayed by the Final Bookings Forecast measure. If the Change to Bookings Forecast
Percentage measure contains a value, the calculated value is displayed by the Final Bookings Forecast measure.
Otherwise, the value of the Bookings Forecast measure is displayed by the Final Bookings Forecast measure.

If both the Adjusted Bookings Forecast and Change to Bookings Forecast Percentage measures contain values,
the percentage of the value in the Adjusted Bookings Forecast measure is calculated and displayed by the Final
Bookings Forecast measure.

Forecasting Profiles for Product Lifecycle Management
You use these predefined forecasting profiles for managing product life cycles:

• Forecast Shipments Including Product Life Cycle: This forecasting profile generates a forecast on the basis of
historical shipments and the Final Launch Date and Final Discontinuation Date measures.

The forecasting profile is available for demand, demand and supply, replenishment, and sales and operations
plans.

• Forecast Bookings Including Product Life Cycle: This forecasting profile generates a forecast on the basis of
historical bookings and the Final Launch Date and Final Discontinuation Date measures.

The forecasting profile is available for demand, demand and supply, and sales and operations plans.

Other Points to Note
Note these other points about the functionality for managing the product life cycle:

• If the Final Launch Date measure doesn’t contain a value or isn’t present in the plan’s measure catalog, the
forecast is generated from the forecast start date of the plan.

The plan’s forecast start date is used if it’s later than the value of the Final Launch Date measure.

• If the Final Discontinuation Date measure doesn’t contain a value or isn’t present in the plan’s measure catalog,
the forecast is generated till the forecast end date of the plan.

The plan’s forecast end date is used if it’s earlier than the value of the Final Discontinuation Date measure.

• If the date in the Final Launch Date measure is later than the date in the Final Discontinuation Date measure,
both measures are ignored, and the forecast is generated from the plan’s forecast start date to the plan’s
forecast end date.

• Optionally, you can use an override label for the Change to Shipments Forecast Percentage or Change to
Bookings Forecast Percentage measure in the Manage Forecast During Product Life Cycle table so that the
functionality of the page layout is better reflected. For example, you can use Launch and Cannibalization Factor
as the override label in the Format Measures dialog box.

Related Topics
• Work with Page Layouts in Replenishment Planning

• Create a Forecasting Profile

• How You Generate Forecasts While Managing Product Life Cycles

• Work with Page Layouts in Demand Management

• Manage Page Layouts in Sales and Operations Planning
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How You Generate Forecasts While Managing Product Life Cycles  
To generate forecasts for your products while managing their life cycles, you can use the Product Lifecycle Management
page layout in your demand, demand and supply, replenishment, or sales and operations plan.

The following is the high-level procedure for forecasting for your products while using this page layout:

1. Set up your plan.
Include the predefined Forecast Bookings Including Product Life Cycle or Forecast Shipments Including Product Life
Cycle forecasting profile in your plan.

2. Perform the collections process or use the file-based data import (FBDI) templates for importing data.
Collect or import values for the Launch Date and Discontinuation Date measures for your products.

3. Do the following:

◦ If you want to generate the forecast on the basis of historical bookings, in the table, make the bookings
forecast measures visible, and hide the shipments forecast measures.

◦ If your products in your plan are in a different Product dimension level than what’s used in the tables, do
the following:

- Make a copy of the page layout.
- Make copies of the page layout’s tables, and select or hide the shipments forecast or bookings

forecast measures as you require.
- Change the Product dimension level for the copied tables.
- Ensure that the copy of the Manage Product Life Cycle by Item and Date table is dynamically linked

to the copy of the Manage Forecast During Product Life Cycle table, and that the top table passes the
highlighted selections in the required Product dimension level to the bottom table.

4. Run the plan.
5. Open the plan, and view the information in the copy of the page layout.
6. If you’re generating a forecast using shipments history, enter a value in the Adjusted Shipments Forecast or Change

to Shipments Forecast Percentage measure to view the result in the Final Shipments Forecast measure. Save your
changes in the table layout.
If you’re generating a forecast using bookings history, enter a value in the Adjusted Bookings Forecast or Change
to Bookings Forecast Percentage measure to view the result in the Final Bookings Forecast measure. Save your
changes in the table layout.

7. If you must modify the launch date for a product, enter a value in the Adjusted Launch Date measure to view the
final date in the Final Launch Date measure. Save your changes in the table layout.
If you must modify the discontinuation date for a product, enter a value in the Adjusted Discontinuation Date
measure to view the final date in the Final Discontinuation Date measure. Save your changes in the table layout.
Run the plan again to view the forecasts for the required periods for your products.
If required, modify the value in the Adjusted Bookings Forecast, Change to Bookings Forecast Percentage, Adjusted
Shipments Forecast, or Change to Shipments Forecast Percentage measure. Save your changes in the table layout.
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Related Topics
• Overview of the Product Lifecycle Management Page Layout

• Work with Page Layouts in Replenishment Planning

• Create a Forecasting Profile

• Work with Page Layouts in Demand Management

• Manage Page Layouts in Sales and Operations Planning

How You Forecast Product Returns  
This topic explains how you can forecast product returns using forecasting profiles that are based on Bayesian machine
learning.

If you must forecast product returns, Oracle recommends that you create two positive history streams, one for product
demand and the other for product returns. Product sales and product returns don't necessarily occur in the same time
buckets, so modeling two separate history streams is advisable. After you forecast the product demand and product
returns with separate forecasting profiles, you can deduct the returns from the demand through a calculated measure.

You can import returns history only by using the file-based data import (FBDI) template for bookings history or
shipments history. You can't collect returns history from other Oracle applications.

Note:  Oracle doesn't recommend that you import negative values using the FBDI template for bookings history or
shipments history to forecast product demand and product returns in one history stream. If you import negative
values, they're set to zero during the forecasting process.

How You Generate Forecasts from a Product Launch
Date  
This topic explains how you can generate a forecast for a new product starting from its launch date.

How to Set Up This Feature
Do the following to set up this feature:

• Load a launch date into the predefined Launch Date measure using the file-based data import (FBDI) template
for Supply Chain Planning measures.
Alternatively, you can manually enter a launch date into the predefined Adjusted Launch Date measure. You
can also use this measure to override the imported value in the Launch Date measure.

• Add the LaunchDateMeasure forecasting parameter to your user-defined forecasting profile that's based on
Bayesian machine learning.
This forecasting parameter is in the General Settings category in the Add Parameter to Viewable List dialog box.
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Note:  You can't use this forecasting parameter in a forecasting profile that uses feature-based machine
learning. You also can't add this forecasting parameter to a predefined forecasting profile.

• Select the predefined Final Launch Date measure or a user-defined measure for the forecasting parameter.

This measure returns the value of the Adjusted Launch Date measure if it has a value. Otherwise, the Final
Launch Date measure returns the value of the Launch Date measure.

• Optionally, add the Final Launch Date, Adjusted Launch Date, and Launch Date measures to a table so that you
can view and adjust the data.

The forecasting process uses the value of the measure selected for the LaunchDateMeasure forecasting
parameter even if the measure isn't present in a table.

Points to Consider
Note these points while using this feature:

• Ensure the following if you create a measure to use instead of the Final Launch Date measure:

◦ The measure has the same dimensions as those of the output measure of the forecasting profile except
for the Time dimension.

◦ You enable the measure for the work areas for which the forecasting profile is enabled.

◦ The measure is in the measure catalog for the plan.

• The forecast is generated from the start of the forecasting horizon if these conditions are met:

◦ The selected measure for the LaunchDateMeasure forecasting parameter doesn't contain a date.

◦ The launch date is before the forecast start date.

• If the launch date falls within a time bucket, the beginning of the time bucket is taken as the launch date.

• The launch date is respected at the lowest level of the forecasting tree of your forecasting profile. For example,
if the lowest level is a combination of the Item and Organization levels, the forecast starts on the same launch
date for all customers and demand classes within the same item-organization combination. If the launch date
varies by customer or demand class within the item-organization combination, the earliest launch date is used.

To respect varying launch dates by customers for the same item, configure your forecast tree with the Product
and Customer dimensions so that the lowest level is a combination of the Item and Customer Site levels.

Related Topics
• Forecasting Parameters

• Overview of Forecast Trees

• How You Stop Forecasts from a Product Discontinuation Date

260



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 11
Statistical Forecasts

How You Stop Forecasts from a Product Discontinuation
Date  
This topic explains how you can stop a forecast for a product starting from a discontinuation date.

How to Set Up This Feature
Do the following to set up this feature:

• Load a discontinuation date into the predefined Discontinuation Date measure using the file-based data import
(FBDI) template for Supply Chain Planning measures.

Alternatively, you can manually enter a discontinuation date into the predefined Adjusted Discontinuation Date
measure. You can also use this measure to override the imported value in the Discontinuation Date measure.

• Add the DiscontinueDateMeasure forecasting parameter to your user-defined forecasting profile that's based
on Bayesian machine learning.

This forecasting parameter is in the General Settings category in the Add Parameter to Viewable List dialog box.

Note:  You can't use this forecasting parameter in a forecasting profile that uses feature-based machine
learning. You also can't add this forecasting parameter to a predefined forecasting profile.

• Select the predefined Final Discontinuation Date measure or a user-defined measure for the forecasting
parameter.

This measure returns the value of the Adjusted Discontinuation Date measure if it has a value. Otherwise, the
Final Discontinuation Date measure returns the value of the Discontinuation Date measure.

• Optionally, add the Final Discontinuation Date, Adjusted Discontinuation Date, and Discontinuation Date
measures to a table so that you can view and adjust the data.

The forecasting process uses the value of the measure selected for the DiscontinueDateMeasure forecasting
parameter even if the measure isn't present in a table.

Points to Consider
Note these points while using this feature:

• Ensure the following if you create a measure to use instead of the Final Discontinuation Date measure:

◦ The measure has the same dimensions as those of the output measure of the forecasting profile except
for the Time dimension.

◦ You enable the measure for the work areas for which the forecasting profile is enabled.

◦ The measure is in the measure catalog for the plan.

• The forecast is generated through the end of the forecasting horizon if these conditions are met:

◦ The selected measure for the DiscontinueDateMeasure forecasting parameter doesn't contain a date.
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◦ The discontinuation date is after the forecast end date.

• If the discontinuation date falls within a time bucket, the beginning of the time bucket is taken as the
discontinuation date.

• The discontinuation date is respected at the lowest level of the forecasting tree of your forecasting profile. For
example, if the lowest level is a combination of the Item and Organization levels, the forecast stops on the same
discontinuation date for all customers and demand classes within the same item-organization combination.
If the discontinuation date varies by customer or demand class within the item-organization combination, the
latest discontinuation date is used.

To respect varying discontinuation dates by customers for the same item, configure your forecast tree with
the Product and Customer dimensions so that the lowest level is a combination of the Item and Customer Site
levels.

Related Topics
• Forecasting Parameters

• Overview of Forecast Trees

• How You Generate Forecasts from a Product Launch Date

How You Analyze Forecast Consumption  
This topic explains how you can use the Past Due Gross Forecast measure to analyze forecast consumption in your
replenishment plan. By using this measure, you can better understand how forecast is consumed before the plan start
date.

You can specify optimal values for the Past Due Forecast Days and Past Due Sales Order Days fields on the
Organizations tab on the Maintain Supply Network Model page by understanding the forecast consumption process.

In the rest of this topic, the use of this measure is explained, and some related points are provided.

Use the Past Due Gross Forecast Measure
Consider an example in which the value of the Past Due Forecast Days field is 3, the value of the Past Due Sales Order
Days field is 3, and the plan start date is March 15.

The initial calculations for various measures when the replenishment plan is run and which aren't visible are listed in this
table:

Measure March 12 March 13 March 14 March 15 March 16 March 17 March 18

Gross Forecast
 

10
 

20
 

15
 

15
 

20
 

10
 

25
 

Net Forecast
 

0
 

8
 

15
 

15
 

20
 

10
 

25
 

Sales Orders
 

0
 

15
 

0
 

0
 

7
 

0
 

0
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The final calculations for various measures when the replenishment plan is run and which are visible are listed in this
table:

Measure March 12 March 13 March 14 March 15 March 16 March 17 March 18

Final Shipments
Forecast
 

10
 

20
 

15
 

15
 

20
 

10
 

25
 

Gross Forecast
 

0
 

0
 

0
 

15
 

20
 

10
 

25
 

Past Due Gross
Forecast
 

0
 

0
 

0
 

45
 

0
 

0
 

0
 

Net Forecast
 

0
 

0
 

0
 

38
 

20
 

10
 

25
 

Sales Orders
 

0
 

0
 

0
 

15
 

7
 

0
 

0
 

Total Demand
 

0
 

0
 

0
 

53
 

27
 

10
 

25
 

These points explain how you use the Past Due Gross Forecast measure to understand how the gross forecast is
consumed:

• When the replenishment plan is run on March 15, as shown in the first table, the sales orders of 22 units (15 + 7)
consume 10 units of the gross forecast on March 12 and 12 on March 13. After this consumption, the net forecast
is set to 8 units on March 13.

• When the replenishment plan is run on March 15, note these calculations in the second table:

◦ The past due net forecast is moved to that date and calculated as 38 units (8 + 15+ 15).

◦ The gross forecast is always shown from the current date and is 15 units on March 15.

◦ The Past Due Gross Forecast measure sums up the gross forecast before the plan start date and is 45
units (10 + 20 + 15) on March 15.

• For clarity, you can calculate the total gross forecast as 60 units on March 15 (45 units for the Past Due Gross
Forecast measure and 15 units for the Gross Forecast measure). When you subtract the sales orders of 22 units
from the total gross forecast of 60 units, you get a figure of 38, which is the value of the net forecast.

Additional Information About the Use of the Past Due Gross Forecast
Measure
Note these points about the use of the Past Due Gross Forecast measure:

• If you're using a user-defined measure catalog, add this measure to the catalog.

• Only forecasts that are after the start of the current plan bucket but before the plan start date are considered in
the measure calculation.

Forecasts that are before the start of the current plan bucket but within the past due forecast days aren't
considered in the measure calculation.
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• Open sales orders that are before the start of the current plan bucket but within the past due sales order days
are carried over to the plan start date. These sales orders don't consume the forecast of the current bucket.

• The past due forecast days and past due sales order days should be set to meaningful values.

If no values are specified for these fields, the values are considered to be zero.

Forecast Processing in Replenishment Plans  

Overview of Forecast Processing in Replenishment Plans  
This topic explains how forecasts are spread to individual working days within replenishment plans and consumed by
sales orders, movement request demands, and transfer order demands before replenishment orders are calculated.

Points About Forecast Processing
Note these points about how forecasts are spread and consumed in replenishment plans:

• The forecast can be provided through the same or another replenishment plan, a demand plan, or an external
forecast schedule.

• The forecast is spread to individual working days and consumed by sales orders, movement request demands,
and transfer order demands before replenishment orders are calculated. Thus, duplication of demand is
avoided.

• When the spreading is done, the forecast for nonworking days is aggregated and moved to the previous
working day.

• For the daily, weekly, or period planning time levels, the forecast is spread and consumed within weeks.

For the monthly planning time level, the forecast is spread and consumed within months.

• All available open and shipped sales orders, transfer order demands, and movement request demands are
aggregated within the week or month, and the forecast is consumed from the first day of the week or month.

• Past due sales orders are considered according to the value of the Past Due Sales Order Days field on
the Organizations tab on the Maintain Supply Network Model page and moved to the plan start date for
consumption of the forecast.

• Past due forecast is considered according to the value of the Past Due Forecast Days field on the
Organizations tab on the Maintain Supply Network Model page. However, the past due forecast is considered
from only the start of the current week or month.

The past due forecast for consideration is brought to the plan start date and stored in the Past Due Gross
Forecast measure.

• The spread forecast is stored in the Gross Forecast measure, and the final forecast after consumption is stored
in the Net Forecast measure.

• The organization's manufacturing calendar is used during forecast processing for an item-location
combination.

• Demand time fences aren't supported in Replenishment Planning and hence not considered during forecast
processing.
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• The forecast processing functionality is enabled by default.

Process Flow for Forecast Processing
This section describes the process for forecast processing.

As depicted in the flow chart, the forecast is processed along with the sales orders, movement request demands,
and transfer order demands. The consumed forecast is subtracted from the spread forecast for calculation of the net
forecast. Finally, the replenishment orders are calculated.

Related Topics
• Scope Plan Options for Replenishment Plans

• How You Analyze Forecast Consumption

Examples of Forecast Processing in Replenishment Plans  
This topic provides examples of forecast processing in replenishment plans with various planning time levels,
forecasting time levels, and calendars.
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Example 1
In this example, the replenishment plan has a daily planning time level and forecasting time level. In the manufacturing
calendar for the item-location combination, all days of the week are working days.

Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12 Day 13 Day 14

Demand
Forecast
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

15
 

15
 

15
 

15
 

15
 

15
 

15
 

Spread
Forecast
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

15
 

15
 

15
 

15
 

15
 

15
 

15
 

Sales
Orders
 

0
 

0
 

30
 

0
 

5
 

0
 

0
 

20
 

0
 

5
 

0
 

0
 

0
 

0
 

Net
Forecast
 

0
 

0
 

0
 

5
 

10
 

10
 

10
 

0
 

5
 

15
 

15
 

15
 

15
 

15
 

Total
Demand
 

0
 

0
 

30
 

5
 

15
 

10
 

10
 

20
 

5
 

20
 

15
 

15
 

15
 

15
 

Note these points:

• The sales orders start consuming the forecast from Day 1.

• The sales orders of 30 units on Day 3 consume the spread forecast (stored in the Gross Forecast measure) on
Days 1 through 3. The net forecast is zero on Days 1 through 3.

• The sales orders of 5 units on Day 5 consume the spread forecast on Day 4. The net forecast is 5 units on Day 4.

• The sales orders of 20 units on Day 8 consume the spread forecast on Days 8 and 9. The net forecast is zero on
Day 8 and 10 units on Day 9.

• The sales orders of 5 units on Day 10 consume the remaining spread forecast of 10 units on Day 9. The net
forecast on Day 9 is 5 units, and the spread forecast and net forecast on Day 10 remain unchanged.

Example 2
In this example, the replenishment plan has a daily planning time level and forecasting time level. In the manufacturing
calendar for the item-location combination, only five days of the week are working days.

Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12 Day 13 Day 14

Demand
Forecast
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

15
 

15
 

15
 

15
 

15
 

15
 

15
 

Spread
Forecast
 

10
 

10
 

10
 

10
 

30
 

0
 

0
 

15
 

15
 

15
 

15
 

45
 

0
 

0
 

Sales
Orders

0
 

0
 

30
 

0
 

5
 

0
 

0
 

20
 

0
 

5
 

0
 

0
 

0
 

0
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Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12 Day 13 Day 14

 

Net
Forecast
 

0
 

0
 

0
 

5
 

30
 

0
 

0
 

0
 

5
 

15
 

15
 

45
 

0
 

0
 

Total
Demand
 

0
 

0
 

30
 

5
 

35
 

0
 

0
 

20
 

5
 

20
 

15
 

45
 

0
 

0
 

Note these points:

• The sales orders of 30 units on Day 3 consume the spread forecast (stored in the Gross Forecast measure) on
Days 1 through 3. The net forecast is zero on Days 1 through 3.

• The sales orders of 5 units on Day 5 consume the spread forecast on Day 4. The net forecast is 5 units on Day 4.

• Days 6 and 7 are nonworking days, and the spread forecast for these days is added to that on Day 5 (10 + 10 +
10).

• The sales orders of 20 units on Day 8 consume the spread forecast on Days 8 and 9. The net forecast is zero on
Day 8 and 10 units on Day 9.

• The sales orders of 5 units on Day 10 consume the remaining spread forecast of 10 units on Day 9. The net
forecast on Day 9 is five units, and the spread forecast and net forecast on Day 10 remain unchanged.

• Days 13 and 14 are nonworking days, and the spread forecast for these days is added to that on Day 12 (15 + 15 +
15).

Example 3
In this example, the replenishment plan has a daily planning time level and weekly forecasting time level. In the
manufacturing calendar for the item-location combination, all days of the week are working days.

Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12 Day 13 Day 14

Demand
Forecast
 

0
 

0
 

0
 

0
 

0
 

0
 

70
 

0
 

0
 

0
 

0
 

0
 

0
 

105
 

Spread
Forecast
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

15
 

15
 

15
 

15
 

15
 

15
 

15
 

Sales
Orders
 

0
 

0
 

30
 

0
 

5
 

0
 

0
 

20
 

0
 

5
 

0
 

0
 

0
 

0
 

Net
Forecast
 

0
 

0
 

0
 

5
 

10
 

10
 

10
 

0
 

5
 

15
 

15
 

15
 

15
 

15
 

Total
Demand
 

0
 

0
 

30
 

5
 

15
 

10
 

10
 

20
 

5
 

20
 

15
 

15
 

15
 

15
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Note these points:

• The demand forecast for 70 units in the first week is spread across seven days (10 units per day).

• The sales orders of 30 units on Day 3 consume the spread forecast (stored in the Gross Forecast measure) on
Days 1 through 3. The net forecast is zero on Days 1 through 3.

• The sales orders of 5 units on Day 5 consume the spread forecast on Day 4. The net forecast is 5 units on Day 4.

• The demand forecast for 105 units in the second week is spread across seven days (15 units per day).

• The sales orders of 20 units on Day 8 consume the spread forecast on Days 8 and 9. The net forecast is zero on
Day 8 and 10 units on Day 9.

• The sales orders of 5 units on Day 10 consume the remaining spread forecast of 10 units on Day 9. The net
forecast on Day 9 is five units, and the spread forecast and net forecast on Day 10 remain unchanged.

Example 4
In this example, the replenishment plan has a daily planning time level and forecasting time level. In the manufacturing
calendar for the item-location combination, all days of the week are working days. The values of the Past Due Forecast
Days and Past Due Sales Order Days fields on the Organizations tab on the Maintain Supply Network Model page for
the organization are 2. The replenishment plan is run on Day 4.

Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12 Day 13 Day 14

Demand
Forecast
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

15
 

15
 

15
 

15
 

15
 

15
 

15
 

Spread
Forecast
 

0
 

0
 

0
 

30
 

10
 

10
 

10
 

15
 

15
 

15
 

15
 

15
 

15
 

15
 

Sales
Orders
 

0
 

0
 

30
 

0
 

5
 

0
 

0
 

20
 

0
 

5
 

0
 

0
 

0
 

0
 

Net
Forecast
 

0
 

0
 

0
 

0
 

5
 

10
 

10
 

0
 

5
 

15
 

15
 

15
 

15
 

15
 

Total
Demand
 

0
 

0
 

0
 

30
 

10
 

10
 

10
 

20
 

5
 

20
 

15
 

15
 

15
 

15
 

Note these points:

• The spread forecast (stored in the Gross Forecast measure) on Days 2 through 3 is carried over to Day 4, which
is the plan start date. The total spread forecast on Day 4 is 30 (10 + 10 + 10). The spread forecast on Day 1 isn't
considered because the Past Due Forecast Days field is set to 2.

On Day 4, the value of the Gross Forecast measure is 10 units, and the value of the Past Due Gross Forecast
measure is 20 units.

• The sales orders of 30 units on Day 3 are carried over to Day 4, which is the plan start date.

The sales orders of 30 units on Day 4 consume the spread forecast on Day 4. The net forecast is zero units on
Day 4.
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• The sales orders of 5 units on Day 5 consume the spread forecast on Day 5. The net forecast is 5 units on Day 5.

• The sales orders of 20 units on Day 8 consume the spread forecast on Days 8 and 9. The net forecast is zero on
Day 8 and 10 units on Day 9.

• The sales orders of 5 units on Day 10 consume the remaining spread forecast of 10 units on Day 9. The net
forecast on Day 9 is five units, and the spread forecast and net forecast on Day 10 remain unchanged.

Example 5
In this example, the replenishment plan has a weekly planning time level and forecasting time level. In the
manufacturing calendar for the item-location combination, all days of the week are working days.

Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12 Day 13 Day 14

Demand
Forecast
 

0
 

0
 

0
 

0
 

0
 

0
 

70
 

0
 

0
 

0
 

0
 

0
 

0
 

105
 

Spread
Forecast
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

15
 

15
 

15
 

15
 

15
 

15
 

15
 

Sales
Orders
 

0
 

0
 

30
 

0
 

5
 

0
 

0
 

20
 

0
 

5
 

0
 

0
 

0
 

0
 

Net
Forecast
 

0
 

0
 

0
 

5
 

10
 

10
 

10
 

0
 

5
 

15
 

15
 

15
 

15
 

15
 

Weekly
Net
Forecast
 

0
 

0
 

0
 

0
 

0
 

0
 

35
 

0
 

0
 

0
 

0
 

0
 

0
 

80
 

Total
Demand
 

0
 

0
 

0
 

0
 

0
 

0
 

70
 

0
 

0
 

0
 

0
 

0
 

0
 

105
 

Note these points:

• The demand forecast for 70 units in the first week is spread across seven days (10 units per day).

• The sales orders of 30 units on Day 3 consume the spread forecast (stored in the Gross Forecast measure) on
Days 1 through 3. The net forecast is zero on Days 1 through 3.

• The sales orders of 5 units on Day 5 consume the spread forecast on Day 4. The net forecast is 5 units on Day 4.

• The demand forecast for 105 units in the second week is spread across seven days (15 units per day).

• The sales orders of 20 units on Day 8 consume the spread forecast on Days 8 and 9. The net forecast is zero on
Day 8 and 10 units on Day 9.

• The sales orders of 5 units on Day 10 consume the remaining spread forecast of 10 units on Day 9. The net
forecast on Day 9 is five units, and the spread forecast and net forecast on Day 10 remain unchanged.

• The net forecast is aggregated at the ends of the weekly buckets.
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Related Topics
• How You Analyze Forecast Consumption
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12  Replenishment Plans

Create a Replenishment Plan  
This topic explains how you create a replenishment plan in the Replenishment Planning work area.

To create the replenishment plan, follow these steps:

1. Do one of the following:

◦ To create the replenishment plan from the Manage Plans page:

i. On the Tasks panel tab, under Plans, select Manage Plans.

The Manage Plans page opens.
ii. Under Search Results, click Actions > Create.

The Plan Options page opens.

◦ To directly create the replenishment plan, on the Plans panel tab, select Plans, and click Actions > Create,
or right-click Plans, and select Create.

The Plan Options page opens.
2. Enter the name and description of the replenishment plan.
3. To make the replenishment plan measures available for reporting in Oracle Transactional Business Intelligence

(OTBI), select the Enable for OTBI reporting check box.

Note:  The check box is grayed out if you select a subinventory as a level member. OTBI reporting isn't
supported for subinventories.

4. Define the access level.

◦ Select Public to make the replenishment plan available to all users.

◦ Select Private to make the replenishment plan accessible to only yourself or other users to whom you
want to provide access.

If you select Private, the Edit Users icon is enabled. Click this icon to open the Users dialog box in which
you can edit the list of users who can access the replenishment plan.

5. In Owner, select the replenishment plan's owner.
6. Select the check boxes:

Check Box Feature

Enable for incremental planning
 

Select this check box to process only those item-location combinations with net changes in
supplies and demands in subsequent plan runs after the initial plan run.
 
This check box can be used with only the Calculate replenishments check box.
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Check Box Feature

Generate forecast
 

Select this check box to use the replenishment plan to generate the demand forecast.
 
If you select this check box, the Demand tab is enabled, and you must select a forecasting
profile on that tab for the replenishment plan.
 
If you don't select this check box, you can use a demand plan, another replenishment plan that
has the Generate forecast check box selected, or an external forecast schedule for the demand
forecast. Under Demand Schedules on the Organizations and Schedules subtab on the Supply
tab on the Plan Options page, select the demand plan, replenishment plan, or external forecast
schedule, and select the check box under Use for Demand Schedule.
 

Calculate policy parameters
 

Select this check box to use the replenishment plan to calculate policy parameters.
 
If you select only this check box, then under Demand Schedules on the Organizations and
Schedules subtab on the Supply tab, you must select another replenishment plan that has the
Generate forecast check box selected, a demand plan, or an external forecast schedule, and
select the check box under Use for Demand Schedule.
 
If you don't select this check box, you can use another replenishment plan that has the
Calculate policy parameters check box selected for calculating policy parameters. Under
Demand Schedules on the Organizations and Schedules subtab on the Supply tab, select the
replenishment plan, and select the check box under Use for Policy Parameters.
 

Calculate replenishments
 

Select this check box to use the replenishment plan to calculate replenishments.
 
If you select only this check box, then under Demand Schedules on the Organizations and
Schedules subtab on the Supply tab, you must select another replenishment plan that has
the Calculate policy parameters check box selected, and select the check box under Use for
Policy Parameters.
 

Rebalance inventory
 

Select this check box to use the replenishment plan to rebalance inventory.
 
If you select this check box, the following happen:
 

◦ The Inventory Rebalancing tab is enabled, and you can specify the clusters, rules, and
supplies and demands for inventory rebalancing on the tab.

◦ The Enable for incremental planning check box is grayed out.

◦ The Enable for policy comparison check box is grayed out in the Scope: Advanced
Options dialog box that you open from the Scope tab on the Plan Options page.

If you select only this check box, then under Demand Schedules on the Organizations and
Schedules subtab on the Supply tab, you must select another replenishment plan that has
the Calculate policy parameters check box selected, and select the check box under Use for
Policy Parameters.
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Check Box Feature

 

To create an integrated replenishment plan, select the Generate forecast, Calculate policy parameters,
Calculate replenishments, and Rebalance inventory check boxes.

Refer to other topics in this chapter for information about the Scope, Demand, Supply, and Inventory Rebalancing tabs
on the Plan Options page.

Related Topics
• Best Practices for Setting Up Replenishment Plans

Open a Replenishment Plan  
You can open a replenishment plan using the Manage Plans page or Plans panel tab.

You can open only those replenishment plans that have been successfully run. Replenishment plans that haven't
been run must be run before they can be viewed. For replenishment plans that haven't been successfully run,
you must troubleshoot them and successfully run them before you can open them. Review the plan messages for
troubleshooting.

Once you open replenishment plans, you can view their data and perform other actions.

On the Manage Plans page, replenishment plans are listed irrespective of their run status. On the Plans panel tab, only
those replenishment plans that have been successfully run are listed.

Do one of the following to open a replenishment plan:

• To open the replenishment plan using the Manage Plans page:

a. On the Tasks panel tab, under Plans, select Manage Plans.

The Manage Plans page opens and displays the available replenishment plans.
b. Select the replenishment plan, and click Actions > Open.

The replenishment plan opens in a separate tab.

• On the Plans panel tab, under Plans, right-click the replenishment plan, and select Open.

The replenishment plan opens in a separate tab.

Copy a Replenishment Plan  
You can make copies of replenishment plans to save time and perform planning activities incrementally.

For example, you have defined the organizations, segments, and policy assignment set for a replenishment plan. You
can make a copy of that replenishment plan if the new replenishment plan uses the same entities.
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Follow these steps to copy the replenishment plan:

1. To open the Duplicate Plan dialog box, do one of the following:

◦ To open the Duplicate Plan dialog box from the Manage Plans page:

i. On the Tasks panel tab, under Plans, select Manage Plans.

The Manage Plans page opens.
ii. Under Search Results, select the replenishment plan that must be copied, and click Actions >

Duplicate.

The Duplicate Plan dialog box opens.

◦ To directly open the Duplicate Plan dialog box, on the Plans panel tab, under Plans, right-click the
replenishment plan that must be copied, and select Duplicate.

The Duplicate Plan dialog box opens.

Only replenishment plans that have been successfully run are displayed on the Plans panel tab.
2. In Copy Type, select one of the following:

◦ Copy plan options only: This choice is for copying the plan options to the new replenishment plan.
However, the plan data isn't copied.

If the source replenishment plan hasn't been successfully run, only this choice is available.

◦ Copy all plan data with no reference to base plan: This choice is for making a full, standalone copy of the
replenishment plan. Both the plan options and plan data are copied.

3. Enter a name and description for the new replenishment plan.
4. Select the access level for the new replenishment plan.

If you select Private, the Users icon is enabled. Click this icon to open the Users dialog box in which you can
edit the list of users who can open the replenishment plan.

5. In Owner, select the owner of the new replenishment plan.
6. Click Save and Close.

View a Replenishment Plan  
You can view a replenishment plan using the Manage Plans page or the Plans panel tab.

On the Manage Plans page, you can view all the replenishment plans regardless of whether they have been successfully
run. You can also search for replenishment plans using various criteria.

On the Plans panel tab, you can view only those replenishment plans that have been successfully run.

Follow these steps to view replenishment plans using the Manage Plans page:

1. On the Tasks panel tab, under Plans, select Manage Plans.

The Manage Plans page opens and displays the available replenishment plans.

You can configure the columns that display information about the replenishment plans.
2. In the Search region, specify the criteria by which you want to search for replenishment plans, and click Search.
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To view replenishment plans using the Plans panel tab, expand Plans on the panel tab.

Manage Plan Options  

Scope Plan Options for Replenishment Plans  
Scope plan options determine the replenishment plan's scope. Define or modify scope plan options on the Scope tab on
the Plan Options page.

The Scope tab includes the following:

• Dimension Catalog field

• Plan Organizations section

• Plan Items section

• Plan Parameters section

Dimension Catalog
In the Dimension Catalog field, select the dimension catalog from which hierarchies are made available for the
replenishment plan.

You can use the predefined Default Replenishment Planning Catalog or a dimension catalog that you have created
for your requirements. The dimension catalog that you use contains the hierarchies that you can select for your
replenishment plan.

Note that Oracle Replenishment Planning doesn't support the Customer or Demand Class dimension. Any dimension
catalog that contains these dimensions isn't available in the Dimension Catalog field.

Plan Organizations
Specify a hierarchy, a level, and level members by which to filter the organizations for the replenishment plan. Only the
Enterprise hierarchy can be selected.

You can select both organizations and subinventories as level members. Subinventories are listed in the
<organization>:<subinventory> format.

Note:  If you select a subinventory as a level member, the Enable for OTBI reporting check box is grayed out.
OTBI reporting isn't supported for subinventories. Subinventories are available for selection only if their parent
organizations are enabled for subinventory-level planning on the Organizations tab on the Maintain Supply Network
Model page.

Also, select the source system to use for filtering legal entities, business units, and organizations. Ensure that the
selected source system is the same as that for the segment group that you select in the Segment Group field under the
Plan Items section.

Plan Items
Select the segment group and segments that must be included in the replenishment plan.
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Only those segment groups for which the segmentation process has been successfully run and that don't use the
Customer or Demand Class dimension are available in the Segment Group field.

Only those item-location combinations belonging to the selected segments and organizations selected as level
members under the Plan Organizations section are included in the replenishment plan scope. Moreover, the MPS and
MRP Planning Method attribute must be set to Replenishment planning for these items. If you selected legal entities or
business units as level members, the organizations in these legal entities or business units are considered.

Note:  The number of combinations of items, locations, and planning time buckets in the replenishment plan can't
exceed 31 million.

Plan Parameters
The following table describes the plan parameters:

Parameter Definition

Planning Calendar
 

Planning calendar.
 
Only those planning calendars that are a part of the selected dimension catalog are available for
selection. Moreover, the planning calendar can be of the fiscal, Gregorian, or organization type.
 
You can select fiscal calendars when only the Generate forecast check box is selected on the Plan
Options page.
 

Planning Time Level
 

Planning time level.
 
The planning time levels you can select are day and month for a fiscal calendar, month for a Gregorian
calendar, and day, week, and period for an organization calendar.
 

Number of Buckets
 

Number of planning time buckets that determines the planning time granularity.
 
The planning time level and number of planning time buckets together determine the planning horizon
that's represented by the plan start date and plan end date on the General subtab on the Supply tab.
 

Policy Assignment Set
 

Policy assignment set for the selected segment group.
 
Policies are calculated on the basis of policy parameters defined in the policy assignment set.
 

Note:
If the Calculate policy parameters check box is selected, you must select a policy assignment set.
 

Measure Catalog
 

Catalog containing measures used in the replenishment plan output.
 
By enabling only those measures that are needed for your replenishment plan, you can perform a
focused analysis with improved performance.
 
If the Enable for incremental planning and Calculate replenishments check boxes are selected on
the Plan Options page, the Incremental Replenishment Planning Default Catalog is selected, and the
field is grayed out.
 

Exception Set Exceptions computed as a part of the replenishment plan.
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Parameter Definition

  
By enabling only required exceptions, you can improve the performance of the replenishment plan.
 
You must create exception sets and exceptions because there aren't any predefined exception sets and
exceptions for Replenishment Planning.
 

Simulation Set
 

Set of adjustments to item attributes.
 
Apply a simulation set to your replenishment plan to model different business scenarios.
 

Related Topics
• How You Set Up Replenishment Planning for Subinventories

• Segmentation in Oracle Replenishment Planning

• Overview of Inventory Rebalancing

• Policy Assignment Sets

Set Up Policy Comparisons and Retain Policy Overrides  
You can compare policies and retain policy overrides for a replenishment plan for which the Calculate policy
parameters check box is selected on the Plan Options page.

Additionally, while the Generate forecast check box may or may not be selected, the Calculate replenishments and
Rebalance inventory check boxes can't be selected.

Follow these steps to set up policy comparisons and retain policy overrides:

1. Open the Plan Options page for the replenishment plan through one of these ways:

◦ Use the Manage Plans page:

i. On the Tasks panel tab, under Plans, select Manage Plans.

The Manage Plans page opens.
ii. Under Search Results, select the replenishment plan that you want to edit, and click Actions > Edit

Plan Options.

◦ On the Plans panel tab, under Plans, right-click the replenishment plan that you want to edit, and select
Edit Plan Options.

2. On the Scope tab of the Plan Options page, click Select Advanced Options.

The Scope: Advanced Options dialog box opens.
3. Select the Enable for policy comparison check box.

The Threshold Percentage for Policy Comparison field and Retain policy overrides check box are enabled.
4. In the Threshold Percentage for Policy Comparison field, enter the deviation percentage for automatically

accepting newly calculated policy parameters.

If the deviation percentage between a newly calculated policy parameter and an existing policy parameter is
less than the threshold value, the newly calculated policy parameter is automatically accepted.
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5. Select the Retain policy overrides check box to retain manual policy overrides after the replenishment plan is
run with the Refresh with current data option selected on the Parameters tab in the Run Plan dialog box.
If you don't select this check box, the policy overrides you made are overwritten the next time you run the
replenishment plan and refresh it with current data.
If you select this check box, your policy overrides are retained even if the deviation percentages for the newly
calculated policy parameters are within the threshold percentage.

6. Click Done.
7. Save your changes.

Considerations for Storing Plan Data at Aggregate Time Levels  
For demand plans and replenishment plans, you can select a planning time level to determine whether plan data is
stored at aggregate time levels.

Storing the demand signal data at a daily level isn't efficient if you forecast using demand signals at aggregate
levels, such as weekly and monthly. When your data is stored at aggregate time levels, embedded analytics are more
responsive and perform faster across your demand plan or replenishment plan. This decision is applicable to the
Demand Management, Demand and Supply Planning, Planning Central, and Replenishment Planning work areas. Your
choices for your forecasting time level are based on what you selected for your planning time level.

Planning Time Level Parameter
The Planning Time Level parameter is located on the Plan Options page, Scope tab, in the Plan Parameters section.
Your selection for the Planning Time Level parameter determines the time level at which the plan data is stored. The
values available for the Planning Time Level parameter are based on what you selected for the Planning Calendar
parameter as follows:

• Gregorian calendar: Day or Month
Oracle Fusion Replenishment Planning doesn't support the daily planning time level for the Gregorian calendar.

• Manufacturing calendar: Day, Week, or Period

Forecasting Time Level Parameter
For demand plans or replenishment plans, the Forecasting Time Level parameter is located on the Demand tab of
the Plan Options page. The selections available for the Forecasting Time Level parameter are limited to the selected
planning time level and any parent levels above it in the selected planning calendar. For example, if the Month level in
the Gregorian calendar is selected for the planning time level, then the Forecasting Time Level parameter is limited to
Month, Quarter, and Year.

Configuration Examples: Weekly and Monthly Plans
Weekly Plan: The following table shows an example of a configuration for a weekly demand plan or replenishment plan.

Parameter Location Parameter Value

Plan Parameters section of the Scope tab
 

Planning Calendar
 

a manufacturing calendar
 

Plan Parameters section of the Scope tab Planning Time Level Week
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Parameter Location Parameter Value

   

Demand tab
 

Forecasting Time Level
 

Week
 

Monthly Plan: The following table shows an example of a configuration for a monthly demand plan or replenishment
plan.

Parameter Location Parameter Value

Plan Parameters section of the Scope tab
 

Planning Calendar
 

Gregorian calendar
 

Plan Parameters section of the Scope tab
 

Planning Time Level
 

Month
 

Demand tab
 

Forecasting Time Level
 

Month
 

Demand Plan Options for Demand or Replenishment Plans  
Define or modify demand options for a demand plan or replenishment plan on the Demand tab on the Plan Options
page.

For a replenishment plan, the Demand tab is enabled only when you select the Generate forecast check box on the
Plan Options page.

The following table explains how you use the Demand tab:

Demand Plan Option Explanation

Aggregate Non-Key Customer Data to an
All Other Level Member
 

Select this check box to aggregate data for customers whom you don't identify as key customers.
When you select this check box, the data for these non-key customers is aggregated to an All Other
member for analysis, and the number of customers and customer sites is reduced in the demand plan.
While certain customers and customer sites are relevant to your demand plan, most others aren't and
only add to the volume of data in your demand plan.
 
Before using this feature, you first need to use the file-based data import (FBDI) template titled Supply
Chain Planning Key Customer Options (ScpKeyCustomerOptionsImportTemplate.xlsm) to identify key
customers by hierarchy and level or by customer name and run the collections process.
 
This check box is available in only the Demand Management work area. The check box is disabled for a
demand plan if you've selected a planning level profile on the Scope tab on the Plan Options page.
 

Forecasting Time Level
 

Select the time level at which the forecast is generated. The selections are restricted to the planning
time level that you selected on the Scope tab or higher levels. For example, for a planning time level of
a week, the available forecasting time levels are week and period.
 
For a demand plan that uses a hybrid time hierarchy, the available forecasting time levels are parent
levels of the Hybrid time level for the hierarchy that you selected as the planning calendar on the Scope
tab.
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Demand Plan Option Explanation

The bucket you select for the forecasting time level is also used for the historical buckets, history
offset, forecast buckets, and locked forecast buckets displayed on the Demand tab.
 

Note:
The forecasting time level doesn't apply to forecasting profiles that use feature-based machine
learning.
 

Forecasting Profile, Input Measure, and
Output Measure
 

In the Forecast Profiles section, specify the forecasting profiles for the plan. Only those forecasting
profiles that are enabled for the Demand Management or Replenishment Planning work area are
available for selection. When you run the plan, the forecasting profiles run in the specified order. If
the forecasting profiles use the same output measure, it stores the output of the last run forecasting
profile.
 
You can't edit the input measure or output measure for a forecasting profile. The data in the input
measure serves as the basis of historical demand for the forecast. The output measure stores the
generated forecast.
 
The following are the predefined forecasting profiles:
 

• Forecast Bookings

◦ Input Measure: Final Bookings History

◦ Output Measure: Bookings Forecast

◦ Use: For forecasting on the basis of bookings history. Not available in the Replenishment Planning
work area.

• Forecast Bookings Including Event Activity

◦ Input Measure: Final Bookings History

◦ Output Measure: Bookings Forecast

◦ Use: For forecasting on the basis of bookings history while incorporating the impact of events.
Not available in the Replenishment Planning work area.

• Forecast Consumption

◦ Input Measure: Final Consumption History

◦ Output Measure: Consumption Forecast

◦ Use: For forecasting on the basis of consumption history. Not available in the Demand
Management work area.

• Forecast Shipments

◦ Input Measure: Final Shipments History

◦ Output Measure: Shipments Forecast

◦ Use: For forecasting on the basis of shipments history

• Forecast Shipments Including Event Activity

◦ Input Measure: Final Shipments History

◦ Output Measure: Shipments Forecast

◦ Use: For forecasting on the basis of shipments history while incorporating the impact of events.
Not available in the Replenishment Planning work area.
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Demand Plan Option Explanation

Analysis Set
 

Select an analysis set.
 

• If you don't select an analysis set, the forecasting profile applies to the full scope of the plan.

• If you select an analysis set, the forecasting profile is applied to only the subset of the plan scope
that's defined by the analysis set.

For example, you've an analysis set containing a specific set of products, and you select that analysis
set for a forecasting profile. The forecast is generated for only the products included in both the
analysis set and the plan, instead of for all the products in the plan.
 
You can use segments as member filters while configuring the analysis sets. Then, you can apply
forecasting profiles to specific segments by selecting the associated analysis sets.
 

Historical Buckets
 

Define the amount of historical data to use during the forecasting process. The number of historical
buckets is multiplied by the forecasting time level for determining the time horizon (number of days
between the history start and end dates) for considering the collected historical demand.
 
The historical buckets substantially affect the demand forecast generated when you run the plan. Use
at least 12 months of history, but using 18 to 36 months of history is the best practice. When setting the
historical buckets, keep the following in mind:
 

• Very long history affects the plan runtime and makes the forecast less relevant to current demand
patterns.

• Less than 1 year of history makes determining the impact of seasonal occurrences and holidays
difficult or impossible.

The historical bucket setting is the maximum amount of history used during forecast generation.
The actual amount depends on the data available for a given item and organization or item-location
combination. For each item and organization or item-location combination, the forecasting process
identifies all available historical data, removes any leading zero demand before the first positive
demand point, and generates a forecast.
 

History Offset
 

Define the buckets by which the history start date is moved backward. The forecast start date is
then set to one bucket ahead of the new history end date, and the history start and end dates and
forecast end date are automatically updated. The bucket size is determined by your selection in the
Forecasting Time Level field.
 
You use the history offset when you want to perform out-of-sample forecast tuning or back testing. By
moving the history start and end dates backward, you can generate a forecast for the period between
the history end date and the forecast start date, for which period you already have data. You can
compare your forecast with the actual data to refine your statistical forecast.
 

History Start and End Dates
 

For a demand plan, the history end date is determined by the plan run date and the planning calendar.
 
For a replenishment plan, the history end date is determined by the plan start date (displayed on the
General subtab on the Supply tab on the Plan Options page) and the planning calendar.
 
The history start date is determined from the history end date and the number of days between the
dates. The number of days between the history start and end dates is determined by multiplying the
number of historical buckets by the forecasting time level.
 

Forecast Buckets
 

Indicates the number of time periods for the demand forecast and is driven by the planning horizon set
for the plan and the forecasting time level.
 

Locked Forecast Buckets
 

Indicate the number of buckets from the end of historical data that don't receive a new forecast when
you run the plan. The bucket size is determined by your selection in the Forecasting Time Level field.
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Demand Plan Option Explanation

Ensure that the number you enter doesn't exceed the displayed number of forecast buckets.
 

Forecast End Date
 

Indicates the end date for the generated forecast. The end date is set to an end-of-period date based
on the history end date, forecasting buckets, and forecasting time level.
 

Related Topics
• Create a Forecasting Profile

• Edit a User-Defined Forecasting Profile

• Use the History Offset for Out-of-Sample Forecast Tuning

• Segmentation in Oracle Replenishment Planning

• Segmentation in Oracle Demand Management

Use the History Offset for Out-of-Sample Forecast Tuning  
This topic explains how you can use the history offset for a forecasting profile for performing out-of-sample forecast
tuning or back testing.

You set the history offset in the Forecast Profiles section on the Demand tab of the Plan Options page for a demand
plan, demand and supply plan (in the Demand and Supply Planning work area), or replenishment plan. When you set
the history offset, the forecast start date is one bucket after the history end date.

Benefits of Using the History Offset
The history offset enables you to shift the history end date backward so that you can generate a forecast for the period
for which you have actual data. By comparing the forecast with your actual data in the period between the history
end date and the current date, you can accurately fine-tune the forecasting methods, causal factors, and forecasting
parameters used in your forecasting profile, thereby increasing the reliability of the statistical forecast.

By using this feature, you don't have to wait for several months to collect data and compare it with your forecast so that
you can fine-tune your forecasting profile.

Points to Note When Using the History Offset
Some points to note when using the history offset are as follows:

• Preferably, create a forecasting profile for using the history offset. Ensure that the output measure isn't used by
other forecasting profiles.

This forecasting profile should contain the forecasting methods, causal factors, and forecasting parameters
that are used by the other forecasting profiles that you use for the statistical forecast.

• The history offset uses the time level you specify in the Forecasting Time Level field.

• When you set or change the history offset, the history start date, history end date, and forecast end date are
automatically updated.

• When you use the history offset, you should ensure that the tables and graphs in your plan display historical
data for enough days to cover the new history start and end dates.
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You can control the number of days for displaying historical demand before the plan start date in tables and
graphs by using the Demand History Days field in the Demand: Advanced Options dialog box that you open
from the Demand tab on the Plan Options page. Enter the number of days to display historical demand before
the plan start date in tables and graphs when a time filter isn't specified. The default is 182.

• If your data is seasonal, you preferably should have at least two years of history before the new history end date
so that trends are captured and an accurate statistical forecast is generated. You can't generate an accurate
statistical forecast if you have less than one year of history before the new history end date.

• The history offset isn't considered in the calculation of the measure that stores the history average for the
forecasting profile. Instead, the original history end date is used in the calculation of the history average.

• If the plan is used as a demand schedule for a replenishment plan or a supply plan, the history offset isn't
considered.

Refine Your Statistical Forecast by Using the History Offset
These are the high-level steps for using the history offset for refining your statistical forecast:

1. Run your plan with the forecasting profile that you normally use.
On the Parameters tab of the Run Plan dialog box, under Details, select Refresh with current data.

2. Create a forecasting profile and output measure for using the history offset.
3. Attach the new forecasting profile to the plan, and set the history offset.
4. Run the plan with the new forecasting profile.

On the Parameters tab of the Run Plan dialog box, under Details, select Do not refresh with current data. For
as long as you're fine-tuning the statistical forecast, you don't need to select Refresh with current data.

5. Compare the forecast with the actual data, and fine-tune the forecasting methods, causal factors, and
forecasting parameters.

6. Make changes to the forecasting methods, causal factors, and forecasting parameters in the forecasting profile
that you want to use for the statistical forecast, and run the plan with the forecasting profile.

Related Topics
• Demand Plan Options for Demand or Replenishment Plans

• Create a Forecasting Profile

• Run a Replenishment Plan

• Run a Demand Plan

Considerations for Configuring Replenishment Plan Attributes  
You can specify generic attributes of a replenishment plan, such as the assignment set and time horizon for demand, in
the Replenishment Plan Attributes section on the Plan Options page, Supply tab, General subtab.

The Supply tab is enabled only when the Calculate policy parameters, Calculate replenishments, or Rebalance
inventory check box is selected by itself or with other check boxes on the Plan Options page.

Note:  If you select only the Calculate policy parameters check box, the Overwrite Firm Planned Orders field is
grayed out. If you select only the Rebalance Inventory check box, except for the Overwrite Firm Planned Orders
field, all the other fields are grayed out under Replenishment Plan Attributes.
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The plan start and end dates are calculated by the replenishment planning process. The plan start date is set to the date
on which you run the replenishment plan, and the plan end date is calculated from the plan start date on the basis of
the planning time level and number of buckets defined on the Scope tab. The plan start and end dates are automatically
advanced each time you run the replenishment plan. The plan start and end dates together define the planning horizon.

Assignment Set
Use assignment sets to link sourcing rules and bills of distribution to organizations and items. Using sourcing rules,
bills of distribution, and assignment sets together, you specify how material is supplied and transferred across a supply
chain.

Select the assignment set that must be used with the replenishment plan.

Overwrite Firm Planned Orders
Specify whether firm planned orders are retained between replenishment plan runs. When you select All, the
replenishment planning process overwrites all orders, planned and firm planned, from the current replenishment plan.
When you select None, the replenishment planning process doesn't overwrite firm planned orders. However, planned
orders that aren't firm are overwritten.

Note:  If you select the Rebalance inventory check box on the Plan Options page, firm planned orders are overwritten
even if you select None in the Overwrite Firm Planned Orders field.

Time Horizon for Demand
Specify the time window in which demand is considered for calculating the Beginning Inventory Position measure on a
given day. When you select None, only the current day's demand for an item-location combination is considered. When
you select Item lead time, the demand within the lead time for the item-location combination is considered.

Lead Time Multiplier
Enter the number by which the lead time for the item-location combination should be multiplied when the time window
for demand is considered.

When you select Item lead time, the Beginning Inventory Position measure is calculated as Projected Available Balance
+ On Order - backlog (open orders within the item lead time). By using the time horizon and lead time multiplier
together, you can determine how many days of backlog are considered during the calculation of the Beginning
Inventory Position measure.

A large lead time multiplier results in a large inventory.

Supply Cutoff Days
Enter the number of days that must be added to the plan end date. All the existing orders with order due dates that fall
within the specified period after the plan end date are considered during the calculation of the On Order measure.

This value is required for proper calculation of the On Order measure and prevents excess replenishments from being
created when the replenishment plan is run.

The maximum number of supply cutoff days you can specify is 15. If no value is specified, zero is taken as the number of
supply cutoff days.
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Aggregate Planned Orders
For a replenishment plan with a planning time level higher than a day, the inventory position is nevertheless evaluated
daily so that replenishments are efficiently created. However, the planned orders are moved to the ends of the
aggregate planning buckets.

For such a replenishment plan, select Yes to aggregate the planned orders into one large order for each aggregate
planning bucket.

If you select No, planned orders aren't aggregated into one large order.

Create Natural Time Fence
Select this check box to create a natural time fence for the replenishment plan. By creating a natural time fence, you
ensure that a new planned order has a due date that's after the due date for the latest, firm purchase order or transfer
order.

Related Topics
• Manually Release Replenishment Orders

• Aggregate Planning Buckets and Replenishment Orders

How the Natural Time Fence Controls the Creation of Planned
Orders  
Enable a natural time fence for your replenishment plan so that a planned order is created with a due date that's after
the due date of the latest, firm purchase order or transfer order.

The natural time fence date is set to the due date of the latest, firm purchase order or transfer order. Therefore, if the
demand before the natural time fence date increases, a new planned order is recommended with a due date that's
one day or more after the natural time fence date. Thus, the natural time fence improves the efficiency of generating
planned orders.

During the bottom-up phase of multiechelon replenishment planning, for purchase orders, purchase requisitions,
movement requests, and transfer orders that aren't firm and are rescheduled (preponed), the due dates must be one
day after the natural time fence.

This feature is useful in scenarios such as these:

• Your supplier might delay the delivery of a purchase order on account of manufacturing issues. Your buyer
firms the purchase order, and you run your replenishment plan again after collecting firm purchase orders. In
this situation, you don't want to release another planned order with a due date that's before the due date of the
existing, firm purchase order.

• To cater to increased demand, your store might generate a planned order with a due date that's earlier than that
for an existing, firm purchase order. In this situation, you want to ensure that the due date of the new planned
order is after that of the existing, firm purchase order.
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Settings That Affect the Creation of the Natural Time Fence
These settings affect the creation of the natural time fence:

• The selection of the Create natural time fence check box on the General subtab on the Supply tab on the Plan
Options page for your replenishment plan.

Note:  Select this check box for the replenishment plan for which you've selected the Calculate
replenishments check box on the Plan Options page.

• The due date of the latest, firm purchase order or transfer order.

How the Natural Time Fence Is Calculated
The natural time fence is set to the due date of the latest, firm purchase order or transfer order.

New planned orders are created with due dates outside the natural time fence. However, the order dates of the planned
orders can be inside the natural time fence.

Example of a Natural Time Fence
Consider this example of an item-location combination for which the policy type is min-max planning:

Measure March 12 March 13 March 14 March 15 March 16 March 17 March 18 March 19

Total Demand
 

20
 

120
 

20
 

20
 

20
 

20
 

20
 

30
 

Final
Minimum
Quantity
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

Final
Maximum
Quantity
 

180
 

180
 

180
 

180
 

180
 

180
 

180
 

180
 

On Hand
 

60
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Purchase
Orders
 

0
 

0
 

0
 

0
 

0
 

140
 

0
 

80
 

Total Supply
 

60
 

0
 

0
 

0
 

0
 

140
 

160
 

80
 

Projected
Available
Balance
 

40
 

-80
 

-100
 

-120
 

-140
 

-20
 

120
 

170
 

On Order
 

0
 

0
 

140
 

140
 

380
 

240
 

80
 

0
 

Beginning
Inventory
Position

40
 

-80
 

40
 

20
 

240
 

220
 

200
 

170
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Measure March 12 March 13 March 14 March 15 March 16 March 17 March 18 March 19

 

Planned
Replenishments
by Order Date
 

0
 

0
 

0
 

160
 

0
 

0
 

0
 

0
 

Planned
Replenishments
by Due Date
 

0
 

0
 

0
 

0
 

0
 

0
 

160
 

0
 

Final
Inventory
Position
 

40
 

-80
 

40
 

180
 

240
 

220
 

200
 

170
 

Note these points:

• The replenishment plan is run on March 12.

• The due date of March 17 for the firm purchase order of 140 units is taken as the natural time fence date.

Any new planned order must have its due date after March 17.

• The Beginning Inventory Position measure on March 12 is less than the Final Minimum Quantity measure. But,
the planned order isn't created on March 12. Instead, the planned order is created with an order date of March
15 and due date of March 18 to ensure that the due date is outside the natural time fence.

Related Topics
• Overview of Multiechelon Replenishment Planning

• Rescheduling of Orders During Bottom-up Phase of Multiechelon Replenishment Planning

Automatic Release Options  
Automatic release uses scheduled processes to release planned orders automatically after the plan run completes.

The following options are available in the Automatic Release Parameters section on the Plan Options page, Supply Tab,
General subtab in one of the work areas for Oracle Fusion Cloud Supply Chain Planning:

• Release planned orders automatically

• Include rescheduled and canceled supplies in automatic releases

• Include rescheduled supplies in automatic releases

To navigate to the Automatic Release Parameters section, follow these steps:

1. On the Plan Options page, click the Tasks panel tab.
2. In the Tasks panel tab, click Manage Plans.
3. In the Search area, search for your plan.
4. Select the plan from the displayed search result.
5. Click Actions, and then click Edit Plan Options.
6. On the Plan Options page, click the Supply tab.
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The General subtab appears. The Automatic Release Parameters section is a part of this tab.

Release Planned Orders Automatically
To release planned orders automatically, you must perform these steps before you run the plan:

• Select the Release planned orders automatically check box on the Plan Options page, Supply Tab, General
subtab.

• Select the Refresh with current data option on the Parameters tab in the Run Plan dialog box.

The planned orders are automatically released after the run plan is successful.

For a demand and supply plan, replenishment plan, or supply plan, the selections in the Automatic Release Parameters
section aren't copied when you copy a plan. The planning process won't release planned orders when you use the
duplicated plan to perform simulations.

Note:  Release time fence is an item-organization attribute and isn't defined in plan options.

Include Rescheduled and Canceled Supplies in Automatic Releases
When you select the Include rescheduled and canceled supplies in automatic releases check box, the planning
process automatically releases rescheduled and canceled supplies. This check box is available only if you selected the
Release planned orders automatically check box.

Note:  The Include rescheduled and canceled supplies in automatic releases check box isn't available in the
Replenishment Planning work area.

Include Rescheduled Supplies in Automatic Releases
When you select the Include rescheduled supplies in automatic releases check box, the planning process
automatically releases purchase orders and transfer orders that aren't firm and that were rescheduled during the
bottom-up phase of multiechelon replenishment planning. This check box is available only if you selected the Release
planned orders automatically check box.

Note:  The Include rescheduled supplies in automatic releases check box is available in only the Replenishment
Planning work area.

Related Topics
• How Replenishment Orders Are Automatically Released

• Rescheduling of Orders During Bottom-up Phase of Multiechelon Replenishment Planning

Item Relationship Options for Replenishment Plans  
The selections you make in the Item Relationships section on the General subtab on the Supply tab on the Plan Options
page affect how related items are used during end item substitution and supersession in your replenishment plan.
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The Use of Related Items Supplies and Lead Time Multiplier for Excess Window fields are enabled only when you
select the Calculate replenishments check box on the Plan Options page. Also, you must not select the Rebalance
inventory check box on the Plan Options page.

In the Use of Related Items Supplies field, these selections are available:

• Don't use related items: This selection is the default.

• Maximize use of related items to minimize new replenishments: The supply of the substitute item or
supersession item is used so that a new replenishment order for the demanded item isn't triggered. The
emphasis is on bringing the quantity of the demanded item above the minimum quantity or reorder point
(ROP) quantity. However, the supply of the substitute item or supersession item is maintained above the
minimum quantity or ROP quantity so that the demand for this item can be met.

The shortage of the item is calculated as follows:

◦ If the Beginning Inventory Position is less than or equal to the Minimum Quantity or ROP Quantity, the
shortage is calculated as Beginning Inventory Position - Minimum Quantity - 1 or Beginning Inventory
Position - ROP Quantity - 1.

◦ If the value of the Minimum Quantity or ROP Quantity is null, when the Beginning Inventory Position is
less than zero, the shortage is equal to the Beginning Inventory Position.

The excess is calculated as the least positive value for Projected Available Balance - Minimum Quantity - 1 or
Projected Available Balance - ROP Quantity - 1 for a day in the excess window.

If the excess window extends beyond the planning horizon, the excess window is restricted to the end of the
planning horizon.

• Use related items only when necessary to avoid stockouts: The demand is fulfilled by the supply of the
demanded item, including new replenishment orders, whenever possible. The supply of the substitute item or
supersession item is used only for preventing backordering or stockouts of the demanded item and negative
values for the Projected Available Balance.

If the Projected Available Balance for an item on a day is less than zero, the Projected Available Balance is the
shortage.

The excess is calculated as the least positive value for the Projected Available Balance in the excess window.

If the excess window extends beyond the planning horizon, the excess window is restricted to the end of the
planning horizon.

The shortage is calculated on every day in the planning horizon and stored in the Initial Shortage for Substitution
measure.

The excess is calculated on every day in the planning horizon and stored in the Initial Excess for Substitution measure.

When you select Maximize use of related items to minimize new replenishments or Use related items only when
necessary to avoid stockouts, the Lead Time Multiplier for Excess Window field is enabled. Enter a value ranging
from 0 to 10 in this field. This value is multiplied by the total lead time (preprocessing lead time + processing lead time +
postprocessing lead time) specified in the Items table for the item for determination of the excess window.

If no data is available in the Items table, or you enter zero, only the supplies and demands for each day are used for
determining the excess and shortage for that day.
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Related Topics
• Overview of End Item Substitution and Supersession

• Examples of End Item Substitution and Supersession

Enable Multiechelon Planning for Your Replenishment Plan  
You enable multiechelon planning for your replenishment plan using the Plan Options page.

1. On the Plan Options page for your replenishment plan, click the Supply tab.
2. Click the General subtab.
3. In the Multiechelon Plan Attributes section, select the Enable multiechelon planning check box.
4. Save your work.

Results:
Multiechelon planning is done for your replenishment plan when you run it.

Related Topics
• Overview of Multiechelon Replenishment Planning

• How Multiechelon Replenishment Planning Is Done

• How You Use Multiechelon Replenishment Planning

Release Recommendation Options  
Use the Release Recommendations Parameters section in the Supply: Advanced Options dialog box to configure the
following supply plan options:

• Compression days tolerance for automatic release

• Requisition load group by

• Transfer load group by

• Released only by user

Access the Release Recommendations Parameters section from a Supply Planning, Demand and Supply Planning,
Replenishment Planning, or Planning Central work area.

Compression Days Tolerance for Automatic Release
Use this option to indicate the number of compression days allowed for the automatic release of planned orders. The
number of compression days applies only to automatic release of planned orders and recommendations. Compression
days means the number of days reduced between the start date and due date as suggested by the planning process.

The Compression Days Tolerance for Automatic Release field isn't available in the Supply: Advanced Options dialog
box for a replenishment plan.
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Requisition Load Group By
Use this option to indicate the requisition load group when loading requisitions to purchasing. For each option, except
All, the planning process creates one line for each planned order within each requisition.

• All: The planning process creates one purchase requisition for all recommended orders.

• Item: The planning process creates one purchase requisition for each item.

• Buyer: The planning process creates one purchase requisition for each buyer.

• Supplier: The planning process creates one purchase requisition for each supplier.

• Category: The planning process creates one purchase requisition for each item category.

• Location: The planning process creates one purchase requisition for each location.

• Project: The planning process creates one purchase requisition for each project. This option is available only
when the project-specific supply planning is enabled for your enterprise.

Transfer Load Group By
Use this option to indicate the transfer load group when loading transfers to logistics. The value of Transfer Load
Group By determines how the actual transfer order is created.

• All: The planning process creates all transfers in one transfer order.

• Source and destination and ship date: The planning process creates one transfer order for each Ship From
and Ship To organization, and each ship date.

• Source and destination, shipping method and ship date: The planning process creates one transfer for each
Ship From and Ship To organization pair, and shipping method and ship date.

Released Only by User
Use this option to specify whether to restrict implementation of planned orders and recommendations to the current
user. If you enable this option, the planning process implements only those planned orders and recommendations
that the current user has marked. If you disable this option, the planning process implements planned orders and
recommendations that are marked by any user.

Note:  This option applies only to the manual release of planned orders.

Use these steps to navigate to the Release Recommendations Parameters section in the Supply: Advanced Options
dialog box:

1. Open a plan:

a. In a Supply Planning, Demand and Supply Planning, Replenishment Planning, or Planning Central work
area, click the Tasks panel drawer.

b. In the Tasks panel drawer, click Manage Plans.
c. In the Search area, search for your plan.
d. Select the plan from the displayed search result.

2. On the Edit Plan page, click Actions and then click Edit Plan Options.
3. On the Plan Options page, click the Supply tab.
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4. On the General subtab, click Select Advanced Options.

The Supply: Advanced Options dialog box opens, which includes the Release Recommendations Parameters
section.

Technical Control Parameters  
You can use multithreading to decrease the overall runtime of a supply plan.

In the plan options, navigate to the Supply: Advanced Options dialog box, Technical tab and select the Enable
multithreading check box. When selected, the planning process implements multithreading during the plan run.

Organizations and Schedules Options for Replenishment Plans  
Use the Organizations and Schedules subtab on the Supply tab on the Plan Options page to configure subinventory
netting and demand schedules for your replenishment plan.

You also use the subtab to select replenishment plans for providing policy parameters.

The Supply tab is enabled only when you select the Calculate policy parameters or Calculate replenishments check
box by itself or with other check boxes on the Plan Options page.

Organizations
Use the Organizations section on the subtab to specify the subinventory netting for organizations that are covered by
the replenishment plan.

These organizations are the same as those that you selected in the Level Members dialog box on the Scope tab on the
Plan Options page.

For each listed organization, in the Subinventory Netting dialog box, select or deselect the check boxes in the Enable
Netting column to include or exclude subinventories from the supply-demand netting in the replenishment plan.
During the collection process, data is collected from the subinventories on the basis of the organization configuration in
the source system. If you enable subinventory netting for a new subinventory in the source system, the replenishment
plan automatically includes the new subinventory after the next collection process.

Demand Schedules
Use the Demand Schedules section on the subtab to specify the replenishment plan for calculating policy parameters
and the sources of the demand forecast.

If the Calculate policy parameters check box is selected on the Plan Options page, the replenishment plan is listed in
the Demand Schedules section, and the check box in the Use for Policy Parameters column is automatically selected
and can't be deselected.

You can select the following for the demand forecast:

• Another replenishment plan that has the Generate forecast check box selected on the Plan Options page, and
that has been run
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• A demand plan that has been run

You can also select a demand plan with a hybrid time hierarchy.

• An external forecast schedule

If the replenishment plan is used for incremental planning (the Enable for incremental planning check box is selected
along with the Calculate replenishments check box on the Plan Options page), you can't select another replenishment
plan, a demand plan, or an external forecast schedule for the demand forecast. Only actual demands (sales orders,
transfer orders, and inventory position) are considered during replenishment calculation.

If the Generate forecast check box is selected on the Plan Options page, the replenishment plan is listed in the Demand
Schedules section, and the check box in the Use for Demand Schedule column is automatically selected and can't be
deselected.

This table explains how you use the Demand Schedules section:

Selected Check Box on Plan Options
Page

Selection in Demand Schedules Section

Calculate replenishments
 

Select another replenishment plan that has been run with the Calculate policy parameters check box
selected on the Plan Options page, and select the check box under Use for Policy Parameters.
 
You can select only one replenishment plan for calculating policy parameters.
 
You can also use the same replenishment plan for generating the forecast and calculating policy
parameters if it was run with the Generate forecast and Calculate policy parameters check boxes
selected on the Plan Options page.
 

Calculate policy parameters
 

Select a source for the demand forecast.
 
If you select more than one source, the forecasts from different sources are added up for the item-
location combination.
 
If you select a replenishment plan, you must select the check box under Use for Demand Schedule. If
you select a demand plan or an external forecast schedule, the check box is automatically selected and
grayed out.
 
For a demand or replenishment plan, you must select a demand measure and forecast accuracy
measures.
 

Related Topics
• Demand Measures and Forecast Accuracy Measures

Demand Measures and Forecast Accuracy Measures  
You can select predefined or user-defined measures for demand and forecast accuracy to drive the calculation of
inventory policies and safety stock and improve your replenishment planning.

In the Demand Schedules section on the Organizations and Schedules subtab on the Supply tab on the Plan Options
page for your replenishment plan, click the Select buttons in the Demand Measures and Forecast Accuracy Measures
columns to open dialog boxes in which you can select measures.
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Note these points:

• The button under Demand Measures is available only if one of these conditions is met:
◦ You selected a demand plan in the Demand Schedule column.

◦ Under Demand Schedule, you selected a replenishment plan for which you've selected the Generate
forecast check box on the Plan options page, and you've selected the check box under the Use for
Demand Schedule column.

• The button under Forecast Accuracy Measures is available only if you've selected the Calculate policy
parameters check box on the Plan Options page, and one of these conditions is met:

◦ Under Demand Schedule, you've selected a demand plan.

◦ Under Demand Schedule, you selected a replenishment plan for which you've selected the Generate
forecast check box on the Plan options page, and you've selected the check box under Use for Demand
Schedule.

◦ Under Demand Schedule, you selected the same replenishment plan as the one for which you're editing
the plan options and for which you've selected the Generate forecast and Calculate policy parameters
check boxes. For this replenishment plan, the check boxes under Use for Policy Parameters and Use for
Demand Schedule are automatically selected and can't be unselected.

• The buttons under Demand Measures and Forecast Accuracy Measures aren't available when you select an
external forecast schedule under Demand Schedule.

Demand Measures
When you click Select under Demand Measures, the Demand Measures dialog box appears.

In this dialog box, in the End Item Demand field, you can select one of the following measures from the selected plan:

• Approved Final Bookings Forecast

• Approved Final Shipments Forecast

• Final Bookings Forecasts

• Final Consumption Forecast

• Final Shipments Forecast (This measure is selected by default.)

• Any user-defined measure in the End Item Demand measure group in the Demand Management work area

The measure you select in the End Item Demand field drives the forecast for the item-location combinations in your
replenishment plan.

Forecast Accuracy Measures
When you click Select under Forecast Accuracy Measures, the Forecast Accuracy Measures dialog box is displayed.

In this dialog box, in the Measure for MAPE field, you can select one of the following measures from the selected plan:

• Bookings Forecast MAPE

• Consumption Forecast MAPE

• Shipments Forecast MAPE (This measure is selected by default.)

• Any user-defined measure in the Forecast Error MAPE measure group in the Demand Management work area

In the Measure for Intermittent Demand field, you can select one of the following measures from the selected plan:

• Bookings Forecast Is Intermittent
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• Consumption Forecast Is Intermittent

• Shipments Forecast Is Intermittent (This measure is selected by default.)

• Any user-defined measure in the Intermittent Demand measure group in the Demand Management work area

In the Measure for Average Interarrival Time field, you can select one of the following measures from the selected
plan:

• Bookings Forecast Average Interarrival Time

• Consumption Forecast Average Interarrival Time

• Shipments Forecast Average Interarrival Time (This measure is selected by default.)

• Any user-defined measure in the Average Interarrival Time measure group in the Demand Management work
area

The measures you select in the Measure for MAPE, Measure for Intermittent Demand, and Measure for Average
Interarrival Time fields drive the calculation of safety stock for the item-location combinations in your replenishment
plan.

Related Topics
• Organizations and Schedules Options for Replenishment Plans

• How Safety Stock Is Calculated in Oracle Replenishment Planning

Inventory Rebalancing Options for Replenishment Plans  
Use the Inventory Rebalancing tab on the Plan Options page to specify the clusters, inventory rebalancing rules, and
supply and demand types for calculating excess inventory and inventory shortages for your replenishment plan.

Select the Rebalance inventory check box on the Plan Options page to enable the Inventory Rebalancing tab.

Note:  The Rebalance inventory check box is grayed out if you select the Enable for incremental planning check
box.  The Rebalance inventory check box is also grayed out if you select the Enable for policy comparison check
box in the Scope: Advanced Options dialog box that you can open from the Scope tab on the Plan Options page.

Clusters
You can add, sequence, and remove the clusters that must be included in your replenishment plan for inventory
rebalancing.

The available clusters are those that you have created on the Manage Planning Clusters page in the Replenishment
Planning work area.

Inventory rebalancing is performed for each included cluster according to its sequence number. The items in each
location are processed so long as the item-location combinations are also in the selected segments of the segment
group that's attached to the replenishment plan.

Note these points while adding or removing clusters:

• Every cluster must have a unique sequence number.
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• The sequence number for a cluster must be a whole number that's one or greater than one.

Inventory Rebalancing Rules
Note these points about the inventory rebalancing rules for your replenishment plan:

• Reduce partial recommendations: Select this check box if you want the inventory rebalancing functionality
to try to meet inventory shortages at locations using planned orders from other locations that have enough
excess inventory to completely meet the shortfall. By selecting this check box, you can reduce the number of
planned orders generated through inventory rebalancing.

• Move excess to sweep location: Select this check box to move the excess inventory after inventory rebalancing
in a cluster to a designated sweep location that may or may not be within the cluster.

• Include safety stock in shortage calculation: Select this check box to include the safety stock for an item-
location combination in the calculation of its inventory shortage.

Supplies and Demands for Calculation of Excess Inventory and Inventory Shortages
You must specify the supply and demand types for inclusion in the calculation of the excess inventory and inventory
shortage for an item-location combination.

The selected supply and demand types are used in the calculation of the Projected Inventory measure for the item-
location combination.

You must select at least one supply type and one demand type for inventory rebalancing.

Related Topics
• Create a Cluster

• Edit a Cluster

• How the Excess Inventory and Inventory Shortage Are Calculated

• How the Projected Inventory Measure Is Calculated

Run a Replenishment Plan  
When you run a replenishment plan, you can specify how you want to refresh the data and what should be done as a
part of the plan run.

Also, you can run the replenishment plan immediately or in the background at a set time or on a repetitive schedule.

Regardless of your plan setup, you use the following sequence for running your replenishment plan:

1. Generate the forecast or specify the following for the forecast:

◦ Another replenishment plan that has been run with the Generate forecast check box selected on the
Plan Options page.

◦ A demand plan that has been run.

◦ An external forecast schedule.

2. Calculate the policy parameters.
3. Rebalance the inventory.
4. Calculate the replenishments.
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Consider these examples:

Setup of Replenishment Plans Run Sequence

Replenishment Plan A generates the
forecast, calculates the policy parameters,
 and calculates the replenishments.
 

Run Replenishment Plan A.
 

Replenishment Plan Y generates the
forecast and calculates the policy
parameters, and Replenishment Plan Z
calculates the replenishments.
 

1. Run Replenishment Plan Y to generate the forecast and calculate the policy parameters.
2. Run Replenishment Plan Z to calculate the replenishments.

Replenishment Plan M generates the
forecast and calculates the policy
parameters, and Replenishment Plan N
rebalances the inventory and calculates
the replenishments.
 

1. Run Replenishment Plan M to generate the forecast and calculate the policy parameters.
2. Run Replenishment Plan N to rebalance the inventory and calculate the replenishments.

Data Refresh Options
These data refresh options are available under the Details region on the Parameters tab in the Run Plan dialog box:

• Do not refresh with current data: Select this option for simulation planning.

When you select this option, the planning horizon (the plan start and end dates) displayed on the Plan Options
page, Supply tab, General subtab isn't advanced.

• Refresh with net-changed data: Select this option to perform incremental replenishment planning for only
those item-location combinations with net changes in demands and supplies. This option is enabled only when
the Enable for incremental planning and Calculate replenishments check boxes are selected on the Plan
Options page for the replenishment plan.

When you select this option, the planning horizon displayed on the Plan Options page, Supply tab, General
subtab is advanced.

• Refresh with current data: Select this option to refresh the replenishment plan with the latest collected data. If
you're running the replenishment plan for the first time, only this option is enabled, and it's selected by default.

If you selected only the Calculate policy parameters check box on the Plan Options page and are running the
replenishment plan for the policy comparison process, you must select this option.

When you select this option, the planning horizon displayed on the Plan Options page, Supply tab, General
subtab is advanced.

Scope Options
These scope options are available under the Details region on the Parameters tab in the Run Plan dialog box:

• Generate forecast: Select this check box to generate the forecast as a part of the plan run. The check box is
enabled only when the Generate forecast check box is selected on the Plan Options page. If this check box is
enabled, and you're running the replenishment plan for the first time, the check box in the dialog box is selected
by default and can't be deselected.
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• Calculate policy parameters: Select this check box to calculate policy parameters as a part of the plan run. The
check box is enabled only when the Calculate policy parameters check box is selected on the Plan Options
page. If this check box is enabled, and you're running the replenishment plan for the first time, the check box in
the dialog box is selected by default and can't be deselected.

• Calculate replenishments: Select this check box to calculate replenishments as a part of the plan run. The check
box is enabled only when the Calculate replenishments check box is selected on the Plan Options page. If this
check box is enabled, and you're running the replenishment plan for the first time, the check box in the dialog
box is selected by default and can't be deselected.

• Rebalance inventory: Select this check box to rebalance inventory as a part of the plan run. This check box
is enabled only when the Rebalance inventory check box is selected on the Plan Options page. If this check
box is enabled, and you're running the replenishment plan for the first time, the check box in the dialog box is
selected by default and can't be deselected.

If you select this check box and the Do not refresh with current data option, the Calculate replenishments
check box is selected and grayed out.

• Archive plan: Select this check box to archive the results of the plan run. This check box is enabled only when
the Refresh with current data option is selected, and the Enable for archiving check box is selected in the
Scope: Advanced Options dialog box that you open from the Plan Options page, Scope tab.

• Prepare for buyer planning: Select this check box to run the Prepare Plan for Buyer Planning scheduled process
as a part of the plan run. The scheduled process copies buy orders from the replenishment plan to Buyer
Planning for quick retrieval.

This check box appears only if these conditions are met:

◦ The replenishment plan uses a source system for Oracle Fusion Cloud Applications.

◦ You've the privileges (MSC_RELEASE_PLANNING_RECOMMENDATIONS_PRIV,
MSC_MONITOR_PLANNING_SCHEDULED_PROCESSES_PRIV, and
MSC_EDIT_SUPPLIES_BUYER_PLANNING_PRIV) to run the Prepare Plan for Buyer Planning scheduled
process.

Note:  Select the Prepare for buyer planning check box only when you've also selected the Calculate
replenishments check box. Unless replenishments are calculated during the plan run, no buy orders will be
available for being copied to Buyer Planning.

Run the Replenishment Plan
Follow these steps to run the replenishment plan:

1. Open the Run Plan dialog box through one of these ways:

◦ Use the Manage Plans page:

i. On the Tasks panel tab, under Plans, select Manage Plans.

The Manage Plans page opens.
ii. Under Search Results, select the replenishment plan, and click Actions > Run.

◦ On the Plans panel tab, under Plans, right-click the replenishment plan, and select Run.

◦ Open the replenishment plan, and click Actions > Run.

2. Enter submission notes for your plan run.
3. On the Parameters tab, under Details, do these steps:
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a. Under Data Refresh Options, select an option.

If you select Do not refresh with current data, the Manage Replan Details link is displayed under
the option. Click the link to open the Manage Replan Details dialog box, in which you can see the item-
location combinations and segments for which you've made simulation-related changes. Under Replan,
deselect the check boxes for the combinations and segments for which you don't want to run the
simulation.

b. Under Scope Options, select check boxes for the type of plan run.
4. Under Demand Plan Run Options, under Include, select the check boxes for the forecasting profiles that you

want to use for generating the forecast.

This section is displayed if the Generate forecast check box is selected on the Plan Options page. The
forecasting profiles selected on the Demand tab on the Plan Options page are displayed here.

This section isn't displayed when you select Do not refresh with current data under Data Refresh Options.
5. On the Schedule tab, do the following:

◦ To run the plan immediately, select As soon as possible.

◦ To run the plan in the background at a set time, select Using a schedule.

The Frequency field is displayed. Other options are displayed on the basis of the selected frequency.

Specify a schedule for the plan run.
6. Click OK to run the replenishment plan.

The Plan Status Details dialog box is displayed.
7. Click OK.

Related Topics
• Overview of Inventory Rebalancing

• Overview of Simulations for Replenishment Plans

• Overview of the Policy Comparison Feature

Publish Plan Data  
You can publish data for a plan in the Demand Management, Demand and Supply Planning, Planning Central,
Replenishment Planning, Sales and Operations Planning, or Supply Planning work area to a compressed file.

You can then use the file for data integration between your Supply Chain Planning application and other Oracle or
external applications.

By submitting a scheduled process from your Supply Chain Planning work area or the Scheduled Processes work area,
you can publish the data in a pivot table within your plan to a file on the content server of Oracle WebCenter Content.

Using APIs of Oracle's ERP integration service for automating the data integration between your Supply Chain Planning
Application and an external application, you can submit the scheduled process, check its status, and get the details of
the published document.

The file name is in the <plan name>_<pivot table name>.zip format.
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Publish Plan Data from a Supply Chain Planning Work Area
Here's how you can publish data for your plan from your Supply Chain Planning work area:

1. Do one of the following to open the Publish Data dialog box:

◦ On the Manage Plans page, select the plan and click Actions > Publish Data.

The Publish Data dialog box opens.

◦ Open your plan and click Actions > Publish Data.

The Publish Data dialog box opens.
2. Optionally, enter submission notes for your scheduled process.
3. On the Parameters tab, optionally, select the Append request number to output file name check box.

Selecting this check box results in the request number being appended to the file name, which enables
easy identification of the file on the content server. The resulting file name (<plan name>_<pivot table
name>_<request number>) is also used as the document title.

If you don't select this check box, the document title is PUBLISHPLANDATA.
4. In Table Name, select the pivot table of your plan for which you want to publish data.

The available tables are enabled for the work area of the plan, and you have the required access to these tables.
5. In Source System, select the source system that's specified on the Scope tab of the Plan Options page for the

plan.
6. On the Schedule tab, specify whether you want to run the process as soon as possible or according to a

schedule.

If you publish the file according to a schedule, you can specify the frequency and start and end dates for the
process.

7. Click Submit.

The Status dialog box opens and displays the request number. Make a note of this number and then click OK.

You can use this number to search for the result of your request in the Scheduled Processes work area.

If you appended this number to the compressed file's name, you can use this number to search for the file in
the File Import and Export work area. You can then download and check the file.

Publish Plan Data from the Scheduled Processes Work Area
Here's how you can publish data for your plan from the Scheduled Processes work area:

1. On the Overview page, click the Schedule New Process button.

The Schedule New Process dialog box opens.
2. In Name, select the Publish Plan job, and click OK.

The Process Details dialog box opens.
3. To be notified when the process ends regardless of the result, select the Notify me when this process ends

check box.
4. Optionally, enter submission notes for your scheduled process.
5. On the Parameters tab, in Plan Name, select your plan.
6. Optionally, select the Append request number to output file name check box.
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Selecting this check box results in the request number being appended to the file name, which enables
easy identification of the file on the content server. The resulting file name (<plan name>_<pivot table
name>_<request number>) is also used as the document title.

If you don't select this check box, the document title is PUBLISHPLANDATA.
7. In Table Name, select the pivot table of your plan for which you want to publish data.

The available tables are enabled for the work area of the plan, and you have the required access to these tables.
8. In Source System, select the source system that's specified on the Scope tab of the Plan Options page for the

plan.
9. To set a schedule for your request and notify other users about the result, click the Advanced button.

The Schedule and Notification tabs are displayed.

◦ On the Schedule tab, specify whether you want to run the process as soon as possible or according to a
schedule.

If you publish the file according to a schedule, you can specify the frequency and start and end dates for
the process.

◦ On the Notification tab, specify the recipients to whom result notifications should be sent and the
conditions under which the notifications are sent.

10. Click Submit.

The Confirmation dialog box opens and displays the process number. Make a note of this number, and click OK.

You can use this number to search for the result of your request in the Scheduled Processes work area.

If you appended this number to the compressed file's name, you can use this number to search for the file in
the File Import and Export work area. You can then download and check the file.

Best Practices for Setting Up Replenishment Plans  
You can configure replenishment plans in various ways to meet your business requirements.

This table explains the various configurations that you can use for your replenishment plans:

Plan Type Plan Purpose Planning Horizon Planning Time
Level

Frequency of Plan
Runs

Selected Check
Boxes

Release from
Plan?

Strategic
replenishment plan
 

To estimate how
well your policies
meet anticipated
demands
 

6 months to 1 year
 

Week or period
 

Weekly or monthly
 

Generate forecast,
 Calculate policy
parameters,
 and Calculate
replenishments
check boxes
 

No
 

Integrated
replenishment plan
 

To monitor and
execute policies
according to the
generated forecast
 

100 days or less
 

Day
 

Daily
 

Generate forecast,
 Calculate policy
parameters,
 and Calculate

Yes
 

301



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 12
Replenishment Plans

Plan Type Plan Purpose Planning Horizon Planning Time
Level

Frequency of Plan
Runs

Selected Check
Boxes

Release from
Plan?

Optionally,
 you can use a
weekly demand
plan, a weekly
replenishment
plan, or an external
forecast schedule
for the forecast.
 
Optionally, you
can use a policy
comparison or
policy calculation
plan for the policy
parameters.
 
Optionally, you can
use the integrated
replenishment plan
to also rebalance
the inventory
by selecting
the Rebalance
inventory check
box. However,
 this use case isn't
common.
 

replenishments
check boxes
 

Automated
execution plan
 

To incrementally
calculate
replenishments
according to a
schedule and
actual demands
(sales orders,
 transfer orders,
 and inventory
position)
 
You must
use another
replenishment
plan for the policy
parameters.
 
You can't
select another
replenishment
plan, a demand
plan, or an external
forecast schedule
for the demand
forecast.
 

15 days or less
 

Day
 

Daily or intraday
 

Enable for
incremental
planning and
Calculate
replenishments
check boxes
 

Yes
 

Policy comparison
plan or policy
calculation plan
 

To compare or
calculate policies
 
You must feed the
calculated policies
to an integrated

6 months
 

Week
 

Monthly
 

Generate forecast
and Calculate
policy parameters
check boxes
 

No
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Plan Type Plan Purpose Planning Horizon Planning Time
Level

Frequency of Plan
Runs

Selected Check
Boxes

Release from
Plan?

replenishment
plan or automated
execution plan.
 

Inventory
rebalancing plan
 

To rebalance
inventory among
the item-location
combinations in
the clusters of a
replenishment plan
 
You must
use another
replenishment plan
with a planning
time level of week,
 month, or period
to calculate the
policy parameters.
 
You must
use another
replenishment
plan, a demand
plan, or an external
forecast schedule
for the demand
forecast. The
planning time
level of the other
plan can be week,
 month, or period.
 

100 days or less
 

Day
 

Daily
 

Calculate
replenishments
and Rebalance
inventory check
boxes
 

Yes
 

Optionally, if you've selected the Calculate replenishments check box, you can also configure the replenishment plan
for end item substitution and supersession.

Related Topics
• How Replenishment Orders Are Calculated During Incremental Planning

• Overview of the Policy Comparison Feature

• Policy Assignment Sets

• Overview of Inventory Rebalancing

• Organizations and Schedules Options for Replenishment Plans

Example of Replenishment Plans for a Standard Business
Scenario  
This topic describes how you set up replenishment plans for a standard business scenario.
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In this example, an enterprise has a distribution center that's modeled as an organization. The distribution center
has buy from sourcing rules. The two warehouses, which are also set up as organizations, source goods from the
distribution center using transfer from sourcing rules. The customer demands are fulfilled through the warehouses. The
enterprise uses Oracle Fusion Cloud ERP.

Note these points about this example:

• You can use a single replenishment plan to generate the forecast, calculate the policy parameters, and calculate
and release replenishment orders for the distribution center and warehouses.

You can also use separate replenishment plans as follows:

◦ A replenishment plan generates the forecast at the distribution center by using transfer orders history
and shipments history.

This replenishment plan also calculates the policy parameters and calculates and releases the
replenishment orders for the distribution center.

◦ Another replenishment plan generates the forecast at the warehouses by using shipments history.

This replenishment plan also calculates the policy parameters and calculates and releases the
replenishment orders for the warehouses.

• If you're using a single replenishment plan for the distribution center and warehouses, when a planned transfer
order is created at the warehouses, an equivalent planned transfer order demand isn't automatically created for
the distribution center.

Planned transfer order demand is created at the distribution center once the planned transfer orders created at
the warehouses are released and collected.

• File-based data import (FBDI) templates can be used for uploading data instead of collecting it.

• At any level, you can use a single or separate replenishment plans to generate the forecast, calculate the policy
parameters, and calculate and release the replenishment orders.
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Guidelines for Working with Plan Messages for
Replenishment Plans  
This topic explains what the plan messages for replenishment plans mean and how you should work with them.

In the Replenishment Planning work area, you can view plan messages after a replenishment plan runs. By
understanding the root causes why policies and replenishments weren't calculated within the replenishment plan for
item-location combinations, you can take corrective actions.

Plan messages deal with these issues:

• The size and run of the replenishment plan

• The calculation of safety stock

• The calculation of average daily demand

• Other issues, such as the calculation of the economic order quantity (EOQ)

Messages Dealing with the Size and Run of the Replenishment Plan
This table lists plan messages that deal with the size and run of the replenishment plan:

Message Meaning Corrective Action

The following number of item and organization
combinations were included in the
replenishment plan: {COUNT}.
 

Indicates the number of item-location
combinations covered in the replenishment
plan and for which replenishment planning is
done.
 
The item-location combinations are in the
selected segments and level members on the
Scope tab on the Plan Options page for the
replenishment plan. Moreover, in Oracle Fusion
Cloud Product Lifecycle Management, for MPS
MRP planning, the planning method attribute is
set to Replenishment Planning for these items.
 

-
 

The plan was run in the Refresh with Current
Data mode because targeted collection was run.
 

Indicates that the replenishment plan is run
with current data even though the Enable for
incremental planning check box is selected on
the Plan Options page and the Refresh with
net-changed data option is selected under the
Details region on the Parameters tab in the Run
Plan dialog box. Current data is used because
the type of the previous collection was targeted.
 

-
 

Messages Dealing with the Calculation of Safety Stock
This table lists plan messages that deal with the safety stock for item-location combinations:
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Message Meaning Corrective Action

Safety stock wasn't calculated for item {ITEM} in
organization {ORG} because the MAPE wasn't
available.
 

Indicates that the safety stock isn't calculated
for the item-location combination.
 
This plan message is displayed because of
these reasons:
 

• In the policy assignment set that's
attached to the replenishment plan, for
the segment to which the item-location
combination belongs, on the Policy
Parameters subtab on the Segment-Level
Policy Parameters Assignment tab, you
selected Service level-based in Safety
Stock Calculation.

• The demand isn't intermittent.

• The mean average percentage error
(MAPE) isn't available for the item-
location combination in the demand plan,
replenishment plan, or external demand
schedule that's used as the demand
schedule for the replenishment plan.

Perform these steps:
 

1. Ensure that the MAPE is available for the
item-location combination in the demand
plan, replenishment plan, or external
demand schedule.

2. Run the replenishment plan:

◦ Under the Details region on the
Parameters tab in the Run Plan dialog box,
 select Refresh with current data.

◦ Select the Calculate policy parameters
check box.

Safety stock wasn't calculated for item {ITEM} in
organization {ORG} because the total lead time
was zero.
 

Indicates that the safety stock isn't calculated
for the item-location combination.
 
This plan message is displayed because of
these reasons:
 

• In the policy assignment set that's
attached to the replenishment plan, for
the segment to which the item-location
combination belongs, on the Policy
Parameters subtab on the Segment-Level
Policy Parameters Assignment tab, you
selected Service level-based in Safety
Stock Calculation.

• The demand isn't intermittent.

• The replenishment lead time, which is the
sum of the preprocessing, processing,
and postprocessing lead times and transit
time for a buy order or preprocessing and
postprocessing lead times and transit time
for a transfer order, is zero for the item-
location combination.

Perform these steps:
 

1. Set the preprocessing, processing, and
postprocessing lead times for the item-
location combination in Oracle Product
Lifecycle Management.

Set the transit time in the sourcing rule or
bill of distribution.

2. Run the collections process.
3. Run the replenishment plan:

◦ Under the Details region on the
Parameters tab in the Run Plan dialog box,
 select Refresh with current data.

◦ Select the Calculate policy parameters
check box.

Safety stock wasn't calculated for item {ITEM} in
organization {ORG} because average interarrival
time wasn't available.
 

Indicates that the safety stock isn't calculated
for the item-location combination.
 
This plan message is displayed because of
these reasons:
 

• In the policy assignment set that's
attached to the replenishment plan, for
the segment to which the item-location
combination belongs, on the Policy
Parameters subtab on the Segment-Level
Policy Parameters Assignment tab, you

Perform these steps:
 

1. Ensure that the average interarrival
time is available for the item-location
combination in the Items table.

2. Run the replenishment plan:

◦ Under the Details region on the
Parameters tab in the Run Plan dialog box,
 select Refresh with current data.

◦ Select the Calculate policy parameters
check box.
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Message Meaning Corrective Action

selected Service level-based in Safety
Stock Calculation.

• The demand is intermittent.

• The average interarrival time isn't available
for the item-location combination in the
Items table.

The intermittent demand indicator for item
{ITEM} in organization {ORG} was invalid. Safety
stock was set equal to average daily demand.
 

Indicates that the safety stock isn't calculated
for the item-location combination.
 
This plan message is displayed because of
these reasons:
 

• In the policy assignment set that's
attached to the replenishment plan, for
the segment to which the item-location
combination belongs, on the Policy
Parameters subtab on the Segment-Level
Policy Parameters Assignment tab, you
selected Service level-based in Safety
Stock Calculation.

• The value in the Intermittent Demand or
Intermittent Demand Override column
of the Items table for the item-location
combination is invalid.

• Consequently, the safety stock has been
set to the average daily demand for the
item-location combination.

Perform these steps:
 

1. Ensure that valid values are there in the
Intermittent Demand and Intermittent
Demand Override columns for the item-
location combination in the Items table.

2. Run the replenishment plan:

◦ Under the Details region on the
Parameters tab in the Run Plan dialog box,
 select Refresh with current data.

◦ Select the Calculate policy parameters
check box.

The uploaded safety stock quantity wasn't
considered for item-location combinations in
segment {SEG_NAME}.
 
Instead of the uploaded quantity, the safety
stock defined or calculated for the segment was
used because the policy UOM for the segment
is Days and not Units.
 

Indicates that the uploaded safety stock
quantity isn't considered for the item-location
combinations in the specified segment. Instead,
the safety stock override or calculated safety
stock for the segment is used.
 
This plan message is displayed because the
safety stock quantity was uploaded through
the file-based data import (FBDI) template
for Supply Chain Planning safety stock levels
(ScpSafetyStockLevelImportTemplate.xlsm).
The uploaded safety stock quantity is always in
units and takes precedence over the calculated
or override value for safety stock. However, the
unit of measure (UOM) for the segment is days
instead of units.
 

Perform these steps:
 

1. In the policy assignment set that's
attached to the replenishment plan, for
the segment, on the Policy Parameters
subtab on the Segment-Level Policy
Parameters Assignment tab, select Units
in Policy UOM.

2. Run the replenishment plan:

◦ Under the Details region on the
Parameters tab in the Run Plan dialog box,
 select Refresh with current data.

◦ Select the Calculate policy parameters
check box.

Messages Dealing with the Calculation of Average Daily Demand
This table lists plan messages that deal with the demand for item-location combinations:

Message Meaning Corrective Action

Average daily demand wasn't calculated for
item {ITEM} in organization {ORG}. Policies
weren't calculated.

Indicates that the average daily demand isn't
calculated for the item-location combination.
 

Perform these steps:
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Message Meaning Corrective Action

 This plan message is logged because
the demand history isn't present or the
forecast isn't generated for the item location
combination. Also, the default daily demand
isn't specified for the segment to which the
item-location combination belongs.
 

1. In the policy assignment set that's
attached to the replenishment plan, for
the segment to which the item-location
combination belongs, on the Policy
Parameters subtab on the Segment-
Level Policy Parameters Assignment tab,
if History is selected in Days of Cover
Basis, ensure that the demand history is
collected or uploaded.

If Forecast is selected in Days of Cover
Basis, ensure that the demand forecast is
there in the demand plan, replenishment
plan, or external demand schedule that's
used as the demand forecast.

Otherwise, specify a default daily demand
for the segment.

2. Run the replenishment plan:

◦ Under the Details region on the
Parameters tab in the Run Plan dialog box,
 select Refresh with current data.

◦ Select the Generate forecast and
Calculate policy parameters check boxes.

For segment {SEG}, the plan horizon days was
used for the horizon for average daily demand
because it's less than the horizon for average
daily demand.
 

Indicates that the number of days in the
planning horizon is taken for calculation of
the average daily demand for item-location
combinations in the segment.
 
This plan message is displayed because the
planning horizon is less than the value supplied
in the Horizon for Average Daily Demand
field on the Policy Parameters subtab on the
Segment-Level Policy Parameters Assignment
tab of the policy assignment set that's attached
to the replenishment plan.
 

If you want the specified horizon for average
daily demand to be considered, perform these
steps:
 

1. Decrease the horizon for the average daily
demand in the policy assignment set, or
increase the days in the planning horizon
by increasing the number of buckets on
the Scope tab on the Plan Options page
for the replenishment plan.

2. Run the replenishment plan:

◦ Under the Details region on the
Parameters tab in the Run Plan dialog box,
 select Refresh with current data.

◦ Select the Generate forecast and
Calculate policy parameters check boxes.

Messages Dealing with Other Issues
This table lists plan messages that deal with other issues:

Message Meaning Corrective Action

The following number of items in ORG {ORG}
were discarded because their planning method
isn't set to Replenishment Planning: {COUNT}.
 

Indicates the number of items in the location
for which replenishment planning isn't done.
 
The items are ignored because their MPS and
MRP Planning Method attribute isn't set to

Perform these steps:
 

1. Set the attribute for the items in Oracle
Product Lifecycle Management.

2. Run the collections process.
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Message Meaning Corrective Action

Replenishment planning in Oracle Product
Lifecycle Management.
 

3. Run the replenishment plan:

◦ Under the Details region on the
Parameters tab in the Run Plan dialog box,
 select Refresh with current data.

◦ Select the Generate forecast, Calculate
policy parameters, and Calculate
replenishments check boxes.

The plan created 10 supplies on a single day for
item {ITEM} in organization {ORG}. Check the
order modifiers.
 

Indicates that 10 replenishment orders are
created for the item-location combination on a
day.
 
This plan message is displayed because of
these reasons:
 

• The fixed order quantity order modifier or
EOQ is used with a very small value, and
many planned orders with small quantities
are generated.

• For reducing the number of planned
orders and improving the replenishment
plan performance, the first nine planned
orders are generated according to the
order modifiers, and the remaining
planned orders are grouped into the 10th
planned order.

The 10th planned order might violate the
order modifiers and therefore won't be
released.

Perform these steps:
 

1. Review and modify the value in the Fixed
Order Quantity column of the Items table
for the item-location combination.

Otherwise, review and modify the inputs
for calculating the EOQ or default EOQ for
the item-location combination.

2. Run the replenishment plan:

◦ Under the Details region on the
Parameters tab in the Run Plan dialog box,
 select Refresh with current data.

◦ Select the Calculate replenishments
check box.

Policy parameters weren't found for segment
{SEGMENT}. Policies weren't calculated for the
item and location combinations that were part
of this segment.
 

Indicates that replenishment policies aren't
calculated for the item-location combinations in
the segment.
 
In the policy assignment set that's attached
to the replenishment plan, policy parameters
aren't specified for the segment. Therefore,
no policies are calculated for the item-location
combinations in the segment.
 

Perform these steps:
 

1. In the policy assignment set, specify policy
parameters for the segment.

2. Run the replenishment plan:

◦ Under the Details region on the
Parameters tab in the Run Plan dialog box,
 select Refresh with current data.

◦ Select the Calculate policy parameters
check box.

EOQ wasn't calculated for item {ITEM}
in organization {ORG}. Check Item cost
components.
 

Indicates that the EOQ isn't calculated for the
item-location combination.
 
This plan message is displayed because of
these reasons:
 

• In the policy assignment set that's
attached to the replenishment plan, for
the segment to which the item-location
combination belongs, the policy type is
one of the following:

◦ Reorder point (ROP) and EOQ

Perform these steps:
 

1. Check that values are present for the item-
location combination in the Items table for
the various components of the formula for
EOQ calculation.

2. If any values are missing in the Items table,
 do one of these steps:

◦ Provide the values in the Items table.

◦ In the policy assignment set, enter the
required defaults for the EOQ formula or
the default EOQ for the segment to which
the item-location combination belongs.
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Message Meaning Corrective Action

◦ Min-max planning or fixed order cycle,
and the maximum quantity calculation
method is minimum plus EOQ.

• For the segment to which the item-
location combination belongs, the default
EOQ isn't specified on the Default Policy
Parameters subtab on the Segment-Level
Policy Parameters Assignment tab in the
policy assignment set.

• The fixed cost per order isn't available
for the item-location combination in the
Order Cost column of the Items table.

• The annual carrying cost isn't available
for the item-location combination in
the Annual Carrying Cost Percentage
column of the Items table.

• The standard cost isn't available for
the item-location combination in the
Standard Cost column of the Item table,
 or the default standard cost isn't specified
for the segment on the Default Policy
Parameters subtab.

3. Run the replenishment plan:

◦ Under the Details region on the
Parameters tab in the Run Plan dialog box,
 select Refresh with current data.

◦ Select the Calculate policy parameters
check box.

Forecast and policy values haven't been
calculated for items in organization {ORG}.
 
Valid manufacturing calendar data isn't
available for the organization. To get the
forecast and policy values, collect the calendar
data, and rerun the replenishment plan.
 

Indicates that the forecast and policy values
aren't calculated for the items in the specified
location.
 
This plan message is displayed because the
manufacturing calendar isn't available for the
location.
 

Perform these steps:
 

1. Ensure that the manufacturing calendar is
available for the location.

2. Run the collections process.
3. Run the replenishment plan:

◦ Under the Details region on the
Parameters tab in the Run Plan dialog box,
 select Refresh with current data.

◦ Select the Generate forecast, Calculate
policy parameters, and Calculate
replenishments check boxes.

Related Topics
• How Safety Stock Is Calculated in Oracle Replenishment Planning

• How Average Daily Demand Is Calculated in Oracle Replenishment Planning

• Policy Assignment Sets

• How EOQ Is Calculated in Oracle Replenishment Planning

• Run a Replenishment Plan
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13  Calculation and Release of Replenishment
Orders

Overview of Replenishment Order Release  
This topic provides an overview of how replenishment orders are calculated and released.

While setting up your replenishment plan, on the General subtab of the Supply tab of the Plan Options page, you can
choose to release replenishment orders automatically or manually after the plan run.

The released replenishment orders are sent to Oracle Supply Chain Orchestration, from where the buy orders are
released to Oracle Fusion Cloud Procurement and transfer orders to Oracle Fusion Cloud Inventory Management. The
replenishment orders can also be released to external source systems as CSV files.

These are some points to note about replenishment orders:

• Replenishment orders are generated on the basis of policies.

• Replenishment orders are forward-planned according to unconstrained, supply planning logic.

• Once replenishment orders are released, they can't be rescheduled or canceled from the Replenishment
Planning work area.

• Reservations, supplier capacity, planning time fences, and demand time fences aren't supported in Oracle
Replenishment Planning.

• When a planned transfer order is created, the corresponding dependent demand isn't directly created in the
source organization. Instead, when the released transfer order is collected, dependent demand is created in the
source organization.

Related Topics
• Automatic Release Options

Measures Used for Calculating Replenishment Orders  
This topic lists the measures that are used for calculating replenishment orders.

Measure Description

Beginning Inventory Position
 

This measure indicates the projected inventory at the beginning of a plan bucket for an item-location
combination and drives the creation of replenishment orders.
 
The calculation of the measure is determined by the selection in the Time Horizon for Demand list on
the General subtab of the Supply tab of the Plan Options page for a replenishment plan:
 

• If the selection is Item lead time, the measure is calculated as follows: Projected Available
Balance + On Order - demand during item lead time.

311



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 13
Calculation and Release of Replenishment Orders

Measure Description

The current day's demand is already included in the calculation of the Projected Available Balance
measure and is therefore excluded from the calculation of the demand during item lead time.

• If the selection is None, the measure is calculated as follows: Projected Available Balance + On
Order

Final Inventory Position
 

This measure indicates the projected inventory position at the end of the plan bucket for the item-
location combination. This measure includes the replenishment orders that are required to bring the
inventory to the maximum quantity or reorder point (ROP).
 
The measure is calculated as follows: Beginning Inventory Position + Planned Replenishments by Order
Date
 

Planned Replenishments by Order Date
 

This measure indicates the planned replenishment quantity on the order date for the item-location
combination.
 

Planned Replenishments by Due Date
 

This measure indicates the planned replenishment quantity on the due date for the item-location
combination.
 

On Order
 

This measure indicates the quantity of projected replenishments that are to be received for the item-
location combination.
 
For planned replenishment orders, the measure is populated from the day after the order date to the
day before the due date. On the day a replenishment order is scheduled to be received (the due date),
 the Projected Available Balance measure is increased by the order quantity, and the On Order measure
is reduced by the order quantity. For the existing buy and transfer orders that are collected, the On
Order measure is populated from the order date.
 

Related Topics
• Considerations for Configuring Replenishment Plan Attributes

Support for Create Supply and Create Supply After
Attributes in Oracle Replenishment Planning  
Your settings for the Create Supply and Create Supply After attributes for an item affect how replenishments are created
for the item.

If the sourcing rule for an item is buy from, the replenishment is created only when you've selected Yes in the
Create Supply field for the item in the Product Information Management work area. If you've specified a date in
the Create Supply After field, the replenishment is created only after that date. These values can also be supplied
through the equivalent columns in the file-based data import (FBDI) template named Supply Chain Planning Items
(ScpItemImportTemplate.xlsm). The values for the fields or columns take effect only after being collected.

This functionality is useful in situations such as these:

• You want to temporarily recall the item.

• You want to place a quality hold on the item until a date.
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• The item has been superseded by another item.

If no sourcing rule is specified for the item, it's treated as a buy item, and a replenishment is created according to the
values for the Create Supply and Create Supply After attributes.

You can change the values for these attributes in a simulation set.

Note:  If the sourcing rule for the item is transfer from, the replenishment is created irrespective of your settings for
these attributes.

Related Topics
• Support for Sourcing Rules and Bills of Distribution in Oracle Replenishment Planning

Support for Sourcing Rules and Bills of Distribution in
Oracle Replenishment Planning  
This topic explains how Oracle Replenishment Planning supports sourcing rules and bills of distribution.

Sourcing rules and bills of distribution are assigned to items at various levels on the Edit Assignment Set page.

When replenishment orders are calculated, sourcing rules and bills of distribution are supported as follows:

• Sourcing rules and bills of distribution of the buy from and transfer from types are supported.

• Sourcing rules and bills of distribution of the make at type aren't supported.

• Both global and local sourcing rules are supported.

• Only Rank 1 sourcing rules and bills of distribution are supported.

• Split sourcing rules and bills of distribution aren't supported.

• The transit times specified for shipping methods are considered.

• If no sourcing rule is defined for an item-location combination, the buy from sourcing rule is used as the
default, and the supplier attributes are taken from the Items table.

Related Topics
• Create a Sourcing Rule

• Create an Assignment Set

Examples of Replenishment Orders for Different Policy
Types  
This topic explains how replenishment orders are calculated for different policy types.
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Min-Max Planning
The following is how a replenishment order is calculated for the min-max policy type:

• When the Beginning Inventory Position measure (the sum of the Projected Available Balance and On Order
measures) equals or falls below the minimum quantity, a replenishment order is triggered.

• The quantity of the replenishment order is what's required to bring the inventory up to the maximum quantity
(provided by Maximum Quantity - Beginning Inventory Position).

Consider the example in the following table:

Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12

Total
Demand
 

10
 

15
 

5
 

15
 

20
 

10
 

15
 

10
 

20
 

15
 

10
 

10
 

Final
Minimum
Quantity
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

Final
Maximum
Quantity
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

On Hand
 

25
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Purchase
Orders
 

0
 

10
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Total
Supply
 

25
 

10
 

0
 

75
 

0
 

0
 

0
 

55
 

0
 

0
 

0
 

55
 

Projected
Available
Balance
 

15
 

10
 

5
 

65
 

45
 

35
 

20
 

65
 

45
 

30
 

20
 

65
 

On Order
 

10
 

75
 

75
 

0
 

0
 

55
 

55
 

0
 

0
 

55
 

55
 

0
 

Beginning
Inventory
Position
 

25
 

85
 

80
 

65
 

45
 

90
 

75
 

65
 

45
 

85
 

75
 

65
 

Planned
Replenishments
by Order
Date
 

75
 

0
 

0
 

0
 

55
 

0
 

0
 

0
 

55
 

0
 

0
 

0
 

Planned
Replenishments
by Due
Date

0
 

0
 

0
 

75
 

0
 

0
 

0
 

55
 

0
 

0
 

0
 

55
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12

 

Final
Inventory
Position
 

100
 

85
 

80
 

65
 

100
 

90
 

75
 

65
 

100
 

85
 

75
 

65
 

The Beginning Inventory Position measure is evaluated every day. On Day 1, the Beginning Inventory Position measure
is 25 units, which is less than the Final Minimum Quantity measure of 50 units. Therefore, a replenishment order of
75 units is created (Final Maximum Quantity - Beginning Inventory Position). The order date is Day 1, and the item
lead time is 3 days. Therefore, the Planned Replenishments by Due Date measure is updated for Day 4, while the On
Order measure reflects 75 units on Days 2 and 3. On Day 4, the order is received in the inventory, and the Total Supply
measure is updated.

The sequence is repeated on Days 5 and 9.

Fixed Order Cycle
The following is how a replenishment order is calculated for the fixed order cycle policy type:

• The replenishment orders are placed on only the open days defined in the associated fixed order cycle calendar.

• When the Beginning Inventory Position measure (the sum of the Projected Available Balance and On Order
measures) falls below the maximum quantity, a replenishment order is triggered.

• The quantity of the replenishment order is what's required to bring the inventory up to the maximum quantity
(provided by Maximum Quantity - Beginning Inventory Position).

Consider the example in the following table:

Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12

Total
Demand
 

10
 

15
 

5
 

15
 

20
 

10
 

15
 

10
 

20
 

15
 

10
 

10
 

Final
Maximum
Quantity
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

On Hand
 

25
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Purchase
Orders
 

0
 

10
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Total
Supply
 

25
 

10
 

0
 

75
 

0
 

0
 

0
 

0
 

0
 

0
 

90
 

0
 

Projected
Available
Balance
 

15
 

10
 

5
 

65
 

45
 

35
 

20
 

10
 

- 10
 

-25
 

55
 

45
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12

On Order
 

10
 

75
 

75
 

0
 

0
 

0
 

0
 

0
 

90
 

90
 

0
 

0
 

Beginning
Inventory
Position
 

25
 

85
 

80
 

65
 

45
 

35
 

20
 

10
 

80
 

65
 

55
 

45
 

Planned
Replenishments
by Order
Date
 

75
 

0
 

0
 

0
 

0
 

0
 

0
 

90
 

0
 

0
 

0
 

0
 

Planned
Replenishments
by Due
Date
 

0
 

0
 

0
 

75
 

0
 

0
 

0
 

0
 

0
 

0
 

90
 

0
 

Final
Inventory
Position
 

100
 

85
 

80
 

65
 

45
 

35
 

20
 

100
 

80
 

65
 

55
 

45
 

The associated fixed order cycle calendar is open on only Days 1 and 8.

On Day 1, the Beginning Inventory Position measure is 25 units, which is less than the Final Maximum Quantity measure
of 100 units. Therefore, a replenishment order of 75 units is placed (Final Maximum Quantity - Beginning Inventory
Position). The order date is Day 1, and the item lead time is 3 days. Therefore, the Planned Replenishments by Due Date
measure is updated for Day 4, while the On Order measure reflects 75 units on Days 2 and 3. On Day 4, the order is
received in the inventory, and the Total Supply measure is updated.

The sequence is repeated on Day 8.

ROP and Order Quantity
The following is how a replenishment order is calculated for the reorder point (ROP) and order quantity policy type:

• When Beginning Inventory Position measure (the sum of the Projected Available Balance and On Order
measures) equals or falls below the ROP, a replenishment order is triggered.

• The quantity of the replenishment order is the order quantity.

• If the fixed order quantity isn't defined in the Items table or the default order quantity isn't defined at the
segment level in the policy assignment set, replenishment orders are created to bring the inventory to the ROP
level.

Consider the example in the following table:

Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12

Total
Demand
 

10
 

15
 

5
 

15
 

20
 

10
 

15
 

10
 

40
 

15
 

10
 

10
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12

Final
ROP
Quantity
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

On Hand
 

25
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Purchase
Orders
 

0
 

10
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Total
Supply
 

25
 

10
 

0
 

75
 

0
 

0
 

0
 

75
 

0
 

0
 

0
 

75
 

Projected
Available
Balance
 

15
 

10
 

5
 

65
 

45
 

35
 

20
 

85
 

45
 

30
 

20
 

85
 

On Order
 

10
 

75
 

75
 

0
 

0
 

75
 

75
 

0
 

0
 

75
 

75
 

0
 

Beginning
Inventory
Position
 

25
 

85
 

80
 

65
 

45
 

110
 

95
 

85
 

45
 

105
 

95
 

85
 

Planned
Replenishments
by Order
Date
 

75
 

0
 

0
 

0
 

75
 

0
 

0
 

0
 

75
 

0
 

0
 

0
 

Planned
Replenishments
by Due
Date
 

0
 

0
 

0
 

75
 

0
 

0
 

0
 

75
 

0
 

0
 

0
 

75
 

Final
Inventory
Position
 

100
 

85
 

80
 

65
 

120
 

110
 

95
 

85
 

120
 

105
 

95
 

85
 

The order quantity is 75 units, and the Beginning Inventory Position measure is evaluated every day.

On Day 1, the Beginning Inventory Position measure is 25 units, which is less than the Final ROP Quantity measure of 50
units. Therefore, a replenishment order of 75 units (the order quantity) is placed. The order date is Day 1, and the item
lead time is 3 days. Therefore, the Planned Replenishments by Due Date measure is updated for Day 4, while the On
Order measure reflects 75 units on Days 2 and 3. On Day 4, the order is received in the inventory, and the Total Supply
measure is updated.

The sequence is repeated on Days 5 and 9.
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ROP and EOQ
The following is how a replenishment order is calculated for the ROP and economic order quantity (EOQ) policy type:

• When the Beginning Inventory Position measure (the sum of the Projected Available Balance and On Order
measures) equals or falls below the ROP, a replenishment order is triggered.

• The quantity of the replenishment order is the EOQ.

• If the EOQ can't be calculated at the item-location level or the default EOQ isn't defined at the segment level in
the policy assignment set, replenishment orders are created to bring the inventory to the ROP level.

Consider the example in the following table:

Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12

Total
Demand
 

10
 

15
 

5
 

15
 

20
 

10
 

15
 

10
 

40
 

15
 

10
 

10
 

Final
ROP
Quantity
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

On Hand
 

25
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Purchase
Orders
 

0
 

10
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Total
Supply
 

25
 

10
 

0
 

75
 

0
 

0
 

0
 

75
 

0
 

0
 

0
 

75
 

Projected
Available
Balance
 

15
 

10
 

5
 

65
 

45
 

35
 

20
 

85
 

45
 

30
 

20
 

85
 

On Order
 

10
 

75
 

75
 

0
 

0
 

75
 

75
 

0
 

0
 

75
 

75
 

0
 

Beginning
Inventory
Position
 

25
 

85
 

80
 

65
 

45
 

110
 

95
 

85
 

45
 

105
 

95
 

85
 

Planned
Replenishments
by Order
Date
 

75
 

0
 

0
 

0
 

75
 

0
 

0
 

0
 

75
 

0
 

0
 

0
 

Planned
Replenishments
by Due
Date
 

0
 

0
 

0
 

75
 

0
 

0
 

0
 

75
 

0
 

0
 

0
 

75
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12

Final
Inventory
Position
 

100
 

85
 

80
 

65
 

120
 

110
 

95
 

85
 

120
 

105
 

95
 

85
 

The EOQ is 75 units, and the Beginning Inventory Position measure is evaluated every day.

On Day 1, the Beginning Inventory Position measure is 25 units, which is less than the Final ROP Quantity measure of 50
units. Therefore, a replenishment order of 75 units (the EOQ) is placed. The order date is Day 1, and the item lead time is
3 days. Therefore, the Planned Replenishments by Due Date measure is updated for Day 4, while the On Order measure
reflects 75 units on Days 2 and 3. On Day 4, the order is received in the inventory, and the Total Supply measure is
updated.

The sequence is repeated on Days 5 and 9.

Related Topics
• Policy Assignment Sets

How Order Modifiers Are Applied When Replenishments
Are Calculated  
This topic explains how order modifiers are applied when replenishments are calculated for a replenishment plan.

Settings That Affect How Order Modifiers Are Applied to Replenishments
The policy type specified in the policy assignment set that's attached to the replenishment plan affects how order
modifiers are applied to the calculated replenishments.

How Order Modifiers Are Applied to Replenishments
This table describes how order modifiers are applied to replenishments calculated for the replenishment plan when the
policies are of different types:

Policy Type How Order Modifiers Are Applied Example

Min-max planning
 

The order modifiers specified in the Fixed Lot
Multiplier, Minimum Order Quantity, Maximum
Order Quantity, and Fixed Order Quantity
columns of the Items table are applied to the
replenishment order quantity.
 
The minimum order quantity and fixed lot
multiplier can also be defined at the supplier
level.
 
Here's how the modifiers are used:

If the minimum quantity is 50, maximum
quantity is 100, beginning inventory position
(sum of the projected available balance and on
order quantity) is 40, and fixed order quantity is
50, the replenishment order quantity is 60 (100
- 40). Two replenishment orders of 50 each are
created.
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Policy Type How Order Modifiers Are Applied Example

 
• If the replenishment order quantity is less

than the minimum order quantity, the
former is increased to the latter.

• If the replenishment order quantity is
more than the maximum order quantity,
 the former is decreased to the latter.

• If the replenishment order quantity isn't
a multiple of the fixed lot multiplier, the
former is converted into a multiple of the
latter.

• If the fixed order quantity is defined, it's
used as the replenishment order quantity.

Fixed order cycle
 

The order modifiers are specified and used as
explained for the min-max planning policy type.
 

If the maximum quantity is 100, beginning
inventory position (sum of the projected
available balance and on order quantity)
is 80, and fixed lot multiplier is 50, the
replenishment order quantity is 20 (100 - 80).
One replenishment order of 50 is created.
 

Reorder point (ROP) and order quantity
 

Not applicable
 

Not applicable
 

ROP and economic order quantity (EOQ)
 

Not applicable
 

Not applicable
 

For buy orders, the order modifiers and lead times defined at the item-supplier level are considered before those
defined at the item-organization level.

Aggregate Planning Buckets and Replenishment Orders  
This topic explains how aggregate planning buckets are used with replenishment orders.

Replenishment Calculation in Aggregate Planning Buckets
For planning buckets at a time level higher than a day, the following is how replenishments are calculated:

• Policies and replenishments are calculated at the daily level and subsequently aggregated and published at the
bucket level.

• Measure values are aggregated and displayed at the bucket level.

• Replenishment orders and demands are pushed to the ends of the aggregate planning buckets.

On the General subtab on the Supply tab on the Plan Options page for a replenishment plan, in the
Replenishment Plan Attributes section, if Yes is selected in Aggregate Planned Orders, the planned orders for
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each day are aggregated into one large order that's pushed to the end of the aggregate planning bucket. While
the number of planned orders is reduced, order modifiers might be violated.

If No is selected, the planned orders generated daily are pushed to the end of the aggregate planning bucket.
These planned orders aren't aggregated into one large order and don't violate order modifiers.

However, if the fixed order quantity order modifier or economic order quantity (EOQ) is used with a very small
value, the replenishment plan might generate too many planned orders with small quantities. For reducing the
number of planned orders and improving the replenishment plan performance, the first nine planned orders
are generated according to the order modifiers, and the tenth planned order is generated for the remaining
quantities and might violate the order modifiers. The tenth planned order can't be released. The generated
orders are pushed to the end of the aggregate planning bucket, and this process is followed on every day of the
aggregate planning bucket.

• If a replenishment plan with a planning time level higher than a day is used for releasing replenishment orders,
the bucket start dates are used as the dock dates.

Normally, such a plan isn't used for releasing replenishment orders.

• In a plan with an aggregate time level, the logic for calculating and releasing planned orders is the same
whether the functionality for multiechelon replenishment planning is used or not.

Example of Replenishment Calculation for Weekly Planning Buckets
In this example, replenishments are calculated for a replenishment plan with weekly planning buckets for the min-max
planning policy type. The Minimum Quantity measure is 50 units, and the Maximum Quantity measure is 100 units.

Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12 Day 13 Day 14

Gross
Forecast
 

0
 

0
 

0
 

0
 

0
 

0
 

70
 

0
 

0
 

0
 

0
 

0
 

0
 

140
 

Total
Demand
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

20
 

20
 

20
 

20
 

20
 

20
 

20
 

On
Hand
 

25
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Purchase
Orders
 

0
 

10
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Total
Supply
 

25
 

10
 

0
 

75
 

0
 

0
 

0
 

0
 

0
 

60
 

0
 

0
 

60
 

0
 

Projected
Available
Balance
 

15
 

15
 

5
 

70
 

60
 

50
 

40
 

20
 

0
 

40
 

20
 

0
 

40
 

20
 

On
Order
 

10
 

75
 

75
 

0
 

0
 

0
 

0
 

60
 

60
 

0
 

60
 

60
 

0
 

60
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9 Day 10 Day 11 Day 12 Day 13 Day 14

Beginning
Inventory
Position
 

25
 

90
 

80
 

70
 

60
 

50
 

40
 

80
 

60
 

40
 

80
 

60
 

40
 

80
 

Planned
Replenishments
by
Order
Date
 

75
 

0
 

0
 

0
 

0
 

0
 

60
 

0
 

0
 

60
 

0
 

0
 

60
 

0
 

Planned
Replenishments
by Due
Date
 

0
 

0
 

0
 

75
 

0
 

0
 

0
 

0
 

0
 

60
 

0
 

0
 

60
 

0
 

Final
Inventory
Position
 

100
 

90
 

80
 

70
 

60
 

50
 

100
 

80
 

60
 

100
 

80
 

60
 

100
 

80
 

The weekly forecast is spread in daily buckets, and the Beginning Inventory Position measure is evaluated every day.
On Day 1, the Beginning Inventory Position measure is 25 units, which is less than the Minimum Quantity measure of
50 units. Therefore, a replenishment order of 75 units is created (Maximum Quantity – Beginning Inventory Position).
Similarly, on Day 7, a replenishment order of 60 units is created. These two replenishment orders are pushed to the end
of the bucket for Week 1.

On Days 10 and 13, two more replenishment orders are created and pushed to the end of the bucket for Week 2.

When the replenishment plan is viewed through the Replenishment Workbench table, the results are aggregated as
follows:

Measure Week 1 Week 2

Gross Forecast
 

70
 

140
 

Total Demand
 

70
 

140
 

On Hand
 

25
 

0
 

Purchase Orders
 

10
 

0
 

Total Supply
 

110
 

120
 

Projected Available Balance
 

40
 

20
 

On Order
 

0
 

60
 

Beginning Inventory Position 40 80
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Measure Week 1 Week 2

   

Planned Replenishments by Order Date
 

135
 

120
 

Planned Replenishments by Due Date
 

75
 

120
 

Final Inventory Position
 

100
 

80
 

Related Topics
• Considerations for Configuring Replenishment Plan Attributes

• Best Practices for Setting Up Replenishment Plans

How Replenishment Orders Are Calculated During
Incremental Planning  
This topic explains how replenishment orders are calculated when incremental planning is done.

When incremental planning is enabled for a replenishment plan, replenishment planning is done for only those item-
location combinations for which there are net changes in supplies and demands. So, the runtime for the replenishment
plan is less. Only actual demands (demand for sales orders, transfer orders, and inventory position) are considered
during replenishment calculation, and you can't select another replenishment plan, a demand plan, or an external
forecast schedule for the demand forecast.

The net change collection must be run for supplies and demands before every incremental planning run. Changed item-
location combinations are identified during incremental planning only through the net change collection.

New item-location combinations aren't covered by incremental planning. For such item-location combinations, you
must first run the replenishment plan again with the Refresh with current data option selected on the Parameters tab
in the Run Plan dialog box. Then, incremental planning can be done for these item-location combinations in later plan
runs.

In a replenishment plan that's enabled for incremental planning and end item substitution and supersession, if an item
with a change in net supplies and demands is a part of a substitution or supersession chain, then the entire chain is
replanned.

In a multiechelon replenishment plan that's enabled for incremental planning, if the demand or supply of an item
is changed, it's replanned at all echelons. A bottom-up pass for unconstrained planning and a top-down pass for
constrained planning are performed. If you change the supply or demand for an item that's part of a substitution or
supersession chain, the entire chain is replanned at all echelons. A bottom-up pass for unconstrained planning and a
top-down pass for constrained planning are performed.

The hold date and expiration date for an on-hand lot are supported in a replenishment plan that's enabled for
incremental planning. When a day is added to the planning horizon, for an item-location combination with no change in
net supplies and demands, the value of the Expired Lot Quantity measure is null.
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Settings for Incremental Calculation of Replenishment Orders
For incrementally calculating replenishment orders, you must take these steps:

• On the Plan Options page for the replenishment plan, select the Enable for incremental planning and
Calculate replenishments check boxes.

When you select the check boxes, the following happen:

◦ The Generate forecast, Calculate policy parameters, and Rebalance inventory check boxes are grayed
out.

◦ In the Plan Parameters section on the Scope tab, Day is selected in the Planning Time Level field, and
it's grayed out.

◦ Incremental Replenishment Planning Default Catalog is selected in the Measure Catalog field, and it's
grayed out.

• To automatically release replenishment orders after incremental planning, take these steps:

◦ On the General subtab on the Supply tab on the Plan Options page, in Automatic Release Parameters,
select the Release planned orders automatically check box.

◦ On the General tab in the Supply: Advanced Options dialog box that you open from the General subtab,
refine the parameters for automatically releasing replenishment orders.

◦ In the Items table, edit the values for the Release Time Fence Type and Release Time Fence Days
columns for item-location combinations as discussed in the topic titled How Replenishment Orders Are
Automatically Released in this chapter.

• On the Organizations and Schedules subtab on the Supply tab, in Demand Schedules, select another
replenishment plan for providing the policy parameters to the plan that you're using for incremental planning.

• On the Parameters tab on the Collect Planning Data page, select Net change in the Collection Type field.

• On the Parameters tab in the Run Plan dialog box, select Refresh with net-changed data.

When you run the replenishment plan for the first time, you must select the Refresh with current data option,
and the Refresh with net-changed data option is grayed out.

How Replenishment Orders Are Calculated During Incremental Planning
In this example, replenishment orders are incrementally calculated for a replenishment plan that uses the min-max
planning policy type and has a maximum quantity of 100 units, minimum quantity of 50 units, and planning horizon of
7 days.

The following table depicts how replenishment orders are incrementally calculated on Day 1 for an item-location
combination:

Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7

Sales Orders
 

10
 

15
 

5
 

15
 

20
 

10
 

15
 

On Hand
 

25
 

0
 

0
 

0
 

0
 

0
 

0
 

Purchase Orders
 

0
 

10
 

0
 

0
 

0
 

0
 

0
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7

Total Supply
 

25
 

10
 

0
 

75
 

0
 

0
 

0
 

Projected
Available
Balance
 

15
 

10
 

5
 

65
 

45
 

35
 

20
 

On Order
 

10
 

75
 

75
 

0
 

0
 

55
 

55
 

Beginning
Inventory
Position
 

25
 

85
 

80
 

65
 

45
 

90
 

75
 

Planned
Replenishments
by Order Date
 

75
 

0
 

0
 

0
 

55
 

0
 

0
 

Planned
Replenishments
by Due Date
 

0
 

0
 

0
 

75
 

0
 

0
 

0
 

Final Inventory
Position
 

100
 

85
 

80
 

65
 

100
 

90
 

75
 

The following is how a replenishment order is calculated for the min-max policy type:

• When the Beginning Inventory Position measure (Projected Available Balance + On Order) equals or falls below
the minimum quantity, a replenishment order is triggered.

• The quantity of the replenishment order is what's required to bring the inventory up to the maximum quantity
(Maximum Quantity - Beginning Inventory Position).

The Beginning Inventory Position measure is evaluated every day. On Day 1, the Beginning Inventory Position measure
is 25 units, which is less than the minimum quantity of 50 units. Therefore, a replenishment order of 75 units is created
(Maximum Quantity - Beginning Inventory Position). The order date is Day 1, and the item lead time is 3 days. Therefore,
the Planned Replenishments by Due Date measure is updated for Day 4, while the On Order measure reflects 75 units
on Days 2 and 3. On Day 4, the order is received in the inventory, and the Total Supply measure is updated.

On Days 2, 3, and 4, the Beginning Inventory Position measure is above the minimum quantity. Therefore, no new
replenishments are needed. On Day 5, the Beginning Inventory Position measure is below the minimum quantity, and a
replenishment order of 55 units is created.

The following table depicts how replenishment orders are incrementally calculated on Day 2 for the item-location
combination:

Measure Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8

Sales Orders
 

15
 

5
 

35
 

20
 

10
 

15
 

0
 

On Hand 15 0 0 0 0 0 0
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Measure Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8

        

Purchase Orders
 

10
 

0
 

0
 

0
 

0
 

0
 

0
 

Total Supply
 

25
 

0
 

75
 

0
 

0
 

55
 

0
 

Projected
Available
Balance
 

10
 

5
 

45
 

25
 

15
 

55
 

55
 

On Order
 

75
 

75
 

0
 

55
 

55
 

0
 

0
 

Beginning
Inventory
Position
 

85
 

80
 

45
 

80
 

70
 

55
 

55
 

Planned
Replenishments
by Order Date
 

0
 

0
 

55
 

0
 

0
 

0
 

0
 

Planned
Replenishments
by Due Date
 

0
 

0
 

75
 

0
 

0
 

55
 

0
 

Final Inventory
Position
 

85
 

80
 

100
 

80
 

70
 

55
 

55
 

Day 8 is added to the planning horizon. Day 4 has a new sales order. For that reason, the incremental planning is
done again for the item-location combination. If there had been no change in the supply and demand for the item-
location combination, the measure values for Day 7 would have been copied as the measure values for Day 8, and no
incremental planning would have been done.

Related Topics
• Scope Plan Options for Replenishment Plans

• Automatic Release Options

• Release Recommendation Options

• Organizations and Schedules Options for Replenishment Plans

• Data Collection Types for Supply Chain Planning
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How Lead Time Is Calculated for Buy Orders and Transfer
Orders  
During the calculation of policies and replenishment orders, the calculation of the lead time for a buy order is different
from that for a transfer order.

These points explain how the lead time is calculated for a buy order:

• If an assignment set is attached to the replenishment plan, these points apply:
◦ The lead time is the total of the preprocessing, processing, and postprocessing lead times and transit

time.
◦ The preprocessing and postprocessing lead times are taken from the Items table for the item-location

combination.
◦ The transit time is taken from the sourcing rule or bill of distribution for the item in the assignment set. If

no transit time is defined or available, it's considered as zero.
◦ The item-supplier processing lead time from the approved supplier list (ASL) is taken as the processing

lead time. If the item-supplier processing lead time isn't defined, the processing lead time is taken from
the Items table for the item-location combination.

• If no assignment set is attached to the replenishment plan, the lead time is the total of the preprocessing,
processing, and postprocessing lead times for the item-location combination in the Items table.

These points explain how the lead time is calculated for a transfer order:

• If an assignment set is attached to the replenishment plan, these points apply:
◦ The lead time is the total of the preprocessing and postprocessing lead times and transit time.

◦ The preprocessing and postprocessing lead times are taken from the Items table for the item-location
combination.

◦ The transit time is taken from the sourcing rule or bill of distribution for the item in the assignment set. If
no transit time is defined or available, it's considered as zero.

• If no assignment set is attached to the replenishment plan, the lead time is the total of the preprocessing,
processing, and postprocessing lead times for the item-location combination in the Items table.

These additional points determine how the lead time for the buy or transfer order is calculated:

• The transit time is taken from the Rank 1 sourcing rule or bill of distribution with the highest allocation
percentage.

• Only those sourcing rules and bills of distribution that are active as on the replenishment plan's start date are
considered.

Related Topics
• Support for Sourcing Rules and Bills of Distribution in Oracle Replenishment Planning

Scheduling of Replenishment Orders  
This topic explains how buy and transfer replenishment orders are scheduled.
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Scheduling of Buy Orders
Buy orders are forward scheduled from the suggested order date.

These points govern the scheduling of buy orders:

• All valid shipping, organization receiving, supplier, transit, and manufacturing calendars are considered.

• The processing lead time defined at the supplier level is first considered. Otherwise, the processing lead time
defined in the Items table is considered. The preprocessing and postprocessing lead times defined in the Items
table are also considered.

• The preprocessing and postprocessing lead times are calculated according to the manufacturing calendar.

• The transit time is calculated according to the transit calendar.

• The processing lead time is calculated according to the supplier calendar.

• Supplier capacity isn't considered.

This figure depicts how various dates are determined for a buy replenishment order. The preprocessing lead time is
added to the suggested order date for calculation of the suggested start date. The processing lead time is added to
the suggested start date for calculation of the suggested ship date. The transit time is added to the suggested ship
date for calculation of the suggested dock date. The postprocessing lead time is added to the suggested dock date for
calculation of the suggested due date.

The suggested order date takes the manufacturing calendar into account, suggested start date takes the supplier
calendar into account, suggested ship date takes the supplier shipping calendar into account, suggested dock date
takes the organization receiving calendar into account, and suggested due date takes the manufacturing calendar into
account.

For example, if Saturday and Sunday aren't working days, the suggested dock date is Friday, and the postprocessing
lead time is 1 day, the suggested due date is Monday.

Scheduling of Transfer Orders
Transfer orders are forward scheduled from the suggested order date.

These points govern the scheduling of transfer orders:

• All valid shipping, receiving, transit, and manufacturing calendars are considered.

• The preprocessing lead time defined at the source organization is considered.
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• No processing lead time is considered.

• The transit time is taken from the shipping method specified in the sourcing rule.

• The postprocessing lead time defined at the destination organization is considered.

• The preprocessing and postprocessing lead times are calculated according to the manufacturing calendars of
the source organization and destination organization respectively.

• The transit time is calculated according to the transit calendar.

This figure depicts how various dates are determined for a transfer replenishment order. The preprocessing lead time is
added to the suggested order date for calculation of the suggested start and suggested ship dates. The transit time is
added to the suggested start and ship dates for calculation of the suggested dock date. The postprocessing lead time is
added to the suggested dock date for calculation of the suggested due date.

The suggested order date and suggested start date take the source organization's manufacturing calendar into account,
suggested ship date takes the source organization's shipping calendar into account, suggested dock date takes the
destination organization's receiving calendar into account, and suggested due date takes the destination organization's
manufacturing calendar into account. The suggested start date and suggested ship date are the same.

For example, if Saturday and Sunday aren't working days, the suggested dock date is Friday, and the postprocessing
lead time is 1 day, the suggested due date is Monday.

How Replenishment Orders Are Automatically Released  
This topic explains how replenishment orders are automatically released.

Settings That Affect Automatic Release of Replenishment Orders
For automatically releasing replenishment orders from a replenishment plan, you must take these steps:

• Select the Release planned orders automatically check box on the General subtab of the Supply tab of the
Plan Options page.

In the Supply: Advanced Options dialog box, on the General tab, refine the parameters for automatically
releasing replenishment orders.

• In the Items table, for an item-location combination, set these columns:
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◦ Release Time Fence Type: Select User-defined time fence or Item total lead time for this column.

◦ Release Time Fence Days: Enter the number of days in this column when the time fence is user-defined.
When the time fence is determined by the item total lead time, the preprocessing lead time, processing
lead time, and postprocessing lead time are added up and displayed under this column.

How Replenishment Orders Are Automatically Released
When the replenishment plan is run, the following is how replenishment orders are automatically released:

1. The suggested order date for a planned order for an item-location combination is considered.
2. The release time fence days for the item-location combination are added to the plan start date for

determination of the release time fence date.
3. When the suggested order date is earlier than or the same as the release time fence date, the replenishment

order is automatically released.

Related Topics
• Automatic Release Options

• Release Recommendation Options

Manually Release Replenishment Orders  
This topic explains how replenishment orders are manually released for a replenishment plan that's been run.

To manually release replenishment orders, you must use the Supplies and Demands page for the replenishment plan.
Before manually releasing replenishment orders, you can edit them using one of the following:

• the Supplies and Demands page

• the edit-in-spreadsheet feature

Edit and Manually Release Replenishment Orders Using the GUI
Follow these steps to edit and manually release a replenishment order using the Supplies and Demands page:

1. Open the replenishment plan through one of these ways:

◦ Use the Manage Plans page:

i. On the Tasks panel tab, under Plans, select Manage Plans.

The Manage Plans page opens.
ii. Under Search Results, select the replenishment plan that you want to open, and click Actions >

Open.

The replenishment plan opens in a separate page.

◦ On the Plans panel tab, under Plans, right-click the replenishment plan that you want to open, and select
Open.

The replenishment plan opens in a separate page.
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2. Click the Open drop-down button.

The Open Table, Graph, or Tile Set dialog box opens.
3. Search for the Supplies and Demands table, and open it.

The Supplies and Demands page opens under the replenishment plan.
4. Under Search, perform a search for item-location combinations for which the value in the Order Type column is

Planned order, and the value in the Release Status column is Release.

The replenishment orders generated by the replenishment plan are listed as planned orders on the Supplies
and Demands page.

The rows with values under the Source Organization column represent transfer orders, while the rows with
values under the Supplier and Supplier Site columns represent purchase orders.

5. Select the item-location combination for which you want to manually release the replenishment order.

◦ Follow these steps to make changes before releasing the replenishment order:

These changes are lost the next time you run the replenishment plan.

i. Under Search Results, click Actions > Mark for Release.

The row is marked with the Changed icon, and the release status for the item-location
combination changes to Marked for release.

The quantity in the Order Quantity column is copied to the Implement Quantity column.
ii. If required, edit the values in the implementation-related and Shipping Method, Source

Organization, Supplier, and Supplier Site columns.

◦ Follow these steps to firm the planned orders:

Note:  You don't always have to firm planned orders before releasing them. Whether you firm planned
orders depends on your business requirements.

i. Under Search Results, click Actions > Mark for Release.

The row is marked with the Changed icon, and the release status for the item-location
combination changes to Marked for release.

ii. Under Firm Status, select Firm.

The quantity in the Order Quantity column is copied to the Firm Quantity column.
iii. Enter values under the Firm Date, Firm Quantity, and other editable columns.

The values under the Firm Date and Firm Quantity columns persist until you change them. The
firm planned orders persist across plan runs until you change the status under the Firm Status
column to Not firm or the replenishment plan is run with All selected in the Overwrite Firm
Planned Orders field on the General subtab of the Supply tab of the Plan Options page.

6. Repeat the previous step for the item-location combinations for which you want to manually release
replenishment orders.

7. To change your decision about manually releasing a replenishment order, select the row, and under Search
Results, click Actions > Unmark for Release.

The release status for the item-location combination changes to Release.
8. Save the replenishment plan.
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9. On the Actions menu for the replenishment plan, select Release.

The Release Plan dialog box appears.
10. Click Yes.

The Plan Status Details dialog box appears and displays the status of the release process.
11. Click OK to return to the Supplies and Demands page.
12. Under Search, click View > Refresh.

For the manually released replenishment orders, the value under the Release Status column changes to
Released and under the Action column to None.

Edit Replenishment Orders Using a Spreadsheet and Manually Release
Them Using the GUI
Follow these steps to edit a replenishment order using the edit-in-spreadsheet feature and thereafter manually release
the replenishment order using the Supplies and Demands page:

1. Open the replenishment plan through one of these ways:

◦ Use the Manage Plans page:

i. On the Tasks panel tab, under Plans, select Manage Plans.

The Manage Plans page opens.
ii. Under Search Results, select the replenishment plan that you want to open, and click Actions >

Open.

The replenishment plan opens in a separate page.

◦ On the Plans panel tab, under Plans, right-click the replenishment plan that you want to open, and select
Open.

The replenishment plan opens in a separate page.
2. Click the Open drop-down button.

The Open Table, Graph, or Tile Set dialog box opens.
3. Search for the Supplies and Demands table, and open it.

The Supplies and Demands page opens under the replenishment plan.
4. Under Search Results, click Actions > Edit in Spreadsheet.

A dialog box opens and prompts you to open or save a Microsoft Excel file.
5. Open the spreadsheet.

The Connect dialog box opens and prompts you to connect to the application URL.
6. Click Yes.

A dialog box opens and prompts you to enter your credentials.
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7. Sign in with your Oracle Fusion Cloud Applications credentials.

The spreadsheet is refreshed with replenishment orders in the replenishment plan.

The replenishment orders generated by the replenishment plan are listed as planned orders in the spreadsheet.

The rows with values under the Source Organization column represent transfer orders, while the rows with
values under the Supplier and Supplier Site columns represent purchase orders.

8. In the first table, enter the details for the item-location combinations for which you want to manually release
replenishment orders.

9. Click Supplies and Demands > Search.

The spreadsheet is refreshed with the item-location combinations that match your search criteria.
10. Select an item-location combination for which the value under the Release Status column is Release.

◦ Follow these steps to make changes before releasing the replenishment order:

These changes are lost the next time you run the replenishment plan.

i. Edit the values under the implementation-related and Shipping Method, Source Organization,
Supplier, and Supplier Site columns.

A symbol appears under the Changed column for the item-location combination.
ii. Under the Release Status column, select Marked for release.

◦ Follow these steps to firm the planned orders:

Note:  You don't always have to firm planned orders before releasing them. Whether you firm planned
orders depends on your business requirements.

i. Under the Firm Status column, select Firm.

A symbol appears under the Changed column for the item-location combination.
ii. Enter values under the Firm Date, Firm Quantity, and other editable columns.

The values under the Firm Date and Firm Quantity columns persist until you change them. The
firm planned orders persist across plan runs until you change the status under the Firm Status
column to Not firm or the replenishment plan is run with All selected in the Overwrite Firm
Planned Orders field on the General subtab of the Supply tab of the Plan Options page.

iii. Under the Release Status column, select Marked for release.
11. Repeat the previous step for the item-location combinations for which you want to manually release

replenishment orders.
12. Click Supplies and Demands > Upload.

For the successfully updated rows, the symbol disappears under the Changed column. For the rows that aren't
successfully updated, the symbol is retained under the Changed column, and information is displayed under
the Status column.

Save and close the spreadsheet.
13. On the Supplies and Demands page, click View > Refresh.

The rows you changed are marked with the Changed icon and reflect the changes you made in the
spreadsheet.

333



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 13
Calculation and Release of Replenishment Orders

14. Select the changed rows, and under Search Results, click Actions > Mark for Release.

The release status for the item-location combinations changes to Marked for release.
15. Save the replenishment plan.
16. On the Actions menu for the replenishment plan, select Release.

The Release Plan dialog box appears.
17. Click Yes.

The Plan Status Details dialog box appears and provides you with the status of the release process.
18. Click OK to return to the Supplies and Demands page.
19. Under Search, click View > Refresh.

For the manually released replenishment orders, the value under the Release Status column changes to
Released and under the Action column to None.

Related Topics
• Considerations for Configuring Replenishment Plan Attributes

Create and Release Manual Planned Orders  
You can create manual planned orders for buy, make, and transfer order types. For each planned order type, you can
select your source specifications.

After you create the manual planned orders, you can then release the orders to the relevant source application. Creating
and releasing manual planned orders enables you to respond quickly to issues by creating supplies in the source
applications. You can create and release manually created planned orders from the Planning Central, Supply Planning,
Demand and Supply Planning, or Replenishment Planning work area.

To create a manual planned order from the Supplies and Demands page, click the Create icon. The Create Order dialog
box opens. In the Create Order dialog box, select the source type. The source type that you select enables additional
parameters for the supply source.

Source Type Additional Parameters

Buy
 

• Supplier

• Supplier Site

• Shipping Method

Make
 
(Not relevant to Oracle Fusion
Replenishment Planning)
 

• Item Structure Name

• Work Definition

Transfer
 

• Source Organization

• Shipping Method
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After you create the manual planned orders, optionally rerun your plan to determine if the new planned orders can be
executed. You can then mark the manually created planned orders for release on the Supplies and Demands page. Next,
run the release process and the planning process releases your manually created planned orders.

Release Plan Recommendations to an External Execution
System  
You can release plan recommendations or planned orders from Oracle Fusion Cloud SCM Applications to an external
execution system. When you release a planned order, the planning process generates a CSV file for the planned order.

The planning process attaches the generated CSV file to the scheduled process called Release Planning
Recommendations: Release to External Source Systems. You can download the CSV file from the scheduled processes.
The planning process also saves the CSV file in a .zip file format in the Universal Content Manager. The name of the .zip
file is ReleasetoExternal.zip.

Prerequisite
Before you can release planned orders from Oracle Fusion Cloud SCM Applications to an external execution system, you
must do the following:

1. Assign your organization as an external source system.
2. Run collections from the external source system.

After you successfully run collections, you can plan your orders and release them to the external source system. The
release process is same for an Oracle Fusion source system and an external source system.

Release Planned Orders
Follow these steps to release the planned orders:

1. From your Supply Chain Planning work area, click the Tasks panel.
2. Click Manage Plans and then search your plan.
3. Open the plan, mark the orders for release, and then click Actions > Release.

The planning process exports the plan in the CSV format and attaches the CSV file to the scheduled process. Also, the
planning process saves the CSV file in a .zip file format in the Universal Content Manager. You can download the .zip file
from the File Import and Export link in the Navigator.

For more information, see Releasing Plan Recommendations to External Systems (Doc ID 2305394.1) on My Oracle
Support at https://support.oracle.com.

Verify Status of Replenishment Orders  
This topic explains how the statuses of replenishment orders are verified after they're automatically or manually
released.
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On the Scheduled Processes page, the details of automatically released replenishment orders are listed under the Run
Plan process and manually released replenishment orders under the Release Plan process.

Follow these steps to verify the statuses of replenishment orders after they're automatically or manually released:

1. On the Scheduled Processes page, search for the released replenishment orders.

Tip:  You can enter the replenishment plan name in the Submission Notes field to search for the Run Plan or
Release Plan process.

2. Under Search Results, select Hierarchy.
3. Expand the Run Plan or Release Plan process under which the replenishment orders are listed.
4. Expand the Release Planning Recommendations process.
5. Do one of the following:

◦ For buy orders, select the Release Planning Recommendations: Load Interface Tables process for which
the submission notes are "Loads interface tables with the data related to buy scenarios from planning."

◦ For transfer orders, select the Release Planning Recommendations: Load Interface Tables process for
which the submission notes are "Loads interface tables with the data related to transfer scenarios from
planning."

6. For the selected process, under Log and Output, open the attached log file to view the statuses of the released
replenishment orders.

Support for Hold Dates and Expiration Dates in On-Hand
Lots  

Overview of Support for Hold Dates and Expiration Dates in On-
Hand Lots  
In replenishment plans, on-hand lots are considered on or after their hold dates. The lots are also considered in the
order of their expiration dates, and the expired quantity is flagged as unusable.

For example, assume that your on-hand lot has 48 units, a hold date of 12-Jan-2023, and an expiration date of 14-
Jan-2023. You can use the on-hand lot only on or after 12-Jan-2023. If 40 units are used by 14-Jan-2023, then the
expired lot quantity on that date is 8 units.

Benefits of Support for Hold Dates and Expiration Dates
By using the inbuilt support for hold dates and expiration dates in replenishment plans, you get these benefits:

• You can recognize the hold date for an on-hand lot and consider it as supply only on or after the hold date,
thereby streamlining inventory usage.

Thus, you can cater to the requirements of industries (such as consumer packaged goods or healthcare) in
which newly transacted inventory must go through an inspection process or physically mature before being
considered for downstream processing or shipment to a customer.

• Demand isn't met through the use of expired lots or lots that expire before the due date, and customer
satisfaction is increased.
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• On-hand lots are considered in the order of expiry dates. Better use of on-hand lots happens because there's
visibility into on-hand lots that are unused.

Additional Points About Support for Hold Dates and Expiration Dates
Note these additional points about the support for hold dates and expiration dates:

• You can collect the hold dates and expiration dates for lots using the collection process or the file-based data
import (FBDI) template named Supply Chain Planning Supply On Hand.

• The Lot, Hold Date, and Expiration Date columns in the Supplies and Demands table provide you with
information about on-hand lots and their hold and expiration dates.

These columns are populated for orders of the on-hand type.

• The expired lot order type in the Supplies and Demands table enables you to identify expired lots. The
Suggested Due Date column for such orders indicates the expiry dates of the lots.

• You can review expired lot quantities using the Expired Lot Quantity measure, which stores only values that are
greater than zero.

The Expired Lot Quantity measure is used in the calculation of the Total Demand and Projected Available
Balance measures. The Expired Lot Quantity measure is treated as demand, and the Projected Available
Balance measure is reduced by the amount in the Expired Lot Quantity measure.

Ensure that you add the Expired Lot Quantity measure to your user-defined measure catalog.

• After you add the Expired Lot Quantity measure to the Replenishment Workbench, you can drill from it to
orders of the expired lot type in the Supplies and Demands table.

• Any on-hand lot quantity with a hold date is shown under the In Receiving measure on the hold date.

• You can simulate changes to the Hold Date column using a simulation set in the Plan Inputs work area.

• Hold dates and expiration dates for on-hand lots are supported in inventory rebalancing. When you create
a cluster for inventory rebalancing, you can specify the expiration days tolerance for on-hand lots. Any on-
hand lot with an expiration date within the specified tolerance isn't considered as supply during inventory
rebalancing.

After the suggested due date is calculated on the basis of the hold date, if the suggested due date falls outside
the windows for calculation of the excess inventory and inventory shortage, then the on-hand lot isn't used for
inventory rebalancing.

The inventory rebalancing process is run before the replenishment planning process. After the inventory
rebalancing process, the planned outbound shipments that are generated are considered as a part of the Total
Demand measure and used in the computation of the Expired Lot Quantity measure.

• Hold dates and expiration dates for on-hand lots are supported in plans that use the functionality for
multiechelon replenishment planning.

The unconstrained planned order demand is included in the computation of the Total Demand measure.
Therefore, when the lot expiration date for an echelon is determined on the basis of the Total Demand measure,
the unconstrained planned order demand is considered indirectly.

• Hold dates and expiration dates for on-hand lots are supported in replenishment plans that are enabled for
incremental planning.
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Related Topics
• How On-Hand Lots Are Consumed in Replenishment Plans

• How the Suggested Due Dates and In Receiving Measure Are Calculated for On-Hand Lots with Hold Dates

• Create a Cluster

• Overview of Multiechelon Replenishment Planning

How On-Hand Lots Are Consumed in Replenishment Plans  
On-hand lots are consumed in replenishment plans in the order of their expiration dates.

This is the process for consumption of on-hand lots in replenishment plans:

1. The on-hand lots are arranged in the order of their expiration dates.
2. The first on-hand lot is consumed with the total demand within the lot expiry date.
3. If the on-hand lot isn't completely consumed on or before the expiration date, the unused quantity is calculated

as expired and reduced from the projected available balance. The expired lot quantity is shown under the
Expired Lot Quantity measure, and an order of the expired lot type is created with the expired lot quantity and
the due date as the lot expiry date.

If the on-hand lot is completely consumed, the Expired Lot Quantity measure doesn't store zero as a value.
4. Steps 2 and 3 are repeated for the remaining on-hand lots.

Example 1

Consider Example 1 of how an on-hand lot is consumed in a replenishment plan:
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Note:  Some measures shown for the Replenishment Workbench aren't available in that table by default and must be
added.

Note these points about the example:

• The on-hand lot has 48 units, and the expiration date is Day 4.

• The total demand is 10 units on each day.

• Consequently, there is an expired lot quantity of 8 units on Day 4.

• In the Supplies and Demands table, this unused quantity is shown under the expired lot order type with a
suggested due date of Day 4. The release status is ineligible because the order can't be released.

Example 2

Consider Example 2 of how an on-hand lot is consumed in a replenishment plan:
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Note:  Some measures shown for the Replenishment Workbench aren't available in that table by default and must be
added.

Note these points about the example:

• The on-hand lot has 35 units, and the expiration date is Day 4.

• The total demand is 10 units on each day.

• Consequently, the on-hand lot is completely used up by Day 4.

• For the purpose of understanding, the expired lot quantity is shown as zero on Day 4. The measure returns only
values that are greater than zero.

Example 3

Consider Example 3 of how an on-hand lot is consumed in a replenishment plan:
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Note:  Some measures shown for the Replenishment Workbench aren't available in that table by default and must be
added.

Note these points about the example:

• Here, we have three on-hand lots.

• The first on-hand lot has 35 units, the second 25 units, and the third 50 units.

For the purpose of understanding, the on-hand quantity is shown separately for each lot. In the Replenishment
Workbench, the on-hand quantity would be shown as a consolidated amount of 110 units.

• The expiration date for the first on-hand lot is Day 4, the second Day 7, and the third Day 8.

The on-hand lots are processed in the order of the expiration dates.

• The total demand is 10 units on each day.

• The first on-hand lot is completely used up by Day 4, and there is an unmet demand of 5 units.

• This unmet demand is met by the second on-hand lot, which is completely used up by Day 6.

• The third on-hand lot is used on Days 7 and 8.

• Consequently, there is an expired lot quantity of 30 units on Day 8.

For the purpose of understanding, the expired lot quantity is shown as zero on Days 4 and 7. The measure
returns only values that are greater than zero.

Also, the expired lot quantity would be shown as a consolidated amount for all the lots in the table, and there's
no measure for the expiration date.

• In the Supplies and Demands table, this unused quantity is shown under the expired lot order type with a
suggested due date of Day 8. The release status is ineligible because the order can't be released.

Related Topics
• Overview of Support for Hold Dates and Expiration Dates in On-Hand Lots

• How the Suggested Due Dates and In Receiving Measure Are Calculated for On-Hand Lots with Hold Dates

How the Suggested Due Dates and In Receiving Measure Are
Calculated for On-Hand Lots with Hold Dates  
The suggested due date for an on-hand lot is defaulted to its hold date. The lot quantity is shown in the In Receiving
measure for the suggested due date.

These points explain how the suggested due dates and In Receiving measure are determined for on-hand lots with hold
dates in replenishment plans:

• The suggested due date for an on-hand lot is set to its hold date after the manufacturing calendar for the
organization is considered.

• If the on-hand lot has no hold date, the suggested due date is set to the plan run date, and the lot appears
under the On Hand measure on Day 1.

• If the hold date coincides with a holiday, the next working day is set as the suggested due date.
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• If the hold date is greater than the plan run date, the lot quantity is shown in the In Receiving measure for the
hold date.

The In Receiving measure is treated as another source of supply and is included in the Total Supply and On
Order measures. The On Order measure is considered from Day 1 for the In Receiving measure.

You can drill from the In Receiving measure to an order of the on-hand type in the Supplies and Demands table
for the suggested due date.

• The supply that's reflected in the In Receiving measure is consumed from the suggested due date to the
expiration date, and the unconsumed quantity is reflected in the Expired Lot Quantity measure.

Example 1

Consider this example in which the suggested due date is determined from the hold date, and the In Receiving measure
reflects the lot quantity.
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Note:  The In Receiving measure shown for the Replenishment Workbench isn't available in that table by default and
must be added to the table.
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Note these points about the example:

• We have four lots. For Lots 1234 and 1235, no hold date is specified. For Lots 1236 and 1237, hold dates are
specified.

• When these lots are processed, the suggested due date is set to the hold date for Lots 1236 and 1237 in the
Supplies and Demands table.

For Lots 1234 and 1235, the suggested due date is set to the plan run date, in keeping with the replenishment
planning functionality when hold dates aren't specified.

• For Lots 1236 and 1237, the lot quantities are shown in the In Receiving measure in the Replenishment
Workbench for the suggested due dates.

• In the Replenishment Workbench, the On Hand measure for Day 1 reflects the combined quantity for Lots 1234
and 1235. This measure is shown for Day 1.

• You can drill from the In Receiving measure in the Replenishment Workbench to the Supplies and Demands
table. The quantity is shown in the Supplies and Demands table under an order of the on-hand type with the
suggested due date as the hold date.

Example 2

Consider this example in which we have both hold dates and expiration dates:
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Note:  Some measures shown for the Replenishment Workbench aren't available in that table by default and must be
added to the table.

Note these points about the example:

• We have four lots. For Lots 1234 and 1235, no hold date or expiration date is specified. For Lots 1236 and 1237,
hold dates and expiration dates are specified.

• When these lots are processed, the suggested due dates are set to the hold dates for Lots 1236 and 1237 in the
Supplies and Demands table.

For Lots 1234 and 1235, the suggested due dates are set to the plan run date, in keeping with the replenishment
planning functionality when hold dates aren't specified.

• For Lots 1236 and 1237, the lot quantities are shown in the In Receiving measure in the Replenishment
Workbench for the suggested due dates.

• In the Replenishment Workbench, the On Hand measure for Day 1 reflects the combined quantity for Lots 1234
and 1235. This measure is shown for Day 1.

• The total demand is 10 units on each day.
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• Lot 1236 is consumed completely on Days 5 and 6.

• Lot 1237 is consumed partially on Days 8, 9, and 10. The Expired Lot Quantity measure for Day 10 is set to 10
units.

Related Topics
• Overview of Support for Hold Dates and Expiration Dates in On-Hand Lots

• How On-Hand Lots Are Consumed in Replenishment Plans
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14  Multiechelon Replenishment Planning

Overview of Multiechelon Replenishment Planning  
Multiechelon replenishment planning balances demand and supply at each echelon of your network. The demand at
each level is propagated to the immediate upstream level. The supply at each level fulfills demand at the immediate
lower level.

Two passes are performed through your supply network during multiechelon replenishment planning. First, a bottom-
up pass is performed for propagating unconstrained demand from downstream locations to upstream locations.
Unconstrained planned orders are created at destination locations, and the corresponding unconstrained planned
order demands are created at source locations. The unconstrained planned orders are governed by policies. This
process is repeated at every echelon till the top-most echelon is reached. Then, a top-down pass is performed for
fulfilling the demands coming from the lower echelons. For fulfilling every unconstrained planned order demand from
a destination location, constrained planned orders (that is, planned orders) are created at destination locations, and the
corresponding constrained planned order demands are created at source locations. This process starts at the top-most
echelon and is repeated at every echelon.

Multiechelon replenishment networks are common in the retail and service parts industries, among other industries.
Most enterprises in such industries prefer to plan their supply networks by considering constraints at all echelons of the
networks.

Benefits of Multiechelon Replenishment Planning
A multiechelon replenishment plan provides you with these benefits:

• You can enhance your planning process by taking a holistic view of your entire supply network and considering
supply constraints.

You can work with a replenishment plan that acts as the single source of truth for demands and supplies across
your supply chain.

• You can improve customer satisfaction by balancing demands and supplies at each echelon of your network.

• Forecasting is done at the lowest echelon of your network, and this forecast drives demand fulfillment across
your supply chain.

• Constrained planned orders are created at a destination location only if the source location has the supply
(reflected in the Constrained Projected Available Balance measure) to completely meet the unconstrained
planned order demand.

Otherwise, the creation of constrained planned orders is delayed until there's supply for meeting the
unconstrained planned order demand.
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Additional Points About Multiechelon Replenishment Planning
Note these points about multiechelon replenishment planning:

• A multiechelon replenishment plan can have the daily or an aggregate planning time level.

In a plan with an aggregate time level, the logic for calculating and releasing planned orders is the same
whether the functionality for multiechelon replenishment planning is used or not.

• You can use multiechelon replenishment planning along with the feature for end item substitution and
supersession.

The supply of the substitute or supersession item at a source location can be used for meeting the requirement
for the demanded item at the destination location. A planned order is created for moving the substitute or
supersession item from the source location to the destination location. At the destination location, substitute
supply is created for the demanded item, and substitute demand is created for the substitute or supersession
item.

• You can use multiechelon replenishment planning along with the feature for inventory rebalancing.

Inventory rebalancing is first done for the entire supply chain before multiechelon replenishment planning is
done.

If the unit of measurement (UOM) for your policy parameters is days, then the Reserved Safety Stock measure
is calculated on the basis of the safety stock that doesn't include the unconstrained planned order demand.

• During simulation for a multiechelon replenishment plan, if you make a change for an item, it's replanned at all
echelons.

If you simulate a change to an item that's part of a substitution or supersession chain, the entire chain is
replanned at all echelons.

• In a multiechelon replenishment plan that's enabled for incremental planning, if the demand or supply of an
item is changed, it's replanned at all echelons.

If you change the supply or demand for an item that's part of a substitution or supersession chain, the entire
chain is replanned at all echelons.

• Hold dates and expiration dates are respected in a multiechelon replenishment plan.

The unconstrained planned order demand is included in the computation of the Total Demand measure.
Therefore, when the lot expiration date for an echelon is determined on the basis of the Total Demand measure,
the unconstrained planned order demand is considered indirectly.

• For policy computation at all the echelons, the total forecast is required, which is the sum of the dependent and
independent forecast.

For replenishment calculation at all the echelons, only the independent forecast is required. The dependent
demand is propagated from the lower echelons.

• At the upper echelons of your supply network, only sales orders are used for consumption against independent
demand.

Transfer orders or movement requests from lower echelons aren't used for consumption of independent
demand.

• During multiechelon replenishment planning, purchase orders, purchase requisitions, transfer orders, or
movement requests that aren't firm might get rescheduled (preponed) for avoiding the creation of planned
orders.
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However, lead-time and supply constraints at the source locations might prevent such rescheduling.

• You can use sourcing ranks and sourcing allocation percentages to model your multiechelon supply network
and determine how demand should be propagated to upstream source locations.
All order modifiers are supported along with sourcing ranks and sourcing allocation percentages.

• Constrained planned supply and constrained planned demand are represented by the order types called
planned order and planned order demand respectively in the Supplies and Demands table. You can release
orders of the planned order type.
Unconstrained planned supply and unconstrained planned demand are represented by the order types called
unconstrained planned order and unconstrained planned order demand respectively in the Supplies and
Demands table. You can't release orders of these types, and you can use these orders for only analysis.

• In a multiechelon replenishment plan, the only supply constraints that are recognized at an echelon are because
of the lead time, calendar, or supply constraints at the upper echelon.

Related Topics
• How Multiechelon Replenishment Planning Is Done

• How You Use Multiechelon Replenishment Planning

• Rescheduling of Orders During Bottom-up Phase of Multiechelon Replenishment Planning

• How Sourcing Ranks Are Used in Multiechelon Replenishment Planning

• How Sourcing Allocation Percentages Are Used in Multiechelon Replenishment Planning

How Multiechelon Replenishment Planning Is Done  
During multiechelon replenishment planning, two passes are performed through your supply chain. During the first,
bottom-up pass, unconstrained planning is performed. During the second, top-down pass, constrained planning is
done.

The following is the high-level process for multiechelon replenishment planning:

1. A low-level code is computed on the basis of the sourcing rules for each item-location combination in the
supply chain.

2. Beginning with the item-location combinations at the bottom-most echelon, unconstrained demand is
propagated up through the supply chain.
Unconstrained planned orders are created at destination locations, and the corresponding unconstrained
planned order demands are created at source locations. The lead-time constraints are adhered to during this
step.
If a substitution or supersession chain is defined at a location, then the substitute or supersession item's excess
supply is first used, and only the remaining, unmet demand is propagated to the upstream location.
Purchase orders, purchase requisitions, transfer orders, or movement requests that aren't firm might
get rescheduled (preponed) for avoiding the creation of planned orders. However, the due dates for the
rescheduled orders must be one day after the natural time fence.
Sourcing ranks and sourcing allocation percentages, if defined, are used for propagating unconstrained
demand to upstream source locations.
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This process is repeated at every echelon until the top-most echelon is reached.
3. At the top-most echelon, constrained planned orders (that is, planned orders) are created.

The lead-time constraints are adhered to during this step.
4. Beginning with the item-location combinations at the top-most echelon, constrained supply is propagated

down through the supply chain.

For fulfilling every unconstrained planned order demand coming from destination locations, constrained
planned orders are created at destination locations, and the corresponding constrained planned order
demands are created at source locations. The lead-time constraints are adhered to during this step. The
constrained demand is created at a source location only after all local demand for the source location is met.

Constrained planned orders are created at a destination location only if the source location has the
required supply (reflected in the Constrained Projected Available Balance measure) to completely meet the
unconstrained planned order demand. Otherwise, the creation of constrained planned orders is delayed until
there's enough supply for meeting the unconstrained planned order demand.

The supply of the substitute or supersession item at a source location can be used for meeting the requirement
for the demanded item at the destination location. A planned order is created for moving the substitute or
supersession item from the source location to the destination location. At the destination location, substitute
supply is created for the demanded item, and substitute demand is created for the substitute or supersession
item. The item relationship at the destination location is respected. If the item relationship at the destination
location isn't the same as that at the source location, then substitution or supersession isn't performed.

This process is repeated at every echelon until the bottom-most echelon is reached.

Related Topics
• Overview of Multiechelon Replenishment Planning

• How the Low-Level Code Is Calculated During Multiechelon Replenishment Planning

• Rescheduling of Orders During Bottom-up Phase of Multiechelon Replenishment Planning

• How Sourcing Ranks Are Used in Multiechelon Replenishment Planning

• How Sourcing Allocation Percentages Are Used in Multiechelon Replenishment Planning

How You Use Multiechelon Replenishment Planning  
This topic provides the high-level process for setting up multiechelon replenishment planning.

Before You Begin
Note these points while setting up your multiechelon replenishment plan:

• For policy computation at each echelon, you need the total forecast, which is the sum of the dependent and
independent forecast.

• For calculating the replenishments at each echelon, you need only the independent forecast, because the
dependent demand is already propagated up the supply chain during multiechelon replenishment planning.

• Because of the previously mentioned points, you need to set up two replenishment plans for multiechelon
replenishment planning:
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◦ The first replenishment plan calculates policies using the total forecast (independent and dependent
forecast).

◦ The second replenishment plan calculates replenishments using only the independent forecast. The
dependent demand will anyway be propagated from lower echelons.

For the second replenishment plan, you must supply the independent forecast using a demand plan or
an external forecast schedule.

Note:  If you're using the feature for multiechelon replenishment planning along with the feature for
incremental planning, you don't need to supply the independent forecast to the plan that calculates
replenishments. For incremental planning, only actual demand (demand for sales orders, transfer
orders, and inventory position) is used during replenishment calculation, and you can't select a demand
plan or an external forecast schedule for the demand forecast.

High-Level Process for Setting Up Multiechelon Replenishment Planning
Follow these steps to set up multiechelon replenishment planning:

1. Set up your sourcing rules, sourcing ranks, and sourcing allocation percentages for all the locations in your
supply chain.

2. Collect the information for your replenishment plans using the collections functionality or the file-based data
import (FBDI) templates.

3. Set up your replenishment plan for calculating the total demand (dependent and independent) and policies for
all echelons of your supply chain.

On the Plan Options page, select the Generate forecast and Calculate policy parameters check boxes.
4. Run your replenishment plan for calculating the total demand and policies for all echelons of your supply chain.

In the Run Plan dialog box, on the Parameters tab, in the Details section, ensure that the Refresh with current
data option, the Generate forecast check box, and the Calculate policy parameters check box are selected.

5. For obtaining the independent forecast that's required for calculating replenishments, set up a demand plan for
the supply chain.

On the Demand: Advanced Options dialog box that's opened from the Demand tab on the Plan Options page,
ensure that the Include transfer orders check box isn't selected.

You don't need to perform this step if you're going to use an external demand schedule.
6. Run your demand plan.

In the Run Plan dialog box, on the Parameters tab, in the Details section, ensure that the Refresh with current
data option is selected.
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7. Set up your replenishment plan for calculating replenishments for all echelons of your supply chain.
a. On the Plan Options page, select the Calculate replenishments check box.
b. On the General subtab on the Supply tab on the Plan Options page, in the Multiechelon Plan Attributes

section, select the Enable multiechelon planning check box.
c. If you want constrained planned orders that are created after the top-down phase to be automatically

released, in the Automatic Release Parameters section, select the Release planned orders automatically
check box.

On the General tab in the Supply: Advanced Options dialog box that you open from the General subtab,
define the parameters for automatically releasing planned orders.

In the Items table, edit the values for the Release Time Fence Type and Release Time Fence Days columns
for item-location combinations.

d. If you want purchase orders and transfer orders that aren't firm and that are rescheduled because
of multiechelon replenishment planning to be automatically released, on the General subtab, in the
Automatic Release Parameters section, select the Include rescheduled supplies in automatic releases
check box.

e. On the Organizations and Schedules subtab on the Supply tab on the Plan Options page, in the Demand
Schedules section, select the demand plan that you created or the external demand schedule. The check
box in the Use for Demand Schedule column is automatically selected and grayed out.

You don't need to perform this step if you're using the feature for multiechelon replenishment planning
along with the feature for incremental planning.

f. Select the replenishment plan that you created for calculating the total demand and policies for all
echelons of your supply chain, and select the check box in the Use for Policy Parameters column.

Ensure that the check box in the Use for Demand Schedule column isn't selected.
8. Run your replenishment plan for calculating replenishments for all echelons of your supply chain.

In the Run Plan dialog box, on the Parameters tab, in the Details section, ensure that the Refresh with current
data option and Calculate replenishments check box are selected.

9. Review the results of multiechelon replenishment planning using the Supplies and Demands table.

Unconstrained demand and supply are represented by the order types called unconstrained planned order
demand and unconstrained planned order. You can't release orders of these types, and you can use the orders
for only analysis.

Constrained demand and supply are represented by the order types called planned order demand and planned
order. You can release orders of the planned order type.

10. If you haven't selected the Release planned orders automatically check box on the General subtab on the
Supply tab on the Plan Options page, manually release your constrained planned orders using the Supplies and
Demands table.

11. If you haven't selected the Include rescheduled supplies in automatic releases check box on the General
subtab on the Supply tab on the Plan Options page, manually release your rescheduled purchase orders and
transfer orders using the Supplies and Demands table.
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Related Topics
• Overview of Multiechelon Replenishment Planning

• Automatic Release Options

• Organizations and Schedules Options for Replenishment Plans

• Run a Replenishment Plan

• Enable Multiechelon Planning for Your Replenishment Plan

Measures for Multiechelon Replenishment Planning  
This topic lists the predefined measures that are available for use in multiechelon replenishment plans.

Predefined Measures for Multiechelon Replenishment Planning
This table lists the predefined measures for multiechelon replenishment planning:

Name Description

Constrained Beginning Inventory Position Sum of the Constrained Projected Available Balance and Constrained On Order measures.

Constrained On Order Quantity of the constrained planned replenishments from the order date to one day before the order
due date.

Constrained Planned Order Demand Constrained demand at a source organization (with the order type of planned order demand) that
originates from constrained planned orders at a destination organization.

Constrained Planned Orders Total quantity of the constrained planned orders (with the order type of planned order) for a location.

Constrained Projected Available Balance Constrained projected quantity on hand in the future.
This measure includes orders of the planned order and planned order demand types.
 

Unconstrained Planned Order Demand Unconstrained demand at a source organization that originates from unconstrained planned orders at
a destination organization.

Unconstrained Planned Orders by Due
Date

Total quantity of unconstrained planned orders by the due date.

Unconstrained Planned Orders by Order
Date

Total quantity of unconstrained planned orders by the order date.

These measures are populated for your replenishment plan only when you select the Enable multiechelon planning
check box in the Multiechelon Plan Attributes section on the General subtab on the Supply tab on the Plan Options
page.

These measures are available in the Default Replenishment Planning Catalog and Incremental Replenishment Planning
Default Catalog. Ensure that you add these measures to any user-defined measure catalog for your multiechelon
replenishment plan.
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Additional Points About Measures
Note these additional points about measures and their use in multiechelon replenishment planning:

• The Total Demand and Total Supply measures don't include constrained demand (orders of the planned order
demand type) and constrained supply (orders of the planned order type) respectively. Therefore, the Total
Demand measure represents orders of the unconstrained planned order demand type, and the Total Supply
measure represents orders of the unconstrained planned order type.

• The value returned by the Projected Available Balance measure in a multiechelon replenishment plan should be
considered as the value for the unconstrained projected available balance.

• The Constrained On Order measure shows values from the order date for a planned order.
However, the On Order measure shows values from the day after the order date for the unconstrained planned
order.

• The Movement Request Demand and Transfer Order Demand measures aren't used in the calculation of the
Inventory Turns and Projected Fill Rate measures.

Related Topics
• Overview of Multiechelon Replenishment Planning

• Enable Multiechelon Planning for Your Replenishment Plan

How the Low-Level Code Is Calculated During
Multiechelon Replenishment Planning  
During multiechelon replenishment planning, the low-level code is used for identifying the bottom-most echelon and
upper echelons in your supply chain.

During the bottom-up pass, unconstrained demand is propagated from the bottom-most echelon through the upper
echelons to the top-most echelon. During the top-down pass, constrained supply is allocated from the top-most
echelon through the lower echelons to the bottom-most echelon. The low-level code is calculated for every item at a
location so that all the echelons in the supply chain are identified and processed correctly. The replenishment plan uses
sourcing rules for calculating the low-level code.

Consider a supply chain in which item ITM001 is present in locations M0, M1, M2, M3, M4, and M5:

• The combinations of the item and the M3, M4, and M5 locations aren't a source for any other location.
Therefore, these item-location combinations get the low-level code of zero.

• The combination of the item and the M2 location is the source for the item at the M3, M4, and M5 locations.
Therefore, this item-location combination gets the low-level code of 1.

• The combination of the item and the M1 location is the source for the item at the M2 location.
Therefore, this item-location combination gets the low-level code of 2.

• The combination of the item and the M0 location is the source for the item at the M1 location.
Therefore, this item-location combination gets the low-level code of 3.
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The following figure depicts this supply chain and the computed low-level codes for the item-location combinations:

Additional Points About the Low-Level Code
Note these additional points about the low-level code:

• The item-location combination with the lowest low-level code in the supply chain gets processed first.

• The item-location combination that doesn't have any transfer from a source location in the sourcing rule gets
the highest low-level code in the supply chain.

• An item-location combination that isn't the source for any other item-location combination needn't always have
the low-level code of zero. The assigned low-level code is computed on the basis of the low-level code for the
source item-location combination.

For example, if an item at the L1 location is the source for the item at the L2 location, the item at L2 isn't the
source for any other item-location combination, and the item at L1 has the low-level code of 2, then the item at
L2 will have the low-level code of 1.

• If an item-location combination is the source for two other item-location combinations with different low-level
codes, then the source item-location combination gets a low-level code that's calculated as follows: 1 + highest
low-level code among destination item-location combinations.

For example, if an item at the L1 location is the source for the item at the L2 location with the low-level code of 1
and the item at the L3 location with the low-level code of 2, then the item at L1 will have the low-level code of 3.

• The low-level code is used for deciding the sequence for processing the item-location combinations. This
process is an internal one, and you only need to ensure that sourcing rules are set correctly.

Related Topics
• Overview of Multiechelon Replenishment Planning

• How Multiechelon Replenishment Planning Is Done
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How Sourcing Ranks Are Used in Multiechelon
Replenishment Planning  
The sourcing ranks that you set in sourcing rules are used during the bottom-up pass of multiechelon replenishment
planning for creating unconstrained planned orders and unconstrained planned order demands.

The multiechelon replenishment plan first checks if supply is available at the source location with the sourcing rank of 1.
If supply isn't available at that location, the plan checks if supply is available at the source location with the sourcing rank
of 2, and so on. Existing supply is used at the source locations in the order of the sourcing ranks. If the existing supplies
aren't enough at any of the source locations, the demand is placed on the source location with the sourcing rank of 1.

Multiechelon replenishment planning supports sourcing ranks and sourcing allocation percentages with order
modifiers.

Consider an organization named S1 that has source locations named M1 and M2. The sourcing rank for M1 is 1, and that
for M2 is 2. An unconstrained planned order of 100 units is placed on S1.

In Example 1, if the projected available balance for M1 is 110 units, and that for M2 is 200 units, then the value of the
Unconstrained Planned Order Demand measure for M1 is 100, while the measure value for M2 is zero.

In Example 2, if the projected available balance for M1 is 70 units, and that for M2 is 50 units, then the value of the
Unconstrained Planned Order Demand measure for M1 is 70, while the measure value for M2 is 30. All the available
supply from M1 is used before the supply from M2 is used for fulfilling the unconstrained planned order.

In Example 3, if the projected available balance for M1 is zero units, and that for M2 is 40 units, then the value of the
Unconstrained Planned Order Demand measure for M1 is 60, while the measure value for M2 is 40. All the available
supply from M2 is first used, and the remaining demand is placed on M1 for fulfilling the unconstrained planned order.

This table lists these examples:

Example Source Location Projected Available Balance at
the Source Location

Unconstrained Planned Order
Demand

1 M1 110 100

1 M2 200 0

2 M1 70 70

2 M2 50 30

3 M1 0 60

3 M2 40 40
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Related Topics
• Overview of Multiechelon Replenishment Planning

• How Multiechelon Replenishment Planning Is Done

• How Sourcing Allocation Percentages Are Used in Multiechelon Replenishment Planning

• How Order Modifiers Are Applied When Replenishments Are Calculated

How Sourcing Allocation Percentages Are Used in
Multiechelon Replenishment Planning  
The sourcing allocation percentages that you set in sourcing rules are used during the bottom-up pass of multiechelon
replenishment planning for creating unconstrained planned orders and unconstrained planned order demands.

Multiechelon replenishment planning supports sourcing allocation percentages and sourcing ranks with order
modifiers.

Because of order modifiers or constraints at source locations, the sourcing allocation percentages might not be
adhered to during the creation of unconstrained planned orders. However, an attempt is made to honor the cumulative
percentages for sourcing allocations within the planning horizon.

Consider an organization named S1 that has source locations named M1 and M2. The sourcing allocation percentage for
M1 is 40%, while that for M2 is 60%. Both M1 and M2 have a sourcing rank of 1. An unconstrained planned order of 100
units is placed on S1 on days 1, 5, and 9.

On day 1, when the projected available balance for M1 is 70 units, and that for M2 is also 70 units, the allocation is done
according to the specified percentages. The value of the Unconstrained Planned Order Demand measure for M1 is 40,
while the measure value for M2 is 60.

On day 5, when the projected available balance for M1 is 30 units, and that for M2 is 80 units, the value of the
Unconstrained Planned Order Demand measure for M1 is 30, while the measure value for M2 is 70.

On day 9, when the projected available balance for M1 is 65 units, and that for M2 is 55 units, the value of the
Unconstrained Planned Order Demand measure for M1 is 50, while the measure value for M2 is 50. The measure value
for M1 has been raised so that the cumulative measure value for M1 across all three days is 40% (120 units) of the
cumulative value for the planned order (300 units).

This table lists this example:

Day Source Location Projected Available Balance at
Source Location

Unconstrained Planned Order
Demand

1 M1 70 40

1 M2 70 60

5 M1 30 30

5 M2 80 70

9 M1 65 50
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Day Source Location Projected Available Balance at
Source Location

Unconstrained Planned Order
Demand

9 M2 55 50

Related Topics
• Overview of Multiechelon Replenishment Planning

• How Multiechelon Replenishment Planning Is Done

• How Sourcing Ranks Are Used in Multiechelon Replenishment Planning

• How Order Modifiers Are Applied When Replenishments Are Calculated

Rescheduling of Orders During Bottom-up Phase of
Multiechelon Replenishment Planning  
During the bottom-up phase of multiechelon replenishment planning, movement requests, purchase orders, purchase
requisitions, or transfer orders that aren't firm are rescheduled so that excess planned orders aren't created.

Note these points about the rescheduling of these order types:

• In the Supplies and Demands table for a multiechelon replenishment plan, the value in the Action column is
Reschedule in for rescheduled movement requests, purchase orders, purchase requisitions, or transfer orders.

• Oracle Purchasing and Oracle Fusion Cloud Inventory Management don't support the rescheduling of purchase
requisitions and movement requests respectively.

For this reason, in the Supplies and Demands table, the value in the Release Status column is Ineligible for
rescheduled purchase requisitions and movement requests.

You can't release rescheduled purchase requisitions and movement requests.

• For rescheduled purchase orders and transfer orders, the value in the Release Status column is Release.

If you mark such purchase orders and transfer orders for release, the value in the Release Status column
changes to Marked for reschedule.

• After multiechelon replenishment planning, rescheduled purchase orders and transfer orders are automatically
released if you selected the Include rescheduled supplies in automatic releases check box in the Automatic
Release Parameters section on the General subtab on the Supply tab on the Plan Options page.

Otherwise, you must manually release these rescheduled purchase orders and transfer orders using the
Supplies and Demands table.

• Lead-time and supply constraints at the source locations might prevent such rescheduling.

• The rescheduling of movement requests, purchase orders, purchase requisitions, or transfer orders happens
after end item substitution and supersession are performed.
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Related Topics
• Overview of Multiechelon Replenishment Planning

• How Multiechelon Replenishment Planning Is Done

• Automatic Release Options

• Manually Release Replenishment Orders

Example of Multiechelon Replenishment Planning  
This topic provides an example of multiechelon replenishment planning for an item in a supply chain with a source
location and two destination locations.

These are the details of the supply chain:

• The source location is M1 and gets its supply from a supplier.

• The lead time for M1 is 3 days. The lead time is considered as a constraint.

However, the supplier capacity isn't considered as a constraint.

• M1 has two destination locations named S1 and S2.

The lead time for S1 and S2 is 2 days.

• The applicable policy type is min-max planning.

The following figure depicts this supply chain:

As is evident from the example, the logic for recommending unconstrained planned orders in multiechelon
replenishment planning is the same as the logic for recommending planned orders in a replenishment plan that doesn't
use the functionality for multiechelon replenishment planning.
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Unconstrained, Bottom-Up Phase
The following table provides the measure values for S1 during the unconstrained, bottom-up phase:

Measure01/01 01/02 01/03 01/04 01/05 01/06 01/07 01/08 01/09 01/10 01/11 01/12 01/13 01/14 01/15

Gross
Forecast

10 8 11 19 10 8 11 10 8 11 10 9 10 8 8

On
Hand

25 – – – – – – – – – – – – – –

Transfer
Orders

– – 40 – – – – – – – – – – – –

Total
Supply

25 – 40 – – 43 – – – 39 – – – 38 –

On
Order

40 40 – – 43 – – – 39 – – – 38 – –

Projected
Available
Balance

15 7 36 17 7 42 31 21 13 41 31 22 12 42 34

Beginning
Inventory
Position

55 47 36 17 50 42 31 21 52 41 31 22 50 42 34

Unconstrained
Planned
Orders
by
Order
Date

– – – 43 – – – 39 – – – 38 – – –

Unconstrained
Planned
Orders
by Due
Date

– – – – – 43 – – – 39 – – – 38 –

Minimum
Quantity

30 30 30 30 30 30 30 30 30 30 30 30 30 30 30

Maximum
Quantity

60 60 60 60 60 60 60 60 60 60 60 60 60 60 60

Note these points about S1:

• Unconstrained planned orders are recommended on 01/04, 01/08, and 01/12 when the value of the Beginning
Inventory Position measure goes below 30 units. The unconstrained planned orders are the units necessary
to bring the value of the Beginning Inventory Position measure up to 60 units. These unconstrained planned
orders are reflected by the values of the Unconstrained Planned Orders by Order Date measure for 01/04,
01/08, and 01/12.

• After the lead time is considered, the unconstrained planned orders are reflected by the Unconstrained Planned
Orders by Due Date measure for 01/06, 01/10, and 01/14.

The following table provides the measure values for S2 during the unconstrained, bottom-up phase:
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Measure01/01 01/02 01/03 01/04 01/05 01/06 01/07 01/08 01/09 01/10 01/11 01/12 01/13 01/14 01/15

Gross
Forecast

9 11 9 11 15 10 9 12 11 10 9 12 10 8 12

On
Hand

21 – – – – – – – – – – – – – –

In
Transit

– 45 – – – – – – – – – – – – –

Total
Supply

21 45 – – – – 54 – – – 42 – – – 41

On
Order

45 – – – – 54 – – – 42 – – – 41 –

Projected
Available
Balance

12 46 37 26 11 1 46 34 23 13 46 34 24 16 45

Beginning
Inventory
Position

57 46 37 26 11 55 46 34 23 55 46 34 24 57 45

Unconstrained
Planned
Orders
by
Order
Date

– – – – 54 – – – 42 – – – 41 – –

Unconstrained
Planned
Orders
by Due
Date

– – – – – – 54 – – – 42 – – – 41

Minimum
Quantity

25 25 25 25 25 25 25 25 25 25 25 25 25 25 25

Maximum
Quantity

65 65 65 65 65 65 65 65 65 65 65 65 65 65 65

Note these points about S2:

• Unconstrained planned orders are recommended on 01/05, 01/09, and 01/13 when the value of the Beginning
Inventory Position measure goes below 25 units. The unconstrained planned orders are the units necessary
to bring the value of the Beginning Inventory Position measure up to 65 units. These unconstrained planned
orders are reflected by the values of the Unconstrained Planned Orders by Order Date measure for 01/05,
01/09, and 01/13.

• After the lead time is considered, the unconstrained planned orders are reflected by the Unconstrained Planned
Orders by Due Date measure for 01/07, 01/11, and 01/15.

Recommendation of Constrained and Unconstrained Planned Orders at
the Top-Most Echelon
The following table enables you to examine the constrained and unconstrained planned orders for M1:
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Measure01/01 01/02 01/03 01/04 01/05 01/06 01/07 01/08 01/09 01/10 01/11 01/12 01/13 01/14 01/15

Unconstrained
Planned
Order
Demand

– – – 43 54 – – 39 42 – – 38 41 – –

Transfer
Order
Demand

40 – – – – – – – – – – – – – –

On
Hand

55 – – – – – – – – – – – – – –

In
Transit

– 66 – – – – – – – – – – – – –

Total
Supply

55 66 – – – – 102 – – – 93 – – – 80

On
Order

66 – – – 102 102 – – 93 93 – – 80 80 –

Projected
Available
Balance

15 81 81 38 –16 –16 86 47 5 5 98 60 19 19 99

Beginning
Inventory
Position

81 81 81 38 86 86 86 47 98 98 98 60 99 99 99

Unconstrained
Planned
Orders
by
Order
Date

– – – 102 – – – 93 – – – 80 – – –

Unconstrained
Planned
Orders
by Due
Date

– – – – – – 102 – – – 93 – – – 80

Constrained
Planned
Orders

– – – – – – 102 – – – 93 – – – 80

Minimum
Quantity

80 80 80 80 80 80 80 80 80 80 80 80 80 80 80

Maximum
Quantity

140 140 140 140 140 140 140 140 140 140 140 140 140 140 140

Note these points about M1:

• For every unconstrained planned order at S1 and S2, the corresponding demand has been created for M1 and is
reflected by the Unconstrained Planned Order Demand measure.

• Unconstrained planned orders are recommended on 01/04, 01/08, and 01/12 when the value of the Beginning
Inventory Position measure goes below 80 units. The unconstrained planned orders are the units necessary
to bring the value of the Beginning Inventory Position measure up to 140 units. These unconstrained planned
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orders are reflected by the values of the Unconstrained Planned Orders by Order Date measure for 01/04,
01/08, and 01/12.

• After the lead time is considered, the unconstrained planned orders are reflected by the Unconstrained Planned
Orders by Due Date measure for 01/07, 01/11, and 01/15.

• The constrained planned orders that are recommended are reflected by the Constrained Planned Orders
measure for 01/07, 01/11, and 01/15.

Constrained, Top-Down Phase
The following table enables you to examine the fulfillment of unconstrained planned order demands at M1:

Measure01/01 01/02 01/03 01/04 01/05 01/06 01/07 01/08 01/09 01/10 01/11 01/12 01/13 01/14 01/15

Unconstrained
Planned
Order
Demand

– – – 43 54 – – 39 42 – – 38 41 – –

Transfer
Order
Demand

40 – – – – – – – – – – – – – –

On
Hand

55 – – – – – – – – – – – – – –

In
Transit

– 66 – – – – – – – – – – – – –

Total
Supply

55 66 – – – – 102 – – – 93 – – – 80

On
Order

66 – – – 102 102 – – 93 93 – – 80 80 –

Projected
Available
Balance

15 81 81 38 –16 –16 86 47 5 5 98 60 19 19 99

Beginning
Inventory
Position

81 81 81 38 86 86 86 47 98 98 98 60 99 99 99

Unconstrained
Planned
Orders
by
Order
Date

– – – 102 – – – 93 – – – 80 – – –

Unconstrained
Planned
Orders
by Due
Date

– – – – – – 102 – – – 93 – – – 80

Constrained
Planned
Orders

– – – – – – 102 – – – 93 – – – 80
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Measure01/01 01/02 01/03 01/04 01/05 01/06 01/07 01/08 01/09 01/10 01/11 01/12 01/13 01/14 01/15

Constrained
Planned
Order
Demand

– – – 43 – – 54 39 42 – – 38 41 – –

Constrained
On
Order

66 – – 102 102 102 – 93 93 93 – 80 80 80 –

Constrained
Projected
Available
Balance

15 81 81 38 38 38 86 47 5 5 98 60 19 19 99

Constrained
Beginning
Inventory
Position

81 81 81 140 140 140 86 140 98 98 98 140 99 99 99

Minimum
Quantity

80 80 80 80 80 80 80 80 80 80 80 80 80 80 80

Maximum
Quantity

140 140 140 140 140 140 140 140 140 140 140 140 140 140 140

Note these points about M1:

• During the top-down pass, based on the constrained supply, a constrained planned order demand is created for
every unconstrained planned order demand and stored in the Constrained Planned Order Demand measure.

• On 01/04, the value of the Constrained Projected Available Balance measure is 81 units and enough to meet the
unconstrained planned order demand (43 units) for that day. The value of the Constrained Projected Available
Balance measure is 38 units (81 – 43) after this demand is met.

The value of the Constrained Planned Order Demand measure is 43 units for 01/04.

• On 01/05, the value of the Constrained Projected Available Balance measure is 38 units and insufficient to meet
the unconstrained planned order demand (54 units) for that day.

On 01/07, a constrained planned order of 102 units is received.

For this reason, the unconstrained planned order demand is met on 01/07, as reflected by the value of the
Constrained Planned Order Demand measure for that day.

On 01/07, the value of the Constrained Projected Available Balance measure is 86 units (38 + 102 – 54).

• On 01/08, the value of the Constrained Projected Available Balance measure is 86 units and enough to meet
the unconstrained planned order demand (39 units) for that day. The value of the Constrained Projected
Available Balance measure is 47 units (86 – 39) after this demand is met.

The value of the Constrained Planned Order Demand measure is 39 units for 01/08.

• On 01/09, the value of the Constrained Projected Available Balance measure is 47 units and enough to meet the
unconstrained planned order demand (42 units) for that day. The value of the Constrained Projected Available
Balance measure is 5 units (47 – 42) after this demand is met.

The value of the Constrained Planned Order Demand measure is 42 units for 01/09.
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• On 01/11, a constrained planned order of 93 units is received, which takes the value of the Constrained
Projected Available Balance measure to 98 units (5 + 93).

• On 01/12, the value of the Constrained Projected Available Balance measure is 98 units and enough to meet the
unconstrained planned order demand (38 units) for that day. The value of the Constrained Projected Available
Balance measure is 60 units (98 – 38) after this demand is met.
The value of the Constrained Planned Order Demand measure is 38 units for 01/12.

• On 01/13, the value of the Constrained Projected Available Balance measure is 60 units and enough to meet the
unconstrained planned order demand (41 units) for that day. The value of the Constrained Projected Available
Balance measure is 19 units (60 – 41) after this demand is met.
The value of the Constrained Planned Order Demand measure is 41 units for 01/13.

The following table enables you to validate the creation of constrained planned orders at S1:

Measure01/01 01/02 01/03 01/04 01/05 01/06 01/07 01/08 01/09 01/10 01/11 01/12 01/13 01/14 01/15

Gross
Forecast

10 8 11 19 10 8 11 10 8 11 10 9 10 8 8

On
Hand

25 – – – – – – – – – – – – – –

Transfer
Orders

– – 40 – – – – – – – – – – – –

Total
Supply

25 – 40 – – 43 – – – 39 – – – 38 –

On
Order

40 40 – – 43 – – – 39 – – – 38 – –

Projected
Available
Balance

15 7 36 17 7 42 31 21 13 41 31 22 12 42 34

Beginning
Inventory
Position

55 47 36 17 50 42 31 21 52 41 31 22 50 42 34

Unconstrained
Planned
Orders
by
Order
Date

– – – 43 – – – 39 – – – 38 – – –

Unconstrained
Planned
Orders
by Due
Date

– – – – – 43 – – – 39 – – – 38 –

Constrained
Planned
Orders

– – – – – 43 – – – 39 – – – 38 –

Constrained
On
Order

40 40 – 43 43 – – 39 39 – – 38 38 – –
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Measure01/01 01/02 01/03 01/04 01/05 01/06 01/07 01/08 01/09 01/10 01/11 01/12 01/13 01/14 01/15

Constrained
Projected
Available
Balance

15 7 36 17 7 42 31 21 13 41 31 22 12 42 34

Constrained
Beginning
Inventory
Position

55 47 36 60 50 42 31 60 52 41 31 60 50 42 34

Minimum
Quantity

30 30 30 30 30 30 30 30 30 30 30 30 30 30 30

Maximum
Quantity

60 60 60 60 60 60 60 60 60 60 60 60 60 60 60

For S1, the due dates of the unconstrained planned orders are aligned with the dates of the constrained planned orders.
Therefore, all the unconstrained planned orders have been met on time.

Tip:  You can validate that the unconstrained planned orders have been met on time by examining the values of the
Projected Available Balance and Constrained Projected Available Balance measures. If the measure values are the
same, the unconstrained planned orders have been met on time.

The following table enables you to validate the creation of constrained planned orders at S2:

Measure01/01 01/02 01/03 01/04 01/05 01/06 01/07 01/08 01/09 01/10 01/11 01/12 01/13 01/14 01/15

Gross
Forecast

9 11 9 11 15 10 9 12 11 10 9 12 10 8 12

On
Hand

21 – – – – – – – – – – – – – –

In
Transit

– 45 – – – – – – – – – – – – –

Total
Supply

21 45 – – – – 54 – – – 42 – – – 41

On
Order

45 – – – – 54 – – – 42 – – – 41 –

Projected
Available
Balance

12 46 37 26 11 1 46 34 23 13 46 34 24 16 45

Beginning
Inventory
Position

57 46 37 26 11 55 46 34 23 55 46 34 24 57 45

Unconstrained
Planned
Orders
by
Order
Date

– – – – 54 – – – 42 – – – 41 – –
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Measure01/01 01/02 01/03 01/04 01/05 01/06 01/07 01/08 01/09 01/10 01/11 01/12 01/13 01/14 01/15

Unconstrained
Planned
Orders
by Due
Date

– – – – – – 54 – – – 42 – – – 41

Constrained
Planned
Orders

– – – – – – – – 54 – 42 – – – 41

Constrained
On
Order

45 – – – – – 54 54 42 42 – – 41 41 –

Constrained
Projected
Available
Balance

12 46 37 26 11 1 –8 –20 23 13 46 34 24 16 45

Constrained
Beginning
Inventory
Position

57 46 37 26 11 1 46 34 65 55 46 34 65 57 45

Minimum
Quantity

25 25 25 25 25 25 25 25 25 25 25 25 25 25 25

Maximum
Quantity

65 65 65 65 65 65 65 65 65 65 65 65 65 65 65

Note these points about S2:

• For every constrained planned order demand at M1, a corresponding constrained planned order has been
created at S2.

In functional terms, there are constrained, inbound (planned transfer) recommendations from M1 to S2. These
recommendations are represented in the Supplies and Demands table as planned orders and get converted to
transfer orders after being released.

• The constrained planned order on 01/09 at S2 is late by two days because of constraints at M1.

So, the constrained projected available balance at S2 for 01/07 and 01/08 is negative.

On 01/07, the constrained projected available balance is –8 units (the previous day's value of 1 minus the gross
forecast of 9).

On 01/08, the constrained projected available balance is –20 units (the previous day's value of –8 minus the
gross forecast of 12).

• On 01/09, a constrained planned order of 54 units is received.

• On 01/09, the constrained projected available balance is 23 units (the previous day's value of –20 minus the
gross forecast of 11 plus the constrained planned order of 54).
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Related Topics
• Overview of Multiechelon Replenishment Planning

• How Multiechelon Replenishment Planning Is Done

• Measures for Multiechelon Replenishment Planning
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15  Replenishment Planning for Subinventories

Overview of Replenishment Planning for Subinventories  
This topic is an overview of how replenishment planning is done at the subinventory level.

These points describe replenishment planning for subinventories:

• Replenishment planning is done for subinventories and organizations in the same way.

• Organizations can be set up so that their subinventories are included for replenishment planning.

Replenishment planning can be done for either an organization or its subinventories.

• You can configure assignment sets, sourcing rules, and bills of distribution for subinventories.

• Historical data is collected at the item-subinventory level.

The forecast can be based on shipments history or consumption history.

The file-based data import (FBDI) templates can also be used for collecting the following information at the
subinventory level:

◦ Item subinventories

◦ Movement requests

◦ Shipments and consumption history transactions

◦ On-hand inventory

◦ Purchase orders, purchase requisitions, and transfer orders

◦ External forecasts

◦ Policy overrides

• If lead times and order modifiers are defined at the item-subinventory level, they're used. Otherwise, lead times
and order modifiers defined at the organization level are used.

• For replenishment planning at the subinventory level, open transactions (purchase orders, purchase
requisitions, transfer orders, and movement requests) have to be available at the subinventory level, and open
transactions at the organization level aren't considered.

• The scope of a replenishment plan can include both organizations and subinventories. Some or all of the
subinventories for an organization can be included in the scope. However, if the scope includes subinventories,
the replenishment plan can't be used for Oracle Transactional Business Intelligence (OTBI) reporting.

• The following types of inventory orders are supported:

◦ Interorganization transfer order: From one organization to another, or from one organization to the
subinventory of another organization.

◦ Intraorganization transfer order: From one subinventory of an organization to another subinventory of
the same organization.

◦ Movement request: From one subinventory of an organization to another subinventory of the same
organization.
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◦ Purchase order or purchase requisition: From a supplier to an organization or a subinventory of the
organization.

• The information for subinventories can't be aggregated to the level of the parent organization.

Replenishment Planning Tasks at the Subinventory Level
You can do these tasks at the item-subinventory level using Oracle Replenishment Planning:

• Assign item-subinventory combinations to segments, and override segments for the combinations.

• Accurately predict demand on the basis of shipments history or consumption history.

• Compute and view policy parameters.

• Override policies.

• Trigger replenishment orders.

• Review analytics.

Subinventories are listed in the <organization>:<subinventory> format in all predefined analytics, tables, and
graphs and on the Members tab of the Selector Tool.

• Perform simulations.

The collected attributes for item-subinventory combinations can be viewed in the Item Subinventory table in
the Plan Inputs work area.

Pros and Cons of Replenishment Planning at the Subinventory Level
These are the benefits of replenishment planning at the subinventory level:

• You have the flexibility to model locations such as retail stores or supply storerooms as organizations or
subinventories on the basis of your business requirements.

You can use movement requests for inventory transfers between subinventories that are located close to each
other. If the subinventories aren't close to each other, and you must create shipment documents, you can
designate the inventory transfers as transfer orders.

• You can increase the overall efficiency of replenishment planning by forecasting demand, computing policy
parameters, and calculating and releasing replenishment orders at the lowest nodes of your supply chain.

• You can reduce inventory costs and maintain optimal inventory levels at the lowest nodes of your supply chain.

However, if you plan replenishments at the subinventory level, the number of item-location combinations in your
replenishment plan increases.

Tip:  Oracle recommends that you first do replenishment planning at the organization level. Once you understand
how to use the functionality and user flows, you can perform replenishment planning at the subinventory level to suit
your business requirements.
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How You Set Up Replenishment Planning for
Subinventories  
This is the high-level process for setting up Oracle Replenishment Planning to forecast demand, calculate policy
parameters, and calculate and release replenishment orders at the subinventory level. Perform all steps except for Step 3
in the Replenishment Planning work area.

Note:  When subinventories are available for selection, they're listed in the <organization>:<subinventory> format.

1. Collect setup data at the organization level.

On the Parameters tab on the Collect Planning Data page, for the Targeted collection type, on the Reference
Data subtab, move Items, Organizations, and Subinventories to Selected Entities. Move any other reference
entities that you require to Selected Entities.

Alternatively, use file-based data import (FBDI) templates for uploading setup data at the organization level.
2. Enable organizations for replenishment planning at the subinventory level.

On the Maintain Supply Network Model page, on the Organizations tab, select Yes under Plan Subinventories
for all organizations for which subinventories should be included for replenishment planning.

To collect both nettable and nonnettable item-subinventory combinations, select Yes under Collect
Nonnettable Item-Subinventories. To collect only nettable item-subinventory combinations, select No under
the column.

3. In the Scheduled Processes work area, submit the Create Trees for Dimensions process for only the
Organization dimension.

After the process runs, Organization dimension trees are recreated with subinventory details.
4. Perform these steps on the Collect Planning Data page:

a. To collect order modifiers and lead time at the item-subinventory level, on the Parameters tab, for the
Targeted collection type, on the Reference Data subtab, move Item Subinventories to Selected Entities.

If a stocking unit of measure (UOM) is used in Oracle Fusion Cloud Inventory Management at the item-
subinventory level, the order modifiers are converted to the primary UOM if required after the collection
process.

Alternatively, use the FBDI template named Supply Chain Planning Item Subinventories
(ScpItemSubinventoryImportTemplate.xlsm).

The collected or uploaded order modifiers and lead time at the item-subinventory level can be viewed in
the Item Subinventory table in the Plan Inputs work area.

b. To generate a consumption-based forecast, on the Demand Planning Data subtab, under History Data
Options, in Subinventory - Consumption Inventory Transactions to Include, select the types of
history transactions you want to collect at the subinventory level. If you select Transfer orders, both
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transfer orders and movement requests history at the subinventory level are collected. If you select All, all
inventory transaction history at the subinventory level is collected.
Alternatively, use the FBDI template named Supply Chain Planning Measures
(ScpMeasuresImportTemplate.xlsm) to upload data to the Consumption History measure for a
consumption-based forecast.

Note:  In the Organization Level Member Name column of the template, specify the subinventories in
the <organization>:<subinventory> format. If you don't want to specify a customer, enter #ignore in
the Customer Level Name and Demand Class Level Name columns, and don't enter anything in the
Customer Level Member Name, Customer Site Level Member Name, and Demand Class Level Member
Name columns.

To generate a shipments-based forecast, use the FBDI template named Supply Chain Planning Shipments
History (ScpShipmentHistoryImportTemplate.xlsm) for uploading shipments history at the subinventory
level into the Shipments History measure.

c. On the Supply Planning Data subtab, move the supply entities, such as transfer orders and movement
requests, that you want to collect at the subinventory level to Selected Entities.
Alternatively, use the FBDI templates for uploading supply entities at the subinventory level.

Note:  Replenishment planning is done for only those collected items for which you set the planning method
attribute for MPS MRP Planning to Replenishment Planning in Oracle Fusion Cloud Product Lifecycle
Management.

5. Configure segment criteria to include subinventory-level information.
On the Create Segment Group page, under Segment Criteria, add the Location attribute for the Organization
dimension, and specify the subinventories that should be listed in a segment. If the segment group already
has the Organization dimension, on the Edit Segment Group page, under Segment Criteria, add or modify the
Location attribute for the dimension to include subinventories in a segment.
After segmentation is run, you can manually override the segments for item-subinventory combinations.
Only items with valid subinventory data are segmented. If the segmentation criteria aren't available as
attributes at the item-subinventory level, the attributes at the item-location level are considered.

6. Enable sourcing rules or bills of distribution for subinventory-level planning.

◦ On the Create Sourcing Rule page, select the Enable for subinventory-level planning check box, and
provide the remaining information.

◦ On the Create Bill of Distribution page, select the Enable for subinventory-level planning check box,
and provide the remaining information.

7. Enable assignment sets for subinventory-level planning.
On the Create Assignment Set page, select the Enable for subinventory-level planning check box, and
provide the remaining information.

8. If required, override policies for item-subinventory combinations.
In your policy assignment set, on the Item-Location Level Policy Overrides tab in the Create Policy Assignment
Set or Edit Policy Assignment Set dialog box, select the item-subinventory combinations for which you want to
specify policy overrides.

9. On the Scope tab on the Plan Options page for your replenishment plan, under Plan Organizations, select the
subinventories (level members) for which replenishment planning should be done.

10. Under Plan Items, select the segments that contain the subinventories.
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11. Run the replenishment plan.

The policies and replenishments are calculated at the subinventory level.

Related Topics
• Collect Data Using the Targeted Collection Type

• Create a Segment Group

• Create a Sourcing Rule

• Create a Policy Assignment Set

• Scope Plan Options for Replenishment Plans

Example of Replenishment Plans for Stores Modeled as
Subinventories  
This topic describes how you set up replenishment plans for stores that are modeled as subinventories.

In this example, an enterprise has a distribution center that's modeled as an organization. The distribution center
has buy from sourcing rules. The two stores, which are set up as subinventories and contained in a placeholder
organization, source goods from the distribution center using transfer from sourcing rules. The customer demands are
fulfilled through the stores. The enterprise owns the stores and uses Oracle Fusion Cloud ERP.

Note:  While this example describes replenishments for stores that are modeled as subinventories, you could also
model the stores as organizations.

Note these points about this example:

• You can use a single replenishment plan to generate the forecast, calculate the policy parameters, and calculate
and release replenishment orders for the distribution center and stores.

You can also use separate replenishment plans as follows:

◦ A replenishment plan generates the forecast at the distribution center by using transfer orders history
and shipments history.

This replenishment plan also calculates the policy parameters and calculates and releases the
replenishment orders for the distribution center.

◦ Another replenishment plan generates the forecast at the stores by using consumption or shipments
history.

This replenishment plan also calculates the policy parameters and calculates and releases the
replenishment orders for the stores.
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• If you're using a single replenishment plan for the distribution center and stores, when a planned transfer
order is created at the stores, an equivalent planned transfer order demand isn't automatically created for the
distribution center.

Planned transfer order demand is created at the distribution center once the planned transfer orders created at
the stores are released and collected.

• File-based data import (FBDI) templates can be used for uploading data instead of collecting it.

• At the distribution center and store levels, you can use a single or separate replenishment plans to generate the
forecast, calculate the policy parameters, and calculate and release the replenishment orders.
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16  Inventory Rebalancing

Overview of Inventory Rebalancing  
The inventory rebalancing feature enables you to rebalance an item's inventory across your supply chain.

Because of varying demands and supplies within your supply chain, some locations end up with excess inventory and
others with inventory shortages. While excess inventory increases your holding costs, inventory shortages result in lost
sales. By using the inventory rebalancing feature, you can move items from locations with excess inventory to locations
with inventory shortages.

You can enable the inventory rebalancing feature for a replenishment plan. Once you enable the feature, it's run before
the replenishment planning process. In a replenishment plan that uses the functionality for inventory rebalancing along
with the functionality for multiechelon replenishment planning, inventory rebalancing is first done for the entire supply
chain before multiechelon replenishment planning is done.

You can set up your replenishment plan for automatic release or manual release of the planned orders generated after
inventory rebalancing.

Salient Features of Inventory Rebalancing
You can do the following using this feature:

• Reposition inventory in your supply chain by using clusters that consist of locations, regions, or zones.

If the clusters consist of regions or zones, inventory rebalancing is performed for the locations in these regions
or zones. The locations should be connected with shipping methods.

• Specify the supplies and demands that are used in the calculation of excess inventory and inventory shortages.

• Specify if a check should be made for locations with excess inventory that can completely meet inventory
shortages so that the number of planned orders is reduced.

• Specify if the safety stock for an item-location combination is used in the calculation of the inventory shortage.

You can also set a percentage of safety stock that's reserved before excess inventory is calculated for the item-
location combination.

• Set windows for computing the excess inventory or inventory shortage for each item within a location of a
cluster.

• Obtain plan recommendations for moving items from locations with excess inventory to those with inventory
shortages.

Planned inbound orders and planned outbound orders are created with the use of defined shipping methods
between locations in a cluster. Excess inventory might be transferred to a sweep location that's inside or outside
the cluster.

Oracle Replenishment Planning recognizes these planned inbound orders as firm supplies before generating
planned orders from upstream sources.

• Use embedded analytics to evaluate the effectiveness of inventory rebalancing.
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• Optimize inventory levels in your supply chain, and minimize the costs of procuring inventory from suppliers or
sourcing inventory from upstream facilities.

• Improve customer satisfaction by fulfilling demands at locations with inventory shortages.

Additional Points About Inventory Rebalancing
Note these additional points about inventory rebalancing:

• You needn't define sourcing rules to use the inventory rebalancing feature.

• The feature doesn't support order modifiers.

• You can't use the feature in a replenishment plan that's set up for policy comparison.

• You can't use the feature in a replenishment plan that's set up for incremental planning.

• You can use the feature in replenishment plans with the daily, weekly, period, or monthly planning time level.

• The excess inventory and inventory shortages are calculated as on the plan start date after consideration of the
supplies and demands within the excess and shortage computation windows. Planned orders are then created
with the order dates as the plan start date after consideration of the calendars for item-location combinations.

Replenishment Planning doesn't perform time-phased evaluation of excess inventory and inventory shortages
and doesn't make time-phased inventory rebalancing recommendations.

• When the feature for inventory rebalancing is used along with the feature for multiechelon replenishment
planning, if the unit of measurement (UOM) for your policy parameters is days, then the Reserved Safety Stock
measure is calculated on the basis of the safety stock that doesn't include the unconstrained planned order
demand.

• The hold dates and expiration dates for on-hand lots are also supported in inventory rebalancing. When you
create a cluster for inventory rebalancing, you can specify the expiration days tolerance for on-hand lots. Any
on-hand lot with an expiration date within the specified tolerance isn't considered as supply during inventory
rebalancing.

After the suggested due date is calculated on the basis of the hold date, if the suggested due date falls outside
the windows for calculation of the excess inventory and inventory shortage, then the on-hand lot isn't used for
inventory rebalancing.

After the inventory rebalancing process, the planned outbound shipments that are generated are considered as
a part of the Total Demand measure and used in the computation of the Expired Lot Quantity measure.

• You must add the Cluster and Source dimensions to the dimension catalog of the replenishment plan for which
you've selected the Rebalance inventory check box on the Plan Options page.

Related Topics
• Inventory Rebalancing Options for Replenishment Plans

• Overview of Multiechelon Replenishment Planning

• Overview of Support for Hold Dates and Expiration Dates in On-Hand Lots
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Work with Clusters  

Create a Cluster  
This topic provides information about clusters and how you create them.

About Clusters
A cluster is a grouping of locations, regions, or zones.

These are the notable points about clusters:

• Inventory rebalancing is performed for the selected item-location combinations in the cluster. If the cluster is
defined at the level of a region or zone, inventory rebalancing is performed for the item-location combinations
in the selected regions or zones.

If Yes is clicked in the Plan Subinventories column on the Organizations tab on the Maintain Supply Network
Model page for an organization (location), item-subinventory combinations are available for selection, and
inventory rebalancing is performed for the selected item-subinventory combinations.

• After inventory rebalancing is performed for the cluster, the excess inventory can optionally be transferred to a
sweep location that may or may not be in the cluster.

• You can even define a nested cluster that consists of the sweep locations of other clusters.

• A location can be in more than one cluster.

• You can use the Cluster dimension to configure your tables and graphs in the Replenishment Planning work
area.

• While creating a cluster, you can specify the expiration days tolerance for on-hand lots. Any on-hand lot with an
expiration date within the specified tolerance isn't considered as supply during inventory rebalancing.

For example, if the expiration days tolerance is 7 days, when the replenishment plan is run on Day 1, any on-
hand lot with an expiration date on or before Day 8 (the plan run date + 7 days) isn't considered for supply.

Create a Cluster
Follow these steps to create a cluster:

1. On the Tasks panel tab, under Plan Inputs, select Manage Planning Clusters.

The Manage Planning Clusters page opens.
2. Click Add Row.

A new row appears for the cluster.
3. Enter the name and description for the cluster.
4. In Source System, select the source system from which you're going to select locations, regions, and zones for

the cluster.

Ensure that the source system matches that of the replenishment plan with which you're going to use the
cluster.
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5. In Sweep Location, optionally, select the sweep location to which excess inventory is moved after inventory
rebalancing is performed for the cluster.
The sweep location doesn't need to be a part of the cluster.

6. In Lead Time Multiplier for Excess Window, enter the number by which the lead time for an item-location
combination is multiplied for determination of the window within which the item-location combination's excess
inventory is calculated.
The lead time is the total of the preprocessing, processing, and postprocessing lead times that are specified for
the item-location combination in the Items table.

Tip:  Use a long window for calculating the excess inventory for the item-location combination so that future
demands within the total lead time are taken care of.

7. In Lead Time Multiplier for Shortage Window, enter the number by which the lead time for the item-location
combination is multiplied for determination of the window within which the item-location combination's
inventory shortage is calculated.
Enter a number that's equal to or less than the number in the Lead Time Multiplier for Excess Window field.
The lead time is determined as explained in the previous step.

Tip:  Use a short window for calculating the inventory shortage for the item-location combination so that
urgent demands can be met from nearby locations.

8. In Reserved Safety Stock Percentage, enter a whole number for the percentage of safety stock for the item-
location combination that's reserved before the item-location combination's excess inventory is calculated.
Only the unreserved portion of the safety stock is considered during the calculation of the excess inventory.

9. In Expiration Days Tolerance for On Hand Lot, enter a whole number that is equal to or greater than zero.
If you don't enter a value, all on-hand lots are considered as supply.
If you enter zero, on-hand lots that expire on the plan run date aren't considered as supply.

10. In Location Hierarchy, select the hierarchy for adding members to the cluster.
If you select Region or Zone, inventory rebalancing is performed for the item-location combinations within the
selected regions or zones.

11. Under Cluster Members, click Edit: Clusters Members to open the Search and Select: Cluster Members dialog
box.
Search for the locations, regions, or zones that you want to include in the cluster, move them to the Selected
Members list, and click OK.
If organizations (locations) are enabled for subinventory planning, you can search for and select subinventories.

12. Click Assign Location Priority to open the Assign Location Priority dialog box.
You can view the selected locations or locations within the selected regions or zones.

13. Under Location Priority, optionally, enter a number for the priority for a location.
During inventory rebalancing, the location with an inventory shortage and the highest priority (lowest number)
is processed first. If two locations have the same number or no priority, the location with the larger shortage is
processed first.

14. Click OK to return to the Manage Planning Clusters page.
15. Save the cluster.
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Related Topics
• Edit a Cluster

Edit a Cluster  
This topic provides information about how you edit clusters.

You can duplicate, edit, or delete a cluster.

You can delete the cluster only when it isn't selected on the Inventory Rebalancing tab on the Plan Options page for a
replenishment plan.

Edit a Cluster
Follow these steps to edit the cluster:

1. On the Tasks panel tab, under Plan Inputs, select Manage Planning Clusters.
The Manage Planning Clusters page opens.

2. Search for the cluster you want to edit, and select it.
3. Edit the name and description of the cluster.
4. In Source System, change the source system.

Note:  If you change the source system, the previously selected sweep location and cluster members are lost.
The assigned priorities in the Assign Location Priority dialog box are also lost. The cluster isn't displayed on
the Inventory Rebalancing tab on the Plan Options page for replenishment plans that previously included the
cluster.

5. In Sweep Location, change the sweep location for the cluster.
6. In Lead Time Multiplier for Excess Window and Lead Time Multiplier for Shortage Window, change the

multipliers for calculating the windows for the excess inventory and inventory shortage for an item-location
combination.

7. In Reserved Safety Stock Percentage, change the percentage of safety stock that's excluded from the
calculation of the item-location combination's excess inventory.

8. In Expiration Days Tolerance for On-Hand Lot, change the number of days for considering the expiration date
for an on-hand lot and not considering it as supply.

9. In Location Hierarchy, change the hierarchy for adding members to the cluster.

Note:  If you change the location hierarchy, the previously selected cluster members are lost. The assigned
priorities in the Assign Location Priority dialog box are also lost.

10. Under Cluster Members, click Edit: Cluster Members to open the Search and Select: Cluster Members dialog
box in which you can add and remove cluster members.

11. Click Assign Location Priority to open the Assign Location Priority dialog box in which you can change the
priorities for locations.

12. Save your changes.

Related Topics
• Inventory Rebalancing Options for Replenishment Plans

• Create a Cluster
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Measures for Inventory Rebalancing  
This topic provides information about the measures that are used in inventory rebalancing for replenishment plans.

This table describes the predefined measures for inventory rebalancing:

Measure Description Supports Cluster
Dimension?

Supports Product
Dimension?

Supports
Organization
Dimension?

Supports Time
Dimension?

Supports Source
Dimension?

Planned Inbound
Shipments
 

Total quantity of
planned orders
to be received at
the destination
location for an item
after inventory
rebalancing.
 

Yes
 

Yes
 

Yes
 

Yes
 

No
 

Planned Outbound
Shipments
 

Total quantity of
planned orders
to be shipped
from the source
location for an item
after inventory
rebalancing.
 

Yes
 

Yes
 

Yes
 

Yes
 

No
 

Excess Before
Rebalancing
 

Excess quantity
before inventory
rebalancing for
an item-location
combination.
The measure
may differ from
the Initial Excess
for Rebalancing
measure if the
item-location
combination
belongs to more
than one cluster,
and inventory
rebalancing has
previously been
performed for
the item-location
combination in
another cluster.
 

Yes
 

Yes
 

Yes
 

No
 

No
 

Excess After
Rebalancing
 

Excess quantity
after inventory
rebalancing for
an item-location
combination.
 

Yes
 

Yes
 

Yes
 

No
 

No
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Measure Description Supports Cluster
Dimension?

Supports Product
Dimension?

Supports
Organization
Dimension?

Supports Time
Dimension?

Supports Source
Dimension?

Shortage Before
Rebalancing
 

Shortage quantity
before inventory
rebalancing for
an item-location
combination. The
measure may
differ from the
Initial Shortage
for Rebalancing
measure if the
item-location
combination
belongs to more
than one cluster,
and inventory
rebalancing has
previously been
performed for
the item-location
combination in
another cluster.
 
 

Yes
 

Yes
 

Yes
 

No
 

No
 

Shortage After
Rebalancing
 

Shortage quantity
after inventory
rebalancing for
an item-location
combination.
 

Yes
 

Yes
 

Yes
 

No
 

No
 

Initial Excess for
Rebalancing
 

Excess quantity
that's initially
available for
inventory
rebalancing for
an item-location
combination.
 
The calculation
of the measure
is based on
the Projected
Inventory measure.
 

No
 

Yes
 

Yes
 

Yes
 

No
 

Initial Shortage for
Rebalancing
 

Shortage quantity
that's initially
available for
inventory
rebalancing for
an item-location
combination.
 
The calculation
of the measure
is based on
the Projected
Inventory measure.
 

No
 

Yes
 

Yes
 

Yes
 

No
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Measure Description Supports Cluster
Dimension?

Supports Product
Dimension?

Supports
Organization
Dimension?

Supports Time
Dimension?

Supports Source
Dimension?

Total Rebalancing
Recommendations
 

Number of
planned orders
recommended
after inventory
rebalancing for
an item-location
combination.
 

Yes
 

Yes
 

Yes
 

No
 

No
 

Rebalanced
Inventory Value
 

Total value of
planned orders
recommended
after inventory
rebalancing.
The measure is
calculated for
an item-location
combination
through
multiplication of
the quantity of
planned orders by
the standard cost
of the item.
 

Yes
 

Yes
 

Yes
 

No
 

No
 

Projected
Inventory
 

Inventory quantity
projected in the
future for an
item-location
combination on
the basis of the
selected supply
types and demand
types.
 

No
 

Yes
 

Yes
 

Yes
 

No
 

Excess
Computation
Window
 

Time window in
days for calculation
of the excess
inventory for an
item-location
combination.
 
This measure
is calculated
by multiplying
the lead time
by the value in
the Lead Time
Multiplier for
Excess Window
field for a cluster
on the Manage
Planning Clusters
page.
 
The lead time is
the total of the
preprocessing,
processing, and

Yes
 

Yes
 

Yes
 

No
 

No
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Measure Description Supports Cluster
Dimension?

Supports Product
Dimension?

Supports
Organization
Dimension?

Supports Time
Dimension?

Supports Source
Dimension?

postprocessing
lead times that
are specified for
the item-location
combination in the
Items table.
 

Shortage
Computation
Window
 

Time window in
days for calculation
of the inventory
shortage for an
item-location
combination.
 
This measure
is calculated by
multiplying the
lead time by the
value in the Lead
Time Multiplier
for Shortage
Window field for
a cluster on the
Manage Planning
Clusters page.
 
The lead time is
the total of the
preprocessing,
processing, and
postprocessing
lead times that
are specified for
the item-location
combination in the
Items table.
 

Yes
 

Yes
 

Yes
 

No
 

No
 

Reserved Safety
Stock
 

Portion of the
safety stock that's
reserved at the
location for an
item during the
computation of the
excess inventory.
 

No
 

Yes
 

Yes
 

Yes
 

No
 

Item Locations
with Excess Before
Rebalancing
 

Number of
item-location
combinations
in a cluster with
excess inventory
before inventory
rebalancing.
 

Yes
 

Yes
 

Yes
 

No
 

No
 

Item Locations
with Excess After
Rebalancing
 

Number of
item-location
combinations
in a cluster with

Yes
 

Yes
 

Yes
 

No
 

No
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Measure Description Supports Cluster
Dimension?

Supports Product
Dimension?

Supports
Organization
Dimension?

Supports Time
Dimension?

Supports Source
Dimension?

excess inventory
after inventory
rebalancing.
 

Item Locations
with Shortage
Before Rebalancing
 

Number of
item-location
combinations
in a cluster with
inventory shortage
before inventory
rebalancing.
 

Yes
 

Yes
 

Yes
 

No
 

No
 

Item Locations
with Shortage
After Rebalancing
 

Number of
item-location
combinations
in a cluster with
inventory shortage
after inventory
rebalancing.
 

Yes
 

Yes
 

Yes
 

No
 

No
 

Percentage of
Item Locations
with Excess Before
Rebalancing
 

Percentage of
item-location
combinations
in a cluster with
excess inventory
before inventory
rebalancing.
 

Yes
 

Yes
 

Yes
 

No
 

No
 

Percentage of
Item Locations
with Excess After
Rebalancing
 

Percentage of
item-location
combinations
in a cluster with
excess inventory
after inventory
rebalancing.
 

Yes
 

Yes
 

Yes
 

No
 

No
 

Percentage of Item
Locations with
Shortage Before
Rebalancing
 

Percentage of
item-location
combinations
in a cluster with
inventory shortage
before inventory
rebalancing.
 

Yes
 

Yes
 

Yes
 

No
 

No
 

Percentage of Item
Locations with
Shortage After
Rebalancing
 

Percentage of
item-location
combinations
in a cluster with
inventory shortage
after inventory
rebalancing.
 

Yes
 

Yes
 

Yes
 

No
 

No
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Measure Description Supports Cluster
Dimension?

Supports Product
Dimension?

Supports
Organization
Dimension?

Supports Time
Dimension?

Supports Source
Dimension?

Total Item
Locations for
Rebalancing
 

Number of
item-location
combinations
in a cluster
for inventory
rebalancing.
 

Yes
 

Yes
 

Yes
 

No
 

No
 

Planned
Shipments
Quantity
 

Total quantity of
planned orders
to be shipped
from the location
for an item
after inventory
rebalancing.
 
The measure
is functionally
similar to the
Planned Outbound
Shipments
measure, but
has the Cluster,
 Organization,
 Product,
 and Source
dimensions.
 

Yes
 

Yes
 

Yes
 

No
 

Yes
 

Planned
Shipments Value
 

Total value of
planned orders
to be shipped
from the location
for an item
after inventory
rebalancing.
The measure is
calculated through
multiplication
of the Planned
Shipments
Quantity measure
with the standard
cost of the item.
 
The measure is
functionally similar
to the Rebalanced
Inventory Value
measure, but
has the Cluster,
 Organization,
 Product,
 and Source
dimensions.
 

Yes
 

Yes
 

Yes
 

No
 

Yes
 

All these measures are in the Inventory Analysis measure group.
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You must add the Cluster and Source dimensions to the dimension catalog of the replenishment plan for which you've
selected the Rebalance inventory check box on the Plan Options page.

How Rebalancing Recommendations Are Created  
This topic explains how rebalancing recommendations are created for replenishment plans.

Settings That Affect the Creation of Rebalancing Recommendations
These settings affect the creation of rebalancing recommendations for a replenishment plan:

• The selections on the Inventory Rebalancing tab on the Plan Options page.

• The selections on the Manage Planning Clusters page for the clusters that are selected on the Inventory
Rebalancing tab.

• The selected segments on the Scope tab on the Plan Options page.

How Rebalancing Recommendations Are Created
Oracle Replenishment Planning uses this high-level process for creating rebalancing recommendations:

1. The item-location combinations for which the process is performed are selected on the basis of these criteria:

◦ The item-location combinations must be in the selected segments for the replenishment plan, and the
MPS and MRP Planning Method attribute for the items should be set to Replenishment planning.

◦ The locations must also be in the selected clusters for the replenishment plan.

2. The forecast is generated or imported for the replenishment plan.
3. Inventory balancing is performed for each cluster on the basis of its sequence number on the Inventory

Rebalancing tab.
4. Within each cluster, locations are selected for processing as follows:

◦ Locations with the highest priority (lowest number) are first processed.

◦ If locations have the same priority or no priority, those with the larger inventory shortages are first
processed.

◦ If locations have the same priorities and inventory shortages, the locations are processed in the
ascending alphanumeric order of their names.

5. For the location being processed, the following steps are taken:

◦ The windows for computation of the excess inventory and inventory shortage for each item in the
location are determined.

◦ The excess inventory or inventory shortage for each item is calculated.

◦ Rebalancing recommendations are created for each item according to the inventory rebalancing rules
specified on the Inventory Rebalancing tab:

- If the Reduce partial recommendations check box is selected, a search is performed for the
nearest location with enough excess inventory to completely meet the inventory shortage at the
location being processed.
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The proximity between the location being processed and any location with excess inventory is
determined through the use of the transfer lead time that's specified in the shipping method
between the locations.

If no location has enough excess inventory to completely meet the inventory shortage, the nearest
location with excess inventory to partially meet the inventory shortage is selected.

If the transfer lead times between the location being processed and two locations with excess
inventory is the same, the location with more excess inventory is selected.

If there are multiple shipping methods between the locations, and a default shipping method isn't
defined, the shipping method with the shortest lead time is selected. If different shipping methods
have the same lead time, the first shipping method in the ascending alphanumeric order of names
is selected.

Note:  If there's no shipping method between the locations, no rebalancing recommendations
are created.

- If the Include safety stock in shortage calculation check box is selected on the Inventory
Rebalancing tab, the safety stock for the item is included in the calculation of the inventory
shortage for the item-location combination.

At the end of the shortage window for the item-location combination, the safety stock is
subtracted from the value of the Projected Inventory measure for calculation of the inventory
shortage. If the resulting value is less than zero for the item-location combination, that value is
considered as the shortage.

6. After all the locations in the cluster are processed, if the Move excess to sweep location check box is selected
on the Inventory Rebalancing tab, the excess inventory from locations is moved to a sweep location that may or
may not be in the cluster.

If the cluster has a sweep location in another cluster, and the excess inventory is moved to the sweep location, a
planned inbound order is created for the sweep location.

7. After inventory rebalancing is performed for the cluster, the next cluster is selected on the basis of its assigned
sequence number.

All the clusters selected on the Inventory Rebalancing tab are processed in this manner.
8. If the Release planned orders automatically check box is selected on the General subtab on the Supply tab

on the Plan Options page, the planned orders with order dates within the release time fence are automatically
released.

The release recommendation parameters specified on the General tab in the Supply: Advanced Options dialog
box that you open from the General subtab on the Supply tab are adhered to.

Note:  The planned orders can also be manually released on the Manage Rebalancing Recommendations
page.

9. The measures and analytics for the replenishment plan are calculated.
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Related Topics
• Segmentation in Oracle Replenishment Planning

• Organizations and Schedules Options for Replenishment Plans

• Automatic Release Options

• Release Recommendation Options

• Scope Plan Options for Replenishment Plans

How You Use the Inventory Rebalancing Feature  
The following is the process for using the inventory rebalancing feature:

1. On the Manage Planning Clusters page, define the clusters for inventory rebalancing.
2. Configure your replenishment plan for inventory rebalancing:

◦ On the Plan Options page for the replenishment plan, select the Rebalance inventory check box.

◦ On the Inventory Rebalancing tab on the Plan Options page, select the clusters, rules, and supplies and
demands for inventory rebalancing.

3. Run the replenishment plan with the Refresh with current data option selected on the Parameters tab in the
Run Plan dialog box.

For every item-location combination in the selected clusters, the excess inventory or inventory shortage is
calculated, and rebalancing recommendations are created.

If you selected the Release planned orders automatically check box on the General subtab on the Supply tab
on the Plan Options page, the planned orders are automatically released.

4. Review the results of inventory rebalancing by using the following:

◦ The Replenishment and Rebalancing Plan Summary page layout

◦ The Cluster Analysis by Quantity and Cluster Analysis by Value pages

◦ The Manage Rebalancing Recommendations page

◦ The Rebalancing Analysis page

◦ The Rebalancing Details by Item Location page

5. If required, manually release your planned orders using the Manage Rebalancing Recommendations page.
The following figure contains the flow chart for using the inventory rebalancing feature:
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Related Topics
• Run a Replenishment Plan

• Automatic Release Options

How the Projected Inventory Measure Is Calculated  
The Projected Inventory measure is used in inventory rebalancing during the calculation of the excess inventory or
inventory shortage for an item-location combination in a cluster of a replenishment plan.

Settings That Affect the Calculation of the Projected Inventory Measure
The supplies and demands that you select on the Inventory Rebalancing tab on the Plan Options page for your
replenishment plan affect the calculation of the Projected Inventory measure.

The Projected Inventory measure differs from the Projected Available Balance measure in that you can configure the
supplies and demands that are considered during the calculation of the former.

391



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 16
Inventory Rebalancing

How the Projected Inventory Measure Is Calculated
The Projected Inventory measure is calculated according to this formula:

Projected Inventory in Bucket N = Projected Inventory in Bucket (N-1) + Sum of Supplies in Bucket N - Sum of Demands
in Bucket N

where Sum of Supplies = Sum of supplies selected on the Inventory Rebalancing tab

and Sum of Demands = Sum of demands selected on the Inventory Rebalancing tab

The Projected Inventory measure is calculated at the start of the inventory rebalancing process for the item-location
combination. After the measure is calculated, it isn't updated with inventory rebalancing recommendations. The
measure is calculated only within the excess computation window.

If the item-location combination is in more than one cluster, the Excess After Rebalancing measure (Excess Before
Rebalancing - Planned Outbound Shipments) for the first cluster is taken as the Excess Before Rebalancing measure for
the item-location combination in the next cluster. Similarly, the Shortage After Rebalancing measure (Shortage Before
Rebalancing - Planned Inbound Shipments) for the first cluster is taken as the Shortage Before Rebalancing measure for
the item-location combination in the next cluster.

Example 1 for Calculation of the Projected Inventory Measure
Note the following about this example:

• The window for calculation of the excess inventory is 4 days.

The inventory rebalancing process is run on Day 1. Therefore, the Projected Inventory measure is calculated up
to Day 5 (plan start date + 4 days).

• On the Manage Planning Clusters page, the value in the Reserved Safety Stock Percentage column for the
cluster is 50.

• On the Inventory Rebalancing tab, the following have been selected:

◦ Demands: Gross forecast

◦ Supplies: On hand

• The Projected Inventory and Reserved Safety Stock measures are determined only during the window for
calculating the excess inventory.

This table provides the measure values for Example 1:

Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7

Gross Forecast
 

10
 

20
 

20
 

20
 

20
 

20
 

20
 

Sales Orders
 

0
 

0
 

35
 

0
 

0
 

0
 

0
 

Net Forecast
 

0
 

0
 

15
 

20
 

20
 

20
 

20
 

Manual Demand
 

0
 

0
 

0
 

0
 

0
 

0
 

0
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7

Sum of
demands
 
(Not a measure)
 

10
 

20
 

20
 

20
 

20
 

20
 

20
 

On Hand
 

100
 

0
 

0
 

0
 

0
 

0
 

0
 

Purchase Orders
 

0
 

0
 

0
 

0
 

40
 

0
 

0
 

Sum of supplies
 
(Not a measure)
 

100
 

0
 

0
 

0
 

0
 

0
 

0
 

Projected
Inventory
 

90
 
(0 + 100 - 10)
 

70
 
(90 + 0 - 20)
 

50
 
(70 + 0 - 20)
 

30
 
(50 + 0 - 20)
 

10
 
(30 + 0 - 20)
 

Not applicable
 

Not applicable
 

Safety Stock
 

20
 

30
 

20
 

20
 

20
 

20
 

20
 

Reserved Safety
Stock
 

10
 

15
 

10
 

10
 

10
 

Not applicable
 

Not applicable
 

Example 2 for Calculation of the Projected Inventory Measure
Note the following about this example:

• The window for calculation of the excess inventory is 4 days, and the window for calculation of the inventory
shortage is 2 days.

The inventory rebalancing process is run on Day 1. Therefore, the Projected Inventory measure is calculated up
to Day 5 (plan start date + 4 days).

• On the Manage Planning Clusters page, the value in the Reserved Safety Stock Percentage column for the
cluster is 50.

• The excess inventory is stored in the Initial Excess for Rebalancing measure and calculated according to this
formula: (lowest value of Projected Inventory within the window for excess inventory calculation) - (highest
value of Reserved Safety Stock within the window for excess inventory calculation) - 1.

• The Projected Inventory and Reserved Safety Stock measures are determined only during the window for
calculating the excess inventory.

• On the Inventory Rebalancing tab, the following have been selected:

◦ Demands: Sales orders, net forecast

◦ Supplies: On hand, purchase orders

This table provides the measure values for Example 2:
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7

Gross Forecast
 

10
 

20
 

20
 

20
 

20
 

20
 

20
 

Sales Orders
 

0
 

0
 

35
 

0
 

0
 

0
 

0
 

Net Forecast
 

0
 

0
 

15
 

20
 

20
 

20
 

20
 

Manual Demand
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Sum of
demands
 
(Not a measure)
 

0
 

0
 

50
 

20
 

20
 

20
 

20
 

On Hand
 

100
 

0
 

0
 

0
 

0
 

0
 

0
 

Purchase Orders
 

0
 

0
 

0
 

0
 

40
 

0
 

0
 

Sum of supplies
 
(Not a measure)
 

100
 

0
 

0
 

0
 

40
 

0
 

0
 

Projected
Inventory
 

100
 
(0 + 100 - 0)
 

100
 
(100 + 0 - 0)
 

50
 
(100 + 0 - 50)
 

30
 
(50 + 0 - 20)
 

50
 
(30 + 40 - 20)
 

Not applicable
 

Not applicable
 

Safety Stock
 

20
 

30
 

20
 

20
 

20
 

20
 

20
 

Reserved Safety
Stock
 

10
 

15
 

10
 

10
 

10
 

Not applicable
 

Not applicable
 

Initial Excess for
Rebalancing
 

14
 
(30 - 15 - 1)
 

Not applicable
 

Not applicable
 

Not applicable
 

Not applicable
 

Not applicable
 

Not applicable
 

Related Topics
• Inventory Rebalancing Options for Replenishment Plans
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How the Excess Inventory and Inventory Shortage Are
Calculated  
This topic explains how the excess inventory or inventory shortage is calculated for an item-location combination in a
cluster of a replenishment plan.

Settings That Affect the Calculation of the Excess Inventory and Inventory
Shortage
The following affect the calculation of the excess inventory or inventory shortage for the item-location combination:

• The sum of the preprocessing, processing, and postprocessing lead times specified for the item-location
combination in the Items table.

• The values in the Lead Time Multiplier for Excess Window, Lead Time Multiplier for Shortage Window,
and Reserved Safety Stock Percentage columns on the Manage Planning Clusters page for the cluster that
contains the item-location combination.

• The values of the Projected Inventory, Safety Stock, and Reserved Safety Stock measures for the item-location
combination.

• The selection of the Include safety stock in shortage calculation check box on the Inventory Rebalancing tab
on the Plan Options page for the replenishment plan.

How the Excess Inventory and Inventory Shortage Are Calculated
This table explains the calculations related to the excess inventory or inventory shortage for the item-location
combination:

Value for the Item-Location
Combination

Calculation

Window for computing the excess
inventory
 

The value in the Excess Computation Window measure is taken.
 
The day on which the inventory rebalancing process is run is added to this value.
 
Only the working days in the calendar for the organization (location) are considered for this window's
calculation.
 
For example, if the value of the Excess Computation Window measure is 3 days, and the plan is run on
Day 1, the excess computation window is up to Day 4.
 

Window for computing the inventory
shortage
 

The value in the Shortage Computation Window measure is taken.
 
The day on which the inventory rebalancing process is run is added to this window.
 
Only the working days in the calendar for the organization (location) are considered for this window's
calculation.
 
For example, if the value of the Shortage Computation Window measure is 2 days, and the plan is run
on Day 1, the shortage computation window is up to Day 3.
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Value for the Item-Location
Combination

Calculation

 

Initial Excess for Rebalancing measure
 

(lowest value of Projected Inventory measure within the excess computation window) - (highest value
of Reserved Safety Stock measure within the excess computation window) - 1
 
If the value of the calculation is greater than zero, the value is the excess inventory and is stored in the
Initial Excess for Rebalancing measure.
 

Initial Shortage for Rebalancing measure
 

At the end of the shortage computation window, the following are done:
 

1. If the Include safety stock in shortage calculation check box is selected on the Inventory
Rebalancing tab, the Safety Stock measure is subtracted from the Projected Inventory measure.

If the check box isn't selected, only the Projected Inventory measure is considered.
2. If the value of the previous step is less than zero, the value is the inventory shortage and is stored

in the Initial Shortage for Rebalancing measure.

Note:  If the item-location combination doesn't have excess inventory or an inventory shortage, inventory rebalancing
isn't performed for the item-location combination.  An item-location combination that has both excess inventory and
an inventory shortage is identified as having an inventory shortage.

After the total lead time is multiplied by the multipliers for the excess and shortage computation windows, the resulting
values are rounded off as follows:

• Standard logic for rounding is applied when the resulting value is greater than one.

• When the resulting value is less than one, the value is rounded off to one.

Examples for Determination of the Excess and Shortage Computation
Windows
This table provides examples for determining the excess and shortage computation windows for the item-location
combination:

Total Lead Time Lead Time
Multiplier for
Excess Window

Excess
Computation
Window (Before
Rounding)

Excess
Computation
Window (After
Rounding)

Lead Time
Multiplier for
Shortage Window

Shortage
Computation
Window (Before
Rounding)

Shortage
Computation
Window (After
Rounding)

4
 

3
 

12
 

12
 

2
 

8
 

8
 

4
 

2.5
 

10
 

10
 

1.5
 

6
 

6
 

4
 

2.6
 

10.4
 

10
 

1.6
 

6.4
 

6
 

4
 

2.72
 

10.88
 

11
 

1.72
 

6.88
 

7
 

4 0.5 2 2 0.5 2 2
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Total Lead Time Lead Time
Multiplier for
Excess Window

Excess
Computation
Window (Before
Rounding)

Excess
Computation
Window (After
Rounding)

Lead Time
Multiplier for
Shortage Window

Shortage
Computation
Window (Before
Rounding)

Shortage
Computation
Window (After
Rounding)

       

4
 

0.21
 

0.84
 

1
 

0.1
 

0.4
 

1
 

4
 

0.1
 

0.4
 

1
 

0.01
 

0.04
 

1
 

Example 1 for Determination of the Excess Inventory and Inventory
Shortage
Note the following about this example:

• The value of the Excess Computation Window measure is 2 days.

Therefore, the Projected Inventory measure is calculated for 3 days.

• The value of the Shortage Computation Window measure is 1 day.

Therefore, the shortage is calculated for 2 days.

• The value of the Safety Stock measure is 10.

• The value of the Reserved Safety Stock measure is zero.

• The Include safety stock in shortage calculation check box isn't selected on the Inventory Rebalancing tab.

This table provides inputs for calculating the excess inventory and inventory shortage:

Day 1 Day 2 Day 3 Day 4 Day 5 Day 6

Sum of demands
 
(Not a measure)
 

10
 

10
 

10
 

10
 

10
 

10
 

Sum of supplies
 
(Not a measure)
 

100
 

0
 

0
 

0
 

0
 

0
 

Projected
Inventory measure
 

90
 

80
 

70
 

Not applicable
 

Not applicable
 

Not applicable
 

The excess inventory is 69 (70 - 1). Therefore, the value of the Initial Excess for Rebalancing measure for the item-
location combination is 69.

On Day 2, the value of the Projected Inventory measure is 80, which is more than zero. Therefore, there's no inventory
shortage.
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Example 2 for Determination of the Excess Inventory and Inventory
Shortage
Note the following about this example:

• The value of the Excess Computation Window measure is 2 days.

Therefore, the Projected Inventory measure is calculated for 3 days.

• The value of the Shortage Computation Window measure is 1 day.

Therefore, the shortage is calculated for 2 days.

• The value of the Safety Stock measure is 10.

• The value of the Reserved Safety Stock measure is zero.

• The Include safety stock in shortage calculation check box isn't selected on the Inventory Rebalancing tab.

This table provides inputs for calculating the excess inventory and inventory shortage:

Day 1 Day 2 Day 3 Day 4 Day 5 Day 6

Sum of demands
 
(Not a measure)
 

10
 

10
 

10
 

10
 

10
 

10
 

Sum of supplies
 
(Not a measure)
 

30
 

0
 

0
 

0
 

0
 

0
 

Projected
Inventory measure
 

20
 

10
 

0
 

Not applicable
 

Not applicable
 

Not applicable
 

The excess inventory is less than zero (0 - 1). Therefore, there's no excess inventory.

On Day 2, the value of the Projected Inventory measure is 10, which is more than zero. Therefore, there's no inventory
shortage.

The item-location combination has no excess inventory or inventory shortage and isn't included in the inventory
rebalancing process.

Example 3 for Determination of the Excess Inventory and Inventory
Shortage
Note the following about this example:

• The value of the Excess Computation Window measure is 2 days.

Therefore, the Projected Inventory measure is calculated for 3 days.

• The value of the Shortage Computation Window measure is 1 day.

Therefore, the shortage is calculated for 2 days.
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• The value of the Safety Stock measure is 10.

• The value of the Reserved Safety Stock measure is zero.

• The Include safety stock in shortage calculation check box isn't selected on the Inventory Rebalancing tab.

This table provides inputs for calculating the excess inventory and inventory shortage:

Day 1 Day 2 Day 3 Day 4 Day 5 Day 6

Sum of demands
 
(Not a measure)
 

10
 

10
 

10
 

10
 

10
 

10
 

Sum of supplies
 
(Not a measure)
 

10
 

0
 

0
 

0
 

0
 

0
 

Projected
Inventory measure
 

0
 

-10
 

-20
 

Not applicable
 

Not applicable
 

Not applicable
 

The excess inventory is less than zero (-20 - 1). Therefore, there's no excess inventory.

On Day 2, the value of the Projected Inventory measure is -10, which is less than zero. Therefore, the value of the Initial
Shortage for Rebalancing measure for the item-location combination is 10.

Example 4 for Determination of the Excess Inventory and Inventory
Shortage
Note the following about this example:

• The value of the Excess Computation Window measure is 2 days.
Therefore, the Projected Inventory measure is calculated for 3 days.

• The value of the Shortage Computation Window measure is 1 day.
Therefore, the shortage is calculated for 2 days.

• The value of the Safety Stock measure is 10.

• The value of the Reserved Safety Stock measure is zero.

• The Include safety stock in shortage calculation check box is selected on the Inventory Rebalancing tab.

This table provides inputs for calculating the excess inventory and inventory shortage:

Day 1 Day 2 Day 3 Day 4 Day 5 Day 6

Sum of demands
 
(Not a measure)
 

10
 

10
 

10
 

10
 

10
 

10
 

Sum of supplies
 

0
 

0
 

50
 

0
 

0
 

0
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Day 1 Day 2 Day 3 Day 4 Day 5 Day 6

(Not a measure)
 

Projected
Inventory measure
 

-10
 

-20
 

20
 

Not applicable
 

Not applicable
 

Not applicable
 

The excess inventory is 19 (20 - 1).

On Day 2, the value of the Projected Inventory measure is -20, and the inventory shortage is -30 (-20 - the safety stock
of 10), which is less than zero. Therefore, the value of the Initial Shortage for Rebalancing measure for the item-location
combination is 30.

The item-location combination has both excess inventory and an inventory shortage and is identified as having an
inventory shortage.

Example 5 for Determination of the Excess Inventory and Inventory
Shortage
Note the following about this example:

• The value of the Excess Computation Window measure is 2 days.

Therefore, the Projected Inventory measure is calculated for 3 days.

• The value of the Shortage Computation Window measure is 2 days.

Therefore, the shortage is calculated for 3 days.

• The value of the Safety Stock measure is 80.

• The value of the Reserved Safety Stock measure is zero.

• The Include safety stock in shortage calculation check box is selected on the Inventory Rebalancing tab.

This table provides inputs for calculating the excess inventory and inventory shortage:

Day 1 Day 2 Day 3 Day 4 Day 5 Day 6

Sum of demands
 
(Not a measure)
 

10
 

10
 

10
 

10
 

10
 

10
 

Sum of supplies
 
(Not a measure)
 

100
 

0
 

0
 

0
 

0
 

0
 

Projected
Inventory measure
 

90
 

80
 

70
 

Not applicable
 

Not applicable
 

Not applicable
 

The excess inventory is 69 (70 - 1).
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On Day 3, the value of the Projected Inventory measure is 70, and the inventory shortage is -10 (70 - the safety stock of
80), which is less than zero. Therefore, the value of the Initial Shortage for Rebalancing measure for the item-location
combination is 10.

The item-location combination has both excess inventory and an inventory shortage and is identified as having an
inventory shortage.

Related Topics
• Inventory Rebalancing Options for Replenishment Plans

Example of Inventory Rebalancing  
This topic provides an example of inventory rebalancing in a replenishment plan.

On the Inventory Rebalancing tab on the Plan Options page for the replenishment plan, the Move excess to sweep
location check box is selected, but the Reduce partial recommendations check box isn't selected.

This table provides information about the clusters in the replenishment plan:

Sequence Number on Inventory
Rebalancing Tab

Cluster Name Locations Sweep Location

1
 

Cluster 1
 

M1, M2, M3, M4, and M5
 

M1
 

2
 

Cluster 2
 

S1, S2, S3, S4, and S5
 

S4
 

3
 

Cluster 3
 

M1 and S4
 

 

Within each cluster, the locations don't have any priority.

This table lists some of the lead times between source and destination locations in Cluster 1:

Source Location Destination Location Lead Time

M1
 

M3
 

3
 

M2
 

M3
 

2
 

This table lists some of the lead times between source and destination locations in Cluster 2:

Source Location Destination Location Lead Time

S1
 

S3
 

3
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Source Location Destination Location Lead Time

S2
 

S3
 

2
 

Inventory Rebalancing in Cluster 1
After the Projected Inventory measure is calculated for an item in the locations of Cluster 1, the excess inventory and
inventory shortage are initially computed as follows:

Measure M1 M2 M3 M4 M5

Excess Before
Rebalancing
 

12
 

6
 

   

Shortage Before
Rebalancing
 

  9
 

1
 

7
 

Note these points:

1. The inventory rebalancing process starts with the location that has the largest inventory shortage: M3.
2. M1 and M2 have excess inventory, but the lead time between M2 and M3 is less than the lead time between M1

and M3. Therefore, a planned order for transferring 6 units is created between M2 and M3.

The inventory shortage at M3 is now 3 units (9 - 6), and the excess inventory at M2 is zero (6 - 6).
3. A second planned order for transferring 3 units is created between M1 and M3.

The inventory shortage at M3 is now zero (3 - 3), and the excess inventory at M1 is 9 units (12 - 3).

Note:  If the Reduce partial recommendations check box were selected on the Inventory Rebalancing tab, a
planned order for transferring 9 units would have been created between M1 and M3. Consequently, only one
shipment would have been created for M3.

4. The inventory rebalancing process picks up the location with the second largest inventory shortage: M5.
5. A planned order for transferring 7 units is created between M1 and M5.

The inventory shortage at M5 is now zero (7 - 7), and the excess inventory at M1 is 2 units (9 - 7).
6. The inventory rebalancing process picks up the last remaining location with an inventory shortage: M4.

A planned order for transferring 1 unit is created between M1 and M4.

The inventory shortage at M4 is now zero (1 - 1), and the excess inventory at M1 is 1 unit (2 - 1).

This table provides the final computation of the excess inventory and inventory shortage for the item in Cluster 1:

Measure M1 M2 M3 M4 M5

Excess After
Rebalancing
 

1
 

0
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Measure M1 M2 M3 M4 M5

Shortage After
Rebalancing
 

  0
 

0
 

0
 

Inventory Rebalancing in Cluster 2
After the Projected Inventory measure is calculated for the item in the locations of Cluster 2, the excess inventory and
inventory shortage are initially computed as follows:

Measure S1 S2 S3 S4 S5

Excess Before
Rebalancing
 

8
 

6
 

   

Shortage Before
Rebalancing
 

  9
 

1
 

7
 

Note these points:

1. The inventory rebalancing process starts with the location that has the largest inventory shortage: S3.
2. S1 and S2 have excess inventory, but the lead time between S2 and S3 is less than the lead time between S1 and

S3. Therefore, a planned order for transferring 6 units is created between S2 and S3.

The inventory shortage at S3 is now 3 units (9 - 6), and the excess inventory at S2 is zero (6 - 6).
3. A second planned order for transferring 3 units is created between S1 and S3.

The inventory shortage at S3 is now zero (3 - 3), and the excess inventory at S1 is 5 units (8 - 3).
4. The inventory rebalancing process picks up the location with the second largest inventory shortage: S5.
5. A planned order for transferring 5 units is created between S1 and S5.

The inventory shortage at S5 is now 2 units (7 - 5), and the excess inventory at S1 is zero (5 - 5).

This table provides the final computation of the excess inventory and inventory shortage for the item in Cluster 2:

Measure S1 S2 S3 S4 S5

Excess After
Rebalancing
 

0
 

0
 

   

Shortage After
Rebalancing
 

  0
 

1
 

2
 

Inventory Rebalancing in Cluster 3
These are the initial values for the excess inventory and inventory shortage for the item in Cluster 3:
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Measure M1 S4

Excess Before Rebalancing
 

1
 

 

Shortage Before Rebalancing
 

 1
 

A planned order for transferring 1 unit is created between M1 and S4.

The inventory shortage at S4 is now zero (1 - 1), and the excess inventory at M1 is zero (1 - 1).

This table provides the final computation of the excess inventory and inventory shortage for the item in Cluster 3:

Measure M1 S4

Excess After Rebalancing
 

0
 

 

Shortage After Rebalancing
 

 0
 

Related Topics
• Inventory Rebalancing Options for Replenishment Plans

Examples of Inventory Rebalancing and Replenishment
Planning  
This topic provides examples of inventory rebalancing and the subsequent replenishment planning for replenishment
plans.

Example with No Sweep Location
In this example, the replenishment plan has a cluster with two locations, Store 1 and Store 2, and none of the locations is
a sweep location.

After inventory rebalancing, these are the measure values for an item in Store 1:

Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9

Gross
Forecast
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

Reserved
Safety Stock
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9

On Hand
 

125
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Purchase
Orders
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Transfer
Orders
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Projected
Inventory
 

115
 

105
 

95
 

85
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Initial
Excess for
Rebalancing
 

74
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Initial
Shortage for
Rebalancing
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Planned
Outbound
Shipments
 

30
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Planned
Inbound
Shipments
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Projected
Available
Balance
 

85
 

75
 

65
 

55
 

45
 

35
 

25
 

15
 

60
 

Note the following:

• The value of the Excess Computation Window measure is 3 days.

Therefore, the Projected Inventory measure is calculated for 4 days.

• The excess inventory for rebalancing is 74 (85 - 10 - 1).

This value is stored in the Initial Excess for Rebalancing and Excess Before Rebalancing measures.

• A planned order for transferring 30 units from Store 1 to Store 2 is recommended on account of the inventory
shortage at Store 2.

The value of the Planned Outbound Shipments measure is 30 for Day 1, which is the ship date of the planned
order.

• The value of the Excess After Rebalancing measure is 44 (74 - 30).

After inventory rebalancing, these are the measure values for the item in Store 2:
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9

Gross
Forecast
 

30
 

30
 

30
 

18
 

30
 

30
 

30
 

18
 

18
 

Reserved
Safety Stock
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

On Hand
 

30
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Purchase
Orders
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Transfer
Orders
 

0
 

0
 

80
 

0
 

0
 

0
 

0
 

0
 

0
 

Projected
Inventory
 

0
 

-30
 

20
 

2
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Initial
Excess for
Rebalancing
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Initial
Shortage for
Rebalancing
 

30
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Planned
Outbound
Shipments
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Planned
Inbound
Shipments
 

0
 

30
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Projected
Available
Balance
 

0
 

0
 

50
 

12
 

-18
 

-48
 

-78
 

-96
 

-114
 

Note the following:

• The value of the Excess Computation Window measure is 3 days.
Therefore, the Projected Inventory measure is calculated for 4 days.

• The excess inventory is -9 (2 - 10 - 1), and there's no excess for rebalancing.

• The value of the Shortage Computation Window measure is 1 day.
Therefore, the inventory shortage is calculated for 2 days.

• The Include safety stock in shortage calculation check box isn't selected on the Inventory Rebalancing tab on
the Plan Options page for the replenishment plan. Therefore, the inventory shortage for rebalancing is 30.
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This value is stored in the Initial Shortage for Rebalancing and Shortage Before Rebalancing measures.

• A planned order for transferring 30 units from Store 1 to Store 2 is recommended on account of the inventory
shortage at Store 2.

The value of the Planned Inbound Shipments measure is 30 for Day 2, which is the due date of the planned
order.

• The value of the Shortage After Rebalancing measure is 0 (30 - 30).

After replenishment planning, these are the measure values for the item in Store 1:

Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9

Gross
Forecast
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

Net Forecast
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

Sales Orders
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Total
Demand
 

40
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

On Hand
 

125
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Purchase
Orders
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Transfer
Orders
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Planned
Outbound
Shipments
 

30
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Planned
Inbound
Shipments
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Total Supply
 

125
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

55
 

On Order
 

0
 

0
 

0
 

0
 

0
 

55
 

55
 

55
 

0
 

Projected
Available
Balance
 

85
 

75
 

65
 

55
 

45
 

35
 

25
 

15
 

60
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9

Beginning
Inventory
Position
 

85
 

75
 

65
 

55
 

45
 

90
 

80
 

70
 

60
 

Planned
Replenishments
by Order
Date
 

0
 

0
 

0
 

0
 

55
 

0
 

0
 

0
 

0
 

Planned
Replenishments
by Due Date
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

55
 

Final
Inventory
Position
 

85
 

75
 

65
 

55
 

100
 

90
 

80
 

70
 

60
 

Adjusted
Minimum
Quantity
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Final
Minimum
Quantity
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

50
 

Adjusted
Maximum
Quantity
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Final
Maximum
Quantity
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

Note the following:

• On Day 1, the Total Demand measure sums up the Net Forecast and Planned Outbound Shipments measures
and is 40 (10 + 30).

• There's no change to the computation logic for replenishment orders.

After replenishment planning, these are the measure values for the item in Store 2:

Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9

Gross
Forecast
 

30
 

30
 

30
 

18
 

30
 

30
 

30
 

18
 

18
 

Net Forecast
 

30
 

30
 

30
 

18
 

30
 

30
 

30
 

18
 

18
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9

Sales Orders
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Total
Demand
 

30
 

30
 

30
 

18
 

30
 

30
 

30
 

18
 

18
 

On Hand
 

30
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Purchase
Orders
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Transfer
Orders
 

0
 

0
 

80
 

0
 

0
 

0
 

0
 

0
 

0
 

Planned
Outbound
Shipments
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Planned
Inbound
Shipments
 

0
 

30
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Total Supply
 

30
 

30
 

80
 

0
 

160
 

0
 

0
 

0
 

0
 

On Order
 

110
 

80
 

160
 

160
 

0
 

0
 

0
 

0
 

156
 

Projected
Available
Balance
 

0
 

0
 

50
 

32
 

162
 

132
 

102
 

84
 

66
 

Beginning
Inventory
Position
 

110
 

80
 

210
 

192
 

162
 

132
 

102
 

84
 

222
 

Planned
Replenishments
by Order
Date
 

0
 

160
 

0
 

0
 

0
 

0
 

0
 

156
 

0
 

Planned
Replenishments
by Due Date
 

0
 

0
 

0
 

0
 

160
 

0
 

0
 

0
 

0
 

Final
Inventory
Position
 

110
 

240
 

210
 

192
 

162
 

132
 

102
 

240
 

222
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9

Adjusted
Minimum
Quantity
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Final
Minimum
Quantity
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

100
 

Adjusted
Maximum
Quantity
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Final
Maximum
Quantity
 

240
 

240
 

240
 

240
 

240
 

240
 

240
 

240
 

240
 

Note the following:

• On Day 2, the Total Supply measure includes the Planned Inbound Shipments measure and is 30.

• On Day 1, the On Order measure includes the planned inbound shipment of 30 units that's arriving on Day 2.

• There's no change to the computation logic for replenishment orders.

Example with a Sweep Location
In this example, the replenishment plan has two clusters, Cluster 1 and Cluster 1.

Cluster 1 has the M1 and M2 locations, and M1 is a sweep location. M1 has excess inventory of 34 units of an item, and
M2 has an inventory shortage of 30 units of the item.

After inventory rebalancing for Cluster 1, these measure values for the item in M1 are calculated:

Note:  The measure values in this table aren't displayed and are provided only for explanation of the inventory
rebalancing logic.

Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9

Gross
Forecast
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

On Hand
 

85
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Transfer
Orders
 

0
 

40
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Projected
Inventory
 

75
 

105
 

95
 

85
 

75
 

65
 

55
 

45
 

Not
applicable
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9

Initial
Excess for
Rebalancing
 

34
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Initial
Shortage for
Rebalancing
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Planned
Outbound
Shipments
 

30
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Planned
Inbound
Shipments
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Reserved
Safety Stock
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

Note the following:

• The value of the Excess Computation Window measure is 7 days.

Therefore, the Projected Inventory measure is calculated for 8 days.

• The value of the Initial Excess for Rebalancing measure is 34 (45 - 10 - 1).

• A planned order is created for transferring 30 units from M1 to M2.

• The value of the Excess After Rebalancing measure is calculated as follows: Excess Before Rebalancing (34) -
Planned Outbound Shipments (30) = 4

• The value of the Shortage After Rebalancing measure for the item at M2 is calculated as follows: Shortage
Before Rebalancing (30) - Planned Inbound Shipments (30) = 0

Cluster 2 has the M1 and S1 locations. M1 has excess inventory of 4 units of the item, and S1 has an inventory shortage of
4 units of the item.

When inventory rebalancing is done for Cluster 2, the value of the Excess After Rebalancing measure for the item at M1
in Cluster 1 is taken as the value of the Excess Before Rebalancing measure for the item at M1 in Cluster 2.

After inventory rebalancing for Cluster 2, these measure values for the item in M1 are displayed on the Rebalancing
Analysis page:

Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9

Gross
Forecast
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

On Hand
 

85
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
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Measure Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 Day 8 Day 9

Transfer
Orders
 

0
 

40
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Projected
Inventory
 

75
 

105
 

95
 

85
 

75
 

65
 

55
 

45
 

Not
applicable
 

Initial
Excess for
Rebalancing
 

34
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Initial
Shortage for
Rebalancing
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Not
applicable
 

Planned
Outbound
Shipments
 

34
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Planned
Inbound
Shipments
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

0
 

Reserved
Safety Stock
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

10
 

Note the following:

• The value of the Excess Computation Window measure is 7 days.
Therefore, the Projected Inventory measure is calculated for 8 days.

• A planned order is created for transferring 4 units from M1 to S1.

• The value of the Initial Excess for Rebalancing measure is 34 (45 - 10 - 1).

• The value of the Planned Outbound Shipments measure is the sum for Cluster 1 and Cluster 2 and is 34 (30 + 4).

You can see these measure values for the item on the Rebalancing Details by Item Location page:

Cluster Location Excess Before
Rebalancing

Excess After
Rebalancing

Shortage
Before
Rebalancing

Shortage After
Rebalancing

Planned
Inbound
Shipments

Planned
Outbound
Shipments

Cluster 1
 

M1
 

34
 

4
 

0
 

0
 

0
 

30
 

Cluster 1
 

M2
 

0
 

0
 

30
 

0
 

30
 

0
 

Cluster 2
 

M1
 

4
 

0
 

0
 

0
 

0
 

4
 

Cluster 2 S1 0 0 4 0 4 0
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Cluster Location Excess Before
Rebalancing

Excess After
Rebalancing

Shortage
Before
Rebalancing

Shortage After
Rebalancing

Planned
Inbound
Shipments

Planned
Outbound
Shipments

        

Related Topics
• Inventory Rebalancing Options for Replenishment Plans

End Item Substitution and Supersession in Inventory
Rebalancing  

Overview of Support for End Item Substitution and Supersession
in Inventory Rebalancing  
You can configure your replenishment plan so that it performs end item substitution and supersession as well as
inventory rebalancing.

By using the functionality for end item substitution and supersession along with the functionality for inventory
rebalancing, you can achieve the following while doing replenishment planning for a primary item at a location:

• Use the excess of a substitute or supersession item at the location before transferring the excess inventory for
the primary item from other locations within a cluster.

• Use the excess of the substitute or supersession item available at other locations in the cluster so long as the
item relationships are recognized.

• Minimize procurement and transportation costs and obsolescence within your supply chain.

Related Topics
• How End Item Substitution and Supersession Are Done with Inventory Rebalancing

• Example of End Item Substitution and Supersession with Inventory Rebalancing

How End Item Substitution and Supersession Are Done with
Inventory Rebalancing  
This topic provides the high-level process for how end item substitution and supersession are done along with
inventory rebalancing in a replenishment plan.
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The following steps explain how end item substitution and supersession are performed along with inventory
rebalancing:

1. The excess inventory or inventory shortage is calculated for an item-location combination in a cluster. The
substitution or supersession chains are ignored in this step.

The logic for inventory rebalancing is used.
2. End item substitution or supersession is performed within the location.

The shortage of the item in the location is resolved through the use of the excess inventory for the substitute
item or supersession item at the same location.

The logic for end item substitution or supersession is used.
3. The remaining inventory shortages are resolved for the item through the use of the excess inventory for the

same item in other locations in the cluster.

The logic for inventory rebalancing is used.
4. Any remaining inventory shortages are resolved for the item through the use of the excess inventory for the

substitute item or supersession item in other locations in the cluster.

The logic for inventory rebalancing is used.

The excess inventory is moved to the sweep location.
The process is summarized by the following diagram:
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Additional Points to Note
Note these additional points about how end item substitution and supersession are done along with inventory
rebalancing:

• In inventory rebalancing, sourcing rules aren't required for the movement of inventory between locations. This
feature of inventory rebalancing is leveraged when end item substitution and supersession are done along with
inventory rebalancing, and sourcing rules aren't required for the movement of substitute and supersession
items in a location or between locations of a cluster.

• During end item substitution and supersession, the item relationships defined for the destination organization
take precedence over the item relationships defined for the source organization.

• The inventory rebalancing window for excess inventory is considered during end item substitution and
supersession. The excess window defined for end item substitution and supersession isn't considered.
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Related Topics
• Overview of Support for End Item Substitution and Supersession in Inventory Rebalancing

• Example of End Item Substitution and Supersession with Inventory Rebalancing

Example of End Item Substitution and Supersession with
Inventory Rebalancing  
This topic contains an example of how end item substitution and supersession are performed with inventory
rebalancing in a replenishment plan.

In this example, we have a cluster of four locations (organizations), M1, M2, M3, and M4. Also, we have two items, A, and
B. Item B is a substitute for Item A.

Calculation of Excess Inventory and Inventory Shortage for All Item-Location
Combinations
The excess inventory and inventory shortage are calculated for all item-location combinations of the cluster according
to the inventory rebalancing logic.

For Item A, Locations M1 and M2 have excess inventory of 12 units and 6 units respectively, and Locations M3 and M4
have an inventory shortage of 9 units and 23 units respectively.

For Item B, Locations M2 and M3 have excess inventory of 8 units and 15 units respectively, and Location M1 has an
inventory shortage of 7 units.

The substitution and supersession chains are initially ignored.

The following figure depicts the excess inventory and inventory shortage for the locations:

End Item Substitution and Supersession Within Each Location
End item substitution and supersession are then performed within each location.
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For Location M3, the inventory shortage of 9 units for Item A is met from the excess inventory of 15 units for Item B
because Item B is a substitute for Item A. The substitute supply for Item A is 9 units, and the substitute demand for Item
B is 9 units. The remaining excess inventory for Item B is 6 units (15-9).

The following figure depicts the results of end item substitution and supersession within each location:

Inventory Rebalancing Across the Cluster
Inventory rebalancing is then performed for the locations across the cluster, and the substitution or supersession chains
are ignored.

For Item A, the inventory shortage is 23 units at Location M4, and the excess inventory is 12 units and 6 units at
Locations M1 and M2 respectively. Planned orders are created for transfer of this excess inventory to Location M4, after
which the inventory shortage at Location M4 is 5 units.

For Item B, the inventory shortage is 7 units at Location M1, and the excess inventory is 8 units and 6 units at Locations
M2 and M3 respectively. A planned order is created for the transfer of the excess inventory from Location M2 to
Location M1, after which the excess inventory at Location M2 is 1 unit, and the inventory shortage at Location M1 is 0
units.

The following figure depicts the results of inventory rebalancing across locations of the cluster:
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Inventory Rebalancing Across the Cluster with Substitute and Supersession Items
Finally, inventory rebalancing is performed for the locations across the cluster, and the substitute and supersession
items are used for meeting inventory shortages.

Location M4 has an inventory shortage of 5 units for Item A, and Location M3 has excess inventory of 6 units for Item
B. Therefore, a planned order of 5 units of Item B is created for meeting the inventory shortage of Item A at Location
M4 because Item B is a substitute for Item A. The substitute supply for Item A is 5 units, and the substitute demand for
Item B is 5 units. After this planned order, the inventory shortage of Item A at Location M4 is 0 units, and the excess
inventory of Item B at Location M3 is 1 unit.

The following figure depicts the results of inventory rebalancing across the locations of the cluster with the use of

substitute and supersession items. 

Related Topics
• Overview of Support for End Item Substitution and Supersession in Inventory Rebalancing

• How End Item Substitution and Supersession Are Done with Inventory Rebalancing
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Manually Release Rebalancing Recommendations  
This topic explains how you can manually release the rebalancing recommendations generated by the inventory
rebalancing process for your replenishment plan.

If you haven't set up your replenishment plan for automatic release of replenishment orders by selecting the Release
planned orders automatically check box on the General subtab on the Supply tab on the Plan Options page, you can
manually release the rebalancing recommendations using the Manage Rebalancing Recommendations page.

Follow these steps to manually release your rebalancing recommendations:

1. After the inventory rebalancing process is run, open your replenishment plan through one of these ways:

Note:  If you aren't using an integrated replenishment plan, open the replenishment plan for which you've
selected the Rebalance inventory check box on the Plan Options page.

◦ Use the Manage Plans page:

i. On the Tasks panel tab, under Plans, select Manage Plans.

The Manage Plans page opens.
ii. Under Search Results, select the replenishment plan that you want to open, and click Actions >

Open.

The replenishment plan opens in a separate page.

◦ On the Plans panel tab, under Plans, right-click the replenishment plan that you want to open, and select
Open.

The replenishment plan opens in a separate page.
2. Click the Open drop-down button.

The Open Table, Graph, or Tile Set dialog box opens.
3. Search for the Manage Rebalancing Recommendations table, and open it.

The Manage Rebalancing Recommendations page opens under the replenishment plan. Only inventory
rebalancing recommendations are displayed on this page. The value under the Order Type column is Planned
order, and the value under the Action column is Release.

Note:  You can also drill to the Manage Rebalancing Recommendations page from the analytics for inventory
rebalancing.

4. Under Search, perform a search for the item-location combinations and clusters for which you want to
manually release rebalancing recommendations.

5. Select a rebalancing recommendation that you want to manually release, and follow these steps:

a. Under Search Results, click Actions > Mark for Release.

The row is marked with the Changed icon, and the release status for the item-location combination
changes to Marked for release.

The quantity in the Order Quantity column is copied to the Implement Quantity column.
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b. If required, edit the values in the implementation-related and Shipping Method columns.

These changes are lost the next time you run the replenishment plan.
6. Repeat the previous step for the item-location combinations for which you want to manually release

rebalancing recommendations.
7. To change your decision about manually releasing a rebalancing recommendation, select the row, and under

Search Results, click Actions > Unmark for Release.

The release status for the item-location combination changes to Release.
8. Save the replenishment plan.
9. On the Actions menu for the replenishment plan, select Release.

The Release Plan dialog box appears.
10. Click Yes.

The Plan Status Details dialog box appears and displays the status of the release process.
11. Click OK to return to the Manage Rebalancing Recommendations page.
12. Under Search, click View > Refresh.

For the manually released rebalancing recommendations, the value under the Release Status column changes
to Released and under the Action column to None.

Related Topics
• Automatic Release Options

• Best Practices for Setting Up Replenishment Plans

How You Use the Analytics for Inventory Rebalancing  
You can use analytics to analyze the effectiveness of the inventory rebalancing process, review the inventory
rebalancing recommendations at various levels, and troubleshoot issues.

Analytics for Inventory Rebalancing
These are the analytics for inventory rebalancing:

• The Replenishment and Rebalancing Plan Summary page layout that includes the Rebalancing Performance
infotile.

Use this infotile to access the Shortages by Cluster and Excess by Cluster graphs, using which you can review
the counts of item-location combinations in clusters with excess inventory and inventory shortages before and
after inventory rebalancing.

• The Cluster Analysis by Quantity and Cluster Analysis by Value pages.

Use these pages to get a high-level view of the inventory rebalancing recommendations by quantity or value
among source and destination locations in a cluster. A highlight is used for the shipping lanes with inventory
rebalancing recommendations in the top 10% by quantity or value in the cluster. Using these highlighted lanes,
you can further analyze the inventory rebalancing results.

• The Manage Rebalancing Recommendations page.
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Use this page to view and manually release the planned orders recommended by the inventory rebalancing
process.

The Initial Excess at Source column provides the excess inventory at the source location for an item before the
planned order is released. The Initial Shortage at Destination column provides the inventory shortage at the
destination location for the item before the planned order is released.

• The Rebalancing Analysis page.

Use this page to analyze the time-phased inventory rebalancing results for an item-location combination.
You can analyze how various measures, such as Projected Inventory, Initial Excess for Rebalancing, and Initial
Shortage for Rebalancing, are calculated. You can also view the inbound and outbound planned shipments.

• The Rebalancing Details by Item Location page.

Use this page to view the excess inventory and inventory shortage for an item across the locations of a cluster.
The page also provides information about the excess and shortage computation windows.

Note:  You must add the Cluster and Source dimensions to the dimension catalog of the replenishment plan for which
you've selected the Rebalance inventory check box on the Plan Options page.

Use the Analytics for Inventory Rebalancing
The following is a sample workflow for using the inventory rebalancing analytics:

1. After running your replenishment plan, open it, and select the Replenishment and Rebalancing Plan Summary
page layout.

2. Click the Rebalancing Performance infotile.
3. Right-click a bar on the Shortages by Cluster or Excess by Cluster graph, and click Drill To > Default Group >

Cluster Analysis by Quantity or Drill To > Default Group > Cluster Analysis by Value.

The Cluster Analysis by Quantity or Cluster Analysis by Value page opens.
4. Right-click a shipping lane, and click Drill To > Manage Rebalancing Recommendations.

The Manage Rebalancing Recommendations page opens with the planned orders recommended for the source
location and destination location.

5. Review the planned orders, modify them if required, and release them.

To analyze a planned order before releasing it, do the following:

a. Select the planned order.
b. Click Drill To > Default Group > Rebalancing Analysis or Drill To > Default Group > Rebalancing

Details by Item Location.

The Rebalancing Analysis or Rebalancing Details by Item Location page opens.
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17  End Item Substitution and Supersession

Overview of End Item Substitution and Supersession  
End item substitution and supersession enable you to increase customer satisfaction while minimizing excess and
obsolete inventory.

These are brief descriptions of end item substitution and supersession and their applicability to replenishment plans:

• End item substitution substitutes one item for another item during demand fulfillment for your replenishment
plan. The substitute item's supply is used, and a replenishment order isn't created for the demanded item.

• Supersession replaces an item with a newer or more advanced version during demand fulfillment for your
replenishment plan. The supply of the supersession item is used, and a replenishment order isn’t created for
the demanded item.

In the Product Information Management work area, on the Manage Item Relationships page, you specify the
substitution or supersession relationship between the items. The type of the relationship between the items is
Substitute for a substitution relationship and Superseded for a supersession relationship. The relationships can
be unilateral or bilateral. By extending the substitution or supersession relationship between two items to other
items, you can create a substitution or supersession chain, which can be specific to an organization or all child
organizations under a master organization. The substitution or supersession chain contains all organizations to
which the source item, substitute item, and supersession item are assigned. You also can import substitution and
supersession relationships using the file-based data import (FBDI) template named Supply Chain Planning Item
Substitute (ScpItemSubstituteImportTemplate.xlsm).

By implementing end item substitution and supersession, you get these benefits:

• You can optimize inventory costs by minimizing excess and obsolete inventory.

By designing your substitution or supersession chain and assigning ranks, you can ensure that the excess of
the substitute or superseded item is used before orders are placed for the item.

If no excess is available, a replenishment order is placed for the item.

◦ If the sourcing rule for the item is Buy from, the order is placed according to your selection in the
Create Supply field and date in the Create Supply After field for the item in the Product Information
Management work area. Or, the imported values are checked for the equivalent columns in the import
template named Supply Chain Planning Items (ScpItemImportTemplate.xlsm).

◦ If the sourcing rule is Transfer from, the replenishment order is always placed.

• You can improve customer satisfaction.

For example, during a period of high demand in the retail industry, you can configure item B as a substitute for
item A. If the supply for item A on a particular day is three units, and the demand is four units, then one unit of
item B is used for fulfilling the demand for item A.

• You can configure analysis hierarchies for items with bidirectional relationships. An analysis hierarchy is a
Product dimension hierarchy that consists of a catalog, categories (primes), and associated items. You can use
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these categories in tables and graphs to view the results of replenishment planning at the aggregate (prime)
level for your substitution or supersession chains.

The analysis hierarchy feature is especially useful in the service parts industry.

Additional Things to Consider When You Implement End Item Substitution
and Supersession
When you implement end item substitution and supersession, here are some additional things to consider:

• In a replenishment plan that's enabled for incremental planning and end item substitution and supersession, if
an item with a change in net supplies and demands is a part of a substitution or supersession chain, the entire
chain is replanned.

• If you enable your replenishment plan for end item substitution and supersession and simulate a change to
the policy parameters, policy values, supplies and demands, or attributes for an item-location combination, the
entire substitution or supersession chain is replanned.

• You can use the feature for end item substitution and supersession in a plan that's enabled for multiechelon
replenishment planning.

The supply of the substitute or supersession item at a source location can be used for meeting the requirement
for the demanded item at the destination location. A planned order is created for moving the substitute or
supersession item from the source location to the destination location. At the destination location, substitute
supply is created for the demanded item, and substitute demand is created for the substitute or supersession
item.

The item relationship at the destination location is respected. If the item relationship at the destination location
isn't the same as that at the source location, then substitution or supersession isn't performed.

• These are the two order types that represent supplies and demands for end item substitution and supersession
in the Supplies and Demands table:

◦ Substitute supply

◦ Substitute demand

The Firm Date, Firm Quantity, and Firm Status columns in the table aren't editable for these order types.

• You can view information about end item substitution and supersession in these columns in the Supplies and
Demands table:

◦ Requested Item

◦ Requested Item Description

◦ Supplied Item

◦ Supplied Item Description

• For a substitution or supersession chain, Oracle Replenishment Planning builds implied relationships so
long as the relationships in the chain are only substitution relationships or only supersession relationships.
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Replenishment Planning doesn't build implied relationships for a chain that contains both substitution and
supersession relationships.

Consider a substitution chain with items A, B, and C, in which B is a substitute of A, and C is a substitute of B.
The following figure depicts this substitution chain:

For this substitution chain, Replenishment Planning builds an implied substitution relationship between C and
A.

Consider a supersession chain with items D, E, and F, in which E supersedes D, and F supersedes E. The
following figure depicts this supersession chain:

For this supersession chain, Replenishment Planning builds an implied supersession relationship between F
and D.

Consider a chain with items G, H, and I, in which H is a substitute for G, while I supersedes H. The following
figure depicts this chain:

For this chain, Replenishment Planning won't build any implied relationship between I and G. However,
Replenishment Planning builds the substitution relationship between H and G and supersession relationship
between I and H.

• The items belonging to the substitution or supersession chain can belong to different segments of the segment
group for your replenishment plan.

• If the end date for an item revision is before the plan start date, then the item revision is ignored by the
replenishment plan. The affected substitution or supersession chain isn't considered by the replenishment plan,
and the items are individually planned.

Related Topics
• Overview of Multiechelon Replenishment Planning

• How You Use the End Item Substitution and Supersession Feature

• How End Item Substitution and Supersession Are Performed

• How You Create and Use Analytics for Analysis Hierarchies
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How You Use the End Item Substitution and
Supersession Feature  
This topic provides the high-level process that you must follow to use the end item substitution and supersession
feature.

1. Set up your item relationships and substitution and supersession chains in Oracle Fusion Cloud Product Lifecycle
Management.
Or, import your item relationships using the file-based data import (FBDI) template named Supply Chain Planning
Item Substitute.

2. Collect the information for your item-location combinations using the collections functionality or import template
named Supply Chain Planning Items.

3. Set up your replenishment plan.
On the General subtab on the Supply tab on the Plan Options page, under Item Relationships, select an option in the
Use of Related Items Supplies field. Then, enter a value in the Lead Time Multiplier for Excess Window field.
If your plan isn't using the Default Replenishment Planning Catalog or Incremental Replenishment Planning Default
Catalog, add the measures for end item substitution and supersession to your measure catalog.

4. Optionally, on the Manage Analysis Hierarchies for Related Items page, set up your analysis hierarchies for items with
bidirectional relationships. Then, submit the Create Analysis Hierarchies for Related Items scheduled process.
Include the newly created Product hierarchies in the dimension catalog for your replenishment plan.

5. Run your replenishment plan.
End item substitution and supersession are performed for your replenishment plan. The substitution and
supersession chains are constructed, excess and shortage are calculated for each item in your substitution and
supersession chains, and substitute supplies, substitute demands, and planned orders are created.

6. Manually release your planned orders on the Supplies and Demands page if you haven't enabled your replenishment
plan for automatic release of planned orders.

7. If you've generated analysis hierarchies, create user-defined tables, and set up the analytics for your analysis
hierarchies so that you can review the data.

Related Topics
• Overview of End Item Substitution and Supersession

• Item Relationship Options for Replenishment Plans

• Create Analysis Hierarchies for Related Items

• How You Create and Use Analytics for Analysis Hierarchies

• Measures for End Item Substitution and Supersession
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How End Item Substitution and Supersession Are
Performed  
End item substitution and supersession use the same process that's described in this topic.

1. The substitution or supersession chain is constructed for each item-location combination for which replenishment
planning is to be done.
The substitution or supersession chain is processed in sequence from the left (earliest revision) to the right (latest
revision). Thus, new orders are avoided for the early revisions, and their excess quantities are used.

2. On Day 1 of the planning horizon, the excess and shortage are computed for each item in the substitution or
supersession chain.
The excess and shortage are calculated according to the values in the Item Relationships section on the General
subtab on the Supply tab on the Plan Options page for the replenishment plan.

3. If the item has a shortage, then the substitute items or supersession items in the substitution or supersession chain
are considered according to the ranks of the item relationships.

4. If no substitute item or supersession item has an excess in the excess window, then the Create Supply and Create
Supply After attributes are checked for the item.
If supply can't be created for the item, then the same checks are performed for the substitute items or supersession
items according to the ranks of the item relationships.

5. A planned order is created according to the applicable policy.
6. The Substitute Demand and Substitute Supply measures are updated so that the substitution or supersession is

reflected.
7. Steps 2 through 6 are repeated for the item-location combination for the remaining days of the planning horizon.

Example for Process of End Item Substitution

Consider a substitution chain in which we have items A, A1, A2, A3, B, and C.

Item A can be substituted by items A1, A2, A3, B, and C, and the ranks of the item relationships are 1, 2, 3, 4, and 5.
Moreover, items B and C have a bidirectional relationship.

This figure depicts the substitution chain:
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End item substitution is performed for this substitution chain as follows:

1. The substitution chain is constructed for item A.
2. On Day 1 of the planning horizon, the excess and shortage for items A, A1, A2, A3, B, and C are calculated.

a. If item A has a shortage, then the substitute items are considered according to the ranks of the item
relationships.

Item A1 is checked to see if it has an excess in the excess window. If item A1 doesn't have an excess, then
item A2 is considered and so on.

3. If no item has an excess, then item A is checked for the Create Supply attribute.

If the value is Yes, then supply is created for item A. The Create Supply After attribute is considered.

If the value is No, then the substitute items are considered according to the ranks of the item relationships. The
same checks are done for item A1 and so on.

4. A planned order is created according to the applicable policy.
5. The Substitute Demand and Substitute Supply measures are updated so that the substitution is reflected.
6. On each remaining day of the planning horizon, Steps 2 through 5 are repeated.

Example for Process of Supersession

Consider a supersession chain in which we have items A, B, and C.

Item A is superseded by item B, item B is superseded by item C, and the ranks of the item relationships are 1 and 2. The
relationships among the items are unidirectional.

This figure depicts the supersession chain:

Supersession is performed for this supersession chain as follows:

1. The supersession chain is constructed for item A.
2. On Day 1 of the planning horizon, the excess and shortage for items A, B, and C are calculated.

a. If item A has a shortage, then the supersession items are considered according to the ranks of the item
relationships.

Item B is checked to see if it has an excess in the excess window. If item B doesn't have an excess, then
item C is considered.

3. If no item has an excess, then item A is checked for the Create Supply attribute.

If the value is Yes, then supply is created for item A. The Create Supply After attribute is considered.

If the value is No, then the supersession items are considered according to the ranks of the item relationships.
The same checks are done for item B and so on.

4. A planned order is created according to the applicable policy.
5. The Substitute Demand and Substitute Supply measures are updated so that the supersession is reflected.
6. On each remaining day of the planning horizon, Steps 2 through 5 are repeated.
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Related Topics
• Overview of End Item Substitution and Supersession

• Item Relationship Options for Replenishment Plans

• Examples of End Item Substitution and Supersession

Create Analysis Hierarchies for Related Items  
Use the Manage Analysis Hierarchies for Related Items page to create analysis hierarchies for analyzing the results of
end item substitution and supersession in your replenishment plan.

You can configure analysis hierarchies for items with bidirectional relationships. An analysis hierarchy is a Product
dimension hierarchy that consists of a catalog, categories (primes), and associated items. You can use these categories
in tables and graphs to view the results of replenishment planning at the aggregate (prime) level for your substitution
and supersession chains.
Note these points while creating analysis hierarchies:

• You can create multiple catalogs for your replenishment plan. You can then configure your tables and graphs
for display of one of the catalogs.

• For your analysis, you'll need to create copies of the Replenishment Workbench table for every catalog that you
create.

Therefore, use your judgment while creating catalogs.

• Different organizations can have different substitution and supersession chains. Even if two organizations share
the same chain, they might have different subsets of the items in the chain, and the item sequence can be
different.

Therefore, while selecting locations, ensure that the resulting analysis hierarchies cover the maximum number
of organizations in your catalog.

• Only those item relationships that are effective on the date the analysis hierarchy is created are considered.

1. On the Tasks panel tab, under Plan Inputs, click Manage Analysis Hierarchies for Related Items.
The Manage Analysis Hierarchies for Related Items page opens.

2. Click the Add Row icon.
An empty row appears in the table on the page.

3. Under Product Hierarchy, enter the name of the Product dimension catalog that you want to create and under
which categories must be created for your bidirectional substitution and supersession chains.

Note:  You can't use an existing catalog for creating the categories.

4. In Description, enter a description for the analysis hierarchy (catalog).
5. In Source System, select the source system that contains the items for your replenishment plan.
6. Under Locations, click the Locations icon.

The Analysis Hierarchy Locations dialog box opens and displays the available locations for the source system.

Note:  Subinventories aren't available for selection in the dialog box.
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7. Move the required locations from the Available pane to the Selected pane, and click OK.
8. Click Save.
9. With the new row selected, click the Create Analysis Hierarchies button to submit the Create Analysis Hierarchies

for Related Items scheduled process.
A warning message is displayed.

Note:  You can also go to the Scheduled Processes work area, search for the Create Analysis Hierarchies for Related
Items scheduled process, and submit it for the created analysis hierarchy.

10.Click Yes.
A dialog box is displayed with the request number of the Create Analysis Hierarchies for Related Items scheduled
process that was submitted. You can use this request number to search for the result of the scheduled process in the
Scheduled Processes work area.
The table row displays information about the status of the submitted request.

11. Click OK.
Click View > Refresh to update the displayed information for the newly created analysis hierarchy.

Related Topics
• Overview of End Item Substitution and Supersession

• Examples of Analysis Hierarchies

• Edit an Analysis Hierarchy

Edit an Analysis Hierarchy  
You can delete an analysis hierarchy or edit its description.

You can delete the analysis hierarchy only if it's not a part of any dimension catalog. Otherwise, you first have to remove
the analysis hierarchy from the dimension catalog and then delete the analysis hierarchy.

To delete the analysis hierarchy, on the Manage Analysis Hierarchies for Related Items page, select the analysis
hierarchy, and click the Delete icon. The Delete Analysis Hierarchy for Related Items scheduled process is initiated. Note
down the request number so that you can track the status of the scheduled process in the Scheduled Processes work
area.

You can also directly submit the Delete Analysis Hierarchy for Related Items scheduled process in the Scheduled
Processes work area.

To edit the description of the analysis hierarchy, on the Manage Analysis Hierarchies for Related Items page, select the
analysis hierarchy, and edit the text under Description.

Related Topics
• Overview of End Item Substitution and Supersession

• Examples of Analysis Hierarchies

• Create Analysis Hierarchies for Related Items
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Examples of Analysis Hierarchies  
This topic explains how analysis hierarchies for end item substitution or supersession are created.

In the rest of this topic, one simple example and four detailed examples of analysis hierarchies are provided.

Simple Example of Analysis Hierarchy
Consider an organization that contains these substitution or supersession chains:

Note:  When the left-angle bracket (<) and right-angle bracket (>) are used together, a bidirectional relationship is
indicated. When the right-angle bracket is used by itself, a unidirectional relationship is indicated.

• A < > B < > C < > D

• X < > Y < > Z < > Z1

• F1 < > F2 > F3 < > F4

For these substitution or supersession chains, you can create a Product dimension hierarchy for a catalog called North
America that contains these categories (primes):

• Category D that contains A, B, C, D.

• Category Z1 that contains X, Y, Z, and Z1

• Category F2 that contains F1 and F2

• Category F4 that contains F3 and F4

Note that a category is created for F1 and F2 and another for F3 and F4 because F2 and F3 don't have a bidirectional
relationship.

Also, note that each category takes its name from the right-most item in the substitution or supersession chain.

This figure depicts the North America catalog:
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Detailed Example 1 of Analysis Hierarchy
In this detailed example, we have two regions. The locations in the regions mostly contain the same items. Therefore,
we can create an analysis hierarchy for each region.
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These are the locations and items with bidirectional relationships:

• M1 (for North America)

◦ A < > B < > C

◦ X < > Y < > Z

◦ F1 < > F2 < > F3 < > H4

• M2 (for North America)

◦ A < > B < > C < > D

◦ X < > Y < > Z < > Z1

◦ F1 < > F2 < > F3 < > H4

• M3 (for North America)

This location is selected for the analysis hierarchy.

◦ A < > B < > C < > D < > E

◦ X < > Y < > Z < > Z1 < > Z2

◦ F1 < > F2 < > F3 < > H4

• M4 (for North America)

◦ A < > B < > C < > D < > E

◦ X < > Y < > Z < > Z1 < > Z2

◦ F1 < > F2 < > F3 < > F4

• M5 (for North America)

◦ A < > B < > C < > D < > E

◦ X < > Y < > Z < > Z1 < > Z2

◦ F1 < > F2 < > F3 < > F4

• S1 (for the Europe, Middle East, and Africa (EMEA) region)

◦ A < > B < > C

◦ X < > Y < > Z

◦ F1 < > F2 < > F3 < > H5

• S2 (for the EMEA region)

◦ A < > B < > C < > D1

◦ X < > Y < > Z < > Z3

◦ F1< > F2 < > F3 < > H5

• S3 (for the EMEA region)

◦ A < > B < > C < > D1 < > E1

◦ X < > Y < > Z < > Z3 < > Z4

◦ F1< > F2 < > F3 < > H5

• S4 (for the EMEA region)

This location is selected for the analysis hierarchy.
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◦ A < > B < > C < > D1 < > E1

◦ X < > Y < > Z < > Z3 < > Z4

◦ F1< > F2 < > F3 < > F5

• S5 (for the EMEA region)

◦ A < > B < > C < > D1 < > E1

◦ X < > Y < > Z < > Z3 < > Z4

◦ F1< > F2 < > F3 < > F5

This figure depicts the item relationships for this example:

On the Manage Analysis Hierarchies for Related Items page, the created hierarchies (catalogs) and selected locations are
as follows:

• North America, for location M3

• EMEA, for location S4

This figure depicts the created hierarchies and selected locations:
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For these bidirectional item relationships and selections, these analysis hierarchies are created:

• North America (catalog), with categories E (for items A, B, C, D, and E), Z2 (for items X, Y, Z, Z1, and Z2), and H4
(for items F1, F2, F3, and H4)

• EMEA (catalog), with categories E1 (for items A, B, C, D1, and E1), Z4 (for items X, Y, Z, Z3, and Z4), and F5 (for
items F1, F2, F3, and F5)

This figure depicts the analysis hierarchies for the example:

Note these points about the example:

• The organizations in North America and EMEA have different sets of items and therefore require separate
analysis hierarchies. For example, M3 has items A, B, C, D, and E, while S3 has items A, B, C, D1, and E1.

• The E and Z2 categories are comprehensive enough for analysis of the substitution or supersession chains in
M1, M2, M3, M4, and M5. However, the H4 category can cover analysis of only the substitution or supersession
chains for M1, M2, and M3.

• The E1 and Z4 categories are comprehensive enough for analysis of the substitution or supersession chains
in S1, S2, S3, S4, and S5. However, the F5 category can cover analysis of only the substitution or supersession
chains for S4 and S5.

• For simplicity, the items have been listed in a sequence. However, the sequence isn't important in a substitution
or supersession chain. For example, M1 could have had a substitution chain with items A, C, and E, and the
substitution chain would still have been covered by the E category.
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Detailed Example 2 of Analysis Hierarchy
In this detailed example, we have two regions. The locations in the regions contain multiple substitution or supersession
chains, and selecting one location in each region with a representative analysis hierarchy is difficult. Therefore, we can
create two analysis hierarchies for each region to cater to all the available substitution or supersession chains.

These are the locations and items with bidirectional relationships:

• M1 (for North America)

◦ A < > B < > C

◦ X < > Y < > Z

◦ F1 < > F2 < > F3 < > H4

• M2 (for North America)

◦ A < > B < > C < > D

◦ X < > Y < > Z < > Z1

◦ F1 < > F2 < > F3 < > H4

• M3 (for North America)

This location is selected for the analysis hierarchy.

◦ A < > B < > C < > D < > E

◦ X < > Y < > Z < > Z1 < > Z2

◦ F1 < > F2 < > F3 < > H4

• M4 (for North America)

This location is selected for the analysis hierarchy.

◦ A < > B < > C < > D < > E

◦ X < > Y < > Z < > Z1 < > Z3

◦ F1 < > F2 < > F3 < > F4

• M5 (for North America)

◦ A < > B < > C < > D < > E

◦ X < > Y < > Z < > Z1 < > Z3

◦ F1 < > F2 < > F3 < > F4

• S1 (for the EMEA region)

◦ A < > B < > C

◦ X < > Y < > Z

◦ F1 < > F2 < > F3 < > H5

• S2 (for the EMEA region)

◦ A < > B < > C < > D1

◦ X < > Y < > Z < > Z3

◦ F1< > F2 < > F3 < > H5
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• S3 (for the EMEA region)

This location is selected for the analysis hierarchy.

◦ A < > B < > C < > D1 < > E1

◦ X < > Y < > Z < > Z3 < > Z4

◦ F1< > F2 < > F3 < > H5

• S4 (for the EMEA region)

This location is selected for the analysis hierarchy.

◦ A < > B < > C < > D1 < > E1

◦ X < > Y < > Z < > Z3 < > Z5

◦ F1< > F2 < > F3 < > F5

• S5 (for the EMEA region)

◦ A < > B < > C < > D1 < > E1

◦ X < > Y < > Z < > Z3 < > Z5

◦ F1< > F2 < > F3 < > F5

This figure depicts the item relationships for this example:
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On the Manage Analysis Hierarchies for Related Items page, the created hierarchies (catalogs) and selected locations are
as follows:

• North America - M3, for location M3

• North America - M4, for location M4

• EMEA - S3, for location S3

• EMEA - S4, for location S4

This figure depicts the created hierarchies and selected locations:

For these bidirectional item relationships and selections, these analysis hierarchies are created:

• North America - M3 (catalog), with categories E (for items A, B, C, D, and E), Z2 (for items X, Y, Z, Z1, and Z2),
and H4 (for items F1, F2, F3, and H4)

• North America - M4 (catalog), with categories E (for items A, B, C, D, and E), Z3 (for items X, Y, Z, Z1, and Z3),
and F4 (for items F1, F2, F3, and F4)

• EMEA - S3 (catalog), with categories E1 (for items A, B, C, D1, and E1), Z4 (for items X, Y, Z, Z3, and Z4), and H5
(for items F1, F2, F3, and H5)

• EMEA - S4 (catalog), with categories E1 (for items A, B, C, D1, and E1), Z5 (for items X, Y, Z, Z3, and Z5), and F5
(for items F1, F2, F3, and F5)

This figure depicts the analysis hierarchies for the example:
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Note these points about the example:

• The organizations in North America and EMEA have different sets of items and therefore require separate
analysis hierarchies. For example, M3 has items A, B, C, D, and E, while S3 has items A, B, C, D1, and E1.

• Within each region, there are subtle changes in the substitution or supersession chains. For example, M3 has
items X, Y, Z, Z1, and Z2, while M4 has items X, Y, Z, Z1, and Z3.

• The E category is comprehensive enough for analysis of the substitution or supersession chains in M1, M2, M3,
M4, and M5. However, the Z2 category can cover analysis of only the substitution or supersession chains for
M1, M2, and M3, and the Z3 category can cover analysis of only the substitution or supersession chains for M1,
M2, M4, and M5. Similarly, the H4 category can cover analysis of only the substitution or supersession chains
for M1, M2, and M3, and the F4 category can cover analysis of only the substitution or supersession chains for
M4 and M5.

• The E1 category is comprehensive enough for analysis of the substitution or supersession chains in S1, S2, S3,
S4, and S5. However, the Z4 category can cover analysis of only the substitution or supersession chains for S1,
S2, and S3, and the Z5 category can cover analysis of only the substitution or supersession chains for S1, S2, S4,
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and S5. Similarly, the H5 category can cover analysis of only the substitution or supersession chains in S1, S2,
and S3, and the F5 category can cover analysis of only the substitution or supersession chains for S4 and S5.

• For simplicity, the items have been listed in a sequence. However, the sequence isn't important in a substitution
or supersession chain. For example, M1 could have had a substitution chain with items A, C, and E, and the
substitution chain would still have been covered by the E category.

Detailed Example 3 of Analysis Hierarchy
In this detailed example, we have two regions. The locations in the regions mostly contain the same items. Therefore,
we can create an analysis hierarchy for both the regions. However, one substitution or supersession chain won't be
covered by any analysis hierarchy, and duplicate categories won't be created.

These are the locations and items with bidirectional relationships:

• M1 (for North America)
◦ A < > B < > C

◦ X < > Y < > Z

◦ F1 < > F2 < > F3 < > H4

• M2 (for North America)
◦ A < > B < > C < > D

◦ X < > Y < > Z < > Z1

◦ F1 < > F2 < > F3 < > H4

• M3 (for North America)
This location is selected for the analysis hierarchy.

◦ A < > B < > C < > D < > E

◦ X < > Y < > Z < > Z1 < > Z2

◦ F1 < > F2 < > F3 < > H4

• M4 (for North America)
◦ A < > B < > C < > D < > E

◦ X < > Y < > Z < > Z1 < > Z2

◦ F1 < > F2 < > F3 < > F4

• M5 (for North America)
◦ A < > B < > C < > D < > E

◦ X < > Y < > Z < > Z1 < > Z2

◦ F1 < > F2 < > F3 < > H4

• S1 (for the EMEA region)
◦ A < > B < > C

◦ X < > Y < > Z

◦ P1 < > P2 < > P3 < > P4

• S2 (for the EMEA region)
◦ A < > B < > C < > D
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◦ X < > Y < > Z < > Z1

◦ P1 < > P2 < > P3 < > P4

• S3 (for the EMEA region)

◦ A < > B < > C < > D < > E

◦ X < > Y < > Z < > Z1 < > Z2

◦ P1 < > P2 < > P3 < > P4

• S4 (for the EMEA region)

This location is selected for the analysis hierarchy.

◦ A < > B < > C < > D < > E

◦ X < > Y < > Z < > Z1 < > Z2

◦ P1 < > P2 < > P3 < > P4

• S5 (for the EMEA region)

◦ A < > B < > C < > D < > E

◦ X < > Y < > Z < > Z1 < > Z2

◦ P1 < > P2 < > P3 < > P4

This figure depicts the item relationships for this example:
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On the Manage Analysis Hierarchies for Related Items page, the created hierarchy (catalog) is North America and EMEA
for the M3 and S4 locations.

This figure depicts the created hierarchy and selected locations:

For these bidirectional item relationships and selections, the North America and EMEA analysis hierarchy (catalog) is
created, with categories E (for items A, B, C, D, and E), Z2 (for items X, Y, Z, Z1, and Z2), H4 (for items F1, F2, F3, and H4),
and P4 (for items P1, P2, P3, and P4).

This figure depicts the analysis hierarchies for the example:

Note these points about the example:

• The organizations in North America and EMEA have the same substitution or supersession chains and also
different substitution or supersession chains. For example, M1, M2, M3, and M5 have items F1, F2, F3, and H4,
while M4 has items F1, F2, F3, and F4. S1, S2, S3, S4, and S5 have items P1, P2, P3, and P4.

• The E, Z2, and P4 categories are comprehensive enough for analysis of the substitution or supersession chains
in M1, M2, M3, M4, and M5, and S1, S2, S3, S4, and S5.

• The H4 category is comprehensive enough for analysis of the substitution or supersession chains in M1, M2,
M3, and M5. However, the category can't cover analysis of the substitution or supersession chain for M4.

• Only one instance of the E category is created for organization M3. A duplicate of the category isn't created for
organization S4.

• Only one instance of the Z2 category is created for organization M3. A duplicate of the category isn't created for
organization S4.

• For simplicity, the items have been listed in a sequence. However, the sequence isn't important in a substitution
or supersession chain. For example, M1 could have had a substitution chain with items A, C, and E, and the
substitution chain would still have been covered by the E category.
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Detailed Example 4 of Analysis Hierarchy
In this detailed example, we have two regions. The locations in the regions contain similar and different items.
Therefore, we can create two analysis hierarchies for each region. However, one substitution or supersession chain in
each region won't be covered by an analysis hierarchy, and duplicate categories won't be created.

These are the locations and items with bidirectional relationships:

• M1 (for North America)

◦ A < > B < > C

◦ X < > Y < > Z

◦ F1 < > F2 < > F3 < > H4

• M2 (for North America)

◦ A < > B < > C < > D

◦ X < > Y < > Z < > Z1

◦ F1 < > F2 < > F3 < > H4

• M3 (for North America)

This location is selected for the analysis hierarchy.

◦ A < > B < > C < > D < > E

◦ X < > Y < > Z < > Z1 < > Z2

◦ F1 < > F2 < > F3 < > H4

• M4 (for North America)

This location is selected for the analysis hierarchy.

◦ A < > B < > C < > D < > E

◦ X < > Y < > Z < > Z1 < > Z2

◦ F1 < > F2 < > F3 < > F4

◦ Q1 < > Q2 < > Q3 < > Q4

• M5 (for North America)

◦ A < > B < > C < > D < > E

◦ X < > Y < > Z < > Z1 < > Z2

◦ F1 < > F2 < > F3 < > F4

• S1 (for the EMEA region)

◦ A < > B < > C

◦ X < > Y < > Z

◦ F1 < > F2 < > F3 < > H5
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• S2 (for the EMEA region)

◦ A < > B < > C < > D1

◦ X < > Y < > Z < > Z3

◦ F1< > F2 < > F3 < > H5

• S3 (for the EMEA region)

This location is selected for the analysis hierarchy.

◦ A < > B < > C < > D1 < > E1

◦ X < > Y < > Z < > Z3 < > Z4

◦ F1< > F2 < > F3 < > H5

• S4 (for the EMEA region)

This location is selected for the analysis hierarchy.

◦ A < > B < > C < > D1 < > E1

◦ X < > Y < > Z < > Z3 < > Z4

◦ F1< > F2 < > F3 < > F5

◦ J1 < > J2 < > J3 < > J4

• S5 (for the EMEA region)

◦ A < > B < > C < > D1 < > E1

◦ X < > Y < > Z < > Z3 < > Z4

◦ F1< > F2 < > F3 < > F5

This figure depicts the item relationships for this example:
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On the Manage Analysis Hierarchies for Related Items page, the created hierarchies (catalogs) and selected locations are
as follows:

• North America - M3 and M4, for locations M3 and M4

• EMEA - S3 and S4, for locations S3 and S4

This figure depicts the created hierarchies and selected locations:

For these bidirectional item relationships and selections, these analysis hierarchies are created:

• North America - M3 and M4 (catalog), with categories E (for items A, B, C, D, and E), Z2 (for items X, Y, Z, Z1, and
Z2), H4 (for items F1, F2, F3, and H4), and Q4 (for items Q1, Q2, Q3, and Q4)

• EMEA - S3 and S4 (catalog), with categories E1 (for items A, B, C, D1, and E1), Z4 (for items X, Y, Z, Z3, and Z4),
H5 (for items F1, F2, F3, and H5), and J4 (for items J1, J2, J3, and J4)

This figure depicts the analysis hierarchies for the example:
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Note these points about the example:

• The organizations in North America and EMEA have different sets of items and therefore require separate
analysis hierarchies. For example, M4 has items Q1, Q2, Q3, and Q4, while S4 has items J1, J2, J3, and J4.

• The E and Z2 categories are comprehensive enough for analysis of the substitution or supersession chains in
M1, M2, M3, M4, and M5. However, the H4 category can cover analysis of only the substitution or supersession
chains for M1, M2, and M3, while the Q4 category can cover analysis of only the substitution or supersession
chain for M4.

• The E1 and Z4 categories are comprehensive enough for analysis of the substitution or supersession chains
in S1, S2, S3, S4, and S5. However, the H5 category can cover analysis of only the substitution or supersession
chains for S1, S2, and S3, while the J4 category can cover analysis of only the substitution or supersession chain
for S4.

• For every organization, categories are created for only unique substitution or supersession chains. A category
named F4 isn't created for organization M4 because the category would be similar to the H4 category for
organization M3. Similarly, a category named F5 isn't created for organization S4 because the category would
be similar to the H5 category for organization S3.

If categories are required for all variants of substitution or supersession chains, then separate catalogs should
be created for organizations M3, M4, S3, and S4, as in the second detailed example.

• For simplicity, the items have been listed in a sequence. However, the sequence isn't important in a substitution
or supersession chain. For example, M1 could have had a substitution chain with items A, C, and E, and the
substitution chain would still have been covered by the E category.

Related Topics
• Overview of End Item Substitution and Supersession

• Create Analysis Hierarchies for Related Items

• Edit an Analysis Hierarchy
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Measures for End Item Substitution and Supersession  
This topic lists the measures that store data for end item substitution and supersession in replenishment plans.

All measures support the Organization, Product, and Time dimensions.

The measures are a part of the Default Replenishment Planning Catalog and Incremental Replenishment Planning
Default Catalog. If your replenishment plan is using other measure catalogs, ensure that you add these measures to the
measure catalogs. Also, add these measures to your tables and graphs.

In a replenishment plan that's enabled for incremental planning, when a day is added to the planning horizon, these
measures are populated with the null value for an item-location combination that doesn't have a change in net demand
or supply.

This table lists the measures for end item substitution and supersession:

Measure Description

Initial Excess for Substitution Excess quantity of the substitute item or supersession item that's initially available for substitution or
supersession.

Initial Shortage for Substitution Shortage quantity of the demanded item that can be initially met by the supply of the substitute item
or by the supply of the supersession item.

Substitute Demand Total quantity of the demanded item that's substituted by the supply of the substitute item or
superseded by the supply of the supersession item.

Substitute Supply Total supply of the substitute item or supersession item that meets the demand for the demanded
item.

Related Topics
• Overview of End Item Substitution and Supersession

• How You Use the End Item Substitution and Supersession Feature

How You Create and Use Analytics for Analysis
Hierarchies  
You can use predefined and user-defined tables to view the data at the Item or category (prime) level for your analysis
hierarchies. Thereby, you can resolve problems and improve the results of your replenishment plan.
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Tables for Analysis Hierarchies
You can view the data for your analysis hierarchies using these tables:

• Replenishment Workbench by Item and Prime: This user-defined table is a copy of the Replenishment
Workbench table. However, on the Hierarchies tab of the Selector Tool, the category level is also included for the
Product dimension. Also, on the Layout tab, the category level is selected as a filter.

• Replenishment Workbench by Prime: This user-defined table is a copy of the Replenishment Workbench table.
However, on the Hierarchies tab of the Selector Tool, the Item level isn't included, while the category level is
included. Also, on the Layout tab, the category level is selected as a filter.

• Supplies and Demands: You can use this predefined table to view data for the items that make up a category
(prime).

• Item Relationships: You can use this predefined table to view the item relationships that you have set up in
Oracle Fusion Cloud Product Lifecycle Management for your substitution and supersession chains.

• Items: You can use this predefined table to view the items for your substitution and supersession chains.

• Shortages by Item Location: You can use this predefined table to view shortages for item-location combinations
in your substitution and supersession chains.

• Replenishment Workbench: You can use this predefined table to view various measures for items in your
substitution and supersession chains.

Note:  You can name the user-defined tables according to your preference. Also, you must create these tables only if
you want to analyze your data by categories (primes).

Set Up the Analytics for Analysis Hierarchies
You can set up the analytics for analysis hierarchies as follows:

1. Create a copy of the Replenishment Workbench table, and name the copy as the Replenishment Workbench by
Item and Prime table.

On the Hierarchies tab of the Selector Tool, include the category level. Also, on the Layout tab, include the
category level as a filter.

2. Create a copy of the Replenishment Workbench table, and name the copy as the Replenishment Workbench by
Prime table.

On the Hierarchies tab of the Selector tool, include the category level, and exclude the Item level. On the Layout
tab, include the category level as a filter.

3. Link the Replenishment Workbench by Item and Prime table to the Replenishment Workbench by Prime table.

In the Manage Links dialog box for the Replenishment Workbench by Item and Prime table, on the To Table,
Graph, or Page Layout tab, configure the link to pass the highlighted selections at the category level to the
Replenishment Workbench by Prime table.

4. Link the Replenishment Workbench by Prime table to the Supplies and Demands table.

In the Manage Links dialog box for the Replenishment Workbench by Prime table, on the To Table, Graph, or
Page Layout tab, configure the link to pass the highlighted selections and selected members to the Supplies
and Demands table.

5. Link the Supplies and Demands, Replenishment Workbench, Shortages by Item Location, Items, and Item
Relationships tables to the Replenishment Workbench by Item and Prime table.
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For the Replenishment Workbench and Shortages by Item Location tables, in the Manage Links dialog box,
on the To Table, Graph, or Page Layout tab, configure the link to pass the highlighted selections and selected
members to the Replenishment Workbench by Item and Prime table.

The following figure depicts how you link tables to view data for analysis hierarchies:

Use the Analytics for Analysis Hierarchies
After you have set up your table links and run your replenishment plan, you can drill to the Replenishment Workbench
by Item and Prime table from the Supplies and Demands, Replenishment Workbench, Shortages by Item Location,
Items, or Items Relationships table. By doing so, you can view information for an item and the other items in its category
(prime).

Note:  Ensure that you select the corresponding items for the selected category while viewing data.

From the Replenishment Workbench by Item and Prime table, you can drill to the Replenishment Workbench by Prime
table. By doing so, you can view the aggregated information for the category (prime).

From the Replenishment Workbench by Prime table, you can drill to the Supplies and Demands table to view
information about the following for the category (prime):

• The total quantity of the demanded item that's substituted by the supply of the substitute item or superseded
by the supply of the supersession item (Substitute Demand measure)
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• The total supply of the substitute item or supersession item that meets the demand for the demanded item
(Substitute Supply measure)

In the Supplies and Demands table, these columns are available for viewing information pertaining to end item
substitution and supersession:

• ◦ Requested Item

◦ Requested Item Description

◦ Supplied Item

◦ Supplied Item Description

Related Topics
• Overview of End Item Substitution and Supersession

Examples of End Item Substitution and Supersession  
How end item substitution and supersession are performed depends on your selection in the Use of Related Items
Supplies field on the General subtab on the Supply tab on the Plan Options page for your replenishment plan.

The sections in this topic provide examples for end item substitution or supersession when you select Maximize use of
related items to minimize new replenishments or Use related items only when necessary to avoid stockouts in the
Use of Related Items Supplies field.

Example for Maximizing Use of Related Items to Minimize New
Replenishments
When you select Maximize use of related items to minimize new replenishments in the Use of Related Items
Supplies field, the shortage of an item is calculated as follows:

• If the Beginning Inventory Position is less than or equal to the Minimum Quantity or ROP Quantity, the
shortage is calculated as Beginning Inventory Position - Minimum Quantity - 1 or Beginning Inventory Position
- ROP Quantity - 1.

• If the value of the Minimum Quantity or ROP Quantity is null, when the Beginning Inventory Position is less
than zero, the shortage is equal to the Beginning Inventory Position.

The excess is calculated as the least positive value for Projected Available Balance - Minimum Quantity - 1 or Projected
Available Balance - ROP Quantity - 1 for a day in the excess window.

In this example, we have two items, A and B, at organization WH1. Item B is a substitute for item A or the item that
supersedes item A. The excess window is 1 day. The policy type is min-max planning.

On Day 1, the data for item A is as depicted in this table:

Measures for Item A Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 15 5 10 10 10
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Measures for Item A Day 1 Day 2 Day 3 Day 4 Day 5

Total Supply 40 0 0 0 0

Projected Available
Balance

25 20 10 0 -10

Beginning Inventory
Position

25 20 10 0 -10

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

0 0 0 0 0

Initial Shortage for
Substitution

16 0 0 0 0

Substitute Supply 0 0 0 0 0

Substitute Demand 0 0 0 0 0

Planned
Replenishments by
Order Date

0 0 0 0 0

On Day 1, the data for item B is as depicted in this table:

Measures for Item B Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 15 5 23 8 10

Total Supply 105 0 0 0 0

Projected Available
Balance

90 85 62 54 44

Beginning Inventory
Position

90 85 62 54 44

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

49 0 0 0 0

Initial Shortage for
Substitution

0 0 0 0 0

Substitute Supply 0 0 0 0 0

Substitute Demand 0 0 0 0 0

Planned
Replenishments by
Order Date

0 0 0 0 0
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For item A, the Initial Shortage for Substitution measure is -16 (25 - 40 - 1).

For item B, the Initial Excess for Substitution measure is 49 (90 - 40 - 1).

On Day 1, the data after end item substitution or supersession for item A is as depicted in this table:

Measures for Item A Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 15 5 10 10 10

Total Supply 56 0 0 0 0

Projected Available
Balance

41 36 26 16 6

Beginning Inventory
Position

41 36 26 16 6

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

0 0 0 0 0

Initial Shortage for
Substitution

16 0 0 0 0

Substitute Supply 16 0 0 0 0

Substitute Demand 0 0 0 0 0

Planned
Replenishments by
Order Date

0 0 0 0 0

On Day 1, the data after end item substitution or supersession for item B is as depicted in this table:

Measures for Item B Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 31 5 23 8 10

Total Supply 105 0 0 0 0

Projected Available
Balance

74 69 46 38 28

Beginning Inventory
Position

74 69 46 38 28

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

49 0 0 0 0

Initial Shortage for
Substitution

0 0 0 0 0
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Measures for Item B Day 1 Day 2 Day 3 Day 4 Day 5

Substitute Supply 0 0 0 0 0

Substitute Demand 16 0 0 0 0

Planned
Replenishments by
Order Date

0 0 0 0 0

For item A, the Substitute Supply measure is 16.

For item B, the Substitute Demand measure is 16.

On Day 2, the data for item A is as depicted in this table:

Measures for Item A Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 15 5 10 10 10

Total Supply 56 0 0 0 0

Projected Available
Balance

41 36 26 16 6

Beginning Inventory
Position

41 36 26 16 6

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

0 0 0 0 0

Initial Shortage for
Substitution

16 5 0 0 0

Substitute Supply 16 0 0 0 0

Substitute Demand 0 0 0 0 0

Planned
Replenishments by
Order Date

0 0 0 0 0

On Day 2, the data for item B is as depicted in this table:

Measures for Item B Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 31 5 23 8 10

Total Supply 105 0 0 0 0

Projected Available
Balance

74 69 46 38 28
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Measures for Item B Day 1 Day 2 Day 3 Day 4 Day 5

Beginning Inventory
Position

74 69 46 38 28

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

49 28 0 0 0

Initial Shortage for
Substitution

0 0 0 0 0

Substitute Supply 0 0 0 0 0

Substitute Demand 16 0 0 0 0

Planned
Replenishments by
Order Date

0 0 0 0 0

For item A, the Initial Shortage for Substitution measure is -5 (36 - 40 - 1).

For item B, the Initial Excess for Substitution measure is 28 (69 - 40 - 1).

On Day 2, the data after end item substitution or supersession for item A is as depicted in this table:

Measures for Item A Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 15 5 10 10 10

Total Supply 56 5 0 0 0

Projected Available
Balance

41 41 31 21 11

Beginning Inventory
Position

41 41 31 21 11

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

0 0 0 0 0

Initial Shortage for
Substitution

16 5 0 0 0

Substitute Supply 16 5 0 0 0

Substitute Demand 0 0 0 0 0

Planned
Replenishments by
Order Date

0 0 0 0 0

On Day 2, the data after end item substitution or supersession for item B is as depicted in this table:
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Measures for Item B Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 31 10 23 8 10

Total Supply 105 0 0 0 0

Projected Available
Balance

74 64 41 33 23

Beginning Inventory
Position

74 64 41 33 23

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

49 28 0 0 0

Initial Shortage for
Substitution

0 0 0 0 0

Substitute Supply 0 0 0 0 0

Substitute Demand 16 5 0 0 0

Planned
Replenishments by
Order Date

0 0 0 0 0

For item A, the Substitute Supply measure is 5.

For item B, the Substitute Demand measure is 5.

On Day 3, the data for item A is as depicted in this table:

Measures for Item A Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 15 5 10 10 10

Total Supply 56 5 0 0 0

Projected Available
Balance

41 41 31 21 11

Beginning Inventory
Position

41 41 31 21 11

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

0 0 0 0 0

Initial Shortage for
Substitution

16 5 10 0 0

Substitute Supply 16 5 0 0 0

Substitute Demand 0 0 0 0 0
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Measures for Item A Day 1 Day 2 Day 3 Day 4 Day 5

Planned
Replenishments by
Order Date

0 0 0 0 0

On Day 3, the data for item B is as depicted in this table:

Measures for Item B Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 31 10 23 8 10

Total Supply 105 0 0 0 0

Projected Available
Balance

74 64 41 33 23

Beginning Inventory
Position

74 64 41 33 23

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

49 28 0 0 0

Initial Shortage for
Substitution

0 0 0 0 0

Substitute Supply 0 0 0 0 0

Substitute Demand 16 5 0 0 0

Planned
Replenishments by
Order Date

0 0 0 0 0

For item A, the Initial Shortage for Substitution measure is -10 (31 - 40 - 1).

For item B, the Initial Excess for Substitution measure is zero (41 - 40 - 1).

On Day 3, the data after end item substitution or supersession for item A is as depicted in this table:

Measures for Item A Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 15 5 10 10 10

Total Supply 56 5 0 0 0

Projected Available
Balance

41 41 31 21 50

Beginning Inventory
Position

41 41 31 21 50

Minimum Quantity 40 40 40 40 40
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Measures for Item A Day 1 Day 2 Day 3 Day 4 Day 5

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

0 0 0 0 0

Initial Shortage for
Substitution

16 5 10 0 0

Substitute Supply 16 5 0 0 0

Substitute Demand 0 0 0 0 0

Planned
Replenishments by
Order Date

0 0 39 0 0

On Day 3, the data after end item substitution or supersession for item B is as depicted in this table:

Measures for Item B Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 31 10 23 8 10

Total Supply 105 0 0 0 0

Projected Available
Balance

74 64 41 33 23

Beginning Inventory
Position

74 64 41 33 23

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

49 28 0 0 0

Initial Shortage for
Substitution

0 0 0 0 0

Substitute Supply 0 0 0 0 0

Substitute Demand 16 5 0 0 0

Planned
Replenishments by
Order Date

0 0 0 0 0

On Day 3, for item A, the Substitute Supply measure is zero because item B doesn't have any excess. Therefore a
planned order of 39 units is created on Day 3 for bringing the inventory level to the Maximum Quantity.
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Example for Using Related Items Only to Avoid Stockouts
When you select Use related items only when necessary to avoid stockouts in the Use of Related Items Supplies
field, the shortage and excess of the item are calculated as follows:

• If the Projected Available Balance for the item on a day is less than zero, the Projected Available Balance is the
shortage.

• The excess is calculated as the least positive value for the Projected Available Balance in the excess window.

In this example, we have two items, C and D, at organization WH2. Item D is a substitute for item C or the item that
supersedes item C. The excess window is 1 day. The policy type is min-max planning.

On Day 1, the data for item C is as depicted in this table:

Measures for Item C Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 15 5 10 10 50

Total Supply 40 0 0 0 0

Projected Available
Balance

25 20 10 0 -50

Beginning Inventory
Position

25 20 10 0 -50

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

0 0 0 0 0

Initial Shortage for
Substitution

0 0 0 0 0

Substitute Supply 0 0 0 0 0

Substitute Demand 0 0 0 0 0

Planned
Replenishments by
Order Date

45 0 0 0 0

On Day 1, the data for item D is as depicted in this table:

Measures for Item D Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 15 5 23 8 10

Total Supply 105 0 0 0 0

Projected Available
Balance

90 85 62 54 44

Beginning Inventory
Position

90 85 62 54 44
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Measures for Item D Day 1 Day 2 Day 3 Day 4 Day 5

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

90 0 0 0 0

Initial Shortage for
Substitution

0 0 0 0 0

Substitute Supply 0 0 0 0 0

Substitute Demand 0 0 0 0 0

Planned
Replenishments by
Order Date

0 0 0 0 0

For item C, the Initial Shortage for Substitution measure is zero because the Projected Available Balance Measure is
25 and not a negative value. A planned order of 45 units is created on Day 1 for bringing the inventory level to the
Maximum Quantity.

For item D, the Initial Excess for Substitution measure is 90.

On Day 5, the data for item C is as depicted in this table:

Measures for Item C Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 15 5 10 10 50

Total Supply 40 0 45 0 0

Projected Available
Balance

25 20 55 45 -5

Beginning Inventory
Position

25 65 55 45 -5

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

0 0 0 0 0

Initial Shortage for
Substitution

0 0 0 0 5

Substitute Supply 0 0 0 0 0

Substitute Demand 0 0 0 0 0

Planned
Replenishments by
Order Date

45 0 0 0 0

On Day 5, the data for item D is as depicted in this table:
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Measures for Item D Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 15 5 23 8 10

Total Supply 105 0 0 0 0

Projected Available
Balance

90 85 62 54 44

Beginning Inventory
Position

90 85 62 54 44

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

90 85 62 54 44

Initial Shortage for
Substitution

0 0 0 0 0

Substitute Supply 0 0 0 0 0

Substitute Demand 0 0 0 0 0

Planned
Replenishments by
Order Date

0 0 0 0 0

For item C, the Initial Shortage for Substitution measure is 5 because the Projected Available Balance measure is -5 and
a negative value.

For item D, the Initial Excess for Substitution measure is 44.

On Day 5, the data after end item substitution or supersession for item C is as depicted in this table:

Measures for Item C Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 15 5 10 10 50

Total Supply 40 0 45 0 5

Projected Available
Balance

25 20 55 45 0

Beginning Inventory
Position

25 65 55 45 0

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

0 0 0 0 0

Initial Shortage for
Substitution

0 0 0 0 5

Substitute Supply 0 0 0 0 5
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Measures for Item C Day 1 Day 2 Day 3 Day 4 Day 5

Substitute Demand 0 0 0 0 0

Planned
Replenishments by
Order Date

45 0 0 0 70

On Day 5, the data after end item substitution or supersession for item D is as depicted in this table:

Measures for Item D Day 1 Day 2 Day 3 Day 4 Day 5

Total Demand 15 5 23 8 15

Total Supply 105 0 0 0 0

Projected Available
Balance

90 85 62 54 39

Beginning Inventory
Position

90 85 62 54 39

Minimum Quantity 40 40 40 40 40

Maximum Quantity 70 70 70 70 70

Initial Excess for
Substitution

90 85 62 54 44

Initial Shortage for
Substitution

0 0 0 0 0

Substitute Supply 0 0 0 0 0

Substitute Demand 0 0 0 0 5

Planned
Replenishments by
Order Date

0 0 0 0 31

For item C, the Substitute Supply measure is 5. A planned order of 70 units is created for bringing the inventory level to
the Maximum Quantity.

For item D, the Substitute Demand measure is 5. A planned order of 31 units is created for bringing the inventory level to
the Maximum Quantity.

Related Topics
• Overview of End Item Substitution and Supersession

• Item Relationship Options for Replenishment Plans

• Measures for End Item Substitution and Supersession
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18  Simulations for Replenishment Plans

Overview of Simulations for Replenishment Plans  
Use plan simulations to quickly perform what-if simulations, improve your replenishment plan's performance, resolve
supply issues, or improve projected fill rates. When you're satisfied with a simulated outcome, you can manually release
planned orders with your changes.

Types of Simulations for Replenishment Plans
This table explains the types of simulations that you can perform for your replenishment plan:

Type of Simulation Explanation Location Where Simulation Is Performed

Simulations for policy parameters
 

You perform these simulations for segments
of the segment group that's attached to your
replenishment plan.
 
You can identify policy parameter alternatives
that maximize your replenishment plan's
performance.
 

Use the Manage Policy Assignments table for
the replenishment plan.
 
If you're satisfied with your changes, you can
save them to the policy assignment set that's
attached to your replenishment plan for future
use.
 

Simulations for policy values
 

You perform these simulations for item-location
combinations of the segment group that's
attached to your replenishment plan.
 
You can identify policy value alternatives
that maximize your replenishment plan's
performance.
 

To simulate changes for all buckets within
your planning horizon, use the Manage Policy
Parameters by Item table for the replenishment
plan.
 
To simulate changes for specific buckets within
your planning horizon, use the Replenishment
Workbench table for the replenishment plan.
 

Simulations for supplies and demands
 

You perform these simulations for item-location
combinations by adding or modifying supplies
and demands.
 
After changing quantities and dates, you
can compare your baseline and simulated
replenishment plans.
 

To simulate changes for all buckets within
your planning horizon, use the Supplies and
Demands table for the replenishment plan.
 
To simulate changes for specific buckets within
your planning horizon, use the Replenishment
Workbench table for the replenishment plan.
 

Simulations for item attributes
 

You perform these simulations by changing
item attributes of item-location combinations
for the segment group that's attached to your
replenishment plan.
 
You can simulate changes to lead times and
order modifiers to resolve supply-related issues
such as stockouts.
 
You can also modify costs, lead times, service-
level percentages, and overrides for the mean
absolute percentage error (MAPE) for policy and
projected fill rate simulations.

Use the Items table for the replenishment plan.
 
If you're satisfied with your changes, you can
optionally save them to a simulation set for
future use.
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Type of Simulation Explanation Location Where Simulation Is Performed

 

Simulations for inventory rebalancing You perform these simulations by making
changes to the planned orders generated after
inventory rebalancing of your replenishment
plan. You can change the firm dates and
quantities and shipping methods.
You can also create a planned order of the
transfer type.
 

Use the Manage Rebalancing
Recommendations table for the replenishment
plan.
Your firm planned orders aren't retained the
next time you run the replenishment plan with
the Refresh with current data option selected
on the Parameters tab in the Run Plan dialog
box.
 

To perform a simulation, you run your replenishment plan by selecting the Do not refresh with current data option on
the Parameters tab in the Run Plan dialog box. Only the following are replanned:

• Item-location combinations for segments whose policy parameters are changed

• Item-location combinations whose policy values, supplies and demands, and item attributes are changed

• The locations in different clusters for the items for which rebalancing recommendations are changed

After you're satisfied with the results of your simulation, you can manually release planned orders.

Note these points about how simulation works with other features for Oracle Replenishment Planning:

• If you enable your replenishment plan for end item substitution and supersession, if you simulate a change to
the policy parameters, policy values, supplies and demands, or attributes for an item-location combination, the
entire substitution or supersession chain is replanned.

• During simulation for a multiechelon replenishment plan, if you make a change for an item, it's replanned at
all echelons. A bottom-up pass for unconstrained planning and a top-down pass for constrained planning are
performed.
If you simulate a change to an item that's a part of a substitution or supersession chain, the entire chain is
replanned at all echelons. A bottom-up pass for unconstrained planning and a top-down pass for constrained
planning are performed.

Replan by Individual Planners
In your simulation plan, simulations are restricted to the changes done by individual replenishment planners.

This functionality is useful when a replenishment plan has subsets of item-location combinations that are managed
by different replenishment planners, and they must often run simulations while resolving issues such as stockouts
in storerooms or demand increases caused by promotions at retail outlets. The functionality enables you to identify
inputs that change replenishment plan results, work in parallel with other replenishment planners without affecting their
changes, and quickly and reliably run simulations.

For example, if you and another replenishment planner are individually changing item attributes, supplies and
demands, policy parameters for segments, and policy parameter overrides for segments and item-location
combinations, when you run a simulation by selecting Do not refresh with current data on the Parameters tab in
the Run Plan dialog box, only your changes are simulated, and those made by the other replenishment planner aren't
considered. Later, when the other replenishment planner runs a simulation, only the changes made by that user are
simulated, and your changes aren't considered.

Further, by using the Manage Replan Details dialog box that you open from the Parameters tab in the Run Plan dialog
box, you can select which of your changes you want to simulate.
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Related Topics
• Run a Replenishment Plan

• Manually Release Replenishment Orders

• Overview of Multiechelon Replenishment Planning

Simulate Changes to Policy Parameters for Segments
Within a Replenishment Plan  
Within your replenishment plan, you can simulate changes to policy parameters, default policy parameters, and
policy parameter overrides at the segment level for the associated policy assignment set by using the Manage Policy
Assignments table.

Note:  You can also use the Manage Policy Assignments table to view the policy parameters that were applied to the
replenishment plan when it was last run. You don't have to see the associated policy assignment set for these details.
Moreover, these policy parameters in the replenishment plan may differ from those in the policy assignment set,
because it may have changed since the replenishment plan was last run.

Follow these steps to simulate changes to parameters, defaults, and overrides at the segment level:

1. Do one of the following to open the replenishment plan for which you want to perform the simulation:

◦ To open the replenishment plan using the Manage Plans page:

i. On the Tasks panel tab, under Plans, select Manage Plans.

The Manage Plans page opens and displays the available replenishment plans.
ii. Select the replenishment plan, and click Actions > Open.

The replenishment plan opens in a separate tab.

◦ On the Plans panel tab, under Plans, right-click the replenishment plan, and select Open.

The replenishment plan opens in a separate tab.
2. Click the Open drop-down button, and click a pane if you're required to do so.

The Open Table, Graph, or Tile Set dialog box opens.
3. Search for the Manage Policy Assignments table, select it, and click OK.

The Manage Policy Assignments page opens.
4. On the Segment-Level Policy Parameters Assignment subtab on the page, select the segment for which you

want to perform your simulation, and make your changes.

Note:   You can only view details on the Item-Location Level Policy Overrides subtab. To simulate changes to
policy values for item-location combinations, use the Manage Policy Parameters by Item or Replenishment
Workbench table. For slow-moving items or items with intermittent demand, you can optionally enter zero as
the safety stock override and minimum override.

5. Click the Save drop-down button.
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6. Click Actions > Run to run the replenishment plan.
The Run Plan dialog box opens.

a. On the Parameters tab, under Scope Options, select the Calculate policy parameters and Calculate
replenishments check boxes.

b. Under Data Refresh Options, select Do not refresh with current data.
The Manage Replan Details link appears under the option.

c. Click Manage Replan Details to open the Manage Replan Details dialog box, in which you can see the
segments for which you have made changes. Deselect the check box under Replan for the segments for
which you don't want to run the simulation.

d. Click Save and Close.
e. Click OK in the Run Plan dialog box.

7. If you're satisfied with the simulation results, save your changes to the policy assignment set by clicking
Actions > Save Changes to Policy Assignment Set.
The Save Changes to Policy Assignment Set dialog box opens and displays the changes that you have saved at
the segment level within the replenishment plan but not saved to the policy assignment set.
If you don't save the changes, they're lost the next time you run the replenishment plan with the Refresh with
current data option selected under Data Refresh Options on the Parameters tab in the Run Plan dialog box.

a. Review the changes that you made for each segment.
You can see the old and new values for your changes.

b. Under Changes to Save, select the check boxes for the segments for which you want to save changes to
the policy assignment set.

c. Click OK.

Related Topics
• Run a Replenishment Plan

Simulate Changes to Policy Values for Items Within a
Replenishment Plan  
Within your replenishment plan, you can simulate changes to policy values for item-location combinations of the
associated segment group.

Changes to policy values for item-location combinations within the replenishment plan persist until you override the
changes. These changes also take precedence over the item-location level policy overrides specified in the associated
policy assignment set but aren't updated there.

You can use the following tables to simulate changes to policy values for item-location combinations:

• Manage Policy Parameters by Item: Use this table when you want to simulate changes to policy values for all
buckets in your planning horizon. Using this table, you can change the minimum quantity, maximum quantity,
minimum days, maximum days, reorder point (ROP) quantity, ROP days, and economic order quantity (EOQ) for
an item-location combination by using the corresponding override measures.
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• Replenishment Workbench: Use this table when you want to simulate changes to policy values for specific
buckets in your planning horizon.

Note:  Using this table, you can also simulate changes to the gross forecast, net forecast, adjusted shipments
forecast, and planned replenishments by due date for the item-location combination, but these simulations
pertain to supplies and demands. Except for the change you make to the adjusted shipments forecast, the
other changes are lost the next time you run the replenishment plan with the Refresh with current data
option selected on the Parameters tab in the Run Plan dialog box.

Simulate Changes to Policy Values of Item-Location Combinations
Follow these steps to simulate changes to policy values for item-location combinations in the replenishment plan:

1. Do one of the following to open the replenishment plan for which you want to perform the simulation:

◦ To open the replenishment plan using the Manage Plans page:

i. On the Tasks panel tab, under Plans, select Manage Plans.

The Manage Plans page opens and displays the available replenishment plans.
ii. Select the replenishment plan, and click Actions > Open.

The replenishment plan opens in a separate tab.

◦ On the Plans panel tab, under Plans, right-click the replenishment plan, and select Open.

The replenishment plan opens in a separate tab.
2. Click the Open drop-down button, and click a pane if you're required to do so.

The Open Table, Graph, or Tile Set dialog box opens.
3. Search for the Manage Policy Parameters by Item or Replenishment Workbench table, select it, and click OK.

The Manage Policy Parameters by Item or Replenishment Workbench page opens.
4. On the toolbar, click View > Highlight Editable Cells to identify the cells that you can edit.
5. Filter the rows by a segment and location of the segment group.

On the Replenishment Workbench page, you must also filter the rows by item.
6. For an item-location combination for which you want to edit policy values, enter values in the editable cells on

the Manage Policy Parameters by Item page.

On the Replenishment Workbench page, enter values in the editable cells for specific days.
7. Repeat Steps 5 and 6 for the item-location combinations for which you want to simulate changes.
8. Click the Save drop-down button.
9. Click Actions Run to run the replenishment plan.

The Run Plan dialog box opens.

a. On the Parameters tab, under Scope Options, select the Calculate replenishments check box.
b. Under Data Refresh Options, select Do not refresh with current data.

The Manage Replan Details link appears under the option.
c. Click Manage Replan Details to open the Manage Replan Details dialog box, in which you can see the

item-location combinations for which you have made changes. Deselect the check box under Replan for
the combinations for which you don't want to run the simulation.
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d. Click Save and Close.
e. Click OK in the Run Plan dialog box.

Related Topics
• Run a Replenishment Plan

How You Simulate Changes to Supplies and Demands in
Replenishment Plans  
This topic explains how you can simulate changes to supplies and demands in the Replenishment Planning work area.

In your replenishment plan, you can use these tables to simulate changes to supplies and demands:

• Supplies and Demands: Use this table when you want to simulate changes for all planning buckets in your
planning horizon.

• Replenishment Workbench: Use this table when you want to simulate changes for specific planning buckets in
your planning horizon.

Simulate Changes with the Supplies and Demands Table
You can simulate changes to supplies and demands for the manual demand, planned order, and on hand order types by
editing the Supplies and Demands table for your replenishment plan.

You can do the following while using the Supplies and Demands table for simulations:

• Create and edit manual demands.

• Create and edit orders of the on hand type.

• Create and edit planned orders.

This table lists the columns that you can edit in the Supplies and Demands table from your replenishment plan:

Column Editable in Replenishment Plan?

Customer
 

• Manual Demand: Yes

• On Hand: No

• Planned Order: No

Customer Site
 

• Manual Demand: Yes

• On Hand: No

• Planned Order: No

Firm Date
 

• Manual Demand: Yes

• On Hand: No

• Planned Order: Yes
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Column Editable in Replenishment Plan?

Firm Quantity
 

• Manual Demand: Yes

• On Hand: Yes

• Planned Order: Yes

Firm Status
 

• Manual Demand: Yes

• On Hand: Yes

• Planned Order: Yes

Shipping Method
 

• Manual Demand: No

• On Hand: No

• Planned Order: Yes

Source Organization
 

• Manual Demand: No

• On Hand: No

• Planned Order: Yes

Supplier
 

• Manual Demand: No

• On Hand: No

• Planned Order: Yes

Supplier Site
 

• Manual Demand: No

• On Hand: No

• Planned Order: Yes

After saving your changes, run your replenishment plan with the Do not refresh with current data option and
Calculate replenishments check box selected on the Parameters tab in the Run Plan dialog box. Click Manage Replan
Details to open the Manage Replan Details dialog box, in which you can see the item-location combinations for which
you have made changes. Deselect the check box under Replan for the combinations for which you don't want to run the
simulation.

The changes are lost the next time you run the replenishment plan with the Refresh with current data option selected
on the Parameters tab in the Run Plan dialog box.

Simulate Changes with the Replenishment Workbench Table
You can simulate changes to supplies and demands in your replenishment plan by using the Replenishment Workbench
table.

Use the Adjusted Shipments Forecast, Gross Forecast, and Net Forecast columns to simulate changes to demands and
the Planned Replenishments by Due Date column to simulate changes to supplies.

After saving your changes, run your replenishment plan with the Do not refresh with current data option and
Calculate replenishments check box selected on the Parameters tab in the Run Plan dialog box. Click Manage Replan
Details to open the Manage Replan Details dialog box, in which you can see the item-location combinations for which
you have made changes. Deselect the check box under Replan for the combinations for which you don't want to run the
simulation.
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Except for the change you make to the Adjusted Shipments Forecast column, the other changes are lost the next time
you run the replenishment plan with the Refresh with current data option selected on the Parameters tab in the Run
Plan dialog box.

Related Topics
• Run a Replenishment Plan

How You Simulate Changes to Item Attributes in
Replenishment Plans  
You can simulate changes to item attributes by editing the Items table for your replenishment plan.

You can edit these columns in the Items table from your replenishment plan:

• Annual Carrying Cost Percentage

• Average Interarrival Time Override

• Fixed Lot Multiplier

• Fixed Order Quantity

• Intermittent Demand Override

• MAPE Override

• Maximum Order Quantity

• Minimum Order Quantity

• Order Cost

• Preprocessing Lead Time

• Postprocessing Lead Time

• Processing Lead Time

• Selling Price

• Service Level Percentage

• Standard Cost

After saving your changes, run your replenishment plan with the Do not refresh with current data option and
Calculate replenishments check box selected on the Parameters tab in the Run Plan dialog box. If required, select the
Calculate policy parameters check box. Click Manage Replan Details to open the Manage Replan Details dialog box,
in which you can see the item-location combinations for which you have made changes. Deselect the check box under
Replan for the combinations for which you don't want to run the simulation.

The changes are lost the next time you run the replenishment plan with the Refresh with current data option selected
on the Parameters tab in the Run Plan dialog box. You can optionally copy the changes you make in the table to a
simulation set for future use.

Related Topics
• Run a Replenishment Plan
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Simulations for Inventory Rebalancing
Recommendations  

Overview of Simulations for Inventory Rebalancing
Recommendations  
You can edit the dates, quantities, and shipping methods for your inventory rebalancing recommendations and add a
planned order of the transfer type. Thereafter, you can simulate the effects of your edits on inventory rebalancing for
your replenishment plan.

During simulation, using the Manage Rebalancing Recommendations page, you can make changes to a subset of
items within a cluster. Your new or edited planned orders for item-location combinations are considered as firm. While
the excess and shortage quantities are computed for these combinations of items, source locations, and destination
locations, no new planned orders are generated for these combinations. The rebalancing recommendations are
recomputed for the remaining locations for these items in the cluster. The locations for these items in other clusters are
also replanned.

Using the Manage Replan Details dialog box, you can further refine the list of the item-location combinations for which
you want to run the simulation.

For the replanned item-location combinations, replenishments are automatically recalculated so that data consistency is
ensured.

Benefits of Simulations for Inventory Rebalancing
By simulating the effects of your changes to the inventory rebalancing for your replenishment plan, you get these
benefits:

• You can effectively respond to changes within your supply chain.

For example, to cater to a sudden demand, you can add a planned order of the transfer type to move excess
inventory from a source location to a destination location. You can then simulate the impact of this change to
the inventory rebalancing for other locations in the clusters for the item.

• You can optimize inventory costs within your supply chain.

• You can improve your customer service by moving inventory from locations with excess inventory to locations
with inventory shortages.

Additional Points About Simulations for Inventory Rebalancing
Note these additional points about the simulations of changes to inventory rebalancing for your replenishment plan:

• Even if your firm date (suggested ship date) for a new or edited outbound planned order is outside the excess
computation window, the planned order is still considered during the calculation of the excess inventory.

• Even if your firm date (suggested due date) for a new or edited inbound planned order is outside the shortage
computation window, the planned order is still considered during the calculation of the inventory shortage.
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• If the pair of source and destination locations for a newly created planned order is present in more than one
cluster, the first cluster is chosen on the basis of the sequence number that you assigned on the Inventory
Rebalancing tab on the Plan Options page for the replenishment plan.

Related Topics
• Example of Simulation of Changes to Inventory Rebalancing Recommendations

• Inventory Rebalancing Options for Replenishment Plans

• How You Simulate Changes to Inventory Rebalancing Recommendations in Replenishment Plans

How You Simulate Changes to Inventory Rebalancing
Recommendations in Replenishment Plans  
After you run your replenishment plan, you can review the inventory rebalancing recommendations and manually
override them or create planned orders. You can then simulate the results of your changes to rebalancing
recommendations.

Types of Simulations to Inventory Rebalancing Recommendations
On the Manage Rebalancing Recommendations page for the replenishment plan for which you've selected the
Rebalance inventory check box on the Plan Options page, you can edit the values in the following columns:

• Firm Date

• Firm Quantity

• Firm Status

• Shipping Method

You can also create planned orders of the transfer type for an item-location combination in a cluster.

Simulate Changes to Inventory Rebalancing Recommendations
To simulate changes to inventory rebalancing recommendations for your replenishment plan, follow these steps:

Note:  If you aren't using an integrated replenishment plan, open the replenishment plan for which you've selected the
Rebalance inventory check box on the Plan Options page.
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1. After the inventory rebalancing process, open your replenishment plan through one of these ways:
◦ Use the Manage Plans page:

i. On the Tasks panel tab, under Plans, select Manage Plans.
The Manage Plans page opens.

ii. Under Search Results, select the replenishment plan that you want to open, and click Actions >
Open.
The replenishment plan opens in a separate page.

◦ On the Plans panel tab, under Plans, right-click the replenishment plan that you want to open, and select
Open.
The replenishment plan opens in a separate page.

2. Click the Open drop-down button.
The Open Table, Graph, or Tile Set dialog box opens.

3. Search for the Manage Rebalancing Recommendations table, and open it.
The Manage Rebalancing Recommendations page opens under the replenishment plan.

Note:  You can also drill to the Manage Rebalancing Recommendations page from the analytics for inventory
rebalancing.

4. Under Search, perform a search for the item-location combinations and clusters for which you want to simulate
changes to rebalancing recommendations.

5. Select a rebalancing recommendation that you want to change, and make changes to the values in the Firm
Date, Firm Quantity, Firm Status, and Shipping Method columns.
If you make any change to the date or quantity, the value in the Firm Status column is automatically set to
Firm. Any change to the shipping method is considered only if there's a change to the date or quantity.
Or, create a planned order of the transfer type, and provide the details under the columns. The value in the
Firm Status column for the planned order is automatically set to Firm.
Your firm planned orders aren't retained the next time you run the replenishment plan with the Refresh with
current data option selected on the Parameters tab in the Run Plan dialog box.

6. Save your changes.
7. Click Actions > Run.

The Run Plan dialog box opens.
8. On the Parameters tab, under Data Refresh Options, ensure that Do not refresh with current data is selected.
9. Under Scope Options, select the Rebalance inventory check box.

The Calculate replenishments check box is automatically selected and grayed out.
10. Under the Do not refresh with current data option, click the Manage Replan Details link.

The Manage Replan Details dialog box opens.
11. For the combinations for which you don't want to run the simulation, deselect the check box under Replan.
12. Click Save and Close.
13. Click OK to run the simulation.

Release Inventory Rebalancing Recommendations After Simulation
After the simulation run, review the results of your changes.
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If you're satisfied with the results of your simulations, you can manually release the rebalancing recommendations.

Related Topics
• Overview of Simulations for Inventory Rebalancing Recommendations

• Example of Simulation of Changes to Inventory Rebalancing Recommendations

• Manually Release Rebalancing Recommendations

Example of Simulation of Changes to Inventory Rebalancing
Recommendations  
Consider an example in which you want to simulate the changes to inventory rebalancing after you consolidate two
planned orders from a source destination to a destination location for an item.

In this example, your cluster has five locations: M1, M2, M3, M4, and M5.

This table depicts the excess inventory and inventory shortages before inventory rebalancing for your replenishment
plan:

Inventory M1 M2 M3 M4 M5

Excess inventory 12 6 0 0 0

Inventory shortage 0 0 9 1 7

This table depicts the initial results after inventory rebalancing for your replenishment plan:

Planned Orders Inventory M1 M2 M3 M4 M5

Excess inventory 9 0 0 0 01 M2 to M3: 6
M1 to M3: 3
 Inventory

shortage
0 0 0 1 7

Excess inventory 2 0 0 0 02 M1 to M5: 7

Inventory
shortage

0 0 0 1 0

Excess inventory 1 0 0 0 03 M1 to M4: 1

Inventory
shortage

0 0 0 0 0

First, two planned orders are created, one for six units from M2 to M3 and the other for three units from M1 to M3. The
excess inventory is zero units for M2 and nine units for M1. The inventory shortage is zero units for M3. In the cluster, M3
is picked up because it has the largest inventory shortage, and M2 is picked up because it has the shortest transfer lead
time.
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Second, one planned order is created for seven units from M1 to M5. The excess inventory is two units for M1. The
inventory shortage is zero units for M5. In the cluster, M5 is picked up because it has the second largest inventory
shortage.

Third, one planned order is created for one unit from M1 to M4. The excess inventory is one unit for M1. The inventory
shortage is zero units for M4.

M1 has an initial excess of 12 units and can fully meet the shortage of nine units at M3. Therefore, you may want to
consolidate the number of shipments arriving at M3 to one shipment from M1 instead of two partial shipments from M1
and M2 and simulate the results of your change to the inventory rebalancing for the other locations in the cluster.

Assume that you've changed the quantity of the shipment from M1 to M3 from three to nine units and firmed the
planned order. This table depicts the results of consolidating the planned orders that are received by M3:

Planned Orders Inventory M1 M2 M3 M4 M5

Excess inventory 3 6 0 0 0M1 to M3: 9

Inventory shortage 0 0 0 1 7

One planned order for 9 units is created from M1 to M3. The excess inventory is three units for M1.

This table depicts the simulation of the results of your change on the inventory rebalancing for the remaining locations
of the cluster:

Planned Orders Inventory M1 M2 M3 M4 M5

Excess inventory 2 0 0 0 01 M2 to M5: 6
M1 to M5: 1
 Inventory

shortage
0 0 0 1 0

Excess inventory 1 0 0 0 02 M1 to M4:1

Inventory
shortage

0 0 0 0 0

The excess inventory and inventory shortage are recalculated for M1 and M3. No planned orders are created from M1 to
M3.

Then, inventory rebalancing is performed for the remaining locations in the cluster. First, two planned orders are
created, one for six units from M2 to M5 and the other for one unit from M1 to M5. The excess inventory is zero units for
M2 and two units for M1. The inventory shortage is zero units for M5. In the cluster, M5 is picked up because it has the
largest inventory shortage.

Second, one planned order is created for one unit from M1 to M4. The excess inventory at M1 is one unit. The inventory
shortage at M4 is zero.

If you're satisfied with the simulation results, you can manually release the modified planned order (M1 to M3) and
recommended planned orders.
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Related Topics
• Overview of Simulations for Inventory Rebalancing Recommendations

• Manually Release Rebalancing Recommendations

• How You Simulate Changes to Inventory Rebalancing Recommendations in Replenishment Plans
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19  Simulation Sets

Create a Simulation Set  
Perform the following steps to create a simulation set from the Plan Inputs work area:

1. In the Navigator, click the Plan Inputs work area link.
2. On the Plan Inputs page, click the Open button.
3. In the Open Table, Graph, or Tile Set dialog box, do the following:

a. In the Search drop-down list, select: Name.
b. In the Search text box, enter the name of a table, such as Items or Resources.
c. Click the Search icon button.
d. Select the Items (or Research) table and click OK.

4. On the Plan Inputs page, Items tab (or Resources tab), click the Search button.
5. In the Search Results region, select one or more rows and do the following:

a. Click Actions and then select Add to Simulation Set.
b. In the Add to Simulation Set dialog box, click the Search: Simulation Set down arrow for a list of values,

and then click Create Simulation Set.
c. In the Create Simulation Set dialog box, in the Simulation Set field, enter the name of the simulation set

you want to create.
d. Click Save and Close.
e. In the Add to Simulation Set dialog box, click Save and Close.

Related Topics
• Edit a Simulation Set

• Overview of Simulation Sets

• Simulations in Supply Planning

• Copy Data to Simulation Sets in Supply Planning

• Add Data from Plan Inputs to Simulation Sets

Edit a Simulation Set  
Perform the following steps to edit a simulation set from the Plan Inputs work area:

1. In the Navigator, click the Plan Inputs work area link.
2. On the Plan Inputs page, click the Plans panel tab.
3. In the Plans panel drawer, do the following:

a. Expand the list of Simulation Sets.
b. Select a simulation set, right-click on it and select Open.

4. On the Simulation Set page, click Open and then select Full Pane.
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5. In the Open Table, Graph, or Tile Set dialog box, select a table, such as Resources or Items, and then click OK.

On the Simulation Set page, a new tab opens for the table that you selected, such as the Resources tab or the
Items tab.

6. In the Search region, click Search.
7. In the Search Results region, select one or more rows. Click Actions and then select Edit from the drop-down

list.

8. In the edit dialog box, you can edit some of the attributes and drill down to additional tables, depending on the
table that you accessed. For example:

◦ For the Resources table, you can change the Bottleneck value. You can also drill down to the Resource
Availability table.

◦ For the Items table, you can change the Processing Lead Time value. You can also drill down to the
Suppliers table.

9. When done, click OK to return to the Simulation Set page. Changed rows and fields are marked with small
colored dots.

Related Topics
• Create a Simulation Set

• Edit a Simulation Set from a Spreadsheet

• Overview of Simulation Sets

• Simulate Demand and Supply Changes

Edit a Simulation Set from a Spreadsheet  
You can download simulation set data into a spreadsheet, make edits, including certain updates, additions, and
deletions, and then upload it back to the simulation set.

In the Plan Inputs work area, while working with the Items or Supplies and Demands table in a simulation set, use the
Edit in Spreadsheet option in the Actions menu to download the table rows into a Microsoft Excel file.

Note:  Before working with spreadsheets, you must download and install the desktop integration installer that is
available under Navigator > Tools. Otherwise, you can't download information into or upload information from
spreadsheets.

To edit the data in the Items or Supplies and Demands table of the simulation set in a Microsoft Excel spreadsheet,
follow these steps:

1. In the Plan Inputs work area, click the Plans panel tab.

Note:  The simulation set can also be edited from the Planning Central, Sales and Operations Planning, and
Supply Planning work areas. However, the Supplies and Demands table is available in the simulation set only
when it is edited in the Supply Planning work area.

2. In the Plans panel drawer, do the following:

a. Expand the list of simulation sets.
b. Select the simulation set that you want to edit, right-click, and click Open. The simulation set opens.
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3. In the Open menu, select Full Pane. The Open Table, Graph, or Tile Set dialog box opens.
4. Select the Items or Supplies and Demands table, and click OK. The table opens in a page in the simulation set.
5. Perform a search for the table rows in the simulation set.
6. In the Actions menu for the table, click Edit in Spreadsheet. A dialog box opens and prompts you to save or

open a Microsoft Excel file.
7. Open the spreadsheet. The Connect dialog box opens and prompts you to connect to the URL for the

application.
8. Click Yes. A dialog box opens and prompts you to type your credentials.
9. Sign in with your credentials for the Oracle Fusion Cloud Applications Suite. The spreadsheet is refreshed with

the data in the simulation set.
10. Edit the data.

Task Steps

To add an item to the Items table of the
simulation set
 

Click the Add Item icon in the Items menu of the spreadsheet, and provide values in the Add
Item dialog box that opens. You can add an existing item or create an item that is based on an
existing item.
 

To create an order in the Supplies and
Demands table of the simulation set
 

Click the Create Order icon in the Supplies and Demands menu of the spreadsheet, and
provide values in the Create Order dialog box that opens. (Not applicable to sales and
operations planning.)
 

To edit a row
 

Modify the values in the row cells that are not grayed out. A symbol appears in the cell under
the Changed column for the row.
 

To delete a row
 

Click the corresponding cell in the Mark for Deletion column. A symbol appears in the cell to
mark the table row for deletion. To deselect the row, click the cell again.
 

11. Click the Upload icon in the Items or Supplies and Demands menu. In the Upload Options dialog box that
appears, select the check boxes for the options that you want to use, and click OK. The data is uploaded to the
simulation set.

12. Save the simulation set. The changes are displayed and marked with colored symbols.
13. Save and close the spreadsheet.
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20  Buyer Planning

Buyer Planning for Administrators  
As a Buyer Planning administrator, understand how it integrates with other modules and products, and what you need
to do before your planners can use it.

Buyer planners take advantage of price breaks for larger quantity orders and reductions in delivery costs into fewer
deliveries.

In the Buyer Planning work area, part of Oracle Replenishment Planning, buyer planners use recommendations from
Replenishment Planning to evaluate ways to consolidate and group planned orders.

Application Integration
This graphic shows how the Buyer Planning work area interacts with other modules or products, such as Oracle
Demand Management, Oracle Procurement, and Oracle Fusion Cloud Product Lifecycle Management through Oracle
Replenishment Planning.

Oracle Replenishment Planning gets demand forecasts from Oracle Demand Management. Item attribute and order
modifier information comes into Buyer Planning from Oracle Fusion Cloud Product Lifecycle Management. Price breaks,
purchase orders, and supplier constraints come from Oracle Procurement. With all the required data gathered into a
replenishment plan recommendation, Buyer Planning becomes a focused platform for the planners to plan purchasing
better.

Planners can review planned orders and change implement quantities, consolidate orders for discounts, or group
orders to save shipping costs. When they release a plan from Buyer Planning, purchase orders are generated in Oracle
Procurement.
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Prerequisites
You must complete certain prerequisites before buyer planners can start using Buyer Planning:

Prerequisite Description

Opt in to Replenishment Planning Ensure that your enterprise has opted in to Oracle Replenishment Planning.

Run the Prepare Plan for Buyer Planning
scheduled Process

Run this scheduled process to copy buy orders of a replenishment plan into Buyer Planning's elastic
index for quick retrieval.
 
You can run this process:
 

• From the Scheduled Process work area.

• Using the View Buyer Planning action from the Actions menu of a replenishment plan in the
Replenishment Planning work area. This action runs the process and also opens Buyer Planning
for the plan.

• Automatically, by selecting Prepare for Buyer Planning in the Run Plan dialog.

Define Default Weight and Volume
Measures

Define a default weight unit of measure and default volume unit of measure so that planners
can view weight and volume totals in the Group Summaries view. Set the default values with the
collaborationParameters REST service using these codes:

• ORA_MSC_BP_DEFAULT_WEIGHT_UOM

• ORA_MSC_BP_DEFAULT_VOLUME_UOM

Note:  Buyer Planning supports data security at the organization level only, data security by supplier isn't supported.

Privileges
Privileges required to use the Buyer Planning work area and its functionality:

Privilege Privilege Code Description

Monitor Buyer Planning Work Area MSC_MONITOR_BUYER_PLANNING_WORK_
AREA_PRIV

Allows monitoring of the Buyer Planning work
area.

Edit Supplies in Buyer Planning MSC_EDIT_SUPPLIES_BUYER_PLANNING_PRIV Allows management of supplies in Buyer
Planning.

Edit Buyer Planning Participating Suppliers MSC_EDIT_BUYER_PLANNING_
PARTICIPATING_SUPPLIERS_PRIV

Allows management of Buyer Planning
suppliers from the Participating Suppliers page.

482



Oracle Fusion Cloud SCM
Using Replenishment Planning

Chapter 20
Buyer Planning

Overview of Buyer Planning for Buyer Planners  
Buyer Planning lets you evaluate ways to consolidate and group purchases to enhance product availability and reduce
the total costs within supply networks.

In the Buyer Planning work area, you can view buy orders from Oracle Replenishment Planning planned
recommendations, and then consolidate and group them. In addition, you evaluate the impact on projected available
balances when you change quantities or dates of planned orders.

The Buyer Planning Work Area
Use any of these ways to get to the Buyer Planning work area:

• Use the View Buyer Planning action from Actions on a replenishment plan

• Use the Buyer Planning work area icon on Supply Chain Planning

In the Buyer Planning work area, there are three tabs:

• Overview

• Buyer Planning

• Suppliers

Tabs in the Work Area What’s There and What You can Do

Overview Shows:
• Planned Orders KPI card

• Orders with Price Breaks KPI card

• Bar chart by supplier and planned order status that shows data based on the KPI card you
selected

Note:  If price break information isn't included on the agreements, then:
• The Planned Orders with Price Break KPI isn't displayed.

• Price break indicator icons for orders aren't shown and the price break tab on the items panel
drawer is hidden for orders in the Buyer Planning tab.

Buyer Planning Shows order lines with a supplier. When you select an order line, orders are shown based on the
supplier-supplier site-location combination. The orders have:

• Planned orders in Ready for Release, Marked for Release, and Released statuses,

• Ineligible purchase requisitions, and

• Ineligible purchase orders.

On the Buyer Planning tab, purchase orders and requisitions are shown for informational purposes.
You work only on planned orders. You can perform actions such as consolidating and grouping orders.
You can quickly create new planned orders while on Buyer Planning. Here, you decide the implement
quantity, change the implement dock date, mark the orders for release, check inventory balances, and
finally, release your plan.
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Tabs in the Work Area What’s There and What You can Do

 

Suppliers Lets you manually add participating suppliers from the Buyer Planning work area.

This graphic shows the functional flow of how to use the Buyer Planning work area:

Begin with adding the participating suppliers to the Buyer Planning work area. You can use REST service or add them
manually from the Suppliers tab of Buyer Planning (call out 1). See the Add Suppliers to Use When Doing Buyer
Planning topic.

Click the Overview tab. On the Overview page, run the Prepare Plan for Buyer Planning process if you get a prompt.
This brings in the latest plan recommendations (call out 2). After the process is run, you see insights on planned orders
based on their suppliers. Review the insights (call out 3). Click a bar on the bar chart in the Overview page (callout 4), to
see the Order Lines view on the Buyer Planning tab. Here, you see the order lines by the supplier you selected on the
chart. Review order lines (callout 5).

Select an order line (callout 6) to see the Order Details view on the Buyer Planning tab. The orders appear based on the
supplier-site-location combination. On this page, review the planned orders that are in different statuses (callout 7). On
this page, you can consolidate orders (callout 7a) and group orders (callout 6b). Here, you can create planned orders,
change the implement quantities, and implement dock dates (callout 7c). After you’re done making all the changes,
mark the planned order for release (callout 7d).

Check the updated projected available balances of inventory (callout 8) and release the plan (callout 9) to generate
purchase orders.
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How to Get Ready for Buyer Planning  
To use the Buyer Planning work area, you need the latest replenishment plan recommendation data. For that, you run
the Prepare Plan for Buyer Planning process.

What You Need Details How To Do

The buy orders data
from replenishment plan
recommendations

Run the Prepare Plan for Buyer Planning scheduled process
to get the data. Points to remember before running the
process:

• Run the process only after confirming that the
plan output meets expectations and planning
recommendations are ready to be released.

• Rerun the process if you have rerun a plan. Otherwise,
the orders displayed in Buyer Planning won't reflect the
latest plan output.

Note:  You won’t see replenishment plan
recommendations on Buyer Planning when:

• The plan is released from Replenishment Planning
and the run is in progress.

• The plan run has failed.

• The plan is deleted.

There are several ways you can run the process:
• Automatically, by selecting the Prepare for

Buyer Planning check box in the Run Plan
dialog.

• By selecting the View Buyer Planning action
from page-level Actions menu within a
replenishment plan.

• Directly from Buyer Planning. The application
checks to see if the plan data has changed
since the Prepare Plan for Buyer Planning
scheduled process was last run and shows
a message if it needs to be run again. Select
the link to submit the Prepare Plan for Buyer
Planning scheduled process for rerun.

Participating Suppliers Though replenishment plan recommendations have the
supplier information, you need to add participating suppliers
to the Buyer Planning work area. After adding suppliers, you
can see order details and insights that help you make buying
decisions.

See the Add Suppliers to Use When Doing Buyer
Planning topic.

The Updated Projected
Available Balances measure

The data from the Updated Projected Available Balances
measure help you assess the impact of changes you made
to the planned orders for the inventory. You need to add this
measure to the measure catalog of a replenishment plan.

See the Add Updated Projected Available
Balances Measure topic.

Add Suppliers to Use When Doing Buyer Planning  
Though replenishment plan recommendations contain supplier information, you need to add participating suppliers to
the Buyer Planning work area to see order details and insights that can help you make buying decisions.

Two ways to add suppliers to the Buyer Planning work area:

• Use the buyerPlanningSuppliers REST service
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• Add each supplier in the Suppliers tab of the Buyer Planning work area

Here’s how you add suppliers manually:

1. In the Buyer Planning work area, Suppliers tab, Click Add.
2. On the Add Supplier panel drawer, start typing in name of a supplier.

You see a list of matching suppliers. Alternatively, you can click the dropdown to see all the suppliers. Select the
one you want to add.

3. Click Add.
The Suppliers table shows the name and number of the supplier you added.

Add the Updated Projected Available Balances Measure  
Updated projected available balances help you assess the impact on inventory caused by the changes you make to
planned orders.

Add this measure to the measure catalog of a replenishment plan. You can add either from the Replenishment Planning
work area or Setup and Maintenance work area.

Add From the Replenishment Planning Work Area
1. In the Replenishment Planning work area, open a plan and click the Tasks panel tab.
2. In the Tasks panel drawer, under Configuration, click the Configure Planning Analytics link.
3. On the Configure Planning Analytics page, Measure Catalogs tab, under Available Measures, search for

Updated Projected Available Balances.
4. Move the measure to Selected Measures.
5. Click Save.

Add From the Setup and Maintenance Work Area
1. In the Setup and Maintenance work area, use the Configure Planning Analytics task:

a. Offering: Supply Chain Planning
b. Functional Area: Supply Chain Planning Configuration
c. Task: Configure Planning Analytics

2. On the Configure Planning Analytics page, Measure Catalogs tab, under Available Measures, search for
Updated Projected Available Balances.

3. Move the measure to Selected Measures.
4. Click Save.

Consolidate Orders for Better Price Break Opportunities  
You can evaluate price break opportunities and consolidate planned orders to reduce costs.

If you have many planned orders created for ordering the same item, you can consolidate all of them into a single order.
However, the orders must be in the Ready for Release or Marked for Release status.
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Consolidate Orders
To consolidate orders:

1. In the Buyer Planning work area, Overview tab, click on a status bar of the planned order bar chart.

you see the Order Lines view on the Buyer Planning tab.
2. Select an order line.

You see the Order Details view on the Buyer Planning tab. The order details are based on the supplier-site-
location combination.

3. Select orders you want to consolidate.
4. Click Consolidate Orders.

Selected orders are merged into a single order. The consolidated orders icon appears for the order. The weight
and quantity of the items in the orders are summed up into a final weight and final quantity.

View the Consolidated Quantity and Weight
By default, the Final Weight and Final Quantity columns are hidden on the Order Details view. To see the final weight
and final quantity after consolidation, do this:

1. Click the column icon to the right of the Order Details table.
2. On the Column UI, search for the Final Weight and Final Quantity columns.
3. Select the check box before the column name and close the UI.

You now see the Final Weight and Final Quantity columns on the table.

Remove Consolidation on Orders
Use the Unmark for Release action to remove consolidation on orders. Here’s how you do it:

1. Select a consolidated order.
2. From More Actions, select Unmark for Release.

The orders are unconsolidated into separate orders. The statuses of the orders change to Ready for Release.

You can also use the Unmark for Release action to:

• Ungroup the orders.

• Remove orders from the Marked for Release status back to the Ready for Release status.

Group Orders to Save Costs  
Group planned orders into purchase orders to build loads that maximize weight and volume limits and reduce the
number of deliveries in a given period. You can ungroup the orders if you have changes to the grouping.

You can group orders that have different items into a single group. However, ensure that the supplier is the same and
the location of the supplier is also the same. After grouping, the orders continue to appear as separate orders but
belong to the same group. When you release the plan, the grouped orders become a single purchase order.
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Group a Set of Orders Using the Group Order Action
Here’s how you group the planned orders:

1. In the Buyer Planning work area, Overview tab, click on a status bar of the planned order bar chart.

You see the Order Lines view on the Buyer Planning tab.
2. Select an order line.

You see the Order Details view on the Buyer Planning tab. The order details are based on the supplier-site-
location combination.

3. Select orders you want to group and click Group Orders.

You see the Group Orders panel drawer.
4. On the panel drawer, enter a Group Name.
5. Change the group dock date if needed.
6. Click Save.

The orders that are grouped show the same group name.

Group the Orders Using Inline Edit
To group your planned orders using inline edit:

1. In the Buyer Planning work area, Overview tab, click on a status bar of the planned order bar chart.

You see the Order Lines view on the Buyer Planning tab.
2. Select an order line.

You see the Order Details view on the Buyer Planning tab. The order details are based on the supplier-site-
location combination.

3. On the Order Details view of the Buyer Planning tab, double-click on the Group Name field for an order.

The field becomes editable.
4. Enter a group name. If there's a name already in the field, you can change it.
5. Click the tick mark.

Your changes are saved.

Remove Grouping on Orders
Use the Unmark for Release action to remove grouping on orders. Here’s how you do it:

1. Select the orders you want to ungroup.
2. From More Actions, select Unmark for Release.

The orders are ungrouped and the statuses of the orders change to Ready for Release.

You can also use the Unmark for Release action to:

• Remove consolidation of orders.

• Remove orders from the Marked for Release status back to the Ready for Release status.
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View Group Summaries
In the Group Summary view, you can see how many planned orders are grouped and how many aren’t. Use this
information to determine if any further grouping or readjustment is needed to optimize the weight and volume of loads.

1. In the Buyer Planning work area, Overview tab, click on a status bar of the planned order bar chart.
You see the Order Lines view on the Buyer Planning tab.

2. Select an order line.
You see the Order Details view on the Buyer Planning tab. The order details are based on the supplier-site-
location combination.

3. On the Order Details view of the Buyer Planning tab, click More Actions, and select Show Group Summaries.
4. On the Group Summaries view, you see:

Field Description

Ungrouped orders: Number of Planned
Orders

Shows the number of planned orders that aren’t grouped yet.

Group: Number of Planned Orders Shows the number of orders each group has.

Total Price Savings You get an understanding of total cost that you saved after consolidating orders.

Total Weight Shows the total weight of the items in a group order.

Total Volume Shows the total volume of load containing a group order.
 
Total weight and volume help you save on delivery costs and number of deliveries. You can
regroup to see that the container in which the items are delivered is optimally utilized so that
you can avoid multiple deliveries.

Analyze Impact on Inventory  
You can evaluate the impact on projected inventory balances and updated projected inventory balances when you
change planned order quantities or dates.

Inventory analysis gives visibility to the time-phased view of a selected item. You get to know the projected available
balance of an item before and after any changes, including order consolidation and grouping.
To see inventory analysis:

1. In the Buyer Planning work area, Overview tab, click on a status bar of the planned order bar chart.
You see the Order Lines view on the Buyer Planning tab.

2. Select an order line.
You see the Order Details view on the Buyer Planning tab. The order details are based on the supplier-site-
location combination.

3. Select an order.
4. From More Actions, select Inventory Analysis.
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You can see inventory analysis of only one item at a time.
5. You can use Change Dates to set different time periods and see the trend of inventory demand.

Inventory Analysis shows these insights based on the item-location combination in an order:

• Projected Available Balances line chart

• Table with inventory details

Projected Available Balances Line Chart
On the chart, you see a line graph for the projected available balance and a dotted line graph for the updated projected
available balance of an item against its quantities and date ranges.

In the background of the line graphs, you see safety stock, final minimum quantity, and final maximum quantity
maintained for an item. This information helps you know how long the remaining stock can last before your supplier
delivers the order.

Inventory Details Table
Inventory details display the measures that help organizations understand how much demand exists for an item for a
given time period, what’s the total demand and supply, projected available balance, updated projected available balance,
average daily demand for the item, and updated days of cover.

Based on this information, you can estimate if the item needs refilling in the near future.

Updated Projected Available Balance
All the measures, including Updated Projected Available Balance, are available in the replenishment plan. However, the
Updated Projected Available Balance measure keeps changing whenever you change the quantities of your planned
orders from Buyer Planning.

Here are the other possible scenarios when the Updated Projected Available Balance measure is updated:

Scenario Description

When you change the Implement Quantity
of an order after marking it for release

When you add or change implement quantities of more than one order, select Calculate Inventory
Balances from Actions to update the Updated Projected Available Balance.

When you create planned orders from the
Buyer Planning work area

Updated Projected Available Balance is automatically updated when you create new planned orders
and add quantities for them from the Buyer Planning work area.
Let’s assume that on Jan 4, 2024, you create a planned order from Buyer Planning. The ordered
quantity is added to the Updated Projected Available Balance Jan 4, 2024. The quantity changes are
reflected in the chart and the inventory details table.
 

Release Your Plan from Buyer Planning  
You can release your replenishment plan from the Buyer Planning work area to generate purchase orders in Oracle
Procurement. The status of the planned orders that are marked for release changes to Released.
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Note:  A good business practice is to ensure that the planning team adheres to a formal business process for releasing
a plan to Oracle Procurement so that you won’t release a plan prematurely.

When you release a plan, the release process generates purchase orders based on:

• Custom grouping of orders you did in the Buyer Planning work area

• Purchase agreements from Oracle Procurement

• Group By settings defined for a replenishment plan

To release a plan:

In the Buyer Planning work area, Buyer Planning tab, click Release Plan. The Release Plan from Buyer Planning
scheduled process runs.

Order status changes after the process completes:

Order Type Status Before Release Status After Release

Planned Orders Marked for Release Released

Planned Orders Ready for Release No change

Planned Orders Released No change

Purchase Requisitions Ineligible No change

Purchase Orders Ineligible No change
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21  Extract Plan Data

Overview of Planning Measure Data Extractions from
Plan Output  
Planning information is an important component of supply chain analytics. It's important to extract planning measure
data from any plan to build offline reports or integrate with any external system.

Planners can use the Export Plan Data action from the Manage Plans page to run the Prepare Supply Chain Planning
Data for Export scheduled process. You can also run the process or schedule as a job from the Scheduled Processes
page under the Tools menu in the Navigator.

When analyzing a plan, you can extract detail supply chain planning multidimensional plan output data, including
measures and hierarchies. The extract is based on the measure catalog and dimension catalog assigned to the plan.
The Prepare Supply Chain Planning Data for Export scheduled process extracts plan output data into a set of files for
external reporting and analysis.

The extract process exports plan data to WebCenter Content in the comma-separated value (CSV) data format. This
extract includes measure data, including any measures that you configured that are either stored or calculated. For
calculated measures, the planning process extracts the data after evaluating the measure expressions. The extract is
based on the measure catalog and dimension catalog assigned to the plan and includes user-defined hierarchies and
levels. Supporting information such as hierarchies for multidimensional analysis is also exported.

Before you can run the Prepare Supply Chain Planning Data for Export scheduled process for a plan, you must:

1. As a one-time setup, create an application integration with login credentials.

a. Navigate to the Setup and Maintenance work area and select the Manage Setup Content task.
b. On the Manage Integration of Additional Applications page, set up the following:

- Application Name: SCP_BICC_REST_CREDENTIALS
- Full URL: Enter the host name of the application. For example: https://

example.fa.app.oraclecloud.com
- Partner Name: SCP_BICC_REST_CREDENTIALS
- Security Policy: oracle/wss_username_token_over_ssl_client_policy

2. Ensure that the user running the extract has access to the Upload and Download Data from On-Premise System
to Cloud System role (OBIA_EXTRACTTRANSFORMLOAD_RWD).

3. Configure the extract options for your plan. Navigate to the Plan Options page, Scope tab and click the
Advanced Options button. In the Scope: Advanced options dialog box, in the Extract Options section, configure
the extract parameters.

4. Navigate to the Manage Plans page and select a plan. Select Export Plan Data to run the Prepare Supply Chain
Planning Data for Export scheduled process.

You can extract data at the lowest level from any of these plan types:

• Demand plan

• Demand and Supply plan

• Replenishment plan
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• Sales and Operations plan

• Supply plan

Configure Plan Extract Parameters  
Before you can select the Export Plan Data action from the Manage Plans page, you must configure the extract options
for your plan.

1. Navigate to the Plan Options page, Scope tab and click the Select Advanced Options button.
2. In the Scope: Advanced options dialog box, in the Extract Options section, select the Enable for extract check

box to enable plan data to be extracted.
3. Configure the extract parameters for the plan.

Dimension Catalog for Extract
Select a dimension catalog to use for the extract process. The list of values includes all dimension catalogs valid for
the plan type. The list of hierarchies included in this list must be a subset of the hierarchies available in the dimension
catalog associated with the plan. The list of hierarchies includes preconfigured and user-defined hierarchies. Note the
following:

• The maximum number of levels per hierarchy is limited to 10 levels.

• The maximum number of hierarchies in the segment dimension is limited to two hierarchies.

Measure Catalog for Extract
Select a measure catalog to use for the extract process. The list of values includes all measure catalogs valid for this
plan type. The measure catalog must contain only the measures that are part of the measure catalog for the plan. The
planning process evaluates measures with expressions and includes the results in the extract.

Extract Time Hierarchy
Select a time hierarchy to use for the extract process. Data extraction is done only at the lowest level for all dimensions
except for the time dimension. You can have only one time hierarchy per plan and it must be part of the dimension
catalog used for the extract process. If it contains other time hierarchies, the extract process ignores them for extract.

The extract time hierarchy depends on the plan type, the planning calendar associated with the plan, and the planning
time level. Validation rules apply for the Extract Time Hierarchy field, based on the type of plan.
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For a demand plan that uses a hybrid time hierarchy, the value in the Extract Time Hierarchy field is automatically set
to the hybrid time hierarchy that you selected as the planning calendar and can't be changed.

Extract Time Level
Select a specific time level to extract. The list of values includes all levels based on the plan type and your selection in
the Extract Time Hierarchy field. The valid values and defaults are as follows:

• Manufacturing calendar: Week, Period (Default is Week)

• Fiscal Calendar: Month, Quarter (Default is Month)

• Gregorian Calendar: Month, Year (Default is Month)

The extract time level depends on the plan type, the planning calendar associated with the plan, and the planning time
level. The Extract Time Level selection is subject to validation for each plan type.

Plan Type Rule

Supply plan
 

Largest supply planning bucket or above. For example:
 

• If Supply Planning Buckets are 0 days, 52 weeks, then the Extract Time Level can be Week or
Period.

• If Supply Planning Buckets are 365 days, 13 Periods, then the Extract Time Level can only be
Period.

Demand plan
 

Planning time level of the plan or above.
 

Demand and Supply plan
 

Largest supply planning bucket or above. For example:
 

• If Supply Planning Buckets are 0 days, 52 weeks, then the Extract Time Level can be Week or
Period.

• If Supply Planning Buckets are 365 days, 13 Periods, then the Extract Time Level can only be
Period.

Sales and Operations plans
 

Planning time level of the plan or above.
 

Replenishment plan
 

Planning time level of the plan or above.
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For a demand plan that uses a hybrid time hierarchy, in the Extract Time Level field, you can select a parent of the
Hybrid time level for the hybrid time hierarchy that you selected as the planning calendar. For a manufacturing hybrid
hierarchy, you can select the Week or Period level. For a Gregorian hybrid hierarchy, you can select the Month, Quarter,
or Year level. For a fiscal hybrid hierarchy, you can select the Month, Quarter, or Year level.

Files Created by the Plan Extract Process  
The plan extract process generates a set of files. Some files have file names that begin with DATA and have a .csv.gz file
extension. These files are compressed, comma-separated value (CSV) files.

The extract process also generates a set of files with file names that begin with META and have a .mdcsv.gz extension
for its internal use. You can ignore the META files.

Every plan extract results in the following DATA files:

File generated Description of file

Dimension Data
 

The plan extract process generates one dimension data file for each dimension selected for the extract
process. This file contains all of the level members with their associated relationships for all hierarchies
in that dimension.
 

Dimension Definition
 

The plan extract process generates one dimension definition file for each extract and contains the
names of the hierarchies and levels.
 

Measure Data
 

The plan extract process generates one measure data file for each set of measures that share the same
dimensionality. This file contains the measure values by the different dimensions.
 

Measure Definition
 

The plan extract process generates one measure definition file for each extract and contains the
names, data types, expressions, granularity, and aggregation rules of the measure.
 

The extract process generates the dimension definition and measure definition files to help you understand the
content of the data files, but they aren't essential for reporting or analysis. These files contain translatable strings in the
language of the planner performing the extract.

Naming Conventions for Extracted DATA Files
In addition to the DATA prefix and .csv.gz file extension, the data file names follow a specific naming pattern. You can
search the content server for this name pattern to get the required files for download.

• Dimension file name patterns

◦ Dimension data file:

◦ Dimension definition file:
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Dimension file name parts Description

jobID
 

The job ID of the extract scheduled process.
 

planID
 

The ID of the plan. This name is available in log files.
 

Dimension code
 

The dimension code that the hierarchies in the file belong to. Used in the dimension data file,
 but not the dimension definition file.
 

BICCJobID
 

The job ID of the extract scheduled job of the BI Cloud Connector (BICC) tool.
 

DateTime
 

Date and time the extract scheduled process began.
 

• Measure file name patterns

◦ Measure data file:

◦ Measure definition file:

Measure file name parts Description

jobID
 

The job ID of the extract scheduled process.
 

planID
 

The ID of the plan. This name is available in log files.
 

Dimensionality group code
 

Name of the dimensionality group code. Used in the measure data file, but not the measure
definition file.
 

BICCJobID
 

The job ID of the extract scheduled job of the BI Cloud Connector (BICC) tool.
 

DateTime
 

Date and time the extract scheduled process began.
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Dimension Data Files Created by the Plan Extract Process
 
The plan extract process generates one dimension data file for each dimension and contains all of the hierarchies in
that dimension. Each dimension file contains information for all of the selected hierarchies.

For example, if the planner selects two product hierarchies, an item appears twice--once for each hierarchy.

Column name Content

HIERARCHY_ID
 

Internal hierarchy identifier
 

[dimension]_LVL_MEMBER_ID
 

ID of the lowest-level member. Each dimension file contains its own lowest level member. For example:
 

• PRD_LVL_MEMBER_ID

• ORG_LVL_MEMBER_ID

BASE_MBR_NAME
 

Name of the lowest level member
 

L2-MBR_ID
 

Level 2 member ID
 

L2_MBR_NAME
 

Level 2 member name
 

L3-MBR_ID
 

Level 3 member ID
 

L3_MBR_NAME
 

Level 3 member name
 

L4-MBR_ID
 

Level 4 member ID
 

L4_MBR_NAME
 

Level 4 member name
 

L5-MBR_ID
 

Level 5 member ID
 

L5_MBR_NAME
 

Level 5 member name
 

L6-MBR_ID
 

Level 6 member ID
 

L6_MBR_NAME
 

Level 6 member name
 

L7-MBR_ID
 

Level 7 member ID
 

L7_MBR_NAME Level 7 member name
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Column name Content

  

L8-MBR_ID
 

Level 8 member ID
 

L8_MBR_NAME
 

Level 8 member name
 

L9-MBR_ID
 

Level 9 member ID
 

L9_MBR_NAME
 

Level 9 member name
 

L10-MBR_ID
 

Level 10 member ID
 

L10_MBR_NAME
 

Level 10 member name
 

SR_BASE_MBR_ID
 

Internal use only
 

Dimension Definition Files Created by the Plan Extract
Process  
The dimension definition file contains information for all of the dimensions and hierarchies specified in the dimension
catalog for extract. The plan extract process creates only one file per extract.

Column name Description

DIMENSION_ID
 

Unique ID of the dimension
 

HIERARCHY_ID
 

Unique ID of the hierarchy
 

BASE_LEVEL_ID
 

Lowest level (Level 1) ID
 

LEVEL_2_ID
 

Level 2 ID
 

LEVEL_3_ID
 

Level 3 ID
 

LEVEL_4_ID
 

Level 4 ID
 

LEVEL_5_ID
 

Level 5 ID
 

LEVEL_6_ID Level 6 ID
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Column name Description

  

LEVEL_7_ID
 

Level 7 ID
 

LEVEL_8_ID
 

Level 8 ID
 

LEVEL_9_ID
 

Level 9 ID
 

LEVEL_10_ID
 

Level 10 ID
 

DIMENSION_CODE
 

Unique code for the dimension
 

DIMENSION_NAME
 

Dimension name
 

HIERARCHY_NAME
 

Hierarchy name
 

BASE_LEVEL_NAME
 

Base level name
 

LEVEL_2_NAME
 

Level 2 name
 

LEVEL_3_NAME
 

Level 3 name
 

LEVEL_4_NAME
 

Level 4 name
 

LEVEL_5_NAME
 

Level 5 name
 

LEVEL_6_NAME
 

Level 6 name
 

LEVEL_7_NAME
 

Level 7 name
 

LEVEL_8_NAME
 

Level 8 name
 

LEVEL_9_NAME
 

Level 9 name
 

LEVEL_10_NAME
 

Level 10 name
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Measure Data Files Created by the Plan Extract Process  
The plan extract process generates one measure data file for each set of measures that share the same dimensionality
or granularity. Use the measure definition file to obtain more details about the measure, including its full name,
description, aggregation methods, and so on.

The following table is an example measure data file for a specific dimensionality with a selected list of measures. The
actual format depends on the dimensionality and the measures selected by users for extract.

Column name Description

PLAN_ID
 

ID of the plan
 

PRD_LVL_MEMBER_ID
 

Product dimension lowest level member ID
 

ORG_LVL_MEMBER_ID
 

Organization dimension lowest level member ID
 

TIM_LVL_MEMBER_ID
 

Time dimension lowest level member ID
 

FACT_DATE
 

Date
 

AVG_DAILY_DMD
 

Value of this measure
 

GROSS_MARGIN_PCT
 

Value of this measure
 

IN_TRANSIT
 

Value of this measure
 

INV_TURNS
 

Value of this measure
 

ITEM_STD_COST
 

Value of this measure
 

ONHAND
 

Value of this measure
 

PAB
 

Value of this measure
 

PAB_VALUE
 

Value of this measure
 

PO_QTY
 

Value of this measure
 

PR_QTY
 

Value of this measure
 

PROJECTED_ONHAND Value of this measure
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Column name Description

  

SCHED_RCPT
 

Value of this measure
 

SS
 

Value of this measure
 

TF_QTY
 

Value of this measure
 

TOTAL_DEMAND
 

Value of this measure
 

TOTAL_DEMAND_VALUE
 

Value of this measure
 

TOTAL_SUPPLY
 

Value of this measure
 

TTL_END_ITEM_CST
 

Value of this measure
 

GROSS_MARGIN
 

Value of this measure
 

The extract process generates one measure data file for each set of measures that share the same dimensionality or
granularity. The measure data files contain information for all measures that share that same dimensionality. A list
of predefined dimensionality groups is listed in the Dimensionality Group Codes Used by the Plan Extract Process
topic. The lowest level of each of these dimensions appears in each file. They will be different for each dimensionality,
based on the dimensions that are part of that group. Each measure column name is a measure code from the measure
definition file. Use the measure definition file to obtain more details about the measure, including its full name,
description, aggregation, and so on.

Measure Definition Files Created by the Plan Extract
Process  
The measure definition file contains information for all of the measures specified in the measure catalog for extract. The
plan extract process creates only one file per extract.

Column name Description

GRANULARITY_ID
 

Dimensionality group ID
 

POSITION
 

Internal use only
 

MEASURE_CODE
 

Used as the column name in measure data files
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Column name Description

MEASURE_ID
 

ID that uniquely identifies a measure
 

NAME
 

Name of the measure
 

DESCRIPTION
 

Brief description of the measure
 

DATA_TYPE
 

Data type
 

EXPRESSION
 

Internal use only
 

AGGR_ORDER
 

Aggregation rule:
 
1 = Calculate, then aggregate
 
2 = Aggregate, then calculate
 

AGGR_METHOD_OTHER
 

Aggregation method on dimensions other than the Time dimension
 

AGGR_METHOD_TIME
 

Aggregation method on the Time dimension
 

WEIGHTED_BY
 

ID of the measure to be used when aggregation method is WAVG (weighted average)
 

The MEASURE_CODE column in this file contains all the measure codes for all measures. The actual measure data
files use this measure code as data column name. Using this code, you can look up additional information about the
measure in the definition file. Note that the expression indicated is only for internal use and is already evaluated before
the extract. Aggregation methods (Sum, Latest, Average, Weighted Average, and so on) can be used to configure your
analytics to aggregate these measures across various dimensions.

Dimension Codes Used by the Plan Extract Process  
The plan extract process uses preconfigured dimension codes related to a list of valid dimension.

Code Dimension name

tim
 

Time
 

res
 

Resource
 

cus
 

Customer
 

prd Product
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Code Dimension name

  

org
 

Organization
 

dcs
 

Demand Class
 

sup
 

Supplier
 

fcm
 

Forecasting Method
 

cto
 

Configure to Order
 

src
 

Source
 

exp
 

Exception Type
 

ord
 

Order Type
 

cig
 

Decomposition Method
 

seg
 

Segment
 

Dimensionality Group Codes Used by the Plan Extract
Process  
The extracted files use codes related to a list of valid dimensionality groups. Dimensionality group codes shown in this
topic list all of the valid preconfigured dimension groups.

For example, code 125 is for all measures that are dimensioned only by the Organization, Product, and Time dimensions.
The measure data file for that dimensionality contains all measures extracted for that dimensionality.

Dimensionality Group Code Dimensionality Group

10
 

org, prd, tim, cus, cto
 

15
 

org, prd
 

20
 

org, res, tim
 

25 tim
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Dimensionality Group Code Dimensionality Group

  

35
 

org, prd, tim, cus
 

40
 

org, prd, res, tim, cus, sup, exp
 

45
 

org, prd, tim, sup
 

50
 

org, prd, tim, cus, sup, src
 

55
 

org, prd, tim, cus, dcs, ord
 

60
 

org, prd, tim, ord
 

65
 

org, prd, tim, cus, sup, dcs, ord
 

70
 

org, prd, tim, sup, ord
 

75
 

org, prd, dcs
 

95
 

org, prd, cus, dcs, fcm, clg, tim, cto
 

100
 

org, prd, tim, cus, dcs, cto
 

105
 

org, prd, cus
 

110
 

org, prd, cus, dcs
 

125
 

org, prd, tim
 

130
 

org, prd, tim, cus
 

135
 

org, prd, tim, cus, dcs
 

145
 

prd, tim, cus
 

150
 

prd, tim, cus, dcs
 

155
 

org, prd, tim, cus, sup, dcs
 

160
 

prd, cus
 

165 org, prd, tim, exp
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Dimensionality Group Code Dimensionality Group

  

170
 

org, tim
 

175
 

prd
 

180
 

org, prd, tim, cus, dcs, fcm, clg
 

185
 

org, prd, cus, dcs, fcm, clg
 

190
 

org, prd, cus, fcm, clg
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22  Troubleshooting

Resolve Error MSC-2806379  
This topic guides you on how you can resolve error MSC-2806379 that may be displayed when you view a table or
graph.

The error is displayed when you view a table or graph that you don't own for your Oracle Fusion Cloud Supply Chain
Planning product, and the table or graph contains too much data.

The error text is as follows: "You can't view this table or graph because the underlying data or analysis produces too
much data. (MSC-2806379)

"To resolve this issue, make a copy of the table or graph because you aren't the owner of it, change configurations to
reduce the data set, and try again. For example, limit the use of measures with different dimensionalities, reduce the
number of measures with complex expressions, such as lead or lag functions, or check measure filter configuration.
Refer to Incident ID <number> on <server name> server."

Follow these steps to resolve the error:

1. If the table or graph is open, in the toolbar, click Actions > Save Table As or Actions > Save Graph As.
Otherwise, do the following:

a. Click Actions > Manage Tables, Graphs, and Analysis Sets.
b. In the Manage Tables, Graphs, and Analysis Sets dialog box, search for your table or graph, and select it.
c. Click Actions > Duplicate.

2. In the dialog box, provide the name and description for the copied table or graph.
Provide other details for the copied table or graph.

3. Click Save and Edit.
4. In the Configure Table or Configure Graph dialog box, do the following:

◦ On the Measures tab, on the Selected Measures pane, select the measures that you can remove from the
table or graph, and move them to the Available Measures pane.

For example, limit the use of measures with complex expressions.

◦ On the Members tab, on the Selected Members pane, select the members that you can remove from the
table or graph, and move them to the Available Members pane.

For example, on the Selected Members pane, retain only one organization or a few products according to
your business requirements. You can use the Advanced Filter dialog box to reduce the number of members
that are displayed by the table or graph.

◦ On the Measure Filters tab, add filters to reduce the amount of data returned by your table or graph.

◦ On the Layout tab, add filters to your table or graph.

For example, if your table includes the Organization level, you can use the level as a filter that restricts the
returned data to the selected member.

5. Click Save and Close.
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Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

• Use Advanced Options in the Selector Tool

• Configure Filters for Graphs

Resolve Error MSC-2806380  
This topic guides you on how you can resolve error MSC-2806380 that may be displayed when you view a table or
graph.

The error is displayed when you view a table or graph that you own for your Oracle Fusion Cloud Supply Chain Planning
product, and the table or graph contains too much data.

The error text is as follows: "You can't view this table or graph because the underlying data or analysis produces too
much data. (MSC-2806380)

"To resolve this issue change configurations to reduce the data set, and try again. For example, limit the use of
measures with different dimensionalities, reduce the number of measures with complex expressions, such as lead or lag
functions, or check measure filter configuration. Refer to Incident ID <number> on <server name> server."

Follow these steps to resolve the error:

1. If the table or graph is open, in the toolbar, click Actions > Configure Table or Actions > Configure Graph.
Otherwise, do the following:

a. Click Actions > Manage Tables, Graphs, and Analysis Sets.
b. In the Manage Tables, Graphs, and Analysis Sets dialog box, search for your table or graph, and select it.
c. Click Actions > Edit.

2. In the Selector Tool, do the following:

◦ On the Measures tab, on the Selected Measures pane, select the measures that you can remove from the
table or graph, and move them to the Available Measures pane.

For example, limit the use of measures with complex expressions.

◦ On the Members tab, on the Selected Members pane, select the members that you can remove from the
table or graph, and move them to the Available Members pane.

For example, on the Selected Members pane, retain only one organization or a few products according to
your business requirements. You can use the Advanced Filter dialog box to reduce the number of members
that are displayed by the table or graph.

◦ On the Measure Filters tab, add filters to reduce the amount of data returned by your table or graph.

◦ On the Layout tab, add filters to your table or graph.

For example, if your table includes the Organization level, you can use the level as a filter that restricts the
returned data to the selected member.

3. Click Save and Close.
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Related Topics
• Overview of Tables, Graphs, Analysis Sets, Tiles, and Tile Sets

• Use Advanced Options in the Selector Tool

• Configure Filters for Graphs
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